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Confirm that the delivered product is what you have ordered. Read this manual to make sure of correct operation. 

• Be certain to read this manual carefully before performing installation, wiring, or maintenance work, or operating 
the HG2G-5T.

• The HG2G-5T has been manufactured with careful regard to quality. However, if you intend to use this product in 
applications where failure of this equipment may result in damage to property or injury, ensure that it used in 
conjunction with appropriate fail-safe backup equipment.

• In this manual, safety precautions are categorized in order of importance to Warning and Caution:

SAFETY PRECAUTIONS

Warning notices are used to emphasize that improper operation may cause severe 
personal injury or death.

Caution notices are used where inattention might cause personal injury or damage to 
equipment.

 

• The HG2G-5T is not intended to be used for applications which require high reliability and safety, such as 
medical equipment, nuclear equipment, railways, aircraft, and vehicles. The HG2G-5T cannot be used for these 
applications.
For other applications which require high reliability in function and precision, provide a failsafe design and 
redundant design for the entire system including the HG2G-5T.

• Turn off the power to the HG2G-5T before installation, removal, wiring, maintenance, and inspection of the 
HG2G-5T. Failure to turn power off may cause electrical shock or fire hazard.

• Special expertise is required to install, wire, configure, and operate the HG2G-5T. People without such expertise 
must not use the HG2G-5T.

• The HG2G-5T uses an LCD (liquid crystal display) as a display device. The liquid inside the LCD is harmful to the 
skin. If the LCD is broken and the liquid attaches to your skin or clothes, wash the liquid off using soap, and 
consult a doctor immediately.

• Emergency and interlocking circuits must be configured outside of the HG2G-5T.
• Do not use the HG2G-5T's internal touch switches for an emergency circuit. If the HG2G-5T failed, the external 

equipment connected to the HG2G-5T will no longer be protected, and serious injury to operators and 
equipment damage may be caused.
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• Prevent the HG2G-5T from falling while moving or transporting, otherwise damage or malfunction of the 
HG2G-5T will result.

• Use the product within the environmental limits given in the catalog and manual. Use of the product in high-
temperature or high-humidity environments, or in locations where it is exposed to condensation, corrosive gas 
or large shock loads can create the risk of electrocution and fire.

• The HG2G-5T is designed for use in pollution degree 2. Use the HG2G-5T in environments of pollution degree 2. 
(based on the IEC60664-1 rating)

• Install the HG2G-5T according to the instructions. Improper installation will result in falling, failure, electrical 
shock, fire hazard, or malfunction of the HG2G-5T.

• Prevent metal fragments or wire chips from dropping inside the HG2G-5T housing. Ingress of such fragments 
and chips may cause fire hazard, damage, and malfunction.

• Use a power supply of the rated value. Using a wrong power supply may cause fire hazard.
• The HG2G-5T uses “PS2 of EN61131” as DC power supply. (based on the IEC/EN61131 rating)
• Use wire of a proper size to meet the voltage and current requirements.
• When exporting the HG2G-5T to Europe, use an EN60127 (IEC60127) approved fuse on the power line outside 

the HG2G-5T.
• When exporting the HG2G-5T to Europe, use an EU-approved circuit protector.
• Make sure of safety before starting and stopping the HG2G-5T. Incorrect operation of the HG2G-5T may cause 

mechanical damage or accidents.
• Use the HG2G-5T in a local area network if you download, upload or monitor the project data via the Ethernet 

port.
• The touch panel of the HG2G-5T is made of glass, and will break if exposed to excessive shock. Take due care 

when handling it.
• When more than one button is pressed at the same time, due to the detection characteristics of an analog type 

touch panel, only the gravity center of the pressed area is sensed and the unit assumes that only one button is 
pressed. Thus, when more than one button is pressed simultaneously, the resulting operation is not guaranteed.

• The screen becomes blank when the backlight is burnt out; however, the touch panel remains enabled. Incorrect 
touch panel operation will occur when operating the touch panel  when the backlight appears to be turned off 
but is actually burnt out. Note that this erroneous operation may result in damage.

• Do not push hard or scratch the touch panel and protection sheet with a hard object such as a tool, because 
they are damaged easily.

• At temperatures over the rated operating temperature, the clock accuracy is affected. Adjust the clock before use.
• For applications which require clock accuracy, adjust the clock periodically.
• Do not install the HG2G-5T in areas subjected to strong ultraviolet rays, since ultraviolet rays may impair the 

quality of the LCD.
• Do not attempt to disassemble, repair or modify the HG2G-5T. This can create the risk of fire or electrocution.
• When disposing of the HG2G-5T, do so as an industrial waste.
• Do not switch off the power or pull out the USB flash drive while it is being accessed, as this may result in 

destruction of the stored data. If the data on the USB flash drive is corrupted, format the USB flash drive.
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Revision history

Caution
• The contents of this manual and the WindO/I-NV4 application are copyright, and all rights are reserved by IDEC 

Corporation. Unauthorized reproduction is prohibited.
• The contents of this manual and the WindO/I-NV4 application are subject to change without notice.
• IDEC Corporation accepts no responsibility for circumstances arising from the use of this manual or the 

WindO/I-NV4 application.
• Please contact your vendor or IDEC Corporation with any problems regarding the operation of this product.

Trademarks
WindO/I and MICRO/I are registered trademarks of IDEC CORPORATION in JAPAN. Microsoft, Windows, Windows XP, 
Windows Vista, Windows 7, and Windows 8 are either registered trademarks or trademarks of Microsoft Corporation 
in the United States and/or other countries. Adobe is a trademark of Adobe Systems Incorporated.
All other company names and product names used in this manual or the WindO/I-NV4 application are trademarks of 
their respective owners.
This product adopts the font of Ryobi.

August 2015: First Edition
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Preface
This manual describes MICRO/I operator interfaces (HG2G-5T) and WindO/I-NV4 general configuration software. The 
information includes drawing tools, setup procedures, and how to configure all MICRO/I operator interfaces.
This manual explains the operation and handling of the MICRO/I HG2G-5T. Please read it carefully and ensure that 
you fully understand the functions and performance of the MICRO/I HG2G-5T and the WindO/I-NV4 configuration 
software.

Read the following materials as necessary for your particular application. 

References Content

WindO/I-NV4 User's Manual 
(This document)

Describes the hardware specifications of the HG2G-5T.

WindO/I-NV4 External Device Setup 
Manual (PDF)

Describes the connection procedures and available device addresses for various 
communication including the Device Link Communication, O/I Link 
communication, and DM Link communication.

WindO/I-NV4 Help
Describes the operating procedures. The user is allowed to view all manuals via 
Help.

Character Table (PDF)
A list of fonts can be used with the HG2G-5T and WindO/I-NV4. For restrictions 
on using the HG2G-5T, refer to Chapter 2 “1.2 Available Text” on page 2-5.
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Symbols Used in this Manual

This manual uses the following symbols to facilitate explanation.

Symbols

…… Information that requires special attention. Failure to operate the product in accordance with 
the information provided can lead to serious injury or damage.

…… Information relating to requests or material to reference in the use of a function

…… Useful information relating to a function

 …… Indicates the chapter and page of related reference information.

OK …… Screen buttons are indicated by bold text or by using the actual graphic icon.

SHIFT, …… Keyboard keys are indicated by the keyboard inscription in capital letters or enclosed in 
square brackets.

**** …… Controls are indicated by bold text.

A
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Abbreviations, Generic Terms, and Terminology Used in this Manual
Item Description

HG2G-5T The name is short for MICRO/I HG2G-5T*22TF-*.

MICRO/I Generic term used to refer to the HG2G-5T.

External Device
Generic term used to refer to a PLC or micro computer that is connected to and 
communicates with the MICRO/I.

Device Address
Memory that is capable of storing values in unit of bits or words loaded on the MICRO/I 
and external device.

System Area
Device address area that is pre-allocated for exchanging screen management, error 
information, and clock data between the MICRO/I and an external device.

Device Link Communication
A communication method that performs communication with the external device 
according to the setting of the screen and without a program.

DM Link Communication
A communication method that reads to or writes from the MICRO/I device address from 
a computer or microcomputer board.

User Communication
A communication method which performs communication with external devices such as 
barcode readers and inverters.

External Device Communication Generic term used to refer to Device Link Communication and DM Link Communication.

Sub Host Communication
A communication method that performs communication with external device according 
to the set device address list and without a program.

O/I Link
A connection format that enables connections of up to 16 units of MICRO/I with high-
speed communication of 115200bps.

O/I Link Master The MICRO/I unit that is directly connected to external device on the O/I Link network.

O/I Link Slave
The MICRO/I units that are not directly connected to external device on the O/I Link 
network.

WindO/I-NV4 Integrated configuration software application for creating projects of the MICRO/I.

Project
Data including image data required for operating the MICRO/I, which is created with 
WindO/I-NV4.

Manager
WindO/I-NV4 provides tools to manage pictures, text and script etc. With the Managers, 
you can create and manage them in your project.

Setup Generic term used to refer to the common settings in the project.

Project Settings Basic settings of operation in the Setup settings.

Alarm Log A function where the MICRO/I collects log data of alarms.

Data Log A function where the MICRO/I collects value of device addresses.

Script A script is an executable list of commands created by a simple programming language.

Text Group
A group of 32 texts maximum that is in order to dynamically switch the character 
displayed on the MICRO/I according to the value of the device address.

Windows Font
Text fonts that can be displayed on the Windows OS on which the WindO/I-NV4 is 
running.

Stroke Font
A glyph's outline is defined by the vertices of individual strokes and stroke's profile. 
Scalable fonts scale easily without jagged edges.
Under font settings, “Stroke” is a stroke-based font.

Maintenance Communication Communications between the WindO/I-NV4 and MICRO/I using a dedicated protocol.

Device Monitor
A special Popup Screen on the MICRO/I on which value of the device address can be 
displayed or changed.

Pass-Through A function that enables maintenance of the external device via the MICRO/I.

System Screen
Pre-allocated screen dedicated for performing initial setting of the MICRO/I, 
self-diagnosis, and clearing the log data etc.

External Memory Device The generic term for a USB flash drive.

NV Metafile A graphic data file that integrates drawings created on the WindO/I-NV4 edit screen.

Window
Screens that are loaded on to the Base Screen, including Popup Screen and Device 
Monitor.
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Internal Device
The generic term for internal device addressing on the MICRO/I such as internal relays, 
registers, etc.

Keep Device
The generic term for internal device not initialized at the start of operation. Even after 
the power is turned off, the values are retained by the battery.

Drawings Define as as non functional content (i.e. shape, picture, text).

Parts Define as functional content (i.e. button, pilot lamp, commands, etc.)

Object Define as combination of Drawings and Parts placed on WindO/I-NV4 edit screen.

Touch Switch A part that operates a function by pressing parts that have been placed on the screen.

Standard Keypad
Keypad that is displayed when operating Numerical and Character Input parts when 
Standard is selected under Type in the Keypad menu for Numerical and Character 
Input parts.

Item Description
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1

System
 Com

position

  

There are two types of system compositions used in operating the MICRO/I: One that is configured for the operation, 
and the other that is used for creating projects required for performing operations. In creating projects, use the 
WindO/I-NV4, the dedicated configuration software application for the MICRO/I.

● MICRO/I
The MICRO/I is equipped with a high-brightness, color LCD with fast screen drawing speed, quick-response touch 
switches, and high-speed communications to provide a comfortable man-machine interface. It is designed to allow 
easy data read/write from/to external device's, and does not burden the operator with issues relating to 
communications software.

1.1 System Composition for the RUN operation

The MICRO/I can be operated in the following system configuration. Devices that can be connected vary depending 
on your MICRO/I model. Refer to the specifications of the model for the details.

Chapter 1 System Composition

1 System Composition

130

MICRO/I

WindO/I-NV4 External Device
Periodically reads

values of device addresses

Writes changed
values of device addresses

Download

Data reception

Data
transmission

Writing data

Reading
data

MICRO/I
Web Browser Terminal
(Computer, PDA, etc.)

External device
(User Communication)

External Memory Device

External Device

USB flash drive

Read

Write

Monitor

Operation



1 System Composition

1-2 WindO/I-NV4 User’s Manual

1.2 System Composition for Creating Screens

It is necessary to create and download a project to the MICRO/I for operating it. Use the WindO/I-NV4 to create a 
project. The project you have created can be downloaded to the MICRO/I by directly connecting it to the computer, or 
the project data can be downloaded to external memory device, and then it can be copied from external memory 
device to the MICRO/I equipped with the memory card interface or the USB interface.

Upload

Copy

Copy

130

Download

Install

External Memory Device

MICRO/I

Computer

WindO/I-NV4

USB flash drive

Upload

Download
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2 About the WindO/I-NV4

1

System
 Com

position

    

WindO/I-NV4 is software that is exclusively designed for operation with the MICRO/I, for specifying settings and 
creating screens. The set of data made up of settings and created screens is called a project.
Using WindO/I-NV4, you create a project and then download it to the MICRO/I, to build the interface necessary for 
operation.

2 About the WindO/I-NV4
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The MICRO/I includes multiple modes, so you switch between modes as and when necessary. These modes are called 
operating modes. The functions and the operations and conditions for switching are as follows.

3 Operating Modes

Mode Functions
Conditions required for 
switching to the mode

Run Mode
This is the mode at the time of executing project 
data. The created screen is displayed.

• Turn ON the power to the MICRO/I.
• Press Run on the Top Page in System Mode 

or on the Main Menu.
• The download of the project data is 

completed.

System Mode
Perform initial settings, clock settings, self-diagnosis, 
etc. for the MICRO/I.

• Press down for 3 seconds or more at the 
top-left corner of the screen to display the 
Maintenance Screen, and then press 
System Mode.

• Using the screen switching button, multi-
buttons, screen switch or multi commands, 
switch to the System Mode.

• All data is cleared using WindO/I-NV4.
• Write the System Area 1 Display screen 

number (address number+0) to FFFFh.

Monitor Mode

Monitor Mode is used for monitoring values of 
device addresses using WindO/I-NV4.
In this mode, the words "Monitor Mode" flashes at 
the bottom-left of the MICRO/I screen.

On the WindO/I-NV4 Online tab, in the 
Monitor group, click Start Monitor.

Offline Mode

MICRO/I stops communicating with the external 
devices. It takes you to a Main Menu with many 
internal settings to choose from including Initial 
Setting, Clock Setting and System Information etc.
In this mode, the message "Offline Mode" blinks on 
the bottom-left of the MICRO/I screen.

• Press Offline on the Top Page in System 
Mode or on the Main Menu.

• While monitoring in WindO/I-NV4, on the 
Online tab, in the Monitors group, click 
Go offline.

Data Transfer
Transferring data between a computer and the 
MICRO/I.

• Download project data.
• Upload project data.

When switched to System Mode, operation of the MICRO/I stops.

• To display the Maintenance Screen, the Enable Maintenance check box from the System Settings tab 
of the Project Settings dialog box must be checked.

• For details about Maintenance Mode, refer to Chapter 29 “1 Maintenance Screen” on page 29-1.



WindO/I-NV4 User’s Manual 1-5

4 Flow from Screen Creation and to Run Operation

1

System
 Com

position

  

The following flowchart describes the sequence of step from the screen creation for the MICRO/I to the Run 
operation.

4 Flow from Screen Creation and to Run Operation

1 Launch the WindO/I-NV4

2 Creating a Project and Screen

Modifying the project

6 Troubleshooting

8 Maintenance

4 Downloading the project

3 Saving the project

5 Debug

7 RUN

( refer to Chapter 2 “2.1 Starting WindO/I-NV4” on page 2-35)

Creating a new project ( refer to Chapter 4 “1.1 Creating New Project Data” on page 4-1)
         
• Creating new screens ( refer to Chapter 5 “2.1 Creating Screens” on page 5-2)

( refer to Chapter 22 “2 Downloading” on 
page 22-9)

(refer to Chapter 23 “Monitor Function” on 
page 23-1)

( refer to Chapter 31 “Troubleshooting” on 
page 31-1)

(refer to Chapter 25 “Maintenance” on page 
25-1)

( refer to Chapter 4 “1.3 Saving Project 
Data” on page 4-4)
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1 Launch WindO/I-NV4

Launch WindO/I-NV4.

2 Creating a Project and Screen

Create a project and performing various settings.
Create display screens.

3 Saving the project

Save the project data at any time after the configuration settings are done.

4 Downloading the project

Connect the computer to the MICRO/I using a USB cable or Ethernet cable and download the created project data to 
the internal memory of the MICRO/I.

5 Debug

Using the monitor function, you can correct created project data while confirming actual actions.

6 Troubleshooting

If there is a module or communication-related problem with the MICRO/I, or a problem with the screen, an 
appropriate message is displayed at the top of the screen.
In addition, error information is saved to a special data register. By referring to this information and repeatedly 
correcting the project, downloading, and debugging, the project can be completed.

7 RUN

Starting communication with the external device and execute various functions according to the project settings.

8 Maintenance

The Web Server function allows the user to remotely monitor or operate the state of the O/Is from the web
browser. In addition, the saved data in the MICRO/I and files in External Memory Device can be uploaded to the 
computer.
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V4 Features &
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This chapter describes the minimum system requirements for WindO/I-NV4, how to start and exit it, and the 
configuration of its screens and menus.

  

1.1 Available Data

● Data types
Data type is the format of the data related to the minimum and maximum values of data that can be processed by a 
part and handling of negative and real numbers.
Data types and data ranges that can be used on the MICRO/I and WindO/I-NV4 are listed below.

● Numeric value handling by data type
Data stored in device addresses is handled as described below.

Chapter 2 WindO/I-NV4 Features & Basic Operations

1 WindO/I-NV4 Specifications

Data type Required word count Processable data range

UBIN16(W) 1 0 to 65535

BIN16(I) 1 -32768 to 32767

UBIN32(D) 2 0 to 4294967295

BIN32(L) 2 -2147483648 to 2147483647

BCD4(B) 1 -999 to 9999

BCD8(EB) 2 -9999999 to 99999999

Float32(F) 2 -3.4x1038 to -1.18x10-38, 0 , 1.18x10-38 to 3.4x1038

Data type Data handling

UBIN16(W) Data is handled as an unsigned 16-bit integer.

BIN16(I)
Data is handled as an signed 16-bit integer.
If the sign bit (bit 15) is 1, the value is two’s complement.

UBIN32(D)
Handled as an unsigned 32-bit integer with the starting address 
number as the lower word.

BIN32(L)
Handled as a signed 32-bit integer with the starting address 
number as the lower word.
If the sign bit (bit 31) is 1, the value is two’s complement.

BCD4(B)

Data is handled as a four digit (16-bit) binary-coded decimal 
value.
Each four bits from bit 0 to bit 11 is handled as the absolute 
value for the 1st to 3rd digit.
Bit 12 to bit 15 is handled as the minus sign (-) when its value is 
F (Hex) and it is handled as the absolute value for the 4th digit 
when 0 to 9 (Hex).

bit bit
15 01 word

bit bit
15 01 word

Sign bit

bit
31

bit
0Upper word Lower word

bit
0

bit
31 Lower wordUpper word

Sign bit

bit bit
15 01 word

Sign

1st2nd3rd

Absolute value
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Example: Data handling

BCD8(EB)

Data is handled as an eight digit (32-bit) binary-coded decimal 
value.
Each four bits from bit 0 to bit 27 is handled as the absolute 
value for the 1st to 7th digit.
Bit 28 to bit 31 is handled as the minus sign (-) when its value is 
F (Hex) and it is handled as the absolute value for the 8th digit 
when 0 to 9 (Hex).

Float32(F)

Data is handled as a 32-bit floating-point real number. The number of significant digits is 6 digits. The 
floating-point type data format conforms to the IEEE (The Institute of Electrical and Electronics Engineers) 
standard for the single precision storage format as explained next.

Single precision floating-point values in IEEE 754 (32 bits)
Single precision floating-point values in IEEE 754 are expressed with a total of 32 bits (2 words) using 1 bit 
for the sign s, 8 bits for the exponent e, and 23 bits for the significand f. The sign bit indicates the sign of the 
expressed value (positive or negative). The exponent is an 8 bit signed integer with a value from -128 to 127.

Example:

If all bits are 0, the value is “0”.

Data type Data handling

bit
0

bit
31

Absolute value

Lower wordUpper word

Sign

1st2nd3rd4th5th6th7th

s e (exponent) [bit 30 to 23]

bit
31

bit
23

f (significand) [bit 22 to 0]

Represents after the decimal of 1.xxx+127

Sign bit (0: positive, 1: negative)

bit
22

bit
0

bit
30

s e f
0 0 1 1 1 1 1 0 1 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

1 . 1 × 2 - 2

The internal representation of Float32(F) is described here, but the data for Float32(F) (floating-point real 
numbers) is handled with a special bit configuration, so do not directly access the bits.

Data type Storing 0FFF (Hex) in LDR10 Storing FFFF (Hex) in LDR10

UBIN16(W)

0FFF (Hex) is handled as 4095 (Dec). FFFF (Hex) is handled as 65535 (Dec).

BIN16(I)

0FFF (Hex) is handled as 4095 (Dec). Sign bit is 1, so FFFF (Hex) is two’s complement, 
handled as -1 (Dec).

Data type Storing 0FFF (Hex) in LDR10, FFFF (Hex) in LDR11 Storing FFFF (Hex) in LDR10, FFFF (Hex) in LDR11

UBIN32(D)

0FFFFFFF (Hex) is handled as 268435455 (Dec). FFFFFFFF (Hex) is handled as 4294967295 (Dec).

BIN32(L)

The sign bit is 0, so the positive number 0FFFFFFF 
(Hex) is handled as 268435455 (Dec).

Sign bit is 1, so two’s complement of the negative 
number FFFFFFFF (Hex), handled as -1 (Dec).

bit bit
15 0

0FFF (Hex)

LDR10

0000111111111111

bit bit
15 0

FFFF (Hex)

LDR10

1111111111111111

bit bit
15 0

0FFF (Hex)

LDR10

1111111111110000

+

bit bit
15 0

FFFF (Hex)

LDR10

1111111111111111

−

bit
31

bit
0LDR11 LDR10

00001111111111111111111111111111

0FFFFFFF (Hex)

bit
31

bit
0LDR11 LDR10

1111111111111111111111111111

FFFFFFFF (Hex)

1111

bit
31

bit
0LDR11 LDR10

00001111111111111111111111111111

0FFFFFFF (Hex)+

bit
31

bit
0LDR11 LDR10

11111111111111111111111111111111

FFFFFFFF (Hex)−
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Data type Storing 1234 (Hex) in LDR10 Storing F765 (Hex) in LDR10

BCD4(B)
The sign is 1 (Hex), so the binary-coded decimal 

value of the positive number 234 (Hex), 
handled as 1234 (Dec).

The sign is F (Hex), so the binary-coded decimal 
value of the negative number 765 (Hex), 

handled as -765 (Dec).

Data type
Storing 5678 (Hex) in LDR10, 1234 (Hex) in 

LDR11
Storing 4321 (Hex) in LDR10, F765 (Hex) in 

LDR11

BCD8(EB)
The sign is 1 (Hex), so the binary-coded decimal 

value of the positive number 2345678 (Hex), 
handled as 2345678 (Dec).

The sign is F (Hex), so the binary-coded decimal 
value of the negative number 7654321 (Hex), 

handled as -7654321 (Dec).

Data type Storing 0000 (Hex) in LDR10, BFA0 (Hex) in LDR11

Float32(F)

In the data types UBIN32(D), BIN32(L), BCD8(EB), and Float32(F), two words (upper word and lower 
word) are used for a single value. The MICRO/I and external devices communicate data in device 
addresses in one word units, so when the upper word and lower word are sent in separate packets, the 
value may have already changed when the data for both words is received, which may cause an 
unexpected result.

bit bit
15 0

234 (Hex)

LDR10

+

0001001000110100

bit bit
15 0

765 (Hex)

LDR10

−

1111011101100101

bit
0

bit
31

2345678 (Hex)

LDR10LDR11

+

00010010001101000101011001111000

bit
0

bit
31

7654321 (Hex)

LDR10LDR11

−

00010010001101000101011001111111

bit bit
22 0

bit
31

bit
23

Exponent

LDR10LDR11

Sign Significand

10111111101000000000000000000000

0000 (Hex)BFA0 (Hex)

1 0100000000000000000000001111111

2-2 = 0.2520+21+22+23+24+25+26 = 127
Negative

−1.25×2127-127 = −1.25
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● Indirect Read and Indirect Write Settings
The indirect specification of a device address means to add a value (indirect value) to the address number of the set 
device address and use that address number as the actual read source or write destination. You can change the read 
source or write destination address number just by changing this indirect value.

Indirect read

Add the indirect value to the address number of the device address set as the read source and read the value of the 
indirectly specified device address.
Example: To read an indirectly specified value of device address into LDR200

When the device set as the read source is LDR10 and the indirect value’s device address is D21, if 4 
(indirect value: 4) is set in D21, the device address of the value actually read is LDR14.

Indirect write

Add the indirect value to the address number of the device address set as the write destination and write a value to 
the indirectly specified device address.
Example: To write the value in LDR20 to an indirectly specified device address

When the device set as the write destination is LDR100 and the indirect value’s device address is D20, if 3 
(indirect value: 3) is set in D20, the device address of the value actually written is LDR103.

Parts you can indirectly read and indirectly write

Device address set as read source

Device address with actually read value

Device address for Indirect value
200LDR11
300LDR12

100LDR10

500LDR14

4D21

500LDR200

4 words
Indirect value

Read

LDR13 400

200LDR101
300LDR102

100LDR100

1000LDR103
3D20

1000LDR20

3 words
Indirect value

Device address set as write source

Device address with actually written value

Device address for Indirect value

Write

Part Indirect read Indirect write

Word Button YES YES

Multi-Button YES YES

Numerical Input YES YES

Character Input YES YES

Numerical Display YES NO

Word Write Command YES YES

Script Command YES YES

Multi-Command YES YES

• Enter the value for indirect values as the data type UBIN16(W). Indirect values can be set in the range of 
0 to 32767. When an indirect write is executed with an out-of-range indirect value, “Device range error” 
is displayed. Similarly, when an indirect read is executed, the previous value before the indirect value 
changed is retained for a data display part, and “Device range error” is displayed for a part that is not a 
data display part.

• For reading device address indirectly, decide the read source address number after the indirect value changes 
and after the screen changes, and then read the value of device address. For the device address of an 
external device, communication may take some time as the value is read from the external device, so when 
transferring or calculating the data that was read, repeatedly execute the corresponding part.
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1.2 Available Text

● Font

Supported Languages

The MICRO/I can display multiple fonts by installing them. In addition to the fonts installed on the MICRO/I, all 
Windows fonts displayed on your computer can be used on the display.

In addition, the MICRO/I has a function that switches between two or more text groups dynamically. With this 
function, the registration text of buttons can be switched to different languages according to the conditions.
For details, refer to Chapter 19 “Text Group” on page 19-1.

Font Description

Installed Fonts in the MICRO/I

Fonts to be pre-loaded on the MICRO/I.
Japanese, European, Chinese, Korean, Taiwanese, Central European, Baltic and Cyrillic 
fonts can be installed on the MICRO/I.
The installed fonts installed can be changed as needed using WindO/I-NV4, which 
helps save and efficiently operate the user capacity.

Windows Font

All fonts used on the computer can be displayed on the MICRO/I.
The Windows fonts allow you to display expressive characters on the MICRO/I screen 
as needed.
Windows fonts are downloaded as part of the project data.

External device
MICRO/I

目標達成

D100 : 1

D100 : 2

D100 : 3

Text ID: 1 目標達成

Group 1: English Group 2: Chinese Group 3: Japanese

Goal reached

Goal reached
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Installed Fonts in the MICRO/I

Font Name Code System Language

Standard 
Fonts

Japanese
JIS 8-bit code 
JIS level-1 and 
level-2 kanji sets

Japanese

English ISO 8859-1 (Latin1)
Icelandic, Irish, Italian, English, Dutch, Swedish, Spanish, Danish, 
German, Norwegian, Portuguese, Finnish, Faeroese, French

Stroke ISO 8859-1 (Latin1)
Icelandic, Irish, Italian, English, Dutch, Swedish, Spanish, Danish, 
German, Norwegian, Portuguese, Finnish, Faeroese, French

7-seg ISO 8859-1 (Latin1)
Displays number 0 to 9, alphabet character A to F, and symbols 
such as asterisk, plus, minus, and period only

Optional 
Fonts

Japanese large 
font
(first standard)

JIS level-1 kanji set
* Install this font to achieve a sharper display of enlarged JIS 
level-1 kanji set.
Refer to “High-quality Fonts” on page 2-9.

Japanese large 
font
(second standard)

JIS level-2 kanji set
* Install this font to achieve a sharper display of enlarged JIS 
level-2 kanji set.
Refer to “High-quality Fonts” on page 2-9.

Chinese GB2312 Chinese

Korean KSC5601 Korean

Taiwanese BIG5 Taiwanese

European large 
font

ISO 8859-1 (Latin1)
* Install this font to achieve a sharper display of enlarged 
European fonts.
Refer to “High-quality Fonts” on page 2-9.

Central European ANSI1250 Czech, Hungarian, Polish, Slovak, Slovene

Baltic ANSI1257 Estonian, Latvian, Lithuanian, Greenlandic, Lappish

Cyrillic ANSI1251 Bulgarian, Belarusian, Ukrainian, Serbian 2, Macedonian, Russian

The MICRO/I displays the single-byte parts of Chinese, Taiwanese, and Korean with ISO 8859-1, and 
supports Hangul characters only in the double-byte part of Korean.



WindO/I-NV4 User’s Manual 2-7

1 WindO/I-NV4 Specifications

2

W
indO

/I-N
V4 Features &

 Basic O
perations

Available Fonts for Parts

*1 To use a MICRO/I-installed font, the font should be downloaded from the WindO/I-NV4 in advance. Depending on parts and 
part setting, to the use of Stroke, European Outline, or 7-seg under “Font” may not be possible. For details, refer to the 
section on Parts.

*2 Windows font can be used for fixed text only. Only the MICRO/I-installed font can be used for the read device data code for 
the Message Display.

*3 Windows font can be used only when the “Use Text Manager” is selected.

Parts Description MICRO/I-installed Font*1 Windows Font

Buttons

Bit Button YES YES

Word Button YES YES

Goto Screen Button YES YES

Print Button YES YES

Key Button YES YES

Keypad YES YES

Selector Switch YES YES*3

Lamps
Pilot Lamp YES YES

Multi-State Lamp YES YES

Data Displays

Numerical Input YES NO

Character Input YES NO

Message Display YES YES*2*3

Message Switching Display YES YES*3

Alarm List Display YES YES*3

Alarm Log Display YES YES*3

Numerical Display YES NO

Calendar YES NO

Charts
Bar Chart YES YES*3

Line Chart YES YES*3
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Font Size

Example: When downloading Japanese large font (level-1 kanji set), Chinese, and European large fonts: 

Font Name Code System Size

Optional Fonts

Japanese large font (first standard) JIS level-1 kanji set 476KB

Japanese large font (second standard) JIS level-2 kanji set 423KB

Chinese GB2312 237KB

Korean KSC5601 108KB

Taiwanese BIG5 421KB

European large font ISO 8859-1 (Latin1) 101KB

Central European ANSI1250 5.25KB

Baltic ANSI1257 5.25KB

Cyrillic ANSI1251 5.25KB

The download size of font data is adjusted in multiples of 64KB.
The download size of font data is 64KB when the font size is 0KB or 64KB and smaller.

Font Size

Japanese large font (first standard) 476KB

Chinese 237KB

European large font 101KB

Total size of the font data: 814KB

Download size of font data: 832KB (814KB is adjusted in multiples of 64KB.)
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● High-quality Fonts
The high-quality fonts are the Japanese large fonts (first standard/second standard), and European fonts.
If you download high-quality fonts and select Use large font on the System tab in the Project Setting dialog box, the 
MICRO/I can replace some of the optional fonts with the high-quality fonts.
Scaled text with a background color is replaced and displayed with these fonts for a more attractive look.

High-quality European Font Display (Size 8x16)
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High-quality Japanese Font Display (Size 8x16)
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High-quality Japanese Font Display (Size 16x16)
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• When the high-quality fonts have not been downloaded into the operator interface, the Standard fonts 
are used even if “Use large font” is selected.

• When the Character Input part display font size is 8x16, high-quality fonts are not displayed even if “Use 
large font” is selected.
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● Windows Font
Selecting Windows Font for the Font property gives you access to all of the fonts installed on your computer for use 
on Drawing Objects and Parts. This allows you to display fonts and languages that are not installed on the MICRO/I.

Windows Font Settings

Windows Font settings are made in the Font Settings dialog box.

1 Click the Change button in the Windows Font group on the properties dialog box for Drawing Objects, Parts, or on 
the Text Manager.

2 Set each item and click the OK button.

■ Font
Select the font to use.

■ Font style
Select italic, bold, or other style.

■ Size
Select the size of the text.

■ Sample
Shows a preview using the specified font.

■ Script
Select the character set code.

• The right end of the text may have missing dots if Font style is set to Italic. You can remedy this by 
adding an extra space at the end of the line.

• An alternate font will be used if the Project Data uses a font that does not exist on the computer. This 
means that text will appear differently if the Project Data is opened on another computer.

• The same font may also appear differently for different OS versions.
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Using Windows Fonts

This section describes how to use Windows Fonts.

To register and use a Windows Font in Text Manager

1 Select the Use Text Manager check box on the Properties dialog box for Draw Objects and Parts.

• The Use Text Manager check box may appear in different locations depending on the part. This table shows 
where to find this property:

• The Alarm List Display and Alarm Log Display parts are designed to use the text registered in the Text Manager so 
the Use Text Manager check box is not shown.

2 Specify the Text ID for the Windows Font set in Text Manager.

Selecting Windows Font for the Font property for Draw Objects and Parts automatically disables these 
properties:

• Style: The style set under Windows Font will be used.

• Magnification: The width by height magnification will be set to 1 x 1. Note, Magnification can be 
selected on the Message Display, Message Switching Display, and Alarm List Display 
parts, but will not be reflected on the actual text displayed. To use scrolling on these 
parts, adjust the display area for text using the Magnification property.

Applicable 
draw object

Text

Applicable 
parts

Buttons
Bit Button, Word Button, Goto Screen Button, Print Button, Key Button, Keypad, Selector 
Switch

Lamps Pilot Lamp, Multi-State Lamp
Data Displays Message Display, Message Switching Display, Alarm List Display, Alarm Log Display
Charts Bar Chart, Line Chart

Part Location

Text Properties of Text dialog box

Bit Button, Word Button, Goto Screen Button, Print Button, Key Button, 
Selector Switch, Pilot Lamp, Multi-State Lamp

Registration Text tab

Keypad Properties of Keypad dialog box

Message Display General tab

Message Switching Display Message tab

Bar Chart, Line Chart Label tab

• Using the Text ID for the Windows Font set in Text Manager disables these settings in the Properties 
dialog box:

- Align Text: Multiple lines of texrot are shown aligned center-left when Center is selected. Text 
is shown with right-indented left-aligned when Right is selected.
With right-indented left-aligned formatting, the line containing the most number of 
characters is aligned on the right end while the other lines are aligned to the left 
end of that line.

- Vertical Writing: Horizontal writing is used.

• The maximum number for the unit in the Numerical Input and Numerical Display parts is 4 characters. 
The fifth character and any characters beyond that will appear outside the part.

• In the Message Display, variable text “\@” appears as is.
• With the Alarm List Display and Alarm Log Display, line spacing is not automatically adjusted based on 

the size of the text. Adjust it using the Line Spacing property on the Format tab.
• If text containing a carriage return is used for a label on a Bar or Line Chart, or for an Alarm List Display 

or Alarm Log Display part, it will appear truncated after the carriage return if a non-Windows Font is 
used. The entire text, including the carriage return, is shown when using a Windows Font.

• When printing Alarm Logs, Text IDs set to a Windows Font will be printed using a font that exists on the MICRO/I.

Aligns text to left end of line with most characters

Aligns text to right end of line with most characters
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To select a font in the Properties dialog box

Select Windows for Font on the Properties dialog box for a Draw Object or Part.
The Font property may appear in different locations depending on the part. This table shows where to find this 
property:

Applicable 
draw object

Text

Applicable 
parts

Buttons Bit Button, Word Button, Goto Screen Button, Print Button, Key Button, Keypad

Lamps Pilot Lamp, Multi-State Lamp

Part Location

Text Properties of Text dialog box

Bit Button, Word Button, Goto Screen Button, Print Button, Key Button, Pilot 
Lamp, Multi-State Lamp

Registration Text tab

Keypad Properties of Keypad dialog box
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● Character Code Table

Using the Character Code Table

Example: Finding the character code for the character “a” in the table.

The upper four bits of the code are hexadecimal 6.
The lower four bits of the code are hexadecimal 1.
Therefore, the character code for "a" is as follows.

Upper 4 bits of the code (hexadecimal)

Lower 4 bits of the code (hexadecimal)

Upper 4 bits

Lower 4 bits

"a " :  6 1

For other fonts and two-byte characters, refer to the table of the relevant code system.
Japanese (two-byte characters): JIS first standard/second standard, Chinese: GB2312, Taiwanese: BIG5, 
Korean (Hangul character): KSC5601
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European Font (ISO 8859-1)

Central European Font (ANSI 1250)
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Baltic Font (ANSI 1257)

Cyrillic Font (ANSI 1251)
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Japanese Font (JIS X0201)

Control Codes

Refer to the following table when using control codes in User Communications.
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1.3 Available Number of Colors

The available number of colors that can be used on the WindO/I-NV4 are listed below.

1.4 Available Image Files

The image file formats that can be displayed on the MICRO/I are as follows.

● About Picture Manager
Picture Manager is an application for managing pictures used for part diagrams and drawings. 
• When saving, deleting, or reducing pictures, the following operations are displayed in Picture Manager.

- On the View tab, in the Workspace group, click  (Picture Manager).
- Double click Picture Manager in the Project window.

• To set up the Picture from the Drawings, click on the editing screen where the Picture is positioned to display 
Picture Manager.

• If setting a graphic for a positioned object, display Picture Manager from the Properties dialog box.

*1 Color LCD models
*2 Monochrome LCD models

Model Target Number of colors

HG2G-5T*1
Picture Manager 65536 colors

Drawing objects and Properties sheet 256 colors

HG2G-5T*2
Picture Manager Monochrome (16 shades)

Drawing objects and Properties sheet Monochrome (16 shades)

File format Description

JPEG
Supports JPEG files that conform to the JPEG standard (ISO/IEC 10918-1, ITU-T Recommendation 
T.81) that adopt baseline DCT coding. The JFIF extension specification is not supported.

Bitmap
Supports monochrome bitmaps, 16-color bitmaps, 256-color bitmaps, and 24-bit bitmaps in which 
data is stored from the bottom up. Run-length encoding is only supported for 256-color bitmaps.

• The MICRO/I cannot handle image files that are larger than the size of the screen. Images that exceed 
the screen size are not displayed.

• The Numerical Input, Character Input, Message Display, Message Switching Display, Numerical Display, 
Calendar, and Meter cannot correctly display pictures that use a transparent color.

• IDEC recommends using bitmap image files when display speed is a priority. JPEG image files take more 
time to display on the MICRO/I than bitmap image files.
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● Saving pictures in Picture Manager
This section describes how to save drawing objects in Picture Manager. Saved pictures can be used for part diagrams 
and drawings.

Saving image files

1 Click Import in Picture Manager.

The Open dialog box is displayed.

2 Specify the image file, and then click Open.

When managing pictures by category, create a new category, and select it. To create a category, click 

Configure, and then click  (New Category) on the Category dialog box. For details, refer to “Category 
Dialog Box” on page 2-30.

Click Options to Apply Dithering or Color Exchange. For details, refer to “Open Dialog Box” on page 2-
29.
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The picture is saved in Picture Manager. The name of the image file becomes the picture name.

(Picture name)

Even when the image is saved to a different category, if a picture of the same name is already saved in that 
category, a confirmation message to overwrite the file is displayed.
• Click Yes to overwrite the image.

After overwriting, the image is saved in the list of the selected category, and the previous image is 
deleted from the list.
Example: The picture "Picture00" is saved in the category "Pic_Lib."

If the picture "Picture00.bmp" is saved to the category "NewBook1," the new image 
"Picture00" is saved to "NewBook1," and the image named "Picture00" that was previously in 
"Pic_Lib" is deleted.

• Click No to stop saving the picture.
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Selecting pictures from Symbol Factory

1 Click Symbol Factory in Picture Manager.
Symbol Factory is displayed.

2 Select a category of pictures from Categories.
A list showing pictures in the category selected from Symbols is displayed.

When managing pictures by category, create a new category, and select it. To create a category, click 

Configure, and then click  (New Category) on the Category dialog box. For details, refer to “Category 
Dialog Box” on page 2-30.

Click Options to display the Symbol Options dialog box, which can be used to modify fill color and 
background color, and to flip or rotate shapes. The settings made here are applied to all the pictures in 
Symbol Factory.



WindO/I-NV4 User’s Manual 2-23

1 WindO/I-NV4 Specifications

2

W
indO

/I-N
V4 Features &

 Basic O
perations

3 Select a picture from Symbols, and then click Copy.
The Picture Name Setting dialog box is displayed.

4 Enter the name of the graphic in Picture Name.

The maximum number is 256 characters.

5 Click OK.
The picture is saved in Picture Manager.

You cannot use the following characters in the picture name.
   \  / : , ; * ? " < > |

Click Options to Apply Dithering or Color Exchange. For details, refer to “Picture Name Setting dialog 
box” on page 2-34.

If a picture contains transparency or a picture is imported with the option of enabling the transparency, the 
transparency range is displayed in magenta (R: 255, G: 4, B: 255).
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Saving drawing objects drawn on the editing screen

Drawing objects drawn on the editing screen are saved as pictures, in NMF (NV Metafile) format in Picture Manager.

1 Select and right-click the drawing object, then click Copy to Picture Manager.

The Picture Name Setting dialog box is displayed.

2 Enter the name of the drawing object in Picture Name.

The maximum number is 256 characters.

Grouped drawing objects can be saved to Picture Manager as a single picture.

You cannot use the following characters in the picture name.
   \  / : , ; * ? " < > |

Click Options to Apply Dithering or Color Exchange. For details, refer to “Picture Name Setting dialog 
box” on page 2-34.
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3 Click OK.
The drawing object is saved in Picture Manager.

If a picture contains transparency or a picture is imported with the option of enabling the transparency, the 
transparency range is displayed in magenta (R: 255, G: 4, B: 255).
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● Saving pictures as image files
To use a picture saved in Picture Manager on another computer, save the picture as an image file.

1 Select a picture to export, and then click Export.

The Browse For Folder dialog box is displayed.

2 Select the folder to save, and then click OK.

• To select multiple pictures, press and hold SHIFT or CTRL while you click the specific items.
• To save as an image file in NMF (NV Metafile) format, select and right-click the drawing object drawn on 

the editing screen, then click Export as NV Metafile.
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● Picture Manager
Pictures used in pictures of part diagrams and drawings are managed using Picture Manager.

■  (Rename picture)
Renames the picture selected in the picture list. The maximum number is 256 characters.

■  (Delete)
Deletes the picture selected in the picture list. Pictures that are used in project or parts cannot be deleted.

■  (Reduce)
Deletes all the pictures not used in the project from the pictures saved in the picture list.

■  (Check All)
Selects all of the check boxes for the pictures registered to the picture list.

■  (Reset)
Clears all of the check boxes for the pictures registered to the picture list.

■  (Save Picture Files in External Memory Device)
Saves the image files for the pictures selected with the check boxes to external memory device.
Click this button to display the Select Drive dialog box.

■ (Category)
The name of the category is displayed.
Selects a category to save to when saving pictures.
When selecting a picture, select the category in which the arranged picture is saved.

The only default category is "Pic_Lib." To add a category, click Configure, and then click  (New Category) in the 
Category dialog box.

■ Configure
Opens the Category dialog box. You can add or change the category to save. For details, refer to “Category Dialog 
Box” on page 2-30.

(Picture List)

(Image)

(Picture Name)

(Check box)

You cannot use the following characters in the picture name.
   \  / : , ; * ? " < > |
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■ (Picture list)
The saved pictures are displayed as a list of images.

■ Import
Save pictures in Picture Manager. Click this button to display the Open dialog box. For details, refer to “Saving image 
files” on page 2-20.
Supported file formats are as follows. When selecting images that are in WMF or ICO file format, the image is 
converted to a bitmap before saving.
• BMP (bitmap file)
• WMF (Windows Metafile)
• JPEG
• ICO (icon files)
• NMF (NV Metafile)

■ Export
Saves a picture selected in the picture list in BMP (bitmap), JPEG, or NMF (NV Metafile) file format, according to file 
type. Click this button to display the Save As dialog box. For details, refer to “Saving pictures as image files” on page 
2-26.
Saved graphics can be saved using Import.

■ Symbol Factory
Display the Symbol Factory images. You can select an image provided by Symbol Factory on your project data. For 
details, refer to “Symbol Factory” on page 2-31.

■ Select
Closes Picture Manager and sets the picture selected in the picture list.

■ Close
Closes Picture Manager.

(Image): An image of the picture is displayed. If a picture contains transparency or a picture is imported 
with the option of enabling the transparency, the transparency range is displayed in magenta 
(R: 255, G: 4, B: 255).

(Picture Name): The name of the picture is displayed.
(Check box): Select this check box to save the picture data to external memory device and use it.

Click  (Write Picture Files to External Memory Device) to save the image files for the pictures 
selected with the check boxes to external memory device.

When the picture data is saved to external memory device, the amount of project data can be decreased, 
which allows you to save the internal memory on the MICRO/I. However, the display update rate of the 
pictures will become slower. To give priority to the display update rate, clear the check boxes.

If you place the cursor near an (Image) or (Picture Name), the size of the picture (width) x (height) and the 
file size (kilobytes) is displayed in a popup.
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Open Dialog Box

By clicking Options, you have the option to set the Apply Dithering and Color Exchange for the image to be 
registered in the Picture Manager.

■ Apply Dithering
Selects this check box to perform dithering (error diffusion method) on images.
This function enables some images with tonal gradations and photo-like pictures to be rendered more beautifully 
when they are saved. 

■ Color Exchange
Selects this check box to convert the color of the picture.

From: Specifies color before conversion. Click this button to display the Color Settings dialog box. Specify the color, 
and then click OK.

to: Selects the color after conversion (color: 256 colors, monochrome: 8 shades). Click this button to display the 
Color Palette. Select a color from the Color Palette. Transparent Color can also be selected.

If a color conversion to transparent is done when the monitor used for WindO/I-NV4 is a 16-bit color or 
256-color display, even colors other than the color specified in From may appear transparent. However, on 
the MICRO/I they will appear normally.
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Category Dialog Box

Manage the categories where pictures are registered.

■  (New Category)
Creates a new category in the Category List.
The default category name is "NewBookn" (n: Number).

■  (Delete Category)
Deletes a category from the Category List.

■  (Rename Category)
Changes the name of the category selected in the Category List. The maximum number is 256 characters.

■ (Category List)
The name of the category is displayed.

(Category List)

You cannot use the following characters in the category name.
   \  / : , ; * ? " < > |
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Symbol Factory

Symbol Factory is an English-version library tool that offers 5,000 images.

■ Preview
Image size (W×H in pixels) and preview of the picture are displayed.

■ Categories 
The images supplied by Symbol Factory are divided into categories. Selects categories of pictures saved in Picture 
Manager.

■ Symbols
The pictures in the selected category are displayed in a list. Selects a picture saved in Picture Manager.

■ Copy
Copy a picture selected from the Symbols to Picture Manager. Click this button to display the Picture Name Setting 
dialog box.

■ Options
Modify the fill and background color and flip or rotate shapes. Click this button to display the Symbol Options dialog 
box.

For details, see online help for Symbol Factory.



1 WindO/I-NV4 Specifications

2-32 WindO/I-NV4 User’s Manual

Symbol Options Dialog Box

Modify the fill color and background color, and to flip or rotate shapes. The settings made here are applied to all the 
pictures in Symbol Factory.

■ Fill Color

■ Orientation

Fill Color Mode: Select from the following picture color conversion methods.

Original: The color of the image is not changed.

Shaded: The image filled with different shades of the color selected in Fill Color (for a 3D 
effect).

Solid: The image is filled uniformly in the color selected in Fill Color.

Hollow: All color is deleted.

Fill Color: Selects the color used for Shaded or Solid modes. Click this button to display the Color Settings 
dialog box. Select a color from the Color Palette.
This option can only be set when Shaded or Solid are selected as the Fill Color Mode.

Shaded Solid HollowOriginal

Flip: Select from the following flipping methods.

None: The image is not flipped.

Horizontal: The image is flipped horizontally.

Vertical: The image is flipped vertically.

Both: The image is flipped both horizontally and vertically.

Horizontal Vertical BothNone
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■ Export Option

■ Defaults
Set options are returned to their default values.

Rotation: Select from the following rotation methods.

0: The image is not rotated.

90: The image is rotated 90° counterclockwise.

180: The image is rotated 180° counterclockwise.

270: The image is rotated 270° counterclockwise.

90 180 270None

Background Color: Selects the background color of the image when saving an image in Picture Manager or exporting 
an image using Export Symbol from the File menu. Click this button to display the Color 
Settings dialog box. Select a color from the Color Palette.

When exporting an image in VML or SVG format by clicking Export Symbol from the File menu, this 
setting is not applied. 
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Picture Name Setting dialog box

Specifies a name for images saved in Picture Manager.

■ (Image)
An image of the picture is displayed.

■ Picture Name
Enter a name for the picture. The maximum number is 256 characters.

■ Apply Dithering
Select this check box to perform dithering (error diffusion method) on images.
This function enables some images with tonal gradations and photo-like pictures to be rendered more beautifully 
when they are saved. 

■ Color Exchange
Select this check box to convert the color of the picture.

(Image)

You cannot use the following characters in the picture name.
   \  / : , ; * ? " < > |

From: Specifies color before conversion. Click this button to display the Color Settings dialog box. Specify the color, 
and then click OK.

to: Selects the color after conversion (color: 256 colors, monochrome: 8 shades). Click this button to display the 
Color Palette. Select a color from the Color Palette. Transparent Color can also be selected.

When the monitor used for WindO/I-NV4 is a 16-bit color or 256-color display, there is a risk that one or 
more of the following phenemona occurs.
• When a color conversion to transparent is done, even colors other than the color specified in From may 

appear transparent. However, on the MICRO/I they will appear normally.
• If converting a background color in Symbol Factory, an image that is copied to the clipboard may have its 

colors reduced to the number of colors displayed by the computer monitor. For this reason, the color 
setting will not match and the color conversion will not be performed.
Save the image again after changing the background color to another color in Symbol Factory.
For example, if the default color (R: 254, G: 254, B: 254) in From is used, and Background Color in 
Symbol Options dialog box is set to R: 254, G: 254, B: 254, the number of monitor colors will match, 
even if it's 256, so the color conversion will be performed.

To make the background color of the picture saved from Symbol Factory transparent, set From and 
Background Color in the Symbol Options dialog box to R: 254, G: 254, B: 254.
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2.1 Starting WindO/I-NV4

■ Windows 8
On the Start screen tiles, click WindOI-NV4.

■ Windows 7, Windows Vista
Click Start, click Programs, click Automation Organizer V2, click WindOI-NV4, and then click WindOI-NV4.

■ Windows XP
Click Start, click All Programs, click Automation Organizer V2, click WindOI-NV4, and then click WindOI-
NV4.

WindO/I-NV4 starts.

2 Starting and Exiting WindO/I-NV4

You can also start WindO/I-NV4 by double-clicking WindO/I-NV4 icon on the desktop.
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● Automation Organizer Updater dialog box
Automation Organizer Updater dialog box is a feature that keeps WindO/I-NV4 up to date.
If a new version of Automation Organizer is released, the Automation Organizer Updater dialog box is displayed when 
WindO/I-NV4 starts.

■ Available Updates

■ Description
This area shows the details of the latest changes in the software.

■ Preference
The Update Preference dialog box is displayed when this button is clicked.
To update information when WindO/I-NV4 starts, check this check box.
The Automation Organizer Updater dialog box will be displayed when there is an update.

■ Close
Closes the Automation Organizer Updater dialog box and start WindO/I-NV4.

In order to display the Automation Organizer Updater, your computer must be connected to the Internet.

Date Shows the date the software was released.
Information Shows the software's title and version.

Click on this link to connect to IDEC's download site.
The software can be updated by downloading and running the latest version.
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● Project Recovery dialog box
The Project Recovery dialog box is a feature to restore edited project data if your computer crashes while you were 
editing. With this feature, you can return crashed the project to its last-saved state and restore project data that was 
being edited. The Project Recovery dialog box is displayed if there is crashed project data when WindO/I-NV4 starts.

■ (Recovery data list)
This list shows recoverable data for a crashed project.

■ Recover
Select the recovery data from the list and click this button to open the project data. The recovery data is deleted 
when the project data is saved.

■ Delete
Deletes the selected recovery data.

■ Delete All
Deletes all recovery data.

■ Close
Closes the Project Recovery dialog box.
Recovery data is not deleted. The Project Recovery dialog box will be displayed again the next time WindO/I-NV4 
starts.

2.2 Exiting WindO/I-NV4

Click  and then click Exit WindO/I-NV4.

WindO/I-NV4 ends.

(Recovery data list)

Project Name: Shows the project name.

Last Save Time: Shows the date and time when the data was last saved.

If WindO/I-NV4 crashes in a state where you edit a screen and perform Save Screens after saving the 
project data, the screen is not saved in the project data. Select the recovery data with the Project Recovery 
dialog box and recover the project data.
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This section describes the names and functions that make up WindO/I-NV4.

■ Title bar
The title bar shows the name of the project being edited and the name of this software, “WindO/I-NV4”.

■ Application menu
The application menu displays commands for handling project data such as commands for creating new project data, 
opening project data, and saving project data. For details, refer to “3.1 Application Menu Command List” on page 2-
39.

■ Quick access toolbar
The quick access toolbar is an area where you can locate commands that you use frequently. You can customize this 
toolbar by adding or deleting buttons. For details, refer to “3.2 Quick Access Toolbar” on page 2-40.

■ Ribbon
The ribbon shows commands for creating project data and transferring data to the MICRO/I. Common commands are 
separated into their own tabs, so you can quickly execute. For details, refer to “3.3 Ribbon Command List” on page 2-
43.

■ Workspace
The workspace is the area where the Project window, the Object List window, the Screen List window, the Part 
List window, and the Toolbox window are located. You can change the position and method for displaying windows 
in the workspace. For details, refer to “3.4 Windows Displayed in the Workspace” on page 2-51.

■ Editing window
The editing window is the area for editing Base Screens and Popup Screens.

■ Right click menu
The right click menu is a popup menu that is displayed when right clicking the mouse on drawing objects and parts in 
a list. It displays context sensitive commands.

■ Status bar
The status bar shows information such as the O/I type, communication driver, project data size, and cursor position. 
You can change the items displayed on the status bar. For details, refer to “3.5 Status Bar” on page 2-54.

3 Configuration & Functions

Ribbon

Title bar

Workspace

Editing window

Right click menu

Status bar

Quick access toolbar

Application menu



WindO/I-NV4 User’s Manual 2-39

3 Configuration & Functions

2

W
indO

/I-N
V4 Features &

 Basic O
perations

3.1 Application Menu Command List

Commands that can be executed from the application button are listed below.

Command Description

New Creates project data by configuring settings displayed in dialog boxes step by step.

Open Opens project data that has already been created.

Save Saves the project data being edited.

Save As Saves the project data being edited with a new name.

Close Closes the project data being edited.

Recent Projects Shows the list of recently used project data, up to a maximum of ten items.

WindO/I-NV4 Options Customizes WindO/I-NV4 and configures the work environment.

Exit WindO/I-NV4 Exits WindO/I-NV4.
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3.2 Quick Access Toolbar

● Quick access toolbar buttons and menus
Click on a quick access toolbar button or click on ▼ to the right of a button and then click on the displayed command 
to execute that command.

● Customizing the quick access toolbar

If you click the  (Customize Quick Access Toolbar) button, the Customize Quick Access Toolbar menu is displayed.

You can change the quick access toolbar to any desired settings.

■ Changing the buttons displayed on the quick access toolbar
Check only the buttons you wish to display on the quick access toolbar.

■ More Commands
You can add or delete quick access toolbar commands.

1 Click the  button on the quick access toolbar and then click More Commands.

The Customize on the WindO/I-NV4 Options dialog box is displayed.

Quick access toolbar
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2 Add or delete commands.

To add a command
1 Select the command to add in Choose commands from.
2 Click on the command to add from the list and then click the Add>> button.

The command is added.

To delete a command
Click the command to delete and then click the Remove button.
The command is deleted.

■ Show below the Ribbon
You can change the position of the quick access toolbar to be located below the ribbon.

Click the  button on the quick access toolbar and then click Show below the Ribbon.

• If you right click a command on the quick access toolbar and click Remove from Quick Access 
Toolbar, that quick access toolbar command can be deleted.

• To change the order of the commands, drag and drop a command.
• To return to the quick access toolbar to its default settings, click the Reset button.
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The quick access toolbar moves below the ribbon.

To return the quick access toolbar to its original position, click the  button and then click Show above the Ribbon.

■ Minimize the Ribbon
You can change the format of the ribbon to be displayed only as tabs.

Click the  button on the quick access toolbar and then click Minimize the Ribbon.

The ribbon is displayed as only tabs.

Click on a tab to display its commands.

To return the ribbon to its original state, click the  button and then click on the Maximize the Ribbon.

You can also change the quick access toolbar display position to be below the ribbon with the following 
methods.
• Right click the quick access toolbar or the ribbon and then click Show below the Ribbon.
• Select the Show Quick Access Toolbar below the Ribbon check box on the Customize on the 

WindO/I-NV4 Options dialog box.

You can also return the quick access toolbar to its original position with the following methods.
• Right click the quick access toolbar or the ribbon and then click Show above the Ribbon.
• Select the Show Quick Access Toolbar below the Ribbon check box on the Customize on the 

WindO/I-NV4 Options dialog box.

You can also change the ribbon to be displayed as only tabs with the following methods.
• Right click the quick access toolbar or the ribbon and then click Minimize the Ribbon when switching to 

the tab only display, or click Maximize the Ribbon when returning to the original state.
• Double click a tab.
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3.3 Ribbon Command List

● Home
Home is where basic operations are performed such as creating a new screen, editing, and downloading project data.

■ Clipboard

■ Screens

■ Drawings

Command Description

Paste Pastes the contents of the clipboard.

Cut Cuts the selected object from the editing window and copies it to the clipboard.

Copy Copies the selected object to the clipboard.

Duplicate Duplicates the selected object.

Command Description

New
Base Screen Adds a new Base Screen.

Popup Screen Adds a new Popup Screen.

Open
Base Screen Opens a Base Screen that has already been created.

Popup Screen Opens a Popup Screen that has already been created.

Open Previous Screen Opens a screen number before the currently selected screen.

Open Next Screen Opens a screen number after the currently selected screen.

Delete Deletes the selected screen.

Reuse Copies another project’s screens.

Command Description

Shapes

Line Draws a line.

Polyline Draws a polyline.

Polygon Draws a polygon.

Rectangle Draws a rectangle.

Circle/Ellipse Draws a circle or ellipse.

Arc Draws an arc.

Pie Draws a pie.

Equilateral Polygons
Draws equilateral polygons (equilateral triangle, equilateral diamond, equilateral 
pentagon, equilateral hexagon, equilateral octagon).

Fill
Fills the region with the same color as the fill start point with the specified color 
and pattern.

Picture Inserts a picture.

Text Inserts text.
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■ Parts

Command Description

Buttons

Bit Button Inserts a Bit Button.

Word Button Inserts a Word Button.

Goto Screen Button Inserts a Goto Screen Button.

Print Button Inserts a Print Button.

Key Button Inserts a Key Button.

Multi-Button Inserts a Multi-Button.

Keypad Inserts a Keypad.

Selector Switch Inserts a Selector Switch.

Potentiometer Inserts a Potentiometer.

Lamps
Pilot Lamp Inserts a Pilot Lamp.

Multi-State Lamp Inserts a Multi-State Lamp.

Data Displays

Numerical Input Inserts a Numerical Input.

Character Input Inserts a Character Input.

Picture Display Inserts a Picture Display.

Message Display Inserts a Message Display.

Message Switching Display Inserts a Message Switching Display.

Alarm List Display Inserts an Alarm List Display.

Alarm Log Display Inserts an Alarm Log Display.

Numerical Display Inserts a Numerical Display.

Calendar Inserts a Calendar.

Charts

Bar Chart Inserts a Bar Chart.

Line Chart Inserts a Line Chart.

Pie Chart Inserts a Pie Chart.

Meter Inserts a Meter.

Commands

Bit Write Command Inserts a Bit Write Command.

Word Write Command Inserts a Word Write Command.

Goto Screen Command Inserts a Goto Screen Command.

Print Command Inserts a Print Command.

Script Command Inserts a Script Command.

Multi-Command Inserts a Multi-Command.

Timer Inserts a Timer.
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■ Editing

■ Project

Command Description

Arrange

Bring to Front Moves the selected object to the front.

Send to Back Moves the selected object to the back.

Group Groups multiple objects.

Ungroup Cancels the group.

Align

Align Left Aligns selected objects to the left.

Align Center Aligns selected objects to the center.

Align Right Aligns selected objects to the right.

Align Top Aligns selected objects to the top.

Align Middle Aligns selected objects to the middle.

Align Bottom Aligns selected objects to the bottom.

Make Horizontal 
Spacing Equal

Aligns selected objects to be equally spaced horizontally.

Make Vertical Spacing 
Equal

Aligns selected objects to be equally spaced vertically.

Rotate

Rotate Right 90° Rotates selected drawing objects 90° to the right.

Rotate Left 90° Rotates selected drawing objects 90° to the left.

Flip Vertical Flips selected drawing objects vertically.

Flip Horizontal Flips selected drawing objects horizontally.

Replace
Automatically replaces a specified device address with a separate device 
address.

Select Selects objects in the editing window.

AutoResize Automatically changes the text size to the object’s size and display region.

Increment Address
Enables or disables the increment address function.
A specific value is added to the value of the object’s device address when 
pasting and duplicating parts.

Command Description

Download

Project Data Downloads project data to the MICRO/I.

Files to External Memory 
Device

Stops the MICRO/I and then downloads files to the external memory 
device inserted in the MICRO/I. The MICRO/I resumes running when files 
have finished downloading.

Files to External Memory 
Device while running

Downloads files to the external memory device inserted in the MICRO/I 
without stopping it.

Upload
Project Data Uploads project data from the MICRO/I.

Stored Data in External 
Memory Device

Uploads data from the External Memory Device folder for the currently 
running project.

Compare
Compare Projects

Compares the screen data and scripts in an existing project with the 
project data currently being edited and displays the results of that 
comparison.

Re-verify Updates the comparison results to the most latest state.

Target Info.
Displays version information for the MICRO/I system software and project 
information.

Comm.Setup
Configures the communication target and communication conditions 
between the target and the MICRO/I or between the computer and the 
MICRO/I.
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● Configuration
Configuration is where you configure the system settings for the MICRO/I that will use the project data being edited.

■ System Setup

■ Protect

● Online
Online is where you download created project data and files to the MICRO/I, where you upload data from the 
MICRO/I, and where you perform monitoring.

■ Transfer

■ MICRO/I

Command Description

Project Configures MICRO/I operations and functions.

Alarm Log Configures the alarm log.

Data Log Configures the data log.

Operation Log Configures the operation log.

Data Storage Area Changes the allocation of the data storage area.

Preventive Maintenance Configures the preventative maintenance function.

Recipe Configures recipes.

Global Script Configures one global script.

Command Description

User Accounts Configures security function, user accounts, and passwords.

Command Description

Download

Project Data Downloads project data to the MICRO/I.

Files to External Memory Device
Stops the MICRO/I and then downloads files to the external memory 
device inserted in the MICRO/I. The MICRO/I resumes running when 
files have finished downloading.

Files to External Memory Device 
while running

Downloads files to the external memory device inserted in the 
MICRO/I without stopping it.

Upload

Project Data Uploads project data from the MICRO/I.

Stored Data in External Memory 
Device

Uploads data from the External Memory Device folder for the 
currently running project.

Command Description

Target Info.
Displays version information for the MICRO/I system software and project 
information.

Clear

All Clears all of the data stored in the internal memory on the MICRO/I.

Alarm Log Data Clears all of the alarm log data stored in the internal memory on the MICRO/I.

Data Log Data Clears all of the data log data stored in the internal memory on the MICRO/I.

Operation Log Data Clears all of the operation log data stored in the internal memory on the MICRO/I.

Values from All Device 
Addresses

Clears the values from all device addresses.

Stored Data in External 
Memory Device

Clears data saved to the external memory device inserted in the MICRO/I.

Format Formats the external memory device inserted in the MICRO/I.
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■ Monitors

■ Communication

Command Description

Start/Stop Monitor
Starts or stops monitoring the MICRO/I with WindO/I-NV4. An external 
device is required when configuring it.

Go offline/Go online
Switch the MICRO/I to Offline Mode or Online Mode. Under Offline Mode, you 
can change values of device addresses with WindO/I-NV4 and check the 
operation of project data on the MICRO/I.

Screens Shows or hides the Screen Monitor window.

Object List
Displays a value of device address in a popup and emphasizes the object that 
is satisfying the trigger condition in the object list or script editor.

Custom Shows or hides the Custom Monitor window.

Batch Shows or hides the Batch Monitor window.

External Devices
Shows or hides the External Device Monitor window during 1:N 
communication.

Back
Returns to the Base Screen that was displayed immediately before the screen 
was changed.

Forward
Advances to the Base Screen that was displayed immediately before the 
screen was changed with the Back command.

Go to Screen

First Screen Switches to the Base Screen with the smallest screen number in the project data.

Previous Screen
Switches to the Base Screen with a screen number one smaller than the Base 
Screen currently displayed. If the screen numbers are not consecutive 
numbers, this command switches to the closest number.

Screen Number Switches to the Base Screen with a specified number.

Next Screen
Switches to the Base Screen with a screen number one larger than the Base 
Screen currently displayed. If the screen numbers are not consecutive 
numbers, this command switches to the closest number.

Last Screen
Switches to the Base Screen with the largest screen number in the project 
data.

Open Current Screens Opens a monitored screen in the editing window.

Command Description

Setup
Configures the communication target and communication conditions between 
the target and the MICRO/I or between the computer and the MICRO/I.
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● View
View is where you can switch the workspace display and display the Tag Editor, Screen Diagram, and various 
managers.
You can configure the items displayed in the editing window.

■ Workspace

■ Show/Hide

Command Description

Toolbox Shows the Toolbox window. This window displays Parts and Drawings.

Project Window
Shows the Project window. This window displays the saved screens and project 
related information.

Screen List
Shows the Screen List window. The window displays the screens saved in the 
project as thumbnails.

Object List
Shows the Object List window. This window displays all of the graphics and parts 
placed in an editing screen.

Part List Shows the Part List window. This window displays the list of part images.

Tag Editor
Shows the Tag Editor. This window displays the list of registered device address, tag 
name, and comments.

Screen Diagram

Shows the Screen Diagram. This window displays the Overlapping Screen 
information, and the screen numbers and titles of the screens linked by the Goto 
Screen Button, the Goto Screen Command, the Numerical Input, the Character 
Input, the Alarm List Display and the Alarm Log Display.

Comparison Result
Shows the Comparison Result window. This window displays the results of that 
comparison of projects.

Picture Manager Shows the Picture Manager. Manages the registered images for project use.

Text Manager
Shows the Text Manager. Manages registered text which can be used for Text, Part 
objects, title of Popup Screen, messages with Alarm List Display and Alarm Log 
Display.

Script Manager Shows the Script Manager. Manages registered scripts for project use.

Protocol Manager Shows the Protocol Manager. Manages protocols created.

Command Description

Part Name Shows or hides drawing object names and part names.

Device Address Shows or hides device addresses and tag names.

Trigger Condition Shows or hides trigger conditions.

Commands Shows or hides the dotted frame for commands.

Popup Screen
Shows or hides a Popup Screen’s number, display frame, and the part name of the 
part calling that Popup Screen.

Overlay Screens Shows or hides the configured overlay screens.

Top Layer Shows or hides drawing objects and parts placed on the top layer.

Security Group
Display Shows or hides the display security group set for parts.

Input Shows or hides the input security group set for parts.

Gridlines Shows or hides the gridlines in the editing window.
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■ Screens

■ Zoom

■ Window

● Format
Format is where you change the style of drawing objects, arrange objects, and change their size.

■ Shape Style

■ Text Style

Command Description

Focus Order Changes the order to move the focus with Numerical Input and Character Input.

State

Reset Returns the displayed images to the default images.

ON/OFF State Switches between the ON image and the OFF image for buttons and lamps.

Previous State Changes the image for the displayed part to the previous state.

State Number
Changes the image for the displayed part to the image for the part with the 
specified number.

Next State Changes the image for the displayed part to the next state.

Text Group Changes the displayed text to the text of the specified text group.

Active User Displays only the parts that correspond to the specified user.

Command Description

Zoom Changes the magnification of the editing window.

Command Description

Close All Closes all editing windows.

Command Description

1 dot Sets the line width to one dot.

2 dots Sets the line width to two dots.

3 dots Sets the line width to three dots.

5 dots Sets the line width to five dots.

Solid Sets the line to solid.

Dot Sets the line to dotted.

Dash Sets the line to dashes.

Long Dash Sets the line to long dashes.

Long Dash Dot Sets the line to long dash dot.

Long Dash Dot Dot Sets the line to long dash dot dot.

Pattern Changes the pattern.

Foreground Color Changes the pattern’s foreground color.

Background Color Changes the pattern’s background color.

Command Description

Regular Sets the text style to regular.

Bold Sets the text style to bold.

Shadow Gives the text a shadow.

Text Color Changes the text color.

Text Background Color Displays the text as if it were highlighted with a highlighter.

Shadow Color Changes the color of the shadow added to text given a shadow.
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■ Arrange

■ Size

Command Description

X-coordinate Changes the X-coordinate of the selected object.

Y-coordinate Changes the Y-coordinate of the selected object.

Bring to Front Moves selected object to the front.

Send to Back Moves selected object to the back.

Group Groups selected objects so they can be handled as a single object.

Ungroup Restores a grouped object to its individual objects.

Rotate Right 90° Rotates selected objects right 90°.

Rotate Left 90° Rotates selected objects left 90°.

Flip Vertical Vertically flips selected objects.

Flip Horizontal Horizontally flips selected objects.

Align Left Aligns selected objects to the left.

Align Center Aligns selected objects to the center.

Align Right Aligns selected objects to the right.

Align Top Aligns selected objects to the top.

Align Middle Aligns selected objects to the middle.

Align Bottom Aligns selected objects to the bottom.

Make Horizontal Spacing 
Equal

Arranges selected objects to be equally spaced horizontally.

Make Vertical Spacing 
Equal

Arranges selected objects to be equally spaced vertically.

Command Description

Width Changes the width of the selected object.

Height Changes the height of the selected object.

Make Same Width Makes the selected objects a uniform width.

Make Same Height Makes the selected objects a uniform height.
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3.4 Windows Displayed in the Workspace

● Changing the position of windows

Disabling docking

You can change the display position of the window by dragging and dropping the title bar of the window or its tab to 
disable docking. Windows that are not docked are called floating windows.
• If you drag the title bar of the workspace window, you can move all the docked windows together.

• If you drag the tab of a workspace window, you can move just the selected window.

Docking windows

You can dock a floating window to WindO/I-NV4’s left, right, top, or bottom frame or a separate window.

1 Drag the window’s title bar or tab.

The  (Docking) icon is displayed.

Drag and drop

Title bar

Drag and drop

Tab
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2 Drop the title bar or tab on the  (Docking) icon to dock that window to WindO/I-NV4’s left, right, top, or bottom 
frame or a separate window.

• If the workspace window is dropped on the  icon, it is docked to WindO/I-NV4’s left, right, top, or bottom 

frame.

• If a floating window is dropped on the  (Docking) icon, it is docked to WindO/I-NV4’s left, right, top, or bottom 

frame or a docked window.

When the mouse cursor gets close to a  (Docking) icon while dragging the title bar or tab, the location 
to dock the window is displayed.

Window docking 
location
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• If you put the mouse cursor on another window while dragging a floating windows title bar, the  (Docking) icon 

is displayed. Drop the title bar on the  (Docking) icon to dock the floating window to that window. Change the 
displayed window with the tabs.

● Changing the display method of windows

Auto Hide

If the workspace window is docked, you can change the widow to automatically hide and show only its tabs.

Click the  (Auto Hide) icon to change the window to show only its tabs.

The window is displayed when you bring the mouse cursor close to the tabs.

Auto Hide icon Tabs

Mouse cursor

• Click  (Auto Hide) to secure the window in place.

• Click  (Close) to close the window.
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3.5 Status Bar

● Status bar items

■ Mode
This section of the status bar shows WindO/I-NV4’s current mode.

■ Type Number
This section of the status bar shows the MICRO/I type set in the project data being edited.

■ Communication Driver
This section of the status bar shows the communication driver set in the project data being edited.

■ Data Size
This section of the status bar shows the download data file size for the project data being edited.
When you save the project, the display is updated with the latest information.

■ Position
This section of the status bar shows the X- and Y-coordinates of the mouse cursor in the editing window.

■ Text Group
This section of the status bar shows the current text group. The text displayed in the editing window changes 
according to the displayed text group.

To change the text group, click ▼ and select the text group.

■ Active User
This section of the status bar shows the active user. You can hide or show objects in the editing window according to 
the security group of the displayed user.

To change the active user, click ▼ and select the user.

Mode

Type Number Communication Driver

Data Size

Position

Text Group

Active User

Snap to Grid

Grid Settings

Preview

Zoom

Zoom Slider

Zoom Out button
Zoom In button
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■ Snap to Grid

Click  to align objects to the grid.

■ Grid Settings
You can change the style and spacing of the grid displayed in the editing window.

Click  to display the Grid Settings dialog box. Configure the items and click the OK button.

Type: Selects the type of grid.
Touch Panel: Aligns the grid to the touch panels.
Other: Aligns the grid to the specified spacing.

Enter the spacing for the grid in Horizontal and Vertical.
Style: Select the grid style with Dot or Line.
Color: Select the grid color (color: 256 colors, monochrome: 16 shades).

Click this button to open the color palette. Select the color with the color palette.



3 Configuration & Functions

2-56 WindO/I-NV4 User’s Manual

■ Preview
You can preview an edited screen.

Click  to open the preview window.

Click the  button to switch between the OFF image and ON image for buttons and lamps.

You can save the image displayed in the preview window as a bitmap image file by clicking the Copy button.

■ Zoom
Zoom shows the magnification of the editing window.
You can zoom in and zoom out by specifying the magnification.

1 Click Zoom on the status bar.
The Zoom dialog box is displayed.

2 Specifying the zoom magnification (50% to 400%) and click OK.

● Customizing the status bar
You can change the commands displayed on the status bar.
Right click the status bar and check only the commands you wish to display on the status bar.

The preview display and the actual screen displayed on the MICRO/I may differ.
For example, the image for overlay screens in the preview display is always shown in front. However, when 
drawing objects and parts overlap on the actual screen, parts are always shown in front irregardless of the 
order of overlay screens.

You can also specify the zoom magnification by dragging the zoom slider or clicking the  button and 

the  button.
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4.1 Configuring the Work Environment

You can configure WindO/I-NV4 settings such as mode and options when editing screens, the path when selecting 
files, and the path for automatic backups. The settings configured here are saved even when you exit WindO/I-NV4.
The procedure for configuring the work environment is shown below.

1 Click  and then click WindO/I-NV4 Options.

The WindO/I-NV4 Options dialog box is displayed.

2 Change the settings on each tab as desired.

4 Customizing WindO/I-NV4
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● General Settings Tab

■ Properties
Select whether or not to display the Properties dialog box for parts in the Advanced mode.

■ Editing

■ Bit Number Symbol
Select the separator for address numbers and bit numbers. When manually entering device address, you can enter 
either separator, but they will be displayed using the symbol selected here.

Basic: Displays the Properties dialog box in Basic mode to use only basic functions.

Advanced: Displays the Properties dialog box in Advanced mode so that all functions can be used.

You can also change the mode by clicking on the Advanced button and the Basic button in the Properties 
dialog box for parts.

Enable Increment Address Number: When copying or duplicating parts, select this check box to add a specified 
value (-999 to 999) to address number of the device address set for the 
original part before pasting it to the screen.

Enable Text Auto Resizing: Select this box to automatically change the text size according to a change in 
part size.

Auto-change IME: Select this box to enter characters other than alphanumeric characters using 
the input method editor (IME) in text boxes for entering device addresses.

You cannot enter full-width characters in text boxes that only accept alphanumeric input, even if the IME is 
enabled.
Select this box to use full-width characters in tag names in the device address settings.

Dot (WindLDR Format): Separates the address number and bit number with a dot.
Example: D100.00

Dash (WindO/I-NV4 Format): Separates the address number and bit number with a dash.
Example: D100-0
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■ Workspace

■ Compatibility

● Save tab

■ Save Project

Workspace Setup: Displays the Workspace Setup dialog box. You can configure items displayed in 
the workspace window. For details, refer to “4.2 Customizing the Workspace” 
on page 2-62

Use Compatible functions from 
previous version:

Select this box to enable functions from previous versions. For details, refer to 
Chapter 4 “3.13 Compatible Tab” on page 4-43.

Use HG1B Compatible functions: Select this box to enable previous functions (HG1B). For details, refer to 
Chapter 4 “3.13 Compatible Tab” on page 4-43.

Save AutoRecover information every: Select this check box to automatically backup the project data at 
regular intervals (5 to 60 minutes).
Backup data is deleted when the project data is closed.

Default file location: Specify the default folder to save the project data.
Click Browse to display the Browse For Folder dialog box. Select a 
folder and click the OK button.
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● Customize tab

■ Choose commands from
Select the category of command to add. A list of commands for selected category is displayed.

■ Show Quick Access Toolbar below the Ribbon
To change the position of the quick access toolbar to be located below the ribbon, select this check box.

■ Add>>
Add a command to the Customizing the quick access toolbar list.

■ Remove
Delete a command from the Customizing the quick access toolbar list.

■ Customize Quick Access Toolbar
Shows the list of commands displayed on the quick access toolbar.

■ Reset
Returns the settings of the quick access toolbar to their default.

To change the order of the commands, drag and drop a command.

For details about the quick access toolbar, refer to “3.2 Quick Access Toolbar” on page 2-40.
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● Resources Tab

■ Get updates

■ Go to IDEC

■ About WindO/I-NV4

Check for Updates: This function will check for any updates.
If a new version of Automation Organizer is released, the Automation Organizer Updater 
dialog box is displayed.
For details, refer to “Automation Organizer Updater dialog box” on page 2-36.

Go online: Shows the IDEC web page for free updates, manuals, and online services.

About: Shows the About WindO/I-NV4 dialog box and displays the version of WindO/I-NV4.

In order to display the Automation Organizer Updater, your computer must be connected to the Internet.
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4.2 Customizing the Workspace

You can change the windows that are displayed in the workspace with the Workspace Setup dialog box.

● Screen List tab
This tab changes the Screen List window display.

■ Zoom
Select the zoom magnification for the thumbnails displayed in the Screen List window from the following.
100, 125, 150, 175, 200, 250, 300, 350, 400

● Object List tab
This tab changes the items displayed in the Object List window.

■ List Items
Shows the list of items that can be displayed in the Object List window.

■ Add
Adds an item to Display Items.
Select an item in List Items and click this button to add it to Display Items.

■ Delete
Deletes an item from Display Items.
Select an item in Display Items and click this button.

■ Display Items
Shows the list of items that are displayed in the Object List window.

■ Up
Shifts the selected item upward in the Display Items list.

■ Down
Shifts the selected item downward in the Display Items list.
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● Parts List tab
This tab changes the items displayed in the Part List window.

■ Show Image Name
Select this box to display the image name for parts in the Part List window.



5 WindO/I-NV4 Common Operations and Settings

2-64 WindO/I-NV4 User’s Manual

  

This section describes common settings when creating project data.

5.1 Device Address Settings

Device addresses are memory on the MICRO/I and external devices that can store values in bit or word units.
By setting device addresses to parts and functions, you can control the screen display and operation of parts.
Device addresses are specified by combining the device type and address number in the following formats.

The device address can be directly entered or it can be set with the Tag Editor.

● Direct entry
Enter a device address with the keyboard following the basic format.
To enter the bit (0 to 15) for a word device, enter the address number, the bit number separator “.” or “-”, and the bit. 
You can enter the address with either separator, but it is displayed according to the Bit Number Symbol setting. Bit 
Number Symbol is set on the General tab of the WindO/I-NV4 Options dialog box.

● Specifying a device address with the Tag Editor
To display the Tag Editor, click  to the right of the text box for setting the device address. Use this Tag Editor to set 
the device address. 

■ Target
Select the device that includes the device address that will be set from MICRO/I or External Device (External 
Device ID): (External Device Name).
You can configure the External Device ID and the external device name in the Communications Driver Network 
tab on the Project Settings dialog box. For details, refer to Chapter 4 “3.4 Communication Driver Network Tab” on 
page 4-31.

■ Device Type
Select the device type.
The list only shows device types that can be used. This is blank if an external device that has not been configured is 
selected for Target in the Communications Driver Network tab on the Project Settings dialog box.

■ Address Number
Specify the address number. The range that can be set differs according to the device type selected.

5 WindO/I-NV4 Common Operations and Settings

 Bit numberDevice type Address number .Dot (WindLDR Format):

 Bit numberDevice type Address number -Dash (WindO/I-NV4 Format):

Address number and bit number separator

(Toolbar)

(Address number list)
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■ Bit Number
Specify the bit (0 to 15) of the word device when a word device is selected in Device Type.

■ Show
Select from the following and display the device addresses on the (Address list): This is blank if an external device 
that has not been configured is selected for Target in the Communications Driver Network tab on the Project 
Settings dialog box.

■ (Toolbar)

■ (Address number list)
Displays a list of device addresses that match the specified condition.

All Address Number: Displays all of the device addresses that can be used with the device selected in Target.

Used Address Number: Displays only the device addresses that are used in the active project data.

Unused Address Number: Displays only the device addresses that are not used in the active project data.

 (Cut): Cuts the selected tag name or comment from (Address number list) and copies it to the 
clipboard.

 (Copy): Copies the selected tag name or comment to the clipboard.

 (Paste): Pastes the contents of the clipboard.

 (Delete): Deletes the selected tag name or comment.

 (Import): Shows the Open dialog box.
Select a file with exported tag names and comments (CSV file), and then click Open to 
collectively overwrite (Address number list) with the tag names and comments in the 
selected file.

 (Export): Displays the Export dialog box.
Select the location to save the file, enter a file name, and then click Save to save the tag 
names and comments of (Address number list) as a CSV file.

 (Cross Reference): Shows the Cross Reference dialog box.

 (Refresh): Updates the Use column on the Tag Editor.

Device Address: Displays the device addresses of the selected Device Type.

Tag Name: Displays the tag name of the address number.

Comment: Displays the comment of the address number.

Used: Displays how many times each address number has used.

The device addresses of the MICRO/I and external devices are collectively managed in Tag Editor. Tag Editor 
can be displayed with the following procedures.

• On the View tab, in the Workspace group, click  (Tag Editor).
• Double click Tag Editor in the Project window.
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Allen-Bradley address settings

In Tag Editor displayed by clicking  for device address setting,  is displayed next to the Address Number text 
box. Click this button to display the Address Number Setting for Allen-Bradley dialog box. With this dialog box, you 
can easily enter the device address following Allen-Bradley PLC address number notation.
This can only be set if Communication Driver is not Ethernet/IP(Logix Native Tag) and Expression of 
Device Address Format is Allen-Bradley.

For the other settings, see the WindO/I-NV4 External Device Setup Manual.

Device Type: Shows the device type selected in the Tag Editor.
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5.2 Setting Conditional Expressions

Specify conditional expressions with Condition on the Trigger Condition tab.
Conditional expressions are specified by combining data and operators using the following basic format.

Directly enter the conditional expression or specify it with the Trigger Conditions Settings dialog box.

● Direct entry
Enter the conditional expression with the keyboard.
• There is no limit on data or operators. However, the maximum number is 480 characters.

• To enter a device address for data, always enclose it with “[” and “]”.
    Example: [LDR 100] == 10
• To flip bits, enter “~” before the data.
• Parentheses “(” and “)” can be used.

• Operator priority is the same as scripts. For details, refer to Chapter 20 “6.3 About the Priority of the Operator” on 
page 20-55.

● Configuring conditional expressions with the Trigger Condition Settings dialog box
You can easily configure a basic conditional expression using the Trigger Condition Settings dialog box.
• Up to a maximum of five items of data can be used.

• To flip the bits in data, select the Not check box.
• Operator priority is the same as scripts. For details, refer to Chapter 20 “6.3 About the Priority of the Operator” on 

page 20-55.

1 Click the Condition  button to display the Trigger Condition Settings dialog box.

2 Click Value or Device Address and enter a value or device address.

To flip the bits in data, select the Not check box.

3 Select the operator.

4 Click the next Value or Device Address and enter a value or device address.

To flip the bits in data, select the Not check box.

5 Repeat steps 3 and 4 for the necessary number of conditions.

OperatorData Data

... (within 480 characters)

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data Operator Data

OperatorData Data Operator OperatorData Data )()(

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data

If you display the Trigger Condition Settings dialog box after directly entering a conditional expression, that 
expression will be reflected in the dialog box. However, if you entered an expression that cannot be 
reflected, the portion of the expression that could not be reflected is deleted when you click the OK button 
and close the Trigger Condition Settings dialog box.
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● Data and operations that can be configured
Data
You can specify these types and values of data for conditional expressions.

Operators
Specify the type of arithmetic operation to execute on the data. (In the table below,  indicates the operator’s left-
hand number,  indicates the right-hand number.)

*1 1 if satisfied, 0 if not satisfied.

Item Description

Value
Set a constant number as data.
The range that can be set differs according to the selected data type.
For details, refer to “Data types” on page 2-1.

Device Address Set a device address for a bit device or a word device that stores the value to be handled as data.

Operator Details

Supported 
device

Bit 
device

Word 
device

Arithmetic 
operators

+ Addition Adds  and . NO YES

- Subtraction Subtracts  from . NO YES

* Multiplication Multiplies  and . NO YES

/ Division Divides  by . NO YES

% Modulo Calculates the remainder after dividing  by . NO YES

Relational 
operators*1

== Equal to Compares if  is equal to . YES YES

!= Not equal to Compares if  is not equal to . YES YES

>= Greater than 
or equal to Compares if  is equal or greater than . NO YES

<= Less than or 
equal to Compares if  is equal or less than . NO YES

> Greater than Compares if  is greater than . NO YES

< Less than Compares if  is less than . NO YES

Bitwise 
operators

& Bitwise AND Calculates the logical product (AND) of each bit in  and . YES YES

| Bitwise OR Calculates the logical sum (OR) of each bit in  and . YES YES

^ Bitwise XOR 
(exclusive OR)

Calculates the exclusive logical sum (XOR) of each bit of  and 
.

YES YES

~ Bitwise NOT
Flips the logic of each bits of .
For word device and fixed values, 0 will be 65535 and 65535 will be 0.
For bit device, 0 will be 1, and 1 will be 0.

YES YES

<< Left shift Shifts each bit of  to left for  bit(s). YES YES

>> Right shift Shifts each bit of  to right for  bit(s). YES YES

Logical 
operators*1

&& Logical AND Calculates the logical product (AND) of a conditional expression 
and a conditional expression. YES YES

|| Logical OR Calculates the logical sum (OR) of a conditional expression and a 
conditional expression. YES YES

• You cannot select logical operators in the Trigger Condition Settings dialog box.
• You cannot mix bit devices and word devices in a conditional expression when using other than logical 

operators.

As a basic rule, conditional expressions are calculated in order from the left, but when multiple arithmetic 
operations are combined, they are calculated according to the operator priority.
For [D 10] == [D 11] + [D 12] * 2 + [D 13], the expression is calculated in the following order.

For the operator priority, refer to Chapter 20 “6.3 About the Priority of the Operator” on page 20-55.

D10 == D11 + D12 2 +* D13

1

2

3

4
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● Setting and operation examples

Settings

Action
Direct entry

Trigger Condition Settings 
dialog box

[M 0] == [M 1]
The condition is satisfied if the values of 
M0 and M1 are equal.

[M 0] == [M 1] & [M 2]
The condition is satisfied if the result of 
the AND operation on M1 and M2 is 
equal to M0.

[M 0] == ~[M 1]
The condition is satisfied if the result of 
flipping the bits in M1 is equal to M0.

1234 == [D 0]
The condition is satisfied if the value of 
D0 equals 1234.

100 <= [D 0] + [D 1] + [D 2] + [D 3]
The condition is satisfied if the result of 
adding the values of D0 through D3 is 
100 or greater.

0 != [D 0] % 10

The condition is satisfied if the value of 
the remainder after D0 is divided by 10 
does not equal 0 (the value of D10 
cannot be entirely divided by 10).

[D 0] == ~[D 1] & ~[D 2] & [D 3] &[D 4]

The condition is satisfied if the logical 
AND operation on the flipped bits of D1, 
the flipped bits of D2, the value of D3, 
and the value of D4 is equal to D0.

[D 10] + [D 11] == [D 12] + [D 13]

The condition is satisfied if the result of 
adding the values of D12 and D13 is 
equal to the result of adding the values 
D10 and D11.

[D 10] == [D 11] + [D 12] * 2 + [D 13]

The condition is satisfied if the result of 
adding the values of D11, D12 
multiplied by two, and D13 is equal to 
the value of D10.

100 <= [D 0] + [D 1] + [D 2] + [D 3] + 
[D 4] + [D 5] + [D 6] + [D 7]

(This expression cannot be 
configured in the Trigger 
Condition Settings dialog box 
because it has over 6 items of 
data.)

The condition is satisfied if the result of 
adding the values of D0 through D7 is 
100 or greater.

1 == ([M 0] && [M 1]) || ([M 2] && [M 3])

(This expression cannot be 
configured on the Trigger 
Condition Settings dialog box 
because it uses logical operators 
and it contains parentheses
 “(” and “)”.)

The condition is satisfied if the logical OR 
operation on the result of the logical AND 
operation on M0 and M1 and the result 
of the logical AND operation on M2 and 
M3 is equal to 1.

[LDR 10] + [LDR 11] == [LDR 12] *
([LDR 13] + [LDR 14])

(This expression cannot be 
configured on the Trigger 
Condition Settings dialog box 
because it mixes bitwise 
operators and logical operators 
or it contains parentheses 
“(” and “)”.)

The condition is satisfied if the result of 
multiplying the value of LDR12 by the 
result of adding the values of LDR13 
and LDR14 is equal to the result of 
adding the values of LDR10 and LDR11.

Data
M0

Op.
==

Data
M1

Data
M0

Op.
==

Data
M1

Op.
&

Data
M2

Data
M0

Op.
&

Data
M1
Not

Data
1234

Op.
==

Data
D0

Data
100

Op.
<=

Data
D0

Op.
+

Data
D1

Op.
+

Data
D2

Op.
+

Data
D3

Data
0

Op.
!=

Data
D0

Op.
%

Data
10

Data
D0

Op.
==

Data
D1
Not

Op.
&

Data
D2
Not

Op.
&

Data
D3

Op.
&

Data
D4

Data
D10

Op.
+

Data
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Op.
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Data
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+

Data
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Data
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Data
2
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+

Data
D13
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This chapter describes the communication between the MICRO/I and the external device.

  

1.1 Overview

Device Link Communication refers to the communiation protocol used for communication with the MICRO/I, via the 

CPU Unit*1 or PLC Link Unit*1 Programming Port of the external device connected to the MICRO/I.
The MICRO/I continuously reads the values of the external device addresses on the currently displayed screen, and 
external devices (such as relays and registers) on the screens are updated with the latest data at all times.
When a button is pressed or a command is executed in the MICRO/I screen, the value is written to the external device 
address.

*1 Unit names vary based on the manufacturer of the external device. 

Chapter 3 Communication

1 Device Link Communication

MICRO/I

1234

External device

Device Link Communicationn

0 1

Read

Write

D0:

M0:

1234
Numerical Display
Reference Device Address: D0

Bit Button
Destination Device Address: M0

For details regarding the Device Link Communication, refer to Chapter 1 "Device Link Communication" and 
Chapter 2 "Connection to External Devices" in the WindO/I-NV4 External Device Setup Manual.
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● Connection Types
There are two basic types of connections. 1:1 Communication, where an external device is connected to a 
MICRO/I; and 1:N Communication, where multiple external devices are connected to a MICRO/I. 

■ 1:1 Communication
The MICRO/I is connected to a single external device.

■ 1:N Communication
The MICRO/I is connected to multiple external devices.

1.2 Device Link Communication Settings

The external devices connected to the MICRO/I are selected on the Select Communication Driver dialog box, or the 
Communication Driver tab on the Project Settings dialog box.
• When creating new project data by following displayed dialog boxes and configuring settings step by step, by 

clicking , and then clicking New, the Select Communication Driver dialog box is displayed. For details, refer 
to Chapter 4 “Create new project data by using the interactive quick start” on page 4-1.

• Click Communication Driver on the status bar to display the Communication Driver tab on the Project 
Settings dialog box tab on the Project Settings dialog box. For details, refer to Chapter 4 “Changing Communication 
Drivers” on page 4-9.

Specify Manufacturer and Communication Driver for each CPU Unit*1 or each PLC Link Unit*1 of the external 
device. For details regarding the correspondence model, refer to the WindO/I-NV4 External Device Setup Manual.

*1 Unit names vary based on the manufacturer of the external device.

MICRO/I External device

Read

Write

Device Link Communication

MICRO/I

Station No.1

Station No.2

Station No.3

External device
Read

Write

Read

Write

Read

Write

Device Link Communication
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2.1 Overview

O/I Link Communication is a protocol for communication between Master and Slave, where a MICRO/I connected to 
the external device is configured as a Master and multiple MICRO/I (Slaves) communicate with the external device via 
the Master.
The Master MICRO/I unit communicates with the external device by means of Device Link Communication. The 
Master MICRO/I is called an O/I Link Master and a slave MICRO/I connected to the O/I Link Master is called an O/I 
Link Slave. A maximum of 15 O/I Link Slaves can be connected to an O/I Link Master.

2.2 O/I Link Communication Settings

These settings are configured under the O/I Link tab on the Project Settings dialog box. The Project Settings dialog 
box can also be accessed using the following methods.
• Click Project on the Configuration tab.
• Double click Project Settings in the Project window.
The O/I Link Communication Settings can only be configured when O/I Link Master or O/I Link Slave is selected 
in Function under Interface Settings on the Communication Interface tab. For details, refer to Chapter 4 “3.5 
O/I Link Tab” on page 4-33.

2 O/I Link Communication

Read Write

5678

MICRO/I
O/I Link Slave

(Slave 1)

MICRO/I
O/I Link Slave

(Slave 2)

MICRO/I
O/I Link Slave

(Slave 15)

MICRO/I
O/I Link Master

External device

0 1

Read

Write

D1: 

M1:

5678

O/I Link Communication

Device Link Communication

Numerical Display
Reference Device Address: D1

Bit Button
Destination Device Address: M1

Read Write Read Write

The HG4G/3G, the HG2G-5F/-5T/-5S/-S can be connected on the O/I Link Communication. The HG4G/3G, 
the HG2G-5F/-5S/-S must support the runtime system version 4.01 or later.

• The HG4G/3G, the HG2G-5F/-5T/-5S/-S, and the HG4F/3F/2F/2S/1F have different O/I Link Communication, 
therefore they can not be connected on the same O/I Link Communication.

• O/I Link Communication can only be used for an external device set to External Device 
Communication 1 on the MICRO/I to use as the O/I Link Master. Set the same communication driver 
to External Device Communication 1 of the O/I Link Master and the O/I Link Slave. 

For details regarding the O/I Link Communication, refer to Chapter 3 "O/I Link Communication" in the 
WindO/I-NV4 External Device Setup Manual.
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3.1 Overview

DM Link Communication reads and writes value to external devices using the MICRO/I's dedicated DM Link memory. 
The device type of dedicated DM Link memory is DM.
This method uses a dedicated IDEC protocol, so a communication program is required in the external device.

● Connection Methods
There are two basic types of DM Link Communication. 1:1 Communication, where the MICRO/I is connected to an 
external device; and 1:N Communication, where multiple MICRO/I are connected to an external device.

■ 1:1 Communication
The external device is connected to a single MICRO/I.

The Event Transmission function from the MICRO/I can be used with 1:1 communication.
The Event Transmission function is a function that works as follows. When value in the dedicated DM Link memory of 
the MICRO/I is changed, the data is transmitted from the MICRO/I to the external device.

3 DM Link Communication

MICRO/I

999

5678

External device

DM Link Communication

Read

Write

DM0: 999

DM1: 1234 5678

DM0

DM1

DM2

DM8190

DM8191

Dedicated DM Link memory

Numerical Display
Destination Device Address: DM0

Numerical Display
Reference Device Address: DM1

For details regarding the DM Link Communication, refer to Chapter 4 "DM Link Communication" in the 
WindO/I-NV4 External Device Setup Manual.
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■ 1:N Communication
The external device is connected to multiple MICRO/I.

3.2 DM Link Communication Settings

DM Link Communication settings are selected on the Select Communication Driver dialog box, or the 
Communication Driver tab on the Project Settings dialog box.
• When creating new project data by following displayed dialog boxes and configuring settings step by step, by 

clicking , and then clicking New, the Select Communication Driver dialog box is displayed. For details, refer 
to Chapter 4 “Create new project data by using the interactive quick start” on page 4-1.

• Click Communication Driver on the status bar to display the Communication Driver tab on the Project 
Settings dialog box. For details, refer to Chapter 4 “Changing Communication Drivers” on page 4-9.

Select IDEC System in Manufacturer, and then select DM Link (1:1) or DM Link (1:N) in Communication 
Driver.

Station No.1

Station No.2

Station No.3

MICRO/I

Dedicated DM 
Link memory

Dedicated DM 
Link memory

Dedicated DM 
Link memory

External device
Read

Write

Read

Write

Read

Write

DM Link 1:N Communication

The Event Transmission function cannot be used with 1:N communication.
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4.1 Overview

In this case, there is no communication with an external device, so the MICRO/I operates as a standalone unit.
It is only possible to operate the MICRO/I with relays and registers.

4.2 No External Devices Settings

No external devices settings are selected on the Select Communication Driver dialog box, or the Communication 
Driver tab on the Project Settings dialog box.
• When creating new project data by following displayed dialog boxes and configuring settings step by step, by 

clicking , and then clicking New, the Select Communication Driver dialog box is displayed. For details, refer 
to Chapter 4 “Create new project data by using the interactive quick start” on page 4-1.

• Click Communication Driver on the status bar to display the Communication Driver tab on the Project 
Settings dialog box. For details, refer to Chapter 4 “Changing Communication Drivers” on page 4-9.

Select No External Devices in Manufacturer.

4 No External Devices

MICRO/I

Internal device No external device
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5.1 Overview

User Communication allows you to develop a communication protocol to transmit and receive data from an external 
device, such as a barcode reader. 

User Communication is supported up to three interfaces of the MICRO/I, either serial, Ethernet, or USB interfaces.

5 User Communication

External device

MICRO/I

Data receptionData transmission

User communication

External device

Device Link Communicaton

When the serial interface connecting external devices is RS485, a maximum of 31 external devices can be 
connected. However, carefully check the specifications including the command settings and error 
processing and verify whether or not multiple external devices is possible and if so how many number of 
external devices may be supported.

• Flow Control setting is None.
• The maximum size of sent data and the maximum size of received data is 1,500 bytes.
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5.2 User Communication Settings Procedure

This section describes the procedure for setting user communication.

● Setting user communication for a communication interface

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Click the Communication Interface tab.

3 Select the interface for user communication under Interface Configuration, and then select the user 
communication in Function under Interface Settings.

The User Communication tab is displayed.
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4 Specify the items for Interface Settings.
The settings vary based on the interface.

■ Serial Interface
 For details, refer to Chapter 4 “When SERIAL1(RS232C) or SERIAL1(RS422/485) is selected under Interface 

Configuration” on page 4-26.

■ Ethernet Interface
 For details, refer to Chapter 4 “When Protocol1 to Protocol7 is selected for Ethernet under Interface 

Configuration” on page 4-24.

■ USB Interface
 For details, refer to Chapter 4 “When USB2(USB-A) is selected under Interface Configuration” on page 4-25.

5 Click the User Communication tab.

6 Select the user communication under Settings, and then click Browse.
Select the user communication configured on the Communication Interface tab.
Protocol Manager is displayed.
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7 Select the user communication protocol under Protocol List, and then click Select.

The name of the configured user communication protocol set on the User Communication tab in the Project 
Settings dialog box is displayed in Protocol Name under Settings, and the protocol settings are displayed under 
Protocol. In addition, the command settings selected under Protocol are displayed under Command.

8 Click OK.

This concludes configuring user communication for communication interfaces.
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● Creating a New User Communication Protocol

1 On the View tab, in the Workspace group, click  (Protocol Manager).

Protocol Manager is displayed.

2 Click Add.

The User Communication Protocol Settings dialog box is displayed.

3 Enter the name of the user communication protocol in the Protocol Name.

The maximum number for protocol name is 40 characters.

4 Set the time out (0 to 255) from when 1 frame of data has been received to when the next frame of data starts to be 
received in Receiving Character Time Out (x100 msec).

A frame refers to a data string from the beginning to the end of a command. These setting items are used only with 
receive command.

5 Click Edit.

The Command Settings dialog box is displayed.

You cannot use the following characters in the protocol name.
   \ / : , ; * ? " < > |
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6 Set Transmission (TXD) command.
Enter a comment for transmission command in Comment.

The maximum number is 40 characters.

7 Select TXD in Command Type.

Specify the transmitted data to the external device connected to the MICRO/I and the conditions for transmitting 
data.

8 Specify the bit device or bit number of the word device for reporting that data transmission was successfully 
completed in Completed Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

9 Specify the destination word device for the transmitted data size and error information in Status Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

10 Set the wait time (0 to 255) from when the trigger condition is satisfied to when the data is transmitted in 
Transmission Wait (x100 msec).

11 Select the condition to transmit data in Trigger Type under Trigger Condition from the following.

■ Rising-edge
Data is transmitted when the value of device address changes from 0 to 1.
Specify the bit device or bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Falling-edge
Data is transmitted when the value of device address changes from 1 to 0.
Specify the bit device or bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
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■ Satisfy the condition
Data is transmitted when condition changes from not satisfied to satisfied.
Specify the conditional expression in Condition and select the data type handled by the conditional expression in 
Data Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.
For details on data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Fixed Period
Data is transmitted at a fixed time interval.
Set the time interval between data transmissions as 1 to 3600 (seconds) in Period (sec).

12 Set data for transmission command.
Click Edit.

The Data Settings dialog box is displayed.

13 Select data type in Type.

Data setting items are displayed.
For details on transmission command, refer to “Transmission (TXD) Command” on page 3-37.



5 User Communication

3-14 WindO/I-NV4 User’s Manual

14 Set the data, and then click OK.

The data configured in Command is displayed.

15 Repeat steps 12 through 14 to set all the data for the transmission command.

16 Click OK.

The transmission command configured under Protocol is displayed.

17 Specify Receive (RXD) command.
Click Edit.

The data are displayed in Command in the order they were set. To change the order of data, select data, 
and then click Up or Down to shift it.
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18 Specify Receive (RXD) command.
Enter a comment for receive command in Comment.

The maximum number is 40 characters.

19 Select RXD in Command Type.

Define the data configuration for received data from the external device.

20 Specify the bit device or bit number of the word device for reporting that data receiving was successfully completed in 
Completed Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
If the value of Completed Device Address automatically is not set to 0 after it is set to 1, select the Not Clear 
Completed Device Address automatically check box.

21 Specify the destination word device for the received data size and error information in Status Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

22 Select the condition for being ready to receive data in Trigger Type under Trigger Condition from the following.

■ Always Enabled
The device is always ready to receive data. Proceed to step 24.

■ While ON
Ready to receive data when the value of device address is 1.
Specify the bit device or bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ While OFF
Ready to receive data when the value of device address is 0.
Specify the bit device or bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ While satisfying the condition
Ready to receive data while a condition is satisfied.
Specify the conditional expression in Condition and select the type of data handled by the conditional expression in 
Data Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.
For details on data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.
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23 Set the time out (0 to 255) from when the trigger condition is satisfied in Receiving Time Out (x100 msec) to 
when 1 frame of data has been received.

A frame refers to a data string from the beginning to the end of a command.

24 Set data for receive command.
Click Edit.

The Data Settings dialog box is displayed.

25 Select data type in Type.

Data setting items are displayed.
For details on receive command, refer to “Receive (RXD) Command” on page 3-50.

26 Specify the data, and then click OK.

The data configured in Command on the Command Settings dialog box is displayed.
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27 Repeat steps 24 through 26 to specify all the data for the receive command.

28 Click OK.

The receive command configured in Protocol on the User Communication Protocol Settings dialog box is displayed.

To add a transmission command, repeat steps 5 through 16.

To add a receive command, repeat steps 17 through 28.

29 Configure all commands, click OK.

User communication protocols are registered in Protocol List on Protocol Manager.

The data are displayed in Command in the order they were set. To change the order of data, select data, 
and then click Up or Down to shift it.
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30 Click Close.

This concludes registering user communication protocol.
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● Using registered user communication protocol on another computer

Saving registered user communication protocol as a file

To use the user communication protocol registered in Protocol Manager on another computer, save it as a file.

1 On the View tab, in the Workspace group, click  (Protocol Manager).

Protocol Manager is displayed.

2 Select the user communication protocol in Protocol List, and then click Export.

The Save As dialog box is displayed.

3 Specify Save in, and then click Save.

The name of the saved file will be the name of the protocol. 

To select multiple user communication protocols, press and hold SHIFT or CTRL while you click the specific 
items.
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Importing user communication protocol

1 On the View tab, in the Workspace group, click  (Protocol Manager).

Protocol Manager is displayed.

2 On Protocol Manager, click Import.

The Open dialog box is displayed.

3 Specify the user communication protocol file, and then click Open.

The user communication protocol is registered in Protocol Manager. The name of the user communication protocol file 
is set as the name of the protocol.

To select multiple user communication protocols, press and hold SHIFT or CTRL while you click the specific 
items.

When a user communication protocol file with the protocol name already exists, a confirmation message is 
displayed.
• Click Overwrite to overwrite the existing user communication protocol.
• Click Rename to display the Protocol File Name Settings dialog box. Enter a new name for Protocol File 

Name, and then click OK to add the user communication protocol with the protocol name entered for 
Protocol File Name. For details, refer to “Protocol File Name Setting Dialog Box” on page 3-25.

• Click Cancel to stop importing the user communication protocol.
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5.3 Protocol Manager

The protocol for user communication is collectively managed in Protocol Manager.

■ Protocol List
Displays a list of registered user communication protocols and sample protocols provided by WindO/I-NV4.

■ Add
Adds user communication protocols to the Protocol List.
Click this button to display the User Communication Protocol Settings dialog box. Specify the user communication 
protocol to be registered in the User Communication Protocol Settings dialog box. For details, refer to “User 
Communication Protocol Settings Dialog Box” on page 3-23.

■ Edit
Changes the selected user communication protocol.
Click this button to display the User Communication Protocol Settings dialog box. Change the user communication 
protocol in the User Communication Protocol Settings dialog box. For details, refer to “User Communication Protocol 
Settings Dialog Box” on page 3-23.

■ Delete
Deletes the selected user communication protocol.

■ Import
Imports a saved user communication protocol file. Click this button to display the Open dialog box. For details, refer 
to “Importing user communication protocol” on page 3-20.

■ Export
Export and saves a selected user communication protocol as a file.
Click this button to display the Save As dialog box. For details, refer to “Saving registered user communication 
protocol as a file” on page 3-19.
Saved user communication protocols can be imported using Import.

■ Copy
Copies the selected user communication protocol.
Click this button to display the Protocol File Name Settings dialog box. For details, refer to “Protocol File Name Setting 
Dialog Box” on page 3-25.

The barcode reader protocols such as Barcode-Reader1, Barcode-Reader2, and Barcode-Reader3 are 
supplied as samples with WindO/I-NV4.
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■ Protocol
The command settings for the user communication protocol selected in the Protocol List are displayed.

■ Command
Shows a list of command settings for the selected user communication protocol. Double clicking the line displays the 
Data Settings dialog box.

■ Select
The highlighted user communication protocol in the protocol list is selected and Protocol Manager is closed.

■ Close
Close Protocol Manager.

No.: Shows the number for managing command settings. Double clicking the cell displays the Command 
Settings dialog box.

Type: Shows the type of command. Double clicking the cell displays the Command Settings dialog box.

Completed: Shows the device address for reporting when transmission or receiving of data is successfully 
completed. Double clicking the cell displays the Command Settings dialog box.

Status: Shows the destination device address for the transmitted or received data size and error 
information. Double clicking the cell displays the Command Settings dialog box.

Trigger Type: Shows the trigger type for data transmission or being ready to receive data. Double clicking the cell 
displays the Command Settings dialog box.

Condition: Shows the condition of trigger type for data transmission or being ready to receive data. The 
displayed content varies based on Trigger Type.

Always Enabled: Trigger conditions are not necessary, so nothing is displayed.

Rising-edge, Falling-edge, While ON, or While OFF:

Shows the bit device as the condition. Double clicking the cell displays the 
Command Settings dialog box.

While satisfying the condition or Satisfy the condition:

Shows the conditional expression.

Fixed Period: Shows the period.

Comment: Shows the command comment. Double clicking the cell displays the Command Settings dialog box.

Size: Shows the command data size in bytes. Double clicking the cell displays the Command Settings 
dialog box.
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● User Communication Protocol Settings Dialog Box
The command for user communication protocol is collectively managed in the User Communication Protocol Settings 
dialog box.

■ Protocol Name
Enter the name of the user communication protocol. The maximum number for protocol name is 40 characters.

■ Receiving Character Time Out (x100 msec)
Specify the time out value (0 to 255) from when 1 frame of data has been received to when the next frame of data 
starts to be received. A frame refers to a data string from the beginning to the end of a command. If the Receiving 
Character Time Out is set to 0, it is not monitored. These setting items are used only with receive command.

Example: When the received data (1 frame) is 2 bytes, While ON is selected as Trigger Type in Trigger 
Condition and LM100 is set to Device Address, LM101 is set to Completed Device Address, and 
LDR110 is set to Status Device Address

The data of second byte starts to be received before exceeding the Receiving Character Time Out duration 
after the data of first byte is received, and the values of the Completed Device Address and Status Device 
Address when receiving of the data has been successfully completed are as follows.
• The value of the Completed Device Address LM101 changes to 1.

When the Not Clear Completed Device Address automatically check box is not selected, when the 
value of the Trigger Condition device address LM100 changes from 0 to 1, the value of the Completed 
Device Address LM101 changes to 0. 
When the Not Clear Completed Device Address automatically check box is selected, the value of 
Completed Device Address LM101 remains 1, so set 0 if necessary.

• The value of the Receiving Character Time Out (address number+0, bit 15) of the Status Device 
Address LDR110 remains 0.

You cannot use the following characters in the protocol name.
   \ / : , ; * ? " < > |

Value of Receiving Character Time Out 
(address number+0, bit 15) 

of Status Device Address LDR110

Value of Completed Device Address 
LM101

Receive command

Value of Device Address LM100 when 
Trigger Condition is While ON

1

0

1

0

1

0

Receiving Character Time Out duration

First byte of receive data Second byte of receive data
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When the Receiving Character Time Out duration exceeds until the data of second byte starts to be 
received after the data of first byte is received, the value of the Receiving Character Time Out (address 
number+0, bit 15) of the Status Device Address LDR110 changes to 1 and the Completed Device Address 
LM101 remains 0. In addition, when the value of the Trigger Condition device address LM100 changes 
from 0 to 1, the value of LDR110 (address number +0, bit 15) changes to 0.

■ Protocol
Displays a list of command settings for the user communication protocol selected during editing. The maximum 
amount that can be configured is 32 commands per protocol.

■ Edit
Adds or changes commands.
To add a command, select an empty line for the protocol, and then click this button. To change a command, select a 
command for the protocol, and then click this button. For details, refer to “Command Settings Dialog Box” on page 3-26.

■ Insert
Inserts a command in the selected position of the protocol.
Click this button to insert a command. The command at the insertion position shift down 1 line. When 32 commands 
are already set, you cannot insert a command. For details, refer to “Command Settings Dialog Box” on page 3-26.

■ Delete
Deletes the selected command.

Value of Receiving Character Time Out  
(address number+0, bit 15) 

of Status Device Address LDR110

Value of Completed Device Address 
LM101

Receive command

1

0

1

0

1

0

Receiving Character Time Out duration

First byte of receive data Second byte of receive data

Value of Device Address LM100 when 
Trigger Condition is While ON

No.: Shows the number for managing command settings. Double clicking the cell displays the Command 
Settings dialog box.

Type: Shows the type of command. Double clicking the cell displays the Command Settings dialog box.

Completed: Shows the device address for reporting when transmission or receiving of data is successfully 
completed. Double clicking the cell displays the Tag Editor.

Status: Shows the destination device address for the transmitted or received data size and error information. 
Double clicking the cell displays the Tag Editor.

Trigger Type: Shows the trigger type for data transmission or being ready to receive data. Double clicking the cell 
displays the Command Settings dialog box.

Condition: Shows the condition of trigger type for data transmission or being ready to receive data. The 
displayed content varies based on Trigger Type.

Always Enabled: Trigger conditions are not necessary, so nothing is displayed.

Rising-edge, Falling-edge, While ON, or While OFF:

Shows the bit device as the condition. Double clicking the cell displays the 
Command Settings dialog box.

While satisfying the condition or Satisfy the condition:

Shows the conditional expression.

Fixed Period: Shows the period.

Comment: Shows the command comment. Double clicking the cell displays the Command Settings dialog box.

Size: Shows the command data size in bytes. Double clicking the cell displays the Command Settings 
dialog box.
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■ Copy
Copies the selected command.
Click this button to copy the selected command and add it to the end of the Protocol List.

■ Command
Displays data of the command selected in the protocol. Double clicking the line displays the Data Settings dialog box.

■ Copy to Protocol Manager
Copies a user communication protocol during editing and copies it to Protocol Manager.
Click this button to copy the user communication protocol and add it to the Protocol List of Protocol Manager.
This is enabled only when the User Communication Protocol Settings dialog box under the User Communication 
tab on the Project Settings dialog box is displayed.
When a protocol of the same name has already been saved, an overwrite confirmation message is displayed.
Click Overwrite to overwrite the existing protocol.
Click Rename to display the Protocol File Name Settings dialog box. Enter a new protocol name, and then click OK to 
save the protocol.
Click Cancel to stop saving the protocol.

Protocol File Name Setting Dialog Box

Specify the name of a user communication protocol.

■ Protocol File Name
Enter the name of the user communication protocol. The maximum number for protocol name is 40 characters.

The User Communication Protocol Settings dialog box under the User Communication tab on the Project 
Settings dialog box can be displayed in the following ways.
• Click Edit.
• Click Browse, and then click Add or Edit in Protocol Manager.

You cannot use the following characters in the protocol name.
   \ / : , ; * ? " < > |
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● Command Settings Dialog Box
Specify the command details for user communication protocol.

■ Comment
Enter a comment for a command. The maximum number is 40 characters.

■ Command Type
Select the type of communication command from the following items.

TXD: A command for data transmission from the MICRO/I to an external device.

Processing of transmission command is as follows.

Example: When Trigger Type in Trigger Condition is Rising-edge, Device Address is LM100 
and Completed Device Address is LM101
When the value of the Trigger Condition device address LM100 changes to 1, data is 
transmitted by user communication from the MICRO/I to the external device. When data 
transmission is successfully completed, the value of the Completed Device Address 
LM101 changes to 1.

Transmission 
dataTransmission

1
(31h)

2
(32h)

3
(33h)

4
(34h)

External deviceMICRO/I

Value of Device Address LM100 when 
Trigger Condition is

Rising-edge

1

0

Value of Completed Device Address 
LM101

1

0

Transmission data

State in which user 
communication is 

not operating

State in which data can be
 transmitted by user communication

State in which user 
communication is 

not operating

Complete 
transmission

Start 
transmission
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■ Completed Device Address
Specify the bit device or bit number of the word device for reporting that data transmission or receiving was 
successfully completed. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

Example: When Trigger Type in Trigger Condition is While ON, Device Address is LM100 and Completed 
Device Address is LM101

When data receiving is successfully completed, the value of the Completed Device Address LM101 
changes to 1. When the value of the Trigger Condition device address LM100 changes from 0 to 1, the 
value of the Completed Device Address LM101 changes to 0.

RXD: A command for analyzing and processing data received by the MICRO/I from an external device.

Processing of receive command is as follows.

Example: When Trigger Type in Trigger Condition is While ON, Device Address is LM100 
and Completed Device Address is LM101
When the value of the Trigger Condition device address LM100 changes to 1, data can be 
received (ready to receive) by user communication, so when data is transmitted from the 
external device, the MICRO/I starts to receive the data. When data receiving is 
successfully completed, the value of the Completed Device Address LM101 changes to 1.

Receive dataReceive
1

(31h)
2

(32h)
3

(33h)
4

(34h)

External device
MICRO/I

Value of Device Address LM100 when 
Trigger Condition is

While ON

1

0

Value of Completed Device Address 
LM101

1

0

Receive data

Data transmission from 
external device

State in which user 
communication is 

not operating

State in which data can be
 received by user communication

State in which user 
communication is 

not operating

Complete 
receiving

Start 
receiving

Value of Completed Device Address 
LM101

Receive command

Value of Device Address LM100 when 
Trigger Condition is

While ON

1

0

1

0

Receive data 1 frame
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■ Not Clear Completed Device Address automatically
Select this check box when the value of the Completed Device Address is not set to 0 automatically after it changes to 
1. This can be configured when RXD is selected in Command Type.

Example: When Trigger Type in Trigger Condition is While ON, Device Address is LM100 and Completed 
Device Address is LM101

When the Not Clear Completed Device Address automatically check box is not selected:
When data receiving is successfully completed, the value of the Completed Device Address LM101 
changes to 1. When the first data of the next frame is received, the value of the Completed Device 
Address LM101 changes to 0.

When the Not Clear Completed Device Address automatically check box is selected:
When data receiving is successfully completed, the value of the Completed Device Address LM101 is set to 
1. Even after the first data of the next frame is received, the value of the Completed Device Address 
LM101 does not change to 0.

Value of Completed Device Address 
LM101

Receive command

Value of Device Address LM100 when 
Trigger Condition is

While ON

1

0

1

0

Receive data 1 frame Receive data 1 frame

1

0

1

0

Receive data 1 frame Receive data 1 frame

Value of Completed Device Address 
LM101

Receive command

Value of Device Address LM100 when 
Trigger Condition is

While ON
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■ Status Device Address
Specify the destination word device for the transmitted or received data size and error information. Error information 
and command data size is stored at the beginning of the configured device address. When data transmission or 
receiving has not successfully completed, the value of each bit changes to 1. The bits of the Status Device Address 
changes to 0 when the trigger condition is satisfied and they are not changed to 0 automatically. When Always 
Enabled is selected in Trigger Condition of receive command, the value of the Status Device Address is kept as 
long as a Clear command is not executed.
You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
Example: When LDR110 is configured as Status Device Address

When TXD is selected as Command Type:

Address 
number Bit Function Cause Solution

+0

0 BCC Error

• The Calculation Start Position and Calculation 
End Position are not stored in 1 frame.

• The Calculation End Position is set before 
Calculation Start Position.

Change the Calculation 
Start Position and 
Calculation End Position 
settings.

• When Calculation Type is Modbus ASCII 
(LCR), the data size from Calculation Start 
Position to Calculation End Position is odd 
bytes.

• The data contains data other than ASCII (30h 
to 39h, 41h to 46h) data.

Change the Calculation 
Start Position and 
Calculation End Position 
settings and the 
transmission data.

1, 2 Reserved

3
Registering Constant 
Data Error

When data type is Registering Constant 
(Character) or Registering Constant 
(Hexadecimal), the value of the Index Device 
Address does not match the Index No. of the 
registered Registering Constant.

Change the data stored in 
the Index Device Address.

4 Reserved

5
Use Reference Device 
Data Error

When data type is Device Address and the 
Use Reference Device Address check box is 
selected, the device address in which the value 
of the Reference Device Address is stored as 
offset has exceeded the valid range.

Change the value stored in 
the Reference Device 
Address.

6
Device Data Variable 
Specification Error

When data type is Device Address, the 
Variable check box is selected and Device 
Address is selected, the value of device 
address is negative or exceeds the setting 
(number of bytes x number of words).

Change the value of device 
address to a positive value 
or to a value that does not 
exceed the setting (number 
of bytes x number of 
words).

7
Transmission 
Command Abandon 
Error

When transmitting data after the Trigger 
Condition is satisfied, the command with the 
same Command No. was transmitting data or 
transmission (transmission is not completed).

Increase the time interval 
for starting transmission.

8 to 15 Reserved

Address 
number Function Description

+1 Transmission Data Size (bytes) Stores the size of transmission data.

LDR110
LDR111

Error information and time out information
Transmitted or received data size (bytes)

(Starting address number) +0
+1

When the Error Information bit changes to 1, data is not transmitted, and the Transmission Completed 
Device Address does not change to 1.
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When RXD is selected as Command Type:
Address 
number Bit Function Cause Solution

+0

0 BCC error

The BCC that calculated the receive data did not match 
the BCC that is appended to the receive data.

Check the transmission data 
from the external device.

• The Calculation Start Position and Calculation End 
Position are not stored in 1 frame.

• The Calculation End Position is set before Calculation 
Start Position.

Change the Calculation 
Start Position and 
Calculation End Position 
settings.

• When Calculation Type is Modbus ASCII (LCR), the 
data size from Calculation Start Position to 
Calculation End Position is odd bytes.

• The data contains data other than ASCII (30h to 39h, 
41h to 46h) data.

Change the Calculation Start 
Position and Calculation End 
Position settings and the 
transmission data from the 
external device.

1
Received Data 
Size Error

• When data type is Device Address and the 
Variable check box is selected, 1 frame of process is 
completed before one of Constant (Character), 
Constant (Hexadecimal), Registering Constant 
(Character), Registering Constant 
(Hexadecimal), BCC, or Skip is processed.

• When data type is Device Address and the 
Variable check box is not selected, the receive data 
size of the receive data does not match that of the 
specified receive command.

Check the transmission data 
from the external device.

2
Registering 
Constant Data 
Error

The Constant (Character) or Constant 
(Hexadecimal) set up with the receive command 
does not match the receive data.

Check the transmission data 
from the external device.

3
Registering 
Constant Error

No data matches the registered setting of the 
Registering Constant data.

Check the transmission data 
from the external device.

4
Device Data 
Conversion Error

• When data type is Device Address and 
Conversion Type is ASCII (Hex) to Binary, a 
code other than 0 to 9 or A to F receives as data.

• When data type is Device Address and 
Conversion Type is ASCII (Dec) to Binary, a 
code other than 0 to 9 receives as data. Or the 
converted data exceeds 65535.

Check the transmission data 
from the external device.

5
Device Data 
Reference 
Device Error

When data type is Device Address and the Use 
Reference Device Address check box is selected, the 
device address in which the value of the Reference 
Device Address is stored as offset has exceeded the valid 
range. Or the number of words setting of the device 
address is beyond the range of device address for which 
data is stored.

Change the value of the 
Reference Device Address 
or the change the number 
of words.

6
Terminal Code of 
Receive Data 
Miscompare Error

In the receive command whose trigger condition is 
being satisfied, the start code matches while the 
terminal code does not match.

Check the transmission data 
from the external device.

7
Device Storing 
Error

In the multiple Receive (RXD) Commands processing, 
the number of the same-time stored device addresses 
which is sum of the number of the stored device 
address of Device Address and the number of the 
index device address of Registering Constant 
(Character) or Registering Constant 
(Hexadecimal), is over 800 words.

Change settings so that the 
total number of device 
addresses used for storage 
at one time does not 
exceed 800 words.
Change settings so that the 
trigger conditions for 
several receive commands 
are not satisfied, to reduce 
the number of receive 
commands that are 
processed. 

8 to 13 Reserved

14
Receiving Time 
Out

1 frame of data is not received even when the preset 
Receiving Time Out duration has passed after the 
Trigger Condition is satisfied. 

Check the transmission data 
from the external device.

15
Receiving 
Character Time 
Out

While 1 frame of data is being received, even after the 
time out period—the specified time interval between 
receiving data (from when 1 frame of data has been 
received to when the next frame of data starts to be 
received)—has elapsed, the next frame of data does 
not start to be received.

Check the transmission data 
from the external device.
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■ Transmission Wait (x100 msec)
Specify the wait time (0 to 255) from when the trigger condition is satisfied to when the data is transmitted. This can 
be configured only when TXD is selected in Command Type on the Command Settings dialog box.
After the Transmission Wait duration has elapsed from when the trigger condition is satisfied, transmission starts.

Example: When Trigger Type in Trigger Condition is Rising-edge and Device Address is LM100

■ Receiving Time Out (x100 msec)
Set the time out (0 to 255) from when the trigger condition is satisfied to when 1 frame of data has been received. A 
frame refers to a data string from the beginning to the end of a command. If the Receiving Character Time Out is set 
to 0, it is not monitored. 
This can be configured only when RXD is selected in Command Type, and While ON, While OFF, or While 
satisfying the condition is selected in Trigger Type.

When 1 frame of data could not be received, even though the Receiving Time Out duration has elapsed from when 
the trigger condition is satisfied, the value of the Receiving Time Out of the Status Device Address (address 
number+0, bit 14) changes to 1. When the Receiving Time Out duration elapses, the value of the Completed Device 
Address does not change to 1, and the receive data is not processed.
When the trigger condition again changes from not satisfied to satisfied, the value of the Receiving Time Out of the 
Status Device Address (address number+0, bit 14) changes to 0. When the value of this bit is not 0, the Receiving 
Time Out cannot be detected.

Example: When Trigger Type in Trigger Condition is While ON, Device Address is LM100, Status Device 
Address is LDR110, Completed Device Address is LM101 and the Not Clear Completed Device 
Address automatically check box is not selected
When Status Device Address is LDR110, error information and time out information is stored in each bit 
of LDR110.

When receiving of 1 frame of data is completed before the Receiving Time Out duration has elapsed from 
when the trigger condition is satisfied, the value of the Receiving Time Out of the Status Device Address 
LDR110 (address number+0, bit 14) remains 0.

Address 
number Function Description

+1 Receive Data Size (bytes) Stores the size of receive data.

After the Receiving Character Time Out duration has elapsed, the receive data is analyzed. When the Error 
Information bit changes to 1, data is not received, and the Receiving Completed Device Address does not change to 1.

Transmission command

Value of Device Address LM100
when Trigger Condition is 

Rising-edge

1

0

Transmission data 1 frame

Transmission 
Wait duration

Transmission data 1 frame

Transmission 
Wait duration

Value of Device Address when 
Trigger Condition is 

While ON

1

0

1

0

Receiving Time Out duration

Value of the Receiving Time Out 
(address number+0, bit14) 

of the Status Device Address

Receive command

Value of Device Address LM100 when 
Trigger Condition is While ON

1

0

1

0
Value of Completed Device Address LM101

1

0

Receive data 1 frame

Receiving Time Out duration

Receive data 1 frame

Value of Receiving Time Out  
(address number+0, bit 14) 

of Status Device Address LDR110
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When receiving of 1 frame of data could not be completed by the time the Receiving Time Out duration 
elapses from when the trigger condition is satisfied, the value of the Receiving Time Out of the Status 
Device Address LDR110 (address number+0, bit 14) changes to 1.

■ Trigger Condition
Set the trigger conditions for transmission or receiving of data.

When TXD is selected as Command Type:

1

0

0

1

0

1

Receive command

Value of Device Address LM100 when 
Trigger Condition is While ON

Value of Completed Device Address LM101

Receive data 1 frame

Receiving Time Out duration

Value of Receiving Time Out 
(address number+0, bit 14) 

of Status Device Address LDR110

1

0

0

1

0

1

Receive command

Value of Device Address LM100 when 
Trigger Condition is While ON

Value of Completed Device Address LM101

Receive data 1 frame

Receiving Time Out duration

Value of Receiving Time Out 
(address number+0, bit 14) 

of Status Device Address LDR110

Trigger Type: A condition for data transmission is selected from the following.
Rising-edge: Data is transmitted when the value of device address changes from 0 to 1.

Falling-edge: Data is transmitted when the value of device address changes from 1 to 0.

Satisfy the condition:
Data is transmitted when the condition changes from not satisfied to satisfied.

Value of Device Address
1

0

Action Execution Execution Execution

1

0

Value of Device Address

Action Execution Execution

Action Execution

Condition
Satisfied

Not satisfied

Execution Execution
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When RXD is selected as Command Type:

Fixed Period: Data is transmitted at a fixed time interval.

Data Type: Select the data type handled by the conditional expression.
Can only be set if Satisfy the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit of the word device to serve as condition. You can only specify the 
internal device.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Condition: Sets the condition formula.
Can only be set if Satisfy the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Period (sec): Specify the period for command execution from 1 to 3600 (seconds).
This is enabled only when Fixed Period is selected in Trigger Type.

Trigger Type: Selects the condition to be ready to receive data from the following.
Always Enabled: The MICRO/I is always ready to receive data.

While ON: Ready to receive data when the value of device address is 1.

While OFF: Ready to receive data when the value of device address is 0.

While satisfying the condition:
Ready to receive data while the condition is satisfied.

Data Type: Select the data type handled by the conditional expression.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as condition. You can only specify the 
internal device.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Condition: Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Fixed time interval Fixed time interval Fixed time interval

Action ExecutionExecutionExecution

Action Always Enabled

Value of Device Address

1

0

Enabled Enabled EnabledAction

1

0

Enabled EnabledEnabled

Value of Device Address

Action

Enabled Enabled Enabled

Condition
Satisfied

Not satisfied

Action
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■ Command
Shows a list of command data. Double clicking the line displays the Data Settings dialog box.
For details, refer to “Data Settings Dialog Box” on page 3-36. The maximum amount that can be configured is 32 
commands per protocol.
The content displayed in lists varies based on the type of command.

Constant (Character): Displays the specified data enclosed in " ". 
"Data"
Example: "1234"

Constant (Hexadecimal): Displays the specified data with each byte value enclosed in ' '. 
'Data of the first byte' 'Data of the second byte' 'Data of the third byte' 'Data of the 
forth byte'
Example: '31' '32' '33' '34'

Device Address: Displays the specified data enclosed by < >, in the following order. 
<Device Address  Conversion Type  Number of bytes  Variable  Words  Storage Method of data>

Device Address: Displays the device address enclosed by [ ]
When the Use Reference Device Address check box is 
selected, displays as OFFSET([Device Address], [Reference 
Device Address]) 

Number of bytes: Displays the number of bytes of the transmitted or 
received data.

Conversion Type: Display the conversion methods for values of device 
addresses as follows.
B16-A: When Binary (Hex) to ASCII is selected
B10-A: When Binary (Dec) to ASCII is selected
N: When No conversion is selected

Variable: When the Variable check box is selected, variables are 
displayed as follows.
V00: When NULL (00h) is selected for transmission 
command
V [Device Address]: When Device Address is selected for 
transmission command
V: In the case of receive command

Words: Displays the number of word devices for transmitting or 
receiving data.

Storage Method of data: Displays the handling method for value of read device 
address as follows.
U: When from Upper byte is selected
L: When from Lower byte is selected

Example: <OFFSET([LDR0100], [LDR0300]) N 2V[LDR0200] 2 U>

Registering Constant (Character):

Displays the specified data enclosed in << >>. 
<<Index No. of No. 1: Data of No. 1 Index No. of No. 2: Data of No. 2 ... Index No. of 
No. N: Data of No. N Index Device Address>> (N = 1 to 100)

Data: Displays the data enclosed by " "

Index Device Address: Displays the device address enclosed by [ ]

Example: <<1:"123" 2 :"456" 3 :"789" [LDR0100]>>

Registering Constant (Hexadecimal):

Displays the specified data enclosed in << >>. 
<<Index No. of No. 1: Data of No. 1 Index No. of No. 2: Data of No. 2 ... Index No. of 
No. N: Data of No. N Index Device Address>> (N = 1 to 100)

Data: Displays the data enclosed by ' '

Index Device Address: Displays the device address enclosed by [ ]

Example: <<1:'313233' 2:'343536' 3 :'373839' [LDR0100]>>
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■ Command Size
Displays the data size of a configured command.
The calculation method for command size varies based on the type selected in Command Type on the Command 
Settings dialog box. The command size calculation methods are as follows.

BCC: Displays the specified data enclosed in BCC ( ). 
BCC(Calculation Start Position   Calculation End Position   Calculation Type    
Conversion Type   Number of bytes)

Calculation Start Position:

Displays the data position where the BCC calculation 
starts.

Calculation End Position:

Displays the data position where the BCC calculation ends.

Calculation Type: Display the methods to calculate the data between the 
Calculation Start Position and Calculation End Position as 
follows.
XOR: When XOR is selected
ADD: When ADD is selected
ADD2: When ADD (2's Complement) is selected

Conversion Type: Display the conversion methods for values of device 
addresses as follows. 
B16-A: When Binary (Hex) to ASCII is selected
N: When No conversion is selected

Number of bytes: Displays the number of bytes of the transmitted or 
received data.

Example: BCC(2 1 XOR N 2)

Skip: Displays the specified data enclosed in Skip( ). 
Skip(Number of bytes)
Example: Skip(2)

Edit: Add or change data.
To add data, select an empty line in the Command, and then click this button. To 
change data, select data in the Command, and then click this button. For details, refer 
to “Data Settings Dialog Box” on page 3-36.

Insert: Insert data at the position of the selected command.
Click this button to display the Data Settings dialog box. And specify the data. The data 
at the insertion point shifts down by 1 item. When 32 data items are already set, you 
cannot insert data.

Delete: Deletes the selected data.

Up: Shifts the selected data upward in the command.

Down: Shifts the selected data downward in the command.

TXD: Number of bytes for Constant Data + Number of bytes for a data of Registering Constant + Number of 
bytes of BCC + Number of bytes of Device Address x Words of Device Address

RXD: Number of bytes for Constant Data + Number of bytes for a data of Registering Constant + Number of 
bytes of BCC + Number of bytes of Skip + Number of bytes of Device Address x Words of Device Address
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● Data Settings Dialog Box
Specify the transmitted or received data by a command.

■ Type
Selects data types from the following items.
Constant (Character), Constant (Hexadecimal), Device Address, Registering Constant (Character), 
Registering Constant (Hexadecimal), BCC, Skip
Skip can only be configured when RXD is selected in Command Type on the Command Settings dialog box.

Setting item varies based on the selection in Command Type on the Command Settings dialog box.
When TXD is selected, refer to “Transmission (TXD) Command” on page 3-37.
When RXD is selected, refer to “Receive (RXD) Command” on page 3-50.
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● Transmission (TXD) Command

Constant (Character)

The character data is sent without being converted. 
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Constant (Character) is selected under Type on the Data Settings dialog box.

■ Data
Enter character data to be transmitted (1 to 1,500 bytes). The size of a single-byte character is one byte and that of 
a double-byte character is two bytes.

Example: Constant (Character) for transmission command data

When the trigger condition is satisfied, the character data is transmitted in the following order.

Item Setting

Data 1234

1234 1
(31h)

Transmission data
Data

2
(32h)

3
(33h)

4
(34h)

Order of transmission

No 
conversion
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Constant (Hexadecimal)

The hexadecimal data is sent without being converted.
Use this setting to send a control code of ASCII data (00h to 1Fh).
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Data
Enter hexadecimal data to be transmitted (1 to 1,500 bytes).

Example: Constant (Hexadecimal) for transmission command data

When the trigger condition is satisfied, 1234h is transmitted in the order 12h and 34h.

Item Setting

Data 1234

1234h
No 

conversion

12h

Transmission data
Data

34h

Order of transmission
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Device Address

The value of device address is either not converted or converted to ASCII and then sent as data with the specified size.
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Device Address is selected under Type on the Data Settings dialog box.

■ Conversion Type:
Select the conversion rule for the value of device address from the following.

■ Device Address
Specify the source word device for transmitted data. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Use Reference Device Address
To change the source word device for transmitted data according to values of device address, select this check box 
and specify a device address. This can be configured only when No conversion is selected under Conversion 
Type. You can only specify an internal device.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 2-4.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Storage Method of data
Select the handling method for the value of read device address. This can be configured only when No conversion is 
selected under Conversion Type.

■ Number of bytes
Specify the number of bytes of transmitted data. The number of bytes that can be specified varies based on the 
setting under Conversion Type.

■ Words
Specify the number of word devices (1 to 99) of transmitted data.

Binary (Hex) to ASCII: Considers the value of device address as binary-coded hexadecimal number and converts it 
to ASCII data.

Binary (Dec) to ASCII: Considers the value of device address as binary-coded decimal number and converts it to 
ASCII data.

No conversion: No conversion is performed.

from Upper byte: Value of device addresses are read from the upper byte.
from Lower byte: Value of device addresses are read from the lower byte.

Binary (Hex) to ASCII: 1 to 4
Binary (Dec) to ASCII: 1 to 5
No conversion: 1 to 2
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■ Variable
Select this check box to change the transmitted data size according to conditions. This can be configured only when 
No conversion is selected under Conversion Type. When the check box is not selected, the amount of data 
(bytes) transmitted is data (bytes) for Number of bytes x Words.

Examples: Device address for transmission command data

Example 1

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following 
order.

Example 2

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following 
order.

NULL (00h): Send the data from the start data of the value of device address up to 00 (hexadecimal). Data 00 
will not be sent. This setting is effective for sending only the character data section of character 
data having 00 (hexadecimal) as the last data.

Device Address: Specify a word device to which a number of bytes is applied for transmitted data.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
When the value of device address exceeds Number of bytes x Words, or when it is negative, the 
Device Data Variable Specification Error (address number+0, bit 6) of the Status Device Address 
changes to 1, and transmission does not occur.

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Upper byte

Number of bytes 1

Words 3

Variable OFF

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 3

Variable OFF

1234hLDR100:
5678hLDR101:
9ABChLDR102:

No conversion

12h

Upper Lower
Value of Device Address

34h

56h 78h

9Ah BCh

from Upper byte 
1 byte

Transmission data

12h 56h 9Ah

Order of transmission

Words: 3

LDR100:
LDR101:

Transmission data

34h 12h 78h

9ABChLDR102:

9Ah BCh

56h BCh 9Ah

Order of transmission

1234h
5678h

12h 34h

56h 78h

No conversion

Upper Lower
Value of Device Address

from Lower byte 
2 bytes

Words: 3
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Example 3

When the trigger condition is satisfied, the value of device address is read, and data is converted to ASCII and 
transmitted in the following order.

Example 4

When the trigger condition is satisfied, the value of device address is read, and data is converted to ASCII and 
transmitted in the following order.

Example 5

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following 
order.

Item Setting

Conversion Type Binary (Hex) to ASCII

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type Binary (Dec) to ASCII

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Upper byte

Number of bytes 2

Words 2

Variable ON, NULL

1234hLDR100:
5678hLDR101:

Binary (Hex) to ASCII

1
(31h)

Value of Device Address
4

(34h)

5
(35h)

2
(32h)

6
(36h)

3
(33h)

7
(37h)

8
(38h)

2 bytes

Transmission data

3
(33h)

4
(34h)

7
(37h)

8
(38h)

Order of transmission

Words: 2

1234LDR100:
5678LDR101:

1
(31h)

4
(34h)

5
(35h)

2
(32h)

6
(36h)

3
(33h)

7
(37h)

8
(38h)

3
(33h)

4
(34h)

7
(37h)

8
(38h)

Binary (Dec) to ASCII

Value of Device Address
Transmission data

Order of transmission

2 bytes
Words: 2

1234hLDR100:
0056hLDR101:

No conversion

12h

Upper Lower
Value of Device Address

34h

56h00h
from Upper byte 

2 bytes

Transmission data

12h 34h

Order of transmission

Words: 2
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Example 6

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following 
order.
When the LDR200 value is 3

Example 7

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following 
order.
When the LDR200 value is 2

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 2

Variable ON, Device Address: LDR200

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address ON, Device Address: LDR200

Storage Method of data from Upper byte

Words 2

Variable OFF

LDR100:
LDR101:

No conversion

Transmission data

34h 12h 78h

Order of transmission

1234h
5678h

12h 34h

56h 78h

Upper Lower
Value of Device Address

from Lower byte 
2 bytes

Words: 2

LDR200=3

1234hLDR100:
5678hLDR101:
2537hLDR102:
4619hLDR103:

No conversion

25h

Upper Lower

Value of Device Address

37h

46h 19h

LDR200=2

Words: 2

Transmission data

25h 37h 46h 19h

Order of transmission

from Upper byte 
2 bytes
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Registering Constant (Character)

From the registered character data, character data according to the value of device address is read and transmitted.
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Registering Constant (Character) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered character data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the character data.

■ Data
Enter the character data (1 to 1500 bytes) to be registered. The size of a single-byte character is one byte and that of 
a double-byte character is two bytes.
The character data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a character data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down 1 line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device Address
Specify the source word device to serve as the Index No. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

No.: Shows the ID No. (1 to 100) of the character data.

Index: Shows the Index No. of the character data.

Data: Shows the character data.
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Example: Transmission command for Registering Constant (Character) data

When the trigger condition is satisfied, the data of the Index No. according to the value of device address is 
transmitted.
When the LDR100 value is 2

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 123

Index No. 2: 456

Index No. 3: 789

Index Device Address LDR100

1231:
4562:
7893: Index Device Address

LDR100=2

DataIndex No.

Number of 
Registering 

Constants: 3

Transmission data

4
(34h)

5
(35h)

6
(36h)

Order of transmission
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Registering Constant (Hexadecimal)

From the registered hexadecimal data, the hexadecimal data according to the value of device address is read and 
transmitted.
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Registering Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered hexadecimal data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the hexadecimal data.

■ Data
Enter the hexadecimal data (1 to 1500 bytes) to be registered.
The data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a hexadecimal data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down one line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device Address
Specify the source word device to serve as the Index No. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

No.: Shows the ID No. (1 to 100) of the hexadecimal data.

Index: Shows the Index No. of the hexadecimal data.

Data: Shows the hexadecimal data.
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Example: Transmission command for Registering Constant (Hexadecimal) data 

When the trigger condition is satisfied, the data of the Index No. according to the value of device address is 
transmitted.
When the LDR100 value is 3

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 1234

Index No. 2: 5678

Index No. 3: 2537

Index Device Address LDR100

1234h1:
5678h2:
2537h3:

Index Device Address
LDR100=3

DataIndex No.

Number of 
Registering 

Constants: 3

Transmission data

25h 37h

Order of transmission
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BCC (Block Check Code)

A BCC for the transmission data is automatically calculated and appended to the transmission data at an arbitrary 
position and transmitted.
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
BCC is selected under Type on the Data Settings dialog box.

■ Calculation Start Position
Specify the position of transmission data at which BCC calculation starts (1 to 15). The position is counted backwards, 
with the first position of the transmission data taken as 1.

■ Calculation End Position
Specify the position of transmission data at which BCC calculation ends (0 to 15). The position is counted forwards, 
with the data position before the BCC taken as 0.

■ Calculation Type
Select the method to calculate the data between the Calculation Start Position and Calculation End Position.

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

Transmission data:

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(5) (4) (3) (2) (1) (0)Calculation End Position:

Transmission data:

XOR: Calculates the data with exclusive logical add.

ADD: Calculates the data using addition.

ADD (2's Complement): Calculates the data using addition, inverts the bit and adds one.

Modbus ASCII (LCR): Calculation is performed according to the following procedure. Conversion Type: 
Binary (Hex) to ASCII, Number of bytes: 2

1. Convert the ASCII characters between Calculation Start Position and Calculation End 
Position into 1-byte hexadecimal data for each set of two characters.
Example: 37h, 35h→75h

2. Calculate the sum of the data obtained in step 1.

3. Invert the bit of the result of step 2 and add one. (2’s complement)

4. Convert the lower one byte data of the result of step 3 into ASCII characters.
Example: 75h→37h, 35h
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■ Conversion Type
After calculating the data using the specified calculation type, select the type of conversion for the data from the 
following.

■ Number of bytes
After converting according to the specifed conversion type, select 1 or 2 for the number of bytes for transmission 
data.

Example: BCC for transmission command data
This example describes the case of transmitting the BCC calculation result from the following transmission data as 
BCC data.

• Calculation Start Position and Calculation End Position
When Calculation Start Position is 2 and Calculation End Position is 1: Calculates the range 1234.

• Calculation Type

• Conversion Type
When the BCC calculation result is 0004h, the converted data is as follows.

Modbus RTU (CRC): CRC-16 (Generating polynomial:x16+x15+x2+1) is calculated according to the following 
procedure. Conversion Type: No conversion, Number of bytes: 2

1. Obtain an exclusive OR (XOR) of 1 byte data at Calculation Start Position and FFFFh.

2. If the least significant bit of the result of step 1 is 0, shift to the right by one bit. If the 
bit is 1, shift to the right by 1 bit and obtain XOR of the result and the value (A001h).

3. Repeat step 2 to shift 8 times.

4. Obtain XOR of the next one byte of data and the result of step 3.

5. Repeat steps 2 through 4 until the data at Calculation End Position is processed.

6. Send the result of step 5 in the order of the lower byte and upper byte.
Example: 1234h→34h, 12h

Binary (Hex) to ASCII Considers the data as binary-coded hexadecimal number and converts it to ASCII data.

No conversion: No conversion is performed.

XOR: 31h^32h^33h^34h^=04h

ADD: 31h+32h+33h+34h=CAh

ADD (2's Complement): Inverts the bit of CAh+1=36h

Modbus ASCII (LCR): BA → 42h, 41h

Modbus RTU (CRC): BA30h → BAh, 30h

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

(5) (4) (3) (2) (1) (0)Calculation End Position:

Data used for BCC calculation

0004h

Binary (Hex) to ASCII

0
(30h)

Data
4

(34h)

0004h

No conversion

00h
Data

04h
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• Bytes and BCC data
When the converted data is 3034h, the data appended to the transmission data is as follows.

• When Calculation Type is Modbus ASCII (LCR)
When the BCC calculation result is 4241h after Binary (Hex) to ASCII conversion the resulting two bytes of data 
is appended to the transmission data. 

• When Calculation Type is Modbus RTU (CRC)
When the BCC calculation result is BA30h with no conversion the two bytes of data is appended to the 
transmission data.

0
(30h)

4
(34h)

1 byte

BCC data(Second byte)  (First byte)
Converted data

4
(34h)

0
(30h)

4
(34h)

BCC data

0
(30h)

4
(34h)

2 bytes

Converted data
(Second byte)  (First byte)

B
(42h)

A
(41h)

B
(42h)

A
(41h)

BCC data

4241h

Binary (Hex) to ASCII

Data 

2 bytes

Converted data
(Second byte)  (First byte)

BAh 30h BAh 30hBA30h

No conversion

BCC dataData 

2 bytes

Converted data
(Second byte)  (First byte)
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● Receive (RXD) Command

Constant (Character)

The received data is considered as character data and compared with the data specified without being converted.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Constant (Character) is selected under Type on the Data Settings dialog box.

■ Data
Enter character data designated to be received (1 to 1,500 bytes). The size of a single-byte character is one byte and 
that of a double-byte character is two bytes.

Example: Constant (Character) for receive command data

When the trigger condition is satisfied, the received data is compared with the following data.

When a Constant (Character) is set at the beginning of a command, the first one byte is recognized as the 
start code. When a Constant (Character) is set at the end of a command, the last one byte is recognized as 
the terminal code.
For details, refer to “Start Code and Terminal Code” on page 3-66.

Item Setting

Data 1234

1234 1
(31h)

Data used for comparison with received data
Specified data

2
(32h)

3
(33h)

4
(34h)

Order of reception

No 
conversion
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Constant (Hexadecimal)

The received data is considered as hexadecimal data and compared with the data specified without being converted.
Use this setting to receive a control code of ASCII data (00h to 1Fh).
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Data
Enter hexadecimal data designated to be received (1 to 1,500 bytes).

Example: Constant (Hexadecimal) for receive command data

When the trigger condition is satisfied, the received data is compared with the following data.

When a Constant (Character) is set at the beginning of a command, the first one byte is recognized as the 
start code. When a Constant (Character) is set at the end of a command, the last one byte is recognized as 
the terminal code.
For details, refer to “Start Code and Terminal Code” on page 3-66.

Item Setting

Data 1234

1234h
No conversion

12h

Data used for comparison with received data
Specified data

34h

Order of reception
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Device Address

From the received data, data of the specified size is unconverted, or converted to binary format, and stored in the 
device.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Device Address is selected under Type on the Data Settings dialog box.

■ Conversion Type
Select conversion processing for the received data from the following.

■ Device Address
Specify the word device for storing the received data. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Use Reference Device Address
To change the word device for storing the received data according to values of device addresses, select this check box 
and specify a device address. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Storage Method of data
Select the handling method for received data. This can be configured only when No conversion is selected under 
Conversion Type.

■ Number of bytes
Specify the received data size to be stored per word. The number of bytes to be specified varies based on 
Conversion Type.

■ Words
Specify the number of word devices (1 to 250) for storing the received data.

ASCII (Hex) to Binary: Considers the received data as a hexadecimal number and converts it to binary data.

ASCII (Dec) to Binary: Considers the received data as a decimal number and converts it to binary data.

No conversion: No conversion is performed.

from Upper byte: Values of device addresses are stored from the upper byte.

from Lower byte: Values of device addresses are stored from the lower byte.

ASCII (Hex) to Binary: 1 to 4

ASCII (Dec) to Binary: 1 to 5

No conversion: 1 to 2
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■ Variable
Select this check box to store data up to either Constant (Character) data, or Constant (Hexadecimal) data from 
the beginning of the received data in a device. Stores data of the size specified under Words.
When the stored data is smaller than the size specified under Words, the values of all remaining devices will stored 0.

When the check box is not selected, the amount of data (bytes) stored is Number of bytes x Number of words.

Examples: Device address for receive command data

Example 1

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.

Example 2

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.

3231hLDR100:
3433hLDR101:
0000hLDR102:

1
(31h)

Value of Device Address
2

(32h)

3
(33h)

4
(34h)

Number of specified words: 3Number of words for stored data: 2

The stored data is smaller than the size specified for Words.

No 
conversion

Stored data

Insufficient by 1 word
0 is stored.

When the Variable check box is selected, observe the following points.
• When data is set expect for the end of a command, set Constant (Character) data or Constant 

(Hexadecimal) data following Device Address data.
• When there is no data stored in the device address, all of the values of device addresses specified under 

Words will be 0.
• The maximum amount of the received data stored in the device address is Number of bytes x Number of 

words. 

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Upper byte

Number of bytes 1

Words 3

Variable OFF

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 2

Variable OFF

3100hLDR100:
3200hLDR101:
3300hLDR102:

No conversion

1
(31h)

Upper Lower
Value of Device Address

0
(00h)

2
(32h)

0
(00h)

3
(33h)

0
(00h)

Received data

1
(31h)

2
(32h)

3
(33h)

Order of reception

Words: 3from Upper byte 
1 byte

from Lower byte 
2 bytes

3231hLDR100:
3433hLDR101:

No conversion

2
(32h)

Upper Lower
Value of Device Address

1
(31h)

4
(34h)

3
(33h)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

Words: 2
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Example 3

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.

Example 4

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.

Example 5

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device address. 
Constant (Hexadecimal) data is not stored.

Item Setting

Conversion Type ASCII (Hex) to Binary

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type ASCII (Dec) to Binary

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Upper byte

Number of bytes 1

Words 3

Variable ON

0012hLDR100:
0034hLDR101:

ASCII (Hex) to Binary

2
(32h)

Value of Device Address
1

(31h)

4
(34h)

3
(33h)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

Words: 2
2 bytes

12LDR100:
34

(DEC)
(DEC)LDR101:

ASCII (Dec) to Binary

2
(32h)

Value of Device Address
1

(31h)

4
(34h)

3
(33h)

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

Words: 2

Received data

2 bytes

3100hLDR100:
3300hLDR101:
0000hLDR102:

1
(31h)

Value of Device Address

The stored data is smaller than the 
size specified for Words.

0 is stored.

NUL
(00h)

3
(33h)

NUL
(00h)

1
(31h)

3
(33h)

ETX
(03h)

Order of reception

Words: 3

Received data

Upper Lower

from Upper byte 
1 byte

Constant (Hexadecimal) data

Constant (Character) data
0 is stored.

Stored data
No 

conversion

Insufficient by 1 word
0 is stored.
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Example 6

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device address. 
Constant (Hexadecimal) data is not stored.

Example 7

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device address. 
Constant (Hexadecimal) data is not stored.

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 3

Variable ON

Item Setting

Conversion Type ASCII (Hex) to Binary

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 1

Words 3

Variable ON

3231hLDR100:
0033hLDR101:
0000hLDR102:

1
(31h)

Value of Device Address
2

(32h)

3
(33h)

NUL
(00h)

1
(31h)

2
(32h)

3
(33h)

ETX
(03h)

Order of reception

Words: 3

Received data

Upper Lower

from Lower byte 
2 bytes

Constant (Hexadecimal) dataStored data
No 

conversion

Constant (Character) data
0 is stored.

The stored data is smaller than the 
size specified for Words.

Insufficient by 1 word
0 is stored.

0001hLDR100:
0003hLDR101:
0000hLDR102:

ASCII (Hex) to Binary Value of Device Address
1

(31h)

3
(33h)

3
(33h)

1
(31h)

ETX
(03h)

Order of reception

Words: 3

The stored data is smaller than the 
size specified for Words.

1 byte

Received data
Constant (Hexadecimal) dataStored data

Insufficient by 1 word
0 is stored.
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Example 8

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device address. 
Constant (Hexadecimal) data is not stored.

Example 9

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
When the LDR200 value is 2

Item Setting

Conversion Type ASCII (Dec) to Binary

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 3

Variable ON

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address ON, Device Address: LDR200

Storage Method of data from Upper byte

Words 2

Variable OFF

LDR100:
LDR101:
LDR102:

2
(32h)

Value of Device Address
1

(31h)

3
(33h)

NUL
(00h)

1
(31h)

2
(32h)

3
(33h)

ETX
(03h)

Words: 3
12
3

(DEC)
(DEC)

0

ASCII (Dec)
 to Binary

(DEC)

2 bytes

Received data
Constant (Hexadecimal) dataStored data

Order of reception

Constant (Character) data
0 is stored.

The stored data is smaller than the 
size specified for Words.

Insufficient by 1 word
0 is stored.

0000hLDR100:
0000hLDR101:
3132hLDR102:
3334hLDR103:

No conversion

1
(31h)

Upper  Lower

Value of Device Address

2
(32h)

3
(33h)

4
(34h)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

LDR200=2

Words: 2Bytes: 2
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Registering Constant (Character)

The received data is compared with the registered character data and the number of the matching character data is 
stored in the device address.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Registering Constant (Character) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered character data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the character data.

■ Data
Enter the character data (1 to 1500 bytes) to be registered. The size of a single-byte character is one byte and that of 
a double-byte character is two bytes.
The character data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a character data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down 1 line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device Address
Specify the word device for storing the Index No. of the character data matching the received data. You can only 
specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

No.: Shows the ID No. (1 to 100) of the character data.

Index: Shows the Index No. of the character data.

Data: Shows the character data.
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Example: Registering Constant (Character) for receive command data

When the trigger condition is satisfied, the received data is compared with the registered data, and the value of the 
Index No. 2 of the matching data is stored in Index Device Address LDR100.

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 123

Index No. 2: 456

Index No. 3: 789

Index Device Address LDR100

Received data

Compare

4
(34h)

5
(35h)

6
(36h)

Order of reception

2LDR100:
Value of the Index Device Address1231:

4562:
7893:

DataIndex No.

Number of 
Registering 

Constants: 3

(DEC)
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Registering Constant (Hexadecimal)

The received data is compared with the registered hexadecimal data and the number of the matching hexadecimal 
data is stored in the device address.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Registering Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered hexadecimal data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the hexadecimal data.

■ Data
Enter the hexadecimal data (1 to 1500 bytes) to be registered.
The hexadecimal data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a hexadecimal data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down 1 line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device Address
Specify the word device for storing the Index No. of the hexadecimal data matching the received data. You can only 
specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

No.: Shows the ID No. (1 to 100) of the hexadecimal data.

Index: Shows the Index No. of the hexadecimal data.

Data: Shows the hexadecimal data.
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Example: Registering Constant (Hexadecimal) for receive command data

When the trigger condition is satisfied, the received data is compared with the registered hexadecimal data, and the 
value of the Index No. 2 of the matching data is stored in Index Device Address LDR100.
When the LDR100 value is 3

Example of applying Registering Constant
When the same device address is specified for the Index Device Address for Registering Constant (Character) 
data or Registering Constant (Hexadecimal) data and for Use Reference Device Address for Device 
Address data, the data storage destination for each unit of received data can be changed.

When the following commands are received

• The first 1 byte is taken as the start code. Constant (Hexadecimal) data is not stored.

• The received data is compared with the registered data, and the value of the Index No. 2 (Dec) of the matching 
data is stored in Index Device Address LDR100.

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 1234

Index No. 2: 5678

Index No. 3: 2537

Index Device Address LDR100

Received data

Compare

25h 37h

Order of reception

3LDR100:
Value of the Index Device Address1234h

5678h
2537h

1:
2:
3:

DataIndex No.

Number of 
Registering 

Constants: 3

(DEC)

Data type Item Setting

Constant (Hexadecimal) Data 02

Registering Constant (Character)

Number of Registering Constants 2

Registering Constant
Index No. 1: AA

Index No. 2: BB

Index Device Address LDR100

Device Address

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address ON, Device Address: LDR200

Storage Method for Data from Upper byte

Bytes 2

Words 2

Variable OFF

Constant (Hexadecimal) Data 0D

STX
(02h)

B
(42h)

B
(42h)

1
(31h)

2
(32h)

CR
(0Dh)

STX
(02h)

Received data

Compare

B
(42h)

B
(42h)

Order of reception

2LDR100:
Value of the Index Device AddressAA

BB
1:
2:

DataIndex No.
Number of 
Registering 

Constants: 2
(DEC)
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• Since the Indirect Device Address LDR100 of Device Address of the receive command data is 2 (Dec), the data is 
stored in the device address LDR202, which is offset by +2.

• The last 1 byte is taken as the terminal code. Constant (Hexadecimal) data is not stored.

0000hLDR200:
0000hLDR201:
3132hLDR202:

Value of Device Address

LDR100=2

CR
(0Dh)



5 User Communication

3-62 WindO/I-NV4 User’s Manual

BCC (Block Check Code)

The BCC comparison data is automatically calculated from the receive data and compared with the BCC part of the 
receive data.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
BCC is selected under Type on the Data Settings dialog box.

■ Calculation Start Position
Specify the position (1 to 15) in the receive data where BCC calculation starts. The position is counted backwards, 
with the first position of the receive data taken as 1.

■ Calculation End Position
Specify the position (0 to 15) in the receive data where BCC calculation ends. The position is counted forwards, with 
the data position before the BCC taken as 0.

■ Calculation Type
Select the method to calculate the data between the Calculation Start Position and Calculation End Position.

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

Receive data:

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(5) (4) (3) (2) (1) (0)Calculation End Position:

Receive data:

XOR: Calculates the data with exclusive logical add.

ADD: Calculates the data using addition.

ADD (2's Complement): Calculates the data using addition, inverts the bit and adds one.

Modbus ASCII (LCR): Calculation is performed according to the following procedure. Conversion Type:
Binary (Hex) to ASCII, Number of bytes: 2

1. Convert the ASCII characters between Calculation Start Position and Calculation End 
Position into 1-byte hexadecimal data for each set of two characters. 
Example: 37h, 35h → 75h

2. Calculate the sum of the data obtained in step 1.

3. Invert the bit of the result of step 2 and add one. (2’s complement)

4. Convert the lower one byte data of the result of step 3 into ASCII characters.
Example: 75h → 37h, 35h
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■ Conversion Type
After calculating the data using the specified calculation type, select the type of conversion for the data from the 
following.

■ Number of bytes
After converting according to the specified conversion type, select 1 or 2 for the number of bytes for comparison 
data.

Example: BCC for receive command data
This example describes the case of comparing the BCC calculation result for the following receive data with the BCC 
part of the receive data.

• Calculation Start Position and Calculation End Position
When Calculation Start Position is 2 and Calculation End Position is 1: Calculates the range 1234.

• Calculation Type

• Conversion Type
When the BCC calculation result is 0004h, the converted data is as follows.

Modbus RTU (CRC): CRC-16 (Generating polynomial:x16+x15+x2+1) is calculated according to the following 
procedure. Conversion Type: No conversion, Number of bytes: 2

1. Obtain an exclusive OR (XOR) of 1 byte data at Calculation Start Position and FFFFh.

2. If the least significant bit of the result of step 1 is 0, shift to the right by one bit. If the 
bit is 1, shift to the right by 1 bit and obtain XOR of the result and the value (A001h).

3. Repeat step 2 to shift 8 times.

4. Obtain XOR of the next one byte of data and the result of step 3.

5. Repeat steps 2 through 4 until the data at Calculation End Position is processed.

6. Compare the result of step 5 in the order of the lower byte and upper byte.
Example: 1234h → 34h, 12h

Binary (Hex) to ASCII: Considers the data as binary-coded hexadecimal number and converts it to ASCII data.

No conversion: No conversion is performed.

XOR: 31h^32h^33h^34h^=04h

ADD: 31h+32h+33h+34h=CAh

ADD (2's Complement): Inverts the bit of CAh+1=36h

Modbus ASCII (LCR): BA→42h, 41h

Modbus RTU (CRC): BA30h→BAh, 30h

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

(5) (4) (3) (2) (1) (0)Calculation End Position:

Data used for BCC calculation

0004h

Binary (Hex) to ASCII

0
(30h)

Data
4

(34h)

0004h

No conversion

00h
Data

04h
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• Number of bytes and comparison data
When the converted data is 3034h, the data used for comparison with the BCC part of the receive data is as 
follows.

• BCC data comparison
The comparison data is compared with the BCC part of the receive data.
In the following receive data, when the comparison data is the 1-byte 34h, there is a match since the BCC part data 
is 34h.
When there is no match, the BCC Error (address number+0, bit 0) of the Status Device changes to 1.

• When the calculation type is Modbus ASCII (LCR)
When the BCC calculation result is 4241h after Binary (Hex) to ASCII conversion the resulting two bytes of data 
is used for comparison with the BCC part of the receive data.

• When the calculation type is Modbus RTU (CRC)
When the BCC calculation result is BA30h with no conversion the two bytes of data is used for comparison with 
the BCC part of the receive data.

0
(30h)

4
(34h)

Comparison data

4
(34h)

Bytes: 1

Converted data
(Second byte)  (First byte)

0
(30h)

4
(34h)

0
(30h)

4
(34h)

Comparison data

Bytes: 2

Converted data
(Second byte)  (First byte)

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC
(34h)

CR
(0Dh)

Comparison data

Match

Receive data BCC part

4
(34h)

B
(42h)

A
(41h)

B
(42h)

A
(41h)

Comparison data

4241h

Binary (Hex) to ASCII

Data

Bytes: 2

Converted data
(Second byte) (First byte)

BAh 30h BAh 30hBA30h
No conversion

Comparison data
Data

Bytes: 2

Converted data
(Second byte) (First byte)
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Skip

The data with the specified number of bytes in the receive data will be ignored.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Skip is selected under Type on the Data Settings dialog box.

■ Number of bytes
Specify the number of bytes (1 to 249) of receive data to be ignored.

Example: Skip for receive command data 

In the received four byte data (1 (31h), 2 (32h), 3 (33h), 4 (34h)), only the data for 3 (33h) and 4 (34h) is received 
and the two bytes of 1 (31h) and 2 (32h) are discarded.

Item Setting

Number of bytes 2

Enabled data

4
(34h)

3
(33h)

2 bytes
(Ignored)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception
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● Start Code and Terminal Code
A start code starts data reception and a terminal code judges the terminal of data reception. A start code and a 
terminal code can be configured for either Constant (Character) or Constant (Hexadecimal) settings for receive 
command. The first 1 byte of the constant is recognized as the start code and the last 1 byte as the terminal code.

Code 00h to 7Fh can be set when Data Length under Interface Settings is 7 bits, and 00h to FFh when the data length 
is 8 bits. Data Length is configured under the Communication Interface tab on the Project Settings dialog box.
The procedure for terminal of data reception varies whether or not the receive data contains a start code and a 
terminal code, and whether the Variable check box for Device Address for receive command data is selected.
In the following description, With Variable indicates that the Variable check box for Device Address for receive 
command data is selected and Without Variable indicates that the Variable check box is not selected. Also, when 
there are multiple Device Address set for receive command data, and at least 1 command has the Variable check 
box selected, this corresponds to With Variable.

Start code Terminal 
code Variable Description of the procedure for terminal of data reception

Set Set
Set

Not set

Reception is started with the start code and terminated with the terminal code.

When the terminal code is followed by BCC, the data including the number of bytes of 
BCC is received.

Set Not set

Set

Reception is started with the start code and the data is received according to the 
maximum command length.

Reception is terminated when the Receiving Character Time Out occurs.

Not set

Reception is started with the start code and the data is received according to the length of 
the command.

'02' '31' '32' '33' <[LDR0100] N 2 2 U>Receive data:

Constant
(Hexadecimal)

'34' '35' '0d'

Constant
(Hexadecimal)Device AddressCommand settings:

Start code 02h Terminal code 0dh

'02' '31' '32' '33' <[LDR0100] N 2 2 U>Receive data: '34' '35' '0d'
Device Address

Receive

Constant
(Hexadecimal)

Constant
(Hexadecimal)Command settings:

Start code 02h Terminal code 0dh

'02' '31' '32' '33' <[LDR0100] N 2 2 U>Receive data: '34' '35' '0d' BCC(1 0 XOR N 1)
BCCDevice Address

Receive

Constant
(Hexadecimal)

Constant
(Hexadecimal)Command settings:

Start code 02h Terminal code 0dh

'02' '31' '32' <[LDR0100] N 2V 2 U>Receive data:

Constant
(Hexadecimal)

<<1:”AB” 2:”CD” [LDR0200]>>
Registering Constant (Hexadecimal)Device Address With Variable

Maximum command length

Receive

Command settings:

Start code 02h Terminal code: None

'02' '31' '32' <[LDR0100] N 2V 2 U>Receive data:

Constant
(Hexadecimal)

'03' <<1:”AB” 2:”CD” [LDR0200]>>

Constant
(Hexadecimal)

Registering Constant
(Hexadecimal)

Device Address
With Variable

Receive

Command settings:

Start code 02h Terminal code: NoneReceiving character 
time out occurs.

'02' '31' '32' <[LDR0100] N 2 2 U>Receive data:

Constant
(Hexadecimal)

<<1:”AB” 2:”CD” [LDR0200]>>

Registering
Constant (Hexadecimal)Device Address Without Variable

Command length

Receive

Command settings:

Start code 02h Terminal code: None



WindO/I-NV4 User’s Manual 3-67

5 User Communication

3

Com
m

unication

Not set Set
Set

Not set

Reception is started from the beginning and terminated with the terminal code.

Not set Not set

Set

Reception is started from the beginning and the data is received according to the 
maximum command length.

Reception is terminated when the Receiving Character Time Out occurs.

Not set

Reception is started from the beginning and terminated when the data is received 
according to the length of the command.

Start code Terminal 
code Variable Description of the procedure for terminal of data reception

<[LDR0100] N 2 2 U>Receive data: <<1:”AB” 2:”CD” [LDR0200]>>

Registering
Constant (Hexadecimal) Device Address

'34' '35' '0d'

Constant
(Hexadecimal)

Receive

Command settings:

Start code: None Terminal code 0dh

Skip(2) <[LDR0100] N 2V 2 U>Receive data:

Skip

“123” 
Device Address With Variable

Maximum command length

Receive

Command settings:
Constant 

(Character)

Start code: None Terminal code: None

Skip(2) <[LDR0100] N 2V 2 U>Receive data:

Skip

“123” 

Constant 
(Character) Device Address With Variable

Receive

Command settings:

Start code: None Terminal code: None

Receiving character time out occurs.

<[LDR0100] N 2 2 U>Receive data: <<1:”AB” 2:”CD” [LDR0200]>>
Registering Constant (Hexadecimal)Device Address Without Variable

Command length

Receive

BCC(1 0 XOR N 1)
BCCCommand settings:

Start code: None Terminal code: None

• When trigger conditions are satisfied for two or more receive commands for which both start code and 
terminal code are set, all commands are analyzed and processed for receive processing. Since 
commands with and without errors may be mixed depending on the results of data reception analysis of 
each command, take extra caution regarding error handling.

• While the trigger condition is satisfied for a receive command for which either a start code or terminal 
code is not set, only this command is processed for data reception when the trigger condition of another 
command is being satisfied. When two or more commands exist for which either start code or terminal 
code is not set, the command with the biggest number for managing the protocol is processed.

• When a start code of the receive command for which a start code is set cannot be received, all of the 
receive data is ignored and abandoned. No error occurs.

• When start code is received with a receive command for which start code and terminal code are set, the 
data reception is completed after the maximum number of bytes received in case of continuous 
reception of data that does not match the terminal code of all receive command in which the trigger 
conditions is satisfied.
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5.4 Example of User Communication Settings

This section describes examples of user communication settings and command operations.

● Example 1
This section describes an example of user communication protocol settings for creating the following commands and 
command operations.
• Transmission command for transmitting data using Constant (Hexadecimal), Constant (Character), Device Address, 

Constant (Hexadecimal) command settings when the trigger condition device address changes to 1 
• Receive command for receiving, processing, and storing data in device addresses, using Constant (Hexadecimal), 

Constant (Character), Device Address, Constant (Hexadecimal) command settings, for data transmitted from an 
external device, when the trigger condition device address is 1

■ User Communication Protocol Settings dialog box settings

Transmission command: Command Settings dialog box settings

Operation for transmission command

1 Write a value of 100 (Dec) to LDR100 of transmission command data Device Address.

2 Change the trigger condition LM100 from 0 to 1 to start command transmission.

After the transmission wait duration (five seconds), the transmission data is sent. The transmission data is as follows.

• When data transmission is successfully completed, the Completed Device Address LM101 changes to 1.
• When the value of each bit of address number+0 for Status Device Address LDR110 is 0, transmission is completed 

without an error.

Item Setting

Protocol Name Sample 1

Receiving Character Time Out 30 (×100 msec)

Item Setting

Comment TXD command

Command Type TXD

Completed Device Address LM101

Status Device Address LDR110

Transmission Wait 50 (×100 msec)

Trigger Condition Rising-edge, Device Address: LM100

Command
Data Settings dialog box settings

Constant 
(Hexadecimal)

'05'

Constant 
(Character)

"D"

Device Address
Conversion Type: Binary (Dec) to ASCII, 
Number of bytes: 4, Words: 1
Device Address: LDR100

Constant 
(Hexadecimal)

'0D'

D
(44h)

0
(30h)

0
(30h)

0
(30h)

EQN
(05h)

1
(31h)

CR
(0Dh)

Transmission data:

Constant
(Hexadecimal)

Constant 
(Character) Device Address

Command settings:

Constant
(Hexadecimal)
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Receive command: Command Settings dialog box settings

Operation for receive command

1 When data transmission of the transmission command is completed, the value of LM101 changes to 1, and since the 
same device address is specified for the trigger condition user communication becomes ready for receiving.

2 Data is transmitted from the external device and the transmitted data is received and processed.

The receive data is as follows.

Since a value of 100 is written to LDR100 at the time of transmission, the data is stored in device address LDR220, 
which corresponds to an offset of +100 from LDR120.

• When data reception is successfully completed, the Completed Device Address LM102 changes to 1.
• When the value of each bit of address+0 of Status Device Address LDR130 is 0, reception is completed without an 

error.

Item Setting

Comment RXD command

Command Type Receive

Completed Device Address LM102

Not Clear Completed Device Address 
automatically

No

Status Device Address LDR130

Receiving Time Out 0 (No Receive Time Out)

Trigger Condition While ON, Device Address: LM101

Command
Data Settings dialog box settings

Constant 
(Hexadecimal)

'02'

Constant 
(Character)

"D"

Device Address
Conversion Type: ASCII (Hex) to Binary, 
Number of bytes: 4, Words: 1
Device Address: LDR120, Reference Device Address: LDR100

Constant 
(Hexadecimal)

'0D'

D
(44h)

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

CR
(0Dh)

Receive data:

Constant
(Hexadecimal)

Constant 
(Character) Device Address

Command settings:

Constant
(Hexadecimal)

0000LDR120:
0000LDR121:

1234hLDR220:

Value of Device Address

LDR230=100
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● Example 2
This section describes an example of user communication protocol settings for creating the following commands and 
command operations.
• Transmission command for transmitting data using Constant (Hexadecimal), Registering Constant (Character), 

Device Address, BCC, Constant (Hexadecimal) command settings when the trigger condition device address 
changes to 1

• Receive command for receiving, processing, and storing data in device addresses, using Constant (Hexadecimal), 
Registering Constant (Character), Skip, Device Address, BCC, Constant (Hexadecimal) command settings, for data 
transmitted from an external device, when the trigger condition device address is 1

■ User Communication Protocol Settings dialog box settings

Transmission command: Command Settings dialog box settings

Operation for transmission command

1 Write a value of 10 (Dec) to LDR200 for Registering Constant (Character) for transmission command data.
AB is selected.

2 Write a value of 3132h to LDR210 and 3334h to LDR211 for Device Address for transmission command data.

3 Change the trigger condition LM200 from 0 to 1 to start command transmission.
The transmission data is as follows.

• When data transmission is successfully completed, the Completed Device Address LM201 changes to 1.
• When the value of each bit of address number+0 for Status Device Address LDR220 is 0, transmission is completed 

without an error.

Item Setting

Protocol Name Sample 2

Receiving Character Time Out 30 (×100 msec)

Item Setting

Comment TXD command

Command Type Transmit

Completed Device Address LM201

Status Device Address LDR220

Transmission Wait 0 (×100 msec)

Trigger Condition Rising-edge, LM200

Command
Data Settings dialog box settings

Constant 
(Hexadecimal) '05'

Registering 
Constant 
(Character)

10: "AB", 20: "CD", Index Device Address: LDR200

Device Address
No conversion, from Upper byte, Number of bytes: 2, 
Words: 2
Device Address: LDR210

BCC Start Calculation Position: 1, End Calculation Position: 0, 
XOR, Binary (Hex) to ASCII, 2 bytes

Constant 
(Hexadecimal) '0D''0A'

AB10:
CD20: Index Device Address

LDR200=10

DataIndex No.

Number of Registering Constants: 2

Transmission data

A
(41h)

B
(42h)

Order of transmission

3
(33h)

4
(34h)

1
(31h)

EQN
(05h)

2
(32h)

CR
(0Dh)

LF
(0Ah)

A
(41h)

B
(42h)

0
(30h)

2
(32h)

BCC

Transmission data:

Constant
(Hexadecimal)

Registering 
Constant (Character) Device Address

Command settings:

Constant
(Hexadecimal)
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Receive command: Command Settings dialog box settings

Operation for receive command

1 Change the trigger condition LM202 from 0 to 1 to be ready for receiving user communication.

2 Data is transmitted from the external device and the transmitted data is received and processed.
The receive data is as follows.

• The receive data is compared with the character data, and the value of the matching Index No. (10 (Dec)) is stored 
in Index Device Address LDR230.

• The 2 bytes (specified with Skip) of the receive command data 43h and 44h are ignored.
• Since the Reference Device Address LDR 230 of Device Address of the receive command data is 10 (Dec), the 

data is stored in the device address LDR250 and LDR251, which is offset by +10.

• [STX] ABCD1234 is calculated with BCC of receive command data and compared with 3032h.
- When Calculation Start Position is 1 and Calculation End Position is 0: Calculates the range STX ABCD1234.

- The BCC calculation type is XOR.
02h^41h^42h^43h^44h^31h^32h^33h^34h^=02h

Item Setting
Comment RXD command
Command Type Receive
Completed Device Address LM203
Not Clear Completed Device 
Address automatically

No

Status Device Address LDR260
Receiving Time Out 0 (No Receive Time Out)
Trigger Condition While ON, Device Address: LM202

Command
Data Settings dialog box 
settings

Constant 
(Hexadecimal) '02'

Registering 
Constant 
(Character)

10: "AB", 20: "CD", Index Device Address: LDR230

Skip 2 bytes

Device Address
Conversion Type: No conversion, from Upper byte, 
Number of bytes: 2, Words: 2
Device Address: LDR240, Reference Device Address: LDR230

BCC Calculation Start Position: 1 Calculation End Position: 0, XOR
Binary (Hex) to ASCII, 2 bytes

Constant 
(Hexadecimal) '0D''0A'

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

A
(41h)

B
(42h)

C
(43h)

D
(44h)

Skip

CR
(0Dh)

LF
(0Ah)

0
(30h)

2
(32h)

BCC
Constant

(Hexadecimal) Device Address
Constant

(Hexadecimal)
Command settings:

Registering 
Constant (Character)

Receive data:

Received data

Compare

A
(41h)

B
(42h)

Order of reception

10LDR230:

Value of the Index Device Address

AB10:
CD20:

DataIndex No.
Number of

 Registering
 Constants: 2

(DEC)

0000hLDR240:
0000hLDR241:

3132hLDR250:

Value of Device Address

LDR230=10

(1) (2) (3) (4) (5) (6) (7) (8) (9)Calculation Start Position:

(5) (4) (3)(8) (7) (6) (2) (1) (0)Calculation End Position:

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

A
(41h)

B
(42h)

C
(43h)

D
(44h)

CR
(0Dh)

LF
(0Ah)

0
(30h)

2
(32h)

Data used for BCC calculation
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- When the BCC calculation result is 0002h, the converted data will be 3032h.

- When the converted data is 3032h, the data for comparison with the BCC part of the receive data will be 
3032h.

- The comparison data is compared with the BCC part of the receive data.
In the following receive data, when the comparison data is the 2-byte 3032h, there is a match since the BCC part 
data is 3032h.
When there is no match, the BCC Error (address number+0, bit 0) of Status Device Address changes to 1.

• When data reception is successfully completed, the Completed Device Address LM203 changes to 1.
• When the value of each bit of address number+0 for Status Device Address LDR250 is 0, transmission is completed 

without an error.

0002h

Binary (Hex) to ASCII

0
(30h)

Data
2

(32h)

0
(30h)

2
(32h)

Comparison data

0
(30h)

2
(32h)

Bytes: 2

Converted data
(Second byte)  (First byte)

Comparison data

Match

Receive data BCC part

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

A
(41h)

B
(42h)

C
(43h)

D
(44h)

CR
(0Dh)

LF
(0Ah)

0
(30h)

2
(32h)

0
(30h)

2
(32h)
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5.5 Compatible USB Barcode Readers

The following USB barcode readers can be used with the MICRO/I:

5.6 Connection Diagram for User Communication

When connecting an external device to the MICRO/I via user communication, refer to the following connection diagram.

■ Serial interface 1 (RS232C)

■ Serial interface 1 (RS422/485)

Manufacturer Type Number

IDEC DATALOGIC QD2130

• Set "USB-KBD(Keyboard)" to the interface settings of USB barcode reader.
• The MICRO/I handles the new line code as 0x0A.

1 SD
Pin No. Name

2 RD
3 RS
4 CS
5 SG

-FG
Pin No.Name

-RD
-SD
-SG

Shield Wire
HG2G-5T (Terminal Block)External Device (RS232C)

8 RDA(RD+)
Pin No. Name

9 RDB(RD-)
6 SDA(SD+)
7 SDB(SD-)
5 SG

-FG
Pin No.Name

-SDA
-SDB
-RDA
-RDB
-SG

Shield Wire
HG2G-5T (Terminal Block)External Device (RS422/485)

There is no pin number corresponding to TERM. When a termination resistor is necessary, use the 
terminating resistor selector switch. For the terminating resistor selector switch, refer to Chapter 1 "3 
Important Points Regarding Wiring" in the WindO/I-NV4 External Device Setup Manual.
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6.1 Overview

Sub Host Communication is a function for communicating with an external device using the MICRO/I's HMI Link 
Registers (LLR).
The external device addresses are allocated to HMI Link Registers (LLR). When MICRO/I receives a request to read 
from or write to HMI Link Registers (LLR), it reads from or writes to the allocated external device addresses, and the 
execution results are stored in HMI Link Registers (LLR).

6.2 Supported Protocols and Communication Driver

The Sub Host communication can be used with the following protocols and communication drivers:

6 Sub Host Communication

Read Write

5678

External device

0 1 D1:
M1:

5678

MICRO/I

Sub Host Communication

Numerical Display
Display Device Address: LLR0

Bit Button
Destination Device Address: LLR1

1

5678

LLR0

LLR1

HMI Link Register

Allocates M1

Allocates D1

External Device Address

Protocol Communication Driver

MicroSmart
Manufacturer: IDEC
Communication driver: OpenNet,MicroSmart,SmartAXIS Pro/Lite(RS232C/485)

Modbus RTU Master
Manufacturer: Modbus
Communication driver: Modbus RTU Master

For the device addresses that can be used by each protocol, communication cable connection, and usable 
device addresses, refer to “5.6 Connection Diagram for User Communication” on page 3-73 and Chapter 2 
"Connection to External Devices" in the WindO/I-NV4 External Device Setup Manual.
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6.3 HMI Link Register (LLR) Assignment

This section describes how to allocate and the operation of HMI Link Registers (LLR) in Sub Host Communication.

● Example of HMI Link Register (LLR) Settings
Use the Device Link Communication between the external device and the MICRO/I's serial interface (COM1), and use 
the Sub Host communication between the external device and the MICRO/I's serial interface (COM2).
Allocate the following external device addresses to the HMI Link Registers (LLR).

■ Settings in the Communication Interface tab on the Project Settings dialog box

■ Settings in the Sub Host Communication tab on the Project Settings dialog box

Example: HMI Link Registers (LLR) are configured for the following parts

Interface Function

COM1 External Device Communication 1

COM2 Sub Host Communication

Item Settings

Protocol MicroSmart

Allocate Device Address HMI Link 
Register (LLR)

LLR0 0:D0100

LLR1 0:M0002

LLR2 1:D100-1

LLR3 2:D101

Display Device Address for Numerical Display LLR0
Destination Device Address for Numerical Input LLR3
Destination Device Address for Bit Button LLR1
Trigger Device Address for Pilot Lamp LLR2

2222

1234

External device

External device
(External Device ID: 0)

External device
(External Device ID: 1)

External device
(External Device ID: 2)

0 1

D100:

M2:

0 1

D100-1:

1234

D101: 2222

MICRO/I

1234

1

1

2222

LLR0

LLR1

LLR2

LLR3

HMI Link Register (LLR)

Numerical Display
Display Device Address: LLR0

Numerical Input
Destination Device Address: LLR3

Bit Button
Destination Device Address: LLR1

Pilot Lamp
Trigger Device Address: 
LLR2

Read

OFF image ON image

WriteRead Write Read Write

COM1

COM2

Don't use the frequent write operation for HMI Link Register (LLR) which is caused by a script and a word 
command. It may make the reading data operation too much slow.
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6.4 Sub Host Communication Configuration Procedure

This section describes the configuration procedure for Sub Host Communication.

● Setting Sub Host Communication for a communication interface

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

2 Click the Communication Interface tab.

3 Select the interface for Sub Host Communication under Interface Configuration, and then select the Sub Host 
Communication in Function under Interface Settings.

The Sub Host Communication tab is displayed.

Serial Interface (SERIAL1) can be used for Sub Host Communication. Two or more interfaces cannot be used 
at the same time.
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4 Configure the Interface Settings.

For details, refer to Chapter 4 “When SERIAL1(RS232C) or SERIAL1(RS422/485) is selected under Interface 
Configuration” on page 4-26.

5 Click the Sub Host Communication tab.

6 Selects the protocol as MicroSmart or Modbus RTU Master in the Protocol.
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7 Allocate the external device addresses to the HMI Link Registers (LLR) used with Address Number in Settings.

For details, refer to Chapter 4 “3.7 Sub Host Communication Tab” on page 4-36.

8 Click OK.

This concludes configuring Sub Host Communication for communication interfaces.
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6.5 Error Information

This setting is for monitoring all error information and for controlling Sub Host Communication.

● Monitor the error information of all Slave Numbers
The error information of all external devices communicated with using Sub Host Communication can be monitored.
This option is configured on the Sub Host Communication tab in the Project Settings dialog box. Select the 
Monitor the error information of all Slave Numbers check box, and then specifies a word device to write the 
error information.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

Bit Function Descriptions

0 Reserved ―

1 Initialize

Clear all error information of Sub Host Communication.
Write 1 to clear all error information, and this bit changes to 0 after clear.
Error information of each slave number of the device addresses configured 
with the Monitor the error information of each Slave Number check 
box is also cleared.

2 Finish 1st reading
This bit changes to 1 after all device addresses allocated to HMI Link 
Registers (LLR) are read.

3 Reserved ―

4 Current Error
This bit changes to 1 while a communication error occurs in any device 
address allocated to HMI Link Registers (LLR). The bit changes to 0 after the 
communication error recovers.

5 Reserved ―

6 Error Log for Reading

This bit changes to 1 when the reading error has occurred in any device 
address allocated to HMI Link Registers (LLR). This bit keeps 1 even if the 
reading error recovers.
Writes 1 to the Bit 1 (Initialize) to make this bit 0.

7 Error Log for Writing

This bit changes to 1 when the writing error has occurred in any device 
address allocated to HMI Link Registers (LLR). This bit keeps 1 even if the 
writing error recovers.
Writes 1 to the Bit 1 (Initialize) to make this bit 0.

8 to 15 Reserved ―

Bit

Function

Read/Write R R R R R/W
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● Monitor the error information of each Slave Number
The error information of external devices communicated with using Sub Host Communication can be monitored per 
external device.
This option is configured on the Sub Host Communication tab in the Project Settings dialog box. Select the 
Monitor the error information of each Slave Number check box, and then specifies a word device to write the 
error information. 256 word devices from top device set in this option are used. Each device is assigned to each slave 
number of PLC.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

● Keep running with skipping the Slave Number of communication error
When this option is selected, skip the slave number error has occurred and connect with next slave number. This 
option is configured on the Sub Host Communication tab in the Project Settings dialog box. Select the Keep 
running with skipping the Slave Number of communication error check box.
When this option is not selected, retry communication with same slave number until recover from the error.

Bit Function Descriptions

0 Connection

Specifies the communication with the external devices of the relevant slave 
number.
When this bit is 1, MICRO/I connects with each external device. When this bit 
is 0, MICRO/I does not connect the external device.
Default value is 1 when the device addresses of the relevant slave number 
are registered to HMI Link Registers (LLR).

1 Reserved ―

2 Finish 1st reading
This bit changes to 1 after all device addresses allocated to HMI Link 
Registers (LLR) of the relevant slave number are read.

3 Reserved ―

4 Current Error
This bit changes to 1 while the communication error occurs in the device 
addresses allocated to the HMI Link Registers (LLR) of the relevant slave 
number. This bit changes to 0 after the communication error recovers.

5 Reserved ―

6 Error Log for Reading

This bit changes to 1 when the reading error has occurred in any device 
address allocated to the HMI Link Registers (LLR) of the relevant slave 
number. This bit keeps 1 even if the reading error recovers. 
Writes 1 to the Bit 1 (Initialize) of the Monitor the error information of 
all Slave Numbers check box to make this bit 0. 

7 Error Log for Writing

This bit changes to 1 when the writing error has occurred in any device 
address allocated to the HMI Link Registers (LLR) of the relevant slave 
number. This bit keeps 1 even if the writing error recovers.
Writes 1 to the Bit 1 (Initialize) of the Monitor the error information of 
all Slave Numbers check box to make this bit 0.

8 to 15 Reserved ―

Bit
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Read/Write R R R R R/W
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Project Settings

The settings and screen data required to run the MICRO/I are contained in a data structure called a Project. You must 
create a project using WindO/I-NV4 before creating the screens and configuring the settings for the MICRO/I. This 
chapter describes the various settings required to create a project.

  

1.1 Creating New Project Data

● Create new project data by using the interactive quick start
You can create project data by following displayed dialog boxes and configuring settings step by step.

1 Click , then click New.

A Select Product Series dialog box is displayed.

2 Select Product Series, Model, and Installation, and then click Next.
The Select Communication Driver dialog box is displayed.

■ Product Series
Select the MICRO/I type.

■ Model
A list of model numbers associated with the selected MICRO/I is displayed. Select the model number to use.

■ Installation
Select the MICRO/I installation direction from the following options.
Horizontal, Vertical (Counter Clockwise), Vertical (Clockwise)

Chapter 4 Project Settings

1 Creating and Manipulating WindO/I-NV4 Project Data
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3 Select Manufacturer and Communication Driver and then click OK.

■ Manufacturer
Select the manufacturer name of the external device used.

■ Communication Driver
Shows the communication driver list for the select manufacturer. Select the communication driver to use.

■ Expression of Device Address Format
Select the format for the device address.

This option can only be configured when Allen-Bradley is selected for Manufacturer.

This concludes creating project data.
Next you will create a screen. For details, refer to Chapter 5 “3.1 Base Screen Settings” on page 5-14.

Allen-Bradley: Enter device addresses in the Allen-Bradley format.
Example: B 10:123/5

WindO/I-NV4: Enter device addresses in the WindO/I-NV4 format.
Example: B 1012305

You can return to the Select Communication Driver dialog box and change its setting by clicking 
Previous.
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1.2 Opening Project Data

● Opening project data
You can open project data that has already been created.

1 Click , then click Open.

The Open dialog box is displayed.

2 Select the file and click Open.

Next you will open a screen. For details, refer to Chapter 5 “2.2 Opening Screens” on page 5-3.

If a password has been configured for the project data, the Enter Password screen will be displayed.
The password to enter varies based on the check box setting of the Use Password to open a Project 
found under the Options tab in the Security dialog box.
When this check box is checked, enter the password for Use Password to open a Project.
When this check box is unchecked, enter the password for the user account assigned to the Administrator 
security group.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.

Project data can also be opened by the following methods.

Click  and then click project data on the Recent Projects list
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1.3 Saving Project Data

● Saving project data
You can save the project data being edited.

Click  and then click Save.

When new project data is created and you have never save it, the Save As dialog box is displayed.
Enter the project name and then click Save.
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● Saving project data with a different name
You can save the project data being edited with a different name.

1 Click , then click Save As.

The Save As dialog box is displayed.

2 Enter the project name and click Save.

• You cannot use the following characters in the project name.
   . \ / : * ? “ < > |

• You cannot create project data in read-only folders or in WindO/I-NV4’s working folders (temporary 
folders that start with “~”).
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1.4 Comparing Project Data

Compares project data during editing with the screens and scripts of saved projects. 

1 On the Home tab, in the Project group, click Compare.

The Open dialog box is displayed.

2 Select a file to compare with, then click Open.

The Comparison Result window is displayed.

Comparison results are displayed using colored text.

Blue: Complete match

Red: Different content

Green: Only saved in the open project

Gray: Only saved in the comparison project

To compare with the comparison project data again, click the arrow to the right of Compare from the 
Project group of the Home tab, then click Recompare.
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1.5 Changing Project Settings

● Changing Product Series
This section describes how to change the product series set in the project data being edited.

1 Click Change Product Series on the status bar.

The Change Product Series dialog box is displayed.

2 Select Product Series, Model, and Installation, and then click OK.

The Destination path for Convert dialog box is displayed.

3 Specify the save location and file name, and then click Save.

The data conversion process begins.
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4 When the data is finished being converted, click Close.

• Color settings (color data) are not converted.
• If the Popup Screen size is larger than the Base Screen size after the Product Series is changed, the 

Popup Screen size is changed to the same size as the Base Screen.
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● Changing Communication Drivers
This section describes how to change the communication driver set in the project data being edited.

1 With Communication Driver on the status bar, click one of External Device Communication 1 to External 
Device Communication 4.

The Communication Driver tab on the Project Settings dialog box is displayed.

2 Change the settings on each tab as necessary.

3 Click the Communication Driver Network tab, change the settings as necessary and then click OK.

The confirmation message is displayed.
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4 Check the message and click Yes.

If there are no device addresses that correspond to the external device addresses used in the current 
project data after changing the communication driver, the items set with those device addresses are blank.
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1.6 Closing Project Data

You can close the project data being edited.

Click  and then click Close.

If the project data being edited has not been saved, a confirmation message for saving the project data is 
displayed.

• Click Yes to save the project data and close it.
• Click No to close the project data without saving changes.
• Click Cancel to return to the editing screen without saving the project data.
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The Project Settings dialog box is used to configure MICRO/I operations and functions for the project overall.
This section describes the configuration procedure for project settings.

1 On the Configuration tab, in the System Setup group, click Project.
The Project Settings dialog box is displayed.

2 Change the settings on each tab as necessary.

2 Project Settings Configuration Procedure
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This section describes items and buttons on the Project Settings dialog box.

3.1 System Tab

The System tab is used to configure MICRO/I operations for the project data overall.

■ Screen Number Format
Selects the type of data to use for the System Area 1 Display screen number (address number+0) as BCD or BIN.

■ Start Time (sec)
Specifies the time from when the MICRO/I power is turned on until communications start with the external device 
(0 to 9999 seconds).

■ Backlight
These options configure the backlight control function.

3 Project Settings Dialog Box

Default Screen: Specifies the screen number of the base screen to display first when the MICRO/I is turned on (0 to 
3000). When 0 is specified, the MICRO/I is in the screen waiting state. Write a screen number to System 
Area 1 Display screen number (address number+0) or specify the default screen number from 1 to 3000.

Auto OFF: Select this check box to turn off the backlight when the MICRO/I is unused for an extended 
period of time. To turn on the backlight, touch the screen or write 1 to System Area 1 Backlight 
auto off bit (address number+1, bit 5) or System Area 1 Backlight bit (address number+1, bit 0).

Time (min): Specifies the time from when the MICRO/I is last used to when the backlight is 
turned off.

Halve the Brightness: Select this check box to lower the backlight brightness when the MICRO/I is unused for an 
extended period of time. To return to the backlight to its original brightness, touch the screen 
or write 1 to System Area 1 Backlight bit (address number+1, bit 0).

Time (min): Specifies the time from when the MICRO/I is last used to when the backlight 
brightness is lowered.

Light ON with Screen Changing:
When the backlight is turned off or when the backlight brightness has been lowered with the 
backlight control function, select this check box to turn on the backlight or restore the 
backlight brightness when the screen is switched.
This option can only be configured when the Auto OFF check box or the Halve the 
Brightness check is selected.
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■ Enable Touch Sound
Select this check box to play a sound when the screen is pressed.

■ Enable Maintenance
Select this check box to display the maintenance screen during operation. The methods for displaying the 
maintenance screen are as follows.
Press the upper-left corner of the MICRO/I screen for three seconds or more.
If the base screen is switched before three seconds have elapsed, the load operation for the maintenance screen will 
be canceled. Please press the screen again.

■ Use Large Font
Select this check box to display text on the MICRO/I in high-quality fonts. The Japanese or European font is 
replaced with the high-quality fonts depending on the magnification.
To use high-quality fonts, the fonts must be downloaded to the MICRO/I at the same time as the project. To 
download fonts, specify the high-quality fonts under Optional Fonts to be downloaded in the Font Settings tab.
For details on high-quality fonts, refer to Chapter 2 “High-quality Fonts” on page 2-9.

■ Enable Two-point Push
Select this check box to enable two-point push for touch switches. When two-point push is enabled, the bottom 
switch and the switch above it operate in order.
On an analog touch panel, this function operates two overlapping switches when the two are pressed. This is not a 
function to simultaneously operate two touch switches when they are both pressed.

■ Enable Low Battery Warning
Select this check box to display a warning message when the backup battery is dead.
This option also displays a warning message when it is time to replace the battery.

■ Show script error
Select this check box to display an error message on the screen when a script error occurs.

■ System Language
Selects the display language for the Maintenance screen, System Menu screen, Device Monitor, and Adjust Brightness 
screen as English or Japanese.
For details, refer to Chapter 29 “1 Maintenance Screen” on page 29-1.

Control by Device Address: Select this check box to control the touch sound with a value of device address.
This option can only be configured when Enable Touch Sound is selected.

(Device Address): Specifies the word device that controls the touch sound.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
The control over a touch sound with a value of device address is as 
follows.
0: Do not play the touch sound.
1: Play the touch sound.
2: Play a shortened touch sound.

Press and hold 
3 or more seconds

MICRO/I

Script error information is saved to the HMI Special Data Registers (LSD52 and LSD53). For details, refer to 
Chapter 20 “1.4 Script Error” on page 20-4.
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■ Use System Area
The System Area is an area of predetermined device addresses to control the screen and communicate error 
information and time information between the MICRO/I and the external device. Select this check box to use the 
System Area. For details, refer to “System Area” on page 4-17.

■ Flashing Cycle
Selects the cycle when flashing (displaying a drawing object by switching it on and off at a fixed interval) drawings 
and parts as 1.0 sec or 0.5 sec.

■ Watch Dog
Select this check box to monitor on the external device side whether or not the MICRO/I and the external device are 
communicating by writing a set value (00FF (Hex)) at a fixed interval.

■ Disable Switch
Select this check box to enable and disable touch switches with a value of device address.
Touch switches are enabled when the value of device address is 1. They are disabled when the device value is 0.

■ Use Device Cache
Select this check box to execute processing by reading all the values of the external device addresses configured for a 
screen when switching the base screen or when displaying a popup screen.

■ Start Part with synchronous
Select this check box to operate commands and HMI Special Internal Relays LSM1, LSM2, LSM3, and LSM5 after 
reading all the values of the external device addresses configured on the screen.
When this check box is cleared, all processing is immediately executed when the screen is displayed.

■ Start from 0 in Always Entry Mode of Numerical Input
Select this check box to display 0 when a Numerical Input that has the Always Entry Mode check box selected on 
the General tab is displayed on the screen. When this check box is cleared, the value of device address is displayed.
This option is reflected for all Numerical Inputs configured in the project.

Device Address: Specifies the word device to use as the System Area. The System Area is allocated starting from the 
configured device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Use System Area 3, 4: Select this check box to use System Area 3 and 4.

Clear Keypad bit in System Area automatically: Select this check box to automatically set the System Area 2 
numerical input setting and character input setting bits to 0 after 
they have been set to 1.
The System Area 2 bits cleared by this function are as follows.
Numerical input setting complete (address number+3, bit 0)
Numerical input setting cancel (address number+3, bit 1)
Character input setting complete (address number+3, bit 5)
Character input setting complete (address number+3, bit 6)

Device Address: Specifies the word device to write the value.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Time (sec): Specifies the interval to write the value (1 to 65535).

Device Address: Specifies the bit device or bit number of the word device that is read to enable or disable touch 
switches.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.
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■ Storage Method of String Data
Selects the handling method for text entered with the Character Input and values of device addresses read by the Message Display.

■ Storage Method of 32-bit Numerical Data
Selects the handling method for values of device addresses when UBIN32(D), BIN32(L), BCD8(EB), or 
Float32(F) is selected for Data Type from the following.

from Upper byte: Values of device addresses are read from and written to the upper order byte.
Example: When the text ABCDE is entered with the Character Input and written to the 

destination device address LDR100

from Lower byte: Values of device addresses are read from and written to the lower order byte.
Example: When the text ABCDE is entered with the Character Input and written to the 

destination device address LDR100

Device address
Stored value

Upper byte Lower byte
LDR100 'A' = 41 (Hex) 'B' = 42 (Hex)
LDR101 'C' = 43 (Hex) 'D' = 44 (Hex)
LDR102 'E' = 45 (Hex) 0

NULL termina�ng character

Device address
Stored value

Upper byte Lower byte
LDR100 'B' = 42 (Hex) 'A' = 41 (Hex)
LDR101 'D' = 44 (Hex) 'C' = 43 (Hex)
LDR102 0 'E' = 45 (Hex)

NULL termina�ng character

When handling strings, 0 is written to the device address as the NULL terminating character and treated as 
the end of the string.

from Upper word: Values of device addresses are read from and written to the upper order word.
Example: When Data Type for the Numerical Input is UBIN32(D) and the numerical value 

12345678 (Hex) was entered and written to destination device address LDR100

from Lower word: Values of device addresses are read from and written to the lower order word.
Example: When Data Type for the Numerical Input is UBIN32(D) and the numerical value 

12345678 (Hex) was entered and written to destination device address LDR100

for MicroSmart, SmartAXIS: The storage method of data varies based on device type when selecting the following 
communication drivers.

• Device types handled as from upper word
Data Register, Timer (Current), Counter (Current), Timer (Preset), Counter (Preset), 
Special Data Register, Internal Device

• Device types handled as from lower word
Input (Word), Output (Word), Internal Relay (Word), Link Register, Special Internal 
Relay (Word), Shift Register (Word)

When using a communication driver other than those listed above and for MicroSmart, 
SmartAXIS is selected, the values of all device addresses are handled as from Upper word.
When using multiple communication drivers, the values of device addresses for the 
communication drivers listed above are handled as for MicroSmart, SmartAXIS, and 
others are handled as from Upper word.

Device address Stored value
LDR100 1234 (Hex) Upper word
LDR101 5678 (Hex) Lower word

Device address Stored value
LDR100 5678 (Hex) Upper word
LDR101 1234 (Hex) Lower word

Manufacturer Communication driver

IDEC
OpenNet, MicroSmart, SmartAXISPro/Lite (RS232C/485) 
OpenNet, MicroSmart, SmartAXISPro/Lite (Ethernet) 
MICRO3, MICRO3C
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● System Area

Overview

The area of predetermined device addresses to control the screen and communicate error information and time 
information between the MICRO/I and the external device is called the System Area.
The System Area on the MICRO/I is as follows.

To use System Area 1 and 2, select the Use System Area check box on the Project Settings dialog box. To use 
System Area 3 and 4, select the Use System Area 3, 4 check box.
Specify the word device to use as the System Area in Device Address to allocate the System Area starting at the 
configured device address.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
Example: When Device Address is configured as LDR100

System Area 1

This area configures the MICRO/I display, beep, and clearing bits.

System Area Number of word addresses User Access

System Area 1 2 Read and write

System Area 2 2 Write

System Area 3 4 Read

System Area 4 4 Write

LDR100
LDR101
LDR102
LDR103
LDR104
LDR105
LDR106
LDR107
LDR108
LDR109
LDR110
LDR111

System Area 1
(Start address number)

+1

+2

+3

+4

+5

+6

+7

+8

+9

+10

+11

System Area 2

System Area 3

System Area 4

Address 
number Bit Function Description

+0 0 to 15 Display screen number

This bit stores the number of the screen being displayed. Write a value to 
this bit to change the screen to that number. Immediately after the power 
is turned on, the value configured by Default Screen in the Project 
Settings dialog box is stored here.
If the screen number does not exist in the project data, an error message 
(No screen data) is displayed. However, when 0 is written to this bit, the 
screen is not switched and no error message is displayed.

+1

0 Backlight

This bit stores the illumination state of the backlight. Write a value to this 
bit to change the state.

0: Off
Turns the backlight off.

1: On
Turns the backlight on.

1 Flash display (1 sec. cycle)

This bit stores the screen flash state (1 sec. cycle). Write a value to this 
bit to change the state. This bit is 0 immediately after the power is turned 
on.

0: Do not flash
Stop flashing the screen and turn it on.

1: Flash
Flashes the screen in one second intervals.
When the Flash display (1 sec. cycle) (address number+1, bit 1) and 
the Flash display (0.5 sec. cycle) (address number+1, bit 2) are both 
1, the screen flashes at one second intervals.
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System Area 2

This area stores MICRO/I states and error information. These bits are 0 immediately after the power is turned on.

+1

2 Flash display 
(0.5 sec. cycle)

This bit stores the screen flash state (0.5 sec. cycle). Write a value to this 
bit to change the state. This bit is 0 immediately after the power is turned 
on.

0: Do not flash
Stop flashing the screen and turn it on.

1: Flash
Flashes the screen in 0.5 second intervals.
When the Flash display (1 sec. cycle) (address number+1, bit 1) and 
the Flash display (0.5 sec. cycle) (address number+1, bit 2) are both 
1, the screen flashes at one second intervals.

3 to 4 Reserved

5 Backlight auto off

This bit stores whether or not the function to automatically turn off the 
backlight is enabled when the Auto OFF check box is selected under 
Backlight in the Project Settings dialog box. Write a value to this bit 
to change the state. This bit is 0 immediately after the power is turned 
on.

0: Enabled
Automatically turns off the backlight when the MICRO/I is unused 
for an extended period of time.

1: Disabled
Does not automatically turn off the backlight when the 
MICRO/I is unused for an extended period of time. The backlight 
turns on if the value changes to 1 when the backlight is off.

6 Beep

This bit stores the beep state. Write a value to this bit to change the 
state. This bit is 0 immediately after the power is turned on.

0: Stop
Stops continuous beeping.

1: Beep
Starts continuous beeping.

7 Screen display

This bit stores the screen display state. Write a value to this bit to change 
the state.

0: Hide
Hides the screen when the backlight is on.

1: Show
Displays the screen.

8 Reserved

9 Clear error
Write 1 to this bit to clear the error information bit (System Area 2, 
address number+2). This bit automatically changes to 0 when processing 
is finished.

10 Numerical input setting 
clear

Write 1 to this bit to clear the Numerical input setting complete bit 
(System Area 2 address number+3, bit 0) and the Numerical input setting 
cancel bit (System Area 2 address number+3, bit 1). This bit 
automatically changes to 0 when processing is finished.

11 Character input setting 
clear

Write 1 to this bit to clear the Character input setting complete bit 
(System Area 2 address number+3, bit 5) and the Character input setting 
cancel bit (System Area 2 address number+3, bit 6). This bit 
automatically changes to 0 when processing is finished.

12 to 15 Reserved

Address 
number Bit Function Description

Address 
number Bit Function Description

+2

0 to 2 Reserved

3 Communication error
This bit changes to 1 when a communication error occurs in external 
device communication. To clear this bit, write 1 to the Clear error bit 
(System Area 1 address number+1, bit 9).

4 Reserved
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+2

5 Processing error

This bit changes to 1 when executing the following arithmetic operations. 
To clear this bit, write 1 to the Clear error bit (System Area 1 address 
number+1, bit 9).
• There is data which cannot be handled with the specified data type; 

BCD4(B), BCD8(EB), or Float32(E).
• A value is divided by 0.
• The setting of Origin, Minimum, or Maximum for the Bar Chart or Line 

Chart are invalid, or the Minimum and Maximum are the same values.
• The setting of Minimum, Maximum, or ranges for the Meter are invalid, 

or the Minimum and Maximum are the same values.

6 Device range error

This bit changes to 1 when writing a value to a device address that falls 
outside its range or when exceeding the restrictions on the number of 
configured device addresses. To clear this bit, write 1 to the Clear error bit 
(System Area 1 address number+1, bit 9).

7 to 9 Reserved

10 Script error

This bit changes to 1 when an error occurs during script execution. Error 
details are stored in HMI Special Data Registers LSD52 and LSD53. For 
details, refer to Chapter 20 “1.4 Script Error” on page 20-4. To clear this 
bit, write 1 to the Clear error bit (System Area 1 address number+1, bit 
9).

11 Reserved

12 Replace battery error
This bit changes to 1 when it is time to replace the backup battery. To 
clear this bit, write 1 to the Clear error bit (System Area 1 address 
number+1, bit 9).

13 Replace battery error (low 
battery)

This bit changes to 1 when the backup battery is low. To clear this bit, 
write 1 to the Clear error bit (System Area 1 address number+1, bit 9).

14 Backup data error

This bit changes to 1 when the backup battery is dead or low and the 
data sampled by the log functions and values in the HMI Keep Registers 
and HMI Keep Relays disappears. To clear this bit, write 1 to the Clear 
error bit (System Area 1 address number+1, bit 9).

15 Reserved

+3

0 Numerical input setting 
complete

This bit changes to 1 when finished entering a numerical value with the 
Numerical Input. This bit changes to 0 when entering a numerical value 
or when entering a numerical value has been canceled. Write 1 to 
numerical input setting clear (address number+1, bit 10) to clear this bit.

1 Numerical input setting 
cancel

This bit changes to 1 when entering a numerical value with the Numerical 
Input was canceled. This bit changes to 0 when entering a numerical 
value or when entering a numerical value has been completed. Write 1 to 
numerical input setting clear (address number+1, bit 10) to clear this bit.

2 Backlight auto off running

The value of this bit changes to 1 when Auto OFF is configured and the 
backlight was turned off by this function. To configure Auto OFF, select 
the Auto OFF check box under Backlight in the Project Settings 
dialog box. This bit automatically changes to 0 when the backlight turns 
on.

3 Reserved

4 Transferring recipe This bit changes to 1 when transferring recipe data. This bit automatically 
changes to 0 when the transfer is finished.

5
Character input setting 
complete

This bit changes to 1 when finished entering text with the Character 
Input. This bit changes to 0 when entering text or when entering text has 
been canceled. Write 1 to character input setting clear (address 
number+1, bit 11) to clear this bit.

6
Character input setting 
cancel

This bit changes to 1 when entering text with the Character Input is 
canceled. This bit changes to 0 when entering text or when entering text 
has been completed. Write 1 to character input setting clear (address 
number+1, bit 11) to clear this bit.

7 to 15 Reserved

Address 
number Bit Function Description
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System Area 3

This area is for changing the MICRO/I internal clock data.

System Area 4

This area reads the MICRO/I internal clock data in one minute intervals.

Address 
number Bit Function Description

+4
0 to 7 Clock data Month Enter Month (01 to 12) as a 2 digit BCD.

8 to 15 Clock data Year Enter Year (00 to 99) as a 2 digit BCD.

+5
0 to 7 Clock data Hour Enter Hour (00 to 23) as a 2 digit BCD.

8 to 15 Clock data Day Enter Day (01 to 31) as a 2 digit BCD.

+6
0 to 7 Clock data Second Enter Second (00 to 59) as a 2 digit BCD.

8 to 15 Clock data Minute Enter Minute (00 to 59) as a 2 digit BCD.

+7
0 to 14 Reserved Enter 0 in the reserved area.

15 Update Write 1 to this bit to write the entered data (address number+4 to 
+6, bits 0 to 15) to the MICRO/I internal clock data.

When the value of the update bit (address number+7, bit 15) becomes 1, the clock data is updated as a 
whole.
Year, month, day, hour, minute, and second cannot be set individually.

Address 
number Bit Function Description

+8
0 to 7 Clock data Month These bits store the current Month (01 to 12) value as a 2 digit BCD.

8 to 15 Clock data Year These bits store the current Year (00 to 99) value as a 2 digit BCD.

+9
0 to 7 Clock data Hour These bits store the current Hour (00 to 23) value as a 2 digit BCD.

8 to 15 Clock data Day These bits store the current Day (01 to 31) value as a 2 digit BCD.

+10
0 to 7 Reserved

8 to 15 Clock data Minute These bits store the current MICRO/I clock data Minute (00 to 59).

+11
0 to 3 Clock data Day of Week

These bits store the current Day of Week value as a 2 digit BCD. The 
relationship between the day of the week and the value is as follows.
00: Sunday
01: Monday
02: Tuesday
03: Wednesday
04: Thursday
05: Friday
06: Saturday

4 to 15 Reserved
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3.2 Communication Interface Tab

The Communication Interface tab is used to configure the functions used by the MICRO/I communication 
interfaces.

■ Interface Configuration
Interface Configuration lists the communication interfaces and functions to use. Select the appropriate Interface  
(COM1, COM2, etc.) to switch Interface Settings to the items that can be configured for that communication 
interface.
The items displayed in Interface vary based on the model. The supported functions for each communication 
interface are as follows.

HG2G-5T

Functions Available with the Serial Interface
The following functions can be used with MICRO/I models equipped with the serial interface.

• Online
 Refer to Chapter 22 “Online Function” on page 22-1.

• Debug
 Refer to Chapter 23 “Monitor Function” on page 23-1.

• Barcode reader connection
 Refer to Chapter 3 “5 User Communication” on page 3-7.

Item
Communication 

Interface

Function

External Device 
Communication 

1 to 4

O/I Link
Master

O/I Link
Slave

User 
Communication

1 to 3

Sub Host
Communication

Maintenance
Communication

SERIAL1(RS232C)
Serial 
Interface

RS232C YES NO NO YES YES NO

SERIAL1
(RS422/485)

RS422/
485 YES YES YES YES YES NO

Ethernet Ethernet Interface YES NO NO YES NO YES

USB2(USB-A) USB Interface Type A NO NO NO YES NO NO

USB(USB-B) USB Interface Mini-B NO NO NO NO NO YES
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Functions Available with the Ethernet Interface
The following functions can be used with MICRO/I models equipped with the Ethernet interface.

• Online
 Refer to Chapter 22 “Online Function” on page 22-1.

• Debug
 Refer to Chapter 23 “Monitor Function” on page 23-1.

• Web Server
 Refer to Chapter 25 “1 Web Server Function” on page 25-1.

Functions Available with the USB Interface
The following functions can be used with MICRO/I models equipped with a USB interface.

• Online
 Refer to Chapter 22 “Online Function” on page 22-1.

• Debug
 Refer to Chapter 23 “Monitor Function” on page 23-1.

• Barcode reader connection
 Refer to Chapter 3 “5 User Communication” on page 3-7.
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■ Interface Settings
The items that can be configured vary based on the communication interface selected under Interface 
Configuration.

When Ethernet is selected under Interface Configuration

Example: To communicate with two MICRO/Is and a computer via Ethernet
Set MICRO/I A, MICRO/I B, and the computer all to the same values: subnet mask 255.255.255.0, default 
gateway 192.168.0.24.
Set the IP addresses to values that do not conflict: MICRO/I A IP address 192.168.0.1, MICRO/I B IP 
address 192.168.0.2, computer IP address 192.168.0.3.

With multiple communication interfaces, External Device Communication 1 to External Device 
Communication 4 or User Communication 1 to User Communication 3 on the Function cannot be 
configured in multiple settings.

ComputerEthernet communication

IP address 192.168.0.1
Subnet mask 255.255.255.0
Default gateway 192.168.0.24

192.168.0.2
255.255.255.0
192.168.0.24

192.168.0.3
255.255.255.0
192.168.0.24

External 
device

MICRO/I A
External 
device

MICRO/I B

Local network

• Set the IP address, subnet mask, and default gateway according to the local network environment being 
used. When Automatically obtain the IP address is selected, the network settings are automatically 
assigned from the DHCP server on the local network environment being used. Settings assigned from the 
DHCP server can be checked on the Top Page in the System Mode.

• When Automatically obtain the IP address is selected, note the following points:
- It takes some time to acquire the network settings. If the download fails, increase the timeout time on 

the Home tab, in the Project group, in Comm.Setup. For details, refer to Chapter 22 “1.3 Change 
Communication Settings” on page 22-5.

- According to the DHCP server specifications, the IP address may change by removing and reinserting 
the Ethernet cable.

- After connecting the MICRO/I into a different network, turn the power to MICRO/I off and then on again.

Automatically obtain the IP address (DHCP).: Automatically sets the network when connected to a network.

Use the following IP address: Manually specifies the IP address, subnet mask, and default gateway.

IP Address: Specifies the IP address. (Default: 0.0.0.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.
When connecting multiple devices to the same network, 
make sure to assign each device a unique IP address.

Subnet Mask: Specifies the subnet mask. (Default: 0.0.0.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.
This value must be the same for all devices.

Default Gateway: Specifies the default gateway. (Default: 0.0.0.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.
Set this value when using a router. Leave the value 
blank when not required.

Forbid Maintenance Communication: Select this check box to prohibit access from a web browser terminal and 
to prohibit maintenance communication via Ethernet communication.
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When Protocol1 to Protocol7 is selected for Ethernet under Interface Configuration

About Networking Terminology

IP Address: The number allocated to identify devices connected to an IP network such 
as the Internet or an intranet. The IP address is the address of each 
individual device on a network.

Subnet Mask: The subnet mask is used to indicate the position of the division between the 
network address portion and the external device address portion of an IP address.

Default Gateway: The device such as a computer or a router that represents the gateway used 
when accessing devices outside the network to which the device belongs.

Function: Selects the user communication to configure for the selected function from the following.
External Device Communication 1, External Device Communication 2, External Device 
Communication 3, External Device Communication 4
User Communication 1, User Communication 2, User Communication 3

Operation Mode:
Selects the operation mode when performing user communication with the Ethernet interface.
This option can only be configured when User Communication 1, User Communication 2, or User 
Communication 3 is selected for Function.
TCP Client: The MICRO/I operates as a TCP/IP client and the external device operates as a TCP server. 

The MICRO/I connects to the TCP server and sends and receives data.
TCP Server: The MICRO/I operates as a TCP/IP server and the external device operates as a TCP client. 

The MICRO/I creates a listening port as a TCP server and waits for connections from TCP 
clients. After a connection, it sends and receives data with the TCP client.

Target: Configures the IP address and port number for the external device.
These options can only be configured when TCP Client is selected for Operation Mode.
IP Address: Specifies the IP address for the target.

The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 0 to 255.
When connecting multiple devices to the same network, make sure to assign 
each device a unique IP address.

Port No.: Specifies the port number for the target (0 to 65535).
Change IP Address and Port Number by Device Address:

Select this check box and specify a word device to change the target's IP 
address and port number during operation. You can only specify an internal 
device. During the start of operation, the MICRO/I writes the values 
configured by IP Address and Port No. to this device address. After the start 
of operation, the value of device address is read and the target is changed.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
Example: When IP Address is set to 192.168.1.1, Port No. is 2105, and the 

device address is LDR100

MICRO/I: Configures the MICRO/I listening port number.
These options can only be configured when TCP Server is selected for Operation Mode.
Port No. Specifies the MICRO/I listening port number (0 to 65535).

The port numbers that cannot be used are as follows.
• Port numbers already used by the MICRO/I: port number 2537 (for 

maintenance communication), 2538 (for pass-through), 2101 (for FC4A 
direct connection pass-through)

• When MODBUS/TCP Server is selected for Communication Driver, 
Port Number on the displayed Communication Driver Extension tab

• Port No. on the Web Server tab when configured for remote control with 
the Web Server function

LDR100
LDR101
LDR102
LDR103
LDR104

2105
192
168
1
1

Port number

IP address
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When USB(USB-B) is selected under Interface Configuration

• The connection status for TCP clients and the TCP server can be checked with the value of the HMI Special 
Data Registers (LSD). The connection is disconnected when 0. The connection is connected when 1.

LSD67-0: Connection status for User Communication 1 set to Ethernet interface

LSD67-1: Connection status for User Communication 2 set to Ethernet interface

LSD67-2: Connection status for User Communication 3 set to Ethernet interface

• To forcibly disconnect the connection with TCP clients and the TCP server, set the value of the HMI 
Special Data Registers (LSD) from 0 to 1.

LSD68-0: User Communication 1 set to Ethernet interface

LSD68-1: User Communication 2 set to Ethernet interface

LSD68-2: User Communication 3 set to Ethernet interface

• For TCP client and TCP server, make a 1:1 connection between the MICRO/I and the external device for 
one user communication setting.

• When the Change IP Address and Port Number by Device Address check box is selected, the 
changed IP address and port number are reflected when data is next sent.

Function: Selects the function used by the USB interface (USB2) Type A from the following.
N/A, User Communication 1, User Communication 2, User Communication 3
This communication interface is not used when N/A is selected.

Function: This communication interface is used for the Maintenance Communication. It cannot be used for 
communication with an external device.
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When SERIAL1(RS232C) or SERIAL1(RS422/485) is selected under Interface Configuration

■ Default
Returns the configured values to their default values.

Function: Selects the function used by Serial Interface 1(RS232C) or Serial Interface 1(RS422/485) from the 
following.
N/A, External Device Communication 1, External Device Communication 2, External 
Device Communication 3, External Device Communication 4, O/I Link Master, O/I Link 
Slave, User Communication 1, User Communication 2, User Communication 3, Sub Host 
Communication
This communication interface is not used when N/A is selected.

Baud Rate: Selects the communication speed with the external device from the following.
1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200, 187500
The baud rate that can be configured varies based on Protocol.

Data Bits: Selects the data length as 7 or 8.
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.

Stop Bits: Selects the stop bits as 1 or 2.
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.

Parity: Selects the parity from the following.
None, Odd, Even
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.

Flow Control: Selects the flow control method as None or ER according to the external device being used.
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, or Sub Host Communication is selected for Function.

Serial Interface: When SERIAL1(RS232C) for Interface under Interface Configuration is selected, the 
standard for the serial interface to use is RS232C.
When SERIAL1(RS422/485) for Interface under Interface Configuration is selected, 
selects the standard for the serial interface to use as RS422/485 2-wire or RS422/485 
4-wire.
RS422/485 4-wire can only be configured when External Device Communication 1, 
External Device Communication 2, External Device Communication 3, External Device 
Communication 4, User Communication 1, User Communication 2, User 
Communication 3, or Sub Host Communication is selected for  Function.
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3.3 Communication Driver Tab

The Communication Driver tab is used to configure the communication driver for the external device configured in 
the current project data.

■ (Function)
Select the External Device Communication.

■ Manufacturer
Selects the manufacturer name of the external device to use in External Device Communication selected by (Function).

■ Communication Driver
The communication driver list for the selected manufacturer is displayed. Selects the serial interface to use.

■ Connection
The connection of the selected communication driver is displayed.

■ External Device
These options configure the communication driver to use. For details, refer to the WindO/I-NV4 External Device Setup Manual.

(Function)

1:1: The MICRO/I is connected to a single external device.

1:N: The MICRO/I is connected to multiple external devices.

Transmission Wait (x 10 msec): Specifies the transmission interval for communication commands (0 to 255).

Time Out (x 100 msec): Specifies the time to wait for a response from the external device (1 to 255).

Retry Cycles: Specifies the number of times to execute a reconnection when the MICRO/I cannot 
communicate with the external device. When the number of reconnect attempts 
reaches the number of times set here, a communication error is displayed.

Enable Pass-Through: Select this check box to use the Pass-Through function.
This option is only displayed for models that can use the Pass-Through function. For 
details, refer to Chapter 24 “1.2 Supported External Devices” on page 24-1.

The Pass-Through function can only use one of External Device Communication 1 to External Device 
Communication 4.

The Pass-Through Tool is required to use the Pass-Through function when using a version of WindLDR before Ver. 
6.01, another company's PLC programming software, or an external device other than IDEC's external device.

Communication Driver Extension Settings:
This button is displayed when the communication driver extension settings are required.
Click this button to display the Communication Driver Extension Settings dialog box. For 
details, refer to Chapter 4 “Communication Driver Extension Settings Dialog Box” on page 4-30.
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■ Ignore communication errors and continue operation
Select this check box to continue MICRO/I operation even when a communication error occurs.

Display error message: Select this check box to display an error message (communication error) when a 
communication error occurs and operation continues. Ack is displayed on the error message 
(communication error).
When the Ignore communication errors and continue operation check box is cleared, 
Ack is not displayed on the error message.

Auto retry: Select this check box to automatically retry communication from the MICRO/I to the station 
number where the communication error occurred when a communication error occurs and 
operation continues.
All other communication stops while retrying.

To manually retry communication, clear the Auto retry check box.
To retry all station numbers, write 1 in bit 1 (initialize) of the device address configured by Batch 
monitoring the communication error information for all Station Numbers.
To individually retry communication, write 1 in bit 0 (connection setting) of the device address configured by 
Monitoring communication error information for each station, individually.

Batch monitoring the communication error information for all Station Numbers:
Specifies the word device that stores communication error information for all station 
numbers. Only an internal device can be configured for this option.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
The information stored as error information is as follows. For details, refer to the 
WindO/I-NV4 External Device Setup Manual.
• Initialization
• Conditions under which the error occurred
• Read error history
• Write error history

Monitoring communication error information for each station, individually:
Select this check box to store the error information for each station number in device addresses.
Total number of station being monitored: Specifies the number of station numbers for 

external devices.
Status Device Address: Specifies the word device that stores communication 

error information for each station number. Only an 
internal device can be configured for this option.

Click  to display the Tag Editor. For the device 
address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.
This error information utilizes a maximum of 256 
device addresses. Use caution so that the used 
address numbers do not overlap with other 
addresses.
The information stored as error information is as 
follows. For details, refer to the WindO/I-NV4 
External Device Setup Manual.
• Connection settings
• Conditions under which the error occurred
• Read error history
• Write error history

The station number varies based on the communication interface. The displayed settings are as follows:
Serial interface: 
Ethernet interface: 

Slave Number
External Device ID 
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Communication drivers that cannot be simultaneously used

The following communication driver combinations can only be used in a single (Function). They cannot be configured 
in multiple settings.

■ Communication drivers that cannot be simultaneously used (1)

■ Communication drivers that cannot be simultaneously used (2)

Example: Communication Driver for External Device Communication 1 is set to Modbus RTU Slave
According to the communication drivers that cannot be simultaneously used (1), External Device 
Communication 2, External Device Communication 3, and External Device Communication 4 
cannot be set to Modbus RTU Master, S7-200(PPI), S7-MPI, or MP920-RTU.
According to the communication drivers that cannot be simultaneously used (2), External Device 
Communication 2, External Device Communication 3, and External Device Communication 4 
cannot be set to DM Link (1:1), DM Link (1:N), or Modbus TCP Server.

Manufacturer Communication Driver

Modbus
Modbus RTU Master

Modbus RTU Slave

SIEMENS
S7-200(PPI)

S7-MPI

YASKAWA ELECTRIC CORPORATION MP920-RTU

Manufacturer Communication Driver

IDEC System
DM Link (1:1)

DM Link (1:N)

Modbus
Modbus RTU Slave

Modbus TCP Server
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● Communication Driver Extension Settings Dialog Box
The Communication Driver Extension Settings dialog box is used to configure the communication driver 
extension settings. These settings vary based on the external device. For details, refer to the WindO/I-NV4 External 
Device Setup Manual.
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3.4 Communication Driver Network Tab

The Communication Driver Network tab is used to configure the information for external devices.

■ Settings
Edits the settings for the external devices.
External Device ID: Shows the number (0 to 31) that the MICRO/I uses to manage the external devices are displayed.
External Device Name: Shows the name for the external device. The default is the number (0 to 31).

Clicking the cell allows you to edit the name. The maximum number is 20 characters.

You cannot use the following characters and name in the External Device Name.
• The following characters and a space

\ / : ; * ? " < > |
• (blank)
• Full width character
• The same name as another External Device ID

External Device Communication: Shows the function set for the serial interface or the Ethernet interface. (Default: N/A)
Clicking the cell allows you to select the function from the following items.
N/A, External Device Communication 1, External Device Communication 
2, External Device Communication 3, External Device Communication 4

Function configured in communication drivers with a 1:1 connection in External Device Communication 
cannot be set to multiple External Device ID.

Communication Driver: Shows the communication driver for use with the External Device Communication.
Slave Number: Displays the slave number of the external device.

Clicking the cell allows you to change the slave number of the external device.
This option can only be configured when SERIAL1(RS232C) or SERIAL1(RS422/485) is 
selected for Interface Configuration on Communication Interface tab.

Leaving it blank or the same number as the other External Device IDs cannot be used for Slave Number.
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■ Clear
Returns the settings for the selected External Device ID to the defaults.

■ Expansion Settings
If extension settings are required for the communication driver set for the selected slave number, those settings are 
displayed. For details, refer to the WindO/I-NV4 External Device Setup Manual.

Number of external device limitations

• The number of external devices that can be connected to External Device Communication 1 to External 
Device Communication 4 is a total of 32 external devices.

• The number of external devices that can be set varies based on the communication interface.

IP Address: Shows the IP address of the external device. (Default: 192.168.0.1)
Clicking the cell allows you to specify the IP address of the external device.
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 0 to 255.
When connecting multiple devices to the same network, make sure to assign each device a unique IP 
address.
This option can only be configured when Ethernet is selected for Interface Configuration on 
Communication Interface tab.

Port Number: Shows the port number of external device. (Default: 2101)
Clicking the cell allows you to specify the port number of the external device (0 to 65535).
This option can only be configured when Ethernet is selected for Interface Configuration on 
Communication Interface tab.

You can change the IP address of the external devices in the System Mode. Perform the following operation 
on the Main Menu screen.
HG2G-5T: Press Initial Setting, Comm. I/F, Ext. IP Address in order.

If you change the Communication Driver and then click OK on the Project Settings dialog box, a 
confirmation message is displayed. Click Yes on the message to run the conversion for the external device 
addresses. If there are no device addresses that correspond to the external device addresses in the current 
project data after changing the communication driver, the items set with those device addresses are blank.

Communication Interface Number of External Devices

Serial Interface (Connection: 1:1 communication) 1

Serial Interface (Connection: 1:N communication) 31 max.

Ethernet Interface 32 max.
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3.5 O/I Link Tab

The O/I Link tab configures the slave stations to connect to when the MICRO/I is used as the O/I Link 
communication master. It configures the O/I link station when the MICRO/I is used as a slave. For details, refer to 
Chapter 3 “2 O/I Link Communication” on page 3-3. These options can only be configured when O/I Link Master or 
O/I Link Slave is selected for Function under Interface Settings on the Communication Interface tab.

■ O/I Link Type
Selects the slave station (Slave1 to Slave15).
This option can only be configured when O/I Link Slave is selected for Function under Interface Settings on the 
Communication Interface tab.

■ Slave Settings
Select the check boxes for the slave stations to connect to.
This option can only be configured when O/I Link Master is selected for Function under Interface Settings on 
the Communication Interface tab.

The slave stations to connect to when the MICRO/I is used as an O/I link communication master are 
enabled after the project is downloaded. The slave station number when the MICRO/I is used as a slave is 
also enabled after the project is downloaded.
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3.6 User Communication Tab

The User Communication tab is used to configure communication with external devices such as barcode readers. 
For details, refer to Chapter 3 “5 User Communication” on page 3-7. This option can only be configured when User 
Communication 1, User Communication 2, or User Communication 3 is selected for Function under 
Interface Settings on the Communication Interface tab.

■ Settings
Edits the user communication settings. You can use up to three user communication settings.

■ Edit
Registers or changes the selected user communication settings. Select a user communication number and click this 
button to display the User Communication Protocol Settings dialog box. For details, refer to Chapter 3 “User 
Communication Protocol Settings Dialog Box” on page 3-23.

■ Browse
Selects a protocol to use as user communication with Protocol Manager. Click this button to display Protocol Manager.

■ Delete
Deletes the protocol set to user communication in Settings. 

User Communication: Shows the user communication number.

Protocol Name: Shows Protocol Name configured in the User Communication Protocol Settings dialog 
box.
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■ Protocol
Shows the protocol defined as the selected user communication. For details, refer to Chapter 3 “Command Settings 
Dialog Box” on page 3-26.

■ Command
Shows the command settings for the selected protocol. Double clicking the cell displays the Data Settings dialog 
box. For details, refer to Chapter 3 “Data Settings Dialog Box” on page 3-36.

No.: Shows the number for managing the protocol settings. Double clicking the cell displays the 
Command Settings dialog box.

Type: Shows the type of command. Double clicking the cell displays the Command Settings dialog 
box.

Completed: Shows the device address to report the transmission and reception completion. Double clicking 
the cell displays the Command Settings dialog box.

Status: Shows the destination device address for the send/receive size and error information. Double 
clicking the cell displays the Command Settings dialog box.

Trigger Type: Shows the trigger type to transmit or receive data. Double clicking the cell displays the 
Command Settings dialog box.

Condition: The displayed content varies based on Trigger Type.

Rising-edge, Falling-edge, While ON, or While OFF: Shows the bit device that is the 
condition. Double clicking the cell 
displays the Command Settings 
dialog box.

While satisfying the condition or Satisfy the condition: Shows the conditional expression.

Fixed Period: Shows the period in seconds. 

Comment: Shows the command comment. Double clicking the cell displays the Command Settings dialog 
box.

Size: Shows the command size in bytes. Double clicking the cell displays the Command Settings 
dialog box.



3 Project Settings Dialog Box

4-36 WindO/I-NV4 User’s Manual

3.7 Sub Host Communication Tab

The Sub Host Communication tab is used to configure the sub host communication protocol and HMI Link Register 
(LLR) addresses to use. For details, refer to Chapter 3 “6 Sub Host Communication” on page 3-74. This option can 
only be configured when Sub Host Communication is selected for Function under Interface Settings on the 
Communication Interface tab.

■ Protocol
Selects the protocol to use in sub host communication as MicroSmart or Modbus RTU Master.

■ Allocate Address Number of HMI Link Register (LLR)

Settings: Lists the device addresses allocated to HMI Link Registers.

Address Number: Shows the LLR address numbers (LLR 0 to LLR 63).

Device Address: Shows the device addresses allocated to LLR address numbers.

B/W: Shows the device type.

B: Bit device

W: Word device

BWORD: Bit device in word

Device Type: Selects the device type of the device address to allocate to the HMI Link Register (LLR). 
Only device types that can be used are shown.

Address Number: Specifies the address number of device address to allocate to the HMI Link Register (LLR). 
The range that can be set varies based on the selected device type.

Bit Number: Specifies the bit number in a word device (0 to 15). This option can only be configured 
when a word device is selected for Device Type.

Slave Number: Specifies the slave number of the external device for the device address to allocate to the 
HMI Link Register (LLR). The range that can be specified varies based on the selected 
communication driver.
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Select this check box to monitor the error information of all external devices that are being communicated with using 
sub host communication.
For details, refer to Chapter 3 “Monitor the error information of all Slave Numbers” on page 3-79.

■ Monitor the error information of each Slave Number
Select this check box to monitor the error information for each external device that is being communicated with using 
sub host communication.
The information for each slave is stored starting with the allocated internal device and utilizes 256 words of address 
numbers.
The slave numbers are allocated with the starting address as number 0, up to number 255.
For details, refer to Chapter 3 “Monitor the error information of each Slave Number” on page 3-80.

■ Keep running with skipping the Slave Number of Communication Error
Select this check box to temporarily stop communication with the slave number where the communication error 
occurred and connect to the next slave number.
For details, refer to Chapter 3 “Keep running with skipping the Slave Number of communication error” on page 3-80.

Set: Allocates the device address to the HMI Link Register (LLR). When a device address is 
already allocated to an LLR address number, the allocated device address can be changed.
Select an LLR address number and click Set to allocate the settings configured by Device 
Type, Address Number, Bit Number, and Slave Number to the HMI Link Register 
(LLR).

Set with Auto Increment: Allocates sequential device addresses from the device address configured by Device 
Type, Address Number, Bit Number, and Slave Number to the HMI Link Registers 
(LLR) after the selected LLR address number.

Delete: Deletes the device address allocated to the HMI Link Register (LLR) from the list.
Select the LLR address on the list and click Delete.

Up: Shifts the device address allocated to the selected HMI Link Register (LLR) up in the list.

Down: Shifts the device address allocated to the selected HMI Link Register (LLR) down in the list.

Import: Displays the Open dialog box.
Select a file with exported device addresses (CSV file) and click Open to collectively 
overwrite the LLR address numbers under Settings with the device addresses in the 
selected file.

Export: Displays the Save As dialog box.
Select the location to save the file, enter a file name, and then click Save to save the 
device address details as a CSV file.

(Destination device address):Specifies the word device to write the error information to.

Click  to display the Tag Editor. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-64.

(Top device address): Specifies the word device to write the error information to. This option uses 64 words of 
addresses starting with the configured device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.



3 Project Settings Dialog Box

4-38 WindO/I-NV4 User’s Manual

3.8 External Memory Device Tab

The External Memory Device tab is used to configure the destination folder on the external memory device 
inserted in the MICRO/I.

■ External Memory Device Folder
Enter the folder name for the folder to use on the MICRO/I within 8 alphanumeric characters using upper-case 
alphabetic characters (A to Z) and numbers (0 to 9). (Default: HGDATA01)
All the data sampled with the log functions is saved in this External Memory Device folder. For details on the external 
memory device, refer to Chapter 27 “1 External Memory Devices” on page 27-1.

■ Remove Files
Select this check box to erase the files saved in the External Memory Device folder.

• You cannot use the following characters in the folder name.
   . \ / : * ? “ < > |

• After operation starts, the folders created in the External Memory Device folder and the file names cannot 
be changed.

All Screenshots: Select this check box to erase all the screenshots in the “CAPTURE” folder.

All Alarm Log files: Select this check box to erase all the Alarm Log data saved in the "ALARMLOG" folder. 

All Data Log files: Select this check box to erase all the Data Log data saved in the "DATALOG" folder.

All Operation Log files: Select this check box to erase all the Operation Log data saved in the “OPERATIONLOG” 
folder.

Trigger Device Address Specifies the bit device or bit of the word device to serve as condition to delete the files.
Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
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3.9 Autorun Tab

The Autorun tab is used to configure the functions for a USB flash drive inserted in the MICRO/I. For details, refer to 
Chapter 27 “2 USB Autorun Function” on page 27-20.

■ Enable USB Autorun
Select this check box to enable the USB Autorun function.
The USB Autorun function automatically displays a menu screen from which the user can execute predefined 
commands when a USB flash drive is inserted in the MICRO/I.

■ Open Popup Screen when USB Flash Drive is inserted
Select this check box to display a popup screen when a USB flash drive is inserted in the MICRO/I.

Screen Number: Specifies the popup screen number (1 to 3015) to display when a USB flash drive 
is inserted in the MICRO/I.

Coordinates X, Y: Specifies the coordinates to display the popup screen.
With the upper-left corner of the screen as the origin, the X and Y coordinates are 
the upper-left corner of the popup screen.
The units and range for the display coordinates are as follows.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)
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3.10 Web Server Tab

The Web Server tab configures the MICRO/I's Web Server function. For details, refer to Chapter 25 “1 Web Server 
Function” on page 25-1.

■ Disable Web Server function
Select this check box to prohibit access from a web browser terminal.
When accessing the MICRO/I from a web browser terminal, not only is remote control and remote monitoring not 
displayed, but the detailed system information page is also not displayed.

■ Remote Control and Monitoring
Select the functions allowed when accessing the MICRO/I from a web browser terminal from the following.

■ Execution Interval (msec)
Specifies the interval (0 to 5,000 ms) for the MICRO/I to return data. The load that the remote control function and 
the remote monitoring function place on MICRO/I operation can be reduced by increasing this value. However, the 
display update speed in the web browser will become slower.

■ Port Number
Specifies the port number to use for the Web Server function (0 to 65,535).

Enable Remote Control and Monitor: Displays a screenshot of the screen displayed on the MICRO/I. You can also 
control the MICRO/I being monitored by clicking on the displayed screenshot.

Enable Remote Monitor only: Displays a screenshot of the screen displayed on the MICRO/I.

Disable: Displays only the detailed system information page.
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3.11 Project Details Tab

The Project Details tab displays and configures project data information.

■ Project Name
Shows the current project name.

■ Project Folder Size
Shows the total size of the current project data.

■ Download Data Size
Shows the total size of the data and the total size of only the image files when the current project data is downloaded.

■ Location
Shows the save location for the current project data.

■ Created
Shows the date and time the current project data was created.

■ Modified
Shows the date and time the current project data was last saved.

■ Accessed
Shows the date and time the current project data was opened.

■ User
Enter the name of the creator. The maximum number is 40 characters.

■ Comment
Enter a comment for the project data. The maximum number is 40 characters.

■ Language
Select the language used for saving alarm log, data log, and operation log data as CSV files:
European, Japanese, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
The display type for dates and times varies based on the selected language.

Japanese: YYYY/MM/DD HH:MM:SS
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY HH:MM:SS
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3.12 Font Settings Tab

The Font Settings tab is used to configure the optional fonts when downloading to the MICRO/I.

■ Optional Fonts to be downloaded
Select the optional fonts for download to the MICRO/I. Select the check boxes for the optional fonts when 
downloading:
Japanese Large Font (First standard), Japanese Large Font (Second Standard), Chinese, Taiwanese, 
Korean, European Large Font, Central European, Baltic, and Cyrillic.

■ Total font size
Shows the total size of the standard fonts and selected optional fonts.
If no optional fonts are selected for download to the MICRO/I, shows the size of the standard fonts.

• Optional fonts, if left cleared, will be removed from the MICRO/I when the project data is downloaded.
• The check boxes for optional fonts used in drawings, parts, and Text Manager are automatically selected.
 For details about optional fonts, refer to Chapter 2 “Installed Fonts in the MICRO/I” on page 2-6.

Standard font size: Shows the total size of the standard fonts.

Optional font size: Shows the total size of the selected optional fonts.
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3.13 Compatible Tab

The Compatible tab is used to enable the functions in previous versions of WindO/I-NV4 and older MICRO/I series 
(HG1B).
This tab is only displayed when the Use Compatible functions for previous version check box or the Use HG1B 
Compatible functions check box is selected in the WindO/I-NV4 Options dialog box, on the General Settings 
tab, under Compatible.

■ Compatible with previous version
This option is only displayed when the Use Compatible functions for previous version check box is selected in 
the WindO/I-NV4 Options dialog box, on the General Settings tab, under Compatible.

Script/Trigger Condition:

Calculate 16-bit data with 16-bit: Select this check box to calculate arithmetic 
operations (+, -, *, /, modulo) as 16-bit data when 
UBIN16(W), BIN16(I), or BCD4(B) is selected for 
Data Type. Data that exceeds 16 bits is lost.
Clear this check box to calculate as 32 bits. No data 
will be lost.

Handle Logical operations as Bit operations: Select this check box to process logical operations 
(||, &&) by replacing them with bit operations (|, &). 
The priority of the replaced bit operators is the same 
as the corresponding logical operators.



3 Project Settings Dialog Box

4-44 WindO/I-NV4 User’s Manual

■ Compatible with HG1B
These options are only displayed when the Use HG1B Compatible functions check box is selected in the 
WindO/I-NV4 Options dialog box, on the General tab, under Properties for Compatible function.

Word Button/Word Write Command:

Write the data as 2 words: Select this check box to write the calculated result of 
arithmetic operations (+, -, *, /) as two words when 
UBIN16(W) or BIN16(I) is selected for Data 
Type. For +, -, *, /, the calculated result is written in 
two words as a 32-bit numeric value. 
For "/" (division), the quotient data is written in the 
first word, and the remainder data is written in the 
second word.
Clear this check box to write the result of arithmetic 
operations as one word.

Numerical Input/Numerical Display:

Divide Floating data and Integer data: Select this check box to read and display the decimal 
portion of data and the integer portion of data from 
different device addresses when BCD4(B) or 
BCD8(EB) is selected for Data Type.

Message Display:

Ignore LF code in the variable strings: Select this check box to display messages by ignoring 
the linefeed code LF (0Ah) when displaying text 
according to values of device addresses.
Clear this check box to display messages with line 
breaks using the linefeed code LF (0Ah).

Convert NULL code to Space code in the variable strings: Select this check box to display messages by 
converting the NULL terminating code (00h) to a 
space (20h) when displaying text according to values 
of device addresses.
Clear this check box to terminate messages with the 
NULL terminating code (00h).

Timer:

Keep Timer status after changing the screen: Select this check box to continue the timer count 
when switching the base screen or when displaying a 
popup screen.
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4.1 Download Restrictions

■ Project Data Size
The size of the project data that can be downloaded to the MICRO/I is as follows.

■ Number of Parts
The number of parts that can be downloaded to the MICRO/I are as follows.

4.2 Maximum Number of External Device Addresses

■ Data Log Settings
A maximum of 128 external device addresses can be used in the Data Log settings.

■ Global Script
A maximum of 256 external device addresses can be used as a trigger condition and in scripts executed as Global 
Script.

■ Scripts
The number of external device addresses which can be used in the script are as follows:

4 Project Restrictions

MICRO/I Project data size

HG2G-5T Approx. 5 MB max (including additional fonts)

• To check the project data size, on the Home tab, in the Project group, click Target Info. The Target 
Information dialog box is displayed. The project data size can be checked with Memory Space (byte) 
under Target Runtime Information.

• The project data size varies based on the fonts downloaded to the MICRO/I. For details, refer to Chapter 
2 “Font Size” on page 2-8.

Parts Number of parts

Total number of Bit Buttons, Word Buttons, Goto Screen Buttons, Key Buttons 32,000 max.

Selector switches 200 max.

If the same device address is used in multiple device address settings, the number of used device addresses 
is counted as 1. It is not counted as 1 device address per device address setting.

If the same device address is used in multiple device address settings, the number of used device addresses 
is counted as 1. It is not counted as 1 device address per device address setting.

Item Number of devices

Destination external device addresses 64 max.

Source external device addresses 64 max.

• If the same device address is used in multiple device address settings, the number of used device 
addresses is counted as 1. It is not counted as 1 device address per device address setting.

• For the Global Script, the maximum number of source external device addresses which can be used as a 
trigger condition and in scripts executed as Global Script is 256.
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This chapter gives an overview of the MICRO/I screen and describes how to create setup and operate the screen.

  

1.1 Screen Types

The types of screens offered by the MICRO/I and screens that can be created with the WindO/I-NV4 are given below.

1.2 Screen Size

The screen size differs depending on the MICRO/I model selected. The size of the MICRO/I screen is equal the size of 
the Base Screen.

Chapter 5 Screens

1 Screen Overview

Screen Type Screen No. Description

Screens that can 
be created with 
the WindO/I-NV4

Base Screen 1 to 3000
The screen that is displayed when the MICRO/I is in Run Mode. This 
screen places drawing objects and parts on the base and creates a 
screen that is displayed on the MICRO/I.

Popup Screen 1 to 3015

The Popup Screen that is displayed on the Base Screen when the 
MICRO/I is in Run Mode. The size and coordinates of the screen can be 
specified and this screen can also be moved on the Base Screen.
A Popup Screen for the standard Keypad will automatically be created 
in screen numbers 3001 to 3015.

The screen 
provided by the 
MICRO/I

Maintenance 
Screen

–

Using the screen that is displayed when the MICRO/I is in Run Mode, 
you can switch from Run Mode to System Mode and load a screen to 
adjust device monitor and screen brightness.
For details, refer to Chapter 29 “1 Maintenance Screen” on page 29-1.
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HG2G-5T 320 x 240 dots
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2.1 Creating Screens

This section describes how to create Base Screens and Popup Screens.

● Creating a screen

1 On the Home tab, in the Screens group, click ▼ under New.

2 Click Base Screen or Popup Screen.

The Screen Properties dialog box is displayed.

3 Change the settings on each tab as necessary and click the OK button.

2 Creating and Manipulating WindO/I-NV4 Screens

To edit the properties for a Base Screen or Popup Screen that has already been created, double click an area 
in the editing window with no objects.
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2.2 Opening Screens

● Opening a screen
You can open a single screen that has already been created.

Double click the screen to open in the Project window.

● Opening specific screens
You can open multiple screens as a group.

1 On the Home tab, in the Screens group, click ▼ to the right of Open.

2 Click the Base Screen or the Popup Screen.

The Open Screens dialog box is displayed.

3 Click the screens to open in Screen List and then click the OK button.

■ Screen Type
Select the type of screen to open from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens that have already been created.

If you right click a screen in the Project window, and then click Open Screens, the selected screen opens.

If you right click a screen folder in the Project window and then click Open Screens, the Open Screens 
dialog box is displayed.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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● Opening the previous or next screen
You can open the screen with the previous screen number or the next screen number of the screen displayed in the 
active editing window.

To open the screen with the previous screen number, click the  (Open Previous Screen) button in the Screens 

group on the Home tab. To open the screen with the next screen number, click the  (Open Next Screen) button.
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2.3 Closing Screens

● Closing the displayed screen
You can close the active editing window.

Click  in the upper-right of the editing window.

● Closing all screens
You can close all the editing windows.

On the View tab, in the Window group, click Close All.

● Closing a specific screen
You can close multiple editing windows as a group.

1 Right click a screen folder in the Project window and click Close Screens.

The Close Screens dialog box is displayed.
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2 Click the screens to close in Screen List and click the OK button.

■ Screen Type
Select the type of screen to close from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows the screens being edited.

■ Select All
Selects all the screens displayed in Screen List.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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2.4 Duplicating Screens

You can copy a screen that has already been created to create a new screen.

1 Right click a screen folder or screen in the Project window and click Duplicate Screens.

The Duplicate Screens dialog box is displayed.

2 Select the screens to copy in Screen List.

3 Specify Screen Number for the new screen and the Number of copies to duplicate and then click the OK button.

■ Screen Type
Select the type of screen to duplicate from either Base Screen or Popup Screen. The selected screen type is 
displayed in Screen List.

■ Screen List
This list shows screens that have already been created.

■ Screen Number
Specify the screen number (Base Screen: 1 to 3000, Popup Screen: 1 to 3015) for the new screen.

■ Number of copies
Specify the number of screens to copy (Base Screen: 1 to 2999, Popup Screen: 1 to 3014).

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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• If multiple screens are selected in Screen List or if the Number of copies is 2 or more, consecutive 
screen numbers are added to the screens starting with the number specified in Screen Number.
Example: When a screen with screen number of 1 is selected in Screen List, the Number of copies is 

3, and Screen Number is 100 is selected, then the screen numbers after duplication are 
“100”, “101”, “102”.

Example: When screens with screen numbers 3 and 5 are selected in Screen List, the Number of 
copies is 2, and Screen Number is 100 is selected, then the screen numbers after 
duplication are “100” and “102” for the screens duplicated from screen number 3 and “101” and 
“103” for the screens duplicated from screen number 5.

• If a screen number already exists after copying and you click the OK button on the Duplicate Screens 
dialog box, an overwrite confirmation message is displayed.
- Click the Yes button to overwrite the screen with the number displayed in the confirmation message.
- Click the Yes To All button to overwrite all the screens.
- Click the No button to display the next confirmation message without copying the screen with the 

number displayed in the confirmation message.
- Click the Cancel button to stop copying screens and return to the editing window.

Screen List’s numbers: 1
Screen Number: 100
Number of copies: 3

Screen Number: 1 Screen Number: 100

Screen Number: 101

Screen Number: 102

Copy99 99

99

99

Screen List’s numbers: 3,  5
Screen Number: 100
Number of copies: 2

Screen Number: 3

Screen Number: 5

Screen Number: 100

Screen Number: 101

Screen Number: 102

Copy

Screen Number: 103

Copy

99

99

99

Full Full

Full
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2.5 Deleting Screens

● Deleting a screen
You can delete a single screen.

1 Right click the screen to delete in the Project window and click Delete Screens.

A delete confirmation message is displayed.

2 Click the Yes button.

The screen is deleted.
Click the No button to return to the editing window without deleting the screen.

● Deleting specific screens
You can delete multiple screens as a group.

1 On the Home tab, in the Screens group, click Delete.

The Delete Screens dialog box is displayed.

If you right click a screen folder in the Project window and click Delete Screens, the Delete Screens 
dialog box is displayed.
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2 Click the screens to delete in Screen List and click the OK button.

A delete confirmation message is displayed.

■ Screen Type
Select the type of screen to delete from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens that have already been created.

■ Select All button
Selects all the screens displayed in Screen List.

3 Click the Yes button or the Yes To All button.

• Click the Yes button to delete the screen with the number displayed in the confirmation message. When deleting 
multiple screens, the next message to confirm deleting a screen is displayed.

• Click the Yes To All button to delete all the screens without displaying the confirmation message.
• Click the No button to display the next message to confirm deleting a screen without deleting the screen with the 

number displayed in the confirmation message. You will return to the editing window when finished confirming all 
the screens.

• Click the Cancel button to stop deleting screens and return to the editing window.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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2.6 Reusing Screens

You can copy screens from other project data.

1 On the Home tab, in the Screens group, click Reuse.

2 Select project data that includes the screens to copy and click OK.

The Open dialog box is displayed.

If you right click a screen folder or screen in the Project window and click Reuse Screens, the Open 
dialog box is displayed.

If a password has been configured for the project data, the Password Screen will be displayed.
The password to enter varies based on the check box setting of the Use Password to open a Project 
found under the Options tab in the Security dialog box.
When this check box is checked, enter the password for Use Password to open a Project.
When this check box is unchecked, enter the password for the user account assigned to the Administrator 
security group.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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3 Click the screens to copy in Screen List and click the OK button.

■ Screen Type
Select the type of screen to copy from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens included in the source project data.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.

If the screen number of the screen to copy, a picture included in the screen, a text ID, or a script ID already 
exists in the project data being edited, an overwrite message is displayed.
• Click the Yes button to overwrite the item displayed in the confirmation message. If there are multiple 

redundant items, a confirmation message is displayed for each of those items.
• Click the Yes To All button to overwrite all of the picture numbers, pictures, text IDs, and script IDs.
• Click No and a dialog box opens for each setting. Change the item to a unique screen number or ID and 

click the OK button.
• Click the Cancel button to stop overwriting the displayed in the confirmation message. If there are 

multiple redundant items, a confirmation message is displayed for each of those items.
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2.7 Batch Editing of Multiple Screen Settings

You can modify the settings for multiple base screens or popup screens collectively.

1 Selects multiple screens of the same type on the Project window or in the Screen List window, right-click to open a 
popup menu, and then click Properties.
The Screen Properties dialog box is displayed.

2 Configure only the items to modify collectively.

3 Click the OK button.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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The screen that is displayed when the MICRO/I is in Run Mode. This screen places drawing objects and parts on the 
base and creates a screen that is displayed on the MICRO/I.

3.1 Base Screen Settings

● General Tab

■ Screen Type
Select Base Screen as the screen type.
You can only select the screen type when creating a new screen.

■ Number
Enter the Base Screen’s screen number (1 to 3000).

■ Title
Enter the Base Screen’s title. Maximum number is 40 characters.

■ Size
Shows the screen size. You cannot change the size of Base Screens.

■ Screen List
This list shows screens that have already been created. It is only displayed when creating a new screen.

3 Base Screen
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● Options Tab

■ Background Color
Select the screen’s background color (color: 256 colors, monochrome: 16 colors). Click this button to open the color 
palette. Select color with the color palette.

■ Overlay with Base Screen
Configure this section to display the Base Screen by overlaying screens.

When Overlay with Base Screen is configured, the background color for the Base Screen specified as the 
background is displayed.

1 to 5: Select these to display the Base Screen by overlaying screens.

No.: Enter the overlay screen’s screen number (1 to 3000).

Coordinates X, Y: Specify the display location of the overlay screen in coordinates. The coordinates can be set 
in the range (Screen size - 1 dot).
The origin is the upper-left corner of the screen and the X- and Y-coordinates correspond to 
the upper-left corner of the overlay window.

(0, 0)
X

Y
Base screen

Overlay screen
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■ Display the Order of Overlapping Screens
You can select the display order of the Base Screen and the overlay screens.
Example: To display the Base Screen being edited as the background

Example: To display the Base Screen being edited above overlay screen: 3

■ Flash
Select one of the following items as the setting when the screen is flashing.

■ Focus Order
Sets the focus order for Numerical Input and Character Input. The focus order is the order the focus moves between 
Numerical Input or Character Input when the user presses the ENT key. Text can be input in Numerical Input or 
Character Input that has focus. The focus order number starts from 0.

Base screen being edited

Overlay screen
(5 screens max)

Base screen being edited

Overlay screen: 3

None: Displays the screen.

Flash (1 sec cycle): The screen display is flashed in one second intervals.

Flash (0.5 sec cycle): The screen display is flashed in half second intervals.

Backlight OFF: Turns off the backlight until the screen is touched or until bit 0 or bit 7 is set to 1 in the 
system area 1’s address number + 1.

Vertical: The focus moves vertically from top to bottom.

Horizontal: The focus moves horizontally from left to right.

Custom: Sets the desired order for moving the focus.
On the View tab, in the Screens group, click Focus Order, and then click the parts in the 
order to move the focus.

The focus moves in the following order when Numerical Input and Character Input on the screen is not 
aligned to the left or top.

1

4

3

2

1

4

3

21234

5

890

67

1234

5
890

67Vertical

X-axis left to right

Y-axis up to down

Horizontal
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■ Security Group
Select the security group to restrict the screen display.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

Click  to display the Security Group Settings dialog box. If you create a security group in the Security Group 
Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding and Editing 
Security Groups” on page 21-18.

None: Any user can open this screen.

Administrator, Operator, 
Reader, (Created security group): Only a selected user can open this screen.

For details about the security function, refer to Chapter 21 “User Accounts and the Security Function” on 
page 21-1.
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3.2 Displaying Layered Base Screens

It is possible to layer and display multiple Base Screens. The coordinates and display order for layered screens can be 
set on the screen that will serve as the base. A maximum of 5 layered screens can be displayed.

■ Coordinates
Using the upper-left corner of the screen as the origin, the upper-left area of the layered screen become the X and Y 
coordinates.

■ Display Order
This allows you to select the order of display for the screen that will serve as the base and layered screens.
Example: Displaying a Base Screen that is currently being edited as the bottom most layer

Example: Displaying a Base Screen currently being edited on the layered screen: 3.

For details about how to configure these settings, refer to “3.1 Base Screen Settings” on page 5-14.
Example: When Base Screen: 100 which has a clock placed in it, is used as a layered screen, Base Screen:1 which is 

displayed as the base and Base Screen: 2 will be displayed as follows:

(0, 0)
X

Y
Base screen

Overlay screen

Base screen being edited

Overlay screen
(5 screens max)

Base screen being edited

Overlay screen: 3

130
100
120

110

11/Feb./22 Tue. 12:00

11/Feb./22 Tue. 12:0011/Feb./22 Tue. 12:00

130
100
120

110

Base Screen: 1 Base Screen: 100 Base Screen: 2

Display for Base Screen: 1 Display for Base Screen: 2

Layering Layering

Displayed as 
the base

Displayed as 
the base

Layered Screen
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• Layered screens that have been set as layered screens will not be displayed on the screen that is 
displayed as the base.
Example: Layering and displaying Base Screen: 100 on Base Screen: 1

Layering and displaying Base Screen: 101 on Base Screen: 100

• Drawing objects and parts from layered screens may not display properly when placed outside of the 
displayed area.

130
100
120

11/Feb./22 Tue. 12:00

11/Feb./22 Tue. 12:00

130
100
120

Base Screen: 1 Base Screen: 100

Base Screen: 101

Display for Base Screen: 1

Display for Base Screen: 100

Layering

Layering

0

11/Feb./22 Tue. 12:00

130
100
120

0

11/Feb./22 Tue. 12:00

0

Displayed as 
the base

Layered Screen
Layered Screen

Layered Screen (Base Screen: 
101) is displayed.

Layered Screen (Base 
Screen: 101) is not 
displayed.

Outside of the display area

Layered Screen

Displayed as the base

When layering and displaying base screens that have drawings and parts placed on the top layer, they are 
displayed in order of each top layer in front of each base screen.
Example: When layering Base Screen 2 on the of Base Screen 1

For displaying of drawings and parts placed on the top layer, refer to Chapter 6 “4 Drawings and Parts 
Overlapping” on page 6-5.

Base Screen 2

Base Screen 1

Display for Base Screen: 1

Layering

14/07/22 12:00

130

100

120

14/07/22 12:00

130
100

120

14/07/22 12:00
130

100
120

Top layer of Base Screen 2

Top layer of 
Base Screen 2

Top layer of 
Base Screen 1

Base Screen 2

Base Screen 1

Top layer of Base Screen 1
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The Popup Screen that is displayed on the Base Screen when the MICRO/I is in Run Mode. The size and coordinates 
of the screen can be specified and this screen can also be moved on the Base Screen.

4.1 Popup Screen Settings

● General Tab

■ Screen Type
Select Popup Screen for the screen type.
You can only select the screen type when creating a new screen.

■ Number
Enter the Popup Screen’s screen number (1 to 3015).
However, screen numbers 3001 to 3015 are Popup Screens for standard Keypads for Numerical Input and Character 
Input.

■ Font
Select the font to use for the title from the following choices:
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
This option can only be selected when Use Text Manager is cleared.

■ Use Text Manager
Select this to use text registered in the Text Manager for the screen title.
However, the text color is white, not the color set in the Text Manager.

■ Text ID

Specify the Text Manager ID number (1 to 32000) to use text registered in the Text Manager. Click  to display the 
Text Manager.
This option can only be set when Use Text Manager is selected.

4 Popup Screen
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■ Title
Enter the Popup Screen’s title. Maximum number is 40 characters. This title is displayed in the Popup Screen’s title bar.
This option can only be entered when Use Text Manager is cleared.

■ Size

■ Screen List
This list shows screens that have already been created. It is only displayed when creating a new screen.

● Options Tab

■ Background Color
Select the screen’s background color (color: 256 colors, monochrome: 16 colors). Click this button to open the color 
palette. Select the color with the color palette.

■ Screen Effects

■ Title Bar
Select this to display the title bar on the Popup Screen. The text set in Title on the General tab is displayed in the 
title bar.
The title bar is not displayed if superimpose is set.

Width, Height: Specify the width (40 dots to Base Screen width) and the height (40 dots to Base Screen height) of 
the Popup Screen.

None: Displays the Popup Screen’s background with the color specified in Background Color.

Transparency: Displays the Popup Screen’s background as transparent. The amount of transparency can be selected 
from 10% to 90% in 10% increments.

Superimpose: Displays the Popup Screen’s background as completely transparent. The screen underneath the 
Popup Screen can be seen.

If you select Superimpose, the buttons underneath the Popup Screen set to superimpose are active.

If Superimpose is selected in Screen Effects, magenta (R:255, G:4, B:255) is treated as the transparent 
color. If you place pictures on a Popup Screen set to superimpose that use this color, those areas are 
completely transparent.

Move Button: Select this to display the  (Move) button on the title bar.

Close Button: Select this to display the  (Close) button on the title bar.
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■ Open with Fade In
When opening a Popup Screen, select this to gradually fade in the popup screen from nothing to the transparency 
specified in Transparency.

■ Close while changing Base Screen
Select this to close the displayed popup screen when changing the Base Screen.

■ Focus Order
Sets the focus order for Numerical Input and Character Input. The focus order is the order the focus moves between 
Numerical Input or Character Input when the user presses the ENT key. Text can be input in Numerical Input or 
Character Input that has focus. The focus order number starts from 0.

■ Security Group
Select a security group to restrict displaying the screen.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security Group 
Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding and Editing 
Security Groups” on page 21-18.

Vertical: The focus moves vertically from top to bottom.

Horizontal: The focus moves horizontally from left to right.

Custom: Sets the desired order for moving the focus.
On the View tab, in the Screens group, click Focus Order, and then click the parts in the order to 
move the focus.

The focus moves in the following order when Numerical Input and Character Input on the screen is not 
aligned to the left or top.

1

4

3

2

1

4

3

21234

5

890

67

1234

5
890

67Vertical

X-axis left to right

Y-axis up to down

Horizontal

None: Any user can open this screen.

Administrator, Operator, 
Reader, (Created security group): Only selected users can open this screen.

For details about the security function, refer to Chapter 21 “User Accounts and the Security Function” on 
page 21-1.
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4.2 Popup Screen Configuration

■ Title Bar
Displays buttons and the title of the Popup Screen.
Pressing the title bar of the screen allows you to move the screen to the front.

■  (Move) Button
Moves the Popup Screen.

Close ButtonMove Button

Title Bar

Screen Display Area

MICRO/I MICRO/I MICRO/I

When there is a title bar on the popup screen, touch switches that are within 20 dots of the title bar will not 
respond.

1 Press 2 Touch the position where the 
screen will be moved to

3 The screen will move the position 
that was touched

MICRO/I MICRO/I MICRO/I

The location that was touched will 
become the location of      .

• The Popup Screen can be moved in the range where the  button can be displayed.

• The Popup Screen will be moved in units of 1 dot.
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■  (Close) Button

Closes the Popup Screen.

■ Screen Display Area
The area where drawing objects and parts are placed.

4.3 Standard Keypad Popup Screen

A Popup Screen that places a regular Keypad used for Numerical and Character Input on screen numbers 3001 to 
3015 with the WindO/I-NV4.
Example: HG2G-5T

Decimal (Number Value) Keypad Uppercase (Alphabet) Keypad

• The Keypad Popup Screen will differ depending on the model selected.
• The Keypad Popup Screen can also place drawing objects and parts in the same manner as Popup Screen 

numbers 1 to 3000.
• Screen numbers 3001 to 3015 are screen numbers that are empty when a new project has been created 

and are handled as normal Popup Screens.
• Deleting a Keypad Popup Screen and recreating a new Popup Screen of the same screen number will 

place the same Keypad.
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5.1 Screen Number

The number of screens and layered screens that can be created in a single project and the number of Popup Screens 
that can be displayed on the Base Screen are as follows:

■ Base Screen

■ Popup Screen

5.2 Maximum Number of Parts

■ Number of Parts That Can be Placed on a Single Screen

■ Number of Parts That Can be Displayed on a Single Screen
In addition to the currently displayed Base Screen, this includes layered screens and currently displayed Popup 
Screens.

*1 The maintenance screen is not included.

5 Screen Restrictions

Item Number of screens

Number of screens that can be created 3,000 max.

Number of layered screens 5 max.

Item Number of screens

Number of screens that can be created 3,015 max.

Number of screens that can be displayed on the Base Screen 3 max. (Including the Device Monitor*1)

Screen Number of Parts

Base Screen 960 max.

Popup Screen 480 max.

Parts Number of Parts

Alarm List Display, Alarm Log Display Limit to 1. Either one but can't be both.

Numerical Inputs and Character Inputs in a constant state of input Limit to 1. Either one but can't be both.

Potentiometer 32 max.

Numerical Input 256 max.

Character Input 256 max.
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5.3 Maximum Number of External Device Addresses

The number of write-destination device addresses for usable external devices and the number of read-source device 
addresses from the external device differ depending on the screen type.

■ Base Screen (Includes Layered Screens)

■ Popup Screen

5.4 Text and Messages

Follow the rules below, otherwise text and messages on the MICRO/I may not be displayed or may be partially 
missing.

5.5 Vertical Installation

Even if you choose for them to be installed and displayed vertically, the screens in the System Mode will be the same 
as horizontal installation and display.

External device Number of Devices

Write-destination Device Addresses 512 max.

Read-source Device Addresses 256 max.

External device Number of Devices

Write-destination Device Addresses 128 max.

Read-source Device Addresses 256 max.

If the same device address is used in multiple device address settings, the used number of device addresses 
will be counted as 1 device address. It will not be counted as 1 point per device address setting.

Popup screen title: Make shorter than the title bar

Text on drawings: Make smaller than the text area

Text and messages used in parts: Make smaller than the size of the parts
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This chapter contains an overview of drawings and parts that are used when creating a screen and a description of 
the types of drawings and parts.

  

Drawings and parts are used by placing them on base screens and popup screens.

Drawings include objects such as straight lines, polygons, circles, pictures, and static text.

Parts are objects that generate a variety of events when triggered by a change in values of device addresses or by 
touch.
 

Chapter 6 Drawings and Parts

1 Overview

MICRO/I

Caution

Equilateral Triangle

Polyline

Line
Text

Picture

External device

External device

Parts changed to reflect 
changes in values of 
device addresses

Tank 1

MICRO/I

MICRO/I

D10: 80

D11: 25

D12: 2

D13: 0

D14: 0

D15: 0

D10: 99

D11: 82

D12: 5

D13: 1

D14: 1

D15: 1

0

Tank 1

0

Full

Empty

99
82

5

80
25

2

Pilot Lamp

Numerical Input

Message Display

Line Chart

Selector Switch

Numerical Display

Picture Display
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This section describes the drawing objects that can be drawn in WindO/I-NV4.

2.1 Shapes

2.2 Picture

Loads drawing objects that are registered in the Picture Manager onto the edit screen.

2.3 Text

Draws text. The maximum number is 3,750 characters.
Loads text that is registered in the Text Manager.

2 Drawing objects

Shapes Function

Basic Shapes Line Draws a line.

Polyline Draws a polyline.

Polygon Draws an object that connects two or more vertices with straight lines.

Rectangle Draws a rectangle.

Circle/Ellipse Draws a circle or ellipse.

Arc Draws an elliptical arc.

Pie Draws a pie.

Equilateral Polygon Draws a equilateral polygon. (triangle, diamond, pentagon, hexagon, or octagon)

Paint Paints the closed region of the drawing object.
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This section describes the parts that can be used on the MICRO/I.

3.1 Buttons

3.2 Lamps

3.3 Data Displays

3 Part Types

Part Description

Bit Button Writes a 0 or 1 to a bit device.

Word Button Writes a value to a word device. Can be used to indirectly specify the destination address 
number or to perform operations on the written value.

Goto Screen Button Switches to another screen or displays a window.

Print Button Outputs a screenshot to external memory devices.

Key Button Performs a variety of functions including uploading and downloading, copying files, and 
operating other parts.

Multi-Button Executes multiple commands at once.

Keypad A part comprised of Key Buttons. Enters numbers and characters into numerical or character 
input parts.

Selector Switch Writes a 0 or 1 to a bit device. This is an exclusive control that only writes a single value as 
1 and all other values as 0.

Potentiometer Writes a value selected by pressing a slider button to a word device.

Part Description

Pilot Lamp Displays images. Switches the displayed image according to the value of a bit device.

Multi-State Lamp Displays images. Switches the displayed image according to the value of a word device.

Part Description

Numerical Input Uses either a Keypad or Key Button to write entered numbers.

Character Input Uses either a Keypad or Key Button to write the character code for entered characters.

Picture Display Displays images. Switches, moves or enlarges/reduces the displayed image according to the 
value of a device address, the bit status within a word device or at a fixed period.

Message Display Loads fixed text strings and word device values as character codes and displays them on the 
screen.

Message Switching Display Switches the displayed fixed text string according to the value of a word device or the bit 
status within a word device.

Alarm List Display Switches the displayed fixed text string according to the value of a device address. Can 
display alarms and multiple fixed text strings.

Alarm Log Display Displays the alarm log stored in the internal memory of the MICRO/I.

Numerical Display Displays the numerical in the specified format.

Calendar Displays the date and time using the MICRO/I's calendar data.



3 Part Types

6-4 WindO/I-NV4 User’s Manual

3.4 Charts

3.5 Commands

Part Description

Bar Chart Displays values of word devices in a Bar Chart.

Line Chart Displays data logs and values of word devices in a Line Chart.

Pie Chart Displays values of word devices in a Pie Chart.

Meter Displays a value of a word device using a needle gauge.

Part Description

Bit Write Command Writes a 0 or 1 to a bit device when certain trigger conditions are satisfied.

Word Write Command
Writes a value to a word device when certain trigger conditions are satisfied. Can be used to 
indirectly specify the destination address number or to perform operations on the written 
value.

Goto Screen Command
Switches to another screen or displays a window when certain trigger conditions are 
satisfied.

Print Command
Outputs a screenshot to external memory devices when certain trigger conditions are 
satisfied.

Script Command Executes a script when certain trigger conditions are satisfied.

Multi-Command Executes multiple commands at once when certain trigger conditions are satisfied.

Timer
Starts a countdown when certain trigger conditions are satisfied, and writes 1 to an internal 
device (HMI Timer Relay LTC) after the set time has elapsed.



WindO/I-NV4 User’s Manual 6-5

4 Drawings and Parts Overlapping

6

D
raw

ings and Parts

This section describes when drawing and parts overlap.

4.1 Overview

Place the drawings and parts on the top layer to have precedence when these objects overlap on base screens and 
popup screens.
Configure the Properties dialog box of the drawings or parts if they need to be placed on the top layer. For details, 
refer to the settings for the drawings or part.

4 Drawings and Parts Overlapping

Base Screen or Popup Screen

Display for Base Screen or Popup Screen

130
100
120

130
100

120Top Layer
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4.2 Displaying Overlapping Drawings and Parts

The display when drawings and parts overlap on base screens and popup screens varies based on the location where 
they are placed.

● Display order of overlapping parts
•If two parts overlap on a base screen or popup screen, the part last modified is displayed in the front.
Example: A Numerical Display is placed on the base screen and a Bit Button is placed in front of it.

•If two parts are overlapping each other on a base screen or popup screen, the part which is configured in the 
Properties dialog box as a top layer, will keep displaying in the front.
Example: A Numerical Display is placed on the base screen and a Bit Button is placed on the top layer.

•If parts placed on the top layer overlap, the display order of the parts does not change.
Example: A Numerical Display is placed on the top layer and a Bit Button is placed in front of it.

Display for Base Screen: 1

Numerical Display is displayed in front

Changes the value

1234

Numerical Display
Bit Button

Base Screen: 1

1234

9999

Object list

No. Type Layer

1 Numerical Display

2 Bit Button

567

Display for Base Screen: 1

The display order of Numerical Display
and Bit Button is unchanged

Changes the value

1234

Top Layer

Numerical
Display

Bit Button

Base Screen: 1

1234

9999

Object list

No. Type Layer

1 Numerical Display

2 Bit Button Top Layer

567

Display for Base Screen: 1

The display order of Numerical Display
and Bit Button is unchanged

Changes the value

1234
Top Layer

Numerical
Display

Bit Button

Base Screen: 1

1234

9999

Object list

No. Type Layer

1 Numerical Display Top Layer

2 Bit Button Top Layer
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● Display order of drawing and parts overlapping
•If a drawing and part are overlapping with each other on a base screen or popup screen, the drawing or part 
configured in the Properties dialog box as a top layer, then it will be displayed in the front over the other.
Example: An equilateral hexagon is placed on the base screen and a Numerical Display is placed in front of it.

•If a part placed on a base screen or popup screen and a drawing placed on the top layer overlap, the drawing placed 
on the top layer is always displayed in front.
Example: A Numerical Display is placed on the base screen and an equilateral hexagon is placed on the top layer.

Display for Base Screen: 1

The display order of the equilateral hexagon
and Numerical Display is unchanged

1234

9999

Changes the value

1234
Equilateral

Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Equilateral hexagon

2 Numerical Display

567

Display for Base Screen: 1

The display order of the equilateral hexagon
and Numerical Display is unchanged

1234

9999

Changes the value

1234

Top Layer

Equilateral Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Numerical Display

2 Equilateral hexagon Top Layer
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● Drawing and Parts are hidden

•When a drawing and another drawing or part placed on a base screen or popup screen overlap, if the drawing or 
part in front becomes hidden, the portion of the background drawing that was overlapped remains missing.
Example: A rectangle is placed on the base screen and a Picture Display is placed in front of it.

•When a drawing placed on a base screen or popup screen and a drawing or part placed on the top layer overlap, if 
the drawing or part placed on the top layer becomes hidden, only the drawing that was placed on the base screen or 
popup screen is displayed.
Example: A rectangle is placed on the base screen and a Picture Display is placed on the top layer.

•When a drawing and another drawing or part placed on the top layer overlap, if the drawing or part in front becomes 
hidden, only the background drawing is displayed.
Example: A rectangle is placed on the top layer and a Picture Display is placed in front of it.

In the following situations, the drawing and the part image type are hidden.
•When the drawing or part is flashing
•When the hidden condition is satisfied in a part configured with display conditions
•When a lamp is off that has its Not Display Image check box selected on the View tab
•When an unregistered state or number is selected for the image type in a Multi-State Lamp or Picture Display
•When moving a Picture Display

Display for Base Screen: 1

Picture Display
is hidden

Overlapping part for the rectangle and Picture Display is the
background for the screen and the rectangle remains missing.

Rectangle

Picture Display

Base Screen: 1

Object list

No. Type Layer

1 Rectangle

2 Picture Display

Display for Base Screen: 1

Picture Display
is hidden

Rectangle remains

Top Layer

Rectangle

Picture Display

Base Screen: 1

Object list

No. Type Layer

1 Rectangle

2 Picture Display Top Layer

Display for Base Screen: 1

Picture Display
is hidden

Rectangle remains

Top Layer
Rectangle

Picture Display

Base Screen: 1

Object list

No. Type Layer

1 Rectangle Top Layer

2 Picture Display Top Layer
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● Display order of overlapping parts that have None selected for Image Type
•When a drawing and a part that has None selected for Image Type placed on a base screen or popup screen 
overlap, if the value for the part changes or if the picture for the part changes, the portion of the background 
drawing that was overlapped remains missing.
Example: An equilateral hexagon is placed on the base screen and a Numerical Display is placed in front of it.

•When a drawing placed on a base screen or popup screen and a part that has None selected for Image Type 
placed on the top layer overlap, if the value for the part changes or if the picture for the part changes, no part of the 
drawing on the base screen will be missing.
Example: An equilateral hexagon is placed on the base screen and a Numerical Display is placed on the top layer.

•When a drawing and a part that has None selected for Image Type placed on the top layer overlap, if the value for 
the top layer part changes or if the picture for the part changes, no part of the background drawing will be missing.
Example: An equilateral hexagon is placed on the top layer and a Numerical Display is placed in front of it.

Display for Base Screen: 1

Overlapping part for the equilateral hexagon and Numerical Display is the
background for the screen and the equilateral hexagon remains missing.

1234

9999

Changes the value

1234
Equilateral

Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Equilateral hexagon

2 Numerical Display

Display for Base Screen: 1

1234

9999

Changes the value

1234

The equilateral hexagon remains 

Top Layer

Equilateral
Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Equilateral hexagon

2 Numerical Display Top Layer

Display for Base Screen: 1

The equilateral hexagon remains 

1234

9999

Changes the value

1234Top Layer
Equilateral

Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Equilateral hexagon Top Layer

2 Numerical Display Top Layer
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4.3 Restrictions

•To place overlapping drawings and parts on a screen, we recommend they be placed on the top layer. When the 
amount of data for parts placed on the top layer exceeds the upper limit, the display is the same as when they are 
placed on a base screen or popup screen. At this time, the value of HMI Special Internal Relay LSM33 is 1. For 
details, refer to Chapter 28 “HMI Special Relay (LSM)” on page 28-2.

•When the Message Display, Message Switching Display, and Alarm List Display have their Scroll check box selected 
on the Format tab in the Properties dialog box and they are placed on the top layer, the scrolling speed of the text 
will be slower.

•On the Top Layer, magenta (R:255, G:4, B:255) is treated as the transparent color. If you place pictures used this 
color on a Top Layer, those areas are completely transparent.
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This chapter describes the procedures for drawing with shapes and the procedures for configuring pictures and text.

  

1.1 Line

● Line Drawing Procedure
This section describes the procedure for drawing lines.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Line) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the line on the edit screen.

3 Drag the mouse to the stop point location.

A line is drawn that connects the start point and stop point.

Chapter 7 Drawings

1 Shapes

Stop 
point

Start 
point

Drag

To change the style of the drawn line, perform one of the following operations.
• Double click the line to open the Properties dialog box
• Select the line and select the style with Shape Style on the Format tab
• Select the line and right click to display the popup menu
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● Properties of Line Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the line from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the line from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Line Color
Selects the line color for the line (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Flash
Select this check box to make the line flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Point1, Point2

■ Place on the Top Layer
Select this check box to display the line on the top layer. The line will have precedence when other drawings and parts 
are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

X, Y: Specifies the start point and stop point of the line in coordinates.
The upper-left corner of the screen is the origin.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y

Screen

Line

Stop 
point

Start 
point
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1.2 Polyline

● Polyline Drawing Procedure
This section describes the procedure for drawing polylines.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Polyline) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click at the location (start point) to start drawing the polyline on the edit screen.

3 Click the end point locations in order.

A line is drawn that connects the start point and the various end point locations in the order that they were created.

4 Double click at the stop point location.

A line is drawn that connects the last end point and the stop point.

Stop 
point

Start 
point

End 
point

End 
point

The maximum number of end points in a polyline, including the start point and the stop point, is 300 points.

• To change the style of the drawn polyline, perform one of the following operations.
- Double click the polyline to open the Properties dialog box
- Select the polyline and select the style with Shape Style on the Format tab
- Select the polyline and right click to display the popup menu

• To change the start point, end points, or the stop point of the drawn polyline, select the polyline and right 

click on it, then click Reshape.  is displayed on the polyline. Drag  to the desired location. Double 

click the edit screen or press the  key to finish changing the shape.



1 Shapes

7-4 WindO/I-NV4 User’s Manual

● Properties of Polyline Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the polyline from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the polyline from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Line Color
Selects the line color for the polyline (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Flash
Select this check box to make the polyline flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates

■ Size

■ Place on the Top Layer
Select this check box to display the polyline on the top layer. The polyline will have precedence when other drawings 
and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

X, Y: Specifies the display position of the polyline in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the polyline is the X and Y coordinates.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y

Screen

Polyline

W, H: Specifies the size of the polyline in width and height.
W: 1 to (base screen horizontal size)
H: 1 to (base screen vertical size)

Width

Height

Screen

Polyline
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1.3 Polygon

● Polygon Drawing Procedure
This section describes the procedure for drawing polygons.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Polygon) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click at the location (start point) to start drawing the polygon on the edit screen.

3 Click the end point locations in order.

A line is drawn that connects the start point and the various end point locations in the order that they were created.

4 Double click at the stop point location.

A polygon is drawn with the start point and stop point connected.

End 
point

Start 
point

Stop 
point

End 
point

The maximum number of end points in the polygon, including the start point and the stop point, is 300 
points.

• To change the style of the drawn polygon, perform one of the following operations.
- Double click the polygon to open the Properties dialog box
- Select the polygon and select the style with Shape Style on the Format tab
- Select the polygon and right click to display the popup menu

• To change the start point, end points, or the stop point of the drawn polygon, select the polygon and right 

click on it, then click Reshape.  is displayed on the polygon. Drag  to the desired location. Double 

click the edit screen or press the  key to finish changing the shape.
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● Properties of Polygon Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the polygon from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the polygon from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the polygon (color: 256 colors, monochrome: 16 
shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the polygon.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the polygon flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

X, Y: Specifies the display position of the polygon in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that circumscribes 
the polygon is the X and Y coordinates.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Polygon
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■ Size

■ Place on the Top Layer
Select this check box to display the polygon on the top layer. The polygon will have precedence when other drawings 
and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

W, H: Specifies the size of the polygon in width and height.
W: 1 to (base screen horizontal size)
H: 1 to (base screen vertical size)

Width

Height

Screen

Polygon
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1.4 Rectangle

● Rectangle Drawing Procedure
This section describes the procedure for drawing rectangles.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Rectangle) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the rectangle on the edit screen.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the rectangle.

A rectangle is drawn with the start point and stop point set to opposite angles.

Stop 
point

Drag

Start 
point

To change the style of the drawn rectangle, perform one of the following operations.
• Double click the rectangle to open the Properties dialog box
• Select the rectangle and select the style with Shape Style on the Format tab
• Select the rectangle and right click to display the popup menu
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● Properties of Rectangle Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the rectangle from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the rectangle from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the rectangle (color: 256 colors, monochrome: 16 
shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the rectangle.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the rectangle flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Round Type
Selects the style of the rectangle's corners from the following.
None, Curve, Straight

Curve StraightNone
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■ Round Radius
Specifies the rounding radius (1 to 200). However, the range that can be configured is where round radius x 2 is a 
value smaller than Size W and Size H.
This option can only be configured when Curve or Straight is selected for Round Type.

■ Shadow
Selects the style of shadow attached to the rectangle from the following. This option draws the rectangle in a three-
dimensional manner.
None, Convex, Concave
This option can only be configured when 1 dot is selected for Line Width and Solid is selected for Line Type.

■ Coordinates 

■ Size

■ Place on the Top Layer
Select this check box to display the rectangle on the top layer. The rectangle will have precedence when other 
drawings and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 
6-5.

For Curve For Straight

Round Radius Round Radius

Convex ConcaveNone

X, Y: Specifies the display position of the rectangle in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle is the X 
and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Rectangle

W, H: Specifies the size of the rectangle in width and height.

W: 1 to (base screen horizontal size)

H: 1 to (base screen vertical size)

Width

Height

Screen

Rectangle
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1.5 Circle/Ellipse

● Circle/Ellipse Drawing Procedure
This section describes the procedure for drawing circles and ellipses.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Circle/Ellipse) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the circle or ellipse on the edit screen.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the rectangle.

A circle or ellipse is drawn that inscribes the rectangle made from the opposite angles of the start point and the stop 
point.

Stop 
point

Drag

Start 
point

To change the style of the drawn circle or ellipse, perform one of the following operations.
• Double click the circle or ellipse to open the Properties dialog box
• Select the circle or ellipse and select the style with Shape Style on the Format tab
• Select the circle or ellipse and right click to display the popup menu



1 Shapes

7-12 WindO/I-NV4 User’s Manual

● Properties of Circle/Ellipse Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the circle or ellipse from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the circle or ellipse from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the circle or ellipse (color: 256 colors, monochrome: 
16 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the circle or ellipse.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the circle or ellipse flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Shadow
Selects the style of shadow attached to the circle or ellipse from the following. This option draws the circle or ellipse 
in a three-dimensional manner.
None, Convex, Concave
This option can only be configured when 1 dot is selected for Line Width and Solid is selected for Line Type.

Convex ConcaveConvex
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■ Coordinates 

■ Size

■ Place on the Top Layer
Select this check box to display the circle or ellipse on the top layer. The circle or ellipse will have precedence when 
other drawings and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” 
on page 6-5.

X, Y: Specifies the display position of the circle or ellipse in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the circle or ellipse is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Circle/ellipse

W, H: Specifies the size of the circle or ellipse in width and height.

W: 1 to (base screen horizontal size)

H: 1 to (base screen vertical size)

Width

Height

Screen

Circle/ellipse
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1.6 Arc

● Arc Drawing Procedure
This section describes the procedure for drawing arcs.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Arc) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the arc on the edit screen.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the rectangle.

An arc is drawn that inscribes the rectangle made from the opposite angles of the start point and the stop point.

Stop 
point

Drag

Start 
point

• To change the style of the drawn arc, perform one of the following operations.
- Double click the arc to open the Properties dialog box
- Select the arc and select the style with Shape Style on the Format tab
- Select the arc and right click to display the popup menu

• To change the start point or the stop point of the drawn arc, select the arc and right click on it, then click 

Reshape.  is displayed on the arc. Drag  to the desired location. Double click the edit screen or press 

the  key to finish changing the shape.



WindO/I-NV4 User’s Manual 7-15

1 Shapes

7

D
raw

ings

● Properties of Arc Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the arc from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the arc from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Line Color
Selects the line color for the arc (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Flash
Select this check box to make the arc flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

■ Size

■ Place on the Top Layer
Select this check box to display the arc on the top layer. The arc will have precedence when other drawings and parts 
are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

X, Y: Specifies the display position of the arc in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the arc is the X and Y coordinates.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen
Arc

W, H: Specifies the size of the arc in width and height.
W: 1 to (base screen horizontal size)
H: 1 to (base screen vertical size)

Width

Height

Screen
Arc
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1.7 Pie

● Pie Drawing Procedure
This section describes the procedure for drawing pies.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Pie) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the pie on the edit screen.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the rectangle.

A pie is drawn that inscribes the rectangle made from the opposite angles of the start point and the stop point.

Stop 
point

Drag

Start 
point

• To change the style of the drawn pie, perform one of the following operations.
- Double click the pie to open the Properties dialog box
- Select the pie and select the style with Shape Style on the Format tab
- Select the pie and right click to display the popup menu

• To change the central angle of the drawn pie, select the pie and right click on it, then click Reshape.  

is displayed on the pie. Drag  to the desired location. Double click the edit screen or press the  
key to finish changing the shape.
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● Properties of Pie Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the pie from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the pie from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the pie (color: 256 colors, monochrome: 16 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the pie.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the pie flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

X, Y: Specifies the display position of the pie in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the circle with the same center as the pie is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen
Pie
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■ Size

■ Place on the Top Layer
Select this check box to display the pie on the top layer. The pie will have precedence when other drawings and parts 
are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

W, H: Specifies the size of the pie in width and height.

W: 1 to (base screen horizontal size)

H: 1 to (base screen vertical size)

Width

Height

Screen
Pie
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1.8 Equilateral Polygons

● Equilateral Polygons Drawing Procedure
This section describes the procedure to draw equilateral polygons (equilateral triangle, equilateral diamond, 
equilateral pentagon, equilateral hexagon, equilateral octagon).

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Equilateral Triangle),  (Equilateral 
Diamond),  (Equilateral Pentagon),  (Equilateral Hexagon), or  (Equilateral Octagon) under Equilateral 
Polygons.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) on the edit screen to start drawing the square that will 
circumscribe the equilateral polygon.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the square.

An equilateral polygon is drawn that inscribes the square made from the opposite angles of the start point and the 
stop point.

Stop 
point

Drag

Start 
point

To change the style of the drawn square, perform one of the following operations.
• Double click the square to open the Properties dialog box
• Select the square and select the style with Shape Style on the Format tab
• Select the square and right click to display the popup menu
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● Properties of Equilateral Polygon Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the equilateral polygon from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the equilateral polygon from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the equilateral polygon (color: 256 colors, 
monochrome: 16 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the equilateral polygon.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the equilateral polygon flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

X, Y: Specifies the display position of the equilateral polygon in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the square that 
circumscribes the equilateral polygon is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Equilateral polygon
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■ Size

■ Place on the Top Layer
Select this check box to display the equilateral polygon on the top layer. The equilateral polygon will have precedence 
when other drawings and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts 
Overlapping” on page 6-5.

W, H: Specifies the size of the equilateral polygon in width and height.

W: 1 to (base screen horizontal size)

H: 1 to (base screen vertical size)

Width

Height

Screen

Equilateral polygon
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1.9 Fill

● Fill Configuration Procedure
This section describes the fill configuration procedure.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Fill) under Fill.

The mouse cursor changes to  (pencil).

2 Click on a section where multiple shapes overlap on the edit screen.

The section where multiple shapes overlap is filled with the Foreground Color, Background Color, and Pattern of 
the shape last drawn or the shape that last had its style changed. The clicked location is the fill start point.

Fill start point

• To change the fill style, perform one of the following operations.
- Double click the fill start point to open the Properties dialog box
- Select the fill start point and select the style with Shape Style on the Format tab
- Select the fill start point and right click to display the popup menu

• If you move the fill start point, the closed region where it was moved to is filled.

• To select the fill start point, click  on the edit screen or select Fill on the Object List window.
Fill start point Fill start point
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● Properties of Fill Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Foreground Color, Background Color
Selects the foreground color and the background color to fill with (color: 256 colors, monochrome: 16 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern to fill with.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Fill Start Point

X, Y: Specifies the display position of the fill start point in coordinates.
The upper-left corner of the screen is the origin.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y

Screen

Fill start point

The fill range is not affected by drawing objects placed on the top layer.
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2.1 Picture Configuration Procedure

This section describes the picture configuration procedure.

1 On the Home tab, in the Drawings group, click Picture.

The mouse cursor changes to  (picture).

2 Click the location on the edit screen to place the picture.

Picture Manager is displayed.

3 Select a picture and click Select.

The selected picture is placed on the screen.

2 Picture

To change the picture that was placed on the screen, perform one of the following operations.
• Double click the picture to open the Properties dialog box, then click Browse
• Replace the picture in Picture Manager
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2.2 Properties of Picture Dialog Box

This section describes items and buttons in the Properties dialog box.

■ Browse
Changes the picture placed on the screen. Click this button to display Picture Manager.

■ Flash
Select this check box to make the picture flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

■ Size

■ Place on the Top Layer
Select this check box to display the picture on the top layer. The picture will have precedence when other drawings 
and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

X, Y: Specifies the display position of the picture in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the picture is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Picture

W, H: Specifies the size of the picture in width and height.

W: 1 to (base screen horizontal size)

H: 1 to (base screen vertical size)

Width

Height

Screen

Picture
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3.1 Text Configuration Procedure

This section describes the configuration procedure for text.

1 On the Home tab, in the Drawings group, click Text.

The mouse cursor changes to  (text).

2 Click the location on the edit screen to place the text.

The Properties of Text dialog box is displayed.

3 Enter the text to display in Text and configure the options as necessary.

The maximum number is 3737 characters.

4 Click OK.

The text is placed on the screen.

3 Text

To change the style of the text placed on the screen, perform one of the following operations. You can 
change the entered text in the Properties dialog box.
• Double click the text to open the Properties dialog box
• Select the text and select the style with Text Style on the Format tab
• Select the text and right click to display the popup menu
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3.2 Properties of Text dialog box

This section describes items and buttons in the Properties dialog box.

■ Font
Selects the font to use to display text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
This option can only be configured if the Use Text Manager check box is cleared.

■ Style
Selects the style of text from the following.
Regular, Bold, Shadow
This option can only be configured when Japanese, European, Chinese, Taiwanese, Korean, Central 
European, Baltic, or Cyrillic is selected for Font.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
Top when the Vertical Writing check box is selected.
For details, refer to Appendix “5 Text Alignment” on page A-7.
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■ Vertical Writing
Select this check box to display text vertically.
This option can only be configured when Japanese, European, Chinese, Taiwanese, Korean, Central 
European, Baltic, Cyrillic or Windows is selected for Font.

■ Windows Font
Configures the font to use as the Windows Font.
Select Windows for Font to display the current settings. You can specify the character spacing (0 to 100) and the 
line spacing (0 to 100). To change the settings other than the character spacing and line spacing, click Change to 
display the Font Settings dialog box.
This option can only be configured if the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.

■ Use Text Manager
Select this check box to use text registered in Text Manager.

■ Text ID
Specifies the Text Manager ID number (1 to 32000) when using text registered in Text Manager.

Click  to display Text Manager.
This option can only be configured when the Use Text Manager check box is selected.

■ Text
Enter the text to display. The maximum number is 3737 characters.
The characters that can be entered vary based on the font selected by Font. For details, refer to Chapter 2 “1.2 
Available Text” on page 2-5.
This option can only be configured if the Use Text Manager check box is cleared.

■ Text Color
Selects the color for the displayed text (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Magnification

This option can only be configured when Japanese, European, Chinese, Taiwanese, Korean, Central 
European, Baltic, or Cyrillic is selected for Font.

■ Size
Specifies the character size (8 to 128).
This option can only be configured when Stroke is selected for Font.

■ Background Color
Selects the background color for the text (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

When the Vertical Writing check box is selected, take care about the following points. This is applicable 
for installations of Windows that support East Asian characters.
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left-

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

Aligned to 
le� edge

Horizontal
display

Next
characters

A newline is counted as two characters.

W, H: Selects the zoom factor for characters (0.5, 1 to 8).
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■ Animation
Selects whether or not to make the text flash.

■ Shadow Color
Selects the shadow color for the text (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Shadow is selected for Style.

■ Coordinates 

■ Use Text Area
Select this check box to specify a text area and adjust the display position of the text with the specified text area.

■ Place on the Top Layer
Select this check box to display the text on the top layer. The text will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Normal: The text does not flash.

Flash: The text flashes.

X, Y: Specifies the display position of the text or the text area in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the text or the upper-left corner of the text area is the X and Y coordinates.
When the Use Text Area check box is cleared, the coordinates are for the text. When the Use Text 
Area check box is selected, the coordinates are for the text area.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

IDEC IDEC

(0, 0)
X

Y

(0, 0)
X

Y

Screen

Text

Screen

Text area

When Use Text Area is cleared When Use Text Area is selected

W, H: Specifies the size of the text area in width and height.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

IDEC

Width

Height

Screen

Text area
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This chapter describes the setup for the button parts and related MICRO/I operations.

  

1.1 How the Bit Button is Used

Writes a 0 or 1 to a bit device.

■ Set

■ Reset

Chapter 8 Buttons

1 Bit Button

MICRO/I

0

1

External device

Pressing the button writes a 1 to the 
bit device. Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 1

WriteAction Write

Pressing the button writes a 0 to the 
bit device. Release

Initial image

Press ReleasePress

0

Operation and 
view

Data written 0

WriteAction Write
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■ Momentary

■ Alternate

■ Toggle

■ Move

Pressing the button writes a 1 to the 
bit device.
Releasing the button writes a 0 to the 
bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 10 0

WriteAction WriteWrite Write

Pressing and holding the button until the screen changes causes a 0 to be written to the bit device.

Each press of the button alternately 
writes a 1 or 0 to the bit device. Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 0

WriteAction Write

Pressing the button inverts the value 
of the bit device.
If the value of the bit device is 0 it 
changes to 1, and vice versa.

Release

Initial image

Press ReleasePress

Operation and 
view

ToggleAction Toggle

Pressing the button writes the value 
in the source bit device to the value in 
the destination bit device.

Release

Initial image

Press ReleasePress

Move

Operation and 
view

Action Move
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1.2 Bit Button Configuration Procedure

This section describes the configuration procedure for Bit Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Bit Button.

2 Click a point on the edit screen where you wish to place the Bit Button.

3 Double-click the dropped Bit Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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1.3 Properties of Bit Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Action Mode
Select the behavior of the button from the following:

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Set: Pressing the button writes a 1 to the bit device.

Reset: Pressing the button writes a 0 to the bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 1

WriteAction Write

Release

Initial image

Press ReleasePress

0

Operation and 
view

Data written 0

WriteAction Write
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■ Destination Device Address
Specify the destination bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

Momentary: Pressing the button writes a 1 to the bit device.
Releasing the button writes a 0 to the bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 10 0

WriteAction WriteWrite Write

Pressing and holding the button until the screen changes causes a 0 to be written to the bit device.

Alternate: Each press of the button alternately writes a 1 or 0 to the bit device.

Toggle: Pressing the button inverts the value of the bit device.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: Pressing the button writes the value in the source bit device to the value in the destination bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 0

WriteAction Write

Release

Initial image

Press ReleasePress

Operation and 
view

ToggleAction Toggle

Release

Initial image

Press ReleasePress

Move

Operation and 
view

Action Move
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■ Write*1

Specify the number of bit devices (1 to 64) at the destination.
This setting is enabled only if Action Mode is set to Set or Reset.

Example: This fills a contiguous block of bit devices with the same value.

If the bit number in a word device is specified, the same value is written to same bit number of contiguous 
word devices.

■ Source Data
Specifies the device address that stores the data to be written.
This setting is enabled only if Action Mode is set to Move.

Example: This button writes the values in a contiguous block of bit devices to a contiguous block of device addresses 
at the destination.

*1 Advanced mode only

1M0

1M1

1M2

1M3

1M4

Action Mode: Set

Write: 5
Destination Device Address: M0

bit bit
15 0

1D0

D1

D2

D3

D4

1

1

1

1

Action Mode: Set

Write: 5
Destination Device Address: D0-15

Device Address: Specify the source bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Transfer: Specify the number of bit devices (1 to 64) to transfer.

Device Address: LM0

Transfer: 4

1LM0

0LM1

0LM2

1LM3

Destination Device Address: M0

1M0

0M1

0M2

1M3
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switch according to the value of M0 even if the 
button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition:

Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

• When Alternate is selected for Action Mode on the General tab, the button remains on when hidden 
in the on state.

• When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not 
operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Word Button is Used

Writes a value to a word device. Can be used to indirectly specify the destination address or to perform operations on 
the written value.

• Pressing the button writes a fixed value to a word device.

• Pressing the button writes the value of device address to a word device.

• Pressing the button performs arithmetic on the value to write before writing it to a word device.

2 Word Button

MICRO/I External device

D1= 0

100

D1= 100

Write

Destination word device

100

Value

100→D1

MICRO/I External device
D0= 123

D1= 0

D0= 123

D1= 123

Move

Value in device address

Destination word device

D0→D1

MICRO/I External device
D0= 100

D1= 23

D2= 0

D0= 100

D1= 23

D2= 123

Add

Write

Value to write

Operator value

Destination word device

D0+D1→D2
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■ Set

■ Move

■ Momentary

■ Alternate

Pressing the button writes a fixed 
value to a word device. Release

Initial image

Press ReleasePress

Write

Value

Operation and 
view

Action

Data written

Write

Value

Pressing the button writes the value of 
source device address to the 
destination word device.

ReleasePress ReleasePress

Initial image

Write

Value in
device address

Operation and 
view

Action

Data written

Write

Value in
device address

Pressing the button writes the fixed 
value of ON Data to a word device.
Releasing the button writes the fixed 
value of OFF Data to a word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

ON data

Write

OFF data

Write

OFF data

Pressing and holding the button until the screen changes causes the OFF data to be written to the word 
device.

Each press of the button alternately 
writes the fixed value of ON data and 
OFF data to the word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

OFF data
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■ Add, Sub, Multi, Div, Mod, OR, AND, XOR
Pressing the button performs 
arithmetic on the value of source 
device address and a fixed value, or a 
value of device address and writes the 
result to a word device.

Example: Add (Addition)
Pressing the button adds the 
value in the Source 1 to the 
Source 2 value and writes 
the sum in the word device.

Release

Initial image

Press ReleasePress

Arithmetic 
operation

↓

Write

Operation and
 view

Action

Data written Result

Arithmetic 
operation

↓

Write

Result

Release

Initial image

Press ReleasePress

Addition

↓

Write

Operation and 
view

Action

Value in reference 
device address

100 200 300 400 500

Data

Value in destination 
device address

240 420

50 40 30 20 10

Addition

↓

Write

0 240 420
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2.2 Word Button Configuration Procedure

This section describes the configuration procedure for Word Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Word Button.

2 Click a point on the edit screen where you wish to place the Word Button.

3 Double-click the dropped Word Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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2.3 Properties of Word Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Action Mode
Select the behavior of the button from the following:

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Set: Pressing the button writes a constant value to a word device.

Move: Pressing the button writes the value in the source device address to the destination word device.

Release

Initial image

Press ReleasePress

Write

Value

Operation and 
view

Action

Data written

Write

Value

ReleasePress ReleasePress

Initial image

Write

Value in
device address

Operation and 
view

Action

Data written

Write

Value in
device address
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Momentary: Pressing the button writes the constant value of ON data to a word device.
Releasing the button writes the constant value of OFF data to a word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

ON data

Write

OFF data

Write

OFF data

Pressing and holding the button until the screen changes causes the OFF data to be written to the word 
device.

Alternate: Each press of the button alternately writes the fixed value of ON data and OFF data to the word device.

Add, Sub, Multi, Div, Mod, OR, AND, XOR:

Pressing the button performs arithmetic on a value of source device address and a constant value or 
the value of device address and writes the result to a word device.

Example: Add (Addition)
Pressing the button adds the value in the Source 1 to the Source 2 value and writes the 
sum in the word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

OFF data

Release

Initial image

Press ReleasePress

Arithmetic 
operation

↓

Write

Operation and
 view

Action

Data written Result

Arithmetic 
operation

↓

Write

Result

Release

Initial image

Press ReleasePress

Addition

↓

Write

Operation and 
view

Action

Value in reference 
device address

100 200 300 400 500

Data

Value in destination 
device address

240 420

50 40 30 20 10

Addition

↓

Write

0 240 420
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■ Data Type
Select the data type to be handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

■ Source Data
Select the data to be handled by the operation selected for Action Mode.

*1 Advanced mode only

UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to Move. Because the number of 
device addresses to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4(B), BCD8(EB), or Float32(F) is selected and the arithmetic data contains a value inexpressible 
in BCD, a 1 is written to the System Area 2 Processing error bit (address number+2, bit 5) and an error 
message is displayed. For details, refer to Chapter 4 “Processing error” on page 4-19 and “Processing 
error” in Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1.

Value: Use a constant.
Only a Value can be handled if Action Mode is set to Set, Momentary, or Alternate.
If Action Mode is set to Momentary or Alternate, the value in the ON Data is written when the 
button is ON, and the value in the OFF Data is written when the button is OFF.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values in 
hexadecimal.

Device Address: Use a word device.
Specify the device address. 
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Use Reference Device Address*1:Select this check box and specify a device address to change the 
source word device according to the value of the specified device 
address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.

Transfer*1 Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.
Example: If Transfer is set to 2 and Write is set to 3, the same data in 

2 continuous word device addresses will be written to the 
destination device address 3 times.

:

Device Address: LDR0

Write: 3

999LDR0

Destination Device: D100

D100

D101

D102

D103

Transfer: 2 1000LDR1

D104

D105

999

1000

999

1000

999

1000
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■ Destination Device Address

*1 Advanced mode only

Destination Device Address: Specify the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device according to the value of the specified device address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 
2-4.

Write*1 Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Momentary, 
Alternate, or Move.
Example: If Data Type is set to UBIN16(W) and Write is set to 5, the same 

data will be written to 5 continuous word addresses.

Example: If Data Type is set to UBIN32(D) and Write is set to 5, the same data 
will be written to a total of 10 word addresses (2 words 5 times).

:

Destination Device Address: LDR10
Write: 5

Data Type: UBIN16(W)
Source Data: 12345

12345LDR10

12345LDR11

12345LDR12

12345LDR13

12345LDR14

5 words

Destination Device Address: LDR10
Write: 5

Data Type: UBIN32(D)
Source Data: 987654

LDR10

987654

LDR11

LDR12

987654

LDR13

LDR14

987654

LDR15

LDR16

987654

LDR17

LDR18

987654

LDR19

10 words
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switched according to the value of M0 even if 
the button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Setting dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

• When Alternate is selected for Action Mode on the General tab, the button remains on when hidden 
in the on state.

• When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not 
operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
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Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state



2 Word Button

8-34 WindO/I-NV4 User’s Manual

● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B
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Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2
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Open Password Screen, 
enter password, 
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For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated
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CLR
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4 5 6 7 8 9

Password

Button
Cannot operate

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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3.1 How the Goto Screen Button is Used

Switches to another screen or displays a window.

• Pressing the button switches between Base Screens.

• Pressing the button opens and closes other windows (such as the Popup Screen, Device Monitor, Password Screen, 
Adjust Brightness Screen, and File Screen).

• Pressing the button switches to the System Mode.

• Pressing the button resets the current screen.

3 Goto Screen Button

MICRO/I MICRO/I

MICRO/I MICRO/I MICRO/I MICRO/I

D51 123

D52 456

D53 0

999

D51 123

D52 456

D53 0

999

MICRO/I MICRO/I

Offline Mein Menu

MICRO/I MICRO/I

130 0
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3.2 Goto Screen Button Configuration Procedure

This section describes the configuration procedure for Goto Screen Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

2 Click a point on the edit screen where you wish to place the Goto Screen Button.

3 Double-click the dropped Goto Screen Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.



WindO/I-NV4 User’s Manual 8-39

3 Goto Screen Button

8

Buttons

3.3 Properties of Goto Screen Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.
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■ Action Mode
Select the behavior of the button from the following:

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen. For details, refer to Chapter 5 “3 Base Screen” on 
page 5-14.

Open Popup Screen: Opens a Popup Screen. For details, refer to Chapter 5 “4 Popup Screen” on page 
5-20.

Close Popup Screen: Closes a Popup Screen. For details, refer to Chapter 5 “4 Popup Screen” on page 
5-20.

Open Device Monitor Screen: Opens the Device Monitor Screen. For details, refer to Chapter 23 “2.2 Device 
Monitor” on page 23-19.

Close Device Monitor Screen: Closes the Device Monitor Screen. For details, refer to Chapter 23 “2.2 Device 
Monitor” on page 23-19.

Open Password Screen: Opens the Password Screen. For details, refer to Chapter 21 “4.1 Entering the 
Password on the MICRO/I” on page 21-39.

Close Password Screen: Closes the Password Screen. For details, refer to Chapter 21 “4.1 Entering the 
Password on the MICRO/I” on page 21-39.

Open Adjust Brightness Screen: Opens the Adjust Brightness Screen. For details, refer to Chapter 29 “1.3 
Adjusting Screen Brightness” on page 29-2.

Close Adjust Brightness Screen: Closes the Adjust Brightness Screen. For details, refer to Chapter 29 “1.3 
Adjusting Screen Brightness” on page 29-2.

Switch to System Mode: Switches to the Top Page in the System Mode. For details, refer to Chapter 29 “2 
System Mode Overview” on page 29-3.

Reset current screen: Resets the current Base Screen.

When the current Base Screen is reset using the Reset current screen function, the window and internal 
devices restart as if the Base Screens were switched.
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■ Goto Screen

■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Screen Number: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup 
Screen, or Close Popup Screen.

Use Reference Device Address*1: Select this check box and specify a device address to specify 
the screen number using the value of the specified device 
address.
Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Open 
Popup Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as the 
origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, or Open Adjust Brightness Screen.

Use Reference Device Address*1: Select this check box and specify a device address to specify 
the coordinates using the value of the specified device 
address.
Click  to display the Tag Editor. For the
device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Open 
Popup Screen.

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device used to switch the drawing object display.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, if 
the value of M0 changes, the display image will switched according to the value of M0 even if the 
button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:



3 Goto Screen Button

8-42 WindO/I-NV4 User’s Manual

● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Setting dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.
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Button state

Satisfied

Not satisfied
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When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3
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For User2, 
Group A parts are displayed but 
Group B parts cannot be operated
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To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Print Button is Used

Outputs a screenshot to an external memory device.

• Pressing the Print Button outputs a screenshot of the current screen to an external memory device.

4 Print Button

USB flash drive

MICRO/I

Image file

External Memory Device
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4.2 Print Button Configuration Procedure

This section describes the configuration procedure for Print Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Print Button.

2 Click a point on the edit screen where you wish to place the Print Button.

3 Double-click the dropped Print Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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4.3 Properties of Print Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Output to
Select where to direct the screenshot to.

■ Action Mode
Select the behavior of the button from the following:

To specify the Registration Text to use when the button is ON, place a check in the Set by State check box 
on the Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

External Memory Device: Outputs the screenshot as a file to the external memory device inserted in the MICRO/I.
Files are output as follows:

File format File name File size

JPEG
CAP***.JPG (***: date and time when file was output)
Example: A file created at 18:50:25 on June 30, 2011 

will be named “CAP110630_185025.JPG”.

Depends on 
image being 
displayed.

For details about external memory devices, refer to Chapter 27 “External Memory Devices” on page 27-1.

Print Screen: Outputs a screenshot of the current screen to the external memory device.
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switched according to the value of M0 even if 
the button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:

The maximum number of screenshots that can be captured (1 to 999) can be set in HMI Special Data Registers 
LSD65. (Default: 99)

The methods to erase screenshot files saved on the external memory device are as follows.
• To erase files during operation using parts, on the External Memory Device tab on the Project Settings 

dialog box, select the Remove Files check box and the All Screenshot data check box, and then configure 
the trigger device address. Assign that trigger device address to a part.

• To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in External 
Memory Device to open the Clear Data dialog box. Select the Screenshot Data check box and click OK.
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing 
(0 to 100) and the line spacing (0 to 100). To change the settings other than the character spacing 
and line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state



WindO/I-NV4 User’s Manual 8-61

4 Print Button

8

Buttons

■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.



5 Key Button

8-66 WindO/I-NV4 User’s Manual

  

5.1 How the Key Button is Used

Performs a variety of functions including uploading and downloading, copying files, and operating other parts.

• Entering numbers in the Numerical Input

• Entering characters in the Character Input

• Operating the Alarm List Display or Alarm Log Display

5 Key Button

1230

MICRO/I

MICRO/I

Show focus Move focus

Key Bu�on

Display reference screen

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Reference screen
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5.2 Key Button Configuration Procedure

This section describes the configuration procedure for Key Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Key Button.

2 Click a point on the edit screen where you wish to place the Key Button.

3 Double-click the dropped Key Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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5.3 Properties of Key Button Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Key Type
Select the function for the Key Button.

The settings explained below appear depending on the type of key selected.

■ Popup Screen Number
The Alt key switches the current Popup Screen used as a Keypad when this button is pressed.
Specify the Popup Screen number to open a Keypad for.
This setting is enabled only if Alt was selected using the Key Browser.

Displays settings 
applicable to the 
selected key.

(Key)

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Language: Switches the display of the key that is displayed when Keypad is selected in Key Browser. These 
languages are available:
Japanese, European, Central European, Baltic, Cyrillic.

Browse: Opens the Key Browser when clicked. Select a key.
For details, refer to “5.5 Key Browser” on page 8-86.

(Key): Displays the name of the key selected using the Key Browser.

• When you select a key, the label for that key is assigned as the Registration Text.
• The function of Key Button will affect on the next scan when the trigger condition is satisfied.
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■ Scroll Size
Key Buttons Page Up and Page Down scroll the list up and down, respectively. Key Buttons Up and Down move 
the focus up and down, respectively. This settings specifies the number of pages or lines (1 to 1023 lines) to scroll or 
move the focus per each press of the button.
This setting is enabled only if Page Up, Page Down, Up, and Down are selected using the Key Browser.

■ Transfer Setting
Key Buttons Download Project, Upload Project, Download PLC Program, and Upload PLC Program, perform 
the data transfer function specified by their names. These settings specify the source, data to be transfered, and 
destination.
This setting is enabled only if one of these keys is selected after clicking Data Transfer in the Key Browser.

If Download Project is selected.

If Upload Project is selected.

Source: Select the external memory device which contains a project file (.ZNV) to transfer. The external 
memory device is USB flash drive.

Location: Specify the location of the project file (.ZNV) to transfer. The maximum number is 247 
characters.
Example: Where “Sample_Project.ZNV” is a project file saved on the root directory of a 

USB flash drive: 
Sample_Project.ZNV

Destination: Specify where to save the project uploaded from MICRO/I. The location is the USB flash drive.

Location: Specify the location where the uploaded project file will be saved. The maximum number 
is 247 characters.
Example: To save it to the folder “Uploaded_Project” on a USB flash drive: 

Uploaded_Project
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If Download PLC Program is selected.

Source: Select the external memory device which contains a PLC program file (.ZLD) to transfer. The external 
memory device is USB flash drive.
Location: Specify the location of the PLC program file (.ZLD) to be transferred. The maximum 

number is 247 characters.
Example: “LDR_PROGRAM.ZLD” is a PLC program file saved in folder “LDRDATA” of a 

USB flash drive:
LDRDATA\LDR_PROGRAM.ZLD

Destination: Specify the destination PLC connected to the MICRO/I. The PLC type is configured in the Project 
Settings dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-31.
Interface: Select the type of communication interface in which the MICRO/I is 

connecting to the download destination PLC.
SERIAL1(RS232C), SERIAL1(RS422/485), Ethernet

If SERIAL1(RS232C) or SERIAL1(RS422/485) is selected for Interface.
Slave Number: Specify the slave number of the download destination PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the destination PLC. This is the 
External Device ID number set in the Project Settings dialog box, on the 
Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the destination PLC.
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If Upload PLC Program is selected.

Source: Specify the source PLC connected to the MICRO/I. The PLC type is configured in the Project Settings 
dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-31.
Interface: Select the type of communication interface in which the MICRO/I is connecting to the upload 

source PLC.
SERIAL1(RS232C), SERIAL1(RS422/485), Ethernet

If SERIAL1(RS232C) or SERIAL1(RS422/485) is selected for Interface.
Slave Number: Specify the slave number of the upload source PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the upload source PLC. This is 
the External Device ID number set in the Project Settings dialog box, on 
the Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the upload source PLC.

Destination: Specify where to save the PLC program uploaded from the PLC connected to the MICRO/I. The location 
is the USB flash drive.
Location: Specify the location of the folder where the uploaded PLC program file will be saved. The 

maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Program” on a USB flash drive: 

Uploaded_Program
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switched according to the value of M0 even if 
the button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

• When Alternate is selected for Action Mode on the General tab, the button remains on when hidden 
in the on state.

• When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not 
operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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5.4 Key Buttons

● For Keypad
These keys can be used for Numerical Input and Character Input:

■ Numerical Input Keypad

■ Character Input Keypad

Key Operation

. Inputs a decimal point.

0 to 9 Inputs a number from 0 to 9.

A to F Inputs a character from A to F.

+/- Toggles the sign.

CAN
Clears the data input thus far and cancels the input. Closes the Popup Screen that is opened as 
the Keypad, if this key is placed on it.

CLR Clears the data input thus far and stands by for further input.

BS Deletes the character to the left of the character at the cursor position. 

ENT
Writes the characters input as a numeric value to a device address. After the data is written, the 
focus can be moved according to the Focus Order setting. Focus Order can be set on the 
Options tab of the Screen Properties dialog box.

< Fcs.
Moves the focus one item before the current one as per the Focus Order setting. Focus 
Order can be set on the Options tab of the Screen Properties dialog box.

Fcs. >
Moves the focus one item after the current one as per the Focus Order setting. Focus Order 
can be set on the Options tab of the Screen Properties dialog box.

Alt
The Alt key switches the Popup Screen opened as a Keypad. Closes the Popup Screen that is 
opened as the Keypad and opens another Popup Screen as the Keypad.

The Alt key can be used, for instance, to switch between a decimal and a hexadecimal Keypad.

Key Operation

! Inputs a !.

" Inputs a ".

# Inputs a #.

$ Inputs a $.

% Inputs a %.

&. Inputs a &.

' Inputs a '.

( Inputs a (.

) Inputs a ).

* Inputs a *.

+ Inputs a +.

, Inputs a ,.

- Inputs a -.

. Inputs a .

/ Inputs a /.

0 to 9 Inputs a number from 0 to 9.

: Inputs a :.

; Inputs a ;.

< Inputs a <.

= Inputs a =.
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> Inputs a >.

? Inputs a ?.

@ Inputs a @.

A to Z Inputs a character from A to Z.

[ Inputs a [.

\ Inputs a \.

] Inputs a ].

^ Inputs a ^.

_ Inputs a _.

' Inputs a '.

a to z Inputs a character from a to z.

{ Inputs a {.

| Inputs a |.

} Inputs a }.

˜ Inputs a ˜.

(Keys dependent on 
Language setting)

Inputs the text displayed according to the language selected in the Language setting. For a list 
of the characters input using these keys, refer to Chapter 2 “1.2 Available Text” on page 2-5.

CAN
Clears the data input thus far and cancels the input. Closes the Popup Screen if it is opened as 
a Keypad.

CLR Clears the data input thus far and stands by for further input.

DEL Deletes the character at the cursor.

BS Deletes the character to the left the cursor.

ENT
Writes the text input in ASCII code form to a device address. After the data is written, the focus 
can be moved according to the Focus Order setting. Focus Order can be set on the Options 
tab of the Screen Properties dialog box.

SP Inputs a space.

Cur. > Moves the cursor right.

< Cur. Moves the cursor left.

< Fcs.
Moves the focus one item before the current one as per the Focus Order setting. Focus 
Order can be set on the Options tab of the Screen Properties dialog box.

Fcs. >
Moves the focus one item after the current one as per the Focus Order setting. Focus Order 
can be set on the Options tab of the Screen Properties dialog box.

Alt
The Alt key switches the Popup Screen opened as a Keypad. Closes the Popup Screen that is 
opened as the Keypad and opens another Popup Screen as the Keypad.

Key Operation

• Press and hold the < Cur. and Cur. > keys for more than one second to cause it to move repeatedly.
• The Alt key can be used, for instance, to switch between Keypads for lower case and upper case letters.
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● For Data Transfer Keys
These keys can be used to execute Data Transfer functions. For details about Data Transfer functions, refer to Chapter 
26 “Data Transfer Function” on page 26-1.

● For Alarm Displays
These keys can be used for the Alarm List Display and Alarm Log Display parts.

■ Alarm List Display

■ Alarm Log Display

Key Operation

Download Project Downloads a project file (ZNV format) saved on an external memory device to the MICRO/I.

Upload Project
Uploads the project used for operation on the MICRO/I and saves the project file (ZNV format) 
to an external memory device.

Download PLC Program
Downloads a PLC program file (ZLD format) saved on an external memory device to a PLC 
connected to the MICRO/I.

Upload PLC Program
Uploads a PLC program from the PLC connected to the MICRO/I and saves the PLC program file 
(ZLD format) to an external memory device.

Key Operation

Page Up Scrolls up the number of lines (1 to 1023) specified in Scroll Size.

Page Down Scrolls down the number of lines (1 to 1023) specified in Scroll Size.

Up
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing Select.

Down
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing Select.

Select Toggles the focus between show and hide.

Reference The reference screen appears.

Press and hold the Page Up, Page Down, < Cur., and Cur. > keys for more than one second to move the 
focus repeatedly.

Key Operation

Up
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing Select.

Down
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing Select.

Select Toggles the focus between show and hide.

Check Shows the date and time the alarm that has focus was confirmed.

All Check Shows the date and time that all alarms were confirmed.

Delete Clears the alarm that has focus.

Delete All Clears all alarms.

Reference Shows the reference screen for the alarm that has focus.

Stop Buzzer and Screen 
Flashing

Stops the sound of the buzzer and screen flashing when an alarm occurs.

Press and hold the Up and Down keys for more than one second to move the focus repeatedly.
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5.5 Key Browser

Select the key using the Key Browser. The Key Browser closes when a key is selected. The name of the key is shown 
in Key Type. Settings that apply to the selected key are displayed.

Select the key type from the following uses:
Keypad, Data Transfer, Alarm Display

■ Keypad
These buttons are used for Numerical Input and Character Input:

■ Data Transfer
These buttons are used to execute Data Transfer functions.

When you select a key, the label for that key is assigned as the Registration Text.
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■ Alarm Display
These buttons are used to manipulate the Alarm List Display and Alarm Log Display parts.
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6.1 How the Multi-Button is Used

Executes multiple commands at once.
These commands can be assigned to a Multi-Button.

• Pressing the button writes a 1 to a bit device, and the value of word device to another device address.

• Pressing the button outputs a screenshot of the current screen to an external memory device, and then switches 
the Base Screen.

6 Multi-Button

Command Description

Bit Write Writes a 0 or 1 to the specified bit device when pressed.

Word Write
Writes a value to a word device when pressed. You can specify the destination address number indirectly, 
and perform arithmetic on the value to be written.

Goto Screen Switches screens and opens other windows when pressed.

Print Outputs a screenshot to the external memory device when pressed.

Key Performs downloads, uploads, and file copying when pressed. Also used to manipulate other parts.

Script Executes a script when pressed.

MICRO/I

1

External device

0

D0= 123

D1= 0

D0= 123

D1= 123

Move

MICRO/I

USB flash drive

Image file

External Memory Device
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■ Momentary

■ Alternate

The button turns ON when pressed, 
and OFF when released. Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action ONOFF OFF

The button switches between ON and 
OFF each time it is pressed. Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action OFF
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6.2 Multi-Button Configuration Procedure

This section describes the configuration procedure for Multi-Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Multi-Button.

2 Click a point on the edit screen where you wish to place the Multi-Button.

3 Double-click the dropped Multi-Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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6.3 Properties of Multi-Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Action Mode
Select the Action Mode for the Multi-Button: Momentary or Alternate.

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Momentary: The button turns ON when pressed, and OFF when released.

Alternate: The button switches between ON and OFF each time it is pressed.

Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action ONOFF OFF

Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action OFF
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■ Multi-Functions
Use this grid to add or edit commands to execute when the Multi-Button is pressed.

Function List: Lists the commands to be executed.
Command Type: Shows the command type.
Command Name: Shows the command name.
Device Address: Shows the setting when one of the following Command Type is selected.

Shows the destination device address for the Bit Write and Word Write 
commands.
Shows the screen number when Goto Screen is set to Switch to Base 
Screen, Open Popup Screen, or Close Popup Screen.
Shows the script ID for the Script command.

• Executes only the Goto Screen command at the end of the Function List when multiple Switch to Base 
Screen type commands are set for Action Mode.

• Goto Screen commands are not executed from top to bottom as they appear in the Function List. 
Rather, they are executed at the end of the scan when the Multi-Button is pressed.

• If multiple Key commands are set, only the first and second Key commands in the Function List are 
executed. The third and following Key commands are not executed. Also, only the first Key command that 
specifies a Data Transfer function in the Function List is executed if multiple Key commands are set.

• Key commands are executed in the scan that follows a scan that satisfies the trigger condition.

Command Type: Select the command to add.
Bit Write: Writes a 0 or 1 to the bit device or bit of the word device. For details, refer to 

“Properties of Bit Write for Multi-Functions dialog box” on page 8-94.
Word Write: Writes a value to a word device. Can be used to indirectly specify the destination 

address or to perform operations on the written value. For details, refer to 
“Properties of Word Write for Multi-Functions dialog box” on page 8-95.

Goto Screen: Switches to another screen or displays a window. For details, refer to “Properties 
of Goto Screen for Multi-Functions dialog box” on page 8-97.

Print: Outputs a screenshot to an external memory device. For details, refer to 
“Properties of Print for Multi-Functions dialog box” on page 8-99.

Key: Performs a variety of functions including uploading and downloading, copying 
files, and operating other parts. For details, refer to “Properties of Key for Multi-
Functions dialog box” on page 8-100.

Script: Executes the script. For details, refer to “Properties of Script for Multi-Functions 
dialog box” on page 8-104.

Add: Adds a command to the list. A maximum of 32 commands may be added.
Click this button to display the Properties dialog box for the command selected from Command 
Type.

Edit: Changes a command in the list.
Click this button to display the Properties dialog box for the command selected in Function List.

Delete: Deletes a command from the list.
Select the command in the list and click this button.

Copy: Copies a command in the list.
Select a command in the list and click this button. A copy of the selected command is added to the 
end of the list.

Up: Shifts the selected command upward in the list.
Down: Shifts the selected command downward in the list.
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switched according to the value of M0 even if 
the button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:
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Properties of Bit Write for Multi-Functions dialog box

Sets the Bit Write command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the behavior of the Multi-Button from the following:

■ Destination Device Address
Specify the destination bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Write*1

Specify the number of bit devices (1 to 64) at the destination.

This setting is enabled only if Action Mode is set to Set or Reset. For details, refer to “Write*1” on page 8-6.

■ Source Data
Specifies the device address that stores the data to be written.
This setting is enabled only if Action Mode is set to Move. For details, refer to “Source Data” on page 8-6.

*1 Advanced mode only

Set: Pressing the Multi-Button writes a 1 to the bit device.

Reset: Pressing the Multi-Button writes a 0 to the bit device.

Set & Reset: Pressing the Multi-Button writes a 1 to the bit device.
Releasing the Multi-Button writes a 0 to the bit device.

Toggle: Pressing the Multi-Button inverts the value of the bit device.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: Pressing the Multi-Button writes the value in the source bit device to the value in the destination bit 
device.

For details about the Action Mode, refer to “Action Mode” on page 8-4. However, Set & Reset for the 
Multi-Button has the same function as Momentary for the Bit Button.

Device Address: Specify the source bit device.

Click to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Transfer: Specify the number of bit devices (1 to 64) to transfer.
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Properties of Word Write for Multi-Functions dialog box

Sets the Word Write command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the behavior of the Multi-Button from the following:

■ Data Type
Select the data type handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1
UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

Set: Pressing the button writes a fixed value to a word device.

Move: Pressing the button writes a value in a source device address to a destination word device.

Set ON & OFF Data: Pressing the button writes a fixed value of ON Data to a word device.
Releasing the button writes a fixed value of OFF Data to a word device.

Add, Sub, Multi, Div, Mod, OR, AND, XOR: Pressing the button performs arithmetic on a value of source device 
address and a fixed value or a value of device address and writes the 
result to a word device.

For details about the Action Mode, refer to “Action Mode” on page 8-22. However, Set ON & OFF Data for 
the Multi-Button has the same function as Momentary for the Word Button.

UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to Move. Because the number of 
device addresses to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4(B), BCD8(EB), or Float32(F) is selected and the arithmetic data contains a value inexpressible 
in BCD, a 1 is written to System Area 2 Processing error bit (address+2, bit 5) and an error message is 
displayed. For details, refer to Chapter 4 “Processing error” on page 4-19 and “Processing error” in Chapter 
31 “1.1 Errors Displayed on the Screen” on page 31-1.
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■ Source Data
Select the data handled by the operation selected for Action Mode.

■ Destination Device Address

*1 Advanced mode only

Value: Use a constant.
Only a Value can be handled if Action Mode is set to Set or Set ON & OFF Data.
If Action Mode is set to Set ON & OFF Data, the value in the ON Data is written when the 
button is ON, and the value in the OFF Data is written when the button is OFF.
Hexadecimal: Select this check box to enter the ON Data and OFF Data 

values in hexadecimal.
Device Address: Use a word device.

Specify the device.

Click  to display the Tag Editor. For the device address configuration
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
Use Reference Device Address*1: Select this check box and specify a device address to change the 

source word device according to the value of the specified device 
address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.

Transfer*1: Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.

For details, refer to “Transfer*1” on page 8-24.

Destination Device Address: Specify the destination word device.

Click  to display the Tag Editor. For the device address
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 
2-64.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device according
to the value of the specified device address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 
2-4.

Write*1: Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Move, or Set ON & OFF 
Data.

For details, refer to “Write*1” on page 8-25.
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Properties of Goto Screen for Multi-Functions dialog box

Sets the Goto Screen command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the behavior of the Multi-Button from the following:

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen.

Open Popup Screen: Opens a Popup Screen.

Close Popup Screen: Closes a Popup Screen.

Open Device Monitor Screen: Opens the Device Monitor Screen.

Close Device Monitor Screen: Closes the Device Monitor Screen.

Open Password Screen: Opens the Password Screen.

Close Password Screen: Closes the Password Screen.

Open Adjust Brightness Screen: Opens the Adjust Brightness Screen.

Close Adjust Brightness Screen: Closes the Adjust Brightness Screen.

Switch to System Mode: Switches to the Top Page in the System Mode.

Reset current screen: Resets the current Base Screen.

When the current Base Screen is reset using the Reset current screen function, the window and internal 
devices restart as if the Base Screens were switched.
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■ Goto Screen

*1 Advanced mode only

Screen Number: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, specify 
the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup 
Screen, or Close Popup Screen.
Use Reference Device Address*1: Select this check box and specify a device address to specify the 

screen number using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Open 
Popup Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as the 
origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, or Open Adjust Brightness Screen.
Use Reference Device Address*1: Select this check box and specify a device address to specify the 

coordinates
using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Open 
Popup Screen.
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Properties of Print for Multi-Functions dialog box

Sets the Print command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Output to
Select where to direct the screenshot to.

d

■ Action Mode
Select the behavior of the button from the following:

External Memory Device: Outputs the screenshot as a file to the external memory device inserted in the MICRO/I.
Files are output as follows:

File format File name File size

JPEG
CAP***.JPG (***: date and time when file was output)
Example: A file created at 18:50:25 on June 30, 2011 will be 
named “CAP110630_185025.JPG”.

Depends on image 
being displayed.

For details about external memory devices, refer to Chapter 27 “External Memory Devices” on page 27-1.

Print Screen: Outputs a screenshot of the current screen to the external memory device.

The maximum number of screenshots that can be captured (1 to 999) can be set in HMI Special Data 
Registers LSD65. (Default: 99)

The methods to erase screenshot files saved on the external memory device are as follows.
• To erase files during operation using parts, on the External Memory Device tab on the Project Settings 

dialog box, select the Remove Files check box and the All Screenshot data check box, and then 
configure the trigger device address. Assign that trigger device address to a part.

• To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in External 
Memory Device to open the Clear Data dialog box. Select the Screenshot Data check box and click 
OK.
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Properties of Key for Multi-Functions dialog box

Sets the Key command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Key Type
Select the function for the Key Button.

The settings explained below appear depending on the type of key selected.

■ Popup Screen Number
The Alt key switches the current Popup Screen used as a Keypad when this button is pressed.
Specify the Popup Screen number to open a Keypad for.
This setting is enabled only if Alt was selected using the Key Browser.

Displays settings 
applicable to the 
selected key.

(Key)

Language: Switches the display of the key that is displayed when Keypad is selected in Key Browser. These 
languages are available:
Japanese, European, Central European, Baltic, Cyrillic.

Browse: Opens the Key Browser when clicked. Select a key.
For details, refer to “5.5 Key Browser” on page 8-86.

(Key): Displays the name of the key selected using the Key Browser.

• When you select a key for Multi-Button or Multi-Command, the label for that key is not assigned as the 
Registration Text.

• The function of Key button will affect on the next scan when the trigger condition is satisfied.
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■ Scroll Size
Key Buttons Page Up and Page Down scroll the list up and down, respectively. Key Buttons Up and Down move 
the focus up and down, respectively. This settings specifies the number of pages or lines (1 to 1023 lines) to scroll or 
move the focus per each press of the button.
This setting is enabled only if Page Up, Page Down, Up, and Down are selected using the Key Browser.

■ Transfer Setting
Key Buttons Download Project, Upload Project, Download PLC Program, and Upload PLC Program, perform 
the data transfer function specified by their names. These settings specify the source, data to be transfered, and 
destination.
This setting is enabled only if one of these keys is selected after clicking Data Transfer in the Key Browser.

If Download Project is selected.

If Upload Project is selected.

Source: Select the external memory device which contains a project file (.ZNV) to transfer. The external 
memory device is USB flash drive.

Location: Specify the location of the project file (.ZNV) to transfer. The maximum number is 247 
characters.
Example: Where “Sample_Project.ZNV” is a project file saved on the root directory of a 

USB flash drive: 
Sample_Project.ZNV

Destination: Specify where to save the project uploaded from MICRO/I. The location is the USB flash drive.

Location: Specify the location of the folder where the uploaded project file will be saved. The 
maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Project” on a USB flash drive: 

Uploaded_Project
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If Download PLC Program is selected.

Source: Select the external memory device which contains a PLC program file (.ZLD) to transfer. The external 
memory device is USB flash drive.
Location: Specify the location of the PLC program file (.ZLD) to be transferred. The maximum number 

is 247 characters.
Example: “LDR_PROGRAM.ZLD” is a PLC program file saved in folder “LDRDATA” of a USB 

flash drive:
LDRDATA\LDR_PROGRAM.ZLD

Destination: Specify the destination PLC connected to the MICRO/I. The PLC type is configured in the Project 
Settings dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-31.
Interface: Select the type of communication interface in which the MICRO/I is connecting to the 

download destination PLC.
SERIAL1(RS232C), SERIAL1(RS422/485), Ethernet

If SERIAL1(RS232C) or SERIAL1(RS422/485) is selected for Interface.
Slave Number: Specify the slave number of the download destination PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the destination PLC. This is the 
External Device ID number set in the Project Settings dialog box, on 
the Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the destination PLC.
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If Upload PLC Program is selected.

Source: Specify the source PLC connected to the MICRO/I. The PLC type is configured in the Project Settings 
dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-31.
Interface: Select the type of communication interface in which the MICRO/I is connecting to the 

upload source PLC.
SERIAL1(RS232C), SERIAL1(RS422/485), Ethernet

If SERIAL1(RS232C) or SERIAL1(RS422/485) is selected for Interface.
Slave Number: Specify the slave number of the upload source PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the upload source PLC. This is 
the External Device ID number set in the Project Settings dialog box, 
on the Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the upload source PLC.

Destination: Specify where to save the PLC program uploaded from the PLC connected to the MICRO/I. The location 
is the USB flash drive.
Location: Specify the location of the folder where the uploaded PLC program file will be saved. The 

maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Program” on a USB flash drive: 

Uploaded_Program
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Properties of Script for Multi-Functions dialog box

Sets the script for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Script ID
Specify the script ID (1 to 32000) of the script to operate.

Script Manager will open when  is clicked. Select a script from the script list.
For details, refer to Chapter 20 “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script selected in Script Manager.

■ (Script)
Displays the contents of the script selected in Script Manager.
Once this area is double clicked, the Script Editor will open and editing can be done.
For details, refer to Chapter 20 “2.3 Script Editor” on page 20-8.

(Script)
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

• When Alternate is selected for Action Mode on the General tab, the button remains on when hidden 
in the on state.

• When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not 
operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.

Even if a Multi-Button is placed on the top layer, drawing objects that are drawn with scripts executed by the 
Multi-Button are not drawn on the top layer. They are drawn on the Base Screen. For details, refer to 
Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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7.1 How the Keypad is Used

A part comprised of Key Buttons. Enters numbers and characters into Numerical or Character Input parts.

• Entering numbers in the Numerical Input

• Entering characters in the Character Input

7 Keypad

1230

MICRO/I

Numerical Input

Keypad

MICRO/I

Character Input

Keypad

Do not use the Keypad part with the Goto Screen Button or a combination of Goto Screen Commands. For 
details, refer to “5 Key Button” on page 8-66.
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7.2 Keypad Configuration Procedure

This section describes the configuration procedure for Keypads.

1 On the Home tab, in the Parts group, click Buttons, and then click Keypad.

2 Click a point on the edit screen where you wish to place the Keypad.

3 Double-click the dropped Keypad and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Keypad Properties dialog box is displayed until OK is clicked.
 Refer to “7.3 Properties of Keypad Dialog Box” on page 8-117.

After OK on the Keypad Properties dialog box is clicked, double clicking the Keypad thereafter calls up the 
Properties dialog box for the Key Buttons as a group.
This allows editing of settings common to each button.
• View: “View Tab” on page 8-73
• Registration Text: “Registration Text Tab” on page 8-75
• Options: “Options Tab” on page 8-80

The Options tab only appears in Advanced mode. To switch to Advanced mode, click Advanced.
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7.3 Properties of Keypad Dialog Box

This section describes items and buttons in the Properties dialog box.

■ Browse
Select a prebuilt Keypad within WindO/I-NV4.
Displays the Standard Browser when clicked. Select numeric keys or character keys registered in the Standard 
Browser.

■ Button

■ Registration Text

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Foreground Color, Background Color:

Select the foreground and background color to use for the Keypad (color: 256 colors, 
monochrome: 16 shades).
Displays the Color Palette when Color is clicked. Select a color from the Color Palette.

Pattern: Select a pattern to use or tonal gradation for the Keypad.
Displays the Pattern Palette when Pattern is clicked. Select a pattern or tonal gradation from 
the Pattern Palette.

Font: Select one of the following fonts to use for the text on the buttons.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, 
Stroke.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 
Available Text” on page 2-5.

Style: Select a character style: Regular or Bold.

Magnification W, H: Select the zoom factor (0.5, 1 to 8) to use on the text.
This setting is only enabled when Font is set to Japanese, European, Chinese, Taiwanese, 
Korean, Central European, Baltic or Cyrillic.

Text Color: Select the text color (color: 256 colors, monochrome: 16 shades).
Displays the Color Palette when Color is clicked. Select a color from the Color Palette.
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■ Coordinates

■ Size

X, Y: Specify the display coordinates of the Keypad.
X and Y specify the upper left corner of the Keypad using the upper left corner of the screen as the origin.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Keypad

W, H: Specify the size of the Keypad by specifying width and height.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Keypad
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8.1 How the Selector Switch is Used

Writes a 0 or 1 to a bit device. This is an exclusive control that only writes a single value as 1 and all other values as 0.

• Switching between two Run Modes (Manual and Auto)

• Switching between three Run Modes (Filling - Stop - Discharge)

8 Selector Switch

Automatic Manual

Automatic

Auto Manual

Auto Manual Auto Manual

R-button

Ch2Ch1

L-button

Knob

Press L-button to
switch to Auto.

Press R-button to
switch to Manual.

Operate 
manually

F S D F S D F S D

F S D

R-button

Ch3Ch2Ch1

L-button

Knob

Press L-button to
switch to Filling.

Switch to Stop
(the operation differs according 

to the switch type)

Press R-button to 
switch to Discharge.
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8.2 Selector Switch Configuration Procedure

This section describes the configuration procedure for Selector Switch buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Selector Switch.

2 Click a point on the edit screen where you wish to place the Selector Switch.

3 Double-click the dropped Selector Switch and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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8.3 Properties of Selector Switch Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switch Type
The 2-Notch action is as follows.
• When the knob is at Ch1 (left), pressing the right button switches the selector knob to Ch2 (right).

During this action, the device address for Ch1 is set to 0 and Ch2 is set to 1.
• When the knob is at Ch2 (right), pressing the left button switches the selector knob to Ch1 (left).

During this action, the device address for Ch1 is set to 1 and Ch2 is set to 0.

The 3-Notch action is as follows.
• The knob behaves as follows for 3-Notch No-return, 3-Notch R-return, and 3-Notch L-return button:

- Press R-button: knob switches from Ch1 (left) -> Ch2 (middle) -> Ch3 (right), in that order.
- Press L-button: knob switches from Ch3 (right) -> Ch2 (middle) -> Ch1 (left), in that order.

• Switching the knob writes 1 to the device address for the new knob position, and 0 to the device addresses for the 
other two channels.

Whether the knob returns and the direction it returns depends on the switch type.
Select the switch type from the following.

2-Notch No-return: The knob does not return when the operator's finger is released.

Release

Default state

Press R-button ReleasePress L-button

0

1

1

0

Write Write

Ch1

 Ch2

Action

Operation 
and view

Data 
written
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2-Notch R-return: After the knob switches from Ch1 to Ch2, it returns to Ch1 when the R-button is released.

2-Notch L-return: After the knob switches from Ch2 to Ch1, it returns to Ch2 when the L-button is released.

3-Notch No-return: The knob does not return when the operator's finger is released.

3-Notch R-return: • If the knob is switched to Ch3, it returns to Ch2 when the button is released.
• If the knob is switched to Ch1, or from Ch1 to Ch2, it stays where it is even if the button is 

released.

Release

Default state

Press

0

1

1

0

Write Write

Ch1

 Ch2

Action

Operation 
and view

Data 
written

Release

Default state

Press

0

1

1

0

Write Write

Ch1

 Ch2

Action

Operation 
and view

Data 
written

Release

Default state

Press R-button ReleasePress L-buttonReleasePress L-button

0

0

1

Ch1

 Ch2

0

1

0Ch3

1

0

0

WriteAction Write

Operation 
and view

Write

Data 
written

ReleasePress R-button ReleasePress R-buttonReleasePress L-button

Default state

0

0

1

1

0

0

0

1

0

0

1

0

Write Write WriteWrite

Ch1

 Ch2

Ch3

Action

Operation 
and view

Data 
written
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■ Notch
Register and edit the settings for each notch to each channel.

3-Notch L-return: • If the knob is switched to Ch1, it returns to Ch2 when the button is released.
• If the knob is switched to Ch2, or from Ch3 to Ch2, it stays where it is even if the button is 

released.

3-Notch Both-return: If the knob is switched to Ch1 or Ch3, it returns to Ch2 when the button is released.

Release

Default state

Press L-button ReleasePress L-buttonReleasePress R-button

0

11

0

1

00

1

0

Write Write Write Write

0

0 0

Ch1

 Ch2

Ch3

Action

Operation 
and view

Data 
written

Release

Default state

Press L-buttonReleasePress R-button

0

1

1

01

0

0

1

Write Write Write Write

0 0

0 0

Ch1

 Ch2

Ch3

Action

Operation 
and view

Data 
written

Use Text Manager: Select this check box to use the text registered in the Text Manager as the Registration Text for 
each channel.

(List of Notch settings): This list shows the notch settings for each channel.

No.: Shows the channel to be output. The number of notches selected in the 
Switch Type determines the number of channels.
Double clicking the cell displays the Notch Settings dialog box where you 
can edit the notch settings. For details, refer to “Notch Settings dialog box” 
on page 8-125.

Device Address: Shows the destination bit device or bit number in the destination word 
device.
Double clicking the cell displays the Tag Editor where you can edit the device 
address. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Text: Shows the Registration Text for the channel.
Double clicking the cell allows you to edit the Registration Text.
Can only be set when the Use Text Manager check box is cleared.

Text ID: Shows the Text ID.

Double clicking the cell displays the Text Manager where you can change the 
Text ID.
Can only be set when the Use Text Manager check box is selected.

Color: Shows the color of the Registration Text for the channel.
Double clicking the cell displays Color Palette where you can change the Text 
Color



8 Selector Switch

8-124 WindO/I-NV4 User’s Manual

Set: Registers or changes the notch settings. Selecting a number that has already been registered 
changes the existing notch settings.
Clicking Set displays the Notch Settings dialog box where you can configure the notch. For 
details, refer to “Notch Settings dialog box” on page 8-125.

Insert: Inserts a notch setting entry above the currently selected position.
Select the channel number from the list where you wish to insert the notch setting and click 
Insert. This displays the Notch Settings dialog box where you can configure the notch. The 
notch settings at the point of insertion shift down one line. Notch settings cannot be inserted if 
all channel numbers have a notch setting.

Remove: Deletes the registered notch setting from the list.
Select the channel number in the list and click Remove.

Default Position: Selects the default position of the knob when the MICRO/I starts operation and the Selector 
Switch is first displayed on the screen.

Ch1: Makes Ch1 the default knob position. Writes 1 to the device address configured for Ch1, 
writes 0 to the device addresses configured for the other channels.

Ch2: Makes Ch2 the default knob position. Writes 1 to the device address configured for Ch2, 
writes 0 to the device addresses configured for the other channels.

Ch3: Makes Ch3 the default knob position. Writes 1 to the device address configured for Ch3, 
writes 0 to the device addresses configured for the other channels.

Read from Destination Device Address: The position of the knob is determined by the value 
of device address.

The default knob position is fixed for these two switch types because of the return functionality.
2-Notch R-return: Ch1
2-Note L-return, 3-Notch Both-return: Ch2

• If Default Position is Ch1, Ch2, or Ch3, the position of the knob does not change even if the 
value in the device address configured for the channel changes, unless the change is caused by 
the buttons on the Selector Switch. If Default Position is Read from Destination Device 
Address, the position of the knob changes according to the value of the device address 
configured for the channel.

• When a Selector Switch is redisplayed immediately after switching the screen or when a hidden 
Selector Switch is redisplayed, values are not written to the destination device addresses for the 
channels.

• If the value in the device address used to determine the default knob position contains an illegal 
value, the knob will be shown as follows:
- 2-Notch No-return: Ch1
- 3-Notch: Ch2
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Notch Settings dialog box

This dialog configures a notch for a channel. If the channel has already been set with a notch, the setting is 
overwritten.

■ Destination Device Address
Specify the destination bit device or bit in the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Text
Enter the Registration Text for the channel.
The characters that can be entered depends on the font selected for Font on the Format tab. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

■ Text ID
To use the text registered in the Text Manager as the Registration Text for the channel, specify the ID number from 1 
to 32000.

Click  to display Text Manager.
The text ID setting is only enabled if you select the Use Text Manager check box.

■ Text Color
Select the Registration Text color for the channel (color: 256 colors, monochrome: 16 shades).
Displays the Color Palette when Color is clicked. Select a color from the Color Palette.



8 Selector Switch

8-126 WindO/I-NV4 User’s Manual

● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Knob Color
Selects the knob color of the Selector Switch (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

■ Switch

Knob

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the button.
Click Pattern to display the Pattern Palette. Select a pattern or tonal 
gradation from the Pattern Palette.

Buttons
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Selector Switch is enabled and operational while the condition is satisfied. The Selector Switch is disabled and not 
operational while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Selector Switch is not operational.
While LM0 is 1, the condition is satisfied and the Selector Switch is operational.

Trigger Type: Selects the condition to enable the Selector Switch from the following.

Always enable: The Selector Switch is always enabled.

While ON: Enables the Selector Switch when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Selector Switch 
state

Enabled

1

0

Value of
device address

Disabled

Selector 
Switch state

Disabled DisabledEnabledEnabledEnabled
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■ Visible Condition
The Selector Switch is displayed while the condition is satisfied. The Selector Switch is hidden while the condition is 
not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Selector Switch is hidden.
While LM0 is 1, the condition is satisfied and the Selector Switch is displayed.

While OFF: Enables the Selector Switch when the value of device address is 0.

While satisfying the condition: Enables the Selector Switch when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Disabled

Value of
device address

Selector 
Switch state

Disabled DisabledEnabled Enabled

Selector 
Switch state

DisabledDisabledDisabled Enabled Enabled Enabled

Satisfied

Not satisfied

Condition

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

If a hidden Selector Switch is redisplayed on the screen when Read from Destination Device Address is 
selected for Default Position on the General tab, the display position of the knob changes according to 
the value of the device address configured for the channel. When Ch1, Ch2, or Ch3 is selected, the knob is 
displayed at the same position as before it was hidden, regardless of the value of device address configured 
for the channel.



WindO/I-NV4 User’s Manual 8-131

8 Selector Switch

8

Buttons

Trigger Type: Selects the condition to display the Selector Switch from the following.

Always visible: The Selector Switch is always displayed.

While ON: Displays the Selector Switch when the value of device address is 1.

While OFF: Displays the Selector Switch when the value of device address is 0.

While satisfying the condition: Displays the Selector Switch when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Selector Switch 
state

Always show

1

0

Hide Show Hide HideShow Show

Value of
device address

Selector 
Switch state

Value of
device address

1

0

Show Show ShowHide Hide Hide

Selector 
Switch state

Hide Hide HideShow Show Show

Selector Switch 
state

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.



8 Selector Switch

8-134 WindO/I-NV4 User’s Manual

● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Selector Switch on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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9.1 How the Potentiometer is Used

Writes a value to a word device by pressing a slider button.

• The slider display position increases and decreases while the button is depressed. The value of the slider at the 
displayed position is written to the device address when the button is released.

The slider indicates the value written to the device address. When the value is increased or decreased, the slider 
display position also changes.
The slider moves between a user-defined minimum and maximum value.
The input value increases and decreases while the button is depressed. The value of the slider at the displayed 
position is written to the device address when the button is released.

9 Potentiometer

D0  : 0

Value of slider at 
displayed position

105

127

Value of slider at 
displayed position

D0  : 127

MICRO/I

D0  :

Value of slider at 
displayed position

0

0

Write to device address

External device

Default state Press R-button Release Press L-button Release

Operation 
and view

Slider StopMoves rightStop StopMoves left

Value Increases Decreases

Action Write Write

The slider display position does not change when the destination device address value changes unless it 
was changed by the Potentiometer buttons. However, immediately after the screen is switched and 
immediately after the part is displayed on the screen, the slider is displayed at the position specified by the 
value of the destination device address.
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9.2 Potentiometer Configuration Procedure

This section describes the configuration procedure for Potentiometer parts.

1 On the Home tab, in the Parts group, click Buttons, and then click Potentiometer.

2 Click a point on the edit screen where you wish to place the Potentiometer.

3 Double-click the dropped Potentiometer and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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9.3 Properties of Potentiometer Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Data Type
Select the data type to be handled by the Potentiometer.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Minimum
Specify the minimum value that can be entered. The minimum value differs depending on the data type.

■ Maximum
Specify the maximum value that can be entered. The maximum value differs depending on the data type.

■ Destination Device Address
Specify the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Slider Color
Selects the slider color of the Potentiometer (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Plate Color
Selects the plate color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Slider

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange (from 256 colors 
or 16 shades for monochrome).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Switch

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the button.
Click Pattern to display the Pattern Palette. Select a pattern or tonal 
gradation from the Pattern Palette.

Buttons

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Potentiometer is enabled and operational while the condition is satisfied. The Potentiometer is disabled and not 
operational while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Potentiometer is not operational.
While LM0 is 1, the condition is satisfied and the Potentiometer is operational.

Trigger Type: Selects the condition to enable the Potentiometer from the following.

Always enable: The Potentiometer is always enabled.

While ON: Enables the Potentiometer when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Enabled

Potentiometer 
state

1

0

Value of
device address

Disabled Disabled DisabledEnabledEnabledEnabled

Potentiometer 
state
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■ Visible Condition
The Potentiometer is displayed while the condition is satisfied. The Potentiometer is hidden while the condition is not 
satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Potentiometer is hidden.
While LM0 is 1, the condition is satisfied and the Potentiometer is displayed.

While OFF: Enables the Potentiometer when the value of device address is 0.

While satisfying the condition: Enables the Potentiometer when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Disabled

Value of
device address

Disabled DisabledEnabled Enabled

Potentiometer 
state

DisabledDisabledDisabled Enabled Enabled Enabled

Potentiometer 
state

Satisfied

Not satisfied

Condition

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

When a hidden Potentiometer is redisplayed, the slider is displayed at the position specified by the value of 
device address.
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Trigger Type: Selects the condition to display the Potentiometer from the following.

Always visible: The Potentiometer is always displayed.

While ON: Displays the Potentiometer when the value of device address is 1.

While OFF: Displays the Potentiometer when the value of device address is 0.

While satisfying the condition: Displays the Potentiometer when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Potentiometer 
state

1

0

Hide Show Hide HideShow Show

Value of
device address

Potentiometer 
state

Value of
device address

Potentiometer 
state

1

0

Show Show ShowHide Hide Hide

Hide Hide HideShow Show Show

Potentiometer 
state

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.
Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Potentiometer on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes the setup for the lamp parts and related MICRO/I operations.

  

1.1 How the Pilot Lamp is Used

Pilot Lamp parts display drawing objects. The value of a bit device is used to switch the drawing object displayed.

• Switch and display pictures by values of device addresses

Chapter 9 Lamps

1 Pilot Lamps

MICRO/I
External device

0

1
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1.2 Pilot Lamp Configuration Procedure

This section describes the configuration procedure for Pilot Lamps.

1 On the Home tab, in the Parts group, click Lamps, and then click Pilot Lamp.

2 Click a point on the Edit screen where you wish to place the Pilot Lamp.

3 Double-click the dropped Pilot Lamp and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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1.3 Properties of Pilot Lamp Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the lamp is OFF or ON.

■ Action Mode
Select the action when the part is ON.

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

No Flash (only ON): Displays the drawing object for the ON state when the trigger condition is satisfied.

Flash (ON + Flash): When the condition is satisfied and the value of the trigger device address is 1, the object flashes 
(alternates between the drawing object for the ON and OFF states at fixed intervals). The 
flashing interval can be set with the Flashing Cycle setting on the System tab of the Project 
Settings dialog box.

Flash Trigger Device Address: Specify the bit device to cause the lamp to flash.
The lamp flashes when the value of the device address is 1. The 
action for No Flash (only ON) applies when the value is 0.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.



1 Pilot Lamps

9-4 WindO/I-NV4 User’s Manual

Example: When Action Mode is Flash (ON + Flash), Flash Trigger Device Address is M0, and on the Trigger 
Condition tab, Trigger Type is While ON, Device Address is LM0

0

Displayed drawing object

Trigger Condition: Device Address LM0 value 1 1 0

0Action Mode: Value of Flash Trigger Device Address M0 0 1 1

Displays OFF 
drawing object

Action Displays ON 
drawing object Flashing Displays OFF 

drawing object

The lamp will neither turn on or flash if the trigger conditions are not met. Lamp trigger conditions are 
configured on the Trigger Condition tab.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

■ Not Display Image*1

Select this check box to display no drawing object in the OFF state.

*1 Advanced mode only

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

Foreground Color, Background Color:

Selects the foreground and background colors of the standard graphic (color: 256 colors, 
monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern 
Palette.

If the Not Display Image check box is selected, Text set as registration text for the OFF state will be 
displayed.
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

Sets width and height to define the size of parts. The minimum size varies based on the item selected for Image Type.

Standard: The minimum size varies based on the selected item and the maximum size is a base screen size.

Picture: W: 2 to (base screen horizontal size)

H: 2 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab

■ Lightning
The Pilot Lamp is on while the condition is satisfied, and it is off while the condition is not satisfied. The Pilot Lamp 
displays the ON graphic when on and it displays the OFF graphic when off.
Example: When Trigger Type is While ON and Device Address is LM0

When LM0 is 0, condition is not satisfied, so Lamp displays OFF graphic.
When LM0 is 1, condition is satisfied, so Lamp displays OFF graphic.

Trigger Type: Selects the condition to turn on the Pilot Lamp from the following.

While ON: Turns on the Pilot Lamp when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Condition
Not satisfied

Condition
Satisfied

Lamp
Displays OFF graphic

Lamp
Displays ON graphic

1

0

Value of 
device address

On Off

Pilot Lamp status

Off OffOn On
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■ Visible Condition
The Pilot Lamp is displayed while the condition is satisfied. The Pilot Lamp is hidden while the condition is not 
satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Pilot Lamp is hidden.
While LM0 is 1, the condition is satisfied and the Pilot Lamp is displayed.

While OFF: Turns on the Pilot Lamp when the value of device address is 0.

While satisfying the condition:
Turns on the Pilot Lamp when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the on condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the on condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the on condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the on condition. The maximum number is 80 characters.

1

0

On On OnOff Off Off

Pilot Lamp status

Value of 
device address

On OffOff OffOn On

Pilot Lamp status

Condition
Satisfied

Not satisfied

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide
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Trigger Type: Selects the condition to display the Pilot Lamp from the following.

Always visible: The Pilot Lamp is always displayed.

While ON: Displays the Pilot Lamp when the value of device address is 1.

While OFF: Displays the Pilot Lamp when the value of device address is 0.

While satisfying the condition: Displays the Pilot Lamp when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Pilot Lamp state

1

0

Hide Show Hide HideShow Show

Value of 
device address

Pilot Lamp state

1

0

Show Show ShowHide Hide Hide

Value of 
device address

Pilot Lamp state

Pilot Lamp state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Pilot Lamp on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Multi-State Lamp is Used

Multi-state lamp parts display drawing objects. The value of a specified word device is used to switch the drawing 
object to be displayed.

• Switch and display pictures by values of device addresses

2 Multi-State Lamps

External device
MICRO/I

D0

bit15 bit0bit3

D0= 0100

bit0bit3

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0000

bit0bit3

 State: 0State: 1State: 2 OFF

(None)
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• Display a picture when in the OFF state.

MICRO/I
External device

D0

bit15 bit0bit3

D0= 0100

bit0bit3

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0000

bit0bit3

OFF State: 0State: 1State: 2

The conditions to display the picture set by the OFF state on the screen are as follows.
• Y is selected under Flash on the State tab and the trigger condition is not satisfied.
• Switching Method on the General tab is Bit Number, and the all bit in the device address are 0 or a 

bit not allocated a picture is 1.
• Switching Method on the General tab is Value, and the value of device address is a number not 

allocated a picture.
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2.2 Multi-State Lamp Configuration Procedure

This section describes the configuration procedure for Multi-State Lamps.

1 On the Home tab, in the Parts group, click Lamps, and then click Multi-State Lamp.

2 Click a point on the edit screen where you wish to place the Multi-State Lamp.

3 Double-click the dropped Multi-State Lamp and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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2.3 Properties of Multi-State Lamp Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switching Method
Specify the method to switch drawing objects from the following:

Bit Number: Switches the drawing object displayed, according to the status of the bits.
Example 1: Bit Number is selected. The bits triggered in device address D0 corresponds to the 

following pictures and the OFF state is None.

Switches the picture to display according to the status of the bits.

bit15 bit0bit3

Value of 
Trigger Device Address D0

Picture

State:  0 State:  1State:  2

(None)

OFF

Display picture 
for bit 0

Display picture 
for bit 1

Display picture 
for bit 2

No picture Display picture 
for bit 1

Display picture 
for bit 2

0001 0010 0100 1000 1110 1100

State:  0 State:  1 State:  1State:  2 State: 2

Picture to display

Bit state of 
Trigger Device Address D0

Action

I f  mu l t ip le  b i t s  a re  1 ,  
display the picture for the 
lowest order bit.

If all bits in the device address are 
0 or if a bit with no associated 
picture becomes 1, display nothing.
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Example 2: Bit Number is selected. The bits of trigger device address D0 and the OFF state are 
allocated to the following pictures.

Switches the picture to display according to the status of the bits.

Value: Switches the drawing object displayed, according to the value of the device address.
Example 3: Value is selected. The value assigned to the trigger device address D0 are allocated to the 

following pictures and the OFF state is None.

Switches the picture to display according to the value of the device address.

Example 4: Value is selected. The values assigned in trigger device address D0 and the OFF state are 
allocated to the following pictures.

Switches the picture to display according to the value of the device address.

bit15 bit0bit3

Value of
Trigger Device Address D0

Picture

State:  0 State:  1State:  2 OFF

OFF

Display picture 
for bit 0

Display picture 
for bit 1

Display picture 
for bit 2

Display picture 
for OFF state

Display picture 
for bit 1

Display picture 
for bit 2

0001 0010 0100 1000 1110 1100

State:  0 State:  1 State:  1State:  2 State: 2

Picture to display

Bit state of
Trigger Device Address D0

Action

I f  mu l t ip le  b i t s  a re  1 ,  
display the picture for the 
lowest order bit.

If all bits in the device address are 0 or if 
a bit with no associated picture becomes 
1, display the picture for OFF state.

0 1 2Value of
Trigger Device Address D0

Picture

State: 2State:  1State:  0

(None)

OFF

Display picture for 0 Display picture for 1 Display picture for 2 No picture

0 1 2 3

State:  0 State:  1 State: 2

Picture to display

Value of
Trigger Device Address D0

Action

If the value of device 
address has no picture 
associated with it, display 
nothing.

OFF

0 1 2Value of
Trigger Device Address D0

Picture

State: 2State:  1State:  0

OFF

Display picture 
for 0

Display picture 
for 1

Display picture 
for 2

Display picture 
for OFF state

0 1 2 3

State:  0 State:  1 State: 2

Picture to display

Value of
Trigger Device Address D0

Action

If the value of device 
address has no picture 
associated with it, display 
the picture for OFF state.
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■ Trigger Device Address
Specifies the word device to use as the condition for switching the drawing object.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Coordinates

■ Size

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

Sets width and height to define the size of parts. The minimum size varies based on the item selected for Image Type.

Standard: The minimum size varies based on the selected item and the maximum size is a base screen size.

Picture: W: 2 to (base screen horizontal size)

H: 2 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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● State Tab

■ Number of States
Specify the number of drawing objects (1 to 16) to display by switching.

■ Settings
Lists the state settings. The list shows various settings such as the state number and file name for the drawing object.

State: Shows the OFF state and state number. 
Double clicking the cell displays the State Settings dialog box where you can edit the state 
settings. For details, refer to “State Settings dialog box” on page 9-25.

Image: Shows the name or a file name for a drawing object. 
Double clicking the cell opens the View Browser if Standard is selected under Image Type on 
the View tab, or Picture Manager if Picture is selected. This allows you to change the drawing 
object to display.

Text: Shows the registration text. 
Double clicking the cell allows you to edit the Registration Text.
Can only be set when the Use Text Manager check box is cleared.

Text ID: Shows the Text ID.
Double clicking the cell displays the Text Manager where you can change the Text ID.
Can only be set when the Use Text Manager check box is selected.

Fg.Color, Bg.Color: Shows the foreground and background colors for standard images. 
Double clicking the cell opens the Color Palette where you can change the foreground and 
background colors. This setting can only be changed if Image Type is set to Standard on the 
View tab.
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■ Image
Shows the image for the OFF state or state number selected in the Settings list.

■ Copy to next State
Select this check box to register or change all state settings at once.
This option copies the current settings to all state numbers after the selected state number when the settings are set 
or changed. This option can only be set when a state number is selected.

Pattern: Shows the pattern or tonal gradation for standard images. 
Double clicking the cell opens the Pattern Palette where you can change the pattern or tonal 
gradation of the image. This setting can only be changed if Image Type is set to Standard on 
the View tab.

Text Color Shows the color of the registration text. Double clicking the cell opens the Color Palette where 
you can change the color of the text.

Flash: Indicates whether to display the drawing object flashing or constantly lit. Double clicking the cell 
toggles between Y for yes and N for no. If Y is selected, the picture which corresponds to a bit 
state or value of device is alternately shown and hidden at a fixed time interval.
However, if the OFF state is set, the picture that corresponds to a bit state or value of device 
and the picture set for the OFF state are alternately displayed at a fixed time interval.

Windows Font: Shows the currently set Windows Font. Double clicking the cell displays the Font Settings 
dialog box where you can change the Windows Font. This setting can only be changed when 
Windows is selected for Font on the Registration Text tab.

Line Spacing: Shows the line spacing for Windows Font. Double clicking the cell allows you to change the line 
spacing (0 to 100). This setting can only be changed when Windows is selected for Font on 
the Registration Text tab.

Character Pitch: Shows the character spacing for Windows Font. Double clicking the cell allows you to change 
the character spacing (0 to 100). This setting can only be changed when Windows is selected 
for Font on the Registration Text tab.

Set: Registers the state settings to the list. If you select the OFF state or state number that is already 
registered, that number is overwritten with the new settings.
Click this button to display the State Settings dialog box. For details, refer to “State Settings 
dialog box” on page 9-25.

Insert: Inserts the settings in the position selected on the list.
Select a state number in the list and click this button to display the State Settings dialog box. 
The settings at the insertion point shift down one line. Settings cannot be inserted if all state 
numbers are configured.

Remove: Deletes the registered settings from the list.
Select the OFF state or state number and click this button to delete the selected settings from 
the list.

When the OFF state is not set

When ON

When OFF

Flash

When the OFF state is set

Flash

No picture is 
shown.

Shows the picture set 
for the OFF state

Shows the picture that 
corresponds to the bit 
state or device value

Shows the picture that 
corresponds to the bit 
state or device value
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State Settings dialog box

This dialog box sets the drawing object and registration text to display.

■ Image

■ Text
Enter the text to display. The maximum number is 3,750 characters.
The characters that can be entered depends on the font selected for Font on the Registration Text tab. For details, 
refer to Chapter 2 “1.2 Available Text” on page 2-5.
This setting is only enabled when the Use Text Manager check box is cleared on the Registration Text tab.

■ Text ID
To use the text registered in the Text Manager, specify the ID number from 1 to 32000.
This setting is only enabled when the Use Text Manager check box is selected on the Registration Text tab.

■ Color

■ Windows Font
Specify the Windows Font to use.
The current settings are displayed by selecting Windows in the Font property on the Registration Text tab. You 
can specify the character spacing (0 to 100) and the line spacing (0 to 100). To change the settings other than the 
character spacing and line spacing, click Change to display the Font Settings dialog box.
The text ID setting is only enabled if the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.

Browse: Select the drawing object to use for the lamp part. Clicking this button opens the View Browser 
if Standard is selected under Image Type on the View tab, or Picture Manager if Picture is 
selected.

Image: Shows the selected drawing object.

Foreground Color, Background Color:

Select the foreground and background color to use for standard images (color: 256 colors, 
monochrome: 16 shades).
Clicking either button opens the Color Palette. Select a color from the Color Palette.

Pattern: Select the pattern or tonal gradation for a standard image. 
Clicking this button opens the Pattern Palette. Select a pattern or tonal gradation from the 
Pattern Palette.

Text Color: Select the text color (color: 256 colors, monochrome: 16 shades) for the registration text.
Clicking this button opens the Color Palette. Select a color from the Color Palette.

Flash: Select this check box to make the picture flash (alternately show and hide the picture that 
corresponds to the bit state or device value at a fixed time interval).
The flashing interval can be set with the Flashing Cycle setting on the System tab of the 
Project Settings dialog box. This option cannot be set for the OFF state.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Visible Condition
The Multi-State Lamp is displayed while the condition is satisfied. The Multi-State Lamp is hidden while the condition 
is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Multi-State Lamp is hidden.
While LM0 is 1, the condition is satisfied and the Multi-State Lamp is displayed.

Trigger Type: Selects the condition to display the Multi-State Lamp from the following.

Always 
visible:

The Multi-State Lamp is always displayed.

While ON: Displays the Multi-State Lamp when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

Always show

Multi-State 
Lamp state

1

0

Hide Show Hide HideShow Show

Value of
device address

Multi-State 
Lamp state
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While OFF: Displays the Multi-State Lamp when the value of device address is 0.

While satisfying the condition:

Displays the Multi-State Lamp when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger 
Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

1

0

Show Show ShowHide Hide Hide

Multi-State 
Lamp state

Value of
device address

Hide Hide HideShow Show Show

Multi-State 
Lamp state

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Multi-State Lamp on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to configure the Data Display parts and their operation on the MICRO/I. 

  

1.1 How the Numerical Input is Used

The Numerical Input features a display mode that displays the current value of a device address and an entry mode 
that enters a value using the keypad or key buttons and writes that value to a device address. When the part is 
displayed on the screen, the Numerical Input is in display mode. To enter a value by pressing the keypad or key 
buttons, touch the Numerical Input to switch it to entry mode. In entry mode, the value of device address is displayed 
until a value is entered.
The Numerical Input can perform the following functions.

• Write a value entered with the keypad or key buttons to a device address

• Display the current value of a device address

• Enter and display decimal numbers

• Display the entered value as * (asterisk)

Chapter 10 Data Displays

1 Numerical Input

MICRO/I
External device

999
999 D100: 999

Numerical Input

Standard keypad

External device
MICRO/I

1234 D100: 1234

MICRO/I

12.30
12.3

12.30

External device

MICRO/I

****
****

****

External device
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1.2 Numerical Input Configuration Procedure

This section describes the configuration procedure for Numerical Inputs.

1 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Input.

2 Click a point on the edit screen where you wish to place the Numerical Input.

3 Double-click the dropped Numerical Input and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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1.3 Properties of Numerical Input Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Methods of using the Numerical Input
Selects how to use the Numerical Input:

Use as Numerical Input: Uses the Numerical Input to enter or display values.

Use as Display for Keypad: Uses the Numerical Input as a part to display the value entered 
with a Keypad.

Display the Minimum value specified with Data Over: Uses the Numerical Input as a part to display the minimum 
value of a Numerical Input switched to input mode.

Display the Maximum value specified with Data Over:Uses the Numerical Input as a part to display the maximum 
value of a Numerical Input switched to input mode.
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■ Keypad
Configures the keypad for entering values in the Numerical Input.

■ Display Type
Selects the display type for the value as Decimal or Hexadecimal.

■ Data Format

Type: According to the location where the keypad is configured, selects the type from the following.
Standard: Uses the standard keypad. The standard keypad is the keypad configured as the 

popup screen for the standard keypad (screen number 3000 to 3015).
This is the keypad for the type configured by Display Type.

Popup: Uses a keypad configured as a popup screen.
Current Screen: Uses the keypad configured on the same screen as the Numerical Input.

Screen Number: Specifies the screen number of the popup screen configured as the keypad (1 to 3015).
This option can only be configured if Popup is selected for Type.

Adjust location automatically: Select this check box to display the popup screen configured as the keypad in a 
location where it will not overlap the Numerical Input.
This option can only be configured if Standard or Popup is selected for Type.

Coordinates X, Y: Specifies the display location of the popup screen configured as the keypad.
With the upper-left corner of the screen as the origin, the X and Y coordinates are 
the upper-left corner of the popup screen.
This option can only be configured when Popup is selected for Type and the 
Adjust location automatically check box is cleared.
Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

Data Type: Selects the type of data for the value.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Digits: Specifies the digits to display. The range of digits that can be set varies based on the 
display type and data type. The digits that can be set are as follows.

Display Type Data Type Digits

Decimal display

UBIN16(W), BIN16(I) 1 to 5

UBIN32(D), BIN32(L) 1 to 10

BCD4(B) 1 to 4

BCD8(EB) 1 to 8

Float32(F) 1 to 10

Hexadecimal 
display

UBIN16(W) 1 to 4

UBIN32(D) 1 to 8

Display Floating Point: Select this check box to display the decimal point.

If Data Type is UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), or BCD8(EB) and the 
Display Floating Point check box is selected, a decimal value will be displayed on the Numerical Input 
when a decimal value is entered on the keypad in entry mode, but an integer is written to the device 
address. In display mode, source data is an integer, but the value is displayed with a decimal point added at 
the number of floating digits configured for the Numerical Input.
However, if Float32(F) is selected for Data Type, both the destination data and the source data are 
decimal values.
Example: When Display Type is configured as Decimal, Data Type is UBIN16(W), the Display Floating 

Point check box is selected, Digits is 5, Floating Digits is 3, and Destination Device Address is 
D100

MICRO/I
External device

12.345 D100: 12345
12.345
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*1 Advanced mode only

Floating Digits: Specifies the number of digits for the fractional part of the decimal value out of the 
number of digits specified by Digits.
This option can only be configured when the Display Floating Point check box is selected. 
The range of digits that can be set for the fractional part varies based on the display type 
and data type. The range of digits that can be set for the fractional part is as follows.

Display Type Data Type Floating Digits

Decimal display

UBIN16(W), BIN16(I) 1 to Digits

UBIN32(D), BIN32(L) 1 to Digits

BCD4(B) 1 to Digits

BCD8(EB) 1 to Digits

Float32(F) 1 to 8

Hexadecimal display
UBIN16(W) --

UBIN32(D) --

Floating Symbol*1: Selects the decimal point symbol from the following.
.(dot), :(colon), ;(semicolon), ,(comma), /(slash)
This option can only be configured when the Display Floating Point check box is selected.
Example: When Digits is 4 and Floating Digits is 2

When Floating Symbol is .(dot) 12.34
When Floating Symbol is /(slash) 12/34

Floating Symbol is not reflected on the standard keypad. To change the decimal point symbol on the 
standard keypad, please change the keypad button.

Suppress Zeros: Select this check box to hide “0” for the upper digits of the integer part.
Example: Suppress Zeros selected: 1234

Suppress Zeros cleared: 00001234
Do not display when the value is zero: Select this check box to show a blank display if the value is "0".

• If the value is zero and it is not displayed, the unit set on the Format tab is also not displayed.
• Even if the Do not display when the value is zero check box is selected, "0" is displayed when the 

value is not 0.

Display the minus sign: Select this check box to display the - (negative) sign when displaying negative 
values.
This option can only be configured when Decimal is selected for Display Type.

Display the plus sign: Select this check box to display the + (positive) sign when displaying positive 
values.
This option can only be configured when Decimal is selected for Display Type.

Symbol to show when Error occurs: Selects the following symbols to display when an error has occurred.
"? (question mark)", " (space)", "# (pound)", "% (percent)", "$ (dollar)", "- (minus)", 
"@ (at sign)", "\ (backslash)", "* (asterisk)", "! (exclamation mark)", "+ (plus)"

The selected symbol from Symbol to show when Error occurs is displayed under the following states:
• If the Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value entered in device address 

doesn't comply with the data type.
• If a value entered in the Numerical Input exceeds the maximum or minimum of the Data Over.
• A value that exceeds the maximum numeric value that can be processed with the data type selected for 

Data Format was entered with the input mode of the Numerical Input.
• If a value divided by zero operation was executed with Display with Arithmetic Operation on the 

Options tab.
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■ Input Method
These options specify the destination for entered values.

■ Always Entry Mode*1

Select this check box to enter values by pressing the keypad and key buttons without touching the Numerical Input 
displayed on the screen.
To display 0 on the Numerical Input until a value is entered, select the Start from 0 in Always Entry Mode of 
Numerical Input check box on the System tab in the Project Settings dialog box. To display the value of device 
address, clear the Start from 0 in Always Entry Mode of Numerical Input check box.
This option can only be configured if Current Screen is selected for Type.
Example: When the Always Entry Mode check box is selected and the Start from 0 in Always Entry Mode of 

Numerical Input check box is selected on the System tab in the Project Settings dialog box

Example: When the Always Entry Mode check box is cleared

*1 Advanced mode only

Destination Device Address: Specifies the word device to write the entered value to.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device by the value of this device address.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
For details on indirect writing, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.

Enter a value

Display value being entered
(Entry mode)

Display 0
(Entry mode)

Press ENT

Write value to device address
(Entry mode)

0

Action

Operations and display

999999

Value of
Destination Device Address

99912341234

Not displayed on Numerical Input.

Only one Numerical Input or one Character Input set to Always Entry Mode can be configured for one 
screen.

Press Numerical Input Enter a value

Enter 999

 Press ENT

Display value of 
device address
(Entry mode)

Write value to
device address
(Entry mode)

Display value of 
device address
(Display mode)

Display focus
(Entry mode)

Display value of
device address
(Display mode)

1234

Operations and display

1234 999

Value of 
Destination Device Address

Action

1234 999

999123412341234 999
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■ Focus is moved by ENT button*1

When multiple Numerical Inputs are configured on the screen, select this check box to continue entering values on 
each of the Numerical Inputs.
Each time ENT is pressed, the focus moves between the Numerical Inputs according to Focus Order. On the View 
tab, in the Screens group, click Focus Order, and then click the Numerical Inputs in the order to move the focus.
Example: When Numerical Input A and B are configured and the Focus is moved by ENT button check box for 

Numerical Input A is selected and the Focus is moved by ENT button check box for Numerical Input B is 
cleared

■ Update the display by ENT button*1

Select this check box to display the current value unchanged and update the display when a value is entered and ENT 
is pressed.
When this check box is cleared, the display updates with each press of a number button to display the number being 
entered.

*1 Advanced mode only

Press Numerical Input A Enter a value Press ENT Enter a value Press ENT

Move focus from 

Numerical Input A to B

Write value to 
device address 
(Entry mode)

Display value of 
device address 
(Display mode)

Display value of 
device address 
(Display mode)

Display value of 
device address 
(Entry mode)

Write value to 
device address
(Entry mode)

Display value of 
device address 
(Display mode)

Display value of 
device address 
(Entry mode)

Display focus
(Entry mode)

Display focus
(Entry mode)

Display value of 
device address 
(Display mode)

1234

567

1234

567

1234

567

999

567

999

567

999

567

999

333

999

333

567

1234

Operations 
and display

1234 999 999

567

1234 999

Numerical Input A 
Value of

Destination Device Address

Numerical Input A 
action

Numerical Input B 
action

567

1234A

B

Numerical Input B 
Value of

Destination Device Address

567

999

567 567

333

999

567

333

999

333

999

333

When a value outside the input range is entered and ENT is pressed, the symbol selected under Symbol to 
show when Error occurs is displayed. The value is not written to the device address.

Press Numerical Input Enter a value Press ENT

Display value of
device address 
(Entry mode)

Write value to
device address 
(Entry mode)

Display value of 
device address 
(Display mode)

Display focus
(Entry mode)

Display value of 
device address 
(Display mode)

1234

Operations and display
1234 999 999

1234 999

Value of
Destination Device Address

Numerical Input display

Keypad display

Action

1234 999

1234

1234

-

1234

1234

1234

1234

1234

999

999

999

999

999

999

-

Numerical Input

Keypad display



1 Numerical Input

10-8 WindO/I-NV4 User’s Manual

● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Size
When Standard is selected, selects the text size as 8x16 or 16x16.
When Stroke or 7-Segment is selected, specifies the text size (8 to 128).

■ Style
Selects Regular or Bold for text style.
Can only be set when Standard is selected for Font.

■ Magnification

Can only be set when Standard is selected for Font.

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.
This option can configure the text color in display mode and in entry mode. However, for Entry Mode text color can 
be set only when the Reverse check box is cleared.

■ Reverse
Select this check box to reverse the text color and plate color during display mode when in entry mode.
Can only be set when Standard is selected for Image Type under the View tab.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Display Numerical Value with “*” *1

Select this check box to display the entered value as * (asterisks).
Nothing is displayed if the value of device address is 0 when this check box is selected and the Suppress Zeros 
check box is selected on the General tab. When this check box is selected in entry mode, nothing is displayed until a 
value is entered from the key buttons or keypad. If ENT is pressed with nothing displayed, 0 is written to the 
destination device address.

■ With Unit*1

Select this check box to display units or other characters at the end of a number. Displayed characters must be 
registered in Text Manager. The displayed text color will be as set for Text Color under the Format tab.

■ Change Display Colors
To switch the text and plate colors, select this check box and select the method to the display colors from the 
following.

*1 Advanced mode only

Text ID: Specifies the Text Manager ID No. (1 to 32000).

Click  to display Text Manager.

Text: Displays the characters of the specified Text ID.

• The maximum number that can be displayed with this function is 4 characters. The fifth and subsequent 
characters of a character string are not displayed. However, if Windows Font is set for the specified Text 
ID characters all the characters are displayed.

• If a carriage return (CR) is included the characters after the CR are not displayed.

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color under the Change Display Colors.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

1234

1234

0

1

Trigger Device Address

Trigger Device Address

External device

Text Color

Plate Color on the View tab

Text Color under Change Display Colors

Plate Color under Change Display Colors
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 0, then the colors specified by Text Color and Plate Color on the View tab and the colors 
specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 1, then the colors specified by Text Color and Plate Color under Change Display Colors 
and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

1234

1234
1234

1234

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

1234

1234
1234

1234

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Trigger device address under
Change Display Colors

Trigger device address under
Change Display Colors

0

0

1

0

1234

1234
1234

1234

Flashing
1

Trigger device address under 
Change Display Colors

Trigger device address
under Flash

Trigger device address under 
Change Display Colors

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

Text Color under 
Change Display Colors
Plate Color under 
Change Display Colors

Text Color under Change Display Colors

Plate Color under Change Display Colors

Text Color under Flash

Plate Color under Flash
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Trigger Device Address: Specifies the bit device or the bit number of the word device that will be used to trigger 
flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
Select data type.

Specifies the allowable range of values to enter or display.

Value: Specifies the minimum and/or the maximum as a constant.

Device Address: Specifies the minimum and/or the maximum as a value of word device.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified when Value is selected vary based on the 
data type selected with Data Format on the General tab. For details on data types, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
When Device Address is selected, these options specify the source word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

• Select UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), or BCD8(EB) for Data Type 
under the General tab, and to display a fractional number specify the values of Minimum and 
Maximum as an integer.
Example: To set a value of “1.25” for the upper limit, enter “125”.

• If the value of the device address to display exceeds the data range that can be processed for the data 
type selected under Data Format on the General tab, the symbol selected under Symbol to show 
when Error occurs on the General tab is displayed.

• If the entered value exceeds the allowable range or if it exceeds the data range that can be processed for 
the data type selected under Data Format on the General tab, the symbol selected under Symbol to 
show when Error occurs on the General tab is displayed and the value is not written to the device.
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■ When Data Over
These options configure the operation of the part when the value entered with the keypad exceeds the allowable 
range.
These options can only be configured when the Minimum or Maximum check boxes are selected under Range.

Example: If you attempt to enter “140”, which is higher than the maximum of “100”, or “-10”, which is lower than the 
minimum of “0”, the value is not written and the symbol selected under Symbol to show when Error 
occurs on the General tab is displayed. 1 is written to the Report Device Address LM0 under When 
Data Over.

Report: Select this check box to write 1 in the Report Device Address when the entered value or the value of the 
device address to display exceeds the allowable range.

Report Device Address: Specifies the Report Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Operations 

and 

display

0

0

Entered data

80

80

80

?????

10

10

80

Written data

140

10

?????

10

80 10

-10

Data over notification: LM0 10 0 1

Range: Value

    Minimum: 0

    Maximum: 100

When Data Over

    Report: On

    Report Device Address: LM0
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Numerical Input is enabled and operational while the condition is satisfied. The Numerical Input is disabled and 
not operational while the condition is not satisfied.

Example: When Trigger Type is While ON and Device Address is LM0
While LM0 is 0, the condition is not satisfied and the Numerical Input is not operational.
While LM0 is 1, the condition is satisfied and the Numerical Input is operational.

Trigger Type: Selects the condition to enable the Numerical Input from the following.

Always enable: The Numerical Input is always enabled.

While ON: Enables the Numerical Input when the value of device address is 1.

LM0:

MICRO/I

Condition 
Not 

satisfied

0

LM0:
Condition 
Satisfied

1 Operational

123

123

Not 
operational

Always enabled

Numerical 
Input state

123

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
Device Address

Numerical 
Input state

123 123 123 123123 123
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■ Visible Condition
The Numerical Input is displayed while the condition is satisfied. The Numerical Input is hidden while the condition is 
not satisfied.

While OFF: Enables the Numerical Input when the value of device address is 0.

While satisfying the condition: Enables the Numerical Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
Device Address

Numerical 
Input state

123 123 123123 123 123

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Numerical 
Input state

Condition

123 123 123123 123 123

Example: When Trigger Type is While ON and Device Address is LM0
While LM0 is 0, the condition is not satisfied and the Numerical Input is hidden.
While LM0 is 1, the condition is satisfied and the Numerical Input is displayed.

LM0:

MICRO/I

0

LM0: 1 Show

Condition 
Not 

satisfied

Condition 
Satisfied

123

Hide

• If the Numerical Input is hidden while entering a value, the input is canceled. If a popup screen 
configured as the standard keypad or a keypad is displayed, these screens are closed.

• When multiple Numerical Inputs are arranged on the screen and the Focus is moved by ENT button 
check box is selected, entry mode is canceled if the Numerical Input is hidden while entering a value.
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Trigger Type: Selects the condition to display the Numerical Input from the following.

Always visible: The Numerical Input is always displayed.

While ON: Displays the Numerical Input when the value of device address is 1.

While OFF: Displays the Numerical Input when the value of device address is 0.

While satisfying the condition: Displays the Numerical Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Numerical 
Input state

123

1

0

Hide Show Hide HideShow Show

Value of
Device Address

Numerical 
Input state

123 123 123

Value of
Device Address

1

0

Show Show ShowHide Hide Hide

Numerical 
Input state

123 123 123

Numerical 
Input state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

123 123 123
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

Since the display security group is Group A, User 2 (of Group A) can view the buttons. But since the input security 
group is Group B, User 2 cannot operate the buttons.
Suppose that the Password Screen is now opened and a switch is made to User 3, who is part of both Group A and 
Group B. Group A buttons can be displayed, and Group B buttons can be operated.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130

999

Line Chart and Bar Chart
Display: Group A

Numerical Input
Display: Group A
Input: Group B

Numerical Display
Display: None

MICRO/I

130

MICRO/I MICRO/I

130

999

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

999999999

999

User2 User3

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Can operate

Button
Cannot operate
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■ Input with Arithmetic Operation
To apply arithmetic operations to values entered using a keypad and writing the results, select this check box and 
input the arithmetic formula.
Example: To divide the value of device address when entered by 60

■ Display with Arithmetic Operation
To apply arithmetic operations to values of device addresses and writing the results, select this check box and input 
the arithmetic formula.
Example: To multiple the value of device address when displayed by 60

Arithmetic Formulas
Arithmetic formulas can be specified by freely combining multiple kinds of data and operators in the following format.

• There is no limit on the number of data items or number of operators. However, the maximum number is 120 
characters.

• Round brackets can be used.

Data

Operators
Specify the type of arithmetic operation to be performed on the data. The operator priority is the same as for scripts. 
For details, refer to Chapter 20 “6.3 About the Priority of the Operator” on page 20-55.

External device MICRO/I

D0 700

42000÷60

Write value of 
entered value 
divided by 60

42000

Numerical Input
Destination Device Address: D0
Input with Arithmetic Operation: @/60

Item Description

@
The device address on which the arithmetic operation is performed is specified in the arithmetic 
formula. Only one device address can be set for an arithmetic operation.
The device address is as specified for Destination Device Address under the General tab.

Value
Sets the constant values for the arithmetic formula.
The values that can be set depend on the data type selected using Data Format under the General 
tab. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address Specifies the bit device or word device for the arithmetic formula.
Always enter the device address enclosed in square brackets, “[” and “]”.

Item Description

Arithmetic 
operators

Sets the arithmetic operators.

+ Addition Adds  and .

- Subtraction Subtracts  from .

* Multiplication Multiplies  and .

/ Division Divides  by .

% Modulo Calculates remainder after dividing  by .

External device MICRO/I

D0 1234

1234×60

Display value multiplied 
by 60 for the value of 

device address

74040

Numerical Input
Destination Device Address: D0
Display with Arithmetic Operation: @•60

...(up to 120 characters)

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data Operator Data
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Examples of Arithmetic Formula Input

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Bit operator

Sets the bit operator.

& Logical AND Calculates the logical product (AND) of each bit of  and .

| Logical OR Calculates the logical sum (OR) of each bit of  and .

^ Logical XOR 
(exclusive OR)

Calculates the exclusive logical sum (XOR) of each bit of  and 
.

<< Left shift Shifts each bit of  to left by  bit(s).

>> Right shift Shifts each bit of  to right by  bit(s).

Input Examples Description

@ + 1

To perform the arithmetic operation and input the result, add 1 to the value entered 
using the Keypad and write the result to the device address.

To perform the arithmetic operation and display the result, add 1 to the value of device 
address and display the result.

[LDR 0] + @ + 100

To perform the arithmetic operation and input the result, add the value of LDR0 to the 
value entered using the Keypad and add 100, and write the result to the device address.

To perform the arithmetic operation and display the result, add the value of LDR0 to the 
value of device address and add 100, then display the result.

@ & 3

To perform the arithmetic operation and input the result, write the logical product of the 
value entered using the Keypad and 3 to the device address.

To perform the arithmetic operation and display the result, add 3 to the value of device 
address and display the result.

Item Description

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Numerical Input on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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1.4 How to Enter Values

Use the keypad or key buttons to write a value to a device address with the Numerical Input. The input methods are 
as follows.

■ Pressing the Numerical Input and Entering Values from the Standard Keypad
Arrange a Numerical Input on the screen and in its properties dialog box, on the General tab, under Keypad, select 
Standard for Type.

External device
MICRO/I

1234

999

1234
999

999

D100: 1234

D100: 1234

D100: 999

999
D100: 999

Press Numerical Input

Write value 
to device address

Press ENT

Display value of device address
(Entry mode)

Display value of device address
(Entry mode)

Close standard keypad

Display standard keypad

Enter "999"

Display value of device address
(Display mode)

Display value of device address
(Display mode)

When the following operations are performed, entry mode is canceled and the current value of device 
address is displayed in the Numerical Input. To enter a value, press the Numerical Input again to set it to 
entry mode.
• CAN was pressed
• When the Focus is moved by ENT button check box on the General tab is cleared and ENT was 

pressed and a value was written to the device address
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■ Without Pressing the Numerical Input, Directly Entering Values from a Keypad on the Same Screen
Arrange a Numerical Input and a keypad on the same screen. In the properties dialog box for the Numerical Input, on 
the General tab, under Keypad, select Current Screen for Type and select the Always Entry Mode check box.

1.5 Advanced Usage

● Using the System Area
• When finished entering a value by pressing ENT, 1 is written to the System Area 2 Numerical Input Setting 

Complete bit (address number+3, bit 0).

• When CAN is pressed, entry mode is canceled and 1 is written to the System Area 2 Numerical Input Setting 

Cancel bit (address number+3, bit 1). However, if the keypad is closed by pressing  (close) on the popup 
screen's title bar or another Numerical Input is pressed before finished entering the value by pressing ENT, entry 
mode is canceled and 1 is not written to the System Area 2 Numerical Input Setting Cancel bit (address number+3, 
bit 1).

• To clear the System Area 2 numerical input setting complete bit or the numerical input setting cancel bit, write 1 to 
System Area 1 Numerical Input Setting Clear bit (address number+1, bit 10). To automatically clear these bits 
when the Numerical Input keypad is pressed in entry mode, select the Clear Keypad bit in System Area 
automatically check box on the System tab in the Project Settings dialog box.

External device
MICRO/I

999

1234
D100: 1234

D100: 999

999
D100: 999

Write value
 to device address

Press ENT

Display value of device address
(Entry mode)

Display value of device address
(Entry mode)

Display value of device address
(Entry mode)

Enter "999"

If the System Area 2 Numerical Input Setting Complete Bit (address number+3, bit 0) is set to another 
function's execution condition, that function can be executed when ENT is pressed.
Example: To simultaneously close a popup screen when ENT is pressed

In the Properties of Goto Screen Command dialog box, on the General tab, select Close Popup 
Screen for Action Mode. On the Trigger Condition tab, select Rising-edge for Trigger 
Type, and configure Device Address as the System Area 2 Numerical Input Setting Complete bit 
(address number+3, bit 0).



2 Character Input

10-26 WindO/I-NV4 User’s Manual

  

2.1 How the Character Input is Used

The Character Input features a display mode that displays the character codes in current values of device addresses 
as text and an entry mode that enters text using the keypad or key buttons and writes the character codes for the 
entered text to device addresses. When the part is displayed on the screen, the Character Input is in display mode. To 
enter text by pressing the keypad or key buttons, touch the Character Input to switch it to entry mode.
The Character Input can perform the following functions.

• Write the character codes for text entered with the keypad or key buttons to device addresses

• Display the character codes in current values of device addresses as text

• Display entered text as * (asterisk)

2 Character Input

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : (NULL)‘S’

‘   ’ ‘S’

MICRO/I
External device

HG  SERIES_

HG  SERIES
Character Input

Standard keypad

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

D102 : 

D103 : 

D104 : ‘S’ (NULL)

‘ I ’ ‘E’

‘E’ ‘R’

‘   ’ ‘S’

MICRO/I
External device

HG  SERIES

MICRO/I
External device

****

********
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2.2 Character Input Configuration Procedure

This section describes the configuration procedure for Character Inputs.

1 On the Home tab, in the Parts group, click Data Displays, and then click Character Input.

2 Click a point on the edit screen where you wish to place the Character Input.

3 Double-click the dropped Character Input and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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2.3 Properties of Character Input Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Keypad
Configures the keypad for entering text in the Character Input.

*1 Advanced mode only

Use as Display for Keypad*1: Select this check box to only use the Character Input as a part to display the 
text entered with the keypad.

Type: According to the location where the keypad is configured, selects the type from the following.

Standard: Uses the standard keypad. The standard keypad is the keypad configured as the 
popup screen for the standard keypad (screen number 3000 to 3015).

Popup: Uses a keypad configured as a popup screen.

Current Screen: Uses the keypad configured on the same screen as the Character Input.

Screen Number: Specifies the screen number of the popup screen configured as the keypad (1 to 3015).
This option can only be configured if Popup is selected for Type.

Adjust location automatically: Select this check box to display the popup screen configured as the keypad in a 
location where it will not overlap the Character Input.
This option can only be configured if Standard or Popup is selected for Type.

Coordinates X, Y: Specifies the display location of the popup screen configured as the keypad.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-left 
corner of the popup screen.
This option can only be configured when Popup is selected for Type and the Adjust location 
automatically check box is cleared.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)
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■ Data Format
Specifies the digits to display.

■ Input Method
These options configure the destination for the character codes for the entered text.

■ Always Entry Mode*1

Select this check box to enter text by pressing the keypad and key buttons without touching the Character Input 
displayed on the screen.
This option can only be configured if Current Screen is selected for Type.
Example: When the Always Entry mode check box is selected

Example: When the Always Entry Mode check box is cleared

*1 Advanced mode only

Input Digits: Specifies the number of digits that can be entered with the Character Input (1 to 127).

Display Digits: Specifies the number of digits that can be displayed in the Character Input display (1 to 100).

Destination Device: Specifies the destination word device for the character codes for the entered text.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device by the value of this device address.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
For details on indirect writing, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.

Enter textPress CLR Press ENT

4944(Hex)

4543(Hex)

‘ I ’ ‘D’4847(Hex)‘H’ ‘G’ 4847(Hex)‘H’ ‘G’4847(Hex)‘H’ ‘G’

Display text being 
entered (Entry mode)

Display values of
device addresses as text

(Entry mode)

Display only focus
(Entry mode)

Write character codes to 
device addresses

(Entry mode)

Enter IDECDeletes text

‘E’ ‘C’

IDEC_HG_ _ IDEC_

Action

Operations 
and display

Value of
Destination Device Address

Only one Numerical Input or one Character Input set to Always Entry Mode can be configured for one 
screen.

Enter text

Enter IDEC

Press Character Input Press ENT

4944(Hex)
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‘ I ’ ‘D’

Display text being 
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Display focus
(Entry mode)
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Display values of
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(Display mode)

4847(Hex)‘H’ ‘G’ 4847(Hex)‘H’ ‘G’ 4847(Hex)‘H’ ‘G’

Press CLR
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Display only focus
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‘C’‘E’‘E’ ‘C’

IDEC_IDEC_HG_ IDECHG
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Operations 
and display

Value of
Destination Device Address

_
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■ Focus is moved by ENT button*1

When multiple Character Inputs are configured on the screen, select this check box to continue entering text on each 
of the Character Inputs.
Each time ENT is pressed, the focus moves between the Character Inputs according to Focus Order. On the View 
tab, in the Screens group, click Focus Order, and then click the Character Inputs in the order to move the focus.
Example: When Character Input A and B are configured and the Focus is moved by ENT button check box for 

Character Input A is selected and the Focus is moved by ENT button check box for Character Input B is 
cleared

■ Update the display by ENT button*1

Select this check box to display the current text unchanged and update the display when text is entered and ENT is 
pressed.
When this check box is cleared, the display updates with each press of a character button to display the character 
being entered.

*1 Advanced mode only

Press Character Input Enter text Press ENT
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange



2 Character Input

10-32 WindO/I-NV4 User’s Manual

■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Central European, Baltic, Cyrillic, Stroke
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Size
When Japanese is selected, selects the text size as 8x16 or 16x16.
When Stroke is selected, specifies the text size (8 to 128).
Can only be set when Japanese or Stroke is selected for Font.

■ Style
Selects Regular or Bold for text style.
Can only be set when Japanese, European, Central European, Baltic, or Cyrillic is selected for Font.

■ Magnification

Can only be set when Japanese, European, Central European, Baltic, or Cyrillic is selected for Font.

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.
This option can configure the text color in display mode and in entry mode. However, for Entry Mode text color can 
be set only when the Reverse check box is cleared.

■ Reverse
Select this check box to reverse the text color and plate color during display mode when in entry mode.
Can only be set when Standard is selected for Image Type under the View tab.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Display Character with “*”*1

Select this check box to display the entered characters as * (asterisks).
If this check box is selected, nothing is displayed until a value is entered from the key buttons or keypad when the 
Character Input is in entry mode. If ENT is pressed with nothing displayed, 0 is written to the destination device address.

■ Change Font with Device Address*1

Select this check box to change the font used to display the text with a value of device address.
The keypad (popup screen) can also be changed when Standard or Popup is selected for Type under Keypad on 
the General tab.

■ Change Display Colors
Select this check box to switch the text and plate colors.

*1 Advanced mode only

Trigger Device Address: Specifies the word device (2 words) to use as the condition to change the font.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

Example: With Trigger Device Address set to D100, to enter Central European text from 
popup screen 100 using a Character Input for entering European text from the 
standard keypad (popup screen 3003)
Write 6 to D100 and 100 to D101.

Font number Popup screen No.

1st word 3rd word2nd word Font number

1: Japanese
2: European
6: Central European
7: Baltic
8: Cyrillic

Popup screen No. 1 to 3015

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color
under the Change Display Colors.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

0

1

Trigger Device Address

Trigger Device Address

External device

HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color under Change Display Colors

Plate Color under Change Display Colors
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 0, then the colors specified by Text Color and Plate Color on the View tab and the colors 
specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device for Change Display 
Colors is 1, then the colors specified by Text Color and Plate Color under Change Display Colors and the 
colors specified by Text Color and Plate Color under Flash are alternately displayed.

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
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Text Color under Flash

Plate Color under Flash

Trigger device address under
Change Display Colors

Trigger device address under
Change Display Colors

0

0

1

0

Flashing
1

Trigger device address under
Change Display Colors

Trigger device address
under Flash

Trigger device address under
Change Display Colors

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color under 
Change Display Colors
Plate Color under 
Change Display Colors

Text Color under Change Display Colors

Plate Color under Change Display Colors

Text Color under Flash

Plate Color under Flash



2 Character Input

10-36 WindO/I-NV4 User’s Manual

Trigger Device Address: Specifies the bit device or the bit number of the word device that will be used to trigger 
flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Character Input is enabled and operational while the condition is satisfied. The Character Input is disabled and 
not operational while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Character Input is not operational.
While LM0 is 1, the condition is satisfied and the Character Input is operational.

Trigger Type: Selects the condition to enable the Character Input from the following.

Always enable: The Character Input is always enabled.

While ON: Enables the Character Input when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1 Operational
Condition 
Satisfied

Condition 
Not 

satisfied

IDEC

IDEC

Not 
operational

Always enabled

Character Input 
state

IDEC

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
Device Address

Character Input 
state

IDEC IDEC IDEC IDECIDEC IDEC
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■ Visible Condition
The Character Input is displayed while the condition is satisfied. The Character Input is hidden while the condition is 
not satisfied.

While OFF: Enables the Character Input when the value of device address is 0.

While satisfying the condition:

Enables the Character Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
Device Address

Character Input 
state

IDEC IDEC IDECIDEC IDEC IDEC

Disabled Disabled DisabledEnabled Enabled Enabled

Satisfied

Not satisfied

Condition

Character Input 
state

IDEC IDEC IDECIDEC IDEC IDEC

Example: When Trigger Type is While ON and Device Address is LM0
While LM0 is 0, the condition is not satisfied and the Character Input is hidden.
While LM0 is 1, the condition is satisfied and the Character Input is displayed.

LM0:

MICRO/I

0

LM0: 1 Show
Condition 
Satisfied

Condition 
Not 

satisfied

IDEC

Hide

• If the Character Input is hidden while entering a value, the input is canceled. If a popup screen 
configured as the standard keypad or a keypad is displayed, these screens are closed.

• When multiple Character Inputs are arranged on the screen and the Focus is moved by ENT button 
check box is selected, entry mode is canceled if the Character Input is hidden while entering a value.
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Trigger Type: Selects the condition to display the Character Input from the following.

Always visible: The Character Input is always displayed.

While ON: Displays the Character Input when the value of device address is 1.

While OFF: Displays the Character Input when the value of device address is 0.

While satisfying the condition: Displays the Character Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Character Input 
state

IDEC

1

0

Hide Show Hide HideShow Show

Value of
Device Address

Character Input 
state

IDEC IDEC IDEC

Value of
Device Address

1

0

Show Show ShowHide Hide Hide

Character Input 
state

IDEC IDEC IDEC

Hide Hide HideShow Show Show

Character Input 
state

Satisfied

Not satisfied

Condition

IDEC IDEC IDEC
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Setting the security group makes it possible to limit the display and operation in a similar way to using the 
Trigger Condition tab.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

Since the display security group is Group A, User 2 (of Group A) can view the buttons. But since the input security 
group is Group B, User 2 cannot operate the buttons.
Suppose that the Password Screen is now opened and a switch is made to User 3, who is part of both Group A and 
Group B. Group A buttons can be displayed, and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130

HG  SERIES

Line Chart and Bar Chart
Display: Group A

Character Input
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

HG  SERIES

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

HG  SERIES_

HG  SERIES_

HG  SERIES HG  SERIES

User2 User3

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Can operate

Button
Cannot operate

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Character Input on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.4 How to Enter Text

Use the keypad or key buttons to write character codes to device addresses with the Character Input. The input 
methods are as follows.

■ Pressing the Character Input and Entering Text from the Standard Keypad
Arrange a Character Input on the screen and in its properties dialog box, on the General tab, under Keypad, select 
Standard for Type.

External device
MICRO/I

HG SERIE

HG SERIES_

HG

HG_

HG SERIES_

HG SERIES

D100 : 4847(Hex)‘H’ ‘G’

D100 : 4847(Hex)‘H’ ‘G’

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

‘S’ (NULL)

‘ I ’ ‘E’

‘   ’ ‘S’

‘ I ’ ‘E’

‘S’ (NULL)

‘   ’ ‘S’

Press Character Input

Write text character 
codes to device addresses

Press ENT

Display values of device addresses as text
(Entry mode)

Display values of device addresses as text
(Entry mode)

Close standard keypad

Display standard keypad

Enter text as
 "HG SERIES"

Display values of device addresses as text
(Display mode)

Display values of device addresses as text
(Display mode)

When the following operations are performed, entry mode is canceled and the current values of device 
addresses are displayed as character codes on the Character Input. To enter text, press the Character Input 
again to select it and set it to entry mode.
• CAN was pressed
• When the Focus is moved by ENT button check box on the General tab is cleared and ENT was 

pressed and a value was written to the device address
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■ Without Pressing the Character Input, Directly Entering Text from a Keypad on the Same Screen
Arrange a Character Input and a keypad on the same screen. In the properties dialog box for the Character Input, on 
the General tab, under Keypad, select Current Screen for Type and select the Always Entry Mode check box.

■ Changing the Language and Entering Text
Select the Change Font with Device Address check box on the Format tab in the properties dialog box.
It is convenient to use this setting together with the text group settings.
The font and popup screen with this setting will change simultaneously with the text group change and text can be 
entered with the same font as the text group.
Specify the same device address in the Change Text Group by Device Address on Text Manager as the Trigger 
Device Address for this setting.

2.5 String Data Storage Method

The entered text is stored in the upper byte and lower byte according to the Storage Method of String Data 
setting. Storage Method of String Data is configured on the System tab in the Project Settings dialog box.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-13.

Example: When the destination device address is LDR100 and the entered text is ABCDE

• When from Upper byte is selected for Storage Method of String Data

• When from Lower byte is selected for Storage Method of String Data

External device
MICRO/I

HG_

HG SERIES_

HG SERIES

D100 : 4847(Hex)‘H’ ‘G’

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

‘   ’ ‘S’

‘ I ’ ‘E’

‘S’ (NULL)

‘   ’ ‘S’

‘ I ’ ‘E’

‘S’ (NULL)

Write text character 
codes to device addresses

Press ENT

Display values of device addresses as text
(Entry mode)

Display values of device addresses as text
(Entry mode)

Display values of device addresses as text
(Entry mode)

Enter text as 
"HG SERIES"

Device address
Stored value

Upper byte Lower byte
LDR100 'A' = 41 (Hex) 'B' = 42 (Hex)
LDR101 'C' = 43 (Hex) 'D' = 44 (Hex)
LDR102 'E' = 45 (Hex) 0

NULL terminating character

Device address
Stored value

Upper byte Lower byte
LDR100 'B' = 42 (Hex) 'A' = 41 (Hex)
LDR101 'D' = 44 (Hex) 'C' = 43 (Hex)
LDR102 0 'E' = 45 (Hex)

NULL terminating character

When handling strings, 0 is written to the device as the NULL terminating character and treated as the end 
of the string.
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2.6 Advanced Usage

● Using the System Area
• When finished entering text by pressing ENT, 1 is written to the System Area 2 Character Input Setting Complete 

bit (address number+3, bit 5).
• When CAN is pressed, entry mode is canceled and 1 is written to the System Area 2 Character Input Setting Cancel 

bit (address number+3, bit 6). However, if the keypad is closed by pressing  (close) on the popup screen's title 
bar or another Character Input is pressed and selected before finished entering the text by pressing ENT, entry 
mode is canceled and 1 is not written to the System Area 2 Character Input Setting Cancel bit (address number+3, 
bit 5).

• To clear the System Area 2 character input setting complete bit or the character input setting cancel bit, write 1 to 
System Area 1 Character Input Setting Clear bit (address number+1, bit 11). To automatically clear these bits when 
the Character Input keypad is pressed in entry mode, select the Clear Keypad bit in System Area 
automatically check box on the System tab in the Project Settings dialog box.
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3.1 How the Picture Display is Used

The Picture Display displays pictures. It can change, move, or scale the displayed picture according to value of device 
address.

• Switch and display pictures by value of device address

3 Picture Display

External device
MICRO/I

D0

bit15 bit0bit3

D0= 0100

bit0bit3

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0100

bit0bit3

Pic0Pic1Pic2
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• Switch and display pictures at a regular interval

• Move the picture position by values of device addresses

MICRO/I
Picture List

5 x 100 ms

5 x 100 ms

5 x 100 ms

Pic0

Pic1

Pic2

External device
MICRO/I

Display picture at X 0, Y 0

Move picture to X 300, Y 250

Move picture to X 600, Y 500

X-coordinate D100= 0
Y-coordinate D101=

X-coordinate D100=
Y-coordinate D101=

X-coordinate D100=
Y-coordinate D101=

0

300
250

600
500



3 Picture Display

10-48 WindO/I-NV4 User’s Manual

• Scale the size of the picture by values of device addresses and display it

When the size of pictures to switch differs and the Dynamic Size check box is cleared, all the pictures are 
displayed with the same size as Pic0.

External device
MICRO/I

Shrink picture to 
W 180, H 120

Scale picture to 
W 360, H 240

Scale picture to 
W 720, H 480

Width D100= 180
Height D101=

Width D100=
Height D101=

Width D100=
Height D101=

120

360
240

720
480
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3.2 Picture Display Configuration Procedure

This section describes the configuration procedure for Picture Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Picture Display.

2 Click a point on the edit screen where you wish to place the Picture Display.

3 Double-click the dropped Picture Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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3.3 Properties of Picture Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switching Method
Specifies the method for switching pictures to display from the following. Register pictures in Picture List on the 
View tab.

Bit Number: Switches the picture to display according to the status of bits in a device address.
Example: When Bit Number is selected and the bits of trigger device address D0 are allocated to 

the following pictures.

Switches the picture to display according to the status of the bits.

bit15 bit0bit3

Trigger device address D0

Picture

Pic0Pic1Pic2

0001

Picture to display

Trigger device address 
D0 bit state

0010 0100 1000

Display picture 

for bit 0

Display picture 

for bit 1

Display picture 

for bit 2
No picture

Display picture 

for bit 1

Display picture 

for bit 2
Action

1110 1100

Pic 0 Pic 1 Pic 1Pic 2 Pic 2

If all bits in the device address are 0 or if a bit with 
no associated picture becomes 1, display nothing.

If multiple bits are 1, display the 
picture for the lowest order bit.
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Value: Switches the picture to display according to the value of the device address.
Example: When Value is selected and the trigger device addresses D0 are allocated to the 

following pictures.

Switches the picture to display according to the value of the device address.

Trigger Device Address: Specifies the word device to use as the condition for switching pictures.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
This option can only be configured when Bit Number or Value is 
selected.

0 1 2Trigger device address D0 value

Picture

Pic2Pic1Pic0

Pic 1Pic 0 Pic 2

0

Picture to display

Trigger device address                 

D0 value

1 2 3

Display picture for 0Action Display picture for 1 Display picture for 2 No picture

If the value of device 
address has no picture 
associated with it, display 
nothing.

When the size of pictures to switch differs and the Dynamic Size check box is cleared, all the pictures are 
displayed with the same size as Pic0.

Fixed Period: Switches the pictures to display at a regular interval in picture number order on the picture list.
Example: When Fixed Period is selected and the following pictures are allocated to the picture list.

Switches the pictures to display at a regular interval in picture number order on the 
picture list.

Interval: Specifies the interval to switch pictures as 2 to 600 (100 ms units).
This option can only be configured when Fixed Period is selected.

Repeat: Select this check box to repeat displaying pictures from the start of the picture 
list when the picture at the end of the list is displayed.
This option can only be configured when Fixed Period is selected.

Picture

Picture list number Pic2Pic1Pic0

Picture to display

Action

5 x 100 msInterval

Regular interval

5 x 100 ms

Regular interval

5 x 100 ms

Regular interval

Display picture 
for bit 0

Display picture 
for bit 1

Display picture 
for bit 2

Pic 0 Pic 1 Pic 2

If the Repeat check box is cleared, 
stop switching the picture list.

When Fixed Period is selected, the picture may not be displayed when the interval is shorter than the scan 
time for the screen on the MICRO/I. The maximum value for the MICRO/I scan time can be checked by the 
value of HMI Special Data Register LSD4. Refer to Chapter 28 “HMI Special Data Register (LSD)” on page 
28-5.
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■ Flash
Select this check box to flash the displayed pictures. The picture is repeatedly shown and hidden.

■ Dynamic Position*1

Select this check box to move and display the picture by specifying the coordinates of the picture as values of device 
addresses.

■ Dynamic Size*1

Select this check box to scale the picture by specifying the size of the picture as values of device addresses.

*1 Advanced mode only

X Point: Specifies the word device that is the X-coordinate of the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-64.

Y Point: Specifies the word device that is the Y-coordinate of the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-64.

Example: When a device address for the X-coordinate is D100 and a device address for the Y-coordinate is D101
The picture is moved to the values of D100 and D101.

0
0

300

250

600

500

Position of picture to display

Value of the Y-coordinate 
device address D101

Value of the X-coordinate 
device address D100 0

0

300

250

600

500

Width: Specifies the word device that is the width of the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-64.

Height: Specifies the word device that is the height of the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-64.

Example: When a device address for the width is D100 and a device address for the height is D101
The picture is displayed with its size scaled to the values of D100 and D101.

180

120

360

240

720

480

180

120

360

240

720

480

Size of picture to display

Value of 
Height Device Address D101

Value of 
Width Device Address D100
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When the size of pictures to switch differs and the Dynamic Size check box is cleared, all the pictures are 
displayed with the same size as Pic0.

When moving and scaling pictures, set the values of device addresses so the picture is not moved or scaled 
outside the screen's display area.
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● View Tab

■ Settings
Registers the pictures to display on the Picture Display.

■ Image
Displays picture for the Pic number that has been selected in the Picture List.

■ Coordinates

*1 Advanced mode only

(Pic number - File name)

(Pic number - File name): Registers the pictures to display. 
Double clicking the cell displays the Picture Manager where you can specify the picture. 
The picture number (Pic number) and the file name of the registered picture are displayed.

Remove: Deletes the registered picture from the list.

Up: Shifts the selected settings upward in the list.

Down: Shifts the selected settings downward in the list.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts
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■ Size

W, H: Sets width and height to define the size of parts.

W: 2 to (base screen horizontal size)

H: 2 to (base screen vertical size)

Width

Height

Screen

Parts
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Picture Display is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. 
Select the operation when the condition is not satisfied as Not update Picture data or Not show Picture Display 
under While not satisfying the condition.

■ Trigger Type
Selects the condition to enable the Picture Display from the following.

Example: When Trigger Type is While ON, Device Address is LM0, and While not satisfying the 
condition is Not show Picture Display
While LM0 is 0, the condition is not satisfied and the Picture Display does not display the picture.
While LM0 is 1, the condition is satisfied and the Picture Display displays the picture.

LM0:

MICRO/I

0

LM0: 1

Condition 
Not 

satisfied

Condition 
Satisfied

Show 
picture

Hide 
picture

Always visible: The Picture Display is always enabled.

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update Update Update Update Update Update
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ While not satisfying the condition
Selects operation of parts when condition is not satisfied. 

While ON: Enables the Picture Display when the value of device address is 1.
Example: When While not satisfying the condition is Not update Picture data

While OFF: Enables the Picture Display when the value of device address is 0.
Example: When While not satisfying the condition is Not update Picture data

While satisfying the condition: Enables the Picture Display when the condition is satisfied.
Example: When While not satisfying the condition is Not update Picture data

Value of 
Device Address

1

0

UpdateDo not update Do not update Do not update

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update Update

Value of 
Device Address

1

0

Update Do not update Do not update Do not update Do not update

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update

UpdateDo not update Do not update Do not update

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update Update

Satisfied

Not satisfied

Condition

Not update Picture data: The last updated graphic is displayed. The graphic does not change.
Not show Picture Display: Graphic is not displayed.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Picture Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Message Display is Used

The Message Display is used to constantly display messages registered in advance and to display text read from 
values of word devices as character codes.
The Message Display can perform the following functions.

• Display messages

• Display text according to values of device addresses

4 Message Display

MICRO/I

Goal reached

External device
MICRO/I

Goal

Goal 1234K

Goal 5678K

D100 : 

D101 : 

0031(Hex)

3233(Hex)

D102 : 4B00(Hex)

D100 : 

D101 : 

3132(Hex)‘1’ ‘2’

3334(Hex)

D102 : 4B00(Hex)

D100 : 

D101 : 

3536(Hex)‘5’ ‘6’

3738(Hex)

D102 : 4B00(Hex)

‘4’‘3’

‘K’

‘7’

(NULL) ‘1’

‘3’‘2’

‘8’

(NULL)

‘K’ (NULL)

‘K’ (NULL)

Always show Show according to 

values of device addresses

Goal             \

Message details

Display

D100

D101

D102

Display only always shown text

Do not show if upper byte of the source device 

address starting address number is 00 (NULL)

Value of 
Source Device Address

Action

Display always shown text and text shown 

according to values of device addresses

Display always shown text and text shown 

according to values of device addresses

4B00(Hex)

3233(Hex)

0031(Hex)

4B00(Hex)

3334(Hex)

3132(Hex)

4B00(Hex)

3738(Hex)

3536(Hex)

‘3’ ‘4’

‘1’

‘7’ ‘8’

‘5’

‘2’ ‘3’

(NULL)

‘M’

‘6’‘2’ ‘1’

‘K’ (NULL) ‘K’ (NULL) ‘K’ (NULL)

GoalGoal     1234K Goal   5678K
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• Scroll messages

• Change the message and plate color according to a value of device address

MICRO/I

Line A

A : 1234K pcs.

pcs.        Line B

8K pcs.

Message details

Line A : 1234K pcs.            Line B : 5678K pcs.

External device
MICRO/I

HG SERIES

HG SERIES

D0：

D0：

D0：

D0：

Lower byteUpper byte

0 x 0 0

Lower byteUpper byte

0 x F 7

Lower byteUpper byte

0 x 9 00 x F 7

0 x 0 00 x F 7

Lower byteUpper byte

0 x 9 00 x F 7

Text colorPlate color

Text colorPlate color
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4.2 Message Display Configuration Procedure

This section describes the configuration procedure for Message Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Message Display.

2 Click a point on the edit screen where you wish to place the Message Display.

3 Double-click the dropped Message Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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4.3 Properties of Message Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Use Text Manager
Select this check box to use text registered in Text Manager.

■ Text ID
Specifies the Text Manager ID number (1 to 32000) when using text registered in Text Manager.

Click  to display Text Manager.

This option can only be configured when the Use Text Manager check box is selected.

To read values of word devices as character codes with text registered in Text Manager and display it as 
text, enter “\@” (1 to 8) in Text for the Text ID at the position to display the value of device address as 
text. The channels configured under Data are allocated in order from the first “\@”. The text is displayed 
according to the values of device addresses in order from the first reference device address.
However, in the following situations “\@” is not handled as text to display according to values of device 
addresses and is displayed unchanged.
• When Font is Windows for Text ID configured in Text Manager
• When the number of “\@” configured in Text for Text ID is greater than the number of channels 

configured with device addresses
(Text for the character codes corresponding to the values of device addresses is only displayed for the 
number of channels in order from the beginning.)
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■ Message
Enter the text to display. The maximum number is 610 characters. You can enter multi-line messages by inserting a 
newline. To configure text to display according to values of device addresses, enter “\@” (1 to 8) at the location to 
read the values of word devices as character codes and display them as text. The channels configured under Data 
are allocated in order from the first “\@”. The text is displayed according to the values of device addresses in order 
from the first reference device address.
Example: The device configured in Ch1 is allocated to the first “\@”. The device address configured in Ch2 is allocated 

to the second “\@”.

The characters that can be entered vary based on to the font selected for Font on the Format tab. For details, refer 
to Chapter 2 “1.2 Available Text” on page 2-5.
This option can only be configured if the Use Text Manager check box is cleared.

■ Data
These options are used to register or edit the device addresses with values to read as character codes.

Now     \

Goal     \

Always show Show according to values of device addresses

Ch1

Ch2

To display the backslash (\), enter a backslash (\) before the backslash (\).
Example:\\

(Settings): Lists the settings for the text to display according to values of device addresses.

No.: Shows the channel numbers (Ch1 to Ch8).

Device Address: Specifies the word device that stores the values read as character codes.
Double clicking the cell displays the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-64.
Set the value of device address to the character codes for the language 
used. For details, refer to Chapter 2 “Character Code Table” on page 2-15.

Words: Specifies the number of words for the length of the text to display (1 to 64). 
Double clicking the cell allows you to change the Words.
Values of device addresses for the configured amount of words are read as 
character codes starting from the device address set by Device Address. 2 
single-byte characters can be displayed by 1 word.

Remove: Deletes the registered settings from the list.

Up: Shifts the selected settings upward in the list.

Down: Shifts the selected settings downward in the list.

You can register the settings from arbitrary numbers, they are aligned filled from the beginning after clicking 
OK on the dialog box. Therefore, when the Properties dialog box is closed and reopened, the list is 
displayed filled from the beginning.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Stroke
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, or 
Cyrillic is selected for Font.

■ Magnification

Can only be set when Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, or 
Cyrillic is selected for Font.

■ Align Text Horizontal
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right, Center-Left, Left-Right
If Top, Center or Bottom is selected for Align Text Vertical, Center or Right can be set as this option.
If Center-Top is selected for Align Text Vertical, Center-Left or Left-Right can be set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects the text alignment in the vertical direction from the following.
Top, Center, Bottom, Center-Top
Set to Center when the Vertical Writing check box is selected.
For details, refer to Appendix “5 Text Alignment” on page A-7.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Vertical Writing
Select this check box when displaying text vertically.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic, or Cyrillic.

■ Align Text depending on the length of the displayed message*1

Select this check box to align text as standard to the number of characters that will be displayed.
When cleared, the maximum number of characters (set number of words) is always aligned as standard.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

*1 Advanced mode only

When the Vertical Writing check box is selected, take care about the following points. This is applicable 
for Windows supports East Asian characters.
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left-

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

• When using text displayed according to values of device addresses, the characters are counted as single-
byte characters and the display area for the characters is indicated by dotted lines. Therefore, when the 
text to display according to values of device addresses is double-byte characters, the display area 
actually required differs from the area indicated by the dotted lines.
Example: When 1 word of text to display according to values of device addresses is set to vertical writ-

ing, the vertical size of the dotted lines is displayed as 2 single-byte characters.

Aligned to 
le� edge

Horizontal
display

Next
characters

2 single-byte chars. 1 double-byte char.

Dotted line frame is
2 chars. High

Example: When there are 2 characters of text to always display on the first line, 6 characters of text to always display 
on the second line and 6 characters of text (3 words) to display according to values of device addresses, 
Align Text Horizontal is set to Center, and the text to display according to values of device addresses is 
blank (when only 6 characters are always displayed on the second line)

Check box: ClearedCheck box: Selected

Always show Show according to
values of devices

EFCDAB EFCAB
AB

AB

D EFCAB
AB

D

Characters to show Maximum characters

1st line text :

2nd line text :

Blank
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■ Scroll*1

Select this check box to enable scrolling display displaying of messages.
This option can only be configured when the Flash check box is cleared and Standard is selected for Image Type 
on the View tab.

■ Change Display Colors
To switch the text and plate colors, select this check box and select the method to the display colors from the 
following.

*1 Advanced mode only

Speed (1: Fastest): Sets the scrolling speed (1 to 10). 1 is fastest, 10 is slowest.

When the Scroll check box is selected operation is follows.
• Messages that include CRs are displayed without the CRs.
• Messages scroll in the direction in which the text is drawn.
• When the text displayed according to values of device addresses, the text color, or the displayed text 

changes, the message is scrolled top the beginning.

• When the Scroll check box is selected, the number of parts that can be arranged on a single screen 
decreases. If the MICRO/I displays an error message, clear the Scroll check box, or reduce the number 
of parts on the screen.

• When the scan time for the screen becomes longer, and when the part that has its Scroll check box 
selected is placed on the top layer, the scrolling speed may become slow.

Specify Color: Switches the text and plate to the specified colors.

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color under the Specify Color.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

HG SERIES

HG SERIES

0

1

Trigger Device Address

Trigger Device Address

External device

Text Color

Plate Color on the View tab

Text Color under Specify Color

Plate Color under Specify Color
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Specify Color by Device Address: Specifies the text and plate colors by the value of the device 
address.

Device Address: Specify the word device that stores the color data for the text or plate.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
This uses address number+1 to specify the text and plate colors when the 
Flash check box has been selected.
Color data assignments that are stored to device addresses are given below.

For color data, refer to Appendix “1 Color Number” on page A-1.

D0=

Lower byteUpper byte

0 x 0 0

Lower byteUpper byte

0 x F 7

D0=

Lower byteUpper byte

0 x 1 40 x 1 6

D0 0 x 0 00 x F 7

Lower byteUpper byte

D0 0 x 1 40 x 1 6

HG SERIES

HG SERIES

MICRO/IExternal device

Text colorPlate color

Text colorPlate color

Device Address

bit bit
15 8

bit
7

bit
0Upper byte

Plate color

Device Address
Text color

Plate color when flashingDevice Address+1 Text color when flashing

Lower byte

HG SERIES

HG SERIES

Flashing

Lower byteUpper byte

0 x 1 40 x 1 6

Lower byteUpper byte

0 x F 70 x 2 3

Text colorPlate color

Device Address

Device Address+1

Text color 
when flashing

Plate color
when flashing
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected, Specify Color is selected and the value of the trigger device 
address for Specify Color is 0, then the colors specified by Text Color and Plate Color on the View tab and the 
colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected, Specify Color is selected and the value of the trigger device 
address for Specify Color is 1, then the colors specified by Text Color and Plate Color under Specify Color 
and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Trigger device address under
Specify Color

Trigger device address under
Specify Color

0

0

1

0

Flashing
1

Trigger device address under
Specify Color

Trigger device address
under Flash

Trigger device address under
Specify Color

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color under 
Specify Color
Plate Color under 
Specify Color

Text Color under Specify Color

Plate Color under Specify Color

Text Color under Flash

Plate Color under Flash
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• The Change Display Colors check box is selected, Specify Color by Device Address is selected, then the 
colors that correspond to the values stored in the device addresses for Specify Color by Device Address and 
this device address number+1 are alternately displayed.

Trigger Device Address: Specifies the bit device or bit number of the word device that will be used to trigger flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when the Change Display Colors check box is cleared 
or selected and Specify Color is selected.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when the Change Display Colors check box is cleared, 
or the check box and Specify Color are selected, and Standard is selected for Image 
Type on the View tab.

HG SERIES

HG SERIES

Flashing

MICRO/IExternal device

HG SERIES

HG SERIES

Lower byteUpper byte

D0 0 x 1 40 x 1 6

Lower byteUpper byte

D1 0 x F 70 x 2 3

Text colorPlate color

Text color 
when flashing

Plate color
when flashing

0

1

D0=

Lower byteUpper byte

0 x 1 40 x 1 6

D1= 0 x F 70 x 2 3

Trigger device

Device Address for
Specify Color by Device Address

Trigger device address
under Flash

Trigger device address
under Flash

Device Address+1
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Message Display is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. 
Select the operation when disabled as Not display message or Not show Message Display under While not 
satisfying the condition.

■ Trigger Type
Selects the condition to enable the Message Display from the following.

Example: When Trigger Type is While ON, Device Address is LM0, and While not satisfying the condition is 
Not display message.
While LM0 is 0, the condition is not satisfied and the Message Display does not display the message.
While LM0 is 1, the condition is satisfied and the Message Display displays the message.

LM0:

MICRO/I

0

LM0: 1
HG SERIES

Condition 
Not 

satisfied

Condition 
Satisfied

Show 

Hide

Always visible: The Message Display is always enabled.

While ON: Enables the Message Display when the value of device address is 1.
Example: When While not satisfying the condition is Not display message.

Message Display 
state

Always show message

HG SERIES

1

0

Show 
message

Hide 
message

Hide 
message

Hide 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Value of
Device Address

Message Display 

state
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ While not satisfying the condition
Selects the operation of the part when the condition is not satisfied.

While OFF: Enables the Message Display when the value of device address is 0.
Example: When While not satisfying the condition is Not display message.

While satisfying the condition:
Enables the Message Display when the condition is satisfied.
Example: When While not satisfying the condition is Not display message.

Value of
Device Address

1

0

Show 
message

Hide 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Hide 
message

Hide 
message

Hide 
message

Message 

Switching Display 

state

Show 
message

Hide 
message

Hide 
message

Hide 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Message Display 
state

Satisfied

Not satisfied

Condition

Not display message: The plate and flange are displayed, but the message is not displayed.

Not show Message Display: Hides the Message Display.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Message Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.4 String Data Storage Method

The values of device addresses read as character codes are stored in the upper byte and lower byte of words 
according to the Storage Method of String Data setting. Storage Method of String Data is configured on the 
System tab in the Project Settings dialog box.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-13.

Example: When reference device address D100 = 3132 (Hex), D101 = 3334 (Hex), D102 = 3500 (Hex)

• When from Upper byte is selected for Storage Method of String Data

• When from Lower byte is selected for Storage Method of String Data

NULL terminating character

Device address
Stored value

Displayed string
Upper byte Lower byte

D100 31 (Hex) 32 (Hex) 12
D101 33 (Hex) 34 (Hex) 34
D102 35 (Hex) 0 5

NULL terminating character

Device address
Stored value

Displayed string
Upper byte Lower byte

D100 32 (Hex) 31 (Hex) 21
D101 34 (Hex) 33 (Hex) 43
D102 0 35 (Hex)

When handling values of device addresses as character 

codes, 0 is handled as the NULL terminating character 

to end the string. Therefore, when the upper byte is 0, 

nothing is displayed.

• When handling values of device addresses as character codes, 0 is handled as the NULL terminating 
character to end the string. Therefore, when the upper byte is 0, nothing is displayed.

• To display only a single character, set the lower byte to 0.
Example: To display a single-byte 7

              3700(Hex)‘7’
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5.1 How the Message Switching Display is Used

The Message Switching Display is used to switch the displayed message according to the value of a word device.

5 Message Switching Display

MICRO/I
External device

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0100

bit0bit3

D0

bit15 bit0bit3

Msg0 Drying

Heating

Cooling

Msg1

Msg2

Message details
Drying

Heating

Cooling
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5.2 Message Switching Display Configuration Procedure

This section describes the configuration procedure for Message Switching Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Message Switching Display.

2 Click a point on the edit screen where you wish to place the Message Switching Display.

3 Double-click the dropped Message Switching Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab and Trigger Condition tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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5.3 Properties of Message Switching Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switching Method
Selects the method for switching message to display from the following. Messages are registered in Settings on the 
Message tab.

Bit Number: Switches the message to display according to the status of bits in a device address.
Example: When Bit Number is selected and the bits of trigger device address D0 are allocated to the 

following messages.

Switches the message to display according to the status of the bits.

bit15 bit0bit3

Trigger device address D0 

Msg0 Drying

Heating

Cooling

Msg1

Msg2

Message

0001

Message to display

0010 0100 1000

Display Msg0Action Display Msg1 Display Msg2

1110

Display Msg1No message

Msg0 Msg1 Msg2 Msg1

Bit state of 
Trigger Device Address D0

Drying Heating Cooling Heating

If all bits in the device address are 0 or if a 
bit with no associated message becomes 1, 
display nothing.

If multiple bits are 1, display the 
message for the lowest order bit.
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■ Trigger Device Address
Specifies the word device to use as the condition for switching messages.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

Value: Switches the message to display according to the value of a device address.
Example: When Value is selected and the trigger device addresses D0 are allocated to the following 

messages.

Switches the message to display according to the value of the device address.

0 :

1 :

2 :

Value of Trigger Device Address D0 Msg0 Drying

Heating

Cooling

Msg1

Msg2

Message details

0

Message to display

1 2 3

Display Msg0Action Display Msg1 Display Msg2 No message

Msg0 Msg1 Msg2

Value of 
Trigger Device Address D0

Drying Heating Cooling

If the value of device address has no message
associated with it, display nothing.
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● Message Tab

■ Use Text Manager
Select this check box to use text registered in Text Manager.

■ Settings
Edits the message settings.

■ Remove
Deletes the registered settings from the list.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

No.: Shows the message number (Msg number).
The number of messages that can be registered varies based on Switching Method on the General tab.

Bit Number: Msg0 to Msg15

Value: Msg0 to Msg999

Message: Enter the text to display.
Double clicking the cell allows to edit the Message. The maximum number is 3750 characters. You can 
enter multi-line messages by inserting a newline.
The characters that can be entered vary based on the font selected for Font on the Format tab. For 
details, refer to Chapter 2 “1.2 Available Text” on page 2-5.
This option can only be configured if the Use Text Manager check box is cleared.

• To display the backslash (\), enter a backslash (\) before the backslash (\).
• A line feed is added with pressing and holding ALT and ENTER keys.

Change: Selects whether or not to configure Text and Plate per Msg number. For N, the colors are configured by 
Text Color on the Format tab and Plate Color on the View tab.
Double clicking the cell toggles between Y as Yes and N as No.

Text: Selects the text color for the messages when configuring the text color per Msg number (color: 256 colors, 
monochrome: 16 shades).
Double clicking the cell displays the Color Palette where you can change the Text Color.

Plate: Selects the plate color for the messages when configuring the plate color per Msg number
(color: 256 colors, monochrome: 16 shades).
Double clicking the cell displays the Color Palette where you can change the Plate Color.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Stroke
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, or 
Cyrillic is selected for Font.

■ Magnification

Can only be set when Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, or 
Cyrillic is selected for Font.

■ Align Text Horizontal
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right, Center-Left, Left-Right
If Top, Center or Bottom is selected for Align Text Vertical, Center or Right can be set as this option.
If Center-Top is selected for Align Text Vertical, Center-Left or Left-Right can be set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects the text alignment in the vertical direction from the following.
Top, Center, Bottom, Center-Top
Set to Center when the Vertical Writing check box is selected.
For details, refer to Appendix “5 Text Alignment” on page A-7.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Vertical Writing
Select this check box when displaying text vertically.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic, or Cyrillic.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Scroll*1

Select this check box to enable scrolling display displaying of messages.
This option can only be configured when Standard is selected for Image Type on the View tab and the Flash 
check box is cleared.

*1 Advanced mode only

When the Vertical Writing check box is selected, take care about the following points. This is applicable 
for Windows supports East Asian characters.
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left-

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

Aligned to 
le� edge

Horizontal
display

Next
characters

Speed (1: Fastest): Sets the scrolling speed (1 to 10). 1 is fastest, 10 is slowest.

When the Scroll check box is selected operation is follows.
• Messages that include CRs are displayed without the CRs.
• Messages scroll in the direction in which the text is drawn.
• When the message is switched, the message is scrolled from the beginning.

• When the Scroll check box is selected, the number of parts that can be arranged on a single screen 
decreases. If the MICRO/I displays an error message, clear the Scroll check box, or reduce the number 
of parts on the screen.

• When the scan time for the screen becomes longer, and when the part that has its Scroll check box 
selected is placed on the top layer, the scrolling speed may become slow.
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■ Change Display Colors
Select this check box to switch the text and plate colors.

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color
under the Change Display Colors.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

0

1

Trigger Device Address

Trigger Device Address

External device

HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color under Change Display Colors

Plate Color under Change Display Colors
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 0, then the colors specified by Text Color and Plate Color on the View tab and the colors 
specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 1, then the colors specified by Text Color and Plate Color under Change Display Colors 
and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Trigger device address under
Change Display Colors

Trigger device address under
Change Display Colors

0

0

1

0

Flashing
1

Trigger device address under
Change Display Colors

Trigger device address
under Flash

Trigger device address under
Change Display Colors

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color under 
Change Display Colors
Plate Color under 
Change Display Colors

Text Color under Change Display Colors

Plate Color under Change Display Colors

Text Color under Flash

Plate Color under Flash
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Trigger Device Address: Specifies the bit device or the bit number of the word device that will be used to trigger 
flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Visible Condition
The Message Switching Display is displayed while the condition is satisfied. The Message Switching Display is hidden 
while the condition is not satisfied.

Example: When Trigger Type is While ON and Device Address is LM0
While LM0 is 0, the condition is not satisfied and the Message Switching Display is hidden.
While LM0 is 1, the condition is satisfied and the Message Switching Display is displayed.

LM0:

MICRO/I

0

LM0: 1
HG SERIES

Condition 
Not 

satisfied

Condition 
Satisfied

Show 

Hide
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Trigger Type: Selects the condition to display the Message Switching Display from the following.

Always visible: The Message Switching Display is always displayed.

While ON: Displays the Message Switching Display when the value of device address is 1.

While OFF: Displays the Message Switching Display when the value of device address is 0.

While satisfying the condition:

Displays the Message Switching Display when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Message 
Switching Display

state

HG SERIES

HG SERIES HG SERIES HG SERIES

1

0

Hide Show Hide HideShow Show

Value of
Device Address

Message 
Switching 

Display state

HG SERIES HG SERIES HG SERIES

Value of 
Device Address

1

0

Show Show ShowHide Hide Hide

Message 
Switching 

Display state

HG SERIES HG SERIES HG SERIES

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Message 
Switching Display 

state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Message Switching Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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6.1 How the Alarm List Display is Used

The Alarm List Display works with the Alarm Log function to display messages for active alarms and to display 
multiple messages according to values of device addresses in a list.

• List currently active alarms out of the alarms configured in the Alarm Log settings

• Display multiple messages according to values of device addresses

6 Alarm List Display

• Only one Alarm List Display or Alarm Log Display can be configured on a single screen.
• When the active alarm is displayed on the Alarm List Display, the message disappears from the list when 

the alarm is recovered from regardless of the Lock/Unlock setting. To display the alarm message until it 
can be checked, use the Alarm Log Display. Lock/Unlock is configured on the Channel tab in the 
Alarm Log Settings dialog box.

• For the key buttons used with the Alarm List Display, refer to Chapter 8 “Alarm List Display” on page 8-85.
• The number of the message (channel when using the Alarm function) that has focus on the Alarm List 

Display is stored in HMI Special Data Register LSD50.
• The information about where on the list the message that has focus is displayed, out of all the messages 

displayed on the Alarm List Display, is stored in HMI Special Data Register LSD56.

MICRO/I
External device

Current fault Pg. Up

Pg. Dwn

Pump fault
Low air pressure

Pg. Up

Pg. Dwn

D0-0 : 
D0-1 : 
D0-2 : 
D0-3 : 

ID1 Current fault
ID2

ID3

ID4

Pump fault

High pressure

Low air pressure

Message

D0-0
Alarm occurred

0 1

D0-0

D0-1
Alarm occurred

0 1

D0-1

D0-3
Alarm occurred

0 1

D0-3

MICRO/I
External device

Setting 1 : 100 Pg. Up

Pg. Dwn

Setting 1 : 100
Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

D0= 0001

bit0bit3

D0= 0111

bit0bit3

D0

bit15 bit0bit3

ID1 Setting 1 : 100
ID2

ID3

Setting 2 : 200

Setting 3 : 300

Message
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6.2 Alarm List Display Configuration Procedure

This section describes the configuration procedure for Alarm List Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Alarm List Display.

2 Click a point on the edit screen where you wish to place the Alarm List Display.

3 Double-click the dropped Alarm List Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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6.3 Properties of Alarm List Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Message Settings
Selects the method for switching message to display.

The active alarm messages are displayed.

Use Alarm Log Settings: Displays messages for the active alarms. The alarms are configured by the Alarm Log 
settings.

Alarm Log Settings: Displays the Alarm Log Settings dialog box.

New Message List: Displays the messages registered in Text Manager according to the state of bits in the 
trigger device address configured on the List tab.

Example: When Use Alarm Log Settings is selected, the source device address (device address to monitor) 
configured by the Alarm Log function is D0, and the following messages are allocated to the channels

D0-0 : 

D0-1 :  

D0-2 :  

D0-3 :  

ID1 Current fault

ID2

ID3

ID4

Pump fault

High pressure

Low air pressure

Message

Source device address

Message to display

Bit state of Source device address

D0-0

Display ID1Action Display ID2, ID3

1 0 1 1 0

D0-1 0 1 0 1 0

D0-2 0 1 1 1 0

D0-3 0 0 1 1 0

No message
Display ID1, ID2, 

ID3, ID4
Display ID1, ID3, 

ID4

Current fault Pg. Up

Pg. Dwn

Pg. Up

Pg. Dwn

Pump fault
High pressure

Pg. Up

Pg. Dwn

Current fault
High pressure
Low air pressure

Pg. Up

Pg. Dwn

Current fault
Pump fault
High pressure
Low air pressure

Pg. Up

Pg. Dwn

If all bits in the device address are 0 or if a bit with no 
associated message becomes 1, display nothing.
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The messages are displayed according to the state of the bits.

■ Display Type
Selects whether or not to simultaneously display multiple messages.

■ Monitor Number of Displayed messages
Select this check box to count the number of displayed messages.
This option can only be configured when the New Message List check box is selected.

Example: When New Message List is selected and the bits of trigger device address D0 are allocated to the 
following messages.

Trigger device address D0 

bit15 bit0bit3

ID1 Setting 1 : 100
ID2

ID3

Setting 2 : 200

Setting 3 : 300

Message

0001

Message to display

0110 0101 0111 0000

Display ID1 Display ID2, ID3 Display ID1, ID3 No messageAction
Display ID1, ID2, 

ID3

Bit state of Trigger device address D0

Setting 1 : 100 Pg. Up

Pg. Dwn

Pg. Up

Pg. Dwn

Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

Setting 1 : 100
Setting 3 : 300

Pg. Up

Pg. Dwn

Setting 1 : 100
Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

If all bits in the device address are 0 or if a bit with no 
associated message becomes 1, display nothing.

List: Simultaneously displays multiple messages.

Sort: Selects the display order when displaying multiple messages.
Old and New can only be configured when the Use Alarm Log Settings check box is 
selected.

Ascending: Sorts the list in alphabetic order from A to Z.

Descending: Sorts the list in alphabetic order from Z to A.

Old: Sorts the list in order from oldest to newest.

New: Sorts the list in order from newest to oldest.

One Line: Displays only a single message.
When multiple bits are 1, the message for the lowest order bit is displayed.

Message to display

0111

Action
Display ID1, ID2, 

ID3

Bit state of Trigger device address D0

Setting 1 : 100
Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

0111

Message to display

Display ID1Action

Setting 1 : 100 Pg. Up

Pg. Dwn

Bit state of Trigger device address D0

(Destination Device Address): Specifies the word device to write the number of displayed messages to.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
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● List Tab
The List tab is only displayed when New Message List is selected for Message Settings on the General tab.

■ Number of Blocks
Configures the device addresses that trigger messages to display and message switching as blocks (1 to 64).

■ Start Text ID
Specifies the Text Manager ID number (1 to 32000) of the message to display. The text ID numbers are sequentially 

configured for all channels from the first block starting with the ID number configured here. Click  to display Text 
Manager.

■ Device Address Setting Method
Selects the trigger device address setting method.

■ (Block settings)
Registers and edits the messages to display for each block channel.

(Block settings)

1 block is composed of 16 channels. 1 device address bit can be monitored for each channel. The maximum 
number of device address bits that can be monitored is 16 for each block.

Serial: The trigger device addresses after the block number selected in the block settings are configured 
with sequential addresses.

Random: Configures trigger device addresses for each block number.

Block No.: Shows the block numbers in the amount specified by Number of Blocks.
Double clicking the cell displays the Individual Settings dialog box. For details, refer to 
“Individual Settings Dialog Box” on page 10-102.

Trigger Device Address: Shows the word device to use as the condition to display messages.
Double clicking the cell displays the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
When Serial is selected for Device Address Setting Method, the trigger device 
addresses for block numbers after the selected block number are automatically configured 
with the configured trigger device address as the starting address.

No. of Reg. Text: Shows the number of messages registered to the block.
Double clicking the cell displays the Individual Settings dialog box. For details, refer to 
“Individual Settings Dialog Box” on page 10-102.

Edit: Changes the block settings in list.
Select a block number in the list and click this button to display the Individual Settings 
dialog box. For details, refer to “Individual Settings Dialog Box” on page 10-102.
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Individual Settings Dialog Box

The Individual Settings dialog box is used to configure the conditions to display the messages.

■ Trigger Device Address
Specifies the word device to use as the condition to display messages. The word device bits correspond to the 
message numbers.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
When Serial is selected for Device Address Setting Method on the List tab, the trigger device addresses for block 
numbers after the block number being registered or edited are automatically changed with the configured trigger 
device address as the starting address.

■ (Settings)

Insert: Inserts the block settings in the position selected on the list.
Select the block number at the position to insert the settings in the list and click this button 
to display the Individual Settings dialog box. For details, refer to “Individual Settings 
Dialog Box” on page 10-102.
The settings at the insertion point shift down one line. Settings cannot be inserted if all 
block numbers are configured.

Delete: Deletes the registered settings from the list.
Select a block number on the list and click this button to delete the selected settings from the list.

(Settings)

Example: When the number of blocks is 1 and D0 is specified as the trigger device address
Message number 1-0 device address bit is D0-0, message number 1-1 device address bit is D0-1, up to 
message number 1-15 device address bit which is D0-15.

D0-0
D0-1
D0-2

D0-14
D0-15

1-0
1-1
1-2

1-14
1-15

Block 1
16 channels

Msg. No. Device bit

Msg. No.: Displayed as (Block No.)-(Message No.).
Alarm function: Selects whether or not to use the alarm function. Double clicking the cell switches between Enable 

and Disable.
Enable: Monitors the state of the device address bit configured for the channel and displays the 

message.
Disable: The device address bit is not monitored and the message is not displayed.

NO/NC: Selects the alarm detection condition. Double clicking the cell switches between NO and NC.
NO: Displays the message when the monitored bit changes from 0 to 1.
NC: Displays the message when the monitored bit changes from 1 to 0.

Text ID: Shows the Text Manager ID number (1 to 32000) to use for the message.
The text ID is sequentially configured starting with the text ID configured by Start Text ID on the 
List tab.

Text: Shows the text for the specified text ID.
Only shows the first line of text when the text registered to the text ID has multiple lines.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Line Color
When lines are displayed, select this check box and select line color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Lines

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 colors, 
monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Buttons

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the button.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation 
from the Pattern Palette.

ButtonsButtons

Can be set only when there are grouped Key Buttons.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Display with Same Text Color
To set the text color for all messages to the same color, select this check box and select the text color to display 
(color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
When this check box is cleared, the color for messages is the text color configured in Text Manager.

W, H: Selects text magnification (0.5, 1 to 8).



6 Alarm List Display

10-106 WindO/I-NV4 User’s Manual

■ Line Spacing*1

Selects the specification method for line spacing in the list and configures the line spacing.

*1 Advanced mode only

Set with Number of Lines: Specifies the number of lines for the message to display for one alarm line.

Number of Lines: Enter the number of lines (1 to 12). To completely display a message that 
contains newlines, a number of lines that is equal to or greater than the number 
of message lines is required.

When you enter a value in Number of Lines, Height (dots) is automatically calculated according 
to the display area.
The relationship between the number of lines and the height (dots) is height (dots) = number of 
lines x magnification H x 16.

Number of Lines Magnification H Height
1 1× × 16 = 16 dots

Current fault 

Current fault 

has occurred
Pump fault 

Pump fault 

has occurred

2 1× × 16 =

Current fault 
has occurred

Pump fault 
has occurred

3 1× × 16 =

Current fault 
has occurred

has occurred
Pump fault 

3 2× × 16 =
Number of Lines Magnification H Height

Number of Lines Magnification H Height

32 dots

48 dots

Number of Lines Magnification H Height

96 dots

When the message is 2 lines, 
2nd line is not shown.

Since the alarm line spacing is adjusted with the number of lines for the message fixed, this option is 
convenient to use when displaying multi-line messages.

Set with Dots: Specifies the line spacing for the message to display for one alarm line in dots.

Height (dots): Enter the height (8 to 237). To completely display a message, a height equal to or 
greater than Magnification H x 16 dots x the number of message lines is required.

When Magnification H is 1
To display a one-line message, 1 x 16 = 16 dots, a height of 16 dots or higher is required.

To display a two-line message, 2 x 16 = 32 dots, a height of 32 dots or higher is required.

When Magnification H is 2
To display a one-line message, 1 x 32 = 32 dots, a height of 32 dots or higher is required.

To display a two-line message, 2 x 32 = 64 dots, a height of 64 dots or higher is required.

16 dots
Height

Current fault has occurred
Pump fault has occurred

Height Height
16 dots32 dots Current fault has occurred

has occurred

Pump fault 
Current fault 

Pump fault 

When the message is 2 lines, 
2nd line is not shown.

Height

32 dots Current fault has occurred
Pump fault has occurred

Height

32 dots Current fault Current fault 
Pump fault 

Pump fault 

Height

64 dots

has occurred

has occurred

When the message is 2 lines, 
2nd line is not shown.
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■ Scroll*1

Select this check box to enable scrolling display displaying of messages.
Can only be set when One Line is selected for Display Type under the General tab.
For Alarm List Display, this can only be set if One Line is selected for Display Type under the General tab.

*1 Advanced mode only

Speed (1: Fastest): Sets the scrolling speed (1 to 10). 1 is fastest, 10 is slowest.

When the Scroll check box is selected operation is follows.
• Messages that include CRs are displayed without the CRs.
• Messages scroll in the direction in which the text is drawn.
• When the text displayed according to values of device addresses, the text color, the displayed text, or the 

alarm state changes, the message is scrolled from the beginning.

• When the Scroll check box is selected, the number of parts that can be arranged on a single screen 
decreases. If the MICRO/I displays an error message, clear the Scroll check box, or reduce the number 
of parts on the screen.

• When the scan time for the screen becomes longer, and when the part that has its Scroll check box 
selected is placed on the top layer, the scrolling speed may become slow.
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● Options Tab

The Options tab is displayed in Advanced mode.

■ Reference Screen
The Options tab is used to configure the reference screen. The reference screen is a base screen or popup screen 
associated with each individual message. The reference screen is displayed when the key button Ref. is pressed.

When displaying a reference screen, select either Base Screen or Popup Screen as the reference screen type.
When not displaying a reference, select Not Use.
This can only be set when New Message List has been selected in Message Settings on the General tab. When 
Use Alarm Log Settings has been selected, the screen type will become the one selected in Reference Screen on 
the Channel tab in the Alarm Log Settings dialog box.

■ Coordinates

(Reference screen list)

Motor fault

Pump1 fault

REV

Up

Dwn

Del

Ref.

High pressure

Pump 1 fault

Motor fault

Pump1 fault

REV

Up

Dwn

Del

Ref.

High pressure

Pump 1 fault

Motor fault

Pump1 fault

REV

Up

Dwn

Del

Ref.

High pressure

Pump 1 fault

Key bu�on Ref. Reference screenKey bu�ons Up and Down

1. Select a message displayed 
on the Alarm List Display 2. Press the key bu�on Ref. Reference screen opens

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

X, Y: Specifies the coordinates to display the reference screen.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-left corner of the 
reference screen.
This option can only be configured when Base Screen or Popup Screen is selected for Reference Screen.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)



WindO/I-NV4 User’s Manual 10-109

6 Alarm List Display

10

D
ata D

isplays

■ Screen Number Setting Method
Selects the setting method for the screen numbers on the reference screen list.

■ (Reference Screen List)
Displays a list reference screen numbers and screen titles that have been set to messages.

Serial: Continuously and automatically specifies screen numbers (1 to 3000) that are at or below the 
selected message number.

Example 1: When screen number “100” has been entered for message number 1-0.

Screen numbers “100”, “101”, “102”....are automatically specified in order from message 
number 1-0.

Example 2: When screen number “200” has been entered for message number 1-5.

Message numbers 1-0 to 1-4 are left unchanged and screen numbers “200”, “201”, 
“202”....are automatically specified in order from message number 1-5.

Random: Specifies a reference screen number (1 to 3000) for each message number.

Message No.: Displays the message number.

Screen No.: Displays the reference screen number.
Double clicking the cell allows you to change the screen number (1 to 3000).

When there is not screen for the specified screen number a message confirming the creation of a new 
screen will appear.
If Yes is clicked, a screen will be created but if No is clicked, you will be returned to the Options screen 
without creating a screen.

Title: Displays the title of a reference screen.
Double clicking the cell allows you to edit the title. The maximum number is 40 characters.
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■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

• The security group for input can only be configured when there are grouped key buttons.
• For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on 

page 21-1.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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Since the display security group is Group A, User 2 (of Group A) can view the buttons. But since the input security 
group is Group B, User 2 cannot operate the buttons.
Suppose that the Password Screen is now opened and a switch is made to User 3, who is part of both Group A and 
Group B. Group A buttons can be displayed, and Group B buttons can be operated.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Alarm List Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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7.1 How the Alarm Log Display is Used

The Alarm Log Display displays Alarm Log data saved in the data storage area.

• List the message, the occurrence time, recovery time, and confirmation time for the alarms that have occurred

• Display the reference screen for alarms that have occurred

7 Alarm Log Display

Occurrence    Message   Recovered   Confirmed
12/01 12 : 00     Current fault        12 : 53              12 : 54

MICRO/I

External device

Occurrence    Message   Recovered   Confirmed
12/01 12 : 00     Current fault        12 : 53              12 : 54

Up Down CheckSelect Delete

Up Down CheckSelect Delete

0 1

12 : 00

01

12 : 53

12 : 00
Alarm occurred

12 : 53     Recovered

12 : 54      Confirmed

Recovery time

Confirmation time

Message

Occurrence time

Show focus Move focus

Key Bu�on

Display reference screen

Time

09:15   Motor fault

Message

10:02   Pump1 fault

Slct

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Slct SlctSlct

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Reference screen

Only one Alarm List Display or Alarm Log Display can be displayed in a screen.

• For the key buttons used with the Alarm Log Display, refer to Chapter 8 “Alarm Log Display” on page 8-
85.

• When the Operate the Alarm on List directly check box on the General tab in the Properties of 
Alarm Log Display dialog box is selected, a displayed alarm can be given focus by pressing it on the list.

• The number of lines from the start line to the selected line of the message displayed on the Alarm Log 
Display is stored in HMI Special Data Register LSD56.
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7.2 Alarm Log Display Configuration Procedure

This section describes the configuration procedure for Alarm Log Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Alarm Log Display.

2 Click a point on the edit screen where you wish to place the Alarm Log Display.

3 Double-click the dropped Alarm Log Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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7.3 Properties of Alarm Log Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Alarm Log Settings
Displays the Alarm Log Settings dialog box.

■ Default Settings
These options configure the default settings when the Alarm Log Display is displayed.

■ Displaying Alarms*1

Select these check boxes for alarms to display on the Alarm Log Display.

*1 Advanced mode only

Start Line Number: Specifies what number alarm to display when multiple alarms have occurred.
The range that can be specified varies based on the model type.

HG2G-5T: 1 to 5520
Sort: Selects the display order for alarms that have occurred as Old or New.

Display Focus on List after changing Screens or occurring Alarms*1:
Select this check box to automatically display the focus at the first item in the list 
after switching screens and when an alarm occurs.

Display Reference Screen*1: Select this check box to automatically display the reference screen for the alarm 
that has focus under the following conditions.
When the focus is displayed
When the focus moves
When a new alarm occurs

Not Recovered and Unconfirmed Alarm: Displays active alarms that have not been recovered and confirmed.
Not Recovered and Confirmed Alarm: Displays alarms that have not been recovered but the key button Check 

has been pressed.
Recovered and Unconfirmed Alarm: Displays alarms that have been recovered but the key button Check has 

not been pressed.
Recovered and Confirmed Alarm: Displays alarms that have been recovered and the key button Check has 

been pressed.
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■ First Alarm*1

An alarm that occurs in a state where no alarms have occurred is called the first alarm. Select the check boxes for the 
operations to execute when the first alarm occurs.

■ Operate the Alarm on List directly*1

Select this check box to display the focus by pressing an alarm displayed on the list.
When an alarm is pressed with no focus displayed, the focus is displayed on that alarm.
When an alarm is pressed that does not have focus when the focus is displayed, the focus is moved to that alarm. The 
focus is no longer displayed when an alarm with focus is pressed.

*1 Advanced mode only

Display First Alarm to 1st line on List: Always displays the first alarm on the first line of the list.

Change the color of First Alarm: Changes the text color of the first alarm according to the First Alarm 
Color setting. First Alarm Color is configured on the Format tab.
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● Log Tab

■ Show Items
Select these check boxes for the items to display on the Alarm Log Display.

(Show items detailed settings)

Title: Shows the titles on the first line of the list.

Occurrence Time: Shows the time the alarm occurred.

Recovery Time: Shows the time the alarm was recovered from.

Confirmation Time: Shows the time the alarm was confirmed by pressing the key button Check.

Occurrence    Message   Recovered   Confirmed
12/01 12 : 00     Current fault         12 : 53              12 : 54

Title

Recovery �me

Confirma�on �me

Message

Occurrence �me

Up Down CheckSelect Delete

You can drag and drop the sub headings to change the order of items to be displayed on the Alarm Log 
Display. This function is not applied to the order of the Alarm Log output data by batch or real time output 
function.

Drag and drop
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■ (Show items detailed settings)
Each of the show items selected by the check boxes under Show Items can be configured in detail here.

■ Title
Select this check box to use text registered in Text Manager for Title in the (Show items detailed settings). The 
Text ID message configured for Occurrence Time, Message, Recovery Time, and Confirmation Time is 
displayed in (Show Items detailed settings).

Title: Double click the cell, and then enter the titles for the items to display. The maximum number is 
100 characters.

Width: Specifies the number of characters to display (1 to 40). 1 is the width of a single-byte character, 
2 is the width of a double-byte character.

Date: Selects the display type of the date from the following.
YY/MM/DD, MM/DD/YY, DD/MM/YY, MM/DD, DD/MM, non-display

Time: Selects the display type of the time from the following.
HH:MM, HH:MM:SS, non-display

• If the title contains a newline, the text after the newline is not displayed. However, if using a Windows 
font for the selected text ID, all the characters are displayed.

• If the title contains a language not supported as standard by the OS, the characters may be garbled 
when displaying the (Show items detailed settings). However, the downloaded data is correctly 
displayed.

• If you change the display format for Date or Time, the number for Width is automatically adjusted.
• The text color for Message changes according to the alarm state. The text color for Message is 

configured by Occurred Color, Recovered Color, and Confirmed Color on the Format tab.

Text ID: Specifies the Text Manager ID number (1 to 32000) when using text registered in Text Manager.

Click  to display Text Manager.

This option can only be configured when the Use Text Manager check box is selected.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Line Color
When lines are displayed, select this check box and select line color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Lines

Foreground Color, Background Color:

Selects the foreground and background colors of the flange (color: 256 colors, monochrome: 
16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Buttons

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the button.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation 
from the Pattern Palette.

ButtonsButtons

Can be set only when there are grouped Key Buttons.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Title Font
Select the font that will be used for the title from the following options.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Title Color
Select the color (color: 256 colors, monochrome: 16 shades) of the text for titles.
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Occurred Color, Recovered Color, Confirmed Color, First Alarm Color*1

Select the color (color: 256 colors, monochrome: 16 shades) of the occurred alarm, recovered alarm, confirmed alarm 
and first alarm.
Click this button to display the Color Palette. Select a color from the Color Palette.

*1 Advanced mode only

W, H: Selects text magnification (0.5, 1 to 8).

Flash*1: Select this check box to flash alarms that are displayed on the list.
The flash interval is specified in Flashing Cycle on the System tab in the Project Settings dialog box.

Reverse*1: Select this check box to show in reverse, the text color and plate color of alarms that are displayed on the 
list.

Current fault Current faultCurrent fault

Current fault

Flash Reverse Flash and reverse

When the Key Button Check is pressed before recovering a triggered alarm, the alarm display will change 
from the Occurred Color to the Confirmed Color. After this, the alarm that has changed to the Confirmed 
Color will remain in that color and will not change to the Recovered Color even when recovered.
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■ Line Spacing*1

Selects the specification method for line spacing in the list and configures the line spacing.

*1 Advanced mode only

Set with Number of Lines:
Specifies the number of lines for the message to display for one alarm line.
Number of Lines: Enter the number of lines (1 to 12). To completely display a message that 

contains newlines, a number of lines that is equal to or greater than the number 
of message lines is required.

When you enter a value in Number of Lines, Height (dots) is automatically calculated according 
to the display area.
The relationship between the number of lines and the height (dots) is height (dots) = number of 
lines x magnification H x 16.

Number of Lines Magnification H Height
1 1× × 16 = 16 dots

Current fault 

Current fault 

has occurred
Pump fault 

Pump fault 

has occurred

2 1× × 16 =

Current fault 
has occurred

Pump fault 
has occurred

3 1× × 16 =

Current fault 
has occurred

has occurred
Pump fault 

3 2× × 16 =
Number of Lines Magnification H Height

Number of Lines Magnification H Height

32 dots

48 dots

Number of Lines Magnification H Height

96 dots

When the message is 2 lines, 
2nd line is not shown.

Since the alarm line spacing is adjusted with the number of lines for the message fixed, this option is 
convenient to use when displaying multi-line messages.

Set with Dots: Specifies the line spacing for the message to display for one alarm line in dots.
Height (dots): Enter the height (8 to 237). To completely display a message, a height equal to 

or greater than Magnification H x 16 dots x the number of message lines is 
required.

When Magnification H is 1
To display a one-line message, 1 x 16 = 16 dots, a height of 16 dots or higher is required.

To display a two-line message, 2 x 16 = 32 dots, a height of 32 dots or higher is required.

When Magnification H is 2
To display a one-line message, 1 x 32 = 32 dots, a height of 32 dots or higher is required.

To display a two-line message, 2 x 32 = 64 dots, a height of 64 dots or higher is required.

16 dots
Height

Current fault has occurred
Pump fault has occurred

Height Height
16 dots32 dots Current fault has occurred

has occurred

Pump fault 
Current fault 

Pump fault 

When the message is 2 lines, 
2nd line is not shown.

Height

32 dots Current fault has occurred
Pump fault has occurred

Height

32 dots Current fault Current fault 
Pump fault 

Pump fault 

Height

64 dots

has occurred

has occurred

When the message is 2 lines, 
2nd line is not shown.

Since only one line of the title is displayed, the title line spacing = 1 (number of lines) x Magnification H 
x 16, regardless of the Line Spacing setting.
Example: When Magnification H is 1, the title line spacing = 1 x 1 x 16 = 16 dots

When Magnification H is 2, the title line spacing = 1 x 2 x 16 = 32 dots
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● Options Tab

The Options tab is displayed in Advanced mode.

■ Reference Screen Settings
The Options tab is used to configure the reference screen. The reference screen is a base screen or popup screen 
associated with each individual message. The reference screen is displayed when the key button Reference is 
pressed.

Reference Screen: Displays the type of screen selected in Reference Screen on the Channel tab in the Alarm 
Log Settings dialog box.

Click  to display the Alarm Log Settings dialog box.

When displaying a reference screen, select either Base Screen or Popup Screen as the 
reference screen type.
When not displaying a reference, select Not Use.

Coordinates X, Y: Specifies the coordinates to display the reference screen.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-left 
corner of the reference screen.
This option can only be configured when Base Screen or Popup Screen is selected for 
Reference Screen.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Key bu�on Reference Reference screen

2. Press the key bu�on Reference Reference screen opens

Key bu�ons Up and Down

1. Select a message displayed on 
the Alarm Log Display

If you overlap the reference screen key button and the move focus key buttons, the reference screen can be 
switched and checked while moving the focus.
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■ Display Block Number
Specifies the range of block numbers that will display the collected alarm log data.

All: Displays the data for all blocks.

Block Number: Displays only the data for the specified blocks in the Alarm Log Display. Alarms in unspecified blocks 
are not displayed, even if active.
Individual block numbers can be specified by separating the numbers with “,”, continuous regions 
can be specified with “-”.

Example: When the number of blocks is 6, enter the following.

To specify blocks 1 to 3: 1-3

To specify blocks 1, 3, 6: 1, 3, 6

To specify blocks 1, 4 to 6: 1, 4-6

No. Device address

1-0

1-1

1-2

1-13

1-14

1-15

D100-0

D100-1

D100-2

D100-13

D100-14

D100-15

2-0

2-1

2-2

2-13

2-14

2-15

D101-0

D101-1

D101-2

D101-13

D101-14

D101-15

Block 1

Block 2

5-0

5-1

5-2

5-13

5-14

5-15

D104-0

D104-1

D104-2

D104-13

D104-14

D104-15

Block 5

6-0

6-1

6-2

6-13

6-14

6-15

D105-0

D105-1

D105-2

D105-13

D105-14

D105-15

Block 6

Number of blocks Specified numbers

1-36

Block 1

Block 2

Block  3

Block 4

Block 5

Block 6

Block 1

Block 2

Block 3

Block 4

Block 5

Block 6

Block 1

Block 2

Block 3

Block 4

Block 5

Block 6

1,  3,  6 1,  4-6

Blocks to display Blocks to display Blocks to display

• To display the alarms set in blocks 65 to 128 of the Alarm Log settings, select All under Display Block 
Number. If Block Number is selected, only blocks 1 to 64 can be specified.

• For the number of blocks, refer to Chapter 13 “Number of Blocks” on page 13-16.
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■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

• The security group for input can only be configured when there are grouped key buttons.
• For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on 

page 21-1.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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Since the display security group is Group A, User 2 (of Group A) can view the buttons. But since the input security 
group is Group B, User 2 cannot operate the buttons.
Suppose that the Password Screen is now opened and a switch is made to User 3, who is part of both Group A and 
Group B. Group A buttons can be displayed, and Group B buttons can be operated.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated

For User3, 
Group A parts are displayed and 
Group B parts can be operated

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Alarm Log Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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8.1 How the Numerical Display is Used

The Numerical Display is used to display the value of a word device in the specified format.

• Display the current value of a device address

• Display the decimal point

• Display the unit

• Flash a value that exceeds the minimum or the maximum

8 Numerical Display

65535

-1

MICRO/I

D100 : FFFF

Display Device Address : D100
Display Type : Decimal
Data Type : UBIN16(W)
Digits : 5

Display Device Address : D100
Display Type : Decimal
Data Type : BIN16(I)
Digits : 5

External device

(Hex)

AD2

?

MICRO/I

D100 : 1234

Display Device Address : D100
Display Type : Hexadecimal
Data Type : UBIN16(W)
Digits : 4

Display Device Address : D100
Display Type : Decimal
Data Type : BCD4(B)
Digits : 4

External device

(Decimal)

123.4

MICRO/I

D100 : 1234

Display Device Address : D100
Display Type : Decimal
Data Type : BIN16(I)
Digits : 4
Display Floating Point : On
Floating Digits : 1

External device

(Decimal)

1234 pcs.

MICRO/I

D100 : 1234

Display Device Address : D100
Display Type : Decimal
Data Type : UBIN16(W)
Digits : 4
With Unit : On
Text ID : 1
Text : pcs.

External device

(Decimal)

120

MICRO/I

D100 : 120

Display Device Address : D100
Display Type : Decimal
Data Type : UBIN16(W)
Digits : 3
Range : Value
    Minimum : 0
    Maximum : 100
When Data Over
    Flash : On

External device

(Decimal)
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8.2 Numerical Display Configuration Procedure

This section describes the configuration procedure for Numerical Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Display.

2 Click a point on the edit screen where you wish to place the Numerical Display.

3 Double-click the dropped Numerical Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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8.3 Properties of Numerical Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Display Type
Selects the display type for the value as Decimal or Hexadecimal.

■ Data Format

Data Type: Selects the type of data for the value.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Digits: Specifies the digits to display. The range of digits that can be set varies based on the 
display type and data type. The digits that can be set are as follows.

Display Type Data Type Digits

Decimal display

UBIN16(W), BIN16(I) 1 to 5

UBIN32(D), BIN32(L) 1 to 10

BCD4(B) 1 to 4

BCD8(EB) 1 to 8

Float32(F) 1 to 10

Hexadecimal display
UBIN16(W) 1 to 4

UBIN32(D) 1 to 8

Display Floating Point: Select this check box to display the decimal point.

When the Display Floating Point check box is selected and UBIN16(W), BIN16(I), UBIN32(D), 
BIN32(L), BCD4(B), or BCD8(EB) is selected for Data Type, the source device is an integer, but the 
value is displayed with the decimal point added at the configured floating digits.
However, if Float32(F) is selected for Data Type, the source data is a decimal value.
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■ Display Method
Specifies the source of the value to display.

*1 Advanced mode only

Floating Digits: Specifies the number of digits for the fractional part of the decimal value out of the 
number of digits specified by Digits.
This option can only be configured when the Display Floating Point check box is selected. 
The range of digits that can be set for the fractional part varies based on the display type and 
data type. The range of digits that can be set for the fractional part is as follows.

Display Type Data Type Floating Digits

Decimal display

UBIN16(W), BIN16(I) 1 to Digits

UBIN32(D), BIN32(L) 1 to Digits

BCD4(B) 1 to Digits

BCD8(EB) 1 to Digits

Float32(F) 1 to 8

Hexadecimal display
UBIN16(W) --

UBIN32(D) --

Floating Symbol*1: Selects the decimal point symbol from the following.
.(dot), :(colon), ;(semicolon), ,(comma), /(slash)
This option can only be configured when the Display Floating Point check box is selected.
Example: When Digits is 4 and Floating Digits is 2

When Floating Symbol is .(dot) 12.34
When Floating Symbol is /(slash) 12/34

Suppress Zeros: Select this check box to hide “0” for the upper digits of the integer part.
Example: Suppress Zeros selected: 1234

Suppress Zeros cleared: 00001234
Do not display when the value is zero: Select this check box to show a blank display if the value is "0".

• If the value is zero and it is not displayed, the unit set on the Format tab is also not displayed.
• Even if the Do not display when the value is zero check box is selected, "0" is displayed when the value is 

not 0.

Display the minus sign: Select this check box to display the - (negative) sign when displaying negative values.
This option can only be configured when Decimal is selected for Display Type.

Display the plus sign: Select this check box to display the + (positive) sign when displaying positive values.
This option can only be configured when Decimal is selected for Display Type.

Symbol to show when Error occurs: Selects the following symbols to display when an error has occurred.
"? (question mark)", " (space)", "# (pound)", "% (percent)", "$ (dollar)", "- (minus)", 
"@ (at sign)", "\ (backslash)", "* (asterisk)", "! (exclamation mark)", "+ (plus)"

The selected symbol from Symbol to show when Error occurs is displayed under the following states:
• If the Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value entered in device address 

doesn't comply with the data type.
• If a value divided by zero operation was executed with Display with Arithmetic Operation on the 

Options tab.

Display Device Address: Specifies the word device that stores the value to display.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Use Reference Device Address*1: Select this check box and specify a device address to change the source device 
address by the value of this device address.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
For details on indirect reading, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-5.

■ Size
When Standard is selected, selects the text size as 8x16 or 16x16.
When Stroke or 7-Segment is selected, specifies the text size (8 to 128).

■ Style
Selects Regular or Bold for text style.
Can only be set when Standard is selected for Font.

■ Magnification

Can only be set when Standard is selected for Font.

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ With Unit*1

Select this check box to display units or other characters at the end of a number. Displayed characters must be 
registered in Text Manager. The displayed text color will be as set for Text Color under the Format tab.

*1 Advanced mode only

W, H: Selects text magnification (0.5, 1 to 8).

Text ID: Specifies the Text Manager ID No. (1 to 32000).

Click  to display Text Manager.

Text: Displays the characters of the specified Text ID.

• The maximum number that can be displayed with this function is 4 characters. The fifth and subsequent 
characters of a character string are not displayed. However, if Windows Font is set for the specified Text 
ID characters all the characters are displayed.

• If a carriage return (CR) is included the characters after the CR are not displayed.
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■ Change Display Colors
Select this check box to switch the text and plate colors.

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color under the Change Display Colors.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

1234

1234

0

1

Trigger Device Address

Trigger Device Address

External device

Text Color

Plate Color on the View tab

Text Color under Change Display Colors

Plate Color under Change Display Colors
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 0, then the colors specified by Text Color and Plate Color on the View tab and the colors 
specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 1, then the colors specified by Text Color and Plate Color under Change Display Colors 
and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

1234

1234
1234

1234

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

1234

1234
1234

1234

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Trigger device address under
Change Display Colors

Trigger device address under
Change Display Colors

0

0

1

0

1234

1234
1234

1234

Flashing
1

Trigger device address under 
Change Display Colors

Trigger device address
under Flash

Trigger device address under 
Change Display Colors

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

Text Color under 
Change Display Colors
Plate Color under 
Change Display Colors

Text Color under Change Display Colors

Plate Color under Change Display Colors

Text Color under Flash

Plate Color under Flash
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Trigger Device Address: Specifies the bit device or the bit number of the word device that will be used to trigger 
flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

If the Flash check box is selected and the Flash check box under When Data Over on the Data Over tab 
is also selected, the Data Over display is blinking will be given precedence when both conditions are 
satisfied.
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
Select data type.

Specifies the allowable range of values to display.

Value: Specifies the minimum and/or the maximum as a constant.

Device Address: Specifies the minimum and/or the maximum as a value of word device.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified when Value is selected vary based on the 
data type selected with Data Format on the General tab. For details on data types, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
When Device Address is selected, these options specify the source word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

• Select UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), or BCD8(EB) for Data Type 
under the General tab, and to display a fractional number specify the values of Minimum and 
Maximum as an integer.
Example: To set a value of “1.25” for the upper limit, enter “125”.

• If the value of the device address to display exceeds the data range that can be processed for the data 
type selected under Data Format on the General tab, the symbol selected under Symbol to show 
when Error occurs on the General tab is displayed.
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■ When Data Over
These options configure the operation of the part when the allowable range is exceeded.
These options can only be configured when the Minimum or Maximum check boxes are selected under Range.

Flash: Select this check box to make the value flash when the displayed data exceeds the allowable range.

Report: Select this check box to write 1 in the Report Device Address when the displayed data exceeds the 
allowable range.

Report Device Address: Specifies the Report Device Address.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Example: If the value of word device of the reading source is “120,” which is higher than the upper limit of “100,” or 
“-10,” which is below the lower limit of “0,” a value of 1 will be written to LM0 and the displayed numerical 
value will flash.

50 120 90

120

-10

9050 -10

Flashing Flashing

1 10 0

Range: Value
Minimum: 0
Maximum: 100
When Data Over
    • Flash
    • Report
Destination Device Address: LM0

Read data

Display

Data over 
notification: LM0
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Numerical Display is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. 
Select the operation when the condition is not satisfied as Not display Numerical data, Not update Numerical 
data, or Not show Numerical Display under While not satisfying the condition.

■ Trigger Type
Selects the condition to enable the Numerical Display from the following.

Example: When Trigger Type is While ON, Device Address is LM0, and While not satisfying the condition is 
Not display Numerical data
While LM0 is 0, the condition is not satisfied and the Numerical Display does not display the number.
While LM0 is 1, the condition is satisfied and the Numerical Display displays the number.

LM0:

MICRO/I

0

LM0: 1
1234

Condition 
Not 

satisfied

Condition 
Satisfied

Show 
number

Hide 
number

Data over does not operate for hidden Numerical Displays. Data over is reported if the minimum or 
maximum is exceeded when the Numerical Display changes from hidden to displayed.

Always visible: The Numerical Display is always enabled.

Display

Data 99 100 101 102 103 104 105

Update Update Update Update Update Update Update

99 100 101 102 103 104 105
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Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ While not satisfying the condition
Selects the operation of the Numerical Display when the condition is not satisfied.

While ON: Enables the Numerical Display when the value of device address is 1.
Example: When While not satisfying the condition is Not update Numerical data

While OFF: Enables the Numerical Display when the value of device address is 0.
Example: When While not satisfying the condition is Not update Numerical data

While satisfying the condition: Enables the Numerical Display when the condition is satisfied.

Example: When While not satisfying the condition is Not update Numerical data

Value of
Device Address

1

0

UpdateDo not update Do not update Do not update Do not update

Display

Data 99 100 101 102 103 104 105

Update Update

0 100 100 102 103 103 103

Value of
Device Address

1

0

Update Do not update Do not update Do not update

Display

Data 99 100 101 102 103 104 105

Update Update Update

99 99 101 101 101 104 105

Update Do not update Do not update Do not update
Display

Data 99 100 101 102 103 104 105

Update Update Update

Condition
Satisfied

Not satisfied

99 99 101 101 101 104 105

Not display Numerical data: The plate and flange are displayed, but number is not displayed.
Not update Numerical data: The last updated number is displayed. The number does not change.
Not show Numerical Display: Hides the Numerical Display.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Example: If the user and security group for a part are set as follows:

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None
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For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

■ Display with Arithmetic Operation
To apply arithmetic operations to values of device addresses and writing the results, select this check box and input 
the arithmetic formula.
Example: To multiple the value of device address when displayed by 60

Arithmetic Formulas
Arithmetic formulas can be specified by freely combining multiple kinds of data and operators in the following format.

• There is no limit on the number of data items or number of operators. However, the maximum number is 120 
characters.

• Round brackets can be used.

Data

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Item Description

@
The device address on which the arithmetic operation is performed is specified in the arithmetic 
formula. Only one device address can be set for an arithmetic operation.
The device address is as specified for Display Device Address under the General tab.

Value
Sets the constant values for the arithmetic formula.
The values that can be set depend on the data type selected using Data Format under the General 
tab. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address
Specifies the bit device or word device for the arithmetic formula.
Always enter the device address enclosed in square brackets, “[” and “]”.

External device MICRO/I

D0 1234

1234×60

Display value multiplied 
by 60 for the value of 

device address

74040 Numerical Input

Destination Device Address: D0

Display with Arithmetic Operation: @*60

...(up to 120 characters)

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data Operator Data
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Operators
Specify the type of arithmetic operation to be performed on the data. The operator priority is the same as for scripts. 
For details, refer to Chapter 20 “6.3 About the Priority of the Operator” on page 20-55.

Examples of Arithmetic Formula Input

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Item Description

Arithmetic 
operators

Sets the arithmetic operators.

+ Addition Adds  and .

- Subtraction Subtracts  from .

* Multiplication Multiplies  and .

/ Division Divides  by .

% Modulo Calculates remainder after dividing  by .

Bit operator

Sets the bit operator.

& Logical AND Calculates the logical product (AND) of each bit of  and .

| Logical OR Calculates the logical sum (OR) of each bit of  and .

^ Logical XOR 
(exclusive OR)

Calculates the exclusive logical sum (XOR) of each bit of  and 

.

<< Left shift Shifts each bit of  to left by  bit(s).

>> Right shift Shifts each bit of  to right by  bit(s).

Input Examples Description

@ + 1

To perform the arithmetic operation and input the result, add 1 to the value entered 
using the Keypad and write the result to the device address.

To perform the arithmetic operation and display the result, add 1 to the value of device 
address and display the result.

[LDR 0] + @ + 100

To perform the arithmetic operation and input the result, add the value of LDR0 to the 
value entered using the Keypad and add 100, and write the result to the device address.

To perform the arithmetic operation and display the result, add the value of LDR0 to the 
value of device address and add 100, then display the result.

@ & 3

To perform the arithmetic operation and input the result, write the logical product of the 
value entered using the Keypad and 3 to the device address.

To perform the arithmetic operation and display the result, add 3 to the value of device 
address and display the result.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Numerical Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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9.1 How the Calendar is Used

The Calendar can be used to display the date and time using the MICRO/I's clock data.

• Display the date and time

• Write 0 or 1 to a device address at the configured times

9 Calendar

MICRO/I

12/07 13:45

MICRO/I

ON Time : 10:00
OFF Time : 11:00

External device

09:00

10:00

11:00

0 1

10:00

01

11:00

0

09:00

Report Device Address M0

Action

Time 09:00 09:30 10:00 10:30 11:00

Write

Report Device Address 
M0 value

10 0 1 0

Write

ON Time OFF Time

When Alarm is selected for Calendar Type, you can use just the alarm function without displaying the 
clock on the screen.
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9.2 Calendar Configuration Procedure

This section describes the configuration procedure for Calendars.

1 On the Home tab, in the Parts group, click Data Displays, and then click Calendar.

2 Click a point on the edit screen where you wish to place the Calendar.

3 Double-click the dropped Calendar and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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9.3 Properties of Calendar Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Calendar Type
Selects the type of Calendar from the following.

■ Clock
These options configure the type and format of the clock. These options can only be configured when Clock or Clock 
& Alarm is selected for Calendar Type.

Clock: Displays the date and time.

Alarm: Notifies by writing 1 (ON Time) or 0 (OFF Time) to a device address at the configured times without 
displaying the clock.

Clock & Alarm: Displays the clock and notifies by writing 1 (ON Time) or 0 (OFF Time) to a device address at the 
configured times.

Clock Type: Selects the items to display for the clock from the following.
Time, Day of the Week & Time, Date & Time, Date & Day of the Week & Time

Date: Selects the display type of the date from the following.
YY/MM/DD, MM/DD/YY, DD/MM/YY, MM/DD, DD/MM
This option can only be configured when Date & Time or Date & Day of the Week & Time is 
selected for Clock Type.

Year: Selects the display type for the year as Double Figures or Four Figures.
This option can only be configured when Date & Time or Date & Day of the Week & Time is 
selected for Clock Type.

Month: Selects the display type for the month as 1/2/3/... or Jan/Feb/Mar/....
This option can only be configured when Date & Time or Date & Day of the Week & Time is 
selected for Clock Type.

Time: Selects the display type for the time as HH:MM or HH:MM:SS.
HH: hours, MM: minutes, SS: seconds
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● Alarm Tab
These options can only be configured when Alarm or Clock & Alarm is selected for Calendar Type on the 
General tab.

■ Alarm Time
Selects the type of data for the alarm time.

■ (Alarm conditions)
Select the check boxes for the conditions to use as the alarm time.
The Day of the Week check box can only be configured when the Year check box is cleared.

(Alarm conditions)

Value: Specifies the alarm time as values and the day of the week.

Year: Enter the year (0 to 99).

Month: Enter the month (1 to 12).

Day: Enter the day (1 to 31).

Day of the Week: Select the day of the week.

Hour: Enter the hour (0 to 23).

Minute: Enter the minute (0 to 59).

Second: Enter the second (0 to 59).

Device Address: Configures the alarm time as values of word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.
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■ ON Time
Configures the time to write 1 to the Report Device Address according to the type of data.

■ OFF Time
Select this check box to configure the time to write 0 to the Report Device Address.
The time is configured according to the type of data.

■ Report Device Address
Specifies the bit device to write the value to at ON Time and OFF Time.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

• After 1 is written to the Report Device Address with ON Time, that value is retained.

• After a screen configured with the Calendar is displayed, if the time is in between ON Time and OFF 
Time, 1 is written to the Report Device Address.

Value of device address retained after ON Time elapses

1

0

09:00 09:30 10:00 10:30 11:00

Report Device Address
M0 value

Time

ON Time

Turn on MICRO/I power
Open screen

1

0

09:00 09:30 10:00 10:30 11:00

Report Device Address
M0 value

Time

ON Time

Writes 1 to notify that ON Time has already elapsed

OFF Time

• The value of Report Device Address is retained even when the current time exceeds OFF Time.

• After a screen configured with the Calendar is displayed, if the time exceeds OFF Time, 0 is written to 
the Report Device Address.

Value of device address retained after OFF Time elapses1

0

10:00 10:30 11:00 11:30 12:00

Report Device Address
M0 value

Time

OFF Time

Turn on MICRO/I power
Open screen

Report Device Address
M0 value

1

0
Time

10:00 10:30 11:00 11:30 12:00

OFF Time

Writes 0 to notify that OFF Time has already elapsed

ON Time
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Size
When Standard is selected, selects the text size as 8x16 or 16x16.
When Stroke or 7-Segment is selected, specifies the text size (8 to 128).

■ Style
Selects Regular or Bold for text style.
Can only be set when Standard is selected for Font.

■ Magnification

Can only be set when Standard is selected for Font.

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

W, H: Selects text magnification (0.5, 1 to 8).
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Calendar is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. When 
disabled, the plate and flange are displayed, but the time is not displayed. However, if the Not show Calendar check 
box under While not satisfying the condition is selected, the plate and flange are also hidden and the part image 
is not displayed.

■ Trigger Type
Selects the condition to enable the Calendar from the following.

Example: When Trigger Type is While ON, Device Address is LM0, and the Not show Calendar check box 
under While not satisfying the condition is cleared
While LM0 is 0, the condition is not satisfied and the Calendar does not display the time.
While LM0 is 1, the condition is satisfied and the Calendar displays the time.

LM0:

MICRO/I

0

LM0: 1
12/07 13:45

Condition 
Not 

satisfied

Condition 
Satisfied

Show 
time

Hide 
time

Always visible: The Calendar is always enabled.

12/07 13:45

Always show time

Calendar state
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ Not show Calendar
When this check box is cleared, the part image is not displayed when the condition is not satisfied.

While ON: Enables the Calendar when the value of device address is 1.
Example: When the Not show Calendar check box is cleared under While not satisfying the 

condition

While OFF: Enables the Calendar when the value of device address is 0.
Example: When the Not show Calendar check box is cleared under While not satisfying the 

condition

While satisfying the condition:

Enables the Calendar when the condition is satisfied.
Example: When the Not show Calendar check box is cleared under While not satisfying the 

condition

12/07 13:45 12/07 13:45 12/07 13:45 12/07 13:45

1

0

Show timeHide time Hide time Hide timeShow time Show time Show time

Value of
Device Address

Calendar state

Value of
Device Address

1

0

Show timeHide timeShow time Show timeHide time Hide time Hide time

Calendar state
12/07 13:45 12/07 13:45 12/07 13:45

Show timeHide time Show time Hide time

12/07 13:45

Show time

12/07 13:45

Show time

12/07 13:45

Show time

12/07 13:45

Condition
Satisfied

Not satisfied

Calendar state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to place the parts on the top layer. When drawings and parts overlap, those place on the top 
layer are displayed in preference. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Calendar on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to configure charts and meters and their operation on the MICRO/I.

  

1.1 How the Bar Chart is Used

Bar charts and peak charts can be used to display word device values.

• Display word device values in a bar chart

• Display word device values in a peak chart

• Make the chart flash when the displayed data exceeds the maximum or minimum

Chapter 11 Charts

1 Bar Chart

External device
MICRO/I

D100 : -50

D200 : 120

D300 : 40

External device
MICRO/I

D100 : -50

D200 : 120

D300 : 40

External device
MICRO/I

Range: Value
Minimum : 0
Maximum : 100
When Data Over
   Flash: Selected

D100 : 20

D200 : 80

D300 : 40

D100 : -50

D200 : 90

D300 : 120
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1.2 Bar Chart Configuration Procedure

This section describes the configuration procedure for bar charts.

1 On the Home tab, in the Parts group, click Charts, and then click Bar Chart.

2 Click a point on the edit screen where you wish to place the Bar Chart.

3 Double-click the dropped Bar Chart and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Scale tab, Label tab, Trigger Condition tab and Options tab only appear in 
Advanced mode.
To switch to Advanced mode, click Advanced.
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1.3 Properties of Bar Chart Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Chart Type
Selects the type of chart from the following items.
Horizontal Bar, Vertical Bar, Horizontal Peak, Vertical Peak
Peak charts only display the tip of the bar chart.

Horizontal Bar Horizontal Peak
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■ Data Format

*1 Advanced mode only

Data Type: Selects the data type handled by the chart from the following.
UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F)
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Origin, Minimum, Maximum: Specifies the origin, minimum, and maximum for the chart.

(Data Type)*1: Selects the data type to use for the Origin, Minimum, and Maximum.

Value: Uses a constant.

Device Address: Uses a word device.

The origin, minimum, and maximum that can be specified during Basic mode and when 
Value is selected vary based on the data type. For details, refer to Chapter 2 “1.1 
Available Data” on page 2-1.
When Device Address is selected, these options specify the source word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-64.

If the data displayed in the chart is invalid, 1 is written to System Area 2 Processing error bit (address 
number+2, bit 5), and an error message is displayed. For details, refer to Chapter 4 “Processing error” on 
page 4-19 and “Processing error” in Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1. 
An error occurs in the following states:
• The setting of Origin, Minimum, or Maximum are invalid, or the Minimum and Maximum are the 

same values.
• Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value cannot be expressed with the data 

type selected for the read data
The chart cannot be displayed when an error has occurred. 

Even if the value of device address is changed while the trigger condition is not satisfied, the minimum and 
maximum are not updated.



WindO/I-NV4 User’s Manual 11-5

1 Bar Chart

11

Charts

● Data Tab

■ Settings
Lists the chart settings. The list shows the numbers, source device addresses, and colors for the chart.

*1 Advanced mode only

No.: Shows the numbers for the chart (Ch1 to Ch10).
For Horizontal Bar and Horizontal Peak, the numbers are listed in order from top. For Vertical 
Bar and Vertical Peak, the numbers are listed in order from the left.

Device Address: Specifies the source word device for the data to display in the chart.
Double clicking the cell displays the Tag Editor where you can edit the device address. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64

Fg. Normal: Selects the foreground color of the chart when normal. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the foreground color of the 
chart when normal.

Fg. Over*1: Selects the foreground color of the chart when data over. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the foreground color of the 
chart when data over.

Horizontal Bar

Ver�cal Bar

Ch1

Ch1 Ch2 Ch3

Ch2

Ch3
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■ Remove
Deletes the registered settings from the list.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

*1 Advanced mode only

Bg. Normal: Selects the background color of the chart when normal. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the background color of the 
chart when normal.

Bg. Over*1: Selects the background color of the chart when data over. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the background color of the 
chart when data over.

Pattern: Selects the chart pattern or tonal gradation.
Double clicking the cell displays the Pattern Palette where you can change the chart pattern or tonal 
gradation.

You can register the settings from arbitrary numbers, they are aligned filled from the beginning after clicking 
OK on the dialog box. Therefore, when the Properties dialog box is closed and reopened, the list is 
displayed filled from the beginning.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 colors, 
monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Space between Bars*1

Specifies the spacing for the bar chart (0 to 100 dots).

■ Coordinates

■ Size

*1 Advanced mode only

Example: If Space between Bars is 10 If Space between Bars is 0

Chart spacing

Chart spacing

Chart spacing

Chart spacing

Chart spacing

Chart spacing
100 2000

Scale not shown Show scale

10 dots

10 dots

10 dots

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
Select data type.

Specifies the allowable range of values to display.

■ When Data Over
These options configure the operation of the part when the allowable range is exceeded.
These options can only be configured when the Minimum or Maximum check boxes are selected under Range.

Example: If the word device value of the reading source is “110” which is higher than the upper limit of “100” ,or 
“-10” which is below the lower limit of “0”, a value of 1 will be written to LM0 and the displayed bar will flash.

Value: Specifies the minimum and/or the maximum as a constant.

Device Address: Specifies the minimum and/or the maximum as a word device value.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified when Value is selected vary based on the 
data type selected with Data Format on the General tab. For details on data types, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
When Device Address is selected, these options specify the source word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

Flash: Select this check box to make the chart flash when the displayed data exceeds the allowable range.

Report: Select this check box to write 1 in the Report Device Address when the displayed data exceeds the 
allowable range.

Report Device Address: Specifies the Report Device Address.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Ch1 data 60

Ch2 data

Ch1
Ch2

10

10 0 1

Display

20

110

50

80

10 -10

Flashing Flashing

Range: Value

   Minimum: 0

   Maximum: 100

When Data Over

   Flash: Selected

   Report: Selected

Report Device Address: LM0

Data over notification: LM0

100500 100500 100500 100500
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● Scale Tab
The Scale tab is displayed in Advanced mode.

The options on the Scale tab vary based on the type selected with Chart Type on the General tab.
Horizontal Bar, Horizontal Peak: X-Axis
Vertical Bar, Vertical Peak: Y-Axis

■ Show Ticks
Select this check box to display a scale on a chart.

Major Divisions: Enter the number of major scale divisions (1 to 20).
Minor Divisions: Enter the number of minor scale divisions (1 to 20).
Color: Selects the color of scales (color: 256 colors, monochrome: 16 shades).

Click Color to display the Color Palette. Select a color from the Color Palette.
Show Tick Numbers: Select this check box to display numbers along the scale.

Digits: Sets the number of digits to be displayed (1 to 10).
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Display Floating Point: Select this check box to display a floating point along the scale.
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Floating Digits: Sets the number of digits for the fractional parts of numbers (1 to 8) 
from the number of digits specified for Digits.
Can only be set when the Display Floating Point check box is selected.

Font: Selects the font used for displayed text from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, 
refer to Chapter 2 “1.2 Available Text” on page 2-5.

Style: Selects Regular or Bold for the character style to be displayed.
Can only be set when Standard is selected for Font.

Magnification W, H: Selects magnification (0.5, 1 to 8) for the displayed text.
Can only be set when Standard is selected for Font.

Size: Sets character size (8 to 128) for displayed text.
Can only be set when Stroke or 7-Segment is selected for Font.

Color: Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

If the area for displaying the scale is small, the scale will not be displayed properly.
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■ Show Gridline
Select this check box to display grid lines on the chart. Grid lines are displayed above the chart. Can only be set when 
the Show Ticks check box is selected.

Display Position: Select from Scale and Data Over to specify the grid line display position.
Scale: Grid lines are displayed according to the number of major scale divisions.

Data Over: Grid lines are displayed at the positions of values specified for Maximum and 
Minimum under the Data Over tab.

Line Type: Selects the type of grid lines from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

Color: Specifies grid line color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Grid line

MaximumMinimum
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● Label Tab
The Label tab is only displayed in Advanced mode.

■ Show Label for X-Axis, Show Label for Y-Axis
Select this check box to display a label on X axis and Y axis scales.
The options on the Label tab vary based on the type selected with Chart Type on the General tab.
Horizontal Bar, Horizontal Peak: Show Label for X-Axis
Vertical Bar, Vertical Peak: Show Label for Y-Axis

■ Use Text Manager
Select this check box if using the text registered in Text Manager for labels. Can only be set when the Show Label 
for X-Axis or Show Label for Y-Axis check box is selected.

Font: Selects the font for text used in labels from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available 
Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when text registered in the Text Manager are used for 
labels.

Click  to display Text Manager.
Can only be set when the Use Text Manager check box is selected.

Text: Inputs characters to be displayed for labels. Maximum number is 40 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to Chapter 2 
“1.2 Available Text” on page 2-5.
Can only be input when the Use Text Manager check box is cleared.

Color: Selects the color of the text used for labels (color: 256 colors, monochrome: 16 shades).
Click Color to open the Color Palette. Select a color from the Color Palette.

If the area for displaying the label is too small, the label will not be displayed properly.

If a carriage return (CR) is included, the characters after the CR are not displayed. However, if Windows 
Font is set for the specified Text ID, all the characters are displayed.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The bar chart is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. Select 
the operation when the condition is not satisfied as Not display Chart data or Not update Chart data under 
While not satisfying the condition.
Example: When Trigger Type is While ON, Device Address is LM0, and While not satisfying the condition is Not 

display Chart data
While LM0 is 0, the condition is not satisfied and the bar chart is not displayed.
While LM0 is 1, the condition is satisfied and the bar chart is displayed.

■ Trigger Type
Selects the condition to enable the bar chart from the following.

LM0:

MICRO/I

Condi�on 
Not 

sa�sfied

0

LM0:
Condi�on 
Sa�sfied

1
Show chart

Hide chart

100500

100500

Data over does not operate for hidden bar charts. Data over is reported if the minimum or maximum is 
exceeded when the bar chart changes from hidden to displayed.

Always visible: The bar chart is always enabled.

Ch1 data 50

Ch2 data

Display

10

60

30

70

50

80

70

90

90

Update Update Update Update Update

100500 100500 100500 100500 100500
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

While ON: Enables the bar chart when the value of device address is 1.
Example: When While not satisfying the condition is Not update Chart data

While OFF: Enables the bar chart when the value of device address is 0.
Example: When While not satisfying the condition is Not update Chart data

While satisfying the condition: Enables the bar chart when the condition is satisfied.
Example: When While not satisfying the condition is Not update Chart data

Value of
device address

1

0

Ch1 data 50

Ch2 data
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Update
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80

70

Update
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■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ While not satisfying the condition
Selects operation of the Bar Chart when condition is not satisfied.

Not display Chart data: The plate and flange are displayed, but Bar Chart is not displayed.

Not update Chart data: The last updated Bar Chart is displayed. The Bar Chart does not change.



1 Bar Chart

11-16 WindO/I-NV4 User’s Manual

● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password



1 Bar Chart

11-18 WindO/I-NV4 User’s Manual

● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the bar chart on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Line Chart is Used

The line chart can be used to display values of device addresses sampled with the Data Log function and the values of 
multiple word devices.

• Display the values of device addresses sampled with the Data Log function in a trend chart

• Display the values of multiple, continuous device addresses in a single line chart

• Display the cursor and the date and time at the cursor

2 Line Chart
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• There are two types of trend charts, a normal trend chart and a pen recorder trend chart.
• If the Data Log data displayed in the chart is deleted, the chart display is erased.
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2.2 Line Chart Configuration Procedure

This section describes the configuration procedure for Line Charts.

1 On the Home tab, in the Parts group, click Charts, and then click Line Chart.

2 Click a point on the edit screen where you wish to place the Line Chart.

3 Double-click the dropped Line Chart and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Scale tab, Label tab, Date and Time (Cursor) tab, Trigger Condition tab and 
Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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2.3 Properties of Line Chart Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Chart Type
Selects the type of chart from the following.

Log Trend (Normal): Shows values of device addresses sampled with the Data Log function in a trend 
chart. The displayed chart is updated each time the latest data is sampled and the 
latest data is charted from the left edge. If the sampled data exceeds the number of 
display points, the entire chart is shifted to the left by the configured scroll size and 
the display is updated.
Example: When Display Points is 5 and Scroll Size is 1
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Example: When the start address number is D100
The display updates when the value of D100 changes from 0 to 1. The display is erased when the value 
changes to 2. The display is first erased and then updated when the value changes to 3.

Log Trend (Pen Recorder): Shows values of device addresses sampled with the Data Log function in a trend 
chart. The displayed chart is updated each time the latest data is sampled and the 
latest data is always displayed at the right edge. The entire chart shifts to the left 
point by point and the display is updated.
Example: When Display Points is 5
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The chart can display a maximum of 20 lines.

To display multiple items of data, set the sampling conditions and data size for the data to display to the 
same settings. The data cannot be displayed if its sampling conditions or data size is different.

Device Display: Display the values of multiple, continuous device addresses as a single line chart. The 
data size for the device addresses is 16 bits.
Updating and erasing the display is controlled by the lower 2 bits of the start address 
number value (control status) of the continuous device addresses.
The number of values of device addresses to display is specified by the value of start 
address number + 1.
The values of device addresses from start address number + 2 are displayed on the 
chart.
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If there are many items of data to display, it may take some time to update the display.
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■ Data Format

■ Display Points
Specifies the maximum number of points of data to display on the chart (2 to (base screen horizontal size)).
This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is selected for Chart 
Type.

Data Type: Selects the data type handled by the chart from the following.
UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F)
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Minimum, Maximum: Specifies the minimum and maximum for the chart.

(Data Type): Selects the data type to use for the minimum and the maximum.
Value:
Device Address:

Uses a constant.
Uses a word device.

The minimum and maximum vary based on the selected data type. For details, refer to Chapter 
2 “1.1 Available Data” on page 2-1.
When Device Address is selected for (Data Type), the minimum and maximum can be 
specified in the word device.

Click  to display the Tag Editor. For the device address
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

If the data displayed in the chart is invalid, 1 is written to System Area 2 Processing error bit (address 
number+2, bit 5), and an error message is displayed. If Chart Type is Device Display, a processing error 
occurs when the chart is initially displayed, when the display is updated, and when it is erased. For details, 
refer to Chapter 4 “Processing error” on page 4-19 and “Processing error” in Chapter 31 “1.1 Errors 
Displayed on the Screen” on page 31-1. 
An error occurs in the following states:
• The setting of Origin, Minimum, or Maximum are invalid, or the Minimum and Maximum are the 

same values.
• Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value cannot be expressed with the data 

type selected for the read data
The chart cannot be displayed when an error has occurred. 

• If the Chart Type is selected as Log Trend (Normal) or Log Trend (Pen Recorder), the chart 
display is updated when a value of device address is changed. At this time, chart data not saved to the 
data storage area is not displayed.

• If the Chart Type is selected as Device Display, the minimum and maximum are updated when the 
display is updated or erased.

• Even if the value of device address is changed while the trigger condition is not satisfied, the minimum 
and maximum are not updated.

(Data Type): Selects the data type to use with the display points.
Value:
Device Address:

Uses a constant.
Uses a word device.

(Display points): Specifies the maximum number of points (2 to Base Screen horizontal size) for the data to be 
displayed on the chart. The handled data type is UBIN16(W) only.
When Device Address is selected for (Data Type), the display points can be specified in the word 
device.

Click  to display the Tag Editor. For the device address
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

• The minimum value of Display Points is 2. If the value of device address is smaller than the minimum 
value, then Display Points remains at 2. If the value is larger than the Base Screen horizontal size, 
then Display Points is the value of the Base Screen horizontal size.

• When the value of device address changes, the chart display is updated. At this time, chart data not 
saved to the data storage area is not displayed.

• Even if the value of device address is changed while the trigger condition is not satisfied, the chart 
display is not updated.
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■ Scroll Size
Specifies the number of points of data to scroll when updating the chart display (1 to the value of Display Points).
This option can only be configured when Log Trend (Normal) is selected for Chart Type.

Example: When Display Points is 5 and Scroll Size is 3

■ Restart Chart
Select this check box to display the chart from the beginning when switching screens.
This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is selected for Chart 
Type.

(Data Type): Selects the data type to use with the scroll size.
Value:
Device Address:

Uses a constant.
Uses a word device.

(Scroll size): Specifies the number of points of data to scroll (1 to the value of Display Points). The handled data 
type is UBIN16(W) only.
When Device Address is selected for (Data Type), the scroll size can be specified in the word device.

Click  to display the Tag Editor. For the device address
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

The minimum value of Scroll Size is 1. If the value of device address is smaller than the minimum value, 
then Scroll Size remains at 1. If the value is larger than Display Points, then Scroll Size is the value of 
Display Points.
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■ Scroll*1

*1 Advanced mode only

Control Display Update and Scrolling: To scroll the chart to display past data and to display the 
cursor, the chart display updating must be stopped. To 
control updating the display, select this check box and 
specify the bit device or bit of the word device to control the 
display.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
Display updating stops when the value of device address 
changes from 0 to 1. Display updating restarts when the 
value of device address changes from 1 to 0.
This option can only be configured when Log Trend 
(Normal) or Log Trend (Pen Recorder) is selected for 
Chart Type.

Right Scroll Device Address, Left Scroll Device Address: The chart can be scrolled to the right or to the left when 
display updating is stopped. This option specifies the bit 
device or bit number of the word device to scroll the chart 
left or right.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
The chart scrolls right or left one point of data each time the 
value of device address changes from 0 to 1.
These options can only be configured when the Control 
Display Update and Scrolling check box is selected.

Display cursor: The cursor can be displayed when display updating is 
stopped. The cursor is displayed on the chart. Select this 
check box to display the cursor. The Date and Time 
(Cursor) tab is displayed where the functions related to the 
cursor, such as the cursor style and display position control, 
can be configured.
This option can only be configured when the Control 
Display Update and Scrolling check box is selected.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

■ Coordinates

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 colors, 
monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts
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■ Size

W, H: Sets width and height to define the size of parts.
W: 5 to (base screen horizontal size)
H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Pen (Log) Tab
The Pen (Log) tab is only displayed when Log Trend (Normal) or Log Trend (Pen Recorder) is selected for 
Chart Type on the General tab.

■ Settings
Lists the chart settings.

No.: Shows the numbers for the chart (Ch1 to Ch20).

Channel No.: Specifies the Data Log channel number to display on the chart (1 to 20).
Double clicking the cell allows you to edit the channel number.

If the sampling condition for the channels and the amount of log data saved in the data storage area differ, 
the chart cannot be displayed. Set the sampling conditions or channel numbers to the same data.

Data No.: Out of the data contained in the selected Data Log channel number, specifies the data number to 
display on the chart (1 to 128).
Double clicking the cell allows you to edit the data number.

Line Type: Selects the type of line from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Double clicking the cell allows you to change the chart line type.

Line Size: Selects the line size from the following.
1 dot, 2 dots, 3 dots, 5 dots
Double clicking the cell allows you to change the chart line size.

Line Color: Selects the line color for the chart (color: 256 colors, monochrome: 16 shades).
Double clicking the cell displays the Color Palette where you can change the chart line color.

You can register the settings from arbitrary numbers, they are aligned filled from the beginning after clicking 
OK on the dialog box. Therefore, when the Properties dialog box is closed and reopened, the list is 
displayed filled from the beginning.
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■ Data Log Settings
Displays the Data Log Settings dialog box where you can configure the channel while checking the data to display. 

■ Remove
Deletes the registered settings from the list.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.
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● Pen (Device Address) Tab
The Pen (Device Address) tab is only displayed when Device Display is selected for Chart Type on the General 
tab.

■ Reference Device Address
Specifies the start address number of the data to display on the chart.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
The data size for the device addresses is 16 bits.
Updating and erasing the display is controlled by the lower 2 bits of the start address number value (control status).

The number of values of device addresses to display is specified by the value of start address number + 1.
The values of device addresses from start address number + 2 are displayed on the chart.
Example: If Reference Device Address is set to D100, continuous device addresses are used starting from D100. 

The used device addresses are as follows.

Bit 15 Bit 0Bit 2

0 : Do not update
1 : Update

0 : Do not erase
1 : Erase

Reserved

D100
D101
D102
D103
D104

Control status (display operation)

Number of data to display values of device addresses on chart

Data to display values of device addresses on chart
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■ Line Type
Selects the type of line from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

■ Line Size
Selects the line size from the following.
1 dot, 2 dots, 3 dots, 5 dots

■ Line Color
Selects the line color for the chart (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
The type of data is Value. This option uses constants for the allowable range.
Specifies the allowable range of values to display.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified differ according to the data type selected 
with Data Format on the General tab. For details on data types, refer to Chapter 2 “1.1 
Available Data” on page 2-1.

When grid lines are displayed for the minimum and maximum, select the Show Gridline check box on the 
Scale tab and then select Data Over.
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● Scale Tab
The Scale tab is displayed in Advanced mode.

■ Show Ticks
Select this check box to display a scale on a chart.

Major Divisions: Enter the number of major scale divisions (1 to 20).
Minor Divisions: Enter the number of minor scale divisions (1 to 20).
Color: Selects the color of scales (color: 256 colors, monochrome: 16 shades).

Click Color to display the Color Palette. Select a color from the Color Palette.
Show Tick Numbers: Select this check box to display numbers along the scale. Can only be set for Y-Axis.

Digits: Sets the number of digits to be displayed (1 to 10).
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Display Floating Point: Select this check box to display a floating point along the scale.
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Floating Digits: Sets the number of digits for the fractional parts of numbers (1 to 8) 
from the number of digits specified for Digits.
Can only be set when the Display Floating Point check box is selected.

Font: Selects the font used for displayed text from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, 
refer to Chapter 2 “1.2 Available Text” on page 2-5.

Style: Selects Regular or Bold for the character style to be displayed.
Can only be set when Standard is selected for Font.

Magnification W, H: Selects magnification (0.5, 1 to 4, 8) for the displayed text.
Can only be set when Standard is selected for Font.

Size: Sets character size (8 to 128) for displayed text.
Can only be set when Stroke or 7-Segment is selected for Font.

Color: Selects the color of displayed text (color: 256 colors, monochrome: 16 
shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

If the area for displaying the scale is small, the scale will not be displayed properly.
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■ Show Gridline
Select this check box to display grid lines on the chart. The grid lines are displayed on the chart. Can only be set when 
the Show Ticks check box is selected.

Display Position: Select from Scale and Data Over to specify the grid line display position.
Scale: Grid lines are displayed according to the number of major scale divisions.

Data Over: Grid lines are displayed at the positions of values specified for Maximum and 
Minimum under the Data Over tab.

Line Type: Selects the type of grid lines from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

Color: Specifies grid line color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Grid lines

Maximum

Minimum
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● Label Tab
The Label tab is only displayed in Advanced mode.

■ Show Label for X-Axis, Show Label for Y-Axis
Select this check box to display a label on X axis and Y axis scales.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for labels. Can only be set when the Show Label 
for X-Axis or Show Label for Y-Axis check box is selected.

Font: Selects the font for text used in labels from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available 
Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when text registered in the Text Manager are used for 
labels.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.
Text: Inputs characters to be displayed for labels. Maximum number is 40 characters.

The characters that can be entered depend on the font selected using Font. For details, refer to Chapter 2 
“1.2 Available Text” on page 2-5.
Can only be input when the Use Text Manager check box is cleared.

Color: Selects the color of the text used for labels (color: 256 colors, monochrome: 16 shades).
Click Color to open the Color Palette. Select a color from the Color Palette.

If the area for displaying the label is too small, the label will not be displayed properly.

If a carriage return (CR) is included, the characters after the CR are not displayed. However, if Windows 
Font is set for the specified Text ID, all the characters are displayed.
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● Date and Time (Cursor) Tab
The Date and Time (Cursor) tab is only displayed in Advanced mode when Log Trend (Normal) or Log Trend 
(Pen Recorder) is selected for Chart Type on the General tab and the Display cursor check box is selected.

■ Cursor Display Position
This value of device address is the cursor's display position. The cursor is displayed at the position counted from the 
left side of the chart.
This option specifies the word device that is the cursor's display position.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
If the value of the device address configured by Cursor Display Position is outside the range of points configured 
by Display Points on the General tab, the cursor is displayed at the minimum or the maximum value of the display 
points.
Example: When Display Points is 50 and the value of the device address configured by Cursor Display Position is 

100, the cursor is displayed at the 50 (maximum) position.

Maximum number of display points

Cursor
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■ Cursor Position data

■ Cursor Style

Store numerical data: To store the numerical data at the position indicated by the cursor in internal devices, select 
this check box and specify the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
The data is stored in continuous device addresses starting from the specified device address 
in order from Ch1 in the amount of charts displayed. The number of used device addresses 
varies based on the data size. If there is no data at the cursor position, 0 is stored in the 
device address.

Example: When specifying LDR10 and storing the numerical data in Ch1 to Ch3

Data size configured in the Data Log: 16 bits

Data size configured in the Data Log: 32 bits

Store date and time data: To store the date and time data at the position indicated by the cursor in internal devices, 
select this check box and specify the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
The year, month, day, hour, minute, and second are stored in continuous devices in order as 
BCD starting from the specified device address. If there is no data at the cursor position, 0 is 
stored in the device address.

Example: When storing the date and time data for October 1, 2011 12:01:30

Destination Numerical data
LDR10
LDR11
LDR12

Ch1 numerical data
Ch2 numerical data
Ch3 numerical data

Destination Numerical data
LDR10           LDR11            Ch1 numerical data
LDR12           LDR13            Ch2 numerical data
LDR14           LDR15            Ch3 numerical data

Destination Date and time data

LDR10                                2011 (Year)

LDR11                                10 (Month)

LDR12                                1 (Day)

LDR13                                12 (Hour)

LDR14                                1 (Minute)

LDR15                                30 (Second)

Line Type: Selects the cursor line type from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

Line Size: Selects the cursor line size from the following.
1 dot, 2 dots, 3 dots, 5 dots

Line Color: Selects the line color for the cursor (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
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■ Show date and time data at the cursor position
To show the date and time data at the position indicated by the cursor, select this check box and specify the font and 
display type.

Example: When Display items is configured as Date & Time, Date Type is YY/MM/DD, Month is 1/2/3/..., 
Year is Double Figures, Time is HH:MM:SS

Font: Configures the format to display the date and time data.

Font: Selects the font for displayed characters from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

Style: Selects the character style as Regular or Bold.
This option can only be configured when Standard is selected for Font.

Magnification W, H: Selects the zoom factor for characters (0.5, 1 to 4, 8).
This option can only be configured when Standard is selected for Font.

Size: Specifies the character size (8 to 128).
This option can only be configured when Stroke or 7-Segment is selected for 
Font.

Color: Selects the text color (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

Display Type: Configures the display type for the date and time data.

Display items: Selects the items to display for the date and time data from the following.
Time, Date, Date & Time
If Date & Time is selected, the date is displayed centered on the first line and the 
time is displayed centered on the second line.

Date Type: Selects the display type of the date from the following.
YY/MM/DD, MM/DD/YY, DD/MM/YY, MM/DD, DD/MM
This option can only be configured when Date or Date & Time is selected for 
Display items.

Year: Selects the display type for the year as Double Figures or Four Figures.
This option can only be configured when Date or Date & Time is selected for 
Display items.

Month: Selects the display type for the month as 1/2/3/... or Jan/Feb/Mar/....
This option can only be configured when Date or Date & Time is selected for 
Display items.

Time: Selects the display type for the time from the following.
HH:MM, HH:MM:SS, MM:SS
HH: hours, MM: minutes, SS: seconds

11/10/01
12:01:30

Cursor

Cursor posi�on date and �me data

If there is no data at the cursor position, the date and time is displayed as "*".

**/**/**
**:**:**

Cursor
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The line chart is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. When 
disabled, the plate and flange are displayed, but the chart is not displayed.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the line chart is not displayed.
While LM0 is 1, the condition is satisfied and the line chart is displayed.

■ Trigger Type
Selects the condition to enable the line chart from the following.

LM0:

MICRO/I

Condi�on 
Not 

sa�sfied

0

LM0:
Condi�on 
Sa�sfied

1
Show chart

Hide chart

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

Always visible: The line chart is always enabled.

Always show chart

Chart state
0

20

40

60

80

100

-20
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

While ON: Enables the line chart when the value of device address is 1.

While OFF: Enables the line chart when the value of device address is 0.

While satisfying the condition: Enables the line chart when the condition is satisfied.

1

0

Hide chart Show chart Hide chart Show chart Show chart Show chart Hide chart

Value of
device address

Chart state
0
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the line chart on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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3.1 How the Pie Chart is Used

The stacked bar chart and pie chart are used to show the proportion of individual data to the sum of the data.
They can be used to check the relative change in multiple values of device addresses in real-time.

• Display the proportion of the sum of multiple values of device addresses in a stacked bar chart or a pie chart

3 Pie Chart

External device
MICRO/I

1 : 1 : 1

4 : 2 : 1

D100 : 10

D200 : 10

D300 : 10

D100 : 120

D200 : 60

D300 : 30

If the source data is all 0, the chart shows the same proportion for all the data.
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3.2 Pie Chart Configuration Procedure

This section describes the configuration procedure for pie charts.

1 On the Home tab, in the Parts group, click Charts, and then click Pie Chart.

2 Click a point on the edit screen where you wish to place the Pie Chart.

3 Double-click the dropped Pie Chart and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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3.3 Properties of Pie Chart Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Chart Type
Select the type of chart from the following items.

Horizontal Bar: Shows the proportion of the sum of the data as a horizontal stacked bar chart.
Example: When displaying the values for three device addresses

Vertical Bar: Shows the proportion of the sum of the data as a vertical stacked bar chart.
Example: When displaying the values for three device addresses

Horizontal bar 
display

Ch3 data 0

Ch2 data 0

50

100

30

60

10

50

Ch1 data 0 100 120 150

Propor�on 1 : 1 : 1 2 : 2 : 1 4 : 2 : 1 15 : 5 : 1

Ver�cal bar display

Ch3 data 0

Ch2 data 0

50

100

30

60

10

50

Ch1 data 0 100 120 150

Propor�on 1 : 1 : 1 2 : 2 : 1 4 : 2 : 1 15 : 5 : 1
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■ Data Type
Selects the data type handled by the chart from the following.
UBIN16(W), UBIN32(D), BCD4(B), BCD8(EB), Float32(F)
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Settings
Lists the chart settings. The list shows the numbers, source device addresses, and colors for the chart.

Pie: Shows the proportion of the sum of the data as a pie chart.
Example: When displaying the values for three device addresses

Ch3 data 0

Ch2 data 0

50

100

30

60

10

50

Ch1 data 0 100 120 300

Propor�on 1 : 1 : 1 2 : 2 : 1 4 : 2 : 1 30 : 5 : 1

Pie chart display

When the BCD4(B), BCD8(EB), or Float32(F) is selected as Data Type and the value cannot be 
expressed with the data type selected for the data that was read, 1 is written to System Area 2 Processing 
Error bit (address number+2, bit 5), and an error message is displayed. For details, refer to Chapter 4 
“Processing error” on page 4-19 and “Processing error” in Chapter 31 “1.1 Errors Displayed on the Screen” 
on page 31-1.

No.: Shows the numbers for the chart (Ch1 to Ch10).
For Horizontal Bar, the numbers are listed in order from the left. For Vertical Bar, the numbers 
are listed in order from the top.

For Pie, the numbers are listed clockwise.

Device Address: Specifies the source word device for the data to display in the chart.
Double clicking the cell displays the Tag Editor where you can edit the device address. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Fg. Color: Selects the foreground color of the chart. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the foreground color of the chart.

Bg. Color: Selects the background color of the chart. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the background color of the chart.

Pattern: Selects the chart pattern.
Double clicking the cell displays the Pattern Palette where you can change the chart pattern.

Horizontal bar Ver�cal bar

Ch1

Ch1 Ch2 Ch3 Ch2

Ch3

Pie chart

Ch1

Ch2

Ch3

You can register the settings from arbitrary numbers, they are aligned filled from the beginning after clicking 
OK on the dialog box. Therefore, when the Properties dialog box is closed and reopened, the list is 
displayed filled from the beginning.
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■ Remove
Deletes the registered settings from the list.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Flange

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 colors, 
monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.
W: 5 to (base screen horizontal size)
H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the pie chart on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Meter is Used

The meter displays the value of a word device as the movement of a needle.

• Display the value of a word device in a meter

4 Meter

External device
MICRO/I

D100 : 0

D100 : 75

0 100

20 80

40 60

0 100

20 80

40 60
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4.2 Meter Configuration Procedure

This section describes the configuration procedure for meters.

1 On the Home tab, in the Parts group, click Charts, and then click Meter.

2 Click a point on the edit screen where you wish to place the Meter.

3 Double-click the dropped Meter and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Range tab, Scale tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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4.3 Properties of Meter Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Meter Type
Select the type of meter from the following items.
90 Degree Meter, 180 Degree Meter, 270 Degree Meter

Example: 180 Degree Meter

90-degree meter 180-degree meter 270-degree meter

180-degree meter display

Data 0 10 40 75
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■ Data Format

■ Reference Device Address
Specifies the source word device for the data to display in the meter.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

Data Type: Selects the data type handled by the meter from the following.
UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F)
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Minimum, Maximum: Specifies the minimum and maximum for the data.
(Data Type): Selects the data type to use for the minimum and the maximum.

Value:  Uses a constant.
Device Address: Uses a word device.

The minimum and maximum vary based on the selected data type. For details, refer to Chapter 
2 “1.1 Available Data” on page 2-1.
The needle does not move past the left edge when the data value is the minimum or lower.
The needle stops at the right edge when the data value is the maximum or higher.
When Device Address is selected for (Data Type), the minimum and maximum can be 
specified in the word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

If the data displayed in the meter is invalid, 1 is written to System Area 2 Processing error bit (address 
number+2, bit 5), and an error message is displayed. For details, refer to Chapter 4 “Processing error” on 
page 4-19 and “Processing error” in Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1. 
An error occurs in the following states:
• The setting of Minimum, Maximum, or ranges are invalid, or the Minimum and Maximum are the 

same values.
• Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value cannot be expressed with the data 

type selected for the read data
If an error occurs, only the flange is initially displayed. Then once the meter is displayed, it doesn't show an 
update.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Needle Color
Selects the needle color of the Meter (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.
Picture: Uses an image file saved using Picture Manager.

For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

Needle color

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Range Tab
The Range tab is only displayed in Advanced mode.

■ Show Range
Select this check box to show ranges on the meter and configure the number of ranges, range colors, and limits.
Ranges can only be configured when Standard is selected under Image Type on the View tab.

Number of Ranges: Specifies the number of ranges (1 to 5).

Range Color: Selects the range color (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

Limits: Specifies the limit for the range.

(Data Type): Selects the data type to use for the limit.

Value:
Device Address:

Uses a constant.
Uses a word device.

The limit varies based on the data type selected with Data Format on the General tab. For 
details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
When Device Address is selected for (Data Type), the minimum and maximum can be 
specified in the word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

If the data displayed in the meter is invalid, 1 is written to System Area 2 Processing error bit (address 
number+2, bit 5), and an error message is displayed. For details, refer to Chapter 4 “Processing error” on 
page 4-19 and “Processing error” in Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1. 
An error occurs in the following states:
• The setting of Minimum, Maximum, or ranges are invalid, or the Minimum and Maximum are the 

same values.
• Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value cannot be expressed with the data 

type selected for the read data
If an error occurs, only the flange is initially displayed. Then once the meter is displayed, it doesn't show an 
update.

Example: 180-degree meter, data minimum is 0, maximum is 100, the number of ranges is set to 5

The limit between range 1 and 2: 20
The limit between range 2 and 3: 40
The limit between range 3 and 4: 60
The limit between range 4 and 5: 80

Range 1

Range 2

Range 3
Range 4

Range 5
0 100

20 80

40 60
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● Scale Tab
The Scale tab is displayed in Advanced mode.

■ Show Ticks
Select this check box to display a scale on a or meter.
Scales can only be set when Standard is selected for Image Type under the View tab.

Major Divisions: Enter the number of major scale divisions (1 to 20).

Minor Divisions: Enter the number of minor scale divisions (1 to 20).

Color: Selects the color of scales (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Show Tick Numbers: Select this check box to display numbers along the scale.

Digits: Sets the number of digits to be displayed (1 to 10).
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Display Floating Point: Select this check box to display a floating point along the scale.
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Floating Digits: Sets the number of digits for the fractional parts of numbers (1 to 8) 
from the number of digits specified for Digits.
Can only be set when the Display Floating Point check box is selected.

Color: Selects the color of displayed text (color: 256 colors, monochrome: 16 
shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

• If the area for displaying the scale is small, the scale will not be displayed properly.
• When the standard graphic F0001, F0101, or F0201 (no flange) are selected, the scale cannot be 

configured.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the 
Security Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 
“2.2 Adding and Editing Security Groups” on page 21-18.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

User Name

Security Group None Group A
User1 User2

MICRO/I

130Line Chart and Bar Chart
Display: Group A

Bu�on
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2

Group A parts are 
not displayed to User1

Group A parts are 
displayed to User2

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the meter on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to setup commands and their operation on the MICRO/I.

  

1.1 How the Bit Write Command is Used

Writes a 0 or 1 to a bit device.

■ Set

■ Reset

■ Momentary

Chapter 12 Commands

1 Bit Write Command

MICRO/I External device

0

1

Condition

Condition

Not satisfiedNot satisfiedNot satisfied

SatisfiedSatisfiedSatisfied

Writes a 1 to the specified bit device 
when the trigger condition is 
satisfied.

1

State of condition

Data written 1

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes a 0 to the specified bit device 
when the trigger condition is 
satisfied.

0

State of condition

Data written 0

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes a 1 to the specified bit device 
when the trigger condition is 
satisfied.
When the trigger condition is no 
longer satisfied, a 0 is written to the 
specified bit device.

0

State of condition

Data written 1 0 1

Action WriteWrite Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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■ Toggle

■ Move

Toggles the value of the specified bit 
device when the trigger condition is 
satisfied.
If the value of the bit device is 0 it 
changes to 1, and vice versa.

State of condition

Action Toggle Toggle

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

This function writes the value in the 
source bit device to the value in the 
destination bit device when the 
trigger condition is satisfied.

State of condition

Action Move Move

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied



WindO/I-NV4 User’s Manual 12-3

1 Bit Write Command

12

Com
m

ands

1.2 Bit Write Command Configuration Procedure

This section describes the configuration procedure for the Bit Write Command.

1 On the Home tab, in the Parts group, click Commands, and then click Bit Write Command.

2 Click a point on the edit screen where you wish to place the Bit Write Command.

3 Double-click the dropped Bit Write Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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1.3 Properties of Bit Write Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

Set: Writes a 1 to the specified bit device when the trigger condition is satisfied.

Reset: Writes a 0 to the specified bit device when the trigger condition is satisfied.

Momentary: Writes a 1 to the specified bit device when the trigger condition is satisfied.
When the trigger condition is no longer satisfied, a 0 is written to the specified bit device.

1

State of condition

Data written 1

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

0

State of condition

Data written 0

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

0

State of condition

Data written 1 0 1

Action WriteWrite Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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■ Destination Device Address
Specify the destination bit device.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Write*1

Specify the number of bit devices (1 to 64) at the destination.
This setting is enabled only if Action Mode is set to Set or Reset.

Example: This fills a contiguous block of bit devices with the same value.

If the bit number in a word device is specified, the same value is written to same bit of contiguous word devices.

■ Source Data
Specifies the device address where the data to be written is stored.
This setting is enabled only if Action Mode is set to Move.

Example: This button writes the values in a contiguous block of bit devices to a contiguous block of device 
addresses at the destination.

*1 Advanced mode only

Toggle: Toggles the value of the specified bit device when the trigger condition is satisfied.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: This function writes the value in the source bit device to the value in the destination bit device when 
the trigger condition is satisfied.

State of condition

Action Toggle Toggle

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Action Move Move

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

1M0

1M1

1M2

1M3

1M4

Action Mode: Set

Write: 5

Destination Device Address: M0

Condition

SatisfiedSatisfiedSatisfied

Condition

bit bit
15 0

SatisfiedSatisfiedSatisfied

1D0

D1

D2

D3

D4

1

1

1

1

Action Mode: Set

Write: 5

Destination Device Address: D0-15

Device Address: Specify the source bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Transfer: Specify the number of bit devices (1 to 64) to move.

1LM0

0LM1

0LM2

1LM3

Device Address: LM0

Transfer: 4

Destination Device Address: M0

1M0

0M1

0M2

1M3

Condition

SatisfiedSatisfiedSatisfied
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Bit Write Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Word Write Command is Used

Writes a value to a word device. Can be used to indirectly specify the destination address number or to perform 
operations on the written value.

• Writes a fixed value to a word device when the trigger condition is satisfied.

• Writes the value of device address to a word device when the trigger condition is satisfied.

• Performs arithmetic on the value to write before writing it to a word device when the trigger condition is satisfied.

2 Word Write Command

MICRO/I External device

D1= 0

100

D1= 100

Write

Destination word device

100

Value

Condition

Condition

SatisfiedSatisfiedSatisfied

Not satisfiedNot satisfiedNot satisfied

MICRO/I External device

D0= 123

D1= 0

D0= 123

D1= 123

Move

Value in device address

Destination word device

Condition

Condition

SatisfiedSatisfiedSatisfied

Not satisfiedNot satisfiedNot satisfied

MICRO/I External device

D0= 100

D1= 23

D2= 0

D0= 100

D1= 23

D2= 123

Add

Write

Value to write

Operator value

Destination word device

Condition

Condition

SatisfiedSatisfiedSatisfied

Not satisfiedNot satisfiedNot satisfied
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■ Set

■ Move

■ Momentary

■ Add, Sub, Multi, Div, Mod, OR, AND, XOR

Writes a fixed value to a word device when the 
trigger condition is satisfied.

State of condition

Data written

WriteAction Write

Value Value

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes the value of source device address to the 
destination word device when the trigger 
condition is satisfied. State of condition

Data written

WriteAction Write

Value in
device address

Value in
device address

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes a fixed value of ON Data to a word device 
when the trigger condition is satisfied.
Writes a fixed value of OFF Data to a word device 
when the trigger condition is no longer satisfied.

State of condition

Data written

WriteAction

OFF Data

Write

ON Data

Write

OFF Data

Write

ON Data

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Performs arithmetic on the value of source device 
address and a fixed value, or a value of device 
address and writes the result to a word device 
when the trigger condition is satisfied.

Example: Add (Addition)
When the trigger condition is satisfied, 
the value in the Source 1 is added to 
the value in Source 2 and the result is 
written to the word device.

State of condition

Data written

Action

Result

Arithmetic operation
↓

Write

Result

Arithmetic operation
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

Action

Result Result

Addition
↓

Write

Addition
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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2.2 Word Write Command Configuration Procedure

This section describes the configuration procedure for the Word Write Command.

1 On the Home tab, in the Parts group, click Commands, and then click Word Write Command.

2 Click a point on the edit screen where you wish to place the Word Write Command.

3 Double-click the dropped Word Write Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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2.3 Properties of Word Write Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

Set: Writes a fixed value to the specified word device when the trigger condition is satisfied.

Move: Writes the value in the source device address to the destination word device when the trigger condition is 
satisfied.

Momentary: Writes the fixed ON Data value to the specified word device when the trigger condition is satisfied.
Writes the fixed OFF Data value to the specified word device when the trigger condition is no longer 
satisfied.

State of condition

Data written

WriteAction Write

Value Value

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

WriteAction Write

Value in
device address

Value in
device address

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

WriteAction

OFF Data

Write

ON Data

Write

OFF Data

Write

ON Data

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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■ Data Type
Select the data type handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

■ Source Data
Select the data handled by the operation selected for Action Mode.

Add, Sub, Multi, Div, Mod, OR, AND, XOR: Performs arithmetic on the value in a reference device address and a
fixed value, or the value at a device address and writes the result to a
word device when the trigger condition is satisfied.

Example: Add (Addition)
When the trigger condition is satisfied, the value in the Source 1 is added to the value in 
Source 2 and the result is written to the word device.

State of condition

Data written

Action

Result

Arithmetic operation
↓

Write

Result

Arithmetic operation
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

Action

Result Result

Addition
↓

Write

Addition
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to Move. Because the number of 
device addresses to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4(B), BCD8(EB), or Float32(F) is selected and the arithmetic data contains a value inexpressible 
in BCD, a 1 is written to System Area 2 Processing error bit (address number+2, bit 5) and an error 
message is displayed. For details, refer to Chapter 4 “Processing error” on page 4-19 and “Processing 
error” in Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1.

Value: Use a constant.
Only a Value can be handled if Action Mode is set to Set or Momentary.
If Action Mode is set to Momentary, the value in the ON Data is written when the trigger 
condition is satisfied, and the value in the OFF Data when the trigger condition is no longer 
satisfied.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values as a 
hexadecimal.
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■ Destination Device Address

*1 Advanced mode only

Device Address: Use a word device.
Specify the device address.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Use Reference Device Address*1: Select this check box and specify a device address to change the 
source word device according to the value of the specified device 
address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.

Transfer*1 Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.
Example: If Transfer is set to 2 and Write is set to 3, the 

same data in 2 continuous word device addresses will 
be written to the destination device address 3 times.

:

Source Data (Device Address): LDR0

Write: 3

999LDR0

Destination Device Address: D100

D100

D101

D102

D103

Transfer: 2 1000LDR1

D104

D105

999

1000

999

1000

999

1000

Condition

SatisfiedSatisfiedSatisfied

Destination Device Address: Specify the destination word device.
Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device according to the value of the specified device address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 
2-4.

Write*1 Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Move, or Momentary.
Example: If Data Type is set to UBIN16(W) and Write is set to 5, the same 

data will be written to 5 continuous word addresses.

If Data Type is set to UBIN32(D) and Write is set to 5, the same 
data will be written to a total of 10 word addresses (2 words 5 times).

:

Destination Device Address: LDR10

Write: 5

Data Type: UBIN16(W)

Source Data (Value): 12345
12345LDR10

12345LDR11

12345LDR12

12345LDR13

12345LDR14

5 words
Condition

SatisfiedSatisfiedSatisfied

Destination Device Address: LDR10

Write: 5

Data Type: UBIN32(D)

Source Data (Value): 987654

LDR10

987654

LDR11

LDR12

987654

LDR13

LDR14

987654

LDR15

LDR16

987654

LDR17

LDR18

987654

LDR19

2 words x 5

Condition

SatisfiedSatisfiedSatisfied
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● Trigger Condition Tab

When the condition has been or is satisfied,  the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Word Write Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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3.1 How the Goto Screen Command is Used

Switches to another screen or displays a window.

• Switches between Base Screens when the trigger condition is satisfied.

• Opens and closes other windows (such as the Popup Screen, Device Monitor, Password Screen, Adjust Brightness 
Screen, and File Screen) when the trigger condition is satisfied.

• Switches to the System Mode when the trigger condition is satisfied.

• Resets the current screen when the trigger condition is satisfied.

3 Goto Screen Command

Condition

MICRO/I

SatisfiedSatisfiedSatisfied

MICRO/I

Condition

SatisfiedSatisfiedSatisfied
D51 123

D52 456

D53 0

999

MICRO/I

Condition

SatisfiedSatisfiedSatisfied
D51 123

D52 456

D53 0

999

MICRO/I

Condition

SatisfiedSatisfiedSatisfied OfflineRun Main Menu

MICRO/I

130 00

Condition

SatisfiedSatisfiedSatisfied
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3.2 Goto Screen Command Configuration Procedure

This section describes the configuration procedure for the Goto Screen Command.

1 On the Home tab, in the Parts group, click Commands, and then click Goto Screen Command.

2 Click a point on the edit screen where you wish to place the Goto Screen Command.

3 Double-click the dropped Goto Screen Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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3.3 Properties of Goto Screen Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is met from the following:

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.
Switch to Base Screen: Switches between Base Screen. For details, refer to Chapter 5 “3 Base Screen” on 

page 5-14.
Open Popup Screen: Opens a Popup Screen. For details, refer to Chapter 5 “4 Popup Screen” on page 5-20.
Close Popup Screen: Closes a Popup Screen. For details, refer to Chapter 5 “4 Popup Screen” on page 5-20.
Open Device Monitor Screen: Opens the Device Monitor Screen. For details, refer to Chapter 23 “2.2 Device 

Monitor” on page 23-19.
Close Device Monitor Screen: Closes the Device Monitor Screen. For details, refer to Chapter 23 “2.2 Device 

Monitor” on page 23-19.
Open Password Screen: Opens the Password Screen. For details, refer to Chapter 21 “4.1 Entering the 

Password on the MICRO/I” on page 21-39.
Close Password Screen: Closes the Password Screen. For details, refer to Chapter 21 “4.1 Entering the 

Password on the MICRO/I” on page 21-39.
Open Adjust Brightness Screen: Opens the Adjust Brightness Screen. For details, refer to Chapter 29 “1.3 

Adjusting Screen Brightness” on page 29-2.
Close Adjust Brightness Screen: Closes the Adjust Brightness Screen. For details, refer to Chapter 29 “1.3 

Adjusting Screen Brightness” on page 29-2.
Switch to System Mode: Switches to the Top Page in the System Mode. For details, refer to Chapter 29 “2 

System Mode Overview” on page 29-3.
Reset current screen: Resets the current Base Screen.

When the current Base Screen is reset using the Reset current screen function, the window and internal 
devices restart as if the Base Screens were switched.
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■ Goto Screen

*1 Advanced mode only

Screen Number: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup 
Screen, or Close Popup Screen.

Use Reference Device Address*1: Select this check box and specify a device address to specify the 
screen number using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Open 
Popup Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as the 
origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, or Open Adjust Brightness Screen.

Use Reference Device Address*1: Select this check box and specify a device address to specify the 
coordinates using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Open 
Popup Screen.
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Goto Screen Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Print Command is Used

Outputs a screenshot to an external memory device.

• Outputs a screenshot of the current screen to the external memory device when the trigger condition is satisfied.

4 Print Command

MICRO/I

Condition

SatisfiedSatisfiedSatisfied

USB flash drive

External Memory Device

Image file
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4.2 Print Command Configuration Procedure

This section describes the configuration procedure for the Print Command.

1 On the Home tab, in the Parts group, click Commands, and then click Print Command.

2 Click a point on the edit screen where you wish to place the Print Command.

3 Double-click the dropped Print Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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4.3 Properties of Print Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Output to
Select where to direct the screenshot to.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

External Memory Device: Outputs the screenshot as a file to the external memory device inserted in the MICRO/I.
Files are output as follows:

File format File name File size

JPEG
CAP***.JPG (***: date and time when file was output)
Example: A file created at 18:50:25 on June 30, 2011 will 

be named “CAP110630_185025.JPG”.

Depends on image 
being displayed.

For details about external memory devices, refer to Chapter 27 “External Memory Devices” on page 27-1.

Print Screen: Outputs a screenshot of the current screen to the external memory device.

The maximum number of screenshots that can be captured (1 to 999) can be set in HMI Special Data Register 
LSD65. (Default: 99)

The methods to erase screenshot files saved on the external memory device are as follows.
• To erase files during operation using parts, on the External Memory Device tab on the Project Settings 

dialog box, select the Remove Files check box and the All Screenshot data check box, and then configure 
the trigger device address. Assign that trigger device address to a part.

• To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in External 
Memory Device to open the Clear Data dialog box. Select the Screenshot Data check box and click OK.
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Print Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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5.1 How the Script Command is Used

Executes a script when certain conditions are satisfied.

5 Script Command

MICRO/I

// Script A

[D 100] = [D 100] + 1;

if ([D 100] >= 50)

{

     [D 100] = 0;

}

Executes Script

Start Condition

SatisfiedSatisfiedSatisfied

Complex processes such as conditional branching, logical operation, arithmetic operation, function, etc., can 
be programmed in a text format using Scripts. For details, refer to Chapter 20 “Script” on page 20-1.
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5.2 Script Command Configuration Procedure

This section describes the configuration procedure for Script Commands.

1 On the Home tab, in the Parts group, click Commands, and then click Script Command.

2 Click a point on the edit screen where you wish to place the Script Command.

3 Double-click the dropped Script Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.



WindO/I-NV4 User’s Manual 12-33

5 Script Command

12

Com
m

ands

5.3 Properties of Script Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Script ID
Specify the script ID (1-32000) of the script to operate.

The Script Manager will open when  is clicked. Select a script from the script list.
For details, refer to Chapter 20 “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script selected in the Script Manager.

■ (Script)
Displays the contents of the script selected in the Script Manager.
Once this area is double clicked, the Script Editor will open and editing can be done.
For details, refer to Chapter 20 “2.3 Script Editor” on page 20-8.

(Script)
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Period
Sets the period for command execution from 1 to 3600 (seconds).
Can only be set if Fixed Period is selected as Trigger Type.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

While satisfying the condition: The command continues being executed while the condition is satisfied.

Fixed Period: Command executes within a fixed time interval.

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution

Fixed time interval Fixed time interval Fixed time interval

Action Execution Execution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Script Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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6.1 How the Multi-Command is Used

Executes multiple commands at once.
These commands can be assigned to a Multi-Command.

• Writes a 1 to a bit device, and the value in a word device to another device when the trigger condition is satisfied.

• Outputs a screenshot of the current screen to an external memory device, and then switches the Base Screen when 
the trigger condition is satisfied.

6 Multi-Command

Command Description

Bit Write Writes a 0 or 1 to the specified bit device.

Word Write
Writes a value to a word device. You can specify the destination address number indirectly, and perform 
arithmetic on the value to be written.

Goto Screen Switches screens and opens other windows.

Print Outputs a screenshot to the external memory device.

Key Performs downloads, uploads, and file copying. Also used to manipulate other parts.

Script Executes a script.

MICRO/I External device

1

Condition

SatisfiedSatisfiedSatisfied

0

D0= 123

D1= 0

D0= 123

D1= 123

Move

USB flash drive

External Memory Device

MICRO/I

Image file

Condition

SatisfiedSatisfiedSatisfied
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6.2 Multi-Command Configuration Procedure

This section describes the configuration procedure for Multi-Commands.

1 On the Home tab, in the Parts group, click Commands, and then click Multi-Command.

2 Click a point on the edit screen where you wish to place the Multi-Command.

3 Double-click the dropped Multi-Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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6.3 Properties of Multi-Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Multi-Functions
Add and edit commands to be executed when the trigger condition is satisfied.

Function List: Lists the commands to be executed.

Command Type: Shows the command type.

Command Name: Shows the command name.

Device Address: Shows the setting when one of the following Command Type is selected.
Shows the destination device address for the Bit Write and Word Write 
commands.
Shows the screen number when Goto Screen is set to Switch to Base 
Screen, Open Popup Screen, or Close Popup Screen.
Shows the script ID for the Script command.

• Executes only the Goto Screen command at the end of the Function List when multiple Switch to Base 
Screen type commands are set for Action Mode.

• Goto Screen commands are not executed from top to bottom as they appear in the Function List. 
Rather, they are executed at the end of the scan when the trigger condition is satisfied.

• Key commands are executed in the scan that follows a scan that satisfies the trigger condition.
• If multiple Key commands are set, only the first and second Key commands in the Function List are 

executed. The third and following Key commands are not executed. Also, only the first Key command that 
specifies a Data Transfer function in the Function List is executed if multiple Key commands are set.

Command Type: Select the command to add.

Bit Write: Writes a 0 or 1 to a bit device or bit of the word device. For details, refer to 
“Properties of Bit Write for Multi-Functions dialog box” on page 12-41.

Word Write: Writes a value to a word device. Can be used to indirectly specify the destination 
address number or to perform operations on the written value. For details, refer 
to “Properties of Word Write for Multi-Functions dialog box” on page 12-42.



6 Multi-Command

12-40 WindO/I-NV4 User’s Manual

Goto Screen: Switches to another screen or displays a window. For details, refer to “Properties 
of Goto Screen for Multi-Functions dialog box” on page 12-44.

Print: Outputs a screenshot to an external memory device. For details, refer to 
“Properties of Print for Multi-Functions dialog box” on page 12-46.

Key: Performs a variety of functions including uploading and downloading, copying
files, and operating other parts. For details, refer to “Properties of Key for Multi-
Functions dialog box” on page 12-47.

Script: Executes a script. For details, refer to “Properties of Script for Multi-Functions 
dialog box” on page 12-51.

Add: Adds a command to the list. A maximum of 32 commands may be added.
Click this button to display the Properties dialog box for the command selected from Command 
Type.

Edit: Changes a command in the list.
Click this button to display the Properties dialog box for the command selected in Function 
List.

Delete: Deletes a command from the list.
Select the command in the list and click this button.

Copy: Copies a command in the list.
Select a command in the list and click this button. A copy of the selected command is added to 
the end of the list.

Up: Shifts the selected command upward in the list.

Down: Shifts the selected command downward in the list.
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Properties of Bit Write for Multi-Functions dialog box

Sets the Bit Write command for the Multi-Command.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

■ Destination Device Address
Specify the destination bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Write*1

Specify the number of bit devices (1 to 64) at the destination.

This setting is enabled only if Action Mode is set to Set or Reset. For details, refer to “Write*1” on page 12-5.

■ Source Data
Specifies the device address where the data to be written is stored.
This setting is enabled only if Action Mode is set to Move. For details, refer to “Source Data” on page 12-5.

*1 Advanced mode only

Set: Writes a 1 to the specified bit device when the trigger condition is satisfied.

Reset: Writes a 0 to the specified bit device when the trigger condition is satisfied.

Set & Reset: Writes a 1 to the specified bit device when the trigger condition is satisfied.
When the trigger condition is no longer satisfied, a 0 is written to the specified bit device.

Toggle: Toggles the value of the specified bit device when the trigger condition is satisfied.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: This function writes the value in the source bit device to the value in the destination bit device 
when the trigger condition is satisfied.

For details about the Action Mode, refer to “Action Mode” on page 12-4. However, Set & Reset for the 
Multi-Command has the same function as Momentary for the Bit Write Command.

Device Address: Specify the source bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Transfer: Specify the number of bit devices (1 to 64) to move.
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Properties of Word Write for Multi-Functions dialog box

Sets the Word Write command for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

■ Data Type
Select the data type handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

Set: Writes a fixed value to the specified word device when the trigger condition is satisfied.

Move: Writes the value in the source device address to the destination word device when the trigger 
condition is satisfied.

Set ON & OFF Data: Writes a fixed value of ON Data to the specified word device when the trigger condition is 
satisfied.
Writes a fixed value of OFF Data to the specified word device when the trigger condition is 
no longer satisfied.

Add, Sub, Multi, Div, Mod, OR, AND, XOR: Performs arithmetic on the value of source device address and a fixed 
value or a value of device address and writes the result to a word device 
when the trigger condition is satisfied.

For details about the Action Mode, refer to “Action Mode” on page 12-12. However, Set ON & OFF Data 
for the Multi-Command has the same function as Momentary for the Word Write Command. 

UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to Move. Because the number of 
device addresses to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4(B), BCD8(EB), or Float32(F) is selected and the arithmetic data contains a value inexpressible 
in BCD, a 1 is written to System Area 2 Processing error bit (address number+2, bit 5) and an error 
message is displayed. For details, refer to Chapter 4 “Processing error” on page 4-19 and “Processing 
error” in Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1.
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■ Source Data
Select the data handled by the operation selected for Action Mode.

■ Destination Device Address

*1 Advanced mode only

Value: Use a constant.
Only a Value can be handled if Action Mode is set to Set or Set ON & OFF Data.
If Action Mode is set to Set ON & OFF Data, the value in the ON Data is written when the 
trigger condition is satisfied, and the value in the OFF Data when the trigger condition is no longer 
satisfied.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values as a hexadecimal.

Device Address: Use a word device.
Specify the device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Use Reference Device Address*1: Select this check box and specify a device address to change the 
source word device according to the value of the specified device 
address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.

Transfer*1: Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.

For details, refer to “Transfer*1” on page 12-14.

Destination Device Address: Specify the destination word device.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device according to the value of the specified device address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 
2-4.

Write*1: Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Move, or Set ON & OFF 
Data.

For details, refer to “Write*1” on page 12-14.



6 Multi-Command

12-44 WindO/I-NV4 User’s Manual

Properties of Goto Screen for Multi-Functions dialog box

Sets the Goto Screen command for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is met from the following:

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen.

Open Popup Screen: Opens a Popup Screen.

Close Popup Screen: Closes a Popup Screen.

Open Device Monitor Screen: Opens the Device Monitor Screen.

Close Device Monitor Screen: Closes the Device Monitor Screen.

Open Password Screen: Opens the Password Screen.

Close Password Screen: Closes the Password Screen.

Open Adjust Brightness Screen: Opens the Adjust Brightness Screen.

Close Adjust Brightness Screen: Closes the Adjust Brightness Screen.

Switch to System Mode: Switches to the Top Page in the System Mode.

Reset current screen: Resets the current Base Screen.

When the current Base Screen is reset using the Reset current screen function, the window and internal 
devices restart as if the Base Screens were switched.
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■ Goto Screen

*1 Advanced mode only

Screen Number: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup
Screen, or Close Popup Screen.

Use Reference Device Address*1: Select this check box and specify a device address to specify 
the screen number using the value of the specified device 
address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Open 
Popup Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as 
the origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, or Open Adjust Brightness Screen.

Use Reference Device Address*1: Select this check box and specify a device address to specify 
the coordinates using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This setting is enabled only if Action Mode is set to Open 
Popup Screen.
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Properties of Print for Multi-Functions dialog box

Sets the Print command for the Multi-Command.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Output to
Select where to direct the screenshot to.

■ Action Mode
Select the behavior of the button from the following:

External Memory Device: Outputs the screenshot as a file to the external memory device inserted in the MICRO/I.
Files are output as follows:

File format File name File size

JPEG
CAP***.JPG (***: date and time when file was output)
Example: A file created at 18:50:25 on June 30, 2011 

will be named “CAP110630_185025.JPG”.

Depends on image 
being displayed.

For details about external memory devices, refer to Chapter 27 “External Memory Devices” on page 27-1.

Print Screen: Outputs a screenshot of the current screen to the external memory device.

The maximum number of screenshots that can be captured (1 to 999) can be set in HMI Special Data 
Register LSD65. (Default: 99)

The methods to erase screenshot files saved on the external memory device are as follows.
• To erase files during operation using parts, on the External Memory Device tab on the Project 

Settings dialog box, select the Remove Files check box and the All Screenshot data check box, and 
then configure the trigger device address. Assign that trigger device address to a part.

• To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in External 
Memory Device to open the Clear Data dialog box. Select the Screenshot Data check box and click 
OK.
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Properties of Key for Multi-Functions dialog box

Sets the Key command for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Key Type
Select the function for the Key Button

The settings explained below appear depending on the type of key selected.

■ Popup Screen Number
The Alt key switches the current Popup Screen used as a Keypad when this button is pressed.
Specify the Popup Screen number to open a Keypad for.
This setting is enabled only if Alt was selected using the Key Browser.

Displays settings 
applicable to the 
selected key.

(Key)

Language: Switches the display of the key that is displayed when Keypad is selected in Key Browser. These 
languages are available:
Japanese, European, Central European, Baltic, Cyrillic.

Browse: Opens the Key Browser when clicked. Select a key.
For details, refer to Chapter 8 “5.5 Key Browser” on page 8-86.

(Key): Displays the name of the key selected using the Key Browser.

• When you select a key for Multi-Button or Multi-Command, the label for that key is not assigned as the 
Registration Text.

• The function of Key Button will affect on the next scan when the trigger condition is satisfied.
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■ Scroll Size
Key Buttons Page Up and Page Down scroll the list up and down, respectively. Key Buttons Up and Down move 
the focus up and down, respectively. This settings specifies the number of pages or lines (1 to 1023 lines) to scroll or 
move the focus per each press of the button.
This setting is enabled only if Page Up, Page Down, Up, and Down are selected using the Key Browser.

■ Transfer Setting
Key Buttons Download Project, Upload Project, Download PLC Program, and Upload PLC Program, perform 
the data transfer function specified by their names. These settings specify the source, data to be transfered, and 
destination.
This setting is enabled only if one of these keys is selected after clicking Data Transfer in the Key Browser.

If Download Project is selected.

If Upload Project is selected.

Source: Select the external memory device which contains a project file (.ZNV) to transfer. The external 
memory device is USB flash drive.

Location: Specify the location of the project file (.ZNV) to transfer. The maximum number is 247 
characters.
Example: Where “Sample_Project.ZNV” is a project file saved on the root directory of a 

USB flash drive: 
Sample_Project.ZNV

Destination: Specify where to save the project uploaded from MICRO/I. The location is the USB flash drive.

Location: Specify the location of the folder where the uploaded project file will be saved. The 
maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Project” on a USB flash drive: 

Uploaded_Project
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If Download PLC Program is selected.

Source: Select the external memory device which contains a PLC program file (.ZLD) to transfer. The external 
memory device is USB flash drive.
Location: Specify the location of the PLC program file (.ZLD) to be transferred. The maximum number 

is 247 characters.
Example: Where “LDR_PROGRAM.ZLD” is a PLC program file saved in folder “LDRDATA” of 

a USB flash drive:
LDRDATA\LDR_PROGRAM.ZLD

Destination: Specify the destination PLC connected to the MICRO/I. The PLC type is configured in the Project 
Settings dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 
“3.4 Communication Driver Network Tab” on page 4-31.
Interface: Select the type of communication interface in which the MICRO/I is connecting to the 

download destination PLC.
SERIAL1(RS232C), SERIAL1(RS422/485), Ethernet

If SERIAL1(RS232C) or SERIAL1(RS422/485) is selected for Interface.
Slave Number: Specify the slave number of the download destination PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the destination PLC. This is the 
External Device ID number set in the Project Settings dialog box, on the 
Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the destination PLC.
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If Upload PLC Program is selected.

Source: Specify the source PLC connected to the MICRO/I. The PLC type is configured in the Project Settings 
dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-31.
Interface: Select the type of communication interface in which the MICRO/I is connecting to the 

upload source PLC.
SERIAL1(RS232C), SERIAL1(RS422/485), Ethernet

If SERIAL1(RS232C) or SERIAL1(RS422/485) is selected for Interface.
Slave Number: Specify the slave number of the upload source PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the upload source PLC. This 
is the External Device ID number set in the Project Settings dialog 
box, on the Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the upload source PLC.

Destination: Specify where to save the PLC program uploaded from the PLC connected to the MICRO/I. The location 
is the USB flash drive.
Location: Specify the location of the folder where the uploaded PLC program file will be saved. The 

maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Program” on a USB flash drive: 

Uploaded_Program
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Properties of Script for Multi-Functions dialog box

Sets the script for the Multi-Command.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Script ID
Specify the script ID (1 to 32000) of the script to operate.

Script Manager will open when  is clicked. Select a script from the script list.
For details, refer to Chapter 20 “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script selected in Script Manager.

■ (Script)
Displays the contents of the script selected in Script Manager.
Once this area is double clicked, the Script Editor will open and editing can be done.
For details, refer to Chapter 20 “2.3 Script Editor” on page 20-8.

(Script)
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Multi-Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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7.1 How the Timer is Used

Starts a countdown when the trigger condition is satisfied, and writes 1 to an internal device (HMI Timer Relay LTC) 
once the set time has elapsed.

7 Timer

MICRO/I

LTD0

0

1

LTC0: 0

LTC0: 1

1999 1998 999 1 0
LTD0

Start countdown Set �me 
has elapsed

Condition

SatisfiedSatisfiedSatisfied

Start 
countdown

0 0 1 0

Writes 1 
to LTC0

Writes the 
preset value 

to LTD0 and 0 
to LTC0

State of condition

Action

HMI timer relay 
LTC0 value

HMI timer current 
LTD0 value 19991999 1998 999 1 19990

Condition Condition Condition Condition

Not satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfied SatisfiedSatisfiedSatisfied Not satisfiedNot satisfiedNot satisfied

• The HMI Timer Relay LTC is an internal device (bit device) that changes to 1 once the time set for the 
timer has elapsed.

• The HMI Timer Current LTD is an internal device (word device) that stores current values for the timer.
• Once switched to the screen that the timer has been placed in, the following values will be given 

regardless of the whether the trigger condition is satisfied or not satisfied.
- HMI Timer Relay LTC: 0
- HMI Timer Current LTD: Preset Value
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7.2 Timer Configuration Procedure

This section describes the configuration procedure for Timers.

1 On the Home tab, in the Parts group, click Commands, and then click Timer.

2 Click a point on the edit screen where you wish to place the Timer.

3 Double-click the dropped Timer and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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7.3 Properties of Timer Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Timer Address Number
Specifies the HMI timer address number (0 to 31).
The device type for the HMI timer relay is LTC. The device type where the current value is stored is LTD.

■ Unit
Select the unit of time from sec or 100 msec.

■ Preset Value
Select the data type to use and the enter the preset value.
The preset value is the time from when the timer starts its countdown until 1 is written to the HMI Timer Relay LTC.

Example: When 0 is specified for Timer Address Number

HMI Timer Relay: LTC0

HMI Timer Current: LTD0

Value: When selecting sec in Unit, the preset value is specified with 1 to 65535 (second units) up to a 
maximum of 1092 minutes 15 seconds.
When selecting 100 msec in Unit, the preset value is specified with 1 to 65535 (100 msec units).

Device Address: Uses word device values.
Specify the device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

While ON: Command is executed when a value of device address is 1.

While OFF: Command is executed when a value of device address is 0.

While satisfying the condition: The command continues being executed while the condition is satisfied.

1

0

Value of
device address

Action Execution Execution Execution

1

0

Action

Value of
device address

Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-67.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Timer on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to configure the Alarm Log function and its operation on the MICRO/I.

  

1.1 How the Alarm Log Function is Used

The Alarm Log function samples the occurrence of alarms and recovery information by monitoring and evaluating the 
state of device addresses.
The Alarm Log function can perform the following functions.

• Monitor states of device addresses and create Alarm Log data

• Monitor states of device addresses and detect alarms

• Display an alarm screen when an alarm occurs

• Make a sound of the buzzer and screen flashing the screen when an alarm occurs

Chapter 13 Alarm Log Function

1 Overview

MICRO/I

External device

0 1

12:00

01

12:53

12:00
Alarm occurred

12:53    Recovered

12:54    Confirmed

Alarm Log data

 No. Message  Occurrence Time  Recovery Time Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:00 12/01 12:53:10 12/01 12:54:30

MICRO/I

External device

0 1 Alarm occurred

MICRO/I

External device

0 1 Voltage 
drop

Alarm screen

Alarm occurred

MICRO/I

External device

0 1
Beep

Alarm occurred
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• Output Alarm Log data to the external memory device

Output to 
External memory device

Alarm Log data (CSV)

External Memory Device
MICRO/I

USB flash drive
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1.2 Alarm States

Alarms have three states: occurred, recovered, and confirmed.

Example: When the source device address (the device address to monitor) is D100-0, the error state (when an alarm 
has occurred) is ON, the channel is set to Unlock, and the used key button is Check
When the source device address is ON, the alarm changes to the “Occurred” state. When the source device 
is OFF, the alarm changes to the “Recovered” state. When Check is pressed, the alarm changes to the 
“Confirmed” state.

If Check is pressed before the source device address changes to OFF, the alarm changes to the “Confirmed” 
state regardless of the state of the source device address.

Alarm state Details

Occurred
Indicates that an alarm has occurred. There are two types of alarms that occur.
First Alarm: The first alarm that occurs in a state where no alarms have occurred.
Second and later: An alarm that has occurred while another alarm is active.

Recovered
Indicates that the alarm that occurred has been recovered from.
However, for channels set to lock, the alarm is not recovered from until a key button is pressed 
(Check or All Check).

Confirmed Indicates the key button Check or All Check was pressed.

Record occurrence time D100-0 : ON

D100-0 : OFF

D100-0 : OFF

Source device address state

Occurred

Record recovery time Recovered

Record confirmation time Confirmed

Alarm Log data

Press Check

No alarm 
occurring state

NO/NC is NO, so the state is 

“Occurred”

Lock/Unlock is Unlock, so the 

state is “Recovered”

Alarm state

Record occurrence timeD100-0 : ON

D100-0 : OFF

Alarm state

Occurred

Record confirmation time Confirmed

Record recovery time  Recovered

Alarm Log data

Press Check

D100-0 : OFF

Source device address state
No alarm 

occurring state

NO/NC is NO, so the state is 

“Occurred”

Lock/Unlock is Unlock, so the 

state is “Recovered”
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1.3 Sampling Data

Data is sampled each time the alarm occurs, is recovered from, or confirmed. 
Example: When the message for channel number 1-1 is “Voltage drop” and the message for channel number 1-2 is 

“Temperature abnormal”

1
Channel No. 1-1: Alarm occurred Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:00) 1-1 Voltage drop 12/01/2011 12:50:00 ‒ ‒

Channel No. 1-2: No alarm

2

Channel No. 1-1: Alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:00) 1-1 Voltage drop 12/01/2011 12:50:00 ‒ ‒

Channel No. 1-2: Alarm occurred
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ ‒
(12:50:10)

3

Channel No. 1-1: Recovered from alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:20) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 ‒

Channel No. 1-2: Alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ ‒
(12:50:10)

4

Channel No. 1-1: Check pressed Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:30) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: Alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ ‒
(12:50:10)

5

Channel No. 1-1: Alarm occurred Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:51:00) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: Alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ ‒
(12:50:10)

1-1 Voltage drop 12/01/2011 12:51:00 ‒ ‒

6

Channel No. 1-1: Alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:51:00) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: Check pressed
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ 12/01 12:52:10
(12:52:10)

1-1 Voltage drop 12/01/2011 12:51:00 ‒ ‒

7

Channel No. 1-1: Alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:51:00) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: Recovered from alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 12/01 12:53:00 12/01 12:52:10
(12:52:10)

1-1 Voltage drop 12/01/2011 12:51:00 ‒ ‒
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1.4 Data Configuration

The sampled data is composed of the channel number, message, alarm state, time, and label.
The relationship between the Alarm Log function settings and the sampled data is as follows.

1. Data storage amount: The amount of data that can be saved in the data storage area. For details, refer to “Data 
Storage Amount” on page 13-8.

2. Channel No.: Composed of (Block No.)-(Channel No.). The device addresses to monitor and the conditions 
for alarm occurrence and recovery are configured in the channels. When the sampled data is 
output as a CSV file, the displayed label is “Ch.No.”.

3. Message: The message displayed when an alarm has occurred.

4. Alarm state and time: The alarm state (occurred, recovered, confirmed) and the time the alarm occurred, was 
recovered from, and confirmed. When the sampled data is output as a CSV file, the 
displayed label varies based on the output method.

5. Label: When the sampled data is output as a CSV file, this is the text displayed in the label row.
This cannot be changed.

 Ch.No. Message Occurrence Time Recovery Time Confirma�on Time

 1-1 Voltage drop 12/01/2011 12:00:05 12/01 12:01:10 12/01 12:01:30

 1-2 Temperature abnormal  12/01/2011 12:01:09 12/01 12:02:21 12/01 12:02:55

 1-1 Voltage drop 12/01/2011 12:02:00 12/01 12:03:11 12/01 12:05:12

 1-3 Overcurrent 12/01/2011 12:30:21 12/01 12:55:15 12/01 13:00:00

 1-1 Voltage drop 12/01/2011 12:45:36 12/01 12:53:12 12/01 12:57:41

1. Data storage amount

2. Channel No.

5. Label

3. Message 4. Alarm state and �me

Alarm Log settings

Sampled data
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For sampled data, the format for displayed items varies based on the output method.

■ Batch
Batch output shows the recovery and confirmation time for an alarm that has occurred on a single line.
The labels displayed in the label row are “Ch.No.”, “Message”, “Occurrence Time”, “Recovery Time”, and “Confirmation 
Time”.
Example: When the message for channel number 1-1 is “Voltage drop” and the message for channel number 1-2 is 

“Temperature abnormal”

■ Real Time
Real time output displays the alarm state and the time the alarm became that state on a single line each time an 
alarm occurs, is recovered from, or is confirmed.
The labels displayed in the label row are “Ch.No.”, “Message”, “State”, and “Time”.
Example: When the message for channel number 1-1 is “Voltage drop” and the message for channel number 1-2 is 

“Temperature abnormal”

Ch.No. Message Occurrence Time Recovery Time Confirmation Time

1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

1-2 Temperature abnormal 12/01/2011 12:50:10 -- 12/01 12:52:10

1-1 Voltage drop 12/01/2011 12:51:00 -- --

Ch.No. Message State Time

1-1 Voltage drop Occurred 12/01/2011 12:50:00

1-2 Temperature abnormal Occurred 12/01/2011 12:50:10

1-1 Voltage drop Recovered 12/01/2011 12:50:20
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1.5 Saving and Deleting Data

● Saving Data
You can select whether or not to save the sampled data in the data storage area. The method to save data is 
configured on the Channel tab in the Alarm Log Settings dialog box.

When Saving Data to the Data Storage Area

Select Store under Data in the Auto-Setup dialog box or in the Individual Settings dialog box.

If the number of active alarms exceeds the Alarm Log data storage amount set for the data storage area, the data is 
processed with either of the following methods.

■ Fixed
If the saved data exceeds the Alarm Log data storage amount, the new data is not saved.

■ Rotate
If the saved data exceeds the Alarm Log data storage amount, the oldest data is deleted and the new data is saved.

MICRO/I

External device

0 1

12:00

01

12:53

12:00
Alarm occurred

12:53    Recovered

12:54    Confirmed

Alarm Log data

 No. Message  Occurrence Time  Recovery Time Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:00 12/01 12:53:10 12/01 12:54:30

Alarm Log data storage amount

New data

Alarm Log data storage amount

Oldest data
(delete)

New data

When the backup battery is depleted, the data in the Alarm Log is erased when the MICRO/I is turned off.
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Data Storage Amount
The maximum amount of data that can be saved in the data storage area is as follows.

When Not Saving Data to the Data Storage Area

Select No Store under Data in the Auto-Setup dialog box or in the Individual Settings dialog box.
Use this option to monitor a state of device address and display only detected active alarms on the Alarm List Display.

● Deleting Data
The method to delete sampled data from the data storage area is as follows.
• On the Online tab in WindO/I-NV4, click the arrow under Clear, and click All or Alarm Log Data. For details, 

refer to Chapter 22 “4 Clear” on page 22-20.
• In the System Mode, on the Main Menu screen, press Initial Setting, Initialize, Alarm Log in order.

Model Maximum amount of data that can be saved in the data storage area

HG2G-5T 5,520

Alarm List Display

MICRO/I

External device

Voltage drop

0 1 Alarm occurred

Page
Up

Down
Page
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1.6 Using Data and Detected Alarms

The saved data and detected alarms can be used in the following ways.

● Using Saved Data
The saved data can be used in the following ways.

● Using Detected Alarms
• Display alarms with the Alarm List Display

Display detected alarms with the Alarm List Display.
For details, refer to “4.2 Displaying Registered Messages with the Alarm List Display According to the Active Alarm” 
on page 13-30.

• Display data with the Alarm 
Log Display
Display Alarm Log data with the 
Alarm Log Display.
For details, refer to Chapter 10 
“7 Alarm Log Display” on page 
10-113.

• Save to and read from a an 
external memory device
Output data from the MICRO/I to 
the external memory device as a 
CSV file and use it on a computer.
For details, refer to “4.4 Saving 
Data as a CSV File” on page 13-36.

To use with the MICRO/I To use with devices other than the MICRO/I

Alarm Log data

 Ch.No. Message Occurrence Time Recovery Time Confirma�on Time

 1-1 Voltage drop 12/01/2011 12:00:05 12/01 12:01:10 12/01 12:01:30

 1-2 Temperature abnormal  12/01/2011 12:01:09 12/01 12:02:21 12/01 12:02:55

 1-1 Voltage drop 12/01/2011 12:02:00 12/01 12:03:11 12/01 12:05:12

 1-3 Overcurrent 12/01/2011 12:30:21 12/01 12:55:15 12/01 13:00:00

 1-1 Voltage drop 12/01/2011 12:45:36 12/01 12:53:12 12/01 12:57:41

Select

Occurred Message Recovered Confirmed
12/01 12:51 Temperature abnormal  12:53 12:52
12/01 12:00 Voltage drop 12:53 12:52

Up Down Reference

External
Memory Device

Alarm Log data (CSV)

Book1

Sheet1 Sheet2 Sheet3

No. Occurrence Time Recovery Time Confirma�on Time Message
Pressure sensor fault
Hydraulic pressure low
Pressure sensor fault
Pressure sensor fault
Hydraulic pressure low
Pressure sensor fault

Alarm List Display

MICRO/I

External device

Voltage drop

0 1 Alarm occurred

Page
Up

Down
Page
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This section describes the configuration procedure for the Alarm Log function.

2.1 Configuring the Device Addresses to Monitor and the Alarm Detection Condition

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device address to monitor under Source Device Address Type on the Channel tab.

If you select Word, device addresses are configured per block.
If you select Bit, device addresses are configured per channel.

3 Set the number of blocks to manage in Number of Blocks.

1 channel is used for 1 device address to monitor. 1 block is 16 channels.
The number of blocks that can be set varies based on the Source Device Address Type setting and the model.

4 Select the reference screen type in Reference Screen.

The reference screen is associated with the channel. This screen is displayed when the key button Reference is 
pressed.
If a reference screen is not displayed, select Not Use.

5 To batch register all channels, click Auto. To individually register each channel, click Edit.

An example when Auto is clicked is described here.
The Auto-Setup dialog box is displayed.

2 Alarm Log Function Configuration Procedure
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6 Specify the device address to monitor in Source.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
For the Auto-Setup dialog box, the device addresses are sequentially set starting with the specified device address 
from the highlighted row in Settings.

7 Under Data, select whether or not to save Alarm Log data in the date storage area.

To display Alarm Log data on the MICRO/I or to output the data to a file, select Store.
If you select No Store, Alarm Log data is not created, but states of device addresses are monitored.

8 Under Alarm function, select whether or not to use the alarm function.

For channels with Disable selected, states of device addresses are not monitored and Alarm Log data is not created.

9 Under NO/NC, select the alarm detection condition.

If you select NO, the alarm occurs when the monitored bit changes from 0 to 1. If you select NC, the alarm occurs 
when the monitored bit changes from 1 to 0.

10 Under Lock/Unlock, select whether or not to automatically recover based on the state of the monitored bit.

If you select Unlock, the alarm is automatically recovered from based on the bit state when the monitored bit 
becomes the normal state.
If you select Lock, even if the monitored bit becomes the normal state, the alarm remains active until the key button 
Check is pressed.

11 Select the Text ID check box and specify the message to display when the alarm occurs as a Text Manager ID 
number (1 to 32000).

Number of blocks x 16 (number of channels) text IDs are used starting from the set ID number.

12 Specify the screen number (1 to 3000) to display when the key button Reference is pressed in Reference Screen 
Number.

Number of blocks x 16 (number of channels) screens are used starting from the screen number.
This option can only be configured when Base Screen or Popup Screen is selected in Reference Screen.
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13 Click OK.

The device addresses to monitor and the messages are batch configured and displayed in Settings.

14 Click OK.

The Alarm Log Settings dialog box closes.
This concludes configuring the device addresses to monitor and the alarm detection condition.

Next, configure the functions to execute using saved data and detected alarms.
 “4.1 Displaying Saved Data with the Alarm Log Display” on page 13-28
 “4.2 Displaying Registered Messages with the Alarm List Display According to the Active Alarm” on page 13-30
 “4.3 Make a Sound of the Buzzer and Flash the Screen when an Alarm has Occurred” on page 13-34
 “4.4 Saving Data as a CSV File” on page 13-36
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This section describes items and buttons on the Alarm Log Settings dialog box.

3.1 Alarm Log Settings Dialog Box

● General Tab
The General tab is used to configure what kind of data to sample when an alarm occurs and the methods for saving 
and deleting the sampled data.

■ Storage Method
Selects the data processing method when the number of active alarms exceeds the Alarm Log data storage amount 
set for the data storage area.

3 Alarm Log Settings Dialog Box

Fixed: If the saved data exceeds the Alarm Log data storage amount, the new data is not saved.

Rotate: If the saved data exceeds the Alarm Log data storage amount, the oldest data is deleted and the new data is saved.
Alarm Log data storage amount

New data

Alarm Log data storage amount

Oldest data
(delete)

New data
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■ Monitoring Period (x 100 msec)
Specifies the period to write the state of the monitored device address to the MICRO/I (6 to 500 (100 ms units)).

■ Monitor Number of Active Alarms
Select this check box to count the number of active alarms.

■ Monitor How Many Times Each Alarm has occurred
Select this check box to count the number of alarms that has occurred per channel.

■ Clear Log Data for Recovered Alarms
Select this check box to delete recovered data out of the saved Alarm Log data.

(Destination Device Address): Specifies a word device to write the number of active alarms.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

(Top Device Address): Specifies a word device to write the number of alarms that has occurred. Number of blocks x 
16 (number of channels) address numbers are used starting from the set device address.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
Example: When the number of blocks is 2 and LKR100 is specified as the start device address

The number of alarms that has occurred for channel number 1-0 is saved in 
LKR100. The number of alarms that has occurred for channel 1-1 is saved in 
LKR101, and this pattern continues up to LKR131 where the number of alarms that 
has occurred for channel number 2-15 is saved.

Top Device Address

Block 1

16 channels

Block 2

16 channels

Channel No.
LKR100
LKR101
LKR102

LKR114
LKR115
LKR116
LKR117
LKR118

LKR130
LKR131

1-0
1-1
1-2

1-14
1-15
2-0
2-1
2-2

2-14
2-15

• If you specify HMI Keep Registers (LKR) as the destination word device, the number of alarms that has 
occurred is retained even when the MICRO/I power is turned off.

• The amount of Alarm Log data saved in the data storage area with the Alarm Log function is stored in 
HMI Special Data Register LSD57.

• To monitor the number of alarms that has occurred, number of blocks x 16 (number of channels) device 
addresses are required from the set start device address. If the destination device address does not 
exist, “Device range error” occurs on the MICRO/I.

• If the values of the device addresses that are counting the number of alarms that has occurred are 
overwritten by another process, the alarms cannot be accurately counted.

(Trigger Device Address): Specifies the bit device or bit number of the word device to serve as condition to delete data. 
The recovered data is deleted when the value of the configured device address changes from 
0 to 1. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
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■ Monitor the State of Each Alarm
Select this check box to check the alarm state per channel.

The following values are written to the bits depending on the alarm state.

■ Call Popup Screen
These settings configure the popup screen to display when an alarm occurs. The popup screen displayed when an 
alarm occurs is called the alarm screen.

 

■ Number of Stored Data
Specifies the maximum amount of Alarm Log data saved in the data storage area. Data is saved up to the set amount. 
The maximum amount of data that can be saved in the data storage area is as follows.

Click  to open the Data Storage Area Management dialog box. You can change the allocation of data storage area 
memory in the Data Storage Area Management dialog box. For details, refer to Chapter 16 “Data Storage Area” on 
page 16-1.

(Top Device Address): Specifies a word device to write the alarm state. Number of blocks x 16 (number of channels) 
address numbers are used starting from the set device address.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

Bit 15 Bit 0Bit 3

0: Before alarm/a�er recovery
1: A�er alarm
0: Second and later alarm (Alarm that has occurred again while an alarm is ac�ve)
1: First alarm (First alarm that occurred)
0: A�er confirm
1: Before confirm

Reserved

Call Popup Screen: Select this check box to display the alarm screen when an alarm occurs.

Screen Number: Specifies the alarm screen number (1 to 3015) to display when an alarm occurs.

Coordinates X, Y: Specifies the coordinates to display the alarm screen.
With the upper-left corner of the screen as the origin, the upper-left corner of the alarm screen 
is the X and Y coordinates.
The units and range for the display coordinates is as follows.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

HG2G-5T: 5,520
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● Channel Tab
The Channel tab is used to configure the device addresses to monitor and the alarm detection condition.

■ Source Device Address Type
Selects the type of device address to monitor.

■ Number of Blocks
Configures the Alarm Log data in block units. The number of blocks that can be set varies based on the Source 
Device Address Type setting.

■ Reference Screen
Select the type of reference screen from the following items.
Base Screen, Popup Screen, Not Use
The reference screen is displayed when a message is selected on the Alarm List Display or the Alarm Log Display and 
the key button Reference is pressed. It is the base screen or popup screen associated with each channel.

Word: Uses a word device. Device Addresses are configured per block.

Bit: Uses a bit device. Device Addresses are configured per channel.

Word: 0 to 128

Bit: 0 to 8

1 block is composed of 16 channels. 1 device address can be monitored for each channel. The maximum 
number of device addresses that can be monitored is 16 for each block.

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Key Button Reference

1. Select a message displayed  
on the Alarm List Display  
or the Alarm Log Display

Reference screen

2. Press the Key Button Reference The reference screen opens
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■ Settings
The Alarm Log settings for each channel are edited here.

■ Auto
Batch registers or changes the settings for all the channels.
Click this button to open the Auto-Setup dialog box. The Auto-Setup dialog box settings are reflected in all the 
channels.
For details, refer to “Auto-Setup Dialog Box and Individual Settings Dialog Box” on page 13-18.

■ Edit
Registers or changes the settings for the selected channel.
Select a channel and click this button to open the Individual Settings dialog box. The settings for the selected channel 
are reflected in the Individual Settings dialog box.
For details, refer to “Auto-Setup Dialog Box and Individual Settings Dialog Box” on page 13-18.

No.: Displayed as (Block No.)-(Channel No.). Double clicking the cell opens the Individual Settings 
dialog box.

Source: Shows the bit device or bit of the word device to monitor. Double clicking the cell opens the 
Tag Editor.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

Data: Shows whether or not to save Alarm Log data in the date storage area.
Double clicking the cell switches between Store and No Store.
Setting to Store makes the buzzer sound when the value of bit for the channel changes to 1.

Alarm function: Shows whether or not the alarm function is used. Double clicking the cell switches between 
Enable and Disable. Channels switched to Disable cannot be configured. States of device 
addresses are not monitored and Alarm Log data is not created.

NO/NC: Shows the alarm detection condition. Double clicking the cell switches between NO and NC.

Lock/Unlock: Shows whether or not to automatically recover based on the state of the monitored bit. 
Double clicking the cell switches between Lock and Unlock.

Text ID: Shows the Text Manager ID number (1 to 32000) to use for the message displayed when an 
alarm occurs. Double clicking the cell allows you to specify the Text Manager ID number.

Text Message: Shows the text for the specified text ID. Double clicking the cell opens the Text Manager.

Reference Screen No.: Shows the screen number to display when the key button Reference is pressed. Double 
clicking the cell opens the Individual Settings dialog box.
This option can only be configured when Base Screen or Popup Screen is selected in 
Reference Screen.
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Auto-Setup Dialog Box and Individual Settings Dialog Box

With the Auto-Setup dialog box, the Alarm Log settings for all channels are batch registered or changed.
With the Individual Settings dialog box, the Alarm Log settings for the selected channel are registered or changed.

■ Channel*1

Shows the block number and the channel number for the selected channel.

■ Block Settings
Configures Source and Data in block units.

*1 Individual Settings dialog box only

Block Number: Shows the block number for the channel selected in Settings.

Channel Number: Shows the channel number for the channel selected in Settings.

Source: For the Auto-Setup dialog box, the device addresses are sequentially set from block number 1-channel 
number 1, starting with the specified device address.
For the Individual Settings dialog box, if Source Device Address Type on the Channel tab is Word, 
the 16 channels for the block selected at the start of the specified device address are batch configured. 
For Bit, the selected channel is individually configured.

Click  to open the Tag Editor where you can edit the device address. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Data: Selects whether or not to save Alarm Log data in the date storage area.
For the Auto-Setup dialog box, all the channels are batch configured.
For the Individual Settings dialog box, the 16 channels for the selected block are batch configured.

Store: Alarm Log data can be displayed on the MICRO/I or output to file.

No Store: Alarm Log data is not created, but states of device addresses are monitored.
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■ Channel Settings
The trigger condition for the channel is configured here.

Alarm function: Selects whether or not to use the alarm function.

Enable: Monitors the state of the device address configured for the channel and samples 
the alarm information.

Disable: Does not monitor the state of the device address. No Alarm Log data is created.

NO/NC: Selects the alarm detection condition.

NO: The alarm occurs when the monitored bit changes from 0 to 1.

NC: The alarm occurs when the monitored bit changes from 1 to 0.

Lock/Unlock: Selects whether or not to automatically recover based on the state of the monitored bit.

Lock: Even if the monitored bit returns the normal state, the alarm remains active until 
the key button Check is pressed.

Unlock: The alarm is automatically recovered from based on the bit state when the 
monitored bit returns the normal state.

Example: NO/NC is NO

Press Check Record confirma�on �me

Record recovery �me

Record occurrence �me

Unlock

Record confirma�on �me
Record recovery �me

No opera�on

Record occurrence �me

Lock

0 1

0 1

Monitored bit

Alarm occurred

The display on the Alarm List Display disappears when the alarm is recovered from, regardless of the Lock/
Unlock setting. To keep displaying the alarm until Check is pressed, use the Alarm Log Display.

Text ID: To use text registered in Text Manager as the message to display when an alarm occurs, 
select this check box and specify the Text Manager ID number to use as the message. 
Number of blocks x 16 (number of channels) text IDs are used starting from the set ID 
number.

Click  to open Text Manager where you can edit the text.

Text: Shows the text for the specified text ID.

Reference Screen Number: Specifies the screen number (1 to 3000) to display when the key button Reference is 
pressed. Number of blocks x 16 (number of channels) screens are used starting from the 
screen number.
This option can only be configured when Base Screen or Popup Screen is selected in 
Reference Screen.
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● External Memory Device Tab
The External Memory Device tab is used to configure whether or not to output saved data to the external memory 
device.

The output data is stored in the following folder on the external memory device.

The default External Memory Device folder name is “HGDATA01”. For details, refer to Chapter 27 “1.6 Setting the 
External Memory Device Folder” on page 27-14.

\External Memory Device folder\ALARMLOG

Sampled data after starting output to the external memory device is not included in the output data.



WindO/I-NV4 User’s Manual 13-21

3 Alarm Log Settings Dialog Box

13

Alarm
 Log Function

■ Batch
Select this check box to batch output all the sampled data to the external memory device.

All the data is saved on the external memory device when the value of the Trigger Device Address changes from 0 to 
1. If a file with the same name already exists on the external memory device, that file is overwritten. The maximum 
amount of output data is the amount configured by the data storage area.

MICRO/I

Alarm Log data (CSV)

Output to 

External memory device 
Alarm Log data

0 1

Trigger Device Address

 Ch.No. Message  Occurrence Time  Recovery Time Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:05 12/01 12:01:10 12/01 12:01:30

 1-2 Temperature abnormal  12/01/2011 12:01:09 12/01 12:02:21 12/01 12:02:55

 1-1 Voltage drop  12/01/2011 12:02:00 12/01 12:03:11 12/01 12:05:12

 1-3 Overcurrent  12/01/2011 12:30:21 12/01 12:55:15 12/01 13:00:00

 1-1 Voltage drop  12/01/2011 12:45:36 12/01 12:53:12 12/01 12:57:41

Data to be output (all)

External Memory Device

USB flash drive

The storing of data stops if there is insufficient free space on the external memory device. The error 
information is stored in the following HMI Special Data Registers. For details about the error information, 
refer to Chapter 28 “HMI Special Data Register (LSD)” on page 28-5.
USB flash drive: LSD33

Trigger Device Address: Specifies the bit device or bit number of the word device to serve as condition for batch 
output. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
Data is output to file when the value of the Trigger Device Address changes from 0 to 1.

File Name: Enter the file name for the output data or shows the file name.

The default is “ALMHTO.CSV”. To change the file name, enter a new file name. The 
maximum number is 120 characters (including the extension).

Specify File Name by Value of Device Address: Select this check box to assign a file name 
for the output data using a value of device 
address specified in the File Name Device 
Address.

(File Name Device Address): Specifies a word device to create a file name. The file 
name is set by reading the values sequentially from 
the starting device specified with the File Name 
Device Address and handling those values as 
character data up to the character before NULL (00).
The maximum number of device addresses is 40 (2 
characters per word device, maximum of 80 single-
byte characters). You can only specify an internal 
device. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

Example: When the device address specified by (File Name Device Address) is LDR100 
and the text to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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Add Device Address data to File Name: Select this check box to add the bottom three digits of 
the value of the device address configured by (File 
Name Device Address) to the end of the file name for 
the output data.

(File Name Device Address): Specifies the word device that is the source for the value to 
add to the file name. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-64. This option can only be configured when the Add 
Device Address data to File Name check box is selected.

Example: When File Name is "ALMHTO01" and the value of device address in (File Name 
Device Address) is 123, the file name is "ALMHTO01123.CSV".

Add Time Stamp: Select from the following format for date and time to be added to the file 
name when data is output:
None, YY, YY+MM, YY+MM+DD, YY+MM+DD+HH, 
YY+MM+DD+HH+MM, YY+MM+DD+HH+MM+SS
The format is YYMMDD_TTMMSS (YY: year, MM: month, DD: day, HH: hour, 
MM: minute, SS: second).

Example:  File Name is "ALMHTO01" on September 15 2013 at 23:30:50

YY: ALMHTO01_13

YY+MM: ALMHTO01_1309

YY+MM+DD: ALMHTO01_130915

YY+MM+DD+HH: ALMHTO01_130915_23

YY+MM+DD+HH+MM: ALMHTO01_130915_2330

YY+MM+DD+HH+MM+SS: ALMHTO01_130915_233050

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be 
output.

 When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the values of the source word devices exceeds the maximum number of device addresses (no 

NULL), the text is up to the maximum number of device addresses from the start.
- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot beused, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.
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■ Real Time
Select this check box to output data to the external memory device in real time.

With real time output, data is saved to the external memory device in three minute intervals after the MICRO/I starts 
running. If the accumulated data reaches 819th item, then the data is forcibly saved to the external memory device. 
When there is already data with the same file name on the external memory device, data is appended to that file. If 
there was no update to the data during the three minutes, it is not output.
Data is appended to the file until the size of the file reaches the restriction size (256 MB), so the maximum amount of 
output data varies based on the settings for the output channel such as the amount of data, the data size, and the labels.

If the interval to update the Alarm Log is shorter than real time output (the interval for writing to the external memory 
device), that Alarm Log is recorded up to the 1023rd item, and then afterwards, old data is discarded in order and 
replaced with new data.

 

MICRO/I

Alarm Log data (CSV)

Alarm Log data

 Time State Ch.No. Message

 12/01/2011 12:00:05 Occurred  1-1 Voltage drop

 12/01/2011 12:01:09 Occurred  1-2 Temperature abnormal

 12/01/2011 12:01:10 Recovered 1-1 Voltage drop

 12/01/2011 12:03:30 Confirmed  1-1 Voltage drop

 12/01/2011 12:03:09 Occurred  1-3 Overcurrent

 12/01/2011 12:04:33 Recovered 1-2 Voltage drop

 12/01/2011 12:05:15 Confirmed  1-2 Voltage drop

 12/01/2011 12:08:41 Recovered 1-3 Overcurrent

Data to be output 
3 minutes after 
operation starts

Data to be output 
3 minutes after that

Data to be output after 
another 3 minutes

3 minute interval 
after operation starts

Output to
External memory device 

External Memory Device

USB flash drive

Real time output stops when the file size of the Alarm Log data exceeds 256 MB or when there is 
insufficient space on the external memory device. The error information is stored in the following HMI 
Special Data Registers. For details about the error information, refer to Chapter 28 “HMI Special Data 
Register (LSD)” on page 28-5.
USB flash drive: LSD33

• When the value of HMI Special Internal Relay LSM20 changes from 0 to 1, the data at that time is first 
output in real time to the external memory device, and then access to the external memory device is 
stopped.

• The amount of free space on the external memory device is saved to the following HMI Special Data 
Registers. For details about the free space on the External Memory Devices, refer to Chapter 28 “HMI 
Special Data Register (LSD)” on page 28-5.
USB flash drive: LSD34, 35

Trigger Condition: Select the check boxes for the items that will trigger the output of Alarm Log data to the external memory 
device.
Occurrence: Alarm Log data is output to the external memory device when an alarm has 

occurred.
Recovery: Alarm Log data is output to the external memory device when the alarm is 

recovered from.
Confirmation: Alarm Log data is output to the external memory device when the key button Check was 

pressed.

Month/day/year hour:minute:second is output for the trigger condition occurrence time, recovery time, and 
confirmation time.
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File Name: Enter the file name for the output data or shows the file name.
The default is “ALMHTA.CSV”. To change the file name, enter a new file name. The maximum 
number is 120 characters (including the extension).
Specify File Name by Value of Device Address: Select this check box to specify the name of the file 

for the output data with the value of the device 
address configured by (File Name Device Address).

(File Name Device Address): Specifies the word device that is the source of the data to use as 
the file name. The file name is set by reading the values 
sequentially from the starting device address specified with the 
File Name Device Address and handling those values as character 
data up to the character before NULL (00).
The maximum number of device addresses is 40 (80 single-byte 
characters). You can only specify an internal device. For the 
device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-64.

Example: When the device address specified by (File Name Device Address) is LDR100 and the 
text to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

Add Device Address data to File Name: Select this check box to add the bottom three digits of the 
value of the device address configured by (File Name Device 
Address) to the end of the file name for the output data.

(File Name Device Address): Specifies the word device that is the source for the value to add to 
the file name. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-64. This 
option can only be configured when the Add Device Address 
data to File Name check box is selected.

Example: File Name is "ALMHTA" and the value of the device address configured by (File Name 
Device Address) is 123, the file name is "ALMHTA123.CSV".

Add Time Stamp: Selects the format of the output date and time to add to the file name for the 
output data.
None, YY, YY+MM, YY+MM+DD
The format is YYMMDD (YY: year, MM: month, DD: day).

Example: File Name is "ALMHTA" on September 15 2013

YY: ALMHTA_13

YY+MM: ALMHTA_1309

YY+MM+DD: ALMHTA_130915

Realtime Output: Select this check box to forcibly output the data and save it to file at the desired 
timing.

(Trigger Device Address): Specifies the bit device or the bit number of the word device to 
serve as the condition to forcibly output the data. You can only 
specify an internal device. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-64. 
Data is output to file when the value of Trigger Device Address 
changes from 0 to 1.

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be 
output.

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for the 

data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may slow 

down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the values of the source word devices exceeds the maximum number of device addresses (no 

NULL), the text is up to the maximum number of device addresses from the start.
- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.

• The following operations are as follows if the Realtime Output check box is selected.
- Even if the data is outputted forcibly, the real time output period (3 minute interval) is not reset.
- While data is being output with the real time output function, the file is not output when the value of 

the Realtime Output device address is 1.
- Even when output has finished, the value of device does not automatically change to 0.

• The function to sample data operates when Alarm Log data is being saved to the external memory device.
• The batch output or real time output status of the Alarm Log data can be checked with the value of HMI 

Special Internal Relay LSM36. When the data starts to be written to the external memory device, the 
value of device address is 1. When writing is complete, the value is 0.

• The methods to erase Alarm Log files saved on the external memory device are as follows.
- To erase files during operation using parts, on the External Memory Device tab on the Project 

Settings dialog box, select the Remove Files check box and the All Alarm Log data check box, and 
then configure the trigger device address. Assign that trigger device address to a part.

- To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in 
External Memory Device to open the Clear Data dialog box. Select the Alarm Log Data check box 
and click OK.
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Output Data File Name

The file name format is as follows.
File Name Value of Device Address_YYMMDD_TTMMSS.CSV

■ Example 1

Result: The file name is "ALMHTO123_1309.CSV".

■ Example 2

Result: The file name is "IDEC123_130915_233050.CSV".

File Name: The text entered in File Name or the text entered according to the value of the 
device address set by Specify File Name by Value of Device Address

Value of Device Address: The lower 3 digits of the value of the device address configured by Add Device 
Address data to File Name

YYMMDD: The year, month, and day of the month set on Add Time Stamp

TTMMSS: The hour, minute, and second of the time configured on Add Time Stamp

Item Setting

File Name ALMHTO

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM Date when data was output: September 2013

Item Setting

Specify File Name by Value of Device 
Address

(File Name Device Address) is 
LDR100
Text to set is "IDEC"

LDR100 value: 4944 (Hex)
LDR101 value: 4543 (Hex)
LDR102 value: 0000 (Hex)

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM+DD+HH+MM+SS
Date and time when data was output: 
September 15 2013 at 23:30:50
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● Options Tab
The Options tab is used to configure whether or not the MICRO/I’s internal buzzer operates and the screen flashing.

■ Trigger Buzzer when Alarm occurs
Select this check box to sound a beep when an alarm has occurred.

■ Screen flashing when Alarm occurs
Select this check box to have the screen flash when an alarm occurs.

■ Buzzer and Screen Flashing
This item selects the condition for the alarm to sound the buzzer or to flash the screen. This item can only be 
configured when the Buzzer when Alarm occurs or the Screen flashing when Alarms occurs is selected.

■ Stop the Sound of the Buzzer and Screen flashing
Select the check box for the items that will trigger the sound of the buzzer and screen flashing to stop.

*1 The first alarm that has occurred in a state where no alarms are active

All Alarms: The buzzer is triggered and the screen flashing each time an alarm occur.

Only First Alarm: The buzzer is triggered and the screen flashing only when the first alarm*1 occurs.
No beeps will sound and no screen will flash when another alarm is already active.

When touch everywhere on the screen: The sound of the buzzer and screen flashing stops when you touch 
anywhere on the screen.

When press Check or All Check button: The sound of the buzzer and screen flashing stops when you touch the 
key buttons Check or All Check on the Alarm Log Display.

When all Alarms are recovered: The sound of the buzzer and screen flashing stops when all the alarms 
are recovered from.

• While the beep is sounding, System Area 1 (address number+1, bit 6) is 1.
• While the screen is flashing, System Area 1 (address number+1, bit 2) is 1.
• To stop the sound of the buzzer and the screen flashing when an alarm has occurred, use the following methods.

- Press the key button Stop the Sound of the Buzzer and Screen flashing
- When a condition selected with the Stop the Sound of the Buzzer and Screen flashing check 

boxes is satisfied
- To stop the sound of the buzzer, set System Area 1 (address number+1, bit 6) to 0
- To stop the screen flashing, set System Area 1 (address number+1, bit 1 to 4) to 0
However, when System Area 1 (address number+1, bit 6) is 1 for a reason other than the occurrence of an 
alarm, the sound of the buzzer does not stop until 0 is written. When System Area 1 (address number+1, 
bit 1 to 4) are 1, the alarm is triggered, however, the screen flashing doesn't stop until 0 is written into it.

• If you stop the screen flashing, the backlight turns off when System Area 1 (address number+1, bit 0), 
and the backlight turns on when it is 1.
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4.1 Displaying Saved Data with the Alarm Log Display

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device address to monitor under Source Device Address Type on the Channel tab and specify 
Number of Blocks.

3 Select the channel number to register and click Edit.

The Individual Settings dialog box is displayed.

4 Specify the device address to monitor in Source and select Store under Data.

4 Using Data and Detected Alarms
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5 Select Enable under Alarm function, configure NO/NC and Lock/Unlock, and click OK.

You are returned to the Alarm Log Settings dialog box.

6 Repeat steps 3 through 5 to register all the channels.

7 Click OK.

The Alarm Log Settings dialog box closes.

8 On the Home tab, in the Parts group, click Data Displays, and then click Alarm Log Display.

9 Click a point on the edit screen where you wish to place the Alarm Log Display.

10 Double-click the dropped Alarm Log Display and a Properties dialog box will be displayed.

11 Change the settings on each tab as necessary.

For details, refer to Chapter 10 “7.3 Properties of Alarm Log Display Dialog Box” on page 10-115.

12 Click OK.

The Properties of Alarm Log Display dialog box closes.
This concludes configuring the MICRO/I to display saved data with the Alarm Log Display.
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4.2 Displaying Registered Messages with the Alarm List Display According to the Active Alarm

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device address to monitor under Source Device Address Type on the Channel tab and specify 
Number of Blocks.

3 Select the channel number to register a message to and click Edit.

The Individual Settings dialog box is displayed.
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4 Specify the device address to monitor in Source and select No Store under Data.

5 Select Enable under Alarm function and configure NO/NC and Lock/Unlock.

6 Select the Text ID check box and click .

Text Manager opens.

7 Double click the (Text) and enter the message.

8 Click OK.

You are returned to the Individual Settings dialog box.

(Text) 
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9 Click OK.

The registered message is displayed in Settings.

10 Repeat steps 3 through 9 to register messages for all the channels.

11 Click OK.

The Alarm Log Settings dialog box closes.

12 On the Home tab, in the Parts group, click Data Displays, and then click Alarm List Display.

13 Click a point on the edit screen where you wish to place the Alarm List Display.

14 Double-click the dropped Alarm List Display and a Properties dialog box will be displayed.

The messages to use can be registered in advance in Text Manager.
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15 On the General tab, under Message Settings, select Use Alarm Log Settings.

16 Configure the other settings and the settings on each tab as necessary.

For details, refer to Chapter 10 “6.3 Properties of Alarm List Display Dialog Box” on page 10-99.

17 Click OK.

The Properties of Alarm List Display dialog box closes.
This concludes configuring the MICRO/I to display registered messages with the Alarm List Display according to the 
active alarm.
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4.3 Make a Sound of the Buzzer and Flash the Screen when an Alarm has Occurred

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device address to monitor under Source Device Address Type on the Channel tab and specify 
Number of Blocks.

3 Select the channel number to register a message to and click Edit.

The Individual Settings dialog box is displayed.

4 Specify the device address to monitor in Source and select Store under Data.

5 Select Enable under Alarm function, configure NO/NC and Lock/Unlock, and click OK.

You are returned to the Alarm Log Settings dialog box.
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6 Click the Options tab in the Alarm Log Settings dialog box.

7 Select the Trigger Buzzer when Alarm occurs check box to make a sound of the buzzer when an alarm has 
occurred.

8 Select the Screen flashing when Alarm occurs check box to have the screen flashing when an alarm has 
occurred.

9 Click OK.

The Alarm Log Settings dialog box closes.
This concludes configuring the settings to make a sound of the buzzer and the screen flashing when an alarm has 
occurred.
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4.4 Saving Data as a CSV File

● Saving Data as a CSV File
The Alarm Log data can be saved to the external memory device as a CSV file or uploaded to a computer.
The procedure to save the data is as follows.
• To save the data to an external memory device, click Alarm Log on the WindO/I-NV4 Configuration tab to open 

the Alarm Log Settings dialog box. Select an output method check box on the External Memory Device tab and 
configure the items. The data can be saved to the External Memory Device folder on the external memory device. 
For details, refer to “External Memory Device Tab” on page 13-20.

● Data Structure and Output Example
The data structure for files output with batch output and real time output is different.

■ Batch
Batch output shows the recovery and confirmation time for an alarm that has occurred on a single line.
The data structure of files output with batch output is as follows. Bold items are replaced by the Alarm Log settings, 
sampled data, project file name, and WindO/I-NV4 version.

Headers

"Project Name","Project name","Version number"

"File Type","Log type"

Blank row

Title row "Ch.No.","Message","Occurrence Time","Recovery Time","Confirmation Time"

Data row

" Channel number","Message"," MM/DD/YYYY HH:MM:SS"," MM/DD/YYYY HH:MM:SS",
" MM/DD/YYYY HH:MM:SS"

·
·
·

Output example Data size of each row

"Project Name","Dimmer Console","V4.50" - 41 bytes

"File Type","Alarm Log Data" - 30 bytes

- 2 bytes

"Ch.No.","Message","Occurrence Time","Recovery Time","Confirmation Time" - 74 bytes

" 1-0","Voltage drop"," 08/11/2011 14:46:12"," 08/11 14:46:13"," 08/11 
14:46:16"

- 82 bytes

" 1-1","Temperature abnormal"," 08/11/2011 14:47:18"," 08/11 14:47:19",
" 08/11 14:47:20"

- 90 bytes

·
·
·
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■ Real Time
Real time output displays the alarm state and the time the alarm became that state on a single line each time an 
alarm occurs, is recovered from, or is confirmed.
The data structure of files output with real time output is as follows. Bold items are replaced by the Alarm Log 
settings, sampled data, project file name, and WindO/I-NV4 version.

Headers

"Project Name","Project name","Version number"

"File Type","Log type"

Blank row

Title row "Time","State","Ch.No.","Message"

Data row

" MM/DD/YYYY HH:MM:SS","State"," Channel number","Message"

·
·
·

Output example Data size of each row

"Project Name","Dimmer Console","V4.50" - 41 bytes

"File Type","Alarm Log Data" - 30 bytes

- 2 bytes

"Time","State","Ch.No.","Message" - 35 bytes

" 08/11/2011 14:46:12","Occurred"," 1-0","Voltage drop" - 57 bytes

" 08/11/2011 14:46:13","Recovered"," 1-0","Voltage drop" - 58 bytes

" 08/11/2011 14:46:16","Confirmed"," 1-0","Voltage drop" - 58 bytes

" 08/11/2011 14:47:18","Occurred"," 1-1","Temperature abnormal" - 65 bytes

·
·
·

• The data size for each row is counted as 2 bytes for full-width characters, 1 byte for half-width characters, 
and 2 bytes for newlines. The total for each row is the total amount of space for the file.

• A space is inserted before the date in the data row.
• The display type for the date and time varies based on the language configured in Project Settings, on 

the Project Details tab, in Language.
Japanese: YYYY/MM/DD HH:MM:SS
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY HH:MM:SS
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This chapter describes how to configure the Data Log function and its operation on the MICRO/I.

  

1.1 How the Data Log Function is Used

The Data Log function samples values of device addresses with the MICRO/I using the configured sampling condition. 
The sampled values of device addresses are saved in internal memory along with the sampling time.
The Data Log function can perform the following functions.

• Sample values of device addresses at a fixed interval

• Sample values of device addresses when a value of device address changes

• Output Data Log data to the external memory device

• Copy Data Log data to internal devices

Chapter 14 Data Log Function

1 Overview

MICRO/I

External device

D100 : 123

D100 : 55

12 : 00

12 : 05

12 : 10

D100 : 0

MICRO/I

External device

D100 : 123
0 1

Output to
External memory device

Data Log data (CSV)

MICRO/I
External Memory Device

USB flash drive

MICRO/I

External device

(Internal device)

124
125
126

Data Log data

 Sampling Time Data001

 01/01/2011 12:00:30 120

 01/01/2011 12:01:30 121

 01/01/2011 12:02:30 122

 01/01/2011 12:03:30 123

 01/01/2011 12:04:30 124

 01/01/2011 12:05:30 125

 01/01/2011 12:06:30 126

LDR10 : 126

LDR11 : 125

LDR12 : 124

Copy
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1.2 Sampling Values of Device Addresses

The MICRO/I samples values of target device addresses at a regular interval or when a value of device address 
changes.

● Sampling Value of Device Addresses at a Regular Interval
When sampling values of device addresses (D100 to D102) at a 5 minute interval (Time: 300 seconds) with the data 
storage amount in the data storage area is set to 3, the MICRO/I samples Data Log data as follows.

1 5 minutes after data sampling starts, the MICRO/I stores the values for device addresses D100 to D102.

2 10 minutes after data sampling starts, the MICRO/I stores the values for device addresses D100 to D102.

3 15 minutes after data sampling starts, the MICRO/I stores the values for device addresses D100 to D102.

4 20 minutes after data sampling starts, the MICRO/I stores the values for device addresses D100 to D102.

Since the data storage amount in the data storage area is set to 3, the oldest data is deleted in order to make room 
for the newest data.

MICRO/I

External device
12 : 05 : 00

12 : 10 : 00

12 : 15 : 00

D100 D101 D102

20  80 2

10  70 3

30  90 1

I/ORCIM eht no derots ataDValues of Device Addresses

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
01/01/2011 12:01:00 10 70 3 01/01/2011 12:05:00 20 80 2
01/01/2011 12:02:00 20 80 2 01/01/2011 12:10:00 10 70 3
01/01/2011 12:03:00 30 90 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:04:00 10 70 3
01/01/2011 12:05:00 20 80 2
01/01/2011 12:06:00 30 90 1
01/01/2011 12:07:00 10 70 3
01/01/2011 12:08:00 20 80 2
01/01/2011 12:09:00 30 90 1
01/01/2011 12:10:00 10 70 3
01/01/2011 12:11:00 20 80 2
01/01/2011 12:12:00 30 90 1
01/01/2011 12:13:00 10 70 3
01/01/2011 12:14:00 20 80 2
01/01/2011 12:15:00 30 90 1
01/01/2011 12:16:00 10 70 3

1
2

3

I/ORCIM eht no derots ataDValues of Device Addresses

Time
Value

Sampling Time
Value

D100 D101 D102 Data 1 Data 2 Data 3
···

···
···

···

01/01/2011 12:17:00 40 60 2 01/01/2011 12:10:00 10 70 3
01/01/2011 12:18:00 30 60 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:19:00 10 90 3 01/01/2011 12:20:00 20 80 2
01/01/2011 12:20:00 20 80 2

4

Deleted
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● Sampling Values of Device Addresses when a Value of Device Address Changes
If sample values of device addresses (D100 to D102), when a bit device or bit of the word device configured as the 
sampling condition switches from 0 to 1 and the data storage amount in the data storage area is set to 3, the MICRO/
I samples Data Log data as follows.

1 When data sampling starts and the value of device address configured as the sampling condition switches from 0 to 1, 
the MICRO/I stores the values for device addresses D100 to D102.

2 When the value of device address configured as the sampling condition switches from 0 to 1 the second time, the 
MICRO/I stores the values for device addresses D100 to D102.

3 When the value of device address configured as the sampling condition switches from 0 to 1 the third time, the 
MICRO/I stores the values for device addresses D100 to D102.

4 When the value of device address configured as the sampling condition switches from 0 to 1 the fourth time, the 
MICRO/I stores the values for device addresses D100 to D102.

Since the data storage amount in the data storage area is set to 3, the oldest data is deleted in order to make room 
for the newest data.

MICRO/I

External device
D100 D101 D102
20  80 2

0 1

0 1

0 1

0 1

I/ORCIM eht no derots ataDValues of Device Addresses

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
01/01/2011 12:01:00 10 70 3 01/01/2011 12:05:00 20 80 2
01/01/2011 12:02:00 20 80 2 01/01/2011 12:13:00 10 70 3
01/01/2011 12:03:00 30 90 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:04:00 10 70 3
01/01/2011 12:05:00 20 80 2
01/01/2011 12:06:00 30 90 1
01/01/2011 12:07:00 10 70 3
01/01/2011 12:08:00 20 80 2
01/01/2011 12:09:00 30 90 1
01/01/2011 12:10:00 10 70 3
01/01/2011 12:11:00 20 80 2
01/01/2011 12:12:00 30 90 1
01/01/2011 12:13:00 10 70 3
01/01/2011 12:14:00 20 80 2
01/01/2011 12:15:00 30 90 1
01/01/2011 12:16:00 10 70 3

1
2

3

0 1

I/ORCIM eht no derots ataDValues of Device Addresses

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
···

···
···

···

01/01/2011 12:17:00 40 60 2 01/01/2011 12:13:00 10 70 3
01/01/2011 12:18:00 30 60 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:19:00 10 90 3 01/01/2011 12:20:00 20 80 2
01/01/2011 12:20:00 20 80 2

4

Deleted
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1.3 Data Configuration

The sampled data is composed of the sampling time, values of device addresses, and labels.
The relationship between the Data Log function settings and the sampled data is as follows.

1. Channel The sampled data is in channel units. A maximum of 20 channels can be configured.
2. Data storage amount: The amount of sampled data to save. The maximum amount that can be configured per 

device address differs according to the model. For details, refer to “Data Storage 
Amount” on page 14-5.

3. Amount of data: The amount of data configured for one channel. The maximum amount of data that can 
be configured is 128. The maximum number of device addresses that can be configured 
to sample values is 128 total for all channels.
For example, when the amount of data for channel 1 is set to 128, this is the maximum 
amount total for all channels, so channel 2 through 20 cannot be configured.

4. Sampling time label: When the sampled data is output as a CSV file, this label is displayed in the label row 
for the sampling time column.

5. Data label: When the sampled data is output as a CSV file, this label is displayed in the label row 
for the data number columns.

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:00 20 120 201

 01/01/2011 12:10:00 21 121 204

 01/01/2011 12:20:00 22 122 206

 01/01/2011 12:30:00 23 123 206

 01/01/2011 12:40:00 24 124 210

Data No. 3 Value of Device Address

3. Amount of data

5. Data label

1. Channel 1 to 20

2. Data storage amount

Data No. 2 Value of Device Address

Data No. 1 Value of Device Address

Time the value of device address was sampled

4. Sampling time label

Data No. 1 settings
Data No. 2 settings
Data No. 3 settings

Data log settings

Sampled data
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1.4 Saving and Deleting Data

● Saving Data
The sampled values of device addresses along with the sampling time are all saved in the data storage area.

If the saved data exceeds the Data Log data storage amount per device address, the old data is deleted and the new data 
is saved.

Data Storage Amount

When saving the sampled data to the data storage area, set the data storage amount per device address. The amount 
of data that can be saved in the data storage area is calculated from the configured data storage amount per device 
address and data amount for each channel.
The maximum amount of data that can be saved in the data storage area is as follows.

● Deleting Data
The method to delete sampled data from the data storage area is as follows.
• On the Online tab in WindO/I-NV4, click the arrow under Clear, and click All or Data Log Data. For details, refer 

to Chapter 22 “4 Clear” on page 22-20.
• In the System Mode, on the Main Menu screen, press Initial Setting, Initialize, Data Log in order.

Sample values of 
device addresses

MICRO/I

External device

Data Log data

 Sampling Time  Data001  Data002  Data003

 01/01/2011 12:00:00  20  120  201

 01/01/2011 12:10:00  21  121  204

 01/01/2011 12:20:00  22  122  206

 01/01/2011 12:30:00  23  123  206

 01/01/2011 12:40:00  24  124  210

 01/01/2011 12:50:00  25  125  218

Data Log data storage amount per device address

Oldest data

(delete)

New data

When the backup battery is depleted, the data in the Data Log is erased when the MICRO/I is turned off.

Model Maximum amount of data that can be saved in the data storage area

HG2G-5T 13,808



1 Overview

14-6 WindO/I-NV4 User’s Manual

1.5 Using the Data

The saved data can be used in the following ways.

• Display the data in the Line 
Chart
Configure the data channel 
numbers and data numbers 
and display the data in the Line 
Chart.
For details, refer to “4.1 
Display the Data in the Line 
Chart” on page 14-29.

• Save to and read from an 
external memory device
Output data from the MICRO/I 
to the an external memory 
device as a CSV file and use it 
on a computer.
For details, refer to “4.3 Saving 
the Data as a CSV File” on 
page 14-40.

• Display the data with the 
Numerical Input or the 
Numerical Display
Copy the data to an internal 
device and display it with the 
Numerical Input or the 
Numerical Display.
For details, refer to “4.2 
Displaying Data as Numerical 
Values” on page 14-31.

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:00 20 120 201

 01/01/2011 12:10:00 21 121 204

 01/01/2011 12:20:00 22 122 206

 01/01/2011 12:30:00 23 123 206

 01/01/2011 12:40:00 24 124 210

Data Log data

To use with the MICRO/I To use with devices other than the MICRO/I

External Memory Device
Book1

Data Log data
(CSV)

Sampling Time Data001 Data002 Data003 Data004

24
124
210

Data001

Data002

Data003
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This section describes the configuration procedure for the Data Log function.

2.1 Configuring the Sampling Condition and Device Addresses for Sampling Data

1 On the Configuration tab, in the System Setup group, click Data Log.

The Data Log Settings dialog box is displayed.

2 Select the channel number to register the Data Log settings to in Settings, then click Edit.

The Individual Settings dialog box is displayed.

2 Data Log Function Configuration Procedure
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3 On the General tab, under Log function, select Enable.

4 Select the data size for the source device address in Data Size.

5 Specify the device address for sampling data in Source.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

6 Select the condition for sampling data under Sampling Method.

■ Fixed Period
Samples the value of source device address at a fixed interval. If Fixed Period is selected, specify Time in seconds.

■ Event Bit
Samples the value of source device address each time the monitored bit device or word device bit changes from 0 to 
1. If Event Bit is selected, specify the device address to monitor as the condition for sampling data in Device 
Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Event Word
Samples the value of source device address each time the value of monitored word device changes. If Event Word is 
selected, select the data size for the word device to monitor in Data Size, and specify the device address to monitor 
as the condition for sampling data in Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
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7 Click the Data tab.

The channel number selected on the General tab is displayed in Channel No.

8 In Number of Data, specify the number of device addresses to sample starting with the source device address 
configured on the General tab.

The sequential device addresses from the start device address for the number of configured devices are displayed in 
Settings.

9 Enter the label to display in the sampling time column when the data is output as CSV under Sampling Time, in Label.

To use text registered in Text Manager, select the Use Text Manager check box and specify the ID number of the 
text to use as the label.

Click  to open Text Manager where you can edit the text.

10 Configure the details in Settings.
To batch register all the data settings for all data numbers, click Auto.
To individually register the data settings for each data number, select a data number and click Edit.

The dialog box that corresponds to each button is displayed.
An example when Edit is clicked is described here.

11 Check that the data number selected under Settings in Data No. is displayed.

12 Select the display type for the sampled value of device address with Display Type.

The display type selected here is the display type for the numerical values when the data is output as CSV.

13 Select the data type for the sampled value of device address with Data Type.

The data type selected here is the data type for the numerical values when the data is output as CSV.
The data type that can be selected differs according to Data Size on the General tab.
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14 Enter the text to display in the data label in Text.

The text entered here is the label row for the data number columns when the data is output as CSV.
If you selected the Use Text Manager check box on the Data tab, specify the ID number for the text to use in the 
label.

15 Click OK to close the Data Settings dialog box.

You are returned to the Individual Settings dialog box.

To individually register Data Log settings, repeat steps 10 through 14.

16 Click OK to close the Individual Settings dialog box.

You are returned to the Data Log Settings dialog box.

17 Repeat steps 2 through 16 to register Data Log settings for all of the channel numbers to use.

18 Specify the Data log data storage amount per device address.

Click  for Number of Stored Data for Data Log per Device Address to display the Data Storage Area 
Management dialog box.

Increase the number for Number of Stored Data for Data Log per Device Address.
Click OK to close the Data Storage Area Management dialog box.

19 Click OK.

The Data Log Settings dialog box closes.
This concludes configuring the sampling conditions and device addresses for sampling data.

Next, configure the functions to execute using sampled data.
 “4.1 Display the Data in the Line Chart” on page 14-29
 “4.2 Displaying Data as Numerical Values” on page 14-31
 “4.3 Saving the Data as a CSV File” on page 14-40
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This section describes the items and buttons on the Data Log Settings dialog box and the Individual Settings dialog box.

3.1 Data Log Settings Dialog Box

All the device addresses to sample values from and their sampling conditions are collectively managed in the Data 
Log Settings dialog box.

■ Settings
Edits the Data Log settings for each channel.

3 Data Log Settings Dialog Box

Channel No.: Shows the channel number. Double clicking the cell displays the Individual Settings dialog box 
where you can edit the settings. For details, refer to “3.2 Individual Settings Dialog Box” on page 
14-13.

Log function: Shows whether or not the Data Log function is used. Double clicking the cell switches between 
Enable and Disable. If switched to Disable, that channel’s settings all return to the default settings.

Data Size: Shows the data size for the source device address. Double clicking the cell switches between 16-bit 
and 32-bit. This option can only be set when Enable is selected in Log Function.

Source: Specifies the device address to sample values from. Double clicking the cell displays the Tag Editor 
where you can edit the device address. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64. This option can only be set when Enable is 
selected in Log Function.

Sampling Method: Shows the condition for sampling data. Double clicking the cell switches between Fixed Period, 
Event Bit, and Event Word. This option can only be set when Enable is selected in Log Function.

Data Size: Shows the data size for the device address that is the sampling condition. Double clicking the cell 
switches between 16-bit and 32-bit. This option can only be set when Event Word is selected in 
Sampling Method.

Range: Shows the time in seconds (1 to 9999) to sample data in a fixed interval when Fixed Period is 
selected in Sampling Method. Double clicking the cell displays the Individual Settings dialog 
box where you can edit the settings. For details, refer to “3.2 Individual Settings Dialog Box” on 
page 14-13.
Shows the device address that is the condition for sampling data when Event Bit or Event Word 
is selected in Sampling Method. Double clicking the cell displays the Tag Editor where you can 
edit the device address. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-64.

Monitor: Shows the write destination device address for the amount of data when monitoring the amount of 
sampled data. Shows No when not monitoring. Double clicking the cell displays the Individual 
Settings dialog box where you can edit the settings. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 14-13. This option can only be set when Enable is selected in Log Function.
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■ Edit
Registers or changes the settings for the selected channel number.
Select a channel number and click this button to display the Individual Settings dialog box. The settings for the 
selected channel are reflected in the Individual Settings dialog box.
For details, refer to “3.2 Individual Settings Dialog Box” on page 14-13.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

■ Clear All Log Data
Select this check box to erase the all log data saved in the data storage area.

■ Number of Stored Data for Data Log per Device Address
Shows the maximum amount of data storage per device address for Data Log data saved in the data storage area. If 
data is saved up the maximum amount and then the maximum is exceeded, the old data is deleted and the new data is 
saved.
The default is 0.

Click  to display the Data Storage Area Management dialog box where you can change the allocation of data 
storage area memory. For details, refer to Chapter 16 “Data Storage Area” on page 16-1.

Batch: Shows the trigger device address that triggers batch output when batch outputting all the data 
saved in the data storage area to the external memory device. Shows No when there is no batch 
output. Double clicking the cell displays the Individual Settings dialog box where you can edit the 
settings. For details, refer to “3.2 Individual Settings Dialog Box” on page 14-13.

Real Time: Shows whether or not to perform real time output. Double clicking the cell switches between Yes 
and No. Data is output to the external memory device in 3 minute intervals for Yes channels. This 
option can only be set when Enable is selected in Log Function.

No. of Data: Shows the number of device addresses to sample in one channel. Double clicking the cell displays 
the Individual Settings dialog box where you can edit the settings. For details, refer to “3.2 
Individual Settings Dialog Box” on page 14-13. This option can only be set when Enable is selected 
in Log Function.

(Trigger Device Address): Specifies the bit device or bit number of the word device that triggers the erasure of the 
data. The data for all channels is erased when the value of the configured device address 
changes from 0 to 1. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-64.
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3.2 Individual Settings Dialog Box

Use the Individual Settings dialog box to register or edit the Data Log settings for the selected channel.

● General Tab
The General tab is used to configure the source device addresses for sampling data and the sampling conditions.

■ Channel Number
Specifies the channel number for sampling data (1 to 20).

■ Log function
Selects whether or not to use the Data Log function.

■ Data Size
Selects the data size of the source device address as 16-bit or 32-bit.
The value of device address in the selected data size is read and saved in the data storage area.

■ Source
Specifies the word device that is the source for sampling data.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Enable: Samples values of device addresses and saves the data along with the sampling time.

Disable: Does not sample values of device addresses.
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■ Sampling Method
Sets the condition for sampling values of device addresses.

■ Monitor Sampling Count
Select this check box to monitor the number of times values of device addresses are sampled. The sampling count is 
written to the specified device address.

■ Monitor % Space Used in Data Storage Area
Select this check box to monitor the usage of the allocated data storage area as the save destination for Data Log 
data. The usage is calculated from the data storage amount allocated to the data storage area and the amount of 
saved data, and then written to the specified device address.

Usage = Current amount of Data Log data ÷ Data Log data storage amount per device address (omits values after the 
decimal point)

Fixed Period: Samples the value of source device address at a fixed interval.

Time (sec): Specifies the time in seconds (1 to 9999).
This option can only be set when Fixed Period is selected.

Event Bit: Samples the value of source device address each time the bit device or word device bit changes from 0 to 
1.

Event Word: Samples the value of source device address each time the value of word device changes.

Data Size: Selects the data size of the monitored device address as 16-bit or 32-bit.
This option can only be set when Event Word is selected.

Device Address: Specifies the device address to monitor as the condition for sampling data.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This option can only be set when Event Bit or Event Word is selected.

Data for channels with different sampling methods cannot be displayed in the Line Chart.

(Destination Device Address): Specifies the destination word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

Report when Sampling Count has reached or exceeded Threshold:

Writes 1 in the Report Device Address when the current 
sampling count reaches or exceeds the set threshold.

Threshold: Specifies the sampling count that is the basis for reporting.

HG2G-5T: 1 to 13808

Report Device Address: Specifies the destination bit device or the bit number in the 
destination word device.
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

(Destination Device Address): Specifies the destination word device to write the current usage of the amount of Data Log 
data storage.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

Report when % Space Used has reached or exceeded Threshold:

Writes 1 in the Report Device Address when the current usage 
reaches or exceeds the set threshold.

Threshold: Specifies the usage (1 to 100) that is the basis for reporting.

Report Device Address: Specifies the destination bit device or the bit number in the 
destination word device.
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
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■ Clear Log Data
Select this check box to erase the Data Log data for the selected channel from the Data Storage Area.

(Trigger Device Address): Specifies the bit device or bit number of the word device that triggers the erasure of the 
data. The data for selected channels is erased when the value of the configured device 
address changes from 0 to 1. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

If the amount of log data for the channel differs, the Line Chart cannot be displayed.
If differing channels of data were displayed in the same chart, the chart can no longer be displayed if the 
Data Log data is erased by channel units.
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● External Memory Device Tab
The External Memory Device tab is used to configure whether or not to output saved data to the external memory 
device.

The output data is stored in the following folder on the external memory device.
\External Memory Device folder\DATALOG

The default External Memory Device folder name is “HGDATA01”. For details, refer to Chapter 27 “1.6 Setting the 
External Memory Device Folder” on page 27-14.

Data that is sampled after starting output to the external memory device is not included in the output data.
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■ Batch
Select this check box to batch output all the sampled data to the external memory device.

All the data is saved on the external memory device when the trigger device addresses changes from 0 to 1. If a file 
with the same name already exists on the external memory device, that file is overwritten. The maximum amount of 
output data is the amount configured by the data storage area or 1024.

MICRO/I

Data Log data (CSV)

Output to 
External memory device Data Log data

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:30 20 120 201

 01/01/2011 12:01:30 21 121 204

 01/01/2011 12:02:30 22 122 206

 01/01/2011 12:03:30 23 123 206

 01/01/2011 12:04:30 24 124 210

 01/01/2011 12:05:30 25 125 210

 01/01/2011 12:06:30 26 126 218 0 1

Trigger Device Address

Data to be output
(all)

External Memory Device

USB flash drive

The storing of data stops if there is insufficient free space on the external memory device. The error 
information is stored in the following HMI Special Data Registers. For details about the error information, 
refer to Chapter 28 “HMI Special Data Register (LSD)” on page 28-5.
USB flash drive: LSD33

Trigger Device Address: Specifies the bit device or bit number of the word device to serve as condition for batch 
output. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
Data is output to file when the value of the Trigger Device Address changes from 0 to 1.

File Name: Enter the file name for the output data or shows the file name.

The default is “LOGOn.CSV”. (n: Data log channel number)
To change the file name, enter a new file name. The maximum number is 120 characters 
(including the extension).

Specify File Name by Value of Device Address: Select this check box to assign a file name 
for the output data using a value of device 
address specified in the File Name Device 
Address.

(File Name Device Address): Specifies a word device to create a file name. The file 
name is set by reading the values sequentially from the 
starting device address specified with the File Name 
Device Address and handling those values as character 
data up to the character before NULL (00).
The maximum number of device addresses is 40 
(2 characters per word device, maximum of 80 single-
byte characters). You can only specify an internal device. 
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

Example: When the device address specified by (File Name Device Address) is LDR100 
and the text to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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Add Device Address data to File Name: Select this check box to add the bottom three digits of 
the value of the device address configured by (File 
Name Device Address) to the end of the file name for 
the output data.

(File Name Device Address): Specifies the word device that is the source for the value to 
add to the file name. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-64. This option can only be configured when the 
Add Device Address data to File Name check box is 
selected.

Example: When File Name is "LOGO01" and the value of device address in (File Name 
Device Address) is 123, the file name is "LOGO01123.CSV".

Add Time Stamp: Select from the following format for date and time to be added to the file 
name when data is output:
None, YY, YY+MM, YY+MM+DD, YY+MM+DD+HH, 
YY+MM+DD+HH+MM, YY+MM+DD+HH+MM+SS
The format is YYMMDD_TTMMSS (YY: year, MM: month, DD: day, HH: hour, 
MM: minute, SS: second).

Example: File Name is "LOGO01" on September 15 2013 at 23:30:50

YY: LOGO01_13
YY+MM: LOGO01_1309
YY+MM+DD: LOGO01_130915
YY+MM+DD+HH: LOGO01_130915_23
YY+MM+DD+HH+MM: LOGO01_130915_2330
YY+MM+DD+HH+MM+SS: LOGO01_130915_233050

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be 
output.

When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte character cannot be used in the file name configured by File Name or Specify 
File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the values of the source word devices exceeds the maximum number of device addresses (no 

NULL), the text is up to the maximum number of device addresses from the start.
- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.
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■ Real Time
Select this check box to output data to the external memory device in real time.

With real time output, data is saved to the external memory device in three minute intervals after the MICRO/I starts 
running. If the accumulated data reaches 80% of the amount set in the Data Storage Area, then the data is forcibly 
saved to the external memory device. When there is already data with the same file name on the external memory 
device, data is appended to that file. If there was no update to the data during the three minutes, it is not output. Data 
is appended to the file until the size of the file reaches the restriction size (256 MB), so the maximum amount of output 
data differs according to the settings for the output channel such as the amount of data, the data size, and the labels.

If the sampling interval is shorter than real time output (the interval for writing to the external memory device), that Data Log 
is recorded up to the data storage amount - 1, and then afterwards, old data is discarded in order and replaced with new data.

MICRO/I

Data Log data (CSV)

Output to
External memory device 

Data Log data

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:30 20 120 201

 01/01/2011 12:01:30 21 121 204

 01/01/2011 12:02:30 22 122 206

 01/01/2011 12:03:30 23 123 206

 01/01/2011 12:04:30 24 124 210

 01/01/2011 12:05:30 25 125 210

 01/01/2011 12:06:30 26 126 218

Data to be output 
3 minutes after 
operation starts

Data to be output 
3 minutes after that
Data to be output 
after another 
3 minutes

3 minute interval 
after operation 

starts

External Memory Device

USB flash drive

Real time output stops when the file size of the Data Log data exceeds 256 MB or when there is insufficient 
space on the external memory device. The error information is stored in the following HMI Special Data 
Registers. For details about the error information, refer to Chapter 28 “HMI Special Data Register (LSD)” on 
page 28-5.
USB flash drive: LSD33

• When the value of HMI Special Internal Relay LSM20 changes from 0 to 1, the data at that time is first 
output in real time to the external memory device, and then access to the external memory device is 
stopped.

• The text font configured for the starting device address is output as the label font.
• The amount of free space on the external device is saved to the following HMI Special Data Registers. For 

details about the free space on the External Memory Devices, refer to Chapter 28 “HMI Special Data 
Register (LSD)” on page 28-5.
USB flash drive: LSD34, 35
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File Name: Enter the file name for the output data or shows the file name.

The default is “LOGOn.CSV”. (n: Data log channel number)
To change the file name, enter a new file name. The maximum number is 120 characters 
(including the extension).

Specify File Name by Value of Device Address: Select this check box to specify the name of the 
file for the output data with the value of the device 
address configured by (File Name Device Address).

(File Name Device Address): Specifies the word device that is the source of the data to use as 
the file name. The file name is set by reading the values 
sequentially from the starting device address specified with the File 
Name Device Address and handling those values as character data 
up to the character before NULL (00).
The maximum number of device addresses is 40 (80 single-byte 
characters). You can only specify an internal device. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

Example: When the device address specified by (File Name Device Address) is LDR100 and the text 
to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

Add Device Address data to File Name: Select this check box to add the bottom three digits of the 
value of the device address configured by (File Name Device 
Address) to the end of the file name for the output data.

(File Name Device Address): Specifies the word device that is the source for the value to add to 
the file name. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64. This 
option can only be configured when the Add Device Address 
data to File Name check box is selected.

Example: When File Name is "LOGA01" and the value of the device address configured by (File 
Name Device Address) is 123, the file name is "LOGA01123.CSV".

Add Time Stamp: Selects the format of the output date and time to add to the file name for the 
output data.
None, YY, YY+MM, YY+MM+DD
The format is YYMMDD (YY: year, MM: month, DD: day).

Example: File Name is "LOGA01" on September 15 2013

YY: LOGO01_13

YY+MM: LOGO01_1309

YY+MM+DD: LOGO01_130915

Realtime Output: Select this check box to forcibly output the data and save it to file at the desired 
timing.

(Trigger device address): Specifies the bit device or the bit number of the word device to 
serve as the condition to forcibly output the data. You can only 
specify an internal device. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-64. Data is output to file when the trigger device address 
changes from 0 to 1.

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be output.

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the values of the source word devices exceeds the maximum number of device addresses (no 

NULL), the text is up to the maximum number of device addresses from the start.
- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

•  The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.

• The following operations are as follows if the Realtime Output check box is selected.
- Even if the data is outputted forcibly, the real time output period (3 minute interval) is not reset.
- While data is being output with the real time output function, the file is not output when the value of 

the Realtime Output device address is 1.
- Even when output has finished, the value of device address does not automatically change to 0.

• The function to sample data operates when Data Log data is being saved to the external memory device.
• The batch output or real time output status of the Data Log data can be checked with the value of HMI 

Special Internal Relay LSM35. When the data starts to be written to the external memory device, the 
value of device address is 1. When writing is complete, the value is 0.

• The methods to erase Data Log files saved on the external memory device are as follows.
- To erase files during operation using parts, on the External Memory Device tab on the Project 

Settings dialog box, select the Remove Files check box and the All Data Log data check boxes, 
and then configure the trigger device address. Assign that trigger device address to a part.

- To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in 
External Memory Device to open the Clear Data dialog box.  Select the Data Log Data check box 
and click OK.
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Output Data File Name

The file name format is as follows.
File Name Value of Device Address_YYMMDD_TTMMSS.CSV

■ Example 1

Result: The file name is "LOGO01123_1309.CSV".

■ Example 2

Result: The file name is "IDEC123_130915_233050.CSV".

File Name: The text entered in File Name or the text entered according to the value of the device 
address set by Specify File Name by Value of Device Address

Value of Device Address: The lower 3 digits of the value of the device address configured by Add Device 
Address data to File Name

YYMMDD: The year, month, and day of the month set on Add Time Stamp

TTMMSS: The hour, minute, and second of the time configured on Add Time Stamp

Item Setting

File Name LOGO01

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM Date when data was output: September 2013

Item Setting

Specify File Name by Value of Device 
Address

(File Name Device Address) is 
LDR100
Text to set is "IDEC"

LDR100 value: 4944 (Hex)
LDR101 value: 4543 (Hex)
LDR102 value: 0000 (Hex)

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM+DD+HH+MM+SS
Date and time when data was output: 
September 15 2013 at 23:30:50
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● Data Tab
The Data tab is used to configure the data to sample.

■ Channel Number
Shows the selected channel number.

■ Number of Data
Specifies the number of device addresses (1 to 128) for sampling data. Samples values of device addresses in this 
amount starting with the device address configured as the source device on the General tab.

■ Use Text Manager
Select this check box to use text registered in the Text Manager for labels when outputting data as CSV.

■ Label

The maximum amount of data that can be configured for one channel is 128. However, if 32-bit is selected 
for Data Size, it is counted as 16-bit data times 2 devices, so the maximum number device addresses that 
can be configured for one channel is 64. Data Size is configured with the General tab on the Individual 
Settings dialog box.

Specifies the label to display in the sampling time column when outputting data as CSV.

Text ID: Specifies the Text Manager ID number (1 to 32000) when text registered in Text Manager are 
used for labels.

Click  to open Text Manager where you can edit the text.
This option is only enabled if you select the Use Text Manager check box.

Sampling Time: Enter the text to display in the label. The maximum number is 40 characters.
Text can only be entered when the Use Text Manager check box is cleared. The registered text 
is displayed when a text ID is specified.
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■ Settings
Settings is used to configure the details of the data to sample for each data number in the selected channel.

■ Auto
Batch registers or changes the settings for all the data.
Click this button to display the Auto-Setup dialog box. The details configured on the Auto-Setup dialog box are 
registered for all the data.
For details, refer to “Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-25.

■ Edit
Registers or changes the settings for the selected data.
Select the data and click this button to display the Data Settings dialog box. The details configured on the Data 
Settings dialog box are registered or changed for the selected data.
For details, refer to “Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-25.

Data No.: Shows the data numbers for the amount of data specified by Number of Data. Double clicking 
the cell displays the Data Settings dialog box. The data number cannot be edited. For details, 
refer to “Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-25.

Device Address: Shows the device as sequential numbers starting with the source device address specified on the 
General tab. Double clicking the cell displays the Data Settings dialog box. The device address 
cannot be edited. For details, refer to “Auto-Setup Dialog Box and Data Settings Dialog Box” on 
page 14-25.

Display Type: Shows the display type for numerical values when data is output as CSV. Double clicking the cell 
displays the Data Settings dialog box where you can edit the data settings. For details, refer to 
“Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-25.

Data Type: Shows the data type for numerical values when data is output as CSV. Double clicking the cell 
displays the Data Settings dialog box where you can edit the data settings. For details, refer to 
“Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-25.

Text ID: Shows the Text Manager ID number when text registered in Text Manager is used for labels. 
Double clicking the cell allows you to edit the text.
Text ID is only displayed when you select the Use Text Manager check box.

Text: Shows the text to display as labels when data is output as CSV. Double clicking the cell allows you 
to edit the label. The maximum number is 40 characters.
Text can only be entered when the Use Text Manager check box is cleared.
The default label is “Data” and the data number.
Example: Data001
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Auto-Setup Dialog Box and Data Settings Dialog Box

With the Auto-Setup dialog box, all the data for the selected channel is batch registered or changed.
With the Data Settings dialog box, the selected data for the selected channel is registered or changed.

Data Number: Displays 1 when the Auto-Setup dialog box was displayed by clicking Auto.
Displays the data number for the selected data when the Data Settings dialog box was displayed 
by clicking Edit.

Display Type: Select the display type as Decimal or Hexadecimal for numerical values when data is output as 
CSV.

Data Type: Select the data type for numerical values when data is output as CSV. For details, refer to Chapter 
2 “1.1 Available Data” on page 2-1.
The data type that can be selected differs according to Data Size on the General tab.
When Float32(F) is selected, the data is output in the floating point type. However, when a value 
that was read is 8 digits or larger, it is output in the exponential type.

Text ID: Specifies the Text Manager ID number (1 to 32000) when text registered in Text Manager are used 
for labels. For the Auto-Setup dialog box, Text ID is automatically configured sequentially 
starting with the specified text ID.

Click  to open Text Manager where you can edit the text.
Text ID can only be configured when you select the Use Text Manager check box.

Text: Enter the text to display as the label when data is output as CSV. The maximum number is 40 
characters.
The default label is Data+number.
Example: Data001
This item is only displayed on the Data Settings dialog box when the Use Text Manager check 
box is cleared.
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● Options Tab
To display the data saved in the data storage area as numerical values on the MICRO/I, copy this data to the specified 
internal device.

■ Copy Data Log Data
Select this check box to copy data to a device address.

Destination Device Address: Specifies the destination device address for copied data. You can only specify an 
internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
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■ Starting Point
Selects the starting point of the data to copy.

Example: 1. For Newest Data, the starting point is the newest sampling time data.
2. For Oldest Data, the starting point is the oldest sampling time data.
3. For Specify by Value of Device Address and source device address: 3, the starting point is the third 
item of data from the oldest sampling time data.

■ Number of Data
Selects the specification method for the amount of data to copy.

■ Stored Order of Data
Selects the order to copy data.

Example: When Starting Point is Newest Data and Number of Data is 3, data is copied in the following order 
starting from device address LDR10 configured in Destination Device Address.

Newest Data: Sets the starting point as the newest data.

Oldest Data: Sets the starting point as the oldest data.

Specify by Value of Device Address: Specifies which data from the oldest data to set as the starting point by the 
value of device address.

Specifies the source device address. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

Data log data

Sampling Time Value
2. Oldest Data read starting point → 12/18/2011 17:44:10 20

12/18/2011 18:34:10 21
3. Specify by Value of Device Address  read starting point (source device address: 3) → 12/19/2011 19:24:43 22

12/19/2011 20:01:54 24
12/19/2011 21:39:21 26

1. Newest Data read starting point → 12/20/2011 05:57:06 28

Value: Uses a constant.
Specifies the amount to copy (1 to 64).

Device Address: Uses a word device.
Specifies the source device address. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-64.

The maximum amount of data that can be copied to the internal device is 64, regardless of data size.

From Newest to Oldest: Of the data to copy, copies from the start point in order of the newest data first.

From Oldest to Newest: Of the data to copy, copies from the start point in order of the oldest data first.

Data log data
Sampling Time Value Destination Device Address Value

12/18/2011 17:44:10 20
Configured
device address → LDR10 28 ←Copy from

newest dataLDR11
LDR12

:: 26
2234:42:91 1102/91/21 24

12/19/2011 20:01:54 24
Newest data 
read starting point→ 

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28

Destination Device Address ValueConfigured
device address → LDR10 24 ←Copy from

oldest dataLDR11 26
LDR12 28

Amount of data: 3
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■ Target Data
Selects the data to copy from the Data Log data.

Example: When Start Number is 2 and End Number is 4, data 2 to 4 is the copy target.

■ Trigger Condition
Selects the condition to start copying.

Sampling Time: Select this check box to copy the sampling time data from the Data Log data. When this 
check box is selected, values of device addresses are copied in order from the data for 
data number 1.

Value of Device Address: Select this check box to copy the value of device address from the Data Log data.

Data Number: Selects the specification method for the data number of the value to copy.

Value: Uses a constant.

Device Address: Uses a word device.

Start Number: Of the data to copy, specifies the data number of the 
data to start copying.
If you select Value, specify the data number (1 to 128).
If you select Device Address, specify the source device 
address. You can only specify an internal device. For the 
device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.
When the Sampling Time check box is selected, the 
data number is 1. This cannot be changed.

End Number: Of the data to copy, specifies the data number of the 
data to end copying.
If you select Value, specify the data number (1 to 128).
If you select Device Address, specify the source device 
address. You can only specify an internal device. For the 
device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-64.

Start No. End No.
Data No.: 1 2 3 4 5

↓ ↓ ↓ ↓ ↓
Sampling Time Data 1 Data 2 Data 3 Data 4 Data 5

10/01/2011 12:34:56 100 60 240 60 240
10/02/2011 03:45:12 200 80 450 80 450

Copy target

Always: Copies each time the data is updated.

Device Address: Specifies the device address that triggers the start of copying the data. Copies the data when 
the value of the specified device address changes from 0 to 1.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-64.
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4.1 Display the Data in the Line Chart

You can display the sampled data in the Line Chart.

1 On the Home tab, in the Parts group, click Charts, and then click Line Chart.

2 Click a point on the edit screen where you wish to place the Line Chart.

3 Double-click the dropped Line Chart and a Properties dialog box will be displayed.

4 On the General tab, select Chart Type as Log Trend (Normal) or Log Trend (Pen Recorder).

4 Using the Data
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5 Click the Pen (Log) tab.

6 Specify Channel No. and Data No. for the data to display in the chart.

7 Select Line Type, Line Size, and Line Color.

The data to display in the chart is registered in the channel number (Ch1 to Ch20) for the chart selected in Settings.

8 Repeat steps 6 and 7 to register the data to display in the chart.

9 Click OK.

The Properties dialog box closes.
This concludes configuring the Line Chart.

Click Data Log Settings to display the Data Log Settings dialog box where you can configure the 
channel while checking the data to display. Select Channel No. under Settings, and then click OK to close 
the Data Settings dialog box. Channel No. reflects the selected channel number.
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4.2 Displaying Data as Numerical Values

You can display data in the Numerical Display by copying data saved in the data storage area to an internal device 
according to the conditions configured with the Options tab on the Individual Settings dialog box.

● Copying Data to Internal Devices

Copying Sampling Time Data

Sampling time data is copied as a BCD value to the six sequential device addresses starting with the device address 
configured by Destination Device Address.
The sampling time data is copied in year, month, day, hour, minute, second order regardless of the Stored Order of 
Data setting.

■ Example
When the sampling time 10/01/2011 12:01:30 is copied to the destination device address

Data Read Start Position and Copy Order of Data to the Destination Device Address

The data to copy and the order differs according to the Starting Point and the Stored Order for Data settings.

■ Example 1
Copying three items of the newest data in the Data Log to the destination device address

Data log data

Sampling Time Value Destination Device Address Value

10/01/2011 12:01:30 20
Configured
device address → LDR10 2011 ←Year

LDR11 10 ←Month

LDR12 1 ←Day

LDR13 12 ←Hour

LDR14 1 ←Minute

LDR15 30 ←Second

Item Setting

Destination Device Address LDR10

Starting Point Newest Data

Number of Data 3

Stored Order of Data From Newest to Oldest

Data log data

Sampling Time Value Destination Device Address Value

12/18/2011 17:44:10 20
Configured
device address → LDR10

LDR11
LDR12

28 ←Copy from
newest data:: 26

12/19/2011 19:24:43 22 24
12/19/2011 20:01:54 24

Newest data 
read starting point →

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28

Amount of data: 3
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■ Example 2
Copying three items of the newest data in the Data Log in order from the oldest to the destination device address

■ Example 3
Setting the starting point to the fourth item of the oldest data in the Data Log and copying three items of data from 
the newest to the destination device address

Item Setting

Destination Device Address LDR10

Starting Point Newest Data

Number of Data 3

Stored Order of Data From Oldest to Newest

Data log data

Sampling Time Value Destination Device Address Value

12/18/2011 17:44:10 20
Configured
device address→ LDR10

LDR11
LDR12

24 ←Copy from
oldest data:: 26

12/19/2011 19:24:43 22 28
12/19/2011 20:01:54 24

Newest data 
read starting point→

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28

Amount of data: 

Item Setting

Destination Device Address LDR10

Starting Point Specify by Value of Device Address (value is 4)

Number of Data 3

Stored Order of Data From Newest to Oldest

Data log data

Sampling Time Value Destination Device Address Value
Specify by Value of 
Device Address
read starting point

12/18/2011 17:44:10 20
Configured
device address → LDR10

LDR11
LDR12

28 ←Copy from
newest data12/19/2011 07:24:09 12 26

12/19/2011 19:24:43 22 24(Source 
device address: 4) → 12/19/2011 20:01:54 24

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28
12/20/2011 15:26:17 29
12/21/2011 06:46:57 31

Amount of data: 3
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Copying Data when 32-bit is Selected as the Data Size

When 32-bit is selected for Data Size on the General tab on the Individual Settings dialog box, two destination 
device addresses are required for a single item of data.

■ Example 1
Copying the newest data in the Data Log with the data size selected as 32-bit to the destination device address 
LDR10.

Item Setting

Destination Device Address LDR10

Starting Point Newest Data

Number of Data 2

Data Size 32-bit

Stored Order of Data From Newest to Oldest

Data log data

Sampling Time Value Destination Device Address Value

12/18/2011 17:44:10
87654321 

(Hex)

Configured
device address→ LDR10 3344 ←Copy from

newest dataLDR11
LDR12

1122
:: 7788

12/19/2011 19:24:43
12345678 

(Hex)
LDR13 5566

12/19/2011 20:01:54
55667788 

(Hex)

Newest data 
read starting point → 12/19/2011 21:39:21

11223344 
(Hex)

Amount of data: 2

The data copy order for the device address selected with a data size of 32-bit is configured on the Project 
Settings dialog box, on the System tab, with Storage Method of 32-bit Numerical Data. For details, 
refer to Chapter 4 “3.1 System Tab” on page 4-13.
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Copying Multiple Items of Data

When copying multiple items of data, first all the sampling times for the data are copied in order starting with the 
device address configured as the destination device address, then the values of device addresses for all the data are 
copied in order.
For example, data is copied in this order: first sampling time → second sampling time → ... → first data 1 value of 
device address → first data 2 value of device address → second data 1 value of device address → second data 2 value 
of device address and so on.

■ Example
The sampling time and values of device addresses from data start number 1 to end number 3 are copied to the 
destination device address as two items of data.

Item Setting

Destination Device Address LDR10

Starting Point Newest Data

Number of Data 2

Stored Order of Data From Oldest to Newest

Target Data
Sampling Time, Value of Device Address

Data No.: Start No. 1, End No. 3

When writing with the following settings, “Device range error” is displayed.
• Starting Point is 0 or a value larger than the amount of saved data
• Start Number is 0 or a value larger than Data Number
• End Number is 0 or a value larger than Data Number
• Start Number is a value larger than End Number

Data log data

Sampling Time Data 1 Data 2 Data 3 Data 4 Data 5

10/01/2011 12:00:30 10 40 100 20 120
10/01/2011 12:34:56 100 60 240 30 200

10/02/2011 03:45:12 200 80 450 70 400 ←Newest Data read starting point

Destination Device Address Value
Configured device address → 2011 ←Copy from oldest data

10

←First sampling time
01
12
34
56

2011

←Second sampling time

10
02
03
45
12

100 ←First data 1 value

200 ←Second data 1 value

60 ←First data 2 value

80 ←Second data 2 value

240 ←First data 3 value

450

LDR10

LDR11
LDR12
LDR13
LDR14
LDR15
LDR16
LDR17
LDR18
LDR19
LDR20
LDR21

LDR22

LDR23

LDR24

LDR25

LDR26

LDR27 ←Second data 3 value

1.

2.

3. 4.   5.

1.

2.

3.

4.

5.
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● Displaying Data on the Numerical Display
You can copy sampled data to an internal device and display it with the Numerical Display.

1 On the Configuration tab, in the System Setup group, click Data Log.

The Data Log Settings dialog box is displayed.

2 Under Settings, select the channel number for the data to display numerical values of on the Numerical Display, then 
click Edit.

The Individual Settings dialog box is displayed.

3 Select Enable for Log function on the General tab and configure Data Size, Source, and Sampling Method.

4 Specify the number of device addresses to sample in Number of Data on the Data tab, and configure Display 
Type and Data Type for each item of data in Settings.
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5 Click the Options tab.

6 Select the Copy Data Log Data check box.

7 Specify the destination device address for the copied data in Destination Device Address.

You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

8 Select the data that is the start point for copying data in Starting Point.

■ Newest Data
Set the starting point to read as the newest data.

■ Oldest Data
Set the starting point to read as the oldest data.

■ Specify by Value of Device Address
Specifies which data from the oldest data to set as the starting point to read by value of device address, and sets that 
data as the starting point to read.
Specifies the source device address. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
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9 Select the specification method for the amount of data to copy in Number of Data.

■ Value
Use a constant.
Specifies the amount to copy (1 to 64).

■ Device Address
Use a word device.
Specifies the source device address. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

10 Select the order to copy data in Stored Order of Data.

■ From Newest to Oldest
Of the data to copy, copies from the start point in order of the newest data first.

■ From Oldest to Newest
Of the data to copy, copies from the start point in order of the oldest data first.

11 Select the data to copy from the data in Target Data.

Select the Sampling Time check box to copy the sampling time data from the data.
Select the Value of Device Address check box to copy the value of device address from the data. When not copying 
the value of device address, proceed to step 15.

12 Select the specification method for the data number to copy the value in Data Number.

■ Value
Use a constant.

■ Device Address
Use a word device.

13 Specify the data number of the data to start copying out of the data to copy with Start Number.

If you select Value, specify the data number (1 to 128).

If you select Device Address, specify the source device address. You can only specify an internal device. Click  to 
display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
When the Sampling Time check box is selected, the data number is 1. This cannot be changed.

14 Specify the data number of the data to end copying out of the data to copy with End Number.

If you select Value, specify the data number (1 to 128).

If you select Device Address, specify the source device address. You can only specify an internal device. Click  to 
display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

15 Select the condition to start copying in Trigger Condition.

■ Always
Copies each time the data is updated.

■ Device Address
Specifies the device address that triggers the start of copying the data. Copies the data when the value of the 

specified device address changes from 0 to 1. Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

16 Click OK to close the Individual Settings dialog box.

You are returned to the Data Log Settings dialog box.

The maximum amount of data that can be copied to the internal device is 64, regardless of data size.
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17 Click OK.

The Data Log Settings dialog box closes.

18 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Display.

19 Click a point on the edit screen where you wish to place the Numerical Display.

20 Double-click the dropped Numerical Display and a Properties dialog box will be displayed.

21 Select the display type for the copied data with Display Type on the General tab.

22 Select the data type for the copied data in Data Type under Data Format.

23 Specify the number of digits to display in Digits under Data Format.

The range of digits that can be set differs according to the display type and data type.



WindO/I-NV4 User’s Manual 14-39

4 Using the Data

14

D
ata Log Function

24 Specify the source device address for the copied data in Display Device Address under Display Method.

For sequential device addresses of the amount of data to copy starting with Destination Device Address 
configured on the Options tab on the Data Log Settings Individual Settings dialog box, set Display Device 
Address for each Numerical Display to those device addresses.
Example: When Destination Device Address is LDR10, Number of Data is 3

Specify three Numerical Displays with Display Device Address specified as LDR10, LDR11, LDR12

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

25 Click OK.

The Properties dialog box closes.

26 Repeat step 18 through 25 to configure the Numerical Displays for the amount of data to copy.

This concludes configuring the Numerical Display.

MICRO/I

External device

(Internal device)

124
125
126

Data Log data

 Sampling Time Data001

 01/01/2011 12:00:30 120

 01/01/2011 12:01:30 121

 01/01/2011 12:02:30 122

 01/01/2011 12:03:30 123

 01/01/2011 12:04:30 124

 01/01/2011 12:05:30 125

 01/01/2011 12:06:30 126

LDR10 : 126

LDR11 : 125

LDR12 : 124

Copy
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4.3 Saving the Data as a CSV File

● Saving the Data as a CSV File
The Data Log data can be saved to the external memory device as a CSV file or uploaded to a computer.
The procedure to save the data is as follows.
• To save the data to an external memory device, click Data Log on the WindO/I-NV4 Configuration tab to display 

the Data Log Settings dialog box. Select a channel number to save to the external memory device and click Edit 
to display the Individual Settings dialog box. Select an output method check box on the External Memory 
Device tab and configure the items. The data can be saved to the External Memory Device folder on the external 
memory device. For details, refer to “External Memory Device Tab” on page 14-16.

● Data Structure and Output Example
The data structure of the output file is as follows. The data structure for files output with batch output and real time 
output is the same.
Bold items are replaced by the Data Log settings, sampled data, project file name, and WindO/I-NV4 version.

Headers

“Project Name”,”Project name”,”Version number”
“File Type”,”Log type”
Blank row
“Channel No.”,”Channel number”
“Source”,”Source device address”
“Sampling Method”,”Sampling condition (type)”
“Sampling condition (label)”,”Sampling condition (configuration details)”
Blank row

Label row
“Label (sampling time)”,”Label (data number 1)”,”Label (data number 2)”... times the amount of 
data

Data row

“MM/DD/YYYY HH:MM:SS”,Data number 1 data value,Data number 2 data value... times the 
amount of data

∙
∙
∙

Output example Data size of each row
“Project Name”,”Dimmer Console”,”V4.50” - 41 bytes
“File Type”,”Data Log Data” - 29 bytes

- 2 bytes
“Channel No.”,”1” - 19 bytes
“Source”,”LDR100” - 20 bytes
“Sampling Method”,”Fixed Period” - 34 bytes
“Time[Sec]”,”1” - 17 bytes

- 2 bytes
“Sampling Time”,”Data001”,”Data002” - 37 bytes
“08/23/2011 18:32:04”,171,234 - 32 bytes

∙
∙
∙

• The data size for each row is counted as 2 bytes for full-width characters, 1 byte for half-width characters, 
and 2 bytes for newlines. The total for each row is the total amount of space for the file.

• A space is inserted before the year in the data row.
• The display type for the date and time differs according to the language configured in Project Settings, 

on the Project Details tab, in Language.
Japanese: YYYY/MM/DD HH:MM:SS
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY HH:MM:SS
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This chapter describes how to configure the Operation Log function and its operation on the MICRO/I.

  

1.1 How the Operation Log Function is Used

The Operation Log function records events that have occurred on the MICRO/I, including user operations such as 
pressing a button or changing the operation mode.
You can perform the following actions using the Operation Log function.

• Record turning on the MICRO/I power

• Record switching the base screen

• Record changing the user

• Record changing the operation mode

Chapter 15 Operation Log Function

1 Overview

MICRO/I

Power ON

MICRO/I

130

12:00
Run Mode

MICRO/I MICRO/I

130 Switch to Base Screen
Full

Tank 1

Base screen 1
12:01
Base screen 2

MICRO/I

130

MICRO/I

130 Change Users

User1

Group parts not displayed on User2 screen

12:02
User2

MICRO/I MICRO/I

130 Change Operation Modes

Run Mode
12:03
System Mode

Run Offline Main Menu

MAC Address  00:03:7B:F0:12:A8
IP Address 192.168.0.1(DHCP)
2010/OCT/14/THU   14:56:44
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• Record pressing a touch switch

• Record writing a value to a device address by pressing a touch switch

• Output Operation Log data to the external memory device

MICRO/I

130

12:04
Press touch switch

MICRO/I

100

100
100

D1= 100

Write 100

ValueExternal device

12:05
Press touch switch

100     D1

Output to
External memory device

Operation Log data
(CSV)

MICRO/I
External memory device

USB flash drive
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1.2 Recorded Events

The recorded events are as follows.

■ Power ON
This operation is recorded when the MICRO/I power is turned on.

■ Switch to Base Screen
This operation is recorded by the following events.
• Switched the base screen by pressing the Goto Screen Button or a Multi-Button
• Switched the base screen by pressing the key button Reference on the Alarm List Display or the Alarm Log Display
• Switched the base screen by executing the Goto Screen Command or a Multi-Command
• Switched the base screen by writing a screen number to System Area 1 address number + 0 (displayed screen 

number)

■ Change Users
This operation is recorded by the following events.
• Switched the user by entering a password on the Password Screen
• Switched the user by writing a value of device address
• Switched to the default user

■ Change Operation Modes
This operation is recorded by the following events.
• Switched to System Mode by pressing the Goto Screen Button or a Multi-Button
• Switched to System Mode by executing the Goto Screen Command or a Multi-Command
• Switched to System Mode by pressing System Mode on the Maintenance screen
• Switched to Run Mode from System Mode by pressing Run on the Top Page in the System Mode
• Switched to Monitor Mode from Run Mode by clicking Start Monitor on the WindO/I-NV4 Online tab
• Switched to Run Mode from Monitor Mode by clicking Stop Monitor on the WindO/I-NV4 Online tab
• Switched to Offline Mode from Monitor Mode by clicking Go offline on the WindO/I-NV4 Online tab
• Switched to Monitor Mode from Online Mode by clicking Go offline on the WindO/I-NV4 Online tab

■ Press buttons
This operation is recorded by the following events.
• Pressing a Bit Button, Word Button, Goto Screen Button, Multi-Button, Selector Switch, Potentiometer, Numerical 

Input, Character Input
• Pressing the key buttons ENT, Download Project, Upload Project, Download PLC Program, Upload PLC 

Program, All Check, Delete All, Reference, Stop Buzzer and Screen Flashing, Record

■ Write Data to any Device Addresses
This operation is recorded by the following event.
Writing a value to a device address by pressing a Bit Button, Word Button, Multi-Button, Selector Switch, 
Potentiometer, Numerical Input, Character Input

• If User is selected in Default User in the Security dialog box, a Change Users event occurs when the 
power is turned on and when the operation mode is changed.

• If the Switch to Base Screen check box is selected, a Switch to Base Screen event also occurs when 
a Change Users event occurs.

The Operation Log is only recorded during Run Mode.
Switching from Run Mode to System Mode and switching from System Mode to Run Mode is recorded. 
Switching from System Mode to Data Transfer Mode and switching from Data Transfer Mode to System 
Mode is not recorded.

The Operation Log only records button presses for parts created in WindO/I-NV4.
Operations for the buttons displayed in the System Mode, the Password Screen, the System Error Message 
and the title bar of Popup Screen are not recorded.
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1.3 Data Configuration

The recorded data is composed of a label, time, user name, screen number, event name, part name, device address, 
and content after the change.
The relationship between the Operation Log function settings and the recorded data is as follows.

1. Event: Events that occur on the MICRO/I due to operations including user operations. Only the 
checked events are recorded.

2. Data storage amount: The amount of data to record. For details, refer to “Data Storage Amount” on page 15-6.
3. Label: When the recorded data is output as a CSV file, this is the text displayed in the label row.
4. Sampling Time: The time the event occurred.

The display type for the date and time varies based on the language configured in Project 
Settings, on the Project Details tab, in Language.
YYYY/MM/DD HH:MM:SS: Japanese
MM/DD/YYYY HH:MM:SS: European, Chinese, Taiwanese, Korean, Central 

European, Baltic, Cyrillic
5. User Name: The user name when the event occurred.

The user name is only recorded when the Use Security functions check box is selected on 
the General tab in the Security dialog box.

6. Screen No.: The screen type and number that was displayed when the event occurred.
Base n: Base screen (n: screen number)

Example: Base 1
Popup n: Popup screen (n: screen number)

Example: Popup 10

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

2. Data storage amount

3. Labels

4. Sampling Time

1. Event

5. User Name 6. Screen No. 10. Changed to7. Event Name 8. Part Name 9. Device Address

Operation Log settings

Recorded data
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7. Event Name: When the recorded data is output as a CSV file, this is the text displayed as a label to 
describe the event that occurred. This item is configured in the Data Labels dialog box.

8. Part Name: The part name for the pressed touch switch when the Press buttons event occurs.
9. Device Address: The destination device address when the Write Data to any Device Addresses event 

occurs.
When an indirect write is used, the device address specified by the indirect value is 
recorded.
Example: When the device address configured as the destination for the value 100 is 

LDR100 and the indirect value is 3

10. Changed to: The result produced from the event that occurred. The recorded content varies based on the 
event that occurred.
Switch to Base Screen: The screen type and number after switching.

Base n: Base screen (n: screen number)
Example: Base 1

Change Users: The user name after the change.
Change Operation Modes: The operation mode after the change.

Run Mode: Run Mode
System Mode: System Mode
Monitor Mode: Monitor Mode
Offline Mode: Offline Mode

Write Data to any Device Addresses: The value written to the device address by pressing the 
touch switch. This value is handled as UBIN16(W). For 
details, refer to Chapter 2 “1.1 Available Data” on page 
2-1.
The value written to the device address is recorded as 
UBIN16(W) regardless of the data type.
Example: When -10 (0xFFF6) is written to device 

address D0

If the written value is 2 words (32 bits), each word is 
recorded (16 bits). For the storage order for 32-bit 
device address data, the upper word and lower word 
are stored following the Storage Method of 32-bit 
Numerical Data setting. Storage Method of 32-bit 
Numerical Data is configured on the System tab in 
the Project Settings dialog box. For details, refer to 
Chapter 4 “3.1 System Tab” on page 4-13.
Example: When Storage Method of 32-bit 

Numerical Data is from Lower word and 
12345678 (0xBC614E) is written to device 
address D0 with the data type UBIN32(D)

Event Name Part Name Details Changed to
Press buttons WordSwitch1 ‒ ‒

Write Data to any Device Addresses ‒ LDR103 100

Changed toDetailsPart Name
Press buttons WordSwitch1
Write Data to 

any Device Addresses ‒

‒ ‒

D0 65526 (0xFFF6)

Event Name

Event Name
Press buttons WordSwitch1
Write Data to 

any Device Addresses ‒ D0 24910 (0x614E)

Write Data to
any Device Addresses ‒ D1 188 (0xBC)

Changed toDetailsPart Name
‒ ‒
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1.4 Saving and Deleting Data

● Saving Data
The recorded data is saved in the data storage area.

If the saved data exceeds the Operation Log data storage amount, the oldest data is deleted and the new data is 
saved.

Data Storage Amount

The maximum amount of data that can be saved in the data storage area is as follows.

● Deleting Data
The method to delete recorded data from the data storage area is as follows.
• On the Online tab in WindO/I-NV4, click the arrow under Clear, and click All or Operation Log Data. For details, 

refer to Chapter 22 “4 Clear” on page 22-20.
• In the System Mode, on the Main Menu screen, perform the following operation;

 

MICRO/I

130

Operation Log data

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

Opera�on Log data storage amount

Oldest data
(delete)

New data

When there is no remaining battery power, the data in the Operation Log is erased when the MICRO/I is 
turned off.

Model Maximum amount of data that can be saved in the data storage area

HG2G-5T 3,945

The maximum amount of data that can be recorded by a single operation is 150 items. When writing to 
multiple device addresses in a single operation using the Multi-Button or other part, data over 150 items 
cannot be recorded. If the data to be recorded in a single operation exceeds 150 items, HMI Special Internal 
Relay LSM22 is set to 1. For details, refer to Chapter 28 “HMI Special Relay (LSM)” on page 28-2.

HG2G-5T: Press Initial Setting, Initialize, Op. Log in order.
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1.5 Using the Data

The saved data can be used in the following ways.

• Save to and read from an external memory device 
Output data from the MICRO/I to the external memory device as 
a CSV file and use it on a computer.
For details, refer to “4.1 Saving the Data as a CSV File” on page 
15-21.

Operation Log data

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

External Memory Device

Operation Log data
(CSV)

Book1

Sheet1 Sheet2 Sheet3

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Devices - LDR0 55
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This section describes the configuration procedure for the Operation Log function.

2.1 Configuring the Events and the Condition for Recording

1 On the Configuration tab, in the System Setup group, click Operation Log.

The Operation Log Settings dialog box is displayed.

2 Select the Enable Operation Log Settings check box.

3 Select the check boxes for the events to record under Target Events to record.

2 Operation Log Function Configuration Procedure

Power ON: The following items are recorded when the MICRO/I power is turned on.
Time, Screen Number, Event Name

Switch to Base Screen: The following items are recorded when the base screen is switched.
Time, User Name, Screen Number, Event Name, Changed to

Change Users: The following items are recorded when the user is changed.
Time, User Name, Screen Number, Event Name, Changed to

Change Operation Modes: The following items are recorded when the operation mode is changed.
Time, User Name, Screen Number, Event Name, Changed to

Press buttons: The following items are recorded when a touch switch is pressed.
Time, User Name, Screen Number, Event Name, Part Name

Write Data to any Device Addresses: The following items are recorded when a value is written to a device address 
by pressing a touch switch.
Time, User Name, Screen Number, Event Name, Device Address, Changed to
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4 Configure the Operation Log data storage amount in Number of Stored Data.

Click  to display the Data Storage Area Management dialog box.
Specify the Operation Log data storage amount in Number of Stored Data for Operation Log and click OK.
The Data Storage Area Management dialog box closes.

5 Select the condition to record events in Trigger condition.

■ Always
Always records events.

■ Device Address
Records events when the specified device address is 1. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

6 Click OK.

The Operation Log Settings dialog box closes.
This concludes configuring the events and the condition for recording.
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This section describes items and buttons on the Operation Log Settings dialog box.

3.1 Operation Log Settings Dialog Box

● General Tab
The General tab is used to configure the events and the condition for recording.

■ Enable Operation Log Settings
Select this check box to use the Operation Log function.

■ Target Events to record
Selects the events to record. Select the check boxes for the events to record.

3 Operation Log Settings Dialog Box

Power ON: The following items are recorded when the MICRO/I power is turned on.
Time, screen number, event name

Switch to Base Screen: The following items are recorded when the base screen is switched.
Time, user name, screen number, event name, changed to

Change Users: The following items are recorded when the user is changed.
Time, user name, screen number, event name, changed to

Change Operation Modes: The following items are recorded when the operation mode is changed.
Time, user name, screen number, event name, changed to

Press buttons: The following items are recorded when a touch switch is pressed.
Time, user name, screen number, event name, part name

Write Data to any Device Addresses: The following items are recorded when a value is written to a device address 
by pressing a touch switch.
Time, user name, screen number, event name, device address, changed to

Edit Data Labels: Displays the Data Labels dialog box.
The Data Labels dialog box is used to edit the text displayed in the label row 
and the event names displayed in the data rows when the recorded data is 
output as a CSV file.
For details, refer to “Data Labels Dialog Box” on page 15-12.
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■ Monitor Number of Stored Data
Select this check box to count the amount of recorded Operation Log data. The amount of recorded data is written to 
the specified device address.

■ Monitor % Space Used in Data Storage Area
Select this check box to monitor the usage of the data storage area allocated as the save destination for Operation 
Log data. The usage is calculated from the data storage amount allocated to the data storage area and the amount of 
saved data, and then written to the specified device address.

Usage = Current amount of Operation Log data ÷ Operation Log data storage amount (omits values after the decimal point)

■ Clear Log Data
Select this check box to erase the Operation Log data saved in the data storage area.

■ Number of Stored Data
Shows the maximum amount of Operation Log data to save in the data storage area. Data is saved up to the set 
amount. The maximum amount of data that can be saved in the data storage area is listed next.

■ Trigger Condition
Selects the trigger condition for the Operation Log function.

(Destination Device Address): Specifies the destination word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
Report when Number of Stored Data has reached or exceeded Threshold:

Writes 1 to the Report Device Address when the current 
amount of data reaches or exceeds the set threshold.

Threshold: Specifies the amount of data that is the basis for reporting.
HG2G-5T: 1 to 3,945

Report Device Address: Specifies the destination bit device or the bit in the destination 
word device.
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

(Destination Device Address): Specifies the destination word device to write the current usage of the amount of 
Operation Log data storage.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
Report when % Space Used has reached or exceeded Threshold:

Writes 1 in the Report Device Address when the current usage 
reaches or exceeds the set threshold.

Threshold: Specifies the usage (1 to 100) that is the basis for reporting.
Report Device Address: Specifies the destination bit device or the bit number in the 

destination word device.
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

(Trigger Device Address): Specifies the bit device that triggers the erasure of the data. The saved data is erased 
when the value of the configured device address changes from 0 to 1. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 
2-64.

HG2G-5T: 3,945

Click  to open the Data Storage Area Management dialog box where you can change the allocation of data storage 
area memory. For details, refer to Chapter 16 “Data Storage Area” on page 16-1.

Always: Always records events.
Device Address: Records events when the value of the specified device address is 1. 

For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-64.
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Data Labels Dialog Box

The Data Labels dialog box is where you can edit labels for recorded data and event names when saving data as a 
CSV file.

Label of Recorded Data

■ Use Text Manager
Select this check box to use text registered in Text Manager for recorded data labels when saving data as a CSV file.

■ Label of Recorded Data
Specifies the text to display in the label row in Text or Text ID.

The details for each label row label is as follows.

Text: Double click the cell to enter the text to display as the label. The maximum number is 40 
characters.
Text can only be entered when the Use Text Manager check box is cleared.

Text ID: Double click the cell to specify the Text Manager ID number (1 to 32000) when using text registered 
in Text Manager as the label.
This option is only enabled if you select the Use Text Manager check box.

Sampling Time: The label for the column to display the time the event occurred.

User Name: The label for the column to display the user name when the event occurred.

Screen No.: The label for the column to display the screen type and number that was displayed when the event 
occurred.

Event Name: The label for the column to display the name of the event that occurred on the MICRO/I by an 
operation including a user operation.

Part Name: The label for the column to display the part name for the pressed touch switch when the Press 
buttons event occurs.

Device Address: The label for the column to display the destination device address when the Write Data to any 
Device Addresses event occurs.

Changed to: The label for the column to display the result produced from the event that occurred. The recorded 
content varies based on the event that occurred.
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Event Name

■ Use Text Manager
Select this check box to use text registered in Text Manager for the event names when saving data as a CSV file.

■ Event Name
Specifies the text to display in Event Name in Text or Text ID.

Event name details are as follows.

Text: Double click the cell to enter the text to display as the event name. The maximum number is 40 
characters.
Text can only be entered when the Use Text Manager check box is cleared.

Text ID: Double click the cell to specify the Text Manager ID number (1 to 32000) when using text registered in 
Text Manager as the event name.
This option is only enabled if you select the Use Text Manager check box.

Power ON: The event name when the MICRO/I power is turned on.

Switch to Base Screens: The event name when the base screen is switched.

Change Users: The event name when the user is changed.

Change Operation Modes: The event name when the MICRO/I operation mode is changed.

Press buttons: The event name when a touch switch is pressed.

Write Data to any Device Addresses: The event name when a value is written to a device address by pressing a 
touch switch.
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● External Memory Device Tab
The External Memory Device tab is used to configure whether or not to output saved data to the external memory 
device.

The output data is stored in the following folder on the external memory device.
\External Memory Device folder\OPERATIONLOG

The default External Memory Device folder name is “HGDATA01”. For details, refer to Chapter 27 “1.6 Setting the 
External Memory Device Folder” on page 27-14.

Data recorded after starting output to the external memory device is not included in the output data.
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■ Batch
Select this check box to batch output all the sampled data to the external memory device.

All the data is saved on the external memory device when the value of the trigger device address changes from 0 to 
1. If a file with the same name already exists on the external memory device, that file is overwritten. The maximum 
amount of output data is the amount configured by the data storage area.

MICRO/I

Operation Log data
(CSV)

Output to
External memory device

Operation Log data

0 1
Trigger Device Address

Data to be output
(all)

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

12/01/2011 12:07:30 User2 Base2 Switch to Base Screen - - Base3

External memory device

USB flash drive

The storing of data stops if there is insufficient free space on the external memory device. The error 
information is stored in the following HMI Special Data Registers. For details about the error information, 
refer to Chapter 28 “HMI Special Data Register (LSD)” on page 28-5.
USB flash drive: LSD33

Trigger Device Address: Specifies the bit device or bit number of the word device to serve as condition for batch 
output. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
Data is output to file when the value of the trigger device address changes from 0 to 1.

File Name: Enter the file name for the output data or shows the file name.
The default is “OPLOGO.CSV”.
To change the file name, enter a new file name. The maximum number is 120 characters 
(including the extension).

Specify File Name by Value of Device Address: Select this check box to assign a file name 
for the output data using a value of device 
address specified in the File Name Device 
Address.

(File Name Device Address): Specifies a word device to create a file name. The file 
name is set by reading the values sequentially from the 
starting device address specified with the File Name 
Device Address and handling those values as character 
data up to the character before NULL (00).
The maximum number of device addresses is 40 
(2 characters per word device, maximum of 80 single-
byte characters). You can only specify an internal device. 
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

Example: When the device address specified by (File Name Device Address) is LDR100 
and the text to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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Add Device Address data to File Name: Select this check box to add the bottom three 
digits of the value of the device address 
configured by (File Name Device Address) to the 
end of the file name for the output data.

(File Name Device Address): Specifies the word device that is the source for the value 
to add to the file name. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64. This option can only be 
configured when the Add Device Address data to File 
Name check box is selected.

Example: File Name is "OPLOGO" and the value of device address in (File Name Device 
Address) is 123, the file name is "OPLOGO123.CSV".

Add Time Stamp: Select from the following format for date and time to be added to the 
file name when data is output:
None, YY, YY+MM, YY+MM+DD, YY+MM+DD+HH, 
YY+MM+DD+HH+MM, YY+MM+DD+HH+MM+SS
The format is YYMMDD_TTMMSS (YY: year, MM: month, DD: day, HH: 
hour, MM: minute, SS: second).

Example: File Name is "OPLOGO" on September 15 2013 at 23:30:50
YY: OPLOGO_13
YY+MM: OPLOGO_1309
YY+MM+DD: OPLOGO_130915
YY+MM+DD+HH: OPLOGO_130915_23
YY+MM+DD+HH+MM: OPLOGO_130915_2330
YY+MM+DD+HH+MM+SS: OPLOGO_130915_233050

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to 
be output.

When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the values of the source word devices exceeds the maximum number of device addresses (no 

NULL), the text is up to the maximum number of device addresses from the start.
- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.
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■ Real Time
Select this check box to output data to the external memory device in real time.

With real time output, data is saved to the external memory device in three minute intervals after the MICRO/I starts 
running. If the accumulated data reaches 80% of the amount set in the Data Storage Area, then the data is forcibly 
saved to the external memory device. When there is already data with the same file name on the external memory 
device, data is appended to that file. If there was no update to the data during the three minutes, it is not output.
Data is appended to the file until the size of the file reaches the restriction size (256 MB), so the maximum amount of 
output data varies based on the settings for the output channel such as the amount of data, the data size, and the labels.
If the interval events occur more quickly than the time it takes to accomplish the real time output (the interval for writing 
to the external memory device), the Operation Log is recorded up to the data storage amount - 1, and then afterwards, 
old data is discarded in order and replaced with new data.

MICRO/I

Operation Log data
(CSV)

Output to
External memory device

Operation Log data

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

12/01/2011 12:07:30 User2 Base2 Switch to Base Screen - - Base3

3 minute interval 

after operation starts

Data to be output 
3 minutes after 
operation starts

Data to be output
3 minutes 
after that

Data to be output 
after another 
3 minutes

External memory device

USB flash drive

Real time output stops when the file size of the Operation Log data exceeds 256 MB or when there is 
insufficient space on the external memory device. The error information is stored in the following HMI 
Special Data Registers. For details about the error information, refer to Chapter 28 “HMI Special Data 
Register (LSD)” on page 28-5.
USB flash drive: LSD33

• When the value of HMI Special Internal Relay LSM20 changes from 0 to 1, the data at that time is first 
output in real time to the external memory device, and then access to the external memory device is 
stopped.

• The amount of free space on the external memory device is saved to the following HMI Special Data 
Registers. For details about the free space on the External Memory Devices, refer to Chapter 28 “HMI 
Special Data Register (LSD)” on page 28-5.
USB flash drive: LSD34, 35
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File Name: Enter the file name for the output data or shows the file name.
The default is “OPLOGA.CSV”.
To change the file name, enter a new file name. The maximum number is 120 characters (including the 
extension).
Specify File Name by Value of Device Address: Select this check box to specify the name of the file for 

the output data with the value of the device address 
configured by (File Name Device Address).

(File Name Device Address): Specifies the word device that is the source of the data to use as the 
file name. The file name is set by reading the values sequentially from 
the starting device address specified with the File Name Device 
Address and handling those values as character data up to the 
character before NULL (00).
The maximum number of device addresses is 40 (80 single-byte 
characters). You can only specify an internal device. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

Example: When the device address specified by (File Name Device Address) is LDR100 and the text 
to set is "IDEC":

The file name at this time becomes "IDEC.CSV".
Add Device Address data to File Name: Select this check box to add the bottom three digits of the value 

of the device address configured by (File Name Device Address) 
to the end of the file name for the output data.

(File Name Device Address): Specifies the word device that is the source for the value to add to the 
file name. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64. This option can 
only be configured when the Add Device Address data to File 
Name check box is selected.

Example: When File Name is "OPLOGA" and the value of the device address configured by (File 
Name Device Address) is 123, the file name is "OPLOGA123.CSV".

Add Time Stamp: Selects the format of the output date and time to add to the file name for the output 
data.
None, YY, YY+MM, YY+MM+DD
The format is YYMMDD (YY: year, MM: month, DD: day).

Example: File Name is "OPLOGA" on September 15 2013
YY: OPLOGA_13
YY+MM: OPLOGA_1309
YY+MM+DD: OPLOGA_130915

Realtime Output: Select this check box to forcibly output the data and save it to file at the desired 
timing.

(Trigger device address): Specifies the bit device or the bit number of the word device to serve 
as the condition to forcibly output the data. You can only specify an 
internal device. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-64. 
Data is output to file when the trigger device address changes from 0 
to 1.

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be output.

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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 When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the values of the source word device addresses exceeds the maximum number of device 

addresses (no NULL), the text is up to the maximum number of device addresses from the start.
- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.

• The following operations are as follows if the Realtime Output check box is selected.
- Even if the data is outputted forcibly, the real time output period (3 minute interval) is not reset.
- While data is being output with the real time output function, the file is not output when the value of 

the Realtime Output device address is 1.
- Even when output has finished, the value of device address does not automatically change to 0.

• The function to record data operates when Operation Log data is being saved to the external memory 
device.

• The batch output or real time output status of the Operation Log data can be checked with the value of 
HMI Special Internal Relay LSM37. When the data starts to be written to the external memory device, the 
value of device is 1. When writing is complete, the value is 0.

• The methods to erase Operation Log files saved on the external memory device are as follows.
- To erase files during operation using parts, on the External Memory Device tab in the Project 

Settings dialog box, select the Remove Files stored in External Memory Device check box and the 
All Operation Log data check box, and then configure the trigger device address. Assign that trigger 
device address to a part.

- To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in 
External Memory Device to open the Clear Data dialog box. Select the Operation Log Data check 
box and click OK.
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Output Data File Name

The file name format is as follows.
File Name Value of Device Address_YYMMDD_TTMMSS.CSV

■ Example 1

Result: The file name is "OPLOGA123_1309.CSV".

■ Example 2

Result: The file name is "IDEC123_130915_233050.CSV".

File Name: The text entered in File Name or the text entered according to the value of the device 
address set by Specify File Name by Value of Device Address

Value of Device Address: The lower 3 digits of the value of the device address configured by Add Device 
Address data to File Name

YYMMDD: The year, month, and day of the month set on Add Time Stamp

TTMMSS: The hour, minute, and second of the time configured on Add Time Stamp

Item Setting

File Name OPLOGA

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM Date when data was output: September 2013

Item Setting

Specify File Name by Value of Device 
Address

(File Name Device Address) is 
LDR100
Text to set is "IDEC"

LDR100 value: 4944 (Hex)
LDR101 value: 4543 (Hex)
LDR102 value: 0000 (Hex)

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM+DD+HH+MM+SS
Date and time when data was output: 
September 15 2013 at 23:30:50
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4.1 Saving the Data as a CSV File

● Saving the Data as a CSV File
The Operation Log data can be saved to the external memory device as a CSV file or uploaded to a computer.
The procedure to save the data is as follows.
• To save the data to an external memory device, click Operation Log on the WindO/I-NV4 Configuration tab to 

open the Operation Log Settings dialog box. Select an output method check box on the External Memory Device 
tab and configure the items. The Operation Log data is saved to the External Memory Device folder on the external 
memory device according to the External Memory Device tab settings. For details, refer to “External Memory 
Device Tab” on page 15-14.

● Data Structure and Output Example
The data structure of the output file is as follows. The data structure for files output with batch output and real time 
output is the same.
Bold items are replaced by the Operation Log settings, recorded data, project file name, and WindO/I-NV4 version.

4 Using the Data

Headers

"Project Name","Project name","Version number"

"File Type","Log type"

Blank row

Label row
"Sampling Time","User Name","Screen No.","Event Name","Part Name","Device 
Address","Changed to"

Data row

" MM/DD/YYYY HH:MM:SS","User Name","Screen Type & No.","Event","Part 
Name","Device Address", "Changed to"

·
·
·

Output example Data size of each row

"Project Name","Dimmer Console","V4.50" - 41 bytes

"File Type","Operation Log Data" - 34 bytes

- 2 bytes

"Sampling Time","User","Screen No.","Operation","Part Name","Details",
"Changed to"

- 85 bytes

" 12/01/2011 12:00:10","-","Base 1","Power ON","-","-","-" - 60 bytes

" 12/01/2011 12:01:23","User1","Base 1","Switch to Base Screen","-","-", 
"Base2"

- 81 bytes

·
·
·

• The data size for each row is counted as 2 bytes for full-width characters, 1 byte for half-width characters, 
and 2 bytes for newlines. The total for each row is the total amount of space for the file.

• A space is inserted before the date in the data row.
• The display type for the date and time varies based on the language configured in Project Settings, on 

the Project Details tab, in Language.
Japanese: YYYY/MM/DD HH:MM:SS
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY HH:MM:SS
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This chapter describes how to configure the data storage area and its operation on the MICRO/I.

  

1.1 What is the Data Storage Area?

The data storage area is the area in the MICRO/I’s internal memory where saved data is not erased even when the 
power is turned off.
The following data can be saved in the data storage area.

• Alarm Log data
 Chapter 13 “Alarm Log Function” on page 13-1

• Data Log data
 Chapter 14 “Data Log Function” on page 14-1

• Operation Log data
 Chapter 15 “Operation Log Function” on page 15-1

Chapter 16 Data Storage Area

1 Overview

• When there is no remaining battery, the data in the data storage area is erased when the MICRO/I is 
turned off.

• If you download the project data from WindO/I-NV4, Alarm Log data, Operation Log data, and Data Log 
data is erased. The data saved in the HMI Keep Register (LKR) and the HMI Keep Relay (LK) is saved.
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1.2 Data Storage Area

The capacity of the data storage area and the types and sizes of data that can be saved there differ according to the 
MICRO/I model.

● Data Storage Area Capacity and Types of Storable Data
You can allocate areas to save Alarm Log data, Operation Log data, and Data Log data, as well as areas to use as HMI 
Keep Register (LKR) and HMI Keep Relay (LK). The unallocated leftover area is free space.

HG2G-5T

● Minimum and Maximum Amount of Data Storage and Number of Addresses
The minimum and maximum amount of data storage and the minimum and maximum number of addresses that can 
be configured for the data storage area is as follows.

Alarm Log data Operation Log 
data

Data Log data HMI Keep Registers 
(LKR)

HMI Keep Relays 
(LK) Free space

Data storage area (112,640 bytes)

Data type
HG2G-5T

Minimum Maximum

Number of Stored Data for Alarm Log 0 5520

Number of Stored Data for Operation Log 0 3945

Number of Stored Data for Data Log per Device Address 0 13808

Number of HMI Keep Register (LKR) 1024 8192

Number of HMI Keep Relay (LK) 1024 8192
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This section describes the configuration procedure for the data storage area.

1 On the Configuration tab, in the System Setup group, click Data Storage Area.

The Data Storage Area Management dialog box is displayed.

2 Specify the amount of Alarm Log data to save in the data storage area in Number of Stored Data for Alarm Log 
(0 to 5520).

3 Specify the amount of Operation Log data to save in the data storage area in Number of Stored Data for 
Operation Log (0 to 3945).

4 Specify the amount of Data Log data per device address to save in the data storage area in Number of Stored Data 
for Data Log per Device Address (0 to 13808).

5 Specify the number of HMI Keep Register (LKR) addresses in Number of HMI Keep Register (LKR) (1024 to 
8192).

6 Specify the number of HMI Keep Relay (LK) addresses in Number of HMI Keep Relay (LK) (1024 to 8192).

7 Click OK.

The Data Storage Area Management dialog box closes.
This concludes configuring the data storage area.

2 Data Storage Area Configuration Procedure
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This section describes items and buttons on the Data Storage Area Management dialog box.

■ Number of Stored Data for Alarm Log
Specifies the amount of Alarm Log data to save in the data storage area (0 to 5520).
Alarm Log data is only saved in the data storage area when Store is selected under Block Settings, Data in the 
Auto-Setup dialog box or in the Individual Settings dialog box for Alarm Log Settings.

■ Number of Stored Data for Operation Log
Specifies the amount of Operation Log data to save in the data storage area (0 to 3945).

■ Number of Stored Data for Data Log per Device Address
Specifies the amount of Data Log data per device address to save in the data storage area (0 to 13808).
Data Log data is only saved in the data storage area when Enable is selected under Log function on the General 
Tab in the Individual Settings dialog box for Data Log Settings.

■ Number of HMI Keep Register (LKR)
Specifies the number of HMI Keep Register (LKR) addresses (1024 to 8192).

■ Number of HMI Keep Relay (LK)
Specifies the number of HMI Keep Relay (LK) addresses (1024 to 8192).

■ Free Space
Shows the amount of free space in the data storage area (in bytes).

■ Default
Returns the configured values to their default values.

3 Data Storage Area Management Dialog Box
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This chapter describes how to configure the Preventive Maintenance function and its operation on the MICRO/I.

  

1.1 How the Preventive Maintenance Function is Used

The Preventive Maintenance function monitors the state of device addresses and counts the time the monitored 
device addresses are 1, as well as the number of times the values of monitored device addresses change to 1.
The Preventive Maintenance function can perform the following functions.

• Monitor device addresses that turn on lighting or warning lights and count the operation time

• Report the replacement time for lighting and warning lights by the counted operation time

• Monitor device addresses connected to buttons and relays and count the operation count

• Report the inspection time for buttons and relays by the counted operation count

Chapter 17 Preventive Maintenance Function

1 Overview

Lighting

Warning light

External device

MICRO/I

1230 hoursLighting

360 hoursWarning 
light

Lighting

Warning light

External device

MICRO/I

Please replaceLighting

Replace soonWarning 
light

Button

Relay

External device

MICRO/I

123 timesButton

1000  timesRelay

Button

Relay

External device

MICRO/I

Button

Please inspect

Inspect soon

Relay
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1.2 Counting the Operation Time and Operation Count

The operation time and operation count are counted up to the set maximum value. The counted operation time and 
operation count are saved in HMI Keep Registers (LKR) and the values are retained until they are reset. To reset a 
counted value, set the value of the configured HMI Keep Register (LKR) to 0.
The maximum value that can be configured varies based on the data type of the destination device address for the 
operation time and operation count.

● Counting the Operation Time
While the value of the monitored device address is 1, 1 is added to the value of the device address (Operation Time 
Device Address) configured in Measure Operation Time for each second that elapses. The operation time is not 
counted when it is less than one second.
The counted operation time is written to the device address configured in Measure Operation Time.

Example: When the value of monitored device address M0 is 1, 1 is added to the value of Operation Time Device 
Address LKR0.

● Counting the Operation Count
When the value of the monitored device address changes from 0 to 1, 1 is added to the value of the device address 
(operation count device address) configured in Measure Operation Count.
The counted operation count is written to the device address configured in Measure Operation Count.

Example: When the value of monitored device address M0 changes from 0 to 1, 1 is added to the value of operation 
count device address LKR0.

3 sec.

1 sec. 1 sec. 1 sec.

3.4 sec.

1 sec. 1 sec. 1 sec.

0.5 sec. 0.5 sec.

Monitored device address

M0 value

Operation Time Device Address

LKR value

1

0

Operation time

0.4 sec.

0 1 2 3 3 3 3 3 3 3 3 4 5 6 6

Not counted Not counted

If the value of monitored device addresses changes from 0 to 1 in an interval shorter than the MICRO/I 
scan time and the communication cycle with external devices, the operation time and operation count is 
not counted normally. You can check the maximum MICRO/I scan time (x 1 ms) with the value of HMI 
Special Data Register LSD4. You can check the communication cycle with external devices (x 1 ms) with the 
value of HMI Special Data Register LSD6. For details, refer to Chapter 28 “HMI Special Data Register (LSD)” 
on page 28-5.

1

0

Monitored device address

M0 value

Operation count device address

LKR value

Operation count

0 1 1 1 1 1 2 2 3 3 3 4 4 4 4

1 2 3 4
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1.3 Thresholds

The threshold is a value that is the criterion for reporting to a configured device address (Report Device Address) 
when the value counted for the operation time or operation count (a value of Operation Time Device Address or 
Operation Count Device Address) has reached the threshold value. 1 is written to the configured device address when 
the operation time and operation count reach the threshold.

Example: When the value of Operation Time Device Address LKR0 reaches the threshold set for level 1 through level 
3, 1 is written to the Report Device Address configured for each level, LM1 through LM3.

Level Threshold Report Device Address

Level 1 10 LM1

Level 2 15 LM2

Level 3 20 LM3

1

0

1

0

1

0

Operation Time Device Address

LKR0 value
9 10 11 12 13 14 15 16 17 18 19 20 21 22

Level 1 threshold Level 2 threshold Level 3 threshold

Level 1 Report Device Address

LM1 value

Level 2 Report Device Address

LM2 value

Level 3 Report Device Address

LM3 value
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This section describes the configuration procedure for the Preventive Maintenance function.

2.1 Counting Operation Time and Operation Count

1 On the Configuration tab, in the System Setup group, click Preventive Maintenance.
The Preventive Maintenance Settings dialog box is displayed.

2 Specify the number of device addresses to monitor in Number of Items.

3 Select the item to display in Settings with Display Options.
Select Operation Time + Operation Count.
The Operation Time and Operation Count settings are displayed in Settings.

4 Select the number to register the Preventive Maintenance settings to in Settings, then click Edit.
The Individual Settings dialog box is displayed.

5 Specify the bit device or bit number of the word device to monitor with Monitor Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

2 Preventive Maintenance Function Configuration Procedure
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6 Select the Measure Operation Time check box on the Operation Time tab.

If you are not counting the operation time, leave the Measure Operation Time check box cleared and proceed to 
step 9.

7 Specify the destination device address for the counted operation time.

You can only specify an HMI Keep Register (LKR).

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

8 Select the data type for the value of Measure Operation Time device address with Data Type.

This concludes configuring operation time counting.

9 Click the Operation Count tab.

10 Select the Measure Operation Count check box.

If you are not counting the operation count, leave the Measure Operation Count check box cleared and proceed to 
step 13.

11 Specify the destination device address for the counted operation count.

You can only specify an HMI Keep Register (LKR).

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

12 Select the data type for the value of Measure Operation Count device address with Data Type.

This concludes configuring operation count counting.

13 Click OK to close the Individual Settings dialog box.

You are returned to the Preventive Maintenance Settings dialog box.

14 Repeat steps 2 to 13 to register settings to count the operation time and operation count in all the used numbers.

This concludes configuring operation time and operation count counting.

Next, configure the functions to execute using counted data.
 “4.1 Displaying the Counted Operation Count on a Numerical Display” on page 17-11
 “4.2 Notifying with a Beep when the Counted Operation Time Reaches the Threshold” on page 17-14
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This section describes the items and buttons on the Preventive Maintenance Settings dialog box and the 
Individual Settings dialog box.

3.1 Preventive Maintenance Settings Dialog Box

The Preventive Maintenance Settings dialog box is used to manage the preventive maintenance settings for each 
monitored device address.

■ Number of Items
Specifies the number of device addresses (1 to 256) to monitor. The numbers for the amount of configured devices is 
displayed in Settings.

■ Display Options
Select the item to display in Settings from the following:

■ Settings
Edits the settings for each number.

3 Preventive Maintenance Settings Dialog Box

Operation Time: Operation time settings are displayed in Settings.
Operation Count: Operation count settings are displayed in Settings.
Operation Time + Operation Count: Operation time and operation count settings are displayed in Settings.

No.: Shows the number of the preventive maintenance settings to manage. Double 
clicking the cell displays the Individual Settings dialog box. For details, refer 
to “3.2 Individual Settings Dialog Box” on page 17-8.

Monitor Device Address: Shows the bit device or bit number of the word device to count the operation time or 
operation count.
Double clicking the cell displays the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Operation Time Device Address: Shows the destination device address for the counted operation time. You can 
only specify an HMI Keep Register (LKR).
Double clicking the cell displays the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
This option is only displayed when Operation Time or Operation Time + 
Operation Count is selected in Display Options.

Data Type: Shows the date type of the Operation Time Device Address. Double clicking the cell 
displays the Individual Settings dialog box. For details, refer to “3.2 Individual 
Settings Dialog Box” on page 17-8.
This option is only displayed when Operation Time or Operation Time + 
Operation Count is selected in Display Options.
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■ Edit
Registers or changes the settings for the selected number.
Select a number and click this button to display the Individual Settings dialog box. The configured content for the 
selected number is reflected in the Individual Settings dialog box. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 17-8.

■ Remove
Deletes the settings for the selected number.
Select a number and click this button.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

Level 1 to 3 Threshold: Shows the time as a constant or a device address that is the criterion for reporting 
at level 1 through level 3. For a constant, double clicking the cell displays the 
Individual Settings dialog box. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 17-8. For a device address, the Tag Editor is displayed. For 
the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This option is only displayed when Operation Time or Operation Time + 
Operation Count is selected in Display Options.

Level 1 to 3 Report Device Address: Shows the bit device or bit of the word device for reporting when the operation 
time reaches or exceeds the level 1 through level 3 thresholds.
Double clicking the cell displays the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-64.
This option is only displayed when Operation Time or Operation Time + 
Operation Count is selected in Display Options.

Operation Count Device Address: Shows the destination device address for the counted operation count. You can 
only specify an HMI Keep Register (LKR).
Double clicking the cell displays the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-64.
This option is only displayed when Operation Count or Operation Time + 
Operation Count is selected in Display Options.

Data Type: Shows the date type of the operation count device address. Double clicking the 
cell displays the Individual Settings dialog box. For details, refer to “3.2 
Individual Settings Dialog Box” on page 17-8.
This option is only displayed when Operation Count or Operation Time + 
Operation Count is selected in Display Options.

Level 1 to 3 Threshold: Shows the count as a constant or a device address that is the criterion for 
reporting at level 1 through level 3. For a constant, double clicking the cell displays 
the Individual Settings dialog box. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 17-8. For a device address, the Tag Editor is displayed. For 
the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This option is only displayed when Operation Count or Operation Time + 
Operation Count is selected in Display Options.

Level 1 to 3 Report Device Address: Shows the bit device or bit number of the word device for reporting when the 
operation count reaches or exceeds the level 1 through level 3 thresholds.
Double clicking the cell displays the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-64.
This option is only displayed when Operation Count or Operation Time + 
Operation Count is selected in Display Options.
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3.2 Individual Settings Dialog Box

The Individual Settings dialog box is used to configure the operation time and operation count settings for each 
monitored device address.

● Operation Time Tab
The Operation Time tab is used to configure the destination device address for the counted operation time and the 
report conditions when the threshold is reached or exceeded.

■ Measure Operation Time
Select this check box to count the operation time.

■ Data Type
Select the data type for the Operation Time Device Address as UBIN16(W) or UBIN32(D). For details, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.

■ Report when Operation Time has reached or exceeded Threshold level
Select this check box to report when the counted operation time reaches or exceeds the threshold. 

■ (Data Type)
Selects the type of data for the threshold.

■ Level 1
Configures the level 1 threshold and Report Device Address.

Number: Shows the number selected in Settings in the Preventive Maintenance Settings dialog 
box. To change the set number, specify a number (1 to 256).
You can only specify a number of the amount of devices configured by Number of Items 
in the Preventive Maintenance Settings dialog box.

Monitor Device Address: Specifies the bit device or bit number of the word device to count the operation time or 
operation count.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

(Operation Time Device Address): Specifies the destination device address for the counted operation time. You can 
only specify an HMI Keep Register (LKR).

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

If you specify the same device address as the Operation Time Device Address for multiple numbers, the 
counted operation time is added in total by all the monitored device addresses for each number and the 
function will not be able to count normally.

Value: Uses a constant as the threshold.
Device Address: Uses a value of device address as the threshold.

Threshold Specifies the time as a constant or a device address that is the criterion for reporting at 
level 1. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
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■ Level 2
Select this check box to configure the level 2 threshold and Report Device Address.

■ Level 3
Select this check box to configure the level 3 threshold and Report Device Address.

● Operation Count Tab
The Operation Count tab is used to configure the destination device address for the counted operation count and 
the report conditions when the threshold is reached or exceeded.

■ Measure Operation Count
Select this check box to count the operation count.

Report Device Address: Specifies the bit device or bit number of the word device for reporting when the operation 
time reaches or exceeds the level 1 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

Threshold Specifies the time as a constant or a device address that is the criterion for reporting at 
level 2. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Report Device Address: Specifies the bit device or bit number of the word device for reporting when the operation 
time reaches or exceeds the level 2 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

Threshold Specifies the time as a constant or a device address that is the criterion for reporting at 
level 3. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Report Device Address: Specifies the bit device or bit number of the word device for reporting when the operation 
time reaches or exceeds the level 3 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

(Operation Count Device Address): Specifies the destination device address for the counted operation count. You can 
only specify an HMI Keep Register (LKR).

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

If you specify the same device address as the operation count device address for multiple numbers, the 
counted operation count is added in total by all the monitored device addresses for each number and the 
function will not be able to count normally.
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■ Data Type
Select the data type for the operation count device address as UBIN16(W) or UBIN32(D). For details, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.

■ Report when Operation Count has reached or exceeded Threshold level
Select this check box to report when the counted operation count reaches or exceeds the threshold.

■ (Data Type)
Selects the type of data for the threshold.

■ Level 1
Configures the level 1 threshold and Report Device Address.

■ Level 2
Select this check box to configure the level 2 threshold and Report Device Address.

■ Level 3
Select this check box to configure the level 3 threshold and Report Device Address.

Value: Uses a constant as the threshold.

Device Address: Uses a value of device address as the threshold.

Threshold Specifies the count as a constant or a device address that is the criterion for reporting at 
level 1. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Report Device Address: Specifies the bit device or bit number of the word device for reporting when the operation 
count reaches or exceeds the level 1 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

Threshold Specifies the count as a constant or a device address that is the criterion for reporting at 
level 2. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Report Device Address: Specifies the bit device or bit number of the word device for reporting when the operation 
count reaches or exceeds the level 2 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

Threshold Specifies the count as a constant or a device address that is the criterion for reporting at 
level 3. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Report Device Address: Specifies the bit device or bit number of the word device for reporting when the operation 
count reaches or exceeds the level 3 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
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4.1 Displaying the Counted Operation Count on a Numerical Display

1 On the Configuration tab, in the System Setup group, click Preventive Maintenance.

The Preventive Maintenance Settings dialog box is displayed.

2 Specify the number of device addresses to monitor in Number of Items.

3 Select the item to display in Settings with Display Options.
Select Operation Count.
Operation count settings are displayed in Settings.

4 Select the number to register the Preventive Maintenance settings to in Settings, then click Edit.
The Individual Settings dialog box is displayed.

5 Specify the bit device or bit number of the word device to monitor with Monitor Device Address.

4 Using the Data
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6 Click the Operation Count tab.

7 Select the Measure Operation Count check box and specify the destination device address for the counted 
operation count.

8 Select the data type for the value of Measure Operation Count device address with Data Type.

9 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Display.

10 Click a point on the edit screen where you wish to place the Numerical Display.

11 Double-click the dropped Numerical Display and the Properties dialog box is displayed.
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12 On the General tab, under Display Type, click Decimal.

13 Under Data Format, in Data Type, select the data type for the value to display.

Select the same data type as the data type selected on the Operation Count tab in the Preventive Maintenance 
settings Individual Settings dialog box.

14 Specify Digits for the value to display.

The digits that can be set varies based on the display type or data type.

15 Under Display Method, in Display Device Address, specify the destination device address for the counted 
operation count.

Select the same device address as the device configured with Measure Operation Count on the Operation Count 
tab in the Preventive Maintenance settings Individual Settings dialog box.

16 Click OK.

The properties dialog box closes.
This concludes the configuration to display the counted operation count on a Numerical Display.
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4.2 Notifying with a Beep when the Counted Operation Time Reaches the Threshold

1 On the Configuration tab, in the System Setup group, click Preventive Maintenance.

The Preventive Maintenance Settings dialog box is displayed.

2 Specify the number of device addresses to monitor in Number of Items.

3 Select the number to register the Preventive Maintenance settings to in Settings, then click Edit.

The Individual Settings dialog box is displayed.

4 Specify the bit device or bit number of the word device to monitor with Monitor Device Address.

5 Select the Measure Operation Time check box on the Operation Time tab and specify the destination device 
address for the counted operation time.

6 Select the data type for the value of Measure Operation Time device address with Data Type.
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7 Select the Report when Operation Time has reached or exceeded Threshold level check box.

8 Select the type of data for the threshold.

If you select Value, specify the threshold as a constant.
If you select Device Address, specify the threshold as a value of device address.

9 Configure Threshold for level 1.

When you select Value as the threshold data type, specify the threshold as a constant. The range for the constant 
that can be set varies based on the data type.
When you select Device Address as the threshold data type, specify the threshold as a value of device address. Click 

 to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

10 Configure Report Device Address for level 1.

Specify the bit device or bit number of the word device for reporting when the threshold is reached or exceeded. Click 

 to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.
You can only specify an internal device.

11 Click OK to close the Individual Settings dialog box.

You are returned to the Preventive Maintenance Settings dialog box.

12 Click OK.

The Preventive Maintenance Settings dialog box closes.

13 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.
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14 On the Channel tab, under Source Device Address Type, select Bit and specify Number of Blocks.

15 Select the channel number to register the level 1 Report Device Address to and click Edit.

The Individual Settings dialog box is displayed.

16 Specify the level 1 Report Device Address in Source and select Store under Data.

Set Source to the level 1 Report Device Address configured on the Operation Time tab in the Preventive 
Maintenance settings Individual Settings dialog box.

17 Select Enable under Alarm function, select NO under NO/NC, and click OK.
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18 On the Alarm Log Settings dialog box, switch the alarm function for all the unused channel numbers to Disable.

Select all the unused channels with the  key + click or the  key + click and click Edit.
The Individual Settings dialog box is displayed.

Under Channel Settings - Alarm function, select Disable and click OK.
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19 Click the Options tab in the Alarm Log Settings dialog box.

20 Select the Trigger Buzzer when Alarm occurs check box.

21 Click OK.

The Alarm Log Settings dialog box closes.
This concludes the configuration to notify with a beep when the counted operation time reaches the threshold.
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This chapter describes how to configure the Recipe function and its operation on the MICRO/I.

  

1.1 How the Recipe Function is Used

The Recipe function batch writes values prepared in advanced to specified device addresses and batch reads the values 
for specified device addresses according to the state of a device address. Use this function for situations such as 
configuring the initial values of an external device when the MICRO/I starts running. The data used by the Recipe 
function is called recipe data for the data saved in internal memory, a recipe file for data saved to the external memory 
device, and recipe values for the values written to device addresses that were saved in recipe data and recipe files.
The Recipe function can perform the following functions.

• Batch write the recipe values saved in internal memory to device addresses when a value of device address 
changes from 0 to 1

• Batch write the recipe values saved on the external memory device to device addresses when a value of device address 
changes from 0 to 1

• Batch read values of device addresses and save them to the external memory device as a recipe file when a value of 
device address changes from 0 to 1

Chapter 18 Recipe Function

1 Overview
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The values of device addresses can be retained when the power is turned off by reading values of device 
addresses to the external memory device and saving them as a recipe file and then writing those values the 
next time the power is turned on.
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1.2 Data for Recipes

The data handled by the Recipe function is based on the top device address and the amount of data selected.
Example: The top device address is D100 and the amount of data is 10.

Value of Device Address
D100 1111

D101 2222

D102 3333

D103 4444

D104 5555

D105 6666

D106 7777

D107 8888

D108 9999

D109 11111
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1.3 Data Configuration

The relationship between the Recipe function settings and the data for recipes is as follows.

1. Number of blocks: The operation using the data for recipes is configured in blocks (0 to 64). 1 block is 16 channels.

2. Channels: Destination device addresses and recipe values are configured in channels. 1 channel is used 
for 1 item of data for the recipe.

3. Amount of data: The amount of data configured for one channel. The maximum amount of data that can be 
configured is 8192.

4. Top Device Address: The start address of the destination device addresses for recipe values and the source device 
addresses for values of device addresses.

5. Data: The values to write to the device addresses.
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5. Data4. Top Device Address

1. Number of blocks

2. Channel 1 to 16

3. Amount of data

Recipe settings

Data for recipes

If Float32(F) is selected for Data Type on the Channel tab, the values of device addresses that were 
read are saved to the recipe file in the floating point type. However, when a value that was read is 8 digits or 
larger, it is saved in the exponential type.

If there are many word devices for the data for the recipe, it will take time to read and write them. For 
example, when using the Recipe function to configure initial values, if other processes are executed before 
the function is finished writing all the settings, you may experience unexpected results. Monitor System 
Area 2 Transferring recipe bit (address number+3, bit4) while the recipe is transferring and wait until 
reading and writing the data for the recipe is finished before executing other processes. For details, refer to 
Chapter 4 “System Area” on page 4-17.
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This section describes the configuration procedure for the Recipe function.

2.1 Configuring Recipe Function Operations and Device Addresses

1 On the Configuration tab, in the System Setup group, click Recipe.

The Recipe Settings dialog box is displayed.

2 Specify the number of blocks to use as data for the recipe in Number of Blocks.

The operation using the data for the recipe is configured in blocks (0 to 64). 1 channel is used for 1 item of data for 
the recipe. 1 block is 16 channels.
The maximum number of blocks that can be configured is 64 blocks. The maximum number of device addresses that 
can be configured for 1 channel is 8192 devices.

3 Select the number of the data for the recipe to configure in Settings, then click Edit.

The Individual Settings dialog box is displayed.

2 Recipe Function Configuration Procedure
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4 On the Channel tab, under Recipe function, select Enable.

The channel for the block number displayed in Channel is enabled.

5 Enter the name for the Recipe function in Recipe Name.

The maximum number is 40 characters.

6 Specify the destination device address for the Recipe values in Top Device Address.

To read values of device addresses and save them as a recipe file, specify the source device address of the values.

Click  to display the Tag Editor.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
The specified device addresses are configured sequentially from the number 1 in Data List on the Data tab.

7 Select the data type for the values to write with Data Type.

To read values of device addresses and save them as a recipe file, specify the type of data for the read values.

8 With Number of Data, specify the number of destination device addresses starting with the device address 
configured by Top Device Address.

To read values of device addresses and save them as a recipe file, specify the number of source device addresses.
The sequential device addresses from the start address for the number of configured device addresses are displayed 
in Settings on the Data tab.
The amount of data that can be set varies based on the data type. When UBIN16(W), BIN16(I), or BCD4(B) is 
selected for Data Type, up to 8192 items of data can be configured. When UBIN32(D), BIN32(L), BCD8(EB), or 
Float32(F) is selected, up to 4096 items of data can be configured.

9 With Display Type, select the display type for Data to configure in Data List on the Data tab.

To save data to a recipe file, the display type is decimal for all.
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10 Click the Data tab.

The data for the recipe in the amount specified by Number of Data on the Channel tab is configured in Data List. 
In Device Address, the devices are sequentially configured starting from the device address specified by Top 
Device Address.

11 Double click the data cell for each number in Data List to enter the value to write to the device address.

The value for the device address that can be configured varies based on Data Type and Display Type configured on 
the Channel tab.
When Read-only is selected under Trigger Setting on the Block tab, entering values of device addresses is 
unnecessary.

12 Click the Block tab.

13 Select the destination to save recipe data to under Access to.

This option is set by block.

■ External Memory Device
Use a recipe file saved to the external memory device.

■ Internal Memory
Use recipe data saved to internal memory.

If you selected Internal Memory, proceed to step 17.
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14 Enter the file name for the recipe file in File Name.

The default file name is “RCPn.CSV”. (n: 4 digit sequential number)
To change the file name, enter a new file name. The maximum number is 120 characters (including the extension).
The file is overwritten when there is a recipe file with the same name on the external memory device.

15 Select the operation using the data for the recipe under Trigger Setting.

This option is set by block.

■ Read/Write 
Save batch read values of device addresses to the external memory device as a recipe file or write them to device 
addresses as recipe values.
This option can only be configured when External Memory Device is selected under Access to.

■ Read-only
Save batch read values of device addresses to the external memory device as a recipe file.
This option can only be configured when External Memory Device is selected under Access to.

■ Write-only
Write recipe values to device addresses.

If you select Write-only, proceed to step 17.

16 Specify the device address that triggers batch reading values of device addresses and saving them to the external 
memory device as a recipe file in Read Trigger.

This option is set by block.

Click  to display the Tag Editor.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
This option can only be configured when Read/Write or Read-only is selected under Trigger Setting.

If you selected Read-only, proceed to step 18.

17 Specify the device address that triggers batch writing recipe values to device addresses in Write Trigger.

This option is set by block.

Click  to display the Tag Editor.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.
This option can only be configured when Read/Write or Write-only is selected under Trigger Setting.

18 Click OK to close the Individual Settings dialog box.

You are returned to the Recipe Settings dialog box.

19 Repeat steps 3 through 18 to register data for the recipe to all the used channels.

20 Click OK.

The Recipe Settings dialog box closes.

For details on how to create and edit the data for recipes, refer to “4 Creating and Deleting Data for Recipes” on page 
18-14.
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This section describes the items and buttons on the Recipe Settings dialog box and the Individual Settings dialog 
box.

3.1 Recipe Settings Dialog Box

Use the Recipe Settings dialog box to collectively manage the save destination of data for recipes, the device 
addresses for writing recipe values and reading values of device addresses, and those execution conditions.

■ Number of Blocks
The operation using the data for the recipe is configured in blocks (0 to 64). 1 channel is used for 1 item of data for 
the recipe. 1 block is 16 channels.
The maximum number of blocks that can be configured is 64 blocks. The maximum number of device addresses that 
can be configured for 1 channel is 8192 devices.

■ Settings
Edits the recipe settings for each channel.

3 Recipe Settings Dialog Box

No.: Displayed as (Block No.)-(Channel No.). Double clicking the cell displays the Individual 
Settings dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

Access to: Shows the save destination for the data for the recipe. Double clicking the cell switches between 
Internal Memory and External Memory Device.

Trigger Setting: Shows the operation using the data for the recipe. When External Memory Device is selected 
for Access to, double clicking the cell switches between Write-only, Read/Write, and Read-
only. Shows Write-only when Internal Memory is selected for Access to.

Read Trigger: Shows the device address that triggers saving the recipe file. Double clicking the cell displays 
the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This option can only be configured when Read/Write or Read-only is selected under Trigger 
Setting.

Write Trigger: Shows the device address that triggers writing recipe values to device addresses. Double 
clicking the cell displays the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.
This option can only be configured when Read/Write or Write-only is selected under 
Trigger Setting.

Recipe function: Shows whether or not to use the Recipe function. Double clicking the cell switches between 
Enable and Disable.
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■ Edit
Registers or changes the settings for the selected number.
Select a number in Settings and click this button to display the Individual Settings dialog box. The settings for the 
selected channel are reflected in the Individual Settings dialog box.
For details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

■ Save Recipe Files to External Memory Device
Saves all the settings in every channel on the Recipe Settings dialog box to the external memory device as a recipe 
file.
Click this button to display the Select Drive dialog box.
Only saves channels configured with Access to set to External Memory Device and Recipe Function set to 
Enable.

Recipe Name: Shows the name of the Recipe function for each channel. Double clicking the cell displays the 
Individual Settings dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on 
page 18-10.

Top Device Address: Shows the start device of the destination device addresses for recipe values and the source 
device addresses for values of device addresses. Double clicking the cell displays the Tag Editor. 
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-64.
This option can only be configured when Recipe function is Enable.

Data Type: Shows the data type of the values of source or destination device addresses. Double clicking the 
cell displays the Individual Settings dialog box. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 18-10.

No. of Data: Shows the number of source or destination device addresses starting with the device address 
configured by Top Device Address. Double clicking the cell displays the Individual Settings 
dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

Display Type: Shows the display type of Data in Data List configured on the Data tab in the Individual 
Settings dialog box. Double clicking the cell displays the Individual Settings dialog box. For 
details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

To register or edit multiple numbers as a group, press and hold SHIFT or CTRL while you click the specific 
items to select multiple lines and click Edit. The details configured on the Individual Settings dialog box 
are collectively configured.
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3.2 Individual Settings Dialog Box

Use the Individual Settings dialog box to register or edit the recipe settings for the selected channel.

● Block Tab
The Block tab is used to configure settings that are managed by blocks such as the save destination for the data for 
the recipe to use, the Recipe function operation, and the operation trigger.

■ Access to
Selects the save destination for data for the recipe to use when writing values to device addresses.

■ File Name
Enter the file name of the recipe file to save on the external memory device.
The default file name is “RCPn.CSV”. (n: 4 digit sequential number)
To change the file name, enter a new file name. The maximum number is 120 characters (including the extension).
The file is overwritten when there is a recipe file with the same name on the external memory device.

■ Trigger Setting
Selects the operation using the data for the recipe.

External Memory Device: Uses a recipe file saved to the external memory device.
Requires an external memory device with a saved recipe file. For details, refer to “4.2 
Creating Recipe Files” on page 18-17.

Internal Memory: Uses recipe data saved to internal memory.
Since recipe data is handled as a portion of project data, it may put pressure on the 
volume of project data that can be downloaded. One item of recipe data uses 2 bytes 
when the top device address data type is 16 bits and it uses 4 bytes when the top device 
address data type is 32 bits.
Example: When the top device address data type is 16 bits and using 1 block of 16 

channels of recipe data with a data amount of 10
2 x 10 x 1 x 16 = 320 bytes
When the top device address data type is 32 bits and using 64 blocks of 16 
channels of recipe data with a data amount of 100
4 x 100 x 64 x 16 = 409.6 kilobytes

Read/Write: Saves batch read values of device addresses to the external memory device as a recipe file and 
writes them to device addresses as recipe values.
This option can only be configured when External Memory Device is selected under Access to.

Read-only: Saves batch read values of device addresses to the external memory device as a recipe file.
This option can only be configured when External Memory Device is selected under Access to.

Write-only: Writes recipe values to device addresses.

If Float32(F) is selected for Data Type on the Channel tab, the values of device addresses that were 
read are saved to the recipe file in the floating point type. However, when a value that was read is 8 digits or 
larger, it is saved in the exponential type.
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■ Read Trigger
Specifies the device address that triggers batch reading values of device addresses and saving them to the external 
memory device as a recipe file.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This option can only be configured when Read/Write or Read-only is selected under Trigger Setting.

■ Write Trigger
Specifies the device address that triggers batch writing recipe values to device addresses by block.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
This option can only be configured when Read/Write or Write-only is selected under Trigger Setting.

■ Monitoring Period
Shows the period to monitor the write trigger device address and the read trigger device address. This period is for 
detecting alarms so it is the same as the period to monitor states of device addresses. This option is configured on the 
General tab in the Alarm Log Settings dialog box.

Each bit of the word device configured by the read trigger device address corresponds to a channel.
When a bit changes from 0 to 1, a read to the device address is executed.
Example: When the block 1 read trigger device address is specified as LDR0000

LDR0000-0 corresponds to channel 1-0, LDR0000-1 to channel 1-1, through to LDR0000-15 which 
corresponds to channel 1-15.

bit bit

Channel 1-0

15 0

LDR0000

Channel 1-15

Each bit of the word device configured by the write trigger device address and the read trigger device 
address corresponds to a channel.
When a bit changes from 0 to 1, a write to the device address is executed.
Example: When the block 1 write trigger device address is specified as LDR0000

LDR0000-0 corresponds to channel 1-0, LDR0000-1 to channel 1-1, through to LDR0000-15 which 
corresponds to channel 1-15.

bit bit

Channel 1-0

15 0

LDR0000

Channel 1-15

• If Access to is set to External Memory Device and no recipe file exists in the "RECIPE" folder located in 
the External Memory Device folder on the external memory device, the recipe values are not written to the 
device addresses.

• If value of device address reads and recipe value writes occur simultaneously, first the values of device 
addresses are read, then the recipe values are written.
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● Channel Tab
The Channel tab is used to configure the recipe name for the selected channel and the device addresses to read and 
write values to.

■ Channel
Shows the block number and the channel number for the selected channel.

■ Recipe function
Selects whether or not to use the Recipe function.

■ Recipe Name
Enter the name for the Recipe function to differentiate the channel. The maximum number is 40 characters. The 
default is “Recipen”. (n: 4 digit sequential number)

■ Top Device Address
Specifies the start device address of the destination device addresses for recipe values and the source device 
addresses for values of device addresses.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
The specified device addresses are configured sequentially from the number 1 in Data List on the Data tab.

■ Data Type
Selects the type of data for recipe values to write and values of device addresses that are read. For details, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.

■ Number of Data
Specifies the number of source or destination device addresses starting with the device address configured by Top 
Device Address.
The sequential device addresses from the start address for the number of configured device addresses is displayed in 
Settings on the Data tab.
The amount of data that can be set varies based on the data type. When UBIN16(W), BIN16(I), or BCD4(B) is 
selected for Data Type, up to 8192 items of data can be configured. When UBIN32(D), BIN32(L), BCD8(EB), or 
Float32(F) is selected, up to 4096 items of data can be configured.

■ Display Type
Selects the display type for Data in Data List configured on the Data tab as Decimal or Hexadecimal.
Values when saving data to a recipe file are decimal.

Block Number: Shows the block number for the channel selected in Settings.

Channel Number: Shows the channel number for the channel selected in Settings.

Enable: Writes recipe values to device addresses, reads values of device addresses and saves them to 
the external memory device as a recipe file.

Disable: The Recipe function is not used.
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● Data Tab
The Data tab is used to configure recipe values written to device addresses.

■ Channel
Shows the block number and the channel number for the selected channel.

■ Data List
Enter the recipe values to write to device addresses for each number in the selected channel.

■ Import
Displays the Open dialog box.
Select a recipe file and click Open to overwrite the data in Data List with the selected recipe file.

■ Export
Displays the Save As dialog box.
Select the location to save the recipe file, enter a file name, and then click Save to save the recipe file for the selected 
channel.
The saved recipe file can be edited using Notepad, commercially available text editors, and spreadsheet software.

Block Number: Shows the block number for the channel selected in Settings.

Channel Number: Shows the channel number for the channel selected in Settings.

No.: Shows the data numbers for the amount of data specified by Number of Data.

Device Address: Devices are sequentially configured starting from the device address specified by Top Device 
Address on the Channel tab.

Data: Double click a cell to enter a recipe value. The value that can be configured varies based on 
Data Type and Display Type configured on the Channel tab.
When Read-only is selected under Trigger Setting on the Block tab, entering recipe values 
is unnecessary.
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4.1 Editing Recipe Data

You can export recipe data for the selected channel, edit the recipe values in a saved file, and import a recipe file back 
into WindO/I-NV4.

1 On the Configuration tab, in the System Setup group, click Recipe.

The Recipe Settings dialog box is displayed.

2 Select the channel number to export its recipe data in Settings, then click Edit.

The Individual Settings dialog box is displayed.

3 Click the Data tab, then click Export.

The Save As dialog box is displayed.

4 Creating and Deleting Data for Recipes



WindO/I-NV4 User’s Manual 18-15

4 Creating and Deleting Data for Recipes

18

Recipe Function

4 Specify the save location in Save in and click Save.

The file name specified on the Block tab in the Individual Settings dialog box is entered in File name.

5 Open the exported recipe data file.

Use Notepad, a commercially available text editor, or spreadsheet software.

6 Edit the values and save the file.

7 Return to the Data tab in the Individual Settings dialog box and click Import.

The Open dialog box is displayed.
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8 Specify the file and click Open.

The recipe data is imported.

9 Click OK.

The Individual Settings dialog box closes.

10 Click OK.

The Recipe Settings dialog box closes.
This concludes editing recipe data.
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4.2 Creating Recipe Files

Recipe files can be created on the external memory device with the following procedure. The recipe values configured 
on the Data tab in the Individual Settings dialog box are saved in recipe files.
 “Creating Recipe Files in the Recipe Settings Dialog Box” on page 18-17
 “Creating Recipe Files when Downloading Project Data” on page 18-19
 “Creating Recipe Files with a Text Editor” on page 18-20

● Creating Recipe Files in the Recipe Settings Dialog Box

1 Insert an external memory device in the computer.

To use a USB flash drive, insert it into the computer's USB port.

2 On the Configuration tab, in the System Setup group, click Recipe.

The Recipe Settings dialog box is displayed.

3 Click Save Recipe Files to External Memory Device.

The Select Drive dialog box is displayed.

Computer

In USB portUSB flash drive
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4 Specify the drive for the external memory device, then click OK.

■ Drive
Specifies the drive assigned to the external memory device.

■ Network
Displays the Map Network Drive dialog box. This dialog box allows you to specify a drive on the network.

■ External Memory Device Folder
Specifies the folder to save the created recipe file.

Click  to display the Project Settings dialog box. You can specify the External Memory Device folder used as the 
save destination.

5 Click OK.

The Recipe Settings dialog box closes.
The “RECIPE” folder is created in the External Memory Device folder used as the save destination, and the recipe files 
for the channels configured with Access to set to External Memory Device and Recipe Function set to Enable 
in the Recipe Settings dialog box are created.
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● Creating Recipe Files when Downloading Project Data
When a project download is executed, the “RECIPE” folder is created in the External Memory Device folder on the 
external memory device inserted in the MICRO/I and the recipe files are created. The recipe files are only created for 
channels configured with Access to set to External Memory Device and Recipe Function set to Enable in the 
Recipe Settings dialog box.

1 Insert an external memory device into the MICRO/I.

2 On the Home tab, in the Project group, click the Download icon.

The Download dialog box is displayed.

If the project data was changed, a confirmation message to save the project data is displayed.
Click OK to save the project data and display the Download dialog box.
Click Cancel to return to the editing screen without saving the project data.

3 Select the Download Recipe Files to External Memory Device check box.

4 Verify Communication Settings and click Download.
Since the recipe files are downloaded to the external memory device inserted in the MICRO/I, use the same settings 
as when communicating with the MICRO/I.
To change Communication Settings, click Change to display the Communication Settings dialog box. Change 
Communicate with, Port, and Baud Rate. For details, refer to Chapter 22 “1 Communicating with the MICRO/I” 
on page 22-1.

The External Memory Device folder is configured in the Project Settings dialog box. For details, refer to 
Chapter 27 “1.6 Setting the External Memory Device Folder” on page 27-14.

MICRO/I

USB flash drive

External Memory Device

If security is enabled in the MICRO/I project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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5 Click Yes.
The Download Project dialog box is displayed and the project files start downloading.
When finished downloading, a completion message is displayed.

6 Click OK.
You are returned to the Download Project dialog box.

7 Click Close.

● Creating Recipe Files with a Text Editor
You can edit recipe files using Notepad, commercially available text editors, or spreadsheet software.

1 Write the data for the amount of data in “value of device address” comma (,) new line order.

If the amount of data in the recipe file is lower than the amount of data for the top device address configured on the 
Channel tab in the Individual Settings dialog box, 0 is written in the rest of the device addresses.

2 Save the file with the “.csv” extension.

Give the file the file name configured on the Block tab in the Individual Settings dialog box. If the file name is 
different, 0 is written to all the device addresses.

3 Copy the edited recipe files to the “RECIPE” folder in the External Memory Device folder on the external memory device.
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4.3 Editing Recipe Files

The recipe file that was read can be edited using Notepad, commercially available text editors, or spreadsheet 
software.

You can read and display the data saved from the MICRO/I to the 
external memory device as a recipe file on a computer. External Memory Device Book1

Recipe File

100
150
200

You can upload recipe files from the external memory device using WindO/I-NV4.
On the Online tab, click the arrow under Upload, and click Stored Data in External Memory Device to 
display the Upload Data from External Memory Device dialog box. Select the Recipe Files check box, 
specify the location to save the recipe files in Path, and click OK to be able to save the recipe files in the 
specified folder.
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4.4 Deleting Recipe Files

The methods to delete recipe files saved on the external memory device are as follows.
• To delete files with WindO/I-NV4, on the Online tab, in the MICRO/I group, click Clear, and then click Stored 

Data in External Memory Device to display the Clear Data dialog box. Select the Recipe Files check box and 
click OK.
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This chapter describes the Text Group function and how to configure text groups and text.

  

1.1 How to Create the Text Groups and Text Registrations

Text groups are a function where the text used for such purposes as registration text, messages for parts, chart 
labels, and titles for Popup Screens are registered in advance. The registered text is loaded and displayed when 
displaying parts and screens. The text can be managed collectively including editing the registered text and adding or 
deleting text.
Text groups can perform the following functions.

• Switch the displayed language by value of device address.

• Use common text for parts.

Chapter 19 Text Group

1 Overview

External device
MICRO/I

目標達成

D100 : 1

D100 : 2

D100 : 3

Text ID: 1 目標達成

Group 1: English Group 2: Chinese Group 3: Japanese

Goal reached

Goal reached

MICRO/I

RUN STOP

Base Screen 1

Base Screen 2

RUN STOP

Text ID: 1 RUN
Text ID: 2 STOP

Group 1: English
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1.2 Functions that Support Text Groups

The functions that support text groups are as follows.

Item Setting

Screen Popup Screen Title

Drawings Text Text

Buttons

Bit Button Registration Text

Word Button Registration Text

Goto Screen Button Registration Text

Print Button Registration Text

Key Button Registration Text

Multi-Button Registration Text

Selector Switch Registration Text

Lamps
Pilot Lamp Registration Text

Multi-State Lamp Registration Text

Data 
Displays

Numerical Input Unit

Message Display Message

Message Switching 
Display

Message

Alarm List Display Message

Alarm Log Display Message, Title

Numerical Display Unit

Charts
Bar Chart X-axis and Y-axis scale labels

Line Chart X-axis and Y-axis scale labels

Alarm Log Messages displayed in data output as CSV

Data Log Labels displayed in data output as CSV

Operation Log Recorded item labels and event names displayed in data output as CSV

When the text group is switched, the displayed Base Screen is reset. Popup Screens and internal devices 
have the same behavior as when the Base Screen is switched. If the Close while changing Base Screen 
check box is selected on the Options tab in the properties dialog box for the Popup Screen, the displayed 
Popup Screen is closed. The behavior of the internal devices differs according to the internal devices. For 
details, refer to Chapter 28 “Internal Devices” on page 28-1.
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This section describes the configuration procedure for text groups and text.

2.1 How to Create the Text Groups and Text Registrations

1 On the View tab, in the Workspace group, click  (Text Manager).

Text Manager is displayed.

2 In Number of Text Groups, specify the number of text groups to create (1 to 32).

The configured number of text groups are enabled.

3 Double click (Text Group Name).

The Text Group Settings dialog box is displayed.

2 Text Groups and Text Configuration Procedure

(Text Group Name)
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4 Under Text Group Name, enter the name for the text group.

The maximum number for the Text Group Name is 20 characters.

5 Click OK.

The Text Group Settings dialog box closes.

For one text group, proceed to step 8.

6 Repeat steps 3 through 5 to create the necessary text group.

7 With Change Text Group by Device Address, specify the word device as the condition to switch the text group.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
These options can only be configured when Number of Text Groups is specified as two or more.

8 With (Font), select the font to use for the text to register from the following.

European, Japanese, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows

9 With (Text Color), select the color of the text to register (color: 256 colors, monochrome: 16 shades).

Click Color to display the Color Palette. Select a color from the Color Palette.

To use when the MICRO/I power is turned on or switched to Run Mode, select the Use this Text Group as 
Default check box.

The text group displayed with  in Text Manager is the default.

When the value of device address is 0, the text group switches to the text group set as the default.
If the value of device address is invalid, the text group is not switched.

When Windows is selected, all the fonts installed on the computer can be used. This allows you to display 
fonts and languages that are not installed on the MICRO/I.
Click Change to display the Font Settings dialog box. Configure the details such as the font, style, and size. 
For details, refer to Chapter 2 “Windows Font” on page 2-12.

(Font)

(Text Color)
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10 To register the text, double click the cell and enter the text in the Text Manager.

The maximum number is 3750 characters.
The characters that can be entered vary based on the font selected. For details, refer to Chapter 2 “1.2 Available Text” 
on page 2-5.

11 Repeat steps 8 through 10 to create the necessary text in each text group.

12 Click OK.

This concludes creating text groups and registering text.

You can enter multi-line text by inserting a newline. The newline is displayed as \n and is counted as two 
characters.

(Text)
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● Saving Registered Text as a CSV File
To use registered text in another project, save the text as a CSV file or as a text file. This file is called a text list.

1 On the View tab, in the Workspace group, click  (Text Manager).

Text Manager is displayed.

2 Select the (Text) of the Text Group to export.

3 Click  (Export).

The Export dialog box is displayed.

4 Enter the location to Location, and then select the file format (*.csv or *.txt) as the Save as type.

The file name becomes "TextGroup**". (** is the same number as the group, 01 to 32)
Example: Save the text for text group 1 and text group 2 as a CSV file

TextGroup01.csv and TextGroup02.csv files are saved in the specified location.

5 Click OK.

This concludes saving a text list.

(Text)

To export multiple text groups, select all of (Text) for the text groups to export. To select multiple items of 
(Text), press and hold SHIFT or CTRL key while you click the specific items.
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● Importing Text from a Text List
A text list saved as a CSV file or as a text file can be imported into Text Manager for the project being edited.

1 On the View tab, in the Workspace group, click  (Text Manager).

Text Manager is displayed.

2 Select the (Text) of the Text Group to import.

3 Click  (Import).

The Open dialog box is displayed.

4 Select a saved text list and click Open.

To import multiple text lists, select all of the text lists to import. To select multiple text lists, press and hold 
SHIFT or CTRL key while you click the specific items.
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An Import dialog box is displayed if a text ID is included in the text list however it has already been registered on the 
Text Manager. Here are your options: 
• Click Yes to overwrite the text in the text list with the text of the displayed text ID, and then to display confirmation 

to overwrite the next text ID.
• Click Yes To All to overwrite all the text in the text list without displaying the Import dialog box subsequently.
• Click No to display the next confirmation to overwrite without overwriting the text with the displayed Text Manager 

ID.
• Click Cancel to stop importing text.

The imported text is displayed in the Text Manager.

This concludes importing text from a text list.



WindO/I-NV4 User’s Manual 19-9

2 Text Groups and Text Configuration Procedure

19

Text G
roup

2.2 Switching the Displayed Language by Value of Device

When multiple text groups have been created, the text group can be switched with a value of device address to 
display a different language.
This section describes an example when the registration text for a button changes between English, Chinese, and 
Japanese.

1 Following the steps in “How to Create the Text Groups and Text Registrations” on page 19-3, specify Number of 
Text Groups as 3, and under Text Group Name, enter “English” for Group 1, “Chinese” for Group 2, and 
“Japanese” for Group 3. Set Change Text Group by Device Address to D100.
Register the following text.

2 Create a Bit Button.
On the Home tab, in the Parts group, click Buttons, and then click Bit Button.

3 Click a point on the edit screen where you want to place the Bit Button.

External device
MICRO/I

RUN STOP

Bit Button 2 (Text ID: 2)

Bit Button 1 (Text ID: 1)

D100 :

D100 :

D100 :

1

2

3

Text ID: 1

Group 1: English Group 2: Chinese

Text ID: 2

Group 3: Japanese

RUN
STOP

運転
停止

運転 停止

Text ID: 1 運転
Group 1: English Group 2: Chinese

Text ID: 2 停止

Group 3: Japanese

RUN
STOP
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4 Double-click the dropped Bit Button and the properties dialog box is displayed.

5 Click the Registration Text tab, and then select the Use Text Manager check box.

6 Specify 1 for the Text ID under OFF.

7 Configure the settings on each tab as necessary, and then click OK.

The Properties of Bit Button dialog box closes.

8 Repeat steps 2 through 7 and create a Bit Button to use text ID 2 for the registration text.

This concludes configuring the settings to switch the displayed language by a value of device address.
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This section describes items and buttons in Text Manager.

3.1 Text Manager

The text that is loaded and displayed when objects and Popup Screens are displayed is collectively managed with Text 
Manager.

■  (Copy)

Select (Text) and click  to copy the text and its attributes to the clipboard.

■  (Paste)

Select (Text) and click  to paste the clipboard contents to that cell.

■  (Delete unused texts)
Deletes the text with Text ID numbers that are registered in the Text Manager but are not used in the project.

3 Text Manager

(Text Messages 
List)

(Text ID)

(Font)

(Text Color)

(Windows Font)

(Text)

(Text Group Name)

• To select multiple items of (Text), press and hold SHIFT or CTRL key while you click the specific items.
• Click (Text ID) to select the entire row.

• To select multiple items of (Text), press and hold SHIFT or CTRL key while you click the specific items.
• Click (Text ID) to select the entire row.
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■  (Find)
Displays the Find dialog box.
The text entered in Find what is searched for in (Text) in the (Text Messages List).

■  (Replace)
Displays the Replace dialog box.
The text entered in Find what is searched for in (Text) in the (Text Messages List) and that text is replaced with the 
text entered in Replace with.

■  (Destination)
Specifies the text ID to move the focus (1 to 32,000).

■ Go to
Moves the focus to the text ID specified in (Destination).

■  (Import)
Imports text in a text list saved as a CSV file or as a text file.
Click this button to display the Open dialog box. For details, refer to “Importing Text from a Text List” on page 19-7.

■  (Export)
Saves the text for the text group being edited as a CSV file or as a text file. This file is called a text list. The types of 
files that can be saved are as follows.
• CSV file (comma delimited) (*.csv)
• CSV file (semicolon delimited) (*.csv)
• Unicode text file (tab delimited) (*.txt)

Click this button to display the Save As dialog box. For details, refer to “Saving Registered Text as a CSV File” on page 
19-6.

The saved text list can be imported with  (Import).

When Unicode text file (tab delimited) (*.txt) is selected, the file can handle multiple languages by 
using a commercially available text editor or spreadsheet software that supports Unicode.
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■ Number of Text Groups
Specifies the number of text groups (1 to 32).

■ Change Text Group by Device Address
Switches the text group according to the value of device address. Specify the word device to use as the condition to 
switch the text group.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.
These options can only be configured when Number of Text Groups is specified as two or more.

■ (Font)
Selects the font used for displaying text from the following.
European, Japanese, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows

■ (Text Color)
Selects the color of the text to register (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ (Windows Font)
Sets the font to be used as the Windows Font.
Select Windows using (Font) to display the current setting. You can specify the character spacing (0 to 100) and the 
line spacing (0 to 100). To change the settings other than the character spacing and line spacing, click Change to 
display the Font Settings dialog box.
For details, refer to Chapter 2 “Windows Font” on page 2-12.

■ (Text Messages List)
The attributes for the registered text are displayed in this list. 

When the value of device address is 0, the text group switches to the text group set as the default.
If the value of device address is invalid, the text group is not switched.

(Text Group Name) Double clicking this item displays the Text Group Settings dialog box. For details, refer to “Text 
Group Settings Dialog Box” on page 19-14.

(Text ID) Shows the ID number (1 to 32,000).

(Text) Enter the text to register here.

When registering text, double click the cell for the text group and text ID (1 to 32,000) to register, 
and then enter the text.
The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected font. For details, refer to
Chapter 2 “1.2 Available Text” on page 2-5.

A line feed will be added with pressing and holding ALT and ENTER keys. You can enter multi-line text by 
inserting a newline. The newline is displayed as \n and is counted as two characters.
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● Text Group Settings Dialog Box
This dialog box is used to configure the Text Group Name and the default.

■ Text Group Name
Enters the names of the text groups.
The maximum number for the Text Group Name is 20 characters.

■ Use this Text Group as Default
Select this check box to setup the group to use when the MICRO/I power is turned on and when switching to run 
mode.

The text group set as the default is displayed with  next to (Text Group Name).
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This chapter explains the script function, editing and management of the script, definition method, and definition 
sample.

  

1.1 Overview of the Script Function

● What is the script function?
Complex processes such as conditional branching, logical operation, arithmetic operation, functions, etc., can be 
programmed in a text format using Script Function.

As an example, the logical product (AND) calculation described as  in a ladder diagram is described as 

[LM 100] & [LM 101] in text format in the script.

■ Description and management of the script
The script is programmed by WindO/I-NV4 script editor, and managed by Script Manager.

■ Example of using the script
As an example, when reading the data from the external device and displaying on the MICRO/I, the load on the 
external device can be reduced for processes such as conditional branching or function calculation, which apply a 
heavy load on the external device, by processing it with a script on the MICRO/I.

Chapter 20 Script

1 About the Script Function

LM100 LM101

• By using the Script Editor, conditional expressions, operators, and functions can be described by selecting 
them from a list, and an error in the script can also be determined. The script can also be exported as a 
text file, so the script can be edited by a text editor such as Notepad, and the edited script can be 
imported back into the Script Editor by saving it as a text file. For details, refer to “2.3 Script Editor” on 
page 20-8.

• Script Manager can manage the script collectively by adding, deleting, organizing, etc., the script created 
by the Script Editor. For details, refer to “2.2 Script Manager” on page 20-7.

// Change the additional value 
// depending on the value of D10  
if ([D 10] <= 9) 
{ [D 10] = [D 10] + 10; } 
else 
{ [D 10] = [D 10] + 20; } 
// Change the additional value 
// depending on the value of D11 
if ([D 11] <= 19) 
{ [D 11] = [D 11] + 20; } 
else 
{ [D 11] = [D 11] + 40; } 
// Change the additional value 
// depending on the value of D12 
if ([D 12] <= 29) 
{ [D 12] = [D 12] + 30; } 
else 
{ [D 12] = [D 12] + 60; } 
// Change the additional value 
// depending on the value of D13 
if ([D 13] <= 39) 
{ [D 13] = [D 13] + 40; } 
else 
{ [D 13] = [D 13] + 80; }

MICRO/I
External device

Get the result by processing with script 

D10 0 → 10
D11 10 → 30
D12 30 → 90
D13 50 → 130

D10 0
D11 10
D12 30
D13 50

Read the data not processed

Write the result

Process with script to decrease 
the load of external device.

D10 10
D11 30
D12 90
D13 130
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1.2 Types and Trigger Conditions of the Script

● Types of scripts
There are 3 types of scripts used.

■ Script Command
This is a script that executes in accordance with trigger conditions in the same way as other parts, such as switches or 
lamps, for each screen.
• It is executed only in the screens where it is placed.
• Multiple scripts can be set for each screen.
For details, refer to Chapter 12 “5 Script Command” on page 12-31.

■ Global Script
This is a script that operates within the whole project. This script is executed at the end of MICRO/I scan process in 
accordance with the trigger condition. The amount of Global Scripts which can be used in a project is maximum of 16 
scripts. For details about setup, refer to “3 Global Script” on page 20-12.

● Trigger condition of the script
Trigger conditions that can be set for the script are as follows:

■ Rising-edge
Script is executed when trigger device address changes from 0 to 1.

■ Falling-edge
Script is executed when trigger device address changes from 1 to 0.

■ Satisfy the condition
Script is executed when the set condition is met.
This can only be set for the Script Command.

■ While satisfying the condition
Script is executed while the set condition is met.
This can only be set for the Script Command.

■ Fixed Period
Script is executed at set intervals.

■ Always Enabled
Script is executed on every scan of the MICRO/I.
This can only be set for the Global Script.

Script

Trigger Condition

Rising-edge Falling-edge
Satisfy the 
condition

While 
satisfying the 

condition
Fixed Period Always ON

Script Command YES YES YES YES YES NO

Global Script YES YES NO NO YES YES
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1.3 Data Type of the Script

It is required to set the data type appropriate for the range of data to be used, such as the maximum and minimum 
values of the data used in the script, negative numbers or real numbers required, etc., considering what is to be 
processed with the script.

● Data Types
There are 7 types of data that can be processed by the script function.
For details about the data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Data type is set by the Script Editor.
For the setting method, refer to “2.3 Script Editor” on page 20-8.

Types of the data type Required word count Range that can be processed

UBIN16(W) 1 0 to 65,535

BIN16(I) 1 -32,768 to 32,767

UBIN32(D) 2 0 to 4,294,967,295

BIN32(L) 2 -2,147,483,648 to 2,147,483,647

BCD4(B) 1 -999 to 9,999

BCD8(EB) 2 -9,999,999 to 99,999,999

Float32(F) 2

-3.4×1038 to -1.18×10-38

0

1.18×10-38 to 3.4×1038

There are functions that cannot be used when the data types are different. Please refer to the format list.
 For details, refer to “4 Script Definition Method” on page 20-17.
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1.4 Script Error

This section describes the types, cause, and information of script errors.

● Error information
Script error information is stored in the following locations. An error message is displayed on the screen when a script 
error has occurred.

● Types and causes of script errors
Script will stop running when an error occurs.

Category Storage location Stored value

Existence of a script error
Bit 10 of the System Area address 
number +2

0 No error

1 Error

Script ID of the script with an error HMI Special Data Register LSD52
1 to 

32,000
Script ID

Types of script errors HMI Special Data Register LSD53

1 Processing error

2 Execution time over error

3 Writing count error

4 Indirect device error

5 Parameter error

6, 7 Reserved

If there is a script error, bit 10 (11th bit) of the beginning device address +2 (third word from the beginning) 
of the System Area will be 1.

Beginning device address of the System Area is set in the System tab of the Project Settings dialog box.
For details about the System Area, refer to Chapter 4 “System Area” on page 4-17.

Beginning 
device address +1 +2 +3 +4 +5 +6 +7

System Area 1 System Area 2 System Area 3 System Area 4

+8 +9

0123456789101112131415

1st word 2nd word

11th bit

3rd word 4th word 5th word 6th word 8th word7th word 10th word9th word

Types of script error Cause

Processing error

Dividend was divided by 0 for division and residue calculation.

Data types are BCD4(B), BCD8(EB), Float32(F) and value out of range is 
specified.

Execution time over error The execution time for one script exceeded 3,000 milliseconds.

Writing count error Data count written to the external device address in one script has exceeded 64.

Indirect device error

During the indirect read of external device address, the value of external device 
address was read.

Indirect read or indirect write of external device address is performed with the 
Global Script.

Parameter error
Value out of range was specified as argument for LINE function, RECTANGLE 
function, or CIRCLE function.



WindO/I-NV4 User’s Manual 20-5

2 Editing and Management of the Script

20

Script

  

2.1 Script Registration Procedure

This section describes the procedure to create a script and register it in the project.
The registered script can be used in a Multi-Button, Script Command, Multi-Command, and Global Script.

1 On the View tab, in the Workspace group, click  (Script Manager).

Script Manager opens.

2 Click Add.

Script Editor opens.

3 Specify Script ID.

When creating a new script, enter the script ID (1 to 32000).

4 Enter Script Name.

2 Editing and Management of the Script
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Maximum number for the script name is 40 characters.

5 Select Data Type.

6 Code a program in Script.

7 When the script is finished, click OK.

The created script is shown in Script List.

8 Click Close.

The scripts are saved in the project data and Script Manager closes.

Be sure to match the Data Type of the script with the types of data being used within the script.
For example, if a fractional value is contained in a script, select Float32(F) for the Data Type of the script. 
If there are only integer values from 0 to 65,535, select UBIN16(W).

To create a script using the samples provided by WindO/I-NV4, under Function List, select Category and 
Function, and then click Insert Format. The sample shown in Format is inserted at the cursor position in 
Script.

When you are in the following dialog boxes, clicking  will open the Script Manager. When you close the 
Script Manager, you will be taken back to the original dialog box.
• Global Script General tab
• Script Command properties General tab
• Multi-function script properties for Multi-Buttons and Multi-Commands
• Project Settings Expansion Module tab
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2.2 Script Manager

Script Manager can add, delete and manage the script created by Script Editor.

■ Script List
Displays a list of registered scripts.

■ Script
Displays the contents of the script selected in the script list.

■ Add
Displays the Script Editor dialog box to add a script.
For details, refer to “2.3 Script Editor” on page 20-8.

■ Edit
Displays the Script Editor dialog box to allow editing of the selected script. For details, refer to “2.3 Script Editor” on 
page 20-8.

■ Delete
Deletes the script selected in the script list.
If a script is used in a project or parts, it cannot be deleted.

■ Reduce
Deletes the scripts that are registered in the script list but are not used in the project.

■ Select
The highlighted script in the script list is selected and the Script Manager is closed.

Script ID: Displays the script ID (1-32000) of the registered scripts.

Error: OK is displayed when there is no error in the registered script and NG is displayed when there is an error.

Script Name: Displays the script name of the registered scripts.

Used: Displays how many times the registered script has used.
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2.3 Script Editor

A new script can be created or the script selected in the Script Manager can be edited using Script Editor.

■ Script ID
To create a new script, enter the script ID (1-32000).
To edit an existing script, the set script ID is displayed.

■ Script Name
Enter the script name. Maximum number for script name is 40 characters.

■ Data Type
Select the data type to be processed by the script.
For details about the data type, refer to “1.3 Data Type of the Script” on page 20-3.

■ Script
Enter the script.
Single script limitation is 240 characters per line with up to 1024 lines.

■ Error Check
The script being edited is checked for errors.

(Description)
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■ Import
The Open dialog box is displayed.
By selecting a script saved (exported) in a text format (*.txt) and clicking on the Open button, the imported script is 
inserted at the cursor position of the script being edited.

■ Export
The Save As dialog box is displayed.
By selecting a save location and clicking on the Save button, the script being edited is saved in text format (*.txt). A 
saved script can be inserted in the script using the Import button.

■ Options
The Options dialog box is displayed.
The fonts and color of the text, tab indents, etc., used in the Script text box are set in the Options dialog box. For 
details, refer to “Options dialog box” on page 20-11.

■ Find
The Find dialog box is displayed.
Enter the text to be searched for in the Find What box.

When the Find button is clicked after selecting a range in the Script text box, it will only search within the 
selected range.
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■ Replace
The Replace dialog box is displayed.
Text entered in Find what will be replaced with the text entered in Replace with.

■ Show/Hide Function List
Switches between showing and not showing the Function List and Script Compilation Output.

■ Cursor
Displays the current position of the cursor in the Script text box by line number and column number.

■ Function List

■ Script Compilation Output
The contents of any errors found when using error check are displayed.
By double-clicking on the comment displayed in the Script Compilation Output, the part corresponding to the error 
is highlighted in the Script text box.

• This is useful when replacing device addresses.
• When the Replace button is clicked after selecting a range in the Script text box, it will only search and 

replace within the selected range.

The size of the script edit box can be changed by dragging the right bottom corner of the Script Editor. By 
hiding the Function List and Script Compilation Output, the script editing area (text box) will become 
larger, making the editing of script easier.

Category: Lists the categories of the functions.

Function: Lists the functions of the selected category.

Format: Displays the definition example of the selected function.

(description): Displays the description of the selected function.

Insert Format: Contents displayed in the selected Format are inserted at the cursor position.

Insert Device Address: The Tag Editor is displayed.
By specifying the device address and clicking on the OK button, specified device address is 
inserted at the cursor position.

Depending on the error, there may be an error in the line that is different from the line displayed in the 
Script Compilation Output, or multiple errors may be displayed.
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● Options dialog box
Font, Size, and Color used in the Script text box of the Script Editor can be specified.

■ Font
The font name for the text displayed in the Script is entered or selected.

■ Size
The font size (dots) for the text displayed in the Script is entered or selected.

■ Sample
Displays a sample of the text with the Font and Size as specified in the Script text box.

■ Color
Displays each of the text colors for Comment, Keyword, and Device Address.
To change the text color, click  on the right of the color to display the Color Palette and select the color.

Text other than comment, keyword, or device address is displayed in black.
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A Global Script operates for the entire project. The scripts are executed in order on the list and in accordance with the trigger 
conditions after the parts on the MICRO/I screen are processed. A maximum of 16 Global Scripts can be set to a project.

3.1 Setting procedures for Global Script

Global Script is setup using the following procedures.

1 On the Configuration tab, in the System Setup group, click Global Script.
The Global Script Settings dialog box is displayed.

2 Under Settings, select the script ID to configure, and then click Edit.
The Global Script dialog box is displayed.

3 On the General tab, select the Use Global Script check box.

3 Global Script

With Global Script, you cannot do indirect read and indirect write of the external device address.
For details about the indirect read and indirect write, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.
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4 Specify the script ID (1 to 32,000) of the script to execute.

The Script Manager is displayed when the  button is clicked. The script can be selected from the script list of the 
Script Manager. For details, refer to “2.2 Script Manager” on page 20-7.

5 Click Trigger Condition tab.

6 With Trigger Type, select the condition to execute the script.

■ Rising-edge
Script is executed when trigger device address changes from 0 to 1. Specify a bit device or a bit number of a word 
device for Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Falling-edge
Script is executed when trigger device address changes from 1 to 0. Specify a bit device or a bit number of a word 
device for Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

■ Always Enabled
The script is executed on every scan of the MICRO/I.

■ Fixed Period
Script is executed at set intervals. Specify Period in seconds.

7 Click OK to close the Global Script dialog box.

8 Click Close on the Global Script Settings dialog box.
This concludes the Global Script configuration.
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3.2 Global Script Settings Dialog Box

This section describes items and buttons on the Global Script Settings dialog box.
Global Script is managed as a group in the Global Script Settings dialog box.

■ Settings
This area is for editing the Global Script settings.

■ Edit
Registers or changes the Global Script settings for the selected line.
Click this button to display the Global Script dialog box. 
The Global Script dialog box settings are reflected on the selected line.
For details, refer to “3.3 Global Script Dialog Box” on page 20-15.

■ Up
Shifts the selected Global Script settings up the list.

■ Down
Shifts the selected Global Script settings down the list.

■ Delete
Deletes the registered settings from the list.

Order: Displays the number (1 to 16) for the order to execute the Global Script.

Script: Displays whether or not to use the Global Script. Double clicking the cell switches between 
Enable and Disable.

Script ID: Specify the script ID (1 to 32,000) of the script to execute.

Script Name: Displays the name of the script specified by the script ID.

Trigger Type: Specify the condition to execute the script.

Trigger Condition: Displays details about the condition to execute the script. The displayed content varies based on 
Trigger Type.

Rising-edge, Falling-edge: Displays the bit device or the bit number of the word device to serve 
as condition.

Always Enabled: Nothing is displayed.

Fixed Period: Displays the specified period.



WindO/I-NV4 User’s Manual 20-15

3 Global Script

20

Script

3.3 Global Script Dialog Box

This section describes items and buttons on the Global Script dialog box.

● General Tab

■ Use Global Script n
To use the Global Script, select the Use Global Script n (n : Order number) check box.

■ Script ID
Specify the script ID (1 to 32,000) of the script to execute.

The Script Manager is displayed when the  button is clicked. The script can be selected from the script list of the 
Script Manager. For details, refer to “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script specified by the script ID.

■ Script
Displays the contents of the script specified by the script ID.

With Global Script, you cannot do indirect read and indirect write of the external device address.
For details about the indirect read and indirect write, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.
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● Trigger Condition Tab

■ Trigger Type
Specify the condition to execute the script.

■ Device Address
Specify the bit device or bit number of the word device.
This is enabled only when Rising-edge or Falling-edge is selected in Trigger Type.

■ Period (sec)
Specify the scan frequency in seconds (1 to 3,600).
This is enabled only when Fixed Period is selected in Trigger Type.

Rising-edge: Script is executed when trigger device address changes from 0 to 1.

Falling-edge: Script is executed when trigger device address changes from 1 to 0.

Always Enabled:The script is executed on every scan of the MICRO/I.

Fixed Period: Script is executed at set intervals.
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4.1 Format List

This section describes the format and operation of control statements, operators, functions, etc.
Enter everything except comments in single-byte. For specific definition examples, refer to “5 Script Coding Examples” 
on page 20-26.

● Control statements
Conditional expressions are described as , ,  here. Execution lines are described as 

, ,  ...

■ Conditional branching

■ Repeat

4 Script Definition Method

Cond. expr. Cond. expr. 1 Cond. expr. 2

Exe. line Exe. line 1 Exe. line 2

Format Description

if
   else
   else if

if ( )
{ ; }

Execution line is executed if the conditional expression is satisfied.

if ( )
{ ; }
else
{ ; }

Execution line 1 is executed if the conditional expression is satisfied.
Execution line 2 is executed if it is not satisfied.

if ( )
{ ; }
else if ( )
{ ; }
else
{ ; }

Execution line 1 is executed if the conditional expression 1 is satisfied.
Conditional expression 2 is determined if conditional expression 1 is not 
satisfied, and execution line 2 is executed if conditional expression 2 is 
satisfied.
Execution line 3 is executed if conditional expression 2 is not satisfied too.

switch
   case
   default

switch ( )
{
  case constant 1:
    ;
    break;
  case constant2:
    ;
    break;
  default:
    :
    break;
}

Execution line 1 is executed if the value of conditional expression matches 
constant 1.
Execution line 2 is executed if the value of conditional expression matches 
constant 2.
Execution line 3 is executed if the value of conditional expression does not 
match constant 1 nor constant 2.

Cond. expr.
Exe. line

Cond. expr.
Exe. line 1

Exe. line 2

Cond. expr. 1
Exe. line 1

Cond. expr. 2
Exe. line 2

Exe. line 3

Cond. expr.

Exe. line 1

Exe. line 2

Exe. line 3

Format Description

while

while ( )
{
  ;
}

Execution line is repeatedly executed while the conditional expression is 
satisfied.

• It will go into an infinite loop when the conditional expression is always satisfied, 
so do not set fixed values or device addresses that do not change as the 
conditional expression.

• Do not write a value to the external device address in the while definition.

Cond. expr.

Exe. line
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■ Halt and exit

● Operator
Device address, constant, and temporary device are described as ,  here, and expression is described as 

, , .

■ Relational operator

■ Logical operator

■ Arithmetic operator

Format Description

break

while ( )
{
  if ( )
  {
    ;
    break;
  }
 ;
}

;

Process will be as follows while the conditional expression 1 is satisfied.
• Execution line 2 is continuously executed while the conditional expression 2 is not 

satisfied.
• Once the conditional expression is satisfied, it will go out of the loop by break (not 

executing execution line 2), and execution line 3 is executed.

switch ( )
{
  case constant 1:
    ;
    break;
  case constant 2:
    ;
    break;
}

;

When the conditional expression 2 matches the constant 1, it will halt the 
determination of constant 2 by break after executing execution line 1, and 
process will move to execution line 3.

return return; It will exit the script, and execute the next parts or script.

Cond. expr. 1

Cond. expr. 2

Exe. line 1

Exe. line 2

Exe. line 3

Cond. expr.

Exe. line 1

Exe. line 2

Exe. line 3

a b
Expr. Expr. 1 Expr. 2

Operator Format Description

==  == Compares if  is equal to .

!=  != Compares if  is not equal to .

<  < Compares if  is less than .

<=  <= Compares if  is equal or less than .

>  > Compares if  is greater than .

>=  >= Compares if  is equal or greater than .

a b a b

a b a b

a b a b

a b a b

a b a b

a b a b

Operator Format Description

&& ( ) && ( ) Calculates the logical product (AND) of  and .

|| ( ) || ( ) Calculates the logical sum (OR) of  and .

! !( ) Reverses the logic of .

Expr. 1 Expr. 2 Expr. 1 Expr. 2

Expr. 1 Expr. 2 Expr. 1 Expr. 2

Expr. Expr.

Operator Format Description

+  + Adds  and .

-  - Subtracts  from .

*  * Multiplies  and .

/  / Divides  by .

%  % Calculates remainder after dividing  by .

a b a b

a b b a

a b a b

a b a b

a b a b
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■ Bit operator

● Function
Device address, constant, and temporary device are described as , , , ... here.

■ Bit function

■ Word function

Arithmetic operation

(Continued to next page)

Operator Format Description

&  & Calculates the logical product (AND) of each bit of  and .

|  | Calculates the logical sum (OR) of each bit of  and .

^  ^ Calculates the exclusive logical sum (XOR) of each bit of  and .

~ ~
Reverses the logic of each bits of .
For word device and fixed values, 0 will be 65535, and 65535 will be 0.
For bit device, 0 will be 1, and 1 will be 0.

<<  << Shifts each bit of  to left for  bit(s).

>>  >> Shifts each bit of  to right for  bit(s).

a b a b

a b a b

a b a b
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a b a b

a b c d

Function Format Description

Bit set SET( );
Turns bit device  to 1.

It will be same result as  = 1;.

Bit reset RST( );
Turns bit device  to 0.

It will be same result as  = 0;.

Bit reverse REV( );
Reverses the 1 and 0 of bit device .

It will be same result as  = ~ ;.
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Function Format Description

Maximum 
value MAX( , , )

Maximum value out of , ,  is returned.

• This can be used for all data types.
• Up to 15 arguments can be defined.

Minimum 
value MIN( , , )

Minimum value out of , ,  is returned.

• This can be used for all data types.
• Up to 15 arguments can be defined.

Exponential 
function EXP( )

Exponential function of  is returned.

• This can only be used for data type Float32(F).

Natural 
logarithm
(Base: e)

LOGE( )
Natural logarithm (base is e) for  is returned.

• This can only be used for data type Float32(F).
• Set a value larger than 0 for argument.

Common 
logarithm
(Base: 10)

LOG10( )
Common logarithm (base is 10) for  is returned.

• This can only be used for data type Float32(F).
• Set a value larger than 0 for argument.

Exponentiation POW( , )
 to the  power is returned.

• This can only be used for data type Float32(F).
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Arithmetic operation (Continued)

Data type conversion

Function Format Description

Square root ROOT( )
Square root of  is returned.

• This can only be used for data type Float32(F).

Sine SIN( )

Sine of  (-1 - +1) is returned. Specify arbitrary formula to represent 

angle (units in radian) for argument .

• This can only be used for data type Float32(F).

Cosine COS( )

Cosine of  (-1 - +1) is returned. Specify arbitrary formula to 

represent angle (units in radian) for argument .

• This can only be used for data type Float32(F).

Tangent TAN( )

Tangent of  (-1 - +1) is returned. Specify arbitrary formula to 

represent angle (units in radian) for argument .

• This can only be used for data type Float32(F).

Arcsine ASIN( )

Arcsine of  (-1 - +1) in radian value (-π/2 - +π/2) is returned. 

Specify arbitrary formula for argument .

• This can only be used for data type Float32(F).

Arccosine ACOS( )

Arccosine of  (-1 - +1) in radian value (0 - π) is returned. 

Specify arbitrary formula for argument .

• This can only be used for data type Float32(F).

Arctangent ATAN( );

Arctangent of  (-1 - +1) in radian value (-π/2 - +π/2) is returned. 

Specify arbitrary formula for argument .

• This can only be used for data type Float32(F).

Conversion 
from Angle to 

Radian
RAD( );

Value of  is converted from degree (°) to radian, and the value is 
returned.

• This can only be used for data type Float32(F).

Conversion 
from Radian 

to Angle
DEG( );

Value of  is converted from radian to degree (°), and the value is 
returned.

• This can only be used for data type Float32(F).

Function Format Description

Conversion 
from BCD to 

Binary
BCD2BIN( )

BCD value of  is returned in binary value.

• This can be used with data types UBIN16(W), BIN16(I), UBIN32(D), and 
BIN32(L).

Conversion 
from Binary to 

BCD
BIN2BCD( )

Binary value of  is returned in BCD value.

• This can be used with data types UBIN16(W), BIN16(I), UBIN32(D), and 
BIN32(L).

Conversion 
from Floating 
point to Binary

FLOAT2BIN( )
Float32 value of  is returned in floating point value.
Values under the decimal point is truncated.

• This can be used with data types UBIN32(D) and BIN32(L).

Conversion 
from Binary to 
Floating point

BIN2FLOAT( )
Binary value of  is returned in floating point value.

• This can be used with data types UBIN32(D) and BIN32(L).

Conversion 
from Decimal 

to String 
character

DEC2ASCII( , )

Decimal number value  is converted to a character string, and store 

in order with  as a beginning device address.

• This can be used with data types UBIN16(W), BIN16(I), UBIN32(D), 
BIN32(L), BCD4(B), or BCD8(EB).

Conversion 
from String 
character to 

Decimal

ASCII2DEC( )

Character string  is returned as decimal number value.

• This can be used with data types UBIN16(W), BIN16(I), UBIN32(D), 
BIN32(L), BCD4(B), or BCD8(EB).
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Data comparison and copy

Character string operation
Only internal devices can be specified as an argument for character string operation function.
Termination character NULL (0x00) is treated as end of character string when character string is handled. Also, 
termination character NULL is not included in the length of the character string.

Function Format Description

Data 
comparison MEMCMP( , , )

: Beginning device address of comparison target 1

: Beginning device address of comparison target 2

: Range of comparison (in words)

Values of device address  for  words and values of device 

address  for  words are compared.
1 is returned if all the values of device addresses match, and 0 is 
returned if any of the value does not match.

• Specified range is compared in word unit, and result is returned.
• Up to 64 words can be compared.

Data copy MEMCPY( , , )

: Beginning device address of copy source

: Beginning device address of copy target

: Range of copy (in words)

Values of device address from  for  words are copied to 

 for  words respectively.

• Specified range is copied in word unit.
• Up to 64 words can be copied.

Function Format Description

Character 
string copy

STRCUT( , , , )

: Beginning device address of copy target

: Beginning device address containing copy source 
character string

: Start location of copy (0-127)

: Number of characters to copy (1-128)

From the character string starting from , character string 

from  bytes forward for  characters are stored into 

 for  characters.

Character 
number count STRLEN( ) Number of characters for character string starting from  is 

returned.

Character 
string 
concatenation

STRCAT( , )
To the character string starting from , the character string 

starting from  is concatenated, and  is returned to 
beginning.

Character 
string search STRSTR( , )

From the character string starting from , character string 

starting from  is searched, and location found (number of 
characters from beginning -1) is returned.
• Maximum number for character string to search is 128 

characters.
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Draw
• This is a function to draw an object on the screen. Top left corner of the screen is coordinates X=0 and Y=0.
• When a device address is used as an argument, an object is drawn with the changed value when the value is 

changed. However, the object that is already drawn is not erased. To erase the drawn object, overwrite it with the 
background color.

• When an out-of-range value is used as an argument, 5 is stored in the LSD53 and script is halted.
• Objects that are drawn with scripts for parts placed on the top layer are not drawn on the top layer.

Example: The Multi-Button is placed on the top layer of a base screen and the script CIRCLE is executed to draw a 
circle or ellipse by pressing the Multi-Button
The settings of the script CIRCLE: center coordinate X is 80, center coordinate Y is 120, X-axis radius is 
60, Y-axis radius is 60, line width is 1, line type is 1, foreground color is 20, background color is 0, and the 
pattern is 2

(Continued to next page)

Function Format Description

Drawing of 
straight 
line

LINE( , , , ,
     , , )

Straight line connecting the start coordinate and end coordinate is drawn.
: Start coordinate X, : Start coordinate Y, : End 

coordinate X, : End coordinate Y, : Line width, : 
Line type, : Line color
• : Line width, : Line type, : Line color can be 

omitted.
• Specification of : Line width is as follows:

It will be set to 1 (1 dot) when omitted.
• Specification of : Line type is as follows.

It will be set to 1 (Solid) when omitted or when the line width is 
set to anything other than 1 (1 dot).

• : Line color is specified by the color data. It will be set to 
255 (white) when omitted. 
For color data, refer to Appendix “1 Color Number” on page A-1.

LINE( , , , )

Display for Base Screen: 1

Draws a circle on the base screen

// Script A
CIRCLE(80, 120, 60, 60, 1, 1, 20, 0, 2);

Execute script

Top Layer

Multi-Button

Base Screen: 1

Top Layer

Circle

Base Screen: 1

Draws a circle

Object List

No. Type Layer

1 Multi-Button Top Layer

No. Type Layer

1 Circle

2 Multi-Button Top Layer

a b c d
e f g

a b c
d e f

g
e f g

e
Set value 1 2 3 5
Line width 1 dot 2 dots 3 dots 5 dots

f
Set value 1 2 3 4 5 6

Line type Solid Dot Dash Long Dash Long Dash 
Dot

Long Dash 
Dot Dot

g

a b c d
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Draw (Continued)

(Continued to next page)

Function Format Description

Drawing of 
Rectangle

RECTANGLE( , , ,
          , , ,
          , , ,
          , )

Rectangle with left top corner as start coordinate and bottom right 
corner as end coordinate is drawn.

: Start coordinate X, : Start coordinate Y, : End 
coordinate X, : End coordinate Y, : Line width, : Line 
type, : Foreground color, : Background color, : 
Pattern, : Rounded corner type, : Rounded corner radius
• : Line width, : Line type, : Foreground color, 

: Background color, : Pattern, : Rounded 
corner type, : Rounded corner radius can be omitted.

• Specification of : Line width is as follows:

It will be set to 1 (1 dot) when omitted.
• Specification of : Line type is as follows.

It will be set to 1 (Solid) when omitted or when the line width is 
set to anything other than 1 (1 dot).

• : Foreground color, : Background color is specified 
by the color data. It will be set to 255 (white) when omitted. 
For color data, refer to Appendix “1 Color Number” on page A-1.

• Specification of : Pattern is as follows.

It will be set to 0 (None) when omitted.
• Specification of : Rounded corner type is as follows.

It will be set to 0 (None) when omitted.
• : Rounded corner radius is specified with number of dots (0 - 200). 

It will be set to 0 (0 dot) when omitted.

RECTANGLE( , , ,
          )

a b c
d e f
g h i
j k
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j k

e f g
h i j

k
e

Set value 1 2 3 5
Line width 1 dot 2 dots 3 dots 5 dots

f
Set value 1 2 3 4 5 6

Line type Solid Dot Dash Long Dash
Long Dash 

Dot
Long Dash 
Dot Dot

g h

i
Set value 0 2 3 4 7 8

Line type None
Foreground 
100%

Foreground 
25%

Foreground 
50%

Background 
100%

Horizontal 
lines

Set value 9 10 11 12 13

Line type
Vertical
lines

Slant 
Upwards

Slant 
Down-wards

Cross-hatch Tint

j
Set value 0 1 2
Line type None Straight Curve

k

a b c
d
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Draw (Continued)

Offset

Function Format Description

Drawing 
of circle 
and ellipse

CIRCLE( , , , ,
       , , , ,
       )

A circle with specified radius from center coordinate is drawn.
: Center coordinate X, : Center coordinate Y,
: X axis radius, : Y axis radius, : Line width, 
: Line type, : Foreground color, 
: Background color, : Pattern

• : Line width, : Line type, : Foreground color, 
: Background color, : Pattern can be omitted.

• Specification of : Line width is as follows:

It will be set to 1 (1 dot) when omitted.
• Specification of : Line type is as follows.

It will be set to 1 (Solid) when omitted or when the line width is 
set to anything other than 1 (1 dot).

• : Foreground color, : Background color is specified 
by the color data. It will be set to 255 (white) when omitted.
For color data, refer to Appendix “1 Color Number” on page A-1.

• Specification of : Pattern is as follows.

It will be set to 0 (none) when omitted.

CIRCLE( , , , )

Function Format Description

Indirect 
specification OFFSET( , )

: Reference device address
: Device address to store the indirect value (0 to 32767)

Specify the device address  words from .
Indirect read
Specify OFFSET function to the right of the assignment statement.

Format example:  = OFFSET( , )
Operation: Stores the value of device address in  

words from  into .
Indirect write
Specify OFFSET function to the left of the assignment statement.

Format example:OFFSET( , ) = 
Operation: Stores the value of  into the device 

address  words from .
• Store the value appropriate for the data type as the indirect 

value. As an example, when the data type is BCD4(B), store the 
indirect value of BCD4(B) into the device address.

a b c d
e f g h
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e
Set value 1 2 3 5
Line width 1 dot 2 dots 3 dots 5 dots

f
Set value 1 2 3 4 5 6

Line type Solid Dot Dash Long Dash
Long Dash 

Dot
Long Dash 
Dot Dot

g h

i
Set value 0 2 3 4 7 8

Line type None
Foreground 
100%

Foreground 
25%

Foreground 
50%

Background 
100%

Horizontal 
lines

Set value 9 10 11 12 13

Line type
Vertical 
lines

Slant 
Upwards

Slant 
Down-wards

Cross-hatch Tint
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● Other
This section provides definitions for constant, device address, temporary device, and comment.

■ Constant
Constant can be defined as decimal or hexadecimal numbers.

Sample definition of decimal numbers

There are 2 ways to define hexadecimal numbers.

Sample definition of hexadecimal numbers

■ Device Address
Device Address is defined with the device type and address within “[” and “]”.

Definition of the device address

Sample definition

■ Temporary Device
Temporary device is a device address that can be used only with the script. It can store a value and can be used as a 
variable.
It is defined with a device type “@” followed by address number (1 - 16).

Definition of the temporary device

Sample definition

■ Comment
A note defined in the script is called a comment. The line with “//” defined at the beginning of a line will become a comment.
“//” is defined with a single-byte. Double-byte characters can be used after “//”.

Definition of comment

Sample definition

1234 Define the numeric value directly.

-1234 Define the negative number with a “-” (minus) symbol at the 
beginning.

12.34 Decimal number can be defined for real numbers (Float32(F)).
Define a “.” (period) between the whole numbers and decimal numbers.

0x12AB Define “0” (zero) and “x” (lower case x) at the beginning of the value.

12ABh Append “h” at the tail of the value.

[Device type address number] (“ ” represents a space.)

[LDR 100]

@Address number (Space between the device type “@” and address number is not required.)

@2 Temporary device number 2

All the values for temporary devices are set to “0” when the execution of the script is started.

// Arbitrary note

// Store the initial value to calculation 
data [LDR 100] for process A
[LDR 100] = 1234;
:
:

←This line is not executed.

• It will be useful to use comments to explain the contents of the script (especially when the editor of the 
script has changed or some time has passed since editing).

• Comments are ignored (not executed) when the script is executed, so they can be defined freely without 
worrying about the execution time.
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This section provides script coding examples for control statements, arithmetic operators, and functions, as well as 
the descriptions of their operations.

5.1 Control Statements

Script

Operation description
If the value of LDR100 is not 0, then 100 is stored in LDR200.

Script

Operation description
If the value of LM100 is not 0, then LDR300, LDR400, and LDR500 are added and that value is stored in LDR200.

Script

Operation description
If the value of LDR100 is not 0 and the value of LDR200 is also not 0, then 0x1234 is stored in LDR300.
If the value of LDR100 is not 0 and the value of LDR200 is 0, then nothing is executed.
If the value of LDR100 is 0, then nothing is executed regardless of the value of LDR200.

5 Script Coding Examples

■ Example 5.1.1 Conditional branch

if ([LDR 100])
{

[LDR 200] = 100;
}

■ Example 5.1.2 Conditional branching

if ([LM 100])
{

[LDR 200] = [LDR 300] + [LDR 400] + [LDR 500];
}

■ Example 5.1.3 Conditional branching

if (0 != [LDR 100])
{

if (0 != [LDR 200])
{

[LDR 300] = 0x1234;
}

}
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Script

Operation description
If either the value of LDR100 or the value of LDR200 is not 0, then 100 is stored in LDR300.
If the value of both LDR100 and LDR200 is 0, 100 is added to LDR500 and that value is stored in LDR400.

Script

Operation description
If the value of LDR100 is 0, then 0x1234 is stored in LDR200.
If the value of LDR100 is 1, then 0x5678 is stored in LDR200.
If the value of LDR100 is not 0 or 1, then 0x9999 is stored in LDR200.

Script

Operation description
If the values of LDR100, LDR200, and LDR300 are all not 0, then 100 is stored in LDR400.
If the values of LDR100 and LDR200 are not 0 and the value of LDR300 is 0, then 200 is stored in LDR400.
If either the value of LDR100 or LDR200 is 0, then nothing is executed regardless of the value of LDR300.

■ Example 5.1.4 Conditional branching

if ((0 != [LDR 100]) || (0 != [LDR 200]))
{

[LDR 300] = 100;
}
else
{

[LDR 400] = [LDR 500] + 100;
}

■ Example 5.1.5 Conditional branching

if ([LDR 100] == 0)
{

[LDR 200] = 0x1234;
}
else if ([LDR 100] == 1)
{

[LDR 200] = 0x5678;
}
else
{

[LDR 200] = 0x9999;
}

■ Example 5.1.6 Conditional branching

if ([LDR 100])
{

if ([LDR 200])
{

if ([LDR300])
{

[LDR 400] = 100;
}
else
{

[LDR 400] = 200;
}

}
}
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Script

Operation description
If the value of LDR100 is larger than 0, then 1 is repeatedly added to the value of LDR200 and 1 is repeatedly 
subtracted from the value of LDR100.
In the script example above, when the while statement repeats ten times, the value of LDR100 becomes 0 and the 
while statement ends.
After this script executes, the value of LDR100 is 0 and the value of LDR200 is 20.

Script

Operation description
While the value of LDR100 is 0, the while statement repeats.
Inside the while statement, if the values of LDR200 and LDR300 are equal, the while statement will terminate, and 
after [LM 0] changes to 1, execution breaks out of the while statement.
In the script example above, the values of LDR200 and LDR300 are equal when the while statement repeats twice, 
and after LM0 changes to 1, execution breaks out of the while statement loop. After execution, the value of LDR100 is 
0, the value of LDR200 is 5, the value of LDR300 is 5, and LM0 is 1.

■ Example 5.1.7 Iteration

[LDR 100] = 10;
[LDR 200] = 10;

while (0 < [LDR 100])
{

[LDR 200] = [LDR 200] + 1;
[LDR 100] = [LDR 100] - 1;

}

■ Example 5.1.8 Iteration

[LDR 100] = 0;
[LDR 200] = 3;
[LDR 300] = 5;

while ([LDR 100] == 0)
{

[LDR 200] = [LDR 200] + 1;

if ([LDR 300] = [LDR 200)
{

SET([LM 0]);
break;

}
}
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Script

This script stores the values of LDR10 through LDR19 in LDR100 through LDR109.
It operates as follows.
First, the indirect value LDR0 is initialized and set to 0.
First iteration (loop): The value of LDR0 is 0, so the condition “[LDR 0] < 10” is true and the statements inside while 
are executed.

• The value of LDR10, 0 words from LDR10, is stored in LDR100, 0 words from LDR100.
• 1 is added to the value of the indirect value LDR0 so that it becomes 1.

Second iteration (loop): The value of LDR0 is 1, so the condition “[LDR 0] < 10” is true and the statements inside 
while are executed.

• The value of LDR11, 1 word from LDR10, is stored in LDR101, 1 word from LDR100.
• 1 is added to the value of the indirect value LDR0 so that it becomes 2.

:
(Repeats in this manner for the third to ninth iterations)

:
Tenth iteration (loop): The value of LDR0 is 9, so the condition “[LDR 0] < 10” is true and the statements inside while 
are executed.

• The value of LDR19, 9 words from LDR10, is stored in LDR109, 9 words from LDR100.
• 1 is added to the value of the indirect value LDR0 so that it becomes 10.

The value of LDR0 is 10, so the condition “[LDR 0] < 10” is false and execution breaks out of the while loop.
After execution, the values of LDR100 through LDR109 are the values of LDR10 through LDR19.

■ Example 5.1.9 Indirect write and indirect read using iteration (while statement)

// Transfer LDR10 through LDR19 to LDR100 through LDR109

// Initialize the indirect value
[LDR 0] = 0;

// Loop ten times
while ([LDR 0] < 10)
{

// Transfer 1 word by indirect assignment
OFFSET([LDR 100], [LDR 0]) = OFFSET([LDR 10], [LDR 0]);
// Increment indirect value
[LDR 0] = [LDR 0] + 1

}
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Script

Operation description
This example converts a decimal value to octal using a while statement.
By repeating the process to divide the original decimal data by 8 and converting each digit to octal in a while 
statement, the conversion is implemented up to four digits.
The unconverted decimal value is stored in LDR100. After the script is executed, the converted octal value is stored in 
LDR200.

■ Example 5.1.10 Decimal to octal conversion using a while statement

// Convert a decimal value to octal
// - For example, convert 10 (Dec) to 12 (Oct), 16 (Dec) to 20 (Oct)
// - Convert a value to octal up to 4 digits max

@1 = 0; // while counter
@2 = [LDR 100]; // gets original data
@3 = 1; // decimal base
@4 = 0; // calculation results

// repeat four times
while (@1 < 4)
{

// Extract 1st octal digit from original data. Store working result in @10.
@10 = @2 % 8;
// Convert the extracted results to decimal and add to results
@4 = @4 + (@10 * @3);

// Increase the decimal base by one digit
@3 = @3 * 10;
// Reduce the original data by one digit
@2 = @2 / 8;
// If @2 is 0, terminate the while statement
if (0 == @2)
{

break;
}

// Increment while counter by 1
@1 = @1 + 1;

}

// Store the calculation result in LDR200
[LDR 200] = @4;
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Operation description
If the value of LDR100 is 10, then 0x1234 is stored in LDR200.
If the value of LDR100 is 999, then 0x5678 is stored in LDR200 and LM10 turns on.
If the value of LDR100 is not 10 or 999, then nothing is executed.

Script

Operation description
If the value of LDR100 is 0, then 0x1234 is stored in LDR200.
If the value of LDR100 is 1, then 0x5678 is stored in LDR200.
If the value of LDR100 is not 0 or 1, then 0x9999 is stored in LDR200.

Script

Operation description
If the value of LDR100 is not 0x1234, then 0 is stored in LDR300.
If the value of LDR100 is 0x1234, then 0x5678 is stored in LDR200 and the script terminates.
The return statement does not break out of a function like the break statement, it terminates the script and executes 
the next part or script.

■ Example 5.1.11 Conditional branching with switch

switch ([LDR 100])
{

case 10:
[LDR 200] = 0x1234;
break;

case 999:
[LDR 200] = 0x5678;
SET([LM 10]);
break;

}

■ Example 5.1.12 Conditional branching with switch using the default statement

switch ([LDR 100])
{

case 0:
[LDR 200] = 0x1234;
break;

case 1:
[LDR 200] = 0x5678;
break;

default:
[LDR 200] = 0x9999;
break;

}

■ Example 5.1.13 Terminate the script with the return statement

if (0x1234 == [LDR 100])
{

[LDR 200] = 0x5678;
return;

}
[LDR 300] = 0;
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Script

Operation description
While the value of LDR100 is 0, the while statement repeats until LDR200 and LDR300 are equal.
Inside the while statement, if the values of LDR200 and LDR300 are equal, the while statement will end and execution 
breaks out of the while statement.
In the script example above, the values of LDR200 and LDR300 are equal when the while statement repeats twice, 
and after LM0 changes to 1, the while statement ends. After execution, the value of LDR100 is 0, the value of LDR200 
is 5, the value of LDR300 is 5, and the value of LM0 is 1.

5.2 Relational Operators

Script

Operation description
If the value of LDR100 is equal to the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is not equal to the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is less than the value of LDR200, then 0x100 is stored in LDR300.

■ Example 5.1.14 Break out of a loop with the break statement

[LDR 100] = 0;
[LDR 200] = 3;
[LDR 300] = 5;

while ([LDR 100] == 0)
{

[LDR 200] = [LDR 200] + 1;

if ([LDR 200] == [LDR 300)
{

SET([LM 0]);
break;

}
}

■ Example 5.2.1 Equal to

if ([LDR 100] == [LDR 200])
{

[LDR 300] = 0x100;
}

■ Example 5.2.2 Not equal to

if ([LDR 100] != [LDR 200])
{

[LDR 300] = 0x100;
}

■ Example 5.2.3 Less than

if ([LDR 100] < [LDR 200])
{

[LDR 300] = 0xl00;
}
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Script

Operation description
If the value of LDR100 is less than or equal to the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is greater than the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is greater than or equal to the value of LDR200, then 0x100 is stored in LDR300.

■ Example 5.2.4 Less than or equal to

if ([LDR 100] <= [LDR 200])
{

[LDR 300] = 0xl00;
}

■ Example 5.2.5 Greater than

if ([LDR 100] > [LDR 200])
{

[LDR 300] = 0xl00;
}

■ Example 5.2.6 Greater than or equal to

if ([LDR 100] > [LDR 200])
{

[LDR 300] = 0xl00;
}
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5.3 Logical Operators

Script

Operation description
If the value of LDR100 is equal to the value of LDR200, and if the value of LDR300 is equal to the value of LDR400 
and LDR500 added together, then 100 is stored in LDR600.
If either ([LDR 100] == [LDR 200]) or ([LDR 300] == [LDR 400] + [LDR 500]) is false, the processing in the brackets 
“{ }” is not executed.

Script

Operation description
If the value of LDR100 is not 0 or the value of LDR200 is not 0, then 100 is stored in LDR300.
If either is true, the processing in the brackets “{ }” is executed.

Script

Operation description
If the value of LDR100 is not equal to 0x1234, then 100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is 0, then 100 is stored in LDR300.
This is the same as the code “if (0==[LDR 100]))”.

■ Example 5.3.1 Logical AND

if (([LDR 100] == [LDR 200]) && ([LDR 300] == [LDR 400] + [LDR 500]))
{

[LDR 600] = 100;
}

■ Example 5.3.2 Logical OR

if ((0 != [LDR 100]) || (0 != [LDR 200]))
{

[LDR 300] = 100;
}

■ Example 5.3.3 Logical inversion

if (!([LDR 100] == 0x1234))
{

[LDR 300] = 100;
}

■ Example 5.3.4 Logical inversion

if (!(0 !=[LDR 100]))
{

[LDR 300] = 100 ;
}
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5.4 Arithmetic Operators

Script

Operation description
The values of LDR100 and LDR200 are added together and the result is stored in LDR300.

Script

Operation description
The value of LDR200 is subtracted from the value of LDR100 and the result is stored in LDR300.

Script

Operation description
The values of LDR100 and LDR200 are multiplied together and the result is stored in LDR300.

Script

Operation description
The value of LDR100 is divided into the value of LDR200 and the result is stored in LDR300.

Script

Operation description
The value of LDR100 is divided into the value of LDR200 and the remainder is stored in LDR300.

■ Example 5.4.1 Addition

[LDR 300] = [LDR 100] + [LDR 200];

■ Example 5.4.2 Subtraction

[LDR 300] = [LDR 100] - [LDR 200];

■ Example 5.4.3 Multiplication

[LDR 300] = [LDR 100] * [LDR 200];

■ Example 5.4.4 Division

[LDR 300] = [LDR 100] / [LDR 200];

■ Example 5.4.5 Modulo

[LDR 300] = [LDR 100] % [LDR 200];
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5.5 Bitwise Operators

Script

Operation description
If the bitwise logical AND operation on the values of LM100 and LM101 is 1, LM200 changes to 1.
If the bitwise logical AND operation on the values of LM100 and LM101 is 0, LM200 changes to 0.
The operation is the same as the following ladder diagram.

Script

Operation description
If the bitwise logical OR operation on the values of LM100 and LM101 is 1, LM200 changes to 1.
If the bitwise logical OR operation on the values of LM100 and LM101 is 0, LM200 changes to 0.
The operation is the same as the following ladder diagram.

Script

Operation description
The logical XOR operation on the value of LDR100 and each bit in 0xFF is stored in LDR200.
For example, if the value of LDR100 is 15 (0x0F), then LDR200 is 240 (0xF0).

■ Example 5.5.1 Logical AND

if ([LM 100] & [LM 101])
{

SET([LM 200)]);
}
else
{

RST([LM 200]);
}

LM100 LM101 LM200

■ Example 5.5.2 Logical OR

if ([LM 100] | [LM 101])
{

SET([LM 200]);
}
else
{

RST([LM 200]);
}

LM100

LM101

LM200

■ Example 5.5.3 Logical XOR (exclusive OR)

[LDR 200] = [LDR 100] ^ 0xFF;
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Operation description
The bits in the value of LDR100 are flipped and stored in LDR200.
For example, if the value of LDR100 is 0, then LDR200 is 65535.

Script

Operation description
If the bitwise logical OR operation on the value of LM102 and the result of the bitwise logical AND operation on the 
value of LM100 and the inverted result of the value of LM101 is 1, then LM200 changes to 1.
If the bitwise logical OR operation on the value of LM102 and the result of the bitwise logical AND operation on the 
value of LM100 and the inverted result of the value of LM101 is 0, then LM200 changes to 0.
The operation is the same as the following ladder diagram.

Script

Operation description
The value of LDR100 is shifted left by only the amount of the value of LDR200 and the result is stored in LDR300.
For example, if the value of LDR100 is 1 and the value of LDR200 is 3, 1 is shifted 3 bits to the left and the result 8 is 
stored in LDR300.

Script

Operation description
The value of LDR100 is shifted right by only the amount of the value of LDR200 and the result is stored in LDR300.
For example, if the value of LDR100 is 8 and the value of LDR200 is 3, 8 is shifted 3 bits to the right and the result 1 
is stored in LDR300.

■ Example 5.5.4 Inversion

[LDR 200] = ~[LDR 100];

■ Example 5.5.5 Inversion

if (([LM 100] & ~ [LM 101]) | [LM 102])
{

SET([LM 200]);
}
else
{

RST([LM 200]);
}

LM100

LM102

LM200LM101

■ Example 5.5.6 Left shift

[LDR 300] = [LDR 100] << [LDR 200];

■ Example 5.5.7 Right shift

[LDR 300] = [LDR 100] >> [LDR 200];
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5.6 Bit Functions

Script

Operation description
Turns LM100 to 1. The result is the same as [LM 100] = 1.

Script

Operation description
Turns LM100 to 0. The result is the same as [LM 100] = 0.

Script

Operation description
Flips LM100 1 and 0. The result is the same as [LM 100] = ~[LM 100].

■ Example 5.6.1 Set a bit

SET([LM 100]);

■ Example 5.6.2 Reset a bit

RST([LM 100]);

■ Example 5.6.3 Invert a bit

REV([LM 100]);
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5.7 Word Functions

● Arithmetic operations

Script

Operation description
Out of the values stored in LDR100, LDR110, LDR120, LDR130, and LDR140, stores the maximum value in LDR200.
Up to 15 arguments can be used.

Script

Operation description
Out of the values stored in LDR100, LDR110, LDR120, LDR130, and LDR140, stores the minimum value in LDR200.
Up to 15 arguments can be used.

Script

Operation description
Calculates the exponential function of the value of D20 and the result is stored in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the natural logarithm of the value of D20 and the result is stored in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the logarithm of the value of D20 with 10 as the base and the result is stored in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the power of a value.
For example, when the value of D20 is 10 and the value of D30 is 5, the function calculates 10 to the power of 5 and 
stores the result in D10.
Only the data type Float32(F) can be used.

■ Example 5.7.1 Maximum value

[LDR 200] = MAX([LDR 100], [LDR 110], [LDR 120], [LDR 130], [LDR 140]);

■ Example 5.7.2 Minimum value

[LDR 200] = MIN([LDR 100], [LDR 110], [LDR 120], [LDR 130], [LDR 140]);

■ Example 5.7.3 Exponential function

[D 10] = EXP([D 20]);

■ Example 5.7.4 Natural logarithm

[D 10] = LOGE([D 20]);

■ Example 5.7.5 Common logarithm

[D 10] = LOG10([D 20]);

■ Example 5.7.6 Power

[D 10] = POW([D 20],[D 30]);
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Script

Operation description
Calculates the square root of the value of [D 20] and the result is stored in [D 10].
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the sine of the radian value of D20 and stores the result in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the cosine of the radian value of D20 and stores the result in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the tangent of the radian value of D20 and stores the result in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the arcsine of the value of D20 and stores the result as radians in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the arccosine of the value of D20 and stores the result as radians in D10.
Only the data type Float32(F) can be used.

■ Example 5.7.7 Square root

[D 10] = ROOT([D 20]);

■ Example 5.7.8 Sine

[D 10] = SIN([D 20]);

■ Example 5.7.9 Cosine

[D 10] = COS([D 20]);

■ Example 5.7.10 Tangent

[D 10] = TAN([D 20]);

■ Example 5.7.11 Arcsine

[D 10] = ASIN([D 20]);

■ Example 5.7.12 Arccosine

[D 10] = ACOS([D 20]);
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Script

Operation description
Calculates the arctangent of the value of D20 and stores the result as radians in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Converts the value of D20 from degrees (°) to radians and stores the result in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Converts the value of D20 from radians to  degrees (°) and stores the result in D10.
Only the data type Float32(F) can be used.

■ Example 5.7.13 Arctangent

[D 10] = ATAN([D 20]);

■ Example 5.7.14 Convert angle to radians

[D 10] = RAD([D 20]);

■ Example 5.7.15 Convert radians to angle

[D 10] = DEG([D 20]);
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● Data type conversions

Script

Operation description
Converts the BCD value in LDR100 to a binary value and stores it in LDR200.
For example, if the BCD value 10 (16 as a binary value) is stored in LDR100, 10 (binary value) is stored in LDR200.

Script

Operation description
Converts the binary value in LDR100 to a BCD value and stores it in LDR200.
For example, if the binary value 16 (10 as a BCD value) is stored in LDR100, 16 (BCD value) is stored in LDR200.

Script

Operation description
Converts the floating point value in LDR100 to a binary value and stores it in LDR200.
For example, if the floating point value 1234 (0x449A4000 as a binary value) is stored in LDR100, 1234 (binary value) 
is stored in LDR200. If the floating point value 1234.56 (0x449A51EC as a binary value) is stored in LDR100, the value 
after the decimal point is discarded and 1234 (binary value) is stored in LDR200.

Script

Operation description
Converts the binary value in LDR100 to a floating point value and stores it in LDR200.
For example, if the binary value 1234 is stored in LDR100, the floating point value 1234 (0x449A4000 as a binary 
value) is stored in LDR200.

■ Example 5.7.16 Convert BCD to binary

[LDR 200] = BCD2BIN([LDR 100]);

■ Example 5.7.17 Convert binary to BCD

[LDR 200] = BIN2BCD([LDR 100]);

■ Example 5.7.18 Convert floating point to binary

[LDR 200] = FLOAT2BIN([LDR 100]);

■ Example 5.7.19 Convert binary to floating point

[LDR 200] = BIN2FLOAT([LDR 100]);
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Operation description
Converts the decimal numeric value in LDR200 to a string and stores it in order with LDR100 as the starting address number.

Converting 1234 (when the data type is UBIN16(W))

Converting -12345 (when the data type is BIN16(I))

Converting 1234567890 (when the data type is UBIN32(D))

Converting -1234567890 (when the data type is BIN32(L))

■ Example 5.7.20 Convert decimal to string

DEC2ASCII([LDR 100], [LDR 200]);

• This function can be used with data types UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), and 
BCD8(EB).

• Only internal devices can be used.
• When using functions that handle strings, check the Storage Method of string data setting on the 

System tab in the Project Settings dialog box. Depending on the setting, the upper and lower bytes 
are stored in the reverse of the following explanation.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-13.

• A NULL terminating character (0x00) is added to the end of the string.

Device address
Stored value

Device address Stored value Upper byte Lower byte
23x0 = '2'13x0 = '1'LDR1004321LDR200

LDR101             '3' = 0x33 '4' = 0x34
LDR102                 0x00 0x00

Terminating characterTerminating character

Device address
Stored value

Device address Stored value Upper byte Lower byte
13x0 = '1'D2x0 = '-' LDR10054321-LDR200

LDR101 '2' = 0x32 '3' = 0x33
LDR102 '4' = 0x34 '5' = 0x35
LDR103                 0x00 0x00

Terminating character

Device address
Stored value

Device address Stored value Upper byte Lower byte
LDR200
LDR201

1234567890
LDR100 '1' = 0x31 '2' = 0x32

43x0 = '4'33x0 = '3'LDR101
LDR102 '5' = 0x35 '6' = 0x36
LDR103 '7' = 0x37 '8' = 0x38
LDR104 '9' = 0x39 '0' = 0x30
LDR105                 0x00 0x00

Terminating characterTerminating character

Device address
Stored value

Device address Stored value Upper byte Lower byte
LDR200

-1234567890
LDR100 '-' = 0x2D '1' = 0x31

33x0 = '3'23x0 = '2'LDR101LDR201
LDR102 '4' = 0x34 '5' = 0x35
LDR103 '6' = 0x36 '7' = 0x37
LDR104 '8' = 0x38 '9' = 0x39
LDR105 '0' = 0x30 0x00

Terminating characterTerminating character
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Script

Operation description
Converts the stored string starting at LDR200 to a decimal and stores the result in LDR100.
The number of digits that can be converted is the maximum number of digits for each data type with added sign.
If the string to convert contains NULL or characters that cannot be converted to numeric values, the string is 
converted up to that character.

Setting the string “1234” (when the data type is UBIN16(W))

Setting the string “1234567” (when the data type is UBIN16(W))

Setting the string “-12345” (when the data type is BIN16(I))

String “1234567890” (when the data type is UBIN32(D))

■ Example 5.7.21 Convert string to decimal

[LDR 100] = ASCII2DEC([LDR 200]);

• This function can be used with data types UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), and 
BCD8(EB).

• Only internal devices can be used.
• When using functions that handle strings, check the Storage Method of string data setting on the 

System tab in the Project Settings dialog box. Depending on the setting, the upper and lower bytes 
are stored in the reverse of the following explanation.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-13.

Device address
Stored value

Upper byte Lower byte Device address Stored value
4321LDR10023x0 = '2'13x0 = '1'LDR200

LDR201 '3' = 0x33 '4' = 0x34
LDR202                 0x00 0x00

Terminating characterTerminating character

Device address
Stored value

Upper byte Lower byte Device address Stored value
54321LDR10023x0 = '2'13x0 = '1'LDR200

LDR201 '3' = 0x33 '4' = 0x34
LDR202 '5' = 0x35 '6' = 0x36
LDR203 '7' = 0x37 0x00

Terminating characterTerminating character

Device address
Stored value

Upper byte Lower byte Device address Stored value
54321-LDR10013x0 = '1'D2x0 = '-'LDR200

LDR201 '2' = 0x32 '3' = 0x33
LDR202 '4' = 0x34 '5' = 0x35
LDR203                 0x00 0x00

Terminating characterTerminating character

Device address
Stored value

Upper byte Lower byte Device address Stored value
0987654321LDR100 - 10123x0 = '2'13x0 = '1'LDR200

LDR201 '3' = 0x33 '4' = 0x34
LDR202 '5' = 0x35 '6' = 0x36
LDR203 '7' = 0x37 '8' = 0x38
LDR204 '9' = 0x39 '0' = 0x30
LDR205                 0x00 0x00

Terminating characterTerminating character



WindO/I-NV4 User’s Manual 20-45

5 Script Coding Examples

20

Script

● Data comparison and copying

Script

Operation description
Compares the value of 10 words from LDR100 (up to LDR109) with the value of 10 words from LDR200 (up to 
LDR209).
If the value for each is entirely equal, 1 is stored in LDR0. If even a single one is not equal, 0 is stored.

Script

Operation description
Compares the third bit of LDR100 through the third bit of LDR109 with the state of the bits from LM0 to LM9.
If the value for each is entirely equal, 1 is stored in LDR0. If even a single one is not equal, 0 is stored.

■ Example 5.7.22 Word-unit data comparison

[LDR 0] = MEMCMP([LDR 100], [LDR 200], 10);

LDR100
LDR101
LDR102

LDR108
LDR109

LDR200
LDR201
LDR202

LDR208
LDR209

Compare each

LDR107 LDR207

Even if the data type is set to UBIN32(D), BIN32(L), BCD8(EB), or Float32(F), the comparison is performed 
from the start device address in word units.

■ Example 5.7.23 Bit-unit data comparison

[LDR 0] = MEMCMP([LDR 100-2], [LM 0], 10);

3rd bit of LDR100
3rd bit of LDR101
3rd bit of LDR102

3rd bit of LDR108
3rd bit of LDR109

LM0
LM1
LM2

LM8
LM9

Compare each

3rd bit of LDR107 LM7

Even if the data type is set to UBIN32(D), BIN32(L), BCD8(EB), or Float32(F), the comparison is performed 
from the start device address in bit units.
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Operation description
Copies the value of 10 word device addresses from LDR200 (up to LDR209) to 10 word device addresses from 
LDR100 (up to LDR109).

Script

Operation description
Copies the third bit of 10 words from LDR100 (up to LDR109) to the bit state for 10 of device addresses from LM0 (up to 
LM9).

■ Example 5.7.24 Word-unit data copy

MEMCPY([LDR 100], [LDR 200], 10);

LDR100
LDR101
LDR102

LDR108
LDR109

LDR200
LDR201
LDR202

LDR208
LDR209

Copy each

LDR107 LDR207

Even if the data type is set to UBIN32(D), BIN32(L), BCD8(EB), or Float32(F), the data is copied from the 
start device address in word units.

■ Example 5.7.25 Bit-unit data copy

MEMCPY([LM 0], [LDR 100-2], 10);

3rd bit of LDR100
3rd bit of LDR101
3rd bit of LDR102

3rd bit of LDR108
3rd bit of LDR109

LM0
LM1
LM2

LM8
LM9

3rd bit of LDR107LM7

Copy each

Even if the data type is set to UBIN32(D), BIN32(L), BCD8(EB), or Float32(F), the bits are copied from the 
start device address in bit units.
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● String operations
When using functions that handle string data, check the Storage Method of string data setting in the project 
settings.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-13.

Script

Operation description
Stores in order from LDR100 character count 3 (3 characters worth) from start position 2 (starting from 0, so the 3rd 
character) of the string “ABCDEFG” that starts from LDR200.

Copy from string “ABCDEFG” at start position 2, character count 3

Script

Copy from string “ABCDEFG” at start position 1, character count 4

■ Example 5.7.26 Copy a string

STRCUT([LDR 100], [LDR 200], 2, 3);

The start position can be specified in the range from 0 to 127, the character count can be specified in the 
range from 1 to 128.

STRUCT([LDR 100], [LDR 200], 1, 4);

Device address Stored value Start 
position Character count Device address Stored value

LDR200
Upper byte 'A' = 0x41 0

LDR100
Upper byte 'C' = 0x43

Lower byte 'B' = 0x42 1 Lower byte 'D' = 0x44

LDR201
Upper byte 'C' = 0x43 ←2

LDR101
Upper byte 'E' = 0x45

Lower byte 'D' = 0x44 3 Lower byte 0x00 Terminating character

LDR202
Upper byte 'E' = 0x45 4

Lower byte 'F' = 0x46 5

LDR203
Upper byte 'G' = 0x47 :

Lower byte 0x00 Terminating character

3 characters

Device address Stored value Start 
position Character count Device address Stored value

LDR200
Upper byte 'A' = 0x41 0

LDR100
Upper byte 'B' = 0x42

Lower byte 'B' = 0x42 ←1 Lower byte 'C' = 0x43

LDR201
Upper byte 'C' = 0x43 ←2

LDR101
Upper byte 'D' = 0x44

Lower byte 'D' = 0x44 3 Lower byte 'E' = 0x45

LDR202
Upper byte 'E' = 0x45 4

LDR102
Upper byte 0x00 Terminating character

Lower byte 'F' = 0x46 5 Lower byte 0x00

LDR203
Upper byte 'G' = 0x47 :

Lower byte 0x00 Terminating character

4 characters
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Operation description
Finds the length (character count) of the string starting from LDR200 and stores that in LDR100.

■ Example 5.7.27 Count a string

[LDR 100] = STRLEN([LDR 200]);

• The only device addresses that can be specified as function arguments in string operations are internal 
devices.

• The NULL terminating character (0x00) is the end of the string. (The terminating character is not included 
in the string length.)

Device address   Stored value Device address Stored value

LDR200
Upper byte 'A' = 0x41

LDR100 7
Lower byte 'B' = 0x42

LDR201
Upper byte 'C' = 0x43

Lower byte 'D' = 0x44

LDR202
Upper byte 'E' = 0x45

Lower byte 'F' = 0x46

LDR203
Upper byte 'G' = 0x47

Lower byte 0x00

Device address Stored value Device address Stored value

LDR200
Upper byte 'A' = 0x41

LDR100 3
Lower byte 'B' = 0x42

LDR201
Upper byte 'C' = 0x43

Lower byte 0x00

LDR202
Upper byte 'E' = 0x45

Lower byte 'F' = 0x46

LDR203
Upper byte 'G' = 0x47

Lower byte 0x00

Character 
count

Terminating character

Character 
count

Terminating character
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Script

Operation description
Concatenates the string starting from LDR200 to the string starting from LDR100.

■ Example 5.7.28 Concatenate strings

STRCAT([LDR 100], [LDR 200]);

• The only device addresses that can be specified as function arguments in string operations are internal 
devices.

• The NULL terminating character (0x00) is the end of the string. (The terminating character is not included 
in the string length.)

Device address Stored value Device address Stored value

LDR100
Upper byte 'A' = 0x41

LDR100
Upper byte 'A' = 0x41

Lower byte 'B' = 0x42 Lower byte 'B' = 0x42

LDR101
Upper byte 'C' = 0x43

LDR101
Upper byte 'C' = 0x43

Lower byte 0x00 Lower byte 'D' = 0x44

LDR102
Upper byte 'E' = 0x45

Device address Stored value Lower byte 'F' = 0x46

LDR200
Upper byte 'D' = 0x44

LDR103
Upper byte 'G' = 0x47

Lower byte 'E' = 0x45 Lower byte 0x00 Terminating character

LDR201
Upper byte 'F' = 0x46

Lower byte 'G' = 0x47

LDR202
Upper byte 0x00

Lower byte 0x00

Concatenate
Terminating 
character

Terminating character
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Script

Operation description
Searches for the search string “DEFG” that starts from LDR200 in the string to be searched “ABCDEFGHIJKLMNO” that 
starts from LDR100 and stores the position of the occurrence of the string in LDR0. If not found, -1 is stored in LDR0.

If “?” is specified as a character to search for, it is handled as an arbitrary single-byte character.
When specifying “?” (0x3F) as a character, specify it as “~?” (0x7E3F) in two bytes.
When specifying “~” (0x7E) as a character, specify it as “~~” (0x7E7E) in two bytes.

When searching for “DEFG” and the string was found

When searching for “WXYZ” and the string was not found

■ Example 5.7.29 Search a string

[LDR 0] = STRSTR([LDR 100], [LDR 200]);

• The maximum number for the search string is 128 characters.
• The only device addresses that can be specified in all arguments are internal devices.

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device address Stored value Device address Stored value Device address Stored value

LDR200
Upper byte 'D' = 0x44

LDR100
Upper byte 'A' = 0x41 0

LDR0 3
Lower byte 'E' = 0x45 Lower byte 'B' = 0x42 1

LDR201
Upper byte 'F' = 0x46

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'G' = 0x47 Lower byte 'D' = 0x44 ←3

LDR202
Upper byte 0x00 Terminating 

character LDR102
Upper byte 'E' = 0x45 4

Lower byte 0x00 Lower byte 'F' = 0x46 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Position

Search string String to be searched Search result
Device address Stored value Device address Stored value Device address Stored value

LDR200
Upper byte 'W' = 0x57

LDR100
Upper byte 'A' = 0x41 0

LDR0 -1
Lower byte 'X' = 0x58 Lower byte 'B' = 0x42 1

LDR201
Upper byte 'Y' = 0x59

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'Z' = 0x5A Lower byte 'D' = 0x44 3

LDR202
Upper byte 0x00 Terminating 

character LDR102
Upper byte 'E' = 0x45 4

Lower byte 0x00 Lower byte 'F' = 0x46 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Position
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When searching for “?” as an arbitrary single-byte character

When searching for “?” as a character

When searching for “~” as a character

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device address Stored value Device address Stored value Position Stored value

LDR200
Upper byte 'E' = 0x45

LDR100
Upper byte 'A' = 0x41 0

LDR0 4
Lower byte '?' = 0x3F Lower byte 'B' = 0x42 1

LDR201
Upper byte 'G' = 0x47

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'H' = 0x48 Lower byte 'D' = 0x44 3

LDR202
Upper byte 0x00 Terminating 

character LDR102
Upper byte 'E' = 0x45 ←4

Lower byte 0x00 Lower byte 'F' = 0x46 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Device address

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device address Stored value Device address Stored value Position Stored value

LDR200
Upper byte 'E' = 0x45

LDR100
Upper byte 'A' = 0x41 0

LDR0 4
Lower byte '~' = 0x7E Lower byte 'B' = 0x42 1

LDR201
Upper byte '?' = 0x3F

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'G' = 0x47 Lower byte 'D' = 0x44 3

LDR202
Upper byte 'H' = 0x48

LDR102
Upper byte 'E' = 0x45 ←4

Lower byte 0x00 Terminating 
character Lower byte '?' = 0x3F 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Device address

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Stored value Stored value Position Stored value

LDR200
Upper byte 'E' = 0x45 Upper byte 'A' = 0x41 0

LDR0 4
Lower byte '~' = 0x7E Lower byte 'B' = 0x42 1

LDR201
Upper byte '~' = 0x7E Upper byte 'C' = 0x43 2
Lower byte 'G' = 0x47 Lower byte 'D' = 0x44 3

LDR202
Upper byte 'H' = 0x48 Upper byte 'E' = 0x45 ←4
Lower byte 0x00 Terminating 

character Lower byte '~' = 0x7E 5
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Device address Device address Device address

LDR100

LDR101

LDR102

LDR103

LDR104

LDR105

LDR106

LDR107



5 Script Coding Examples

20-52 WindO/I-NV4 User’s Manual

● Drawing

Script

Operation description
Draws a line connecting the start coordinates X=20, Y=20 and the end coordinates X=60, Y=60 on the screen where 
the script is running. The line has a line width of 3 (3 pixels), line type of 1 (solid line), and line color of 20 (red).

Script

Operation description
Draws a line connecting the start coordinates X=0, Y=0 and the end coordinates X=150, Y=100 on the screen where 
the script is running. The line width, line type, and line color have been omitted, so the line's line width is 1 (1 pixel), 
the line type is 1 (solid line), and the line color is 255 (white).

Script

Operation description
Draws a rectangle with the start coordinates (the coordinates of the rectangle's upper-left corner) X=20, Y=20 and 
the end coordinates (the coordinates of the rectangle's lower-right corner) X=100, Y=60 on the screen where the 
script is running. The rectangle's line width is 1 (1 pixel), line type is 2 (dotted line), foreground color is 24 (green), 
background color is 22 (yellow), pattern is 13 (tint), rounding type is 2 (curve), and rounding radius is 5 (5 pixels).

Script

Operation description
Draws a rectangle with the start coordinates (the coordinates of the rectangle's upper-left corner) X=0, Y=0 and the end 
coordinates (the coordinates of the rectangle's lower-right corner) X=150, Y=100 on the screen where the script is 
running. The line width, line type, foreground color, background color, pattern, rounding type, and rounding radius are 
omitted, so the rectangle's line width is 1 (1 pixel), line type is 1 (solid line), foreground color and background color is 
255 (white), pattern is 0 (none), rounding type is 0 (none), and rounding radius is 0 (0 pixels).

Script

Operation description
Draws a circle with the center coordinate X=100, Y=100, the X-axis radius 60 pixels, and the Y-axis radius 60 pixels. 
The circle's line width is 1 (1 pixel), line type is 2 (dotted line), foreground color is 26 (light blue), background color is 
0 (black), and pattern is 4 (foreground 50%).

Script

Operation description
Draws an ellipse with the center coordinate X=100, Y=100, the X-axis radius 80 pixels, and the Y-axis radius 40 pixels. 
The line width, line type, foreground color, background color, and pattern are omitted, so the ellipse's line width is 1 (1 
pixel), line type is 1 (solid line), foreground color and background color is 255 (white), and pattern is 0 (none).

■ Example 5.7.30 Draw a line

LINE(20, 20, 60, 60, 3, 1, 20);

■ Example 5.7.31 Draw a line (omitting arguments)

LINE(0, 0, 150, 100);

■ Example 5.7.32 Draw a rectangle

RECTANGLE(20, 20, 100, 60, 1, 2, 24, 22, 13, 2, 5);

■ Example 5.7.33 Draw a rectangle (omitting arguments)

RECTANGLE(0, 0, 150, 100);

■ Example 5.7.34 Draw a circle or ellipse

CIRCLE(100, 100, 60, 60, 1, 2, 26, 0, 4);

■ Example 5.7.35 Draw a circle or ellipse (omitting arguments)

CIRCLE(100, 100, 80, 40);
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● Indirect assignment

Script

Operation description
When the value of D20 is 8, the value of LDR18, the device address 8 words from LDR10, is read and stored in 
LDR200.

Script

Operation description
When the value of D20 is 3, the constant 1234 is stored in LDR13, the device address 3 words from LDR10.

■ Example 5.7.36 Indirect read

[LDR 200] = OFFSET([LDR 10],[D 20]);

Read

0000LDR10 0008D20

+8

1234LDR181234LDR200

■ Example 5.7.37 Indirect write

OFFSET([LDR 10],[D 20]) = 1234;

Write

0000LDR10 0003D20

+3

1234LDR131234
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This section describes important notes when defining a script.

6.1 Important Notes Regarding the While Definition

■ Define so it will not go into an infinite loop.
The execution expression is repeatedly executed while the conditional expression is satisfied.
However, it will go into an infinite loop when the conditional expression is satisfied continually.

In the conditional expression of the while definition, it states to exit the loop when the value of LDR100 turns 0. However, the 
value stored in the LDR100 is not changed after storing 10 in the first line of the script, so it will go into an infinite loop.

When using the while definition, define it so it will not go into an infinite loop.
The value of LDR100 will become 0 when the while definition is repeated 10 times in the next example, and it will get 
out of the while definition.

■ Define it so it will not continue the process for longer than the time limit.
When the processing of a single script continues for more than the time limit due to a while definition, etc., an 
execution time over error occurs and that script will be halted. Define the script so the execution time for one script 
does not exceed 3,000 milliseconds.
For details, refer to “1.4 Script Error” on page 20-4.

■ Do not write into the external device address.
When it is written into an external device address in the while definition, a script error will occur.

6.2 Number of Device Addresses That Can Be Used
The number of external device addresses that can be used in the script are as follows:

6 Important Notes

[LDR 100] = 10;

while (0 != [LDR 100])
{

[LDR 200] = [LDR 200] + 1;
} 

[LDR 100] = 10;

while (0 != [LDR 100])
{

[LDR 200] = [LDR 200] + 1;
[LDR 100] = [LDR 100] - 1;

}

Item Number of devices

Destination external device addresses 64 max.

Source external device addresses 64 max.

• The maximum number of source external device addresses which can be used as a trigger condition and 
in scripts executed as Grobal Script is 256.

• When the total number of write data to an external device address exceeds 64 in a single script while 
executing a script with MICRO/I, that script will be halted with an error.
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6.3 About the Priority of the Operator

As a basic rule, operators are calculated in order from left of the line, but when multiple calculations are combined, 
they are calculated in following priority.

Priority Operator

High ()

! ~ -(Negative number)

* / %

+ -(Subtraction)

<< >>

&

^

|

< <= > >=

== !=

&&

||

Low =
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ser Accounts and the Security 

This chapter outlines user accounts and the Security function, how to configure them, and their operation on the 
MICRO/I and in WindO/I-NV4.

  

1.1 User Accounts

The Security function protects access to data and MICRO/I displays and operations using accounts. Accounts are the 
privileges to use the MICRO/I and data. By assigning accounts to users, you can protect the MICRO/I from being 
inappropriately operated and protect project data from alterations and misuse.
Accounts assigned to users are called user accounts.

In WindO/I-NV4, security groups are used as accounts.
There are two types of security groups. One type protects access to data. The other type protects MICRO/I displays 
and operations. To protect access to data, assign one of the provided security groups to a user. To protect MICRO/I 
displays and operations, assign a user-created security group to a user.

A user name and password are associated with a user account and up to 15 user accounts can be created.

Chapter 21 User Accounts and the Security Function

1 Overview

User

Assign

Account

User account

Privileges to operate the MICRO/I

Privileges to access data

Assign Assign

Provided security groups User-created security 
groups (12 max)

Protect displays and opera�onsProtect data

Administrator

Operator

Reader

GroupA

GroupB

User account: User account:

User4User3 User15User2User1

11111111 22222222 33333333 44444444 EEEEEEEEPassword:

User name:

User account:
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If you configure a password for a user account assigned to a security group, access to data and MICRO/I displays and 
operations are password protected.
For password protected operations, users are prompted to enter their user name and password as necessary on the 
MICRO/I Password screen or the WindO/I-NV4 Enter Password dialog box.

Password screen Enter Password dialog box

CAN

User

A B C D E F

G H I J K L

CLR

M N O P Q R

S T U V W X

ENT

Y Z 0 1 2 3

4 5 6 7 8 9

Password

• You can set a dedicated password when opening the project. In the Security dialog box, on the Options 
tab, select the Use Password to open a Project check box, and then set the password.

• If a password is not configured for a user account, access to data and MICRO/I displays and operations 
cannot be protected.
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1.2 Protecting Data

● Protecting Access to Data
Security groups that protect access to data can perform the following functions.

• Protect from changes by editing project data

• Protect from alterations or misuse by downloading data

The Enter Password dialog box is displayed

Opening project data

Computer MICRO/I

The Enter Password dialog box is displayed

Download

Download

Project data

Recipe files

Picture files

USB flash drive

External memory device

The Password screen is displayed

CAN

User

Enter the appropriate password 
for Data Transfer Function

Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

USB flash drive

MICRO/I

External device

Download

PLC programs

External memory device
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• Protect from the loss of data by upload

• Protect from data erasures and formatting external memory device by unauthorized access

• Protect from alterations and misuse by operating the MICRO/I under the System Mode

Computer MICRO/I

The Enter Password dialog box is displayed

Upload

Upload

Screenshot data

Alarm Log data

Data Log data

Operation Log data

Recipe files

Picture files

Project data

USB flash drive

External memory device

The Password screen is displayed

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Enter the appropriate password 
for Data Transfer Function

Password

USB flash drive

MICRO/I

External device

Upload

PLC programs

External memory device

Computer MICRO/IDeleting data

The Enter Password dialog box is displayed

Deleting data
Formatting

USB flash drive

External memory device

The Password screen is displayed

Maintenance
System Mode

Device Monitor

Adjust Brightness

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/I
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• Protect from unauthorized browsing by displaying Device Monitor

• Protect from the loss of data or alterations by the execution of the USB Autorun function

• Protect from remote unauthorized browsing and unauthorized operations using a web browser terminal on a 
computer or PDA

The Password screen is displayed

Device Monitor CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

System Mode

Adjust Brightness

Maintenance Password

MICRO/IMICRO/I

The Password screen is displayed

USB flash drive

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/I

Web Browser Terminal

(computer, PDA, etc.)

Local Network

Ethernet Communication (TCP/IP)

The Password screen is displayed
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● Security Groups that Protect Access to Data
Three security groups have been provided to protect access to data. These security groups are Administrator, 
Operator, and Reader. Each one of these security groups can only be assigned to a single user.

■ Administrator
The Administrator group possesses complete access rights to project data. This security group can execute all 
necessary operations including editing project data and changing MICRO/I project data.

■ Operator
The Operator group can partially change project data by changing values of device addresses. This security group 
download data to external memory device.

■ Reader
The Reader group can read data stored on external memory device and read values of device addresses with the Web 
Server function.

The provided user account has the security groups Administrator, Operator, and Reader allocated to it. 
Passwords have not been configured for this user account. To protect access to data, a password must be 
configured for the user account.

User1

Provided security groups

Administrator

Operator

Reader
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● Operations Subject to Password Protection
If you configure a password for a user account assigned to a security group to protect access to data, access to data 
is password protected. The operations that are subject to password protection and the security group that the 
password is valid for are as follows.

*1 Inserted into the MICRO/I

Operations subject to password protection
Security group that the password is valid for

Administrator Operator Reader

Data editing
Opening projects YES NO NO

Reusing screens YES NO NO

Modifying data

Downloading a project data YES NO NO

Downloading PLC programs from an external memory 

device*1 to external devices
YES NO NO

Downloading data to an external memory device*1 YES NO NO

Downloading data to an external memory device*1 
while the MICRO/I is running

YES YES NO

Uploading a project data YES NO NO

Uploading PLC programs from external devices to an 

external memory device*1 YES NO NO

Uploading data from an external memory device*1 YES YES YES

Deleting all data YES NO NO

Deleting data in external memory device*1 YES NO NO

Formatting external memory device*1 YES NO NO

Switching to the System Mode YES NO NO

Displaying Device Monitor YES YES NO

Remotely monitoring the MICRO/I state from a web 
browser terminal

YES YES YES

Remotely operating the MICRO/I state from a web 
browser terminal

YES YES NO

• You can set a dedicated password. In the Security dialog box, on the Options tab, select the Use 
Password to open a Project check box, and then set the password. The dedicated password is 
applicable to the following operations:
- Opening projects
- Reusing screens
- Opening projects after uploading project data

• To password protect operations, the lowest level security group out of the security groups enabled with a 
password must be assigned to a user account.
The security levels, from highest to lowest, are Administrator > Operator > Reader.
Example: To password protect the operation to display Device Monitor, assign the Operator security 

group to a user account. If a user account assigned to the Operator security group does not 
exist, the operation is not password protected.

• The commands that the USB Autorun function can execute vary based on the enabled security group. For 
details, refer to Chapter 27 “2.4 USB Autorun Function Security” on page 27-33.
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1.3 Protecting Displays and Operations

● Displays and Operations that can be Protected with the Security Function
Security groups can be assigned to users to protect MICRO/I displays and operations. These groups are capable of 
the following actions.

• Protecting the display of screens

• Protecting the display of parts

• Protecting the operation of parts

Switch user accountGoto Screen Button 
(Switch to base screen 2)

No user

The Password 
screen is displayed

Base screen 2 is 
displayed

Full

Tank 1
Base screen 1

User2
User2

CAN

User2 Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/IMICRO/I

Base screen 2 
Cannot be 
displayed

Base screen 2 
Can be displayed

Switch user account

The Password 
screen is displayed

Line Chart is 
displayed

Goto Screen Button
(Open password screen)

Line Chart that can only be displayed with User2

User2
User2

No user

CAN

User2 Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/IMICRO/I

Line Chart
Can be displayed

Line Chart
Cannot be 
displayed

Switch user account

The Password screen 
is displayed

The Numerical Input 
can be operated

Goto Screen Button
(Open password screen)

Numerical Input that can only be operated by User2

User2
User2

999999 999

999

No user

CAN

User2 Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/IMICRO/I

Numerical Input
Can be operated

Numerical Input
Can be operated
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● Security Groups that Protect MICRO/I Displays and Operations
The security groups that protect the display and operation of screens and parts are user-created. Only the user 
accounts assigned to the same security group as the security group configured for the screens and parts can display 
and operate those screens and parts.
The security group for screens and parts is configured in the Options tab in the Properties dialog box for the screen 
or part. The input security group to protect operations can only be configured for parts with an input function.

Example: If the user and security group for the part are set as follows:

If the password screen is opened and the user switches to User2 in GroupA, the parts for GroupA are displayed. The 
parts for GroupB cannot be operated.

If the password screen is opened and the user switches to User3 in GroupA and GroupB, the parts for GroupA are 
displayed and the parts for GroupB can be operated.

User Name

Security Group GroupA GroupA, GroupB GroupB

User2 User3 User4

MICRO/I

999

Default user: None

Line Chart and Bar Chart
Display: GroupA

Button
Display: GroupA
Input: GroupB

Goto Screen Button (Open password screen)
Display: None
Input: None

Numerical Input
Display: None
Input: GroupB

MICRO/I MICRO/I MICRO/I

User2

Open the password screen with the Goto 
Screen Button, enter the password, and 
switch to User2

With no user, GroupA parts 
are hidden, GroupB parts 
cannot be operated

With User2, GroupA parts are 
shown, GroupB parts cannot be 
operated

999 999 999
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Cannot be 
operated

Cannot be 
operated

DisplayedNot 
displayed

MICRO/I MICRO/I MICRO/I

With User3, GroupA parts are 
shown, GroupB parts can be 
operated

User3

With no user, GroupA parts 
are hidden, GroupB parts 
cannot be operated

Open the password screen with the Goto 
Screen Button, enter the password, and 
switch to User3

999 999 999
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

999

Cannot be 
operated

Can be 
operated

DisplayedNot 
displayed

Parts that are not displayed on the screen cannot be operated regardless of the input security group.
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If the password screen is opened and the user switches to User4 in GroupB, only the displayed parts for GroupB can 
be operated. The GroupA parts are not displayed.

MICRO/I MICRO/I MICRO/I

User4

With User4, GroupA parts are 
hidden, displayed GroupB parts 
can be operated

With no user, GroupA parts 
are hidden, GroupB parts 
cannot be operated

Open the password screen with the Goto 
Screen Button, enter the password, and 
switch to User4

999 999 999
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

999

Can be 
operated

Not 
displayed

Cannot be 
operated

Not 
displayed

GroupA is not configured for User4, so the button in the lower right of the screen is not displayed. Parts that 
are not displayed on the screen cannot be operated, even by the user configured with the input security 
group.
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This section describes the configuration procedure for the Security function.

2.1 Creating and Editing User Accounts

● Creating a User Account

1 On the Configuration tab, in the Protect group, click User Accounts.

The Security dialog box is displayed.

2 Select the Use Security functions check box.

The settings related to user accounts are displayed.
The user account already provided with WindO/I-NV4 is as follows.

3 Click Add.
The New User Account dialog box is displayed.

2 Security Function Configuration Procedure

No.: 1
User Name: User
Password: (blank)
Security Group: Administrator, Operator, Reader
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4 Specify the user number (1 to 15) in Number
This number is used when switching the user account via the value of device address.

5 Enter the name for the new user in User Name.
The maximum number for the user name is 8 characters. Only alphanumeric characters and symbols can be used.

6 Enter the password in New Password.
The number for the password is 4 to 15. Only uppercase alphabetic characters and numbers can be used.

7 Enter the password in Confirm Password that was entered in step 6.

8 Click the Group Membership tab.
Assign the security groups to the user being created.
Administrator, Operator, and Reader have already been provided in Security Group. These three security 
groups cannot be used in multiple user accounts. To use them with the user account being created, delete the 
security group from the user account they are assigned to beforehand.

If you will not add a new security group, proceed to step 12.

If you will not assign a security group, proceed to step 13.

You cannot use the following characters in the user name.
   \ / : * ? “ < > |

Write down the password so you do not forget it and save that note in a safe place. 

To display the content of the password for New Password and Confirm Password, select the Show 
Passwords check box in the Security dialog box.

User3User2User1

Administrator AdministratorOperator

Reader
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9 Click Add.
The New Security Group dialog box is displayed.

10 Enter the name of the new group in New Group and click << Add.
The maximum number for the group name is 15 characters.
The created group name is added to Security Group. Repeat this procedure to create multiple security groups.

11 Click OK.
The group added is displayed in Security Group.

12 Select the security groups in Security Group on the New User Account dialog box to assign to the user being 
created, and then click << Copy.

The security groups are copied to To.
The security groups that you create can be used in multiple user accounts.

To delete the security groups assigned to the user, select the security groups to delete in To, and then click Delete.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.

User3 User4User2User1

Created security 
groups (12 max)

GroupA

GroupB

GroupC

GroupC

GroupB GroupB GroupC

Multiple user accounts can use the same security groups

• To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.
• Select the security groups in Security Group and click Delete to delete the security groups. However, 

security groups configured for user accounts, screens, and parts cannot be deleted.
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13 Click OK.

If you will not continue creating a user account, proceed to step 15.

14 Repeat steps 3 to 13 and create all of the necessary user accounts.

15 Click OK.

The Security dialog box closes.
This concludes creating a user account.

You can configure a user account to be enabled when the MICRO/I power is turned on and when switching 
the operation mode in Default User.



WindO/I-NV4 User’s Manual 21-15

2 Security Function Configuration Procedure

21

U
ser Accounts and the Security 

● Editing a User Account

1 On the Configuration tab, in the Protect group, click User Accounts.

The Security dialog box is displayed.

2 Select the user account to edit and click Edit.

The Change User Account dialog box is displayed.

3 On the General tab, change User Name and New Password.

4 Enter the password in Confirm Password that was entered in step 3.

To display the content of the password for New Password and Confirm Password, select the Show 
Passwords check box in the Security dialog box.
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5 Click the Group Membership tab.

Change the security groups assigned to the user.

If you will not assign a security group or you will not delete a security group, proceed to step 7.

6 Select the security groups in Security Group to assign to the user being edited and click << Copy.

The security groups are copied to To.

If you will not delete a security group, proceed to step 8.

7 Select the security groups assigned to the user to delete in To and click Delete.

The security groups are deleted from To.

To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.

• To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.
• Select the security groups in Security Group and click Delete to delete the security groups. However, 

security groups configured for user accounts, screens, and parts cannot be deleted.
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8 Click OK.

9 Click OK to close the Security dialog box.

This concludes editing a user account.

● Deleting a User Account

1 On the Configuration tab, in the Protect group, click User Accounts.

The Security dialog box is displayed.

2 Select the user account to delete and click Remove.

The user account is deleted.

3 Click OK.

The Security dialog box closes.
This concludes deleting a user account.
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2.2 Adding and Editing Security Groups

● Adding a Security Group

1 On the Project window, double click Security Group Settings.

The Security Group Settings dialog box is displayed.

2 Enter the name of the new group in New Group and click << Add.

The maximum number for the group name is 15 characters.
The created group name is added to Security Group. Repeat this procedure to create multiple security groups.

3 Click OK.

The Security Group Settings dialog box closes.
This concludes adding a security group.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.



WindO/I-NV4 User’s Manual 21-19

2 Security Function Configuration Procedure

21

U
ser Accounts and the Security 

● Changing the Name of a Security Group

1 On the Project window, double click Security Group Settings.

The Security Group Settings dialog box is displayed.

2 Select the security group in Security Group to change the name of and click Rename.

The Change Security Group Name dialog box is displayed.

3 Change the name of the security group to the new group name in New Name.

The maximum number for the group name is 15 characters.

4 Click OK.

The Change Security Group Name dialog box closes.

5 Click OK.

The Security Group Settings dialog box closes.
This concludes changing the name of a security group.

The group name for Administrator, Operator, and Reader cannot be changed.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.
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● Deleting a Security Group

1 On the Project window, double click Security Group Settings.

The Security Group Settings dialog box is displayed.

2 Select the security group in Security Group to delete and click Delete.

The security group is deleted.

3 Click OK.

The Security Group Settings dialog box closes.
This concludes deleting a security group.

To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.

• Security groups configured for user accounts, screens, and parts cannot be deleted.
• Administrator, Operator, and Reader cannot be deleted.
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2.3 Protecting the Display and Operation of Screens and Parts

● Protecting the Display of Screens
Here you will configure the security group for a screen to protect the display of that screen.
This section describes an example where the display of base screen 2 is protected when switching to base screen 2 by 
pressing the Goto Screen Button.

Configuration Procedure

1 Following the procedure in “Creating a User Account” on page 21-11, create the following user account.

To automatically display the Password screen when the user attempts to switch to a base screen they cannot access 
with the current user account using the Goto Screen Button, in the Security dialog box, in the Options tab, select 
the Require a password automatically check box. For displaying the Password screen, refer to “4.1 Entering the 
Password on the MICRO/I” on page 21-39.

User2

Goto Screen Button
(Switch to base screen 2) Full

Tank 1
Base screen 1 Base screen 2

No user

MICRO/IMICRO/I

Base screen 2
Can be displayed

Base screen 2
Cannot be 
displayed

To change the user account, a button or command is required to open the Password screen.

User Name

Security Group GroupA
User2
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2 Place a Goto Screen Button on base screen 1.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

3 Click a point on the edit screen where you wish to place the Goto Screen Button.

4 Double-click the dropped Goto Screen Button and the Properties dialog box is displayed.

5 Select Switch to Base Screen for Action Mode.

6 Specify the screen number of the base screen to switch to with Screen Number under Goto Screen.

2 is specified here.

7 Click OK.

Close the Properties of Goto Screen Button dialog box.
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8 Create the base screen to switch to and configure the security group.
On the Home tab, in the Screens group, click the arrow under New, and then click Base Screen.
The Screen Properties dialog box is displayed.

9 Specify the screen number of the base screen to switch to with Number on the General tab.
This is the same screen number as the screen number specified in step 6. 2 is specified here.

10 Click the Options tab.

11 With Security Group, select the security group to allow the display of the base screen.
GroupA is selected here.

12 Configure the settings on each tab as necessary and click OK.
The Screen Properties dialog box closes.
This concludes configuring the project to protect the display of screens.
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Operating Procedure

This section describes an example when the current user account has no default user.

1 Press the Goto Screen Button configured with Switch to Base Screen.

The Password screen is displayed.

2 Press Down and select User2.

3 Enter the password and press ENT.

If the correct password is entered, the user account changes to User2 and the Password screen closes.
Base screen 2 is displayed.

Press the Goto Screen Button
Base screen 1

No user

MICRO/I

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

1
2

User2

Full

Tank 1
Base screen 2

MICRO/I
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● Protecting the Display of Parts
Here you will configure the security group for a part to protect the display of that part.
This section describes an example where the display of the Line Chart is protected.

Configuration Procedure

1 Following the procedure in “Creating a User Account” on page 21-11, create the following user account.

2 Create a Line Chart and configure the display security group.
On the Home tab, in the Parts group, click Charts, and then click Line Chart.

3 Click a point on the edit screen where you wish to place the Line Chart.

4 Double-click the dropped Line Chart and the Properties dialog box is displayed.

Goto Screen Button
(Open password screen)

User2
No user

MICRO/IMICRO/I

Line Chart
Can be displayed

Line Chart
Cannot 

be displayed

To change the user account, a button or command is required to open the Password screen.

User Name

Security Group GroupA

User2
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5 Click Advanced.

The Options tab is displayed.

6 Click the Options tab.

7 Select the security group to allow the display of the Line Chart with Display under Security Group.

GroupA is selected here.

8 Configure the settings on each tab as necessary and click OK.

The Properties of Line Chart dialog box closes.
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9 Place a Goto Screen Button to display the password screen on the base screen.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

10 Click a point on the edit screen where you wish to place the Goto Screen Button.
11 Double-click the dropped Goto Screen Button and the Properties dialog box is displayed.

12 Select Open Password Screen for Action Mode.

13 Specify the display location in coordinates for the password screen to open above the base screen with Coordinates 
X, Y.
With the upper-left corner of the screen as the origin, the upper-left corner of the window is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)
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14 Click OK.
The Properties of Goto Screen Button dialog box closes.
This concludes configuring the project to protect the display of a part.

Operating Procedure

This section describes an example when the current user account has no default user.

1 Press the Goto Screen Button configured with Open Password Screen.

The Password screen is displayed.

2 Press Down and select User2.

3 Enter the password and press ENT.

If the correct password is entered, the user account changes to User2 from no default user and the Password screen 
closes.
The Line Chart is displayed.

Press the Goto Screen Button

No user

MICRO/I

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

1
2

User2

MICRO/I
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● Protecting the Operation of Parts
Here you will configure the security group for a part to protect the operation of that part.
This section describes an example where the operation of the Numerical Input is protected.

Configuration Procedure

1 Following the procedure in “Creating a User Account” on page 21-11, create the following user account.

2 Create a Numerical Input and configure the input security group.
On the Home tab, in the Parts group, click Data Displays, and then click Numerical Input.

3 Click a point on the edit screen where you wish to place the Numerical Input.

4 Double-click the dropped Numerical Input and the Properties dialog box is displayed.

Goto Screen Button
(Open password screen)

User2
No user

999999 999

MICRO/IMICRO/I

Numerical Input
Can be operated

Numerical Input
Cannot be 
operated

The keypad is not displayed, 
nothing can be operated

To change the user account, a button or command is required to open the Password screen.

User Name

Security Group GroupA
User2



2 Security Function Configuration Procedure

21-30 WindO/I-NV4 User’s Manual

5 Click Advanced.

The Options tab is displayed.

6 Click the Options tab.

7 Select the security group to allow the operation of the Numerical Input with Input under Security Group.

GroupA is selected here.

8 Configure the settings on each tab as necessary and click OK.

The Properties of Numerical Input dialog box closes.

9 Place a Goto Screen Button to display the password screen on the base screen.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

10 Click a point on the edit screen where you wish to place the Goto Screen Button.
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11 Double-click the dropped Goto Screen Button and the Properties dialog box is displayed.

12 Select Open Password Screen for Action Mode.

13 Specify the display location in coordinates for the password screen to open above the base screen with Coordinates 
X, Y.

With the upper-left corner of the screen as the origin, the upper-left corner of the window is the X and Y coordinates.

14 Click OK.

The Properties of Goto Screen Button dialog box closes.
This concludes configuring the project to protect the operation of a part.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)
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Operating Procedure

This section describes an example when the current user account has no default user.

1 Press the Goto Screen Button configured with Open Password Screen.
The Password screen is displayed.

2 Press Down and select User2.

3 Enter the password and press ENT.

If the correct password is entered, the user account changes to User2 from no default user and the Password screen 
closes.
The Numerical Input can be operated.

Press the Goto Screen Button

No user

999

MICRO/I

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

1
2

User2

999999

MICRO/I



WindO/I-NV4 User’s Manual 21-33

3 Security Dialog Box

21

U
ser Accounts and the Security 

  

This section describes items and buttons on the Security dialog box.

3.1 Security Dialog Box

The passwords and security groups assigned to user accounts are collectively managed in the Security dialog box.

● General Tab

■ Use Security functions
Select this check box to protect access to data and to protect MICRO/I displays and operations by accounts. The 
settings related to user accounts are displayed.

When this check box is cleared, the switching to the System Mode, monitor display, or downloading or uploading data 
are protected by a single password. Note, the MICRO/I is not password protected if Password is left blank.

3 Security Dialog Box

User Name: Enter the name for the user account.
The maximum number for the user name is 8 characters. Only alphanumeric characters and 
symbols can be used.

You cannot use the following characters in the user name.
   \ / : * ? “ < > |

Password: Enter the password.
The number of characters for the password is 4 to 15. Only uppercase alphabetic characters 
and numbers can be used.

Write down the password so you do not forget it and save that note in a safe place.

Confirm Password: Re-enter the same password.
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■ Users for this project

■ Add
This button adds a user account. You can create a maximum of 15. Click this button to display the New User 
Account dialog box. In the New User Account dialog box, the user name, password, and security groups are 
assigned to the user account. For details, refer to “New User Account Dialog Box and Change User Account Dialog 
Box” on page 21-35.

■ Edit
Select a number in Users for this project and click this button to display the Change User Account dialog box. In 
the Change User Account dialog box, the user name, password, and security groups are changed. For details, refer 
to “New User Account Dialog Box and Change User Account Dialog Box” on page 21-35.

■ Remove
This button deletes the user account with the selected number. Select a number and click this button.

■ Default User
Select the user account to be enabled when the MICRO/I power is turned on and when switching the operation mode.
If None is selected, no user account is selected when the MICRO/I power is turned on and when the operation mode 
is changed. Screens and parts cannot be displayed or operated that are protected by a security group.

■ Show Passwords
Select this check box to display the characters of the password entered in Password under Users for this project. 
When this check box is cleared, the passwords are displayed with * (asterisk).

No.: Displays the number (1 to 15) used when switching the user account via the value of device 
address. Double clicking the cell displays the Change User Account dialog box. For details, 
refer to “New User Account Dialog Box and Change User Account Dialog Box” on page 21-35.

User Name: Displays the name for the user account. Double clicking the cell displays the Change User 
Account dialog box. For details, refer to “New User Account Dialog Box and Change User 
Account Dialog Box” on page 21-35.

Password: Displays the password for the user account with asterisk(*). Double clicking the cell displays 
the Change User Account dialog box. For details, refer to “New User Account Dialog Box and 
Change User Account Dialog Box” on page 21-35.
To display the password characters, select the Show Passwords check box.

Security Group: Displays all of the security groups for user accounts. Double clicking the cell displays the 
Change User Account dialog box. For details, refer to “New User Account Dialog Box and 
Change User Account Dialog Box” on page 21-35.
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New User Account Dialog Box and Change User Account Dialog Box

In the New User Account dialog box, the user name, password, and security groups are assigned to an account and 
that user account is added.
In the Change User Account dialog box, the user name, password, and security groups for the selected user 
account are changed.

General Tab

■ Number
In the New User Account dialog box, this setting specifies the number (1 to 15) when switching the account via the 
value of device address.
When Edit was clicked and the Change User Account dialog box was displayed, this item displays the selected user 
account number.

■ User Name
Enter the name for the user account.
The maximum number is 8 characters. Only alphanumeric characters and symbols can be used.

■ New Password
Enter the password.
The number of characters for the password is 4 to 15. Only uppercase alphabetic characters and numbers can be 
used.

■ Confirm Password
Re-enter the same password.

You cannot use the following characters in the user name.
   \ / : * ? “ < > |

Write down the password so you do not forget it and save that note in a safe place.

To display the content of the password for New Password and Confirm Password, select the Show 
Passwords check box in the Security dialog box.
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Group Membership Tab

■ To: (user name being configured)
Displays the user name and the list of security groups assigned to the user.

■ << Copy
This button assigns the security groups to the user displayed in To.
Select the security groups in Security Group and click this button to add them to To.

■ Delete
This button deletes the security groups assigned to the user.
Select the security groups in To and click this button.

■ Security Group
This item displays a list of all the security groups. The provided security groups (Administrator, Operator, and Reader) 
are grayed out if assigned to another user account.

■ Add
This button adds a security group. You can create a maximum of 12.
Click this button to display the New Security Group dialog box. New security groups are added in the New 
Security Group dialog box. For details, refer to “Adding a Security Group” on page 21-18.

■ Rename
Select a security group in Security Group and click this button to display the Change Security Group Name 
dialog box. Change the name of the security group in the Change Security Group Name dialog box. For details, 
refer to “Changing the Name of a Security Group” on page 21-19.
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● Options Tab

■ Use Password to open a Project
Select this check box and enter a password to protect the project with a dedicated password when opening it.
The number for the password is 4 to 15 characters. Only uppercase alphabetic characters and numbers can be used.
The operations subject to password protection are as follows.
• Opening projects
• Reusing screens
• Opening projects after uploading project data

■ Change User by Device Address
Select this check box to switch the user account according to the value of device address.
The user account is specified by using the number on the General tab.

Example: When the trigger device address is D0 and the default user is selected as User1

The user account switches according to the value of device address.

Confirm Password: Re-enter the password that was entered in Use Password to open Project.

Write down the password so you do not forget it and save that note in a safe place.

(Trigger Device Address): Specifies the word device to write the number.

Click to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-64.

1 2 3No.

User Name User3User2User1
(Default user)

0

User account

Trigger device address 
D0 value

Switch to default 
user account

1

Switch to user 
account no. 1

2

Switch to user 
account no. 2

3

Switch to user 
account no. 3

4

NoneAction

User3 User3User2User1 User1

The user account is not switched when the value of 

device address is a number not configured to a user 

account or an invalid number.

If the value of device address is 

0, the user is switched to the 

default user.
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■ Back to Default User
Select this check box to automatically switch to the default user when the MICRO/I is unused for an extended period 
of time.

■ Check the Status of Password Entry
Select this check box to check the entry status of the password on the Password screen. 

The following bits change to 1 depending on the password input status. These bits become 0 when the Password 
screen opens or when a button other than ENT or CAN is pressed on the Password screen.

■ Require a password automatically
Select this check box to automatically display the Password screen when the user attempts to switch to a base screen 
that cannot be accessed with the current user account by using a Goto Screen Button or Goto Screen Command 
configured with Switch to Base Screen for the Action Mode in the Properties dialog box.

After: Specify the time (0 to 60 minutes) to switch to the default user after the MICRO/I is last used.
If 0 is set, the MICRO/I switches back to the default user immediately, even if the user account was 
changed.

(Destination Device Address): Specifies a word device to write the password entry status.

Click to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-64.

Bit position Function Parameters

0
This bit stores the information when the correct password was 
entered on the Password screen and ENT was pressed.

0: Password being entered
1: Correct password entered

1
This bit stores the information when an incorrect password was 
entered on the Password screen and ENT was pressed.

0: Password being entered
1: Incorrect password entered

2
This bit stores the information when CAN was pressed on the 
Password screen.

0: Password being entered
1: Password entry canceled

3 to 7 Reserved -
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When a password is configured for a user account, the user is prompted to enter their password with the following 
operations.
• Accessing password protected data
• Executing password protected displays and operations

4.1 Entering the Password on the MICRO/I

To execute password protected operations, the user must open the Password screen and switch the user account.
The Password screen is opened with a Goto Screen Button or Goto Screen Command configured with Password 
Screen. The Password screen is also automatically displayed on the MICRO/I when the following operations are 
executed.
• Switching to a base screen for a security group that cannot be displayed by the current user account with the Goto 

Screen Button, Multi-Button, Goto Screen Command, or Multi-Command when the Require a password 
automatically check box is selected on the Options tab in the Security dialog box

• Switching to the System Mode or displaying the Device Monitor with the Maintenance screen, Goto Screen Button, 
Multi-Button, Goto Screen Command, or Multi-Command

• Downloading or uploading project data or PLC programs with a Key Button, Multi-Button, or Multi-Command
• Executing the USB Autorun function

4 Password Input

• Operations where the Password screen is not displayed are as follows.
- Switching the base screen using the System Area
- Displaying the alarm screen for the alarm log
- Opening the keypad with the Numerical Input or Character Input
- Opening the Reference Screen with the Alarm Log Display
- For screens that are already open when the user account was switched by opening the Password 

screen with the Goto Screen Button or Goto Screen Command
• When the user account is switched, the displayed base screen is reset. Popup screens and internal 

devices have the same behavior as when the base screen is switched. However, if the Close while 
changing Base Screen check box is selected on the Options tab in the Properties dialog box for the 
popup screen, the popup screen is closed when the base screen is switched. The behavior of the internal 
devices varies based on the internal devices. For details, refer to Chapter 28 “Internal Devices” on page 
28-1.
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● Password Screen Configuration

■ User Name
Displays the selected user name.

■ , 
Switches the user name.

■ Password
The entered password is displayed as “*”.

■ A to Z, 0 to 9
Enters A to Z, 0 to 9 in Password.

■ CAN
Clears the entered password and cancels input. The Password screen closes.

■ CLR
Clears the entered password and continues input.

■ ENT
Confirms the entered password and starts verifying the user name and password.
If the entered password is correct, the Password screen closes and the operation executes.
If the entered password was incorrect, the password entered on the Password screen is deleted and the screen 
returns to input mode.

CAN

User

A B C D E F

G H I J K L

CLR

M N O P Q R

S T U V W X

ENT

Y Z 0 1 2 3

4 5 6 7 8 9

Password

User Name Password
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4.2 Entering the Password in WindO/I-NV4

When a user account assigned with Administrator is configured with a password, or when a dedicated password for 
opening the project has been set, the Enter Password dialog box is displayed in WindO/I-NV4 as required and the 
user is prompted to enter their password.
The operations that display the Enter Password dialog box are as follows.
• Opening projects
• Reusing screens

• Downloading a project data

• Downloading data to an external memory device*1

• Downloading data to an external memory device*1 while the MICRO/I is running

• Uploading a project data

• Uploading data from an external memory device*1

• Deleting all data

• Deleting data in external memory device*1

• Formatting external memory device*1

● Enter Password Dialog Box

■ User Name
Selects the user name. This item can only be selected when multiple user accounts are registered.

■ Password
Enter the password. The entered password is displayed as “*”.

*1 External memory device inserted into the MICRO/I

If Administrator or Other Operation password is 
required, the following dialog box appears.

If dedicated password for opening project is required, 
the following dialog box appears.
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This chapter describes in detail on how to setup the online function and the operation of the MICRO/I.

  

1.1 How the Online Function is Used

The online function enables communication with the MICRO/I in WindO/I-NV4. This communication between 
WindO/I-NV4 and the MICRO/I, implemented using an exclusive protocol called maintenance communication.
The online function enables the following.

•  Write a project data into the MICRO/I.

• Write files to an external memory device inserted in the MICRO/I.

Chapter 22 Online Function

1 Communicating with the MICRO/I

Computer

Download

MICRO/I

Project data

When project data is downloaded using the online function, the Alarm Log data, Data Log data, and 
Operation Log data in the data storage area are deleted. All internal devices except for the HMI Keep 
Register (LKR) and HMI Keep Relay (LK) are cleared.

• The following functions can be executed with downloading of project data.
- Download additional fonts.
- Download the runtime system.
- Download recipe files and picture files to the External Memory Device folder in the external memory 

device inserted into the MICRO/I.
- Clear the HMI Keep Register (LKR) and HMI Keep Relay (LK) after download.
- Start running the control functions after download.

• For details on writing project data to an external memory device inserted in the computer, refer to 
Chapter 27 “Downloading” on page 27-9.

Computer
MICRO/I

Download

Recipe file

Picture file

USB flash drive

External memory device
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• Read the project data downloaded to the MICRO/I and then save it to a computer.

• Delete the data stored in the internal memory or the external memory device inserted in the MICRO/I and format 
the external memory device inserted in the MICRO/I.

• Display the information about the runtime system and project data of the MICRO/I.

Computer

Upload

MICRO/I

Project data

• It is possible to upload recipe files and picture files from the External Memory Device folder in the 
external memory device inserted in the MICRO/I, together with uploading of project data.

• For details on reading project data saved on an external memory device using WindO/I-NV4, refer to 
Chapter 27 “Uploading” on page 27-11.

MICRO/I

Computer
Deleting data

Deleting data
Formatting

External memory device

USB flash drive

Computer MICRO/I

System 
Information
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• Edit a project data in WindO/I-NV4 while checking MICRO/I operation by displaying and changing values of device 
addresses and switching screens using the monitor function.

Computer External device

Screen monitor

LDR1= 0 130

MICRO/I

130

Computer

Switches to Base Screen 2.

MICRO/I

Full
Tank 1

130

External device

External device

Base Screen 1

Base Screen 2

For details about monitor function, refer to Chapter 23 “1 Monitoring with WindO/I-NV4” on page 23-1.
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1.2 Connect MICRO/I to a Computer

Connection type varies based on the interface between the MICRO/I and computer.

● USB cable connection
The computer must be running Windows XP/Vista (32-bit edition only), or Windows 7/8 (64-bit and 32-bit versions), 
and must have a USB 1.1/2.0 port.

● Ethernet cable connection
The computer must be equipped with an Ethernet port.

MICRO/IComputer

USB cableA plug Mini-B plug

To USB port To USB interface

A USB driver must be installed when connecting the MICRO/I to a computer with a USB cable. 
Install the USB driver when making the connection for the first time. For details, refer to Appendix “6.1 
Installing the USB driver” on page A-10.
The USB driver does not have to be installed for subsequent connections. Note, the connection must use the 
same USB port that was connected to when installing the USB driver. The computer will not recognize the 
MICRO/I immediately if the USB cable is connected to a different USB port.

• Multiple MICRO/I connections using different USB ports on the same computer are not supported.
• The computer cannot be connected to the MICRO/I via a USB hub.

Computer

Ethernet cable

To Ethernet port To Ethernet interface

MICRO/I

It is necessary to configure the MICRO/I according to the local network that is used.
On the Communication Interface tab in the Project Settings dialog box, specify the IP address, subnet 
mask, and default gateway, and clear the Forbid Maintenance Communication check box. For details, 
refer to Chapter 4 “3.2 Communication Interface Tab” on page 4-21.
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1.3 Change Communication Settings

To communicate with the MICRO/I in WindO/I-NV4, configure the settings such as communication speed and port 
used to match the connection method for the MICRO/I.

1 On the Home tab, in the Project group, click Comm.Setup.

The Communication Settings dialog box is displayed.

2 Change the settings on each tab as necessary and then click OK.

■ Communicate with
Select the device to communicate with from the following items.

■ Port
Select the communication port on the computer from the following items.

■ Time Out (min)
Specify the time to wait for a response from the MICRO/I (0 minute to 20 minutes).

MICRO/I: Communicate with the MICRO/I connected to the computer.
For details, refer to “Using the online function for Ethernet communication” on page 22-6.

External Memory Device: Read or write data to the external memory device inserted in the computer.
For details, refer to Chapter 27 “1.5 Reading/Writing Data” on page 27-3.

MICRO/IComputer

USB cable

Ethernet cable

USB: Connect the USB port on the computer to the USB interface on the MICRO/I.

Ethernet: Connect the Ethernet port on the computer to the Ethernet interface on the MICRO/I.

• The port number is 2537 when connecting from WindO/I-NV4 to the MICRO/I via Ethernet.
• The default network settings configured on the MICRO/I are as follows.

IP Address: 192.168.0.1
Subnet Mask: 255.255.255.0
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● Using the online function for Ethernet communication
Select Ethernet under Port on the Target IP Address dialog box.

To download project data

Click Download in the Download dialog box to display the Target IP Address dialog box. 
Specify the Ethernet settings (IP address, subnet mask, and default gateway) for the MICRO/I.
Select the MICRO/I IP addresses and you can batch download project data to multiple MICRO/I.
It is also possible to change the Ethernet settings (IP address, subnet mask, and default gateway) for the MICRO/I to 
which you are downloading after project data is downloaded.

■ Target List

■ Add
Adds a download destination for project data to the Target List. Click this button to open the Target IP Address 
dialog box. Using the Target IP Address dialog box, specify the Ethernet settings for the MICRO/I to which you are 
downloading.

■ Edit
Changes the settings of the Target List.
Select a download destination from the Target List, and then click this button to open the Target IP Address dialog 
box. Using the Target IP Address dialog box, change the Ethernet settings for the MICRO/I to which you are 
downloading.

■ Delete
Deletes download destinations from the Target List.

It is necessary to configure the MICRO/I according to the local network that is used.
On the Communication Interface tab in the Project Settings dialog box, specify the IP address, subnet 
mask, and default gateway, and clear the Forbid Maintenance Communication check box. For details, 
refer to Chapter 4 “3.2 Communication Interface Tab” on page 4-21.

Download to: Shows the current IP address for the MICRO/I to download the project data to.

Set IP Address: Shows the IP address for the MICRO/I after downloading the project data.

Set Subnet Mask: Shows the subnet mask for the MICRO/I after downloading the project data.

Set Default Gateway: Shows the default gateway for the MICRO/I after downloading the project data.

Even if the Ethernet settings of the MICRO/I are changed by using the Target IP Address dialog box when 
downloading a project, the Ethernet settings in the editing project data are not changed.
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Target IP Address dialog box
Specifies the IP address of the MICRO/I used for communication.

■ Target IP Address
Specify the IP address for the target MICRO/I to execute this function.

Click  to open IP Address Manager. Specify the IP address for the target MICRO/I with IP Address Manager.

■ Change the network settings after downloading the project data
Select this check box to change the Ethernet settings of the MICRO/I to which you are downloading after project data 
is downloaded.

To execute any function except project data download

The Target IP Address dialog box will be displayed when any of the following functions are executed.
• Upload a project data.
• Upload data from an external memory device inserted in the MICRO/I.
• Delete data stored in the internal memory.
• Delete data from or formatting an external memory device inserted in the MICRO/I.
• Display information about runtime system and project data.
• Monitor the MICRO/I.
Specifies the IP address of the MICRO/I used for communication.

■ Target IP Address
Specify the IP address for the target MICRO/I to execute this function.

Click  to display IP Address Manager. Specify the IP address for the target MICRO/I with IP Address Manager.

IP Address: Enter the IP address to register in the project data. Click  to open IP Address Manager. 
Specify the IP address for the target MICRO/I with IP Address Manager.

Subnet Mask: Enter the subnet mask to register in the project data.

Default Gateway: Enter the default gateway to register in the project data.
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● IP Address Manager
You can register target Ethernet settings for performing online function via Ethernet communication to the project 
data.

■ IP Address List
Ethernet settings registered in the project data are displayed in this list.

■ IP Address
Enter the IP address to register in the project data.

■ Subnet Mask
Enter the subnet mask to register in the project data.

■ Default Gateway
Enter the default gateway to register in the project data.

■ Comment
Enter comment to register in the project data.

■ Add New
Adds IP Address, Subnet Mask, Default Gateway, and Comment to the list.

■ Delete
Deletes the selected IP address from the list.

■ Select
Closes IP Address Manager, and apply the Ethernet settings selected from the list.

IP Address: Displays the IP address.

Subnet Mask: Displays the subnet mask.

Default Gateway: Displays the default gateway.

Comment: Displays comment.
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2.1 Downloading Project Data to the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.
In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 22-5.

2 Open a project to download.

3 On the Home tab, in the Project group, click the Download icon.

The Download dialog box is displayed.

4 Select data for download under Download Data.

■ All
Download the entire project data.

■ Modified Data Only
Downloads files modified since the previous download.
If download fails, select All to download.

2 Downloading

To download a project without opening it, on the Home tab, in the Project group, click the Download 
icon. The Open dialog box is displayed. Select a file then click Open. The Download dialog box is displayed. 
Proceed to Step 4.

When project data is downloaded to the MICRO/I, the MICRO/I screen data is overwritten.

If the project data was changed, a confirmation message to save the project data is displayed.
• Click OK to save the project data and display the Download dialog box.
• Click Cancel to return to the editing screen without saving the project data.
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5 Click Download.

• When Communicate with is set to MICRO/I and Port to USB, the project data starts downloading.
• When Communicate with is set to MICRO/I and Port to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start the download. For details, refer to “To 
download project data” on page 22-6.

6 Click Yes.

The Download Project dialog box is displayed and the project file starts downloading.
When finished downloading, a completion message is displayed.

7 Click OK.

8 Click Close on the Download Project dialog box.

This concludes downloading project data.

If security is enabled in the MICRO/I project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.

• Do not turn off the MICRO/I while project data is downloading.
• Turn the power of the MICRO/I off and on and download the project data once again if the following 

conditions occur:
- The project data downloading failed, then WindO/I-NV4 cannot communicate with the MICRO/I.
- The cable was disconnected or the power was turned off while WindO/I-NV4 and the MICRO/I were 

communicating, and MICRO/I no longer responds
• If project data is repeatedly downloaded with Modified Data Only, the free space in the MICRO/I's 

internal memory will be used up and the download will fail. In this case, select All and attempt the 
download again.

For details on writing project data to an external memory device inserted in the computer, refer to Chapter 
27 “Downloading” on page 27-9.
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2.2 Download Dialog Box

This section describes items and buttons of the Download dialog box.

■ Communication Settings

■ Download Data
Selects data to be downloaded.

■ Download Runtime system
Select this check box to force download runtime system, irrespective of the runtime system version of the MICRO/I, 
when downloading project data. Normally this option should not be used.

■ Download the standard fonts and the optional fonts
Download standard fonts and optional fonts are selected on the Font Settings tab in the Project Settings dialog box 
to the MICRO/I when the project data is downloaded. For details, refer to Chapter 4 “3.12 Font Settings Tab” on page 
4-42.

■ Clear Keep Devices
Select this check box to clear the keep devices after the project data is downloaded. Note that when a project data 
with a changed data storage area setting is downloaded, the keep devices are always cleared.

■ Download Recipe Files to External Memory Device
Select this check box to create a RECIPE folder or recipe files in the External Memory Device folder on an external 
memory device inserted in the MICRO/I when downloading projects. Only on channels for which Save to in the 
Recipe Settings dialog box is set to External Memory Device, and Recipe Function is set to Use.
• When Download Data is set to All, recipe files are created for all channels for which recipe data is set.
• When Download Data is set to Modified Data Only, only recipe files on channels where recipe data has 

changed are created.

■ Download Picture Files to External Memory Device
Select this check box to create the PICTURE folder under the External Memory Device folder on the external memory 
device inserted in the MICRO/I and to save the picture files when downloading project. Out of the pictures registered 
in Picture Manager, the picture files that are saved are those picture files that have been selected with the check box 
on the picture list.

Communicate with: Available computer devices are displayed.

Port: Available communication ports on the computer are displayed.

Change: Changes communication settings. Click this button to display the Communication Settings dialog 
box. For details, refer to “1.3 Change Communication Settings” on page 22-5.

All: All project data is downloaded.

Modified Data Only: Only files that were updated since the previous download are downloaded.
If an upload fails, select All to download.
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■ Download
• When Communicate with is set to MICRO/I and Port to USB, the project data starts downloading.
• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start the download. For details, refer to “To 
download project data” on page 22-6.

• When Communicate with is set to External Memory Device, the Select Drive dialog box is displayed. Select 
the external memory device drive, then click OK to start the download. For details, refer to “2.3 Downloading Files 
to an External Memory Device Inserted in the MICRO/I” on page 22-13.

Do not turn off the MICRO/I while project data is downloading.

If project data downloading fails and communication is not possible, turn the MICRO/I off and on then 
download the data once again.
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2.3 Downloading Files to an External Memory Device Inserted in the MICRO/I

Specified files can be downloaded to an external memory device inserted in the MICRO/I. The files are downloaded to 
External Memory Device folder specified in the Project Settings dialog box for the current project.

1 Insert the external memory device into the MICRO/I.

2 Change communication settings according to the connection method between the computer and the MICRO/I.

In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 22-5.

3 On the Home tab, in the Project group, click the arrow under Download.

4 Select the method for downloading the file to the external memory device.

The Open dialog box is displayed.

■ Files to External Memory Device
Stops operation of the MICRO/I and downloads the file to the external memory device inserted in the MICRO/I. When 
the file download is complete, operation resumes.

■ Files to External Memory Device while running
Downloads the file to the external memory device inserted in the MICRO/I without stopping operation of the MICRO/I.

MICRO/IExternal memory device

USB flash drive

While editing project data, even if you click the arrow under Download in the Transfer group on the 
Online tab, the download menu will be displayed.
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5 Select the file, and then click Open.

• When Communicate with is set to MICRO/I and Port to USB, the project data starts downloading.
• When Communicate with is set to MICRO/I and Port to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start the download. For details, refer to “To 
execute any function except project data download” on page 22-7.

6 Click Yes.

The Download dialog box is displayed and the file starts downloading.
When finished downloading, a completion message is displayed.

7 Click OK.

If security is enabled in the MICRO/I project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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8 Click Close in the External Memory Device Maintenance dialog box.

To create a recipe file on an external memory device inserted in the computer, use Save Recipe Files in 
External Memory Device in the Recipe Settings dialog box. For details, refer to Chapter 18 “Creating 
Recipe Files in the Recipe Settings Dialog Box” on page 18-17.
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Project data in the MICRO/I or in an external memory device inserted in a computer can be read using WindO/I-NV2 
and saved to the computer.

3.1 Upload Project Data from the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.

In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 22-5.

2 On the Home tab, in the Project group, click the Upload icon.

• When Communicate with is set to MICRO/I and Port is set to USB, the Upload dialog box is displayed.
• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start the upload. For details, refer to “To 
execute any function except project data download” on page 22-7.

3 Uploading

While editing project data, project data can be uploaded from the MICRO/I even by clicking the Upload 
icon in the Transfer group on the Online tab.

If project data is being edited, project data will be closed. If the project data was changed, a confirmation 
message to save the project data is displayed.
• Click Yes to save the project data and display a dialog box corresponding to the communication settings.
• Click No to close the project data without saving changes and display a dialog box corresponding to the 

communication settings.
• Click Cancel to stop uploading and return to the editing screen without saving the project data.

If security is enabled in the MICRO/I project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.



WindO/I-NV4 User’s Manual 22-17

3 Uploading

22

O
nline Function

3 Check the project data details, and then click Upload.

If there is a project file with the same file name in the upload folder, an overwrite confirmation message is displayed.
• Click Yes to start uploading the project data.
• Click Cancel to stop uploading the project data.
When finished uploading, a completion message is displayed.

■ Project Name
The project file is saved with the currently displayed name. To change the project name, enter a new name for the 
file. The maximum number is 50 characters.

■ Location
The uploaded project file is saved to the currently displayed location. To change the location of the saved file, 

click . The Browse folders dialog box is displayed. Select a location, and then click OK.

4 Click OK.

5 Click Close on the Upload dialog box.

A confirmation message to open the project is displayed.

You cannot use the following characters in the project name.
   \ / : * ? " < > |
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6 Click OK.

The uploaded project opens.
This concludes uploading of project data.

If a password has been configured for the project data, the Enter Password screen will be displayed. 
The password to enter varies based on the check box setting of the Use Password to open a Project 
found under the Options tab in the Security dialog box.
When this check box is selected, enter the password for Use Password to open a Project.
When this check box is cleared, enter the password for the user account assigned to the Administrator 
security group.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.

For details on reading project data saved on an external memory device using WindO/I-NV4, refer to 
Chapter 27 “Uploading” on page 27-11.



WindO/I-NV4 User’s Manual 22-19

3 Uploading

22

O
nline Function

3.2 Upload Dialog Box

This section describes the settings and buttons of the Upload dialog box.

■ Project Name
The project file is saved with the currently displayed name. To change the project name, enter a new name for the 
file. The maximum number is 50 characters.

■ Type Number
Displays the type number selected in project data downloaded to the MICRO/I.

■ Modified
Displays the time that project data downloaded to the MICRO/I was last saved in WindO/I-NV4.

■ Location
Specifies the location for saving uploaded project files.

Click  to display the Browse folders dialog box. Select the location for saving, then click OK.

■ Upload files used in this project from the External Memory Device
To upload files located on an external memory device inserted in the MICRO/I that are used by the project together 
with project data, select the file to be uploaded from the following.
Recipe Files
Picture Files

■ Upload
Starts uploading of project data.

■ Cancel
Stops uploading of project data.

You cannot use the following characters in the project name.
   \ / : * ? " < > |
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Deletes data from the MICRO/I or from an external memory device inserted in the MICRO/I.

4.1 Clear Data from the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.
In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 22-5.

2 Open project data.

3 On the Online tab, in the MICRO/I group, click Clear, then click the data to be deleted.

■ All
Deletes project data, Alarm Log data, Data Log data, and Operation Log data. It also clears the values from all device 
addresses.

■ Alarm Log Data
Deletes the data collected by the Alarm Log function.

■ Data Log Data
Deletes the data collected by the Data Log function.

■ Operation Log Data
Deletes the data collected by the Operation Log function.

■ Values of All Device Addresses
Clears the values of all device addresses.

■ Stored Data in External Memory Device
After stopping operation, deletes data saved to the External Memory Device folder on an external memory device.
Click this to display the Clear Data dialog box. For details, refer to “4.2 Deleting Data from an External Memory Device 
Inserted in the MICRO/I” on page 22-22.

• When Communicate with is set to MICRO/I and Port to USB, deletion of the data starts.
• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start deletion of the data. For details, refer 
to “To execute any function except project data download” on page 22-7.

4 Clear

If security is enabled in the MICRO/I project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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4 Click Yes.

5 Click Close.

This concludes clearing data.



4 Clear

22-22 WindO/I-NV4 User’s Manual

4.2 Deleting Data from an External Memory Device Inserted in the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.

In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 22-5.

2 Open project data.

3 On the Online tab, in the MICRO/I group, click Clear, then click Stored Data in External Memory Device.

The Clear Data dialog box is displayed.

4 Select the check box for the data items to be deleted from the External Memory Device folder.

Screenshot, Alarm Log files, Data Log files, Operation Log files, and Recipe Files

5 Click OK.

• When Communicate with is set to MICRO/I and Port to USB, deletion of the data starts.
• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start deletion of the data. For details, refer 
to “To execute any function except project data download” on page 22-7.

If security is enabled in the MICRO/I project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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6 Click Yes.

7 Click Close.

This concludes clearing data on the external memory device.
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Stops operation of the MICRO/I and formats an external memory device inserted in the MICRO/I.

5.1 Formatting an External Memory Device Inserted in the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.

If communicating with a MICRO/I inserted in a computer, in the Communication Settings dialog box, select MICRO/I 
from Communicate with. For details, refer to “1.3 Change Communication Settings” on page 22-5.

2 Open project data.

3 On the Online tab, in the MICRO/I group, click Format.

• When Communicate with is set to MICRO/I and Port is set to USB, a formatting confirmation message is 
displayed.

• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 
displayed. Specify the IP address of the MICRO/I, and then click OK to display the formatting confirmation 
message. For details, refer to “To execute any function except project data download” on page 22-7.

4 Click Yes.

5 Click Close.

This concludes formatting the external memory device.

5 Formatting

If security is enabled in the MICRO/I project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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Displays information about the runtime system and downloaded project data of the MICRO/I.
This function can be used to show information about project data during editing and to simultaneously check details 
of project data downloaded to the MICRO/I.

6.1 Displaying System Information

1 Change communication settings according to the connection method between the computer and the MICRO/I.

If communicating with a MICRO/I inserted in a computer, in the Communication Settings dialog box, select MICRO/I 
from Communicate with. For details, refer to “1.3 Change Communication Settings” on page 22-5.

2 On the Home tab, in the Project group, click Target Info..

• When Communicate with is set to MICRO/I and Port is set to USB, the System Information dialog box is displayed.
• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to display the System Information dialog box. 
For details, refer to “To execute any function except project data download” on page 22-7.

3 Check information about the runtime system and project data.

6 System Information

While editing project data, information about runtime system and project data can be displayed even by 
clicking Target Info. in the MICRO/I group on the Online tab.

• To check the additional fonts installed on the MICRO/I, click Font Information. The Font Information 
dialog box is displayed. For details, refer to “Font Information Dialog Box” on page 22-28.

• To check information about the external memory device inserted in the MICRO/I, click External Memory 
Device Information. The External Memory Device Information dialog box is displayed. For details, refer 
to “External Memory Device Information Dialog Box” on page 22-28.

• To check the communication driver set for the project that is downloaded to the MICRO/I, click 
Communication Driver Information. The Communication Driver Information dialog box is displayed. 
For details, refer to “Communication Driver Information Dialog Box” on page 22-29.
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4 When you have finished checking the information, click OK.

5 Click Close.

This concludes checking system information.
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6.2 Target Information Dialog Box

This section describes the settings and buttons of the Target Information dialog box.

■ Target Runtime Information

■ Target Project Information

■ Opened Project Information

Type Number: Shows the type number of MICRO/I

Runtime Version: Shows the runtime system version of the MICRO/I.

Memory Space (byte): Shows the maximum amount of project data (bytes) that can be downloaded to the MICRO/I.

Font Information: Checks the additional fonts currently installed on the MICRO/I. Click this 
button to display the Font Information dialog box. For details, refer to “Font 
Information Dialog Box” on page 22-28.

External Memory Device Information: Checks the state of an external memory device inserted in the MICRO/I, its 
total capacity, available capacity, and used capacity. Click this button to display 
the External Memory Device Information dialog box. For details, refer to 
“External Memory Device Information Dialog Box” on page 22-28.

Project Name: Shows the project name of projects downloaded to the MICRO/I.

Modified: Displays the time that project data downloaded to the MICRO/I was last saved in 
WindO/I-NV4.

Project Version: Displays the version of WindO/I-NV4 used to create the project data downloaded to the 
MICRO/I.

Communication Driver Information: Checks the communication driver configured in the project downloaded to the 
MICRO/I.
Click this button to display the Target Communication Driver Information dialog 
box. For details, refer to “Communication Driver Information Dialog Box” on 
page 22-29.

Project Name: Shows the project name of the project being edited.

Modified: Displays the time that the project being edited was last saved in WindO/I-NV4.

Project Version: Displays the version of WindO/I-NV4 used to create the project being edited.

This function can be used to show information about a project that is being edited and simultaneously check 
information about project data downloaded to the MICRO/I.
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Font Information Dialog Box

This dialog box is used to check the state of installed additional fonts.

The installation status of each additional font is shown to the right of the font. The following additional fonts can be 
installed.
• Japanese Large Font (First standard)
• Japanese Large Font (Second standard)
• Chinese
• Taiwanese
• Korean
• European Large Font
• Central European
• Baltic
• Cyrillic

External Memory Device Information Dialog Box

Checks the state of an external memory device inserted in the MICRO/I, its total capacity, used capacity, and available 
capacity.

Status: Shows the state of the external memory device inserted in the MICRO/I.

Memory Capacity: Shows the total capacity of the external memory device inserted in the MICRO/I.

Used Space: Shows how much of the capacity of the external memory device inserted in the MICRO/I is 
currently in use.

Free Space: Shows how much of the capacity of the external memory device inserted in the MICRO/I is 
currently available for use.



WindO/I-NV4 User’s Manual 22-29

6 System Information

22

O
nline Function

Communication Driver Information Dialog Box

Checks the communication driver configured in the project downloaded to the MICRO/I.

■ External Device Communication 1 to 4

Manufacturer: Displays the manufacturer of the external device.

Communication Driver: Displays the communication driver.

Communicate Driver Version: Displays the communication driver version.
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This chapter describes the monitor function that checks operation of the created project data.
Monitor function enables the values of internal devices and the values of the external device addresses to be checked 
and changed. This can be done in two ways: using WindO/I-NV4 on a computer connected to the MICRO/I, or directly 
on the screen of the MICRO/I.

  

1.1 How the Monitor Function in WindO/I-NV4 is Used

Monitor function in WindO/I-NV4 can be performed as follows.

• Checking values of device addresses used on the screen of the MICRO/I

• Checking values of specified device addresses

• Checking values of device addresses of sequential address numbers

Chapter 23 Monitor Function

1 Monitoring with WindO/I-NV4

Computer
MICRO/I

130

External device

Screen Monitor
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Displays device addresses used in a screen.
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• Checking the state of external devices connected to the MICRO/I

• Displaying the value of device address in a popup

• Highlighting objects while satisfying conditions

Object List window Script Editor

Computer
MICRO/I

130

Disconnect

Connect
External device

External device

External Device Monitor

External Device ID: 0

External Device ID: 1

External Device ID: 0

External Device ID: 1

Popup 

Popup

Highlighted

Trigger Condition
  While satisfying the condition: LM0==1

LM0 = 0 1

Condition

Condition

Not satisfiedNot satisfiedNot satisfied

SatisfiedSatisfiedSatisfied



WindO/I-NV4 User’s Manual 23-3

1 Monitoring with WindO/I-NV4

23

M
onitor Function

• Switching to the screen of the MICRO/I

• Opening current screen

• Change values of device addresses and check the operation of project data offline

Computer
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Switches to Base Screen 2.

Full

Tank 1

External device

External device

Base Screen 1

Base Screen 2

130

Computer
MICRO/I
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Click

Computer
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100
150
200

Disconnect External device
Custom Monitor in the Offline mode
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200



1 Monitoring with WindO/I-NV4

23-4 WindO/I-NV4 User’s Manual

1.2 Debugging in WindO/I-NV4

This section describes the procedure for monitoring values of device addresses and debugging in WindO/I-NV4.

1 Change the communication setting to match the connection method between computer and MICRO/I.

For details, refer to Chapter 22 “1.3 Change Communication Settings” on page 22-5.

2 On the Online tab, in the Monitors group, click Start Monitor.

The MICRO/I switches to monitor mode and Monitor Mode is displayed at the bottom left of the screen.

3 On the Online tab, in the Monitors group, click the following button or enter the number to the text box to switch 
the screen displayed on the MICRO/I to the Monitor screen.

■  (Back)
You are returned to the Base Screen that was displayed immediately before the screen was switched.

■  (Forward)

Advances to the Base Screen that was displayed immediately before the screen was switched using  (Back).

■  (First Screen)
Switches to the Base Screen of the lowest screen number in the project data.

■  (Previous Screen)
Switches to the Base Screen of screen number one lower than the Base Screen currently displayed. If the screen 
numbers are not sequential, switches to the screen of next lowest number.

■  (Specified Screen)
Switches to the Base Screen with the specified number.

■  (Next Screen)
Switches to the screen with screen number one higher than the Base Screen currently displayed. If the screen 
numbers are not consecutive, switches to the screen of next highest number.

■  (Last Screen)
Switches to the Base Screen of highest screen number in the project data.

If a password has been configured for the project data, the Enter Password screen will be displayed. Enter 
the password. For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.

To change values of device addresses and check the operation of project data offline, first switch to monitor 
mode, and then on the Online tab, in the Monitors group, click Go Offline.
The MICRO/I switches to offline mode and Offline mode is displayed at the bottom left of the screen.
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4 On the Online tab, in the Monitors group, click Open Current Screens.

 The screen displayed on MICRO/I opens in the editing window.

5 On the Online tab, in the Monitors group, select the monitor being used.

When monitoring starts, the screen monitor is displayed.

■ Screens
Automatically checks device addresses used on the screen displayed on the MICRO/I. For details, refer to “Screen 
Monitor” on page 23-6.

■ Object List
Displays values of device addresses in a popup on the Object List window. It also highlights objects while satisfying 
conditions. For details, refer to “1.3 Display the Value of Device Address in Popup” on page 23-16, and “1.4 
Highlighting Objects While Satisfying Conditions” on page 23-16.

■ Custom
Registers monitored device addresses individually and displays the value of device addresses. For details, refer to 
“Custom Monitor” on page 23-7.

■ Batch
Registers monitored device address as a batch for sequential address numbers and displays the value of device 
addresses. For details, refer to “Batch Monitor” on page 23-14.

■ External Devices
Displays the state of external devices connected to the MICRO/I. For details, refer to “External Device Monitor” on 
page 23-15.

6 Check operation of project data by monitoring and changing values of device addresses, and edit project data if there 
is an error.

If the monitored screen is switches, repeat steps 3 through 4.

7 Download the edited project data to the MICRO/I.

8 On the Online tab, in the Monitors group, click Stop Monitor.

To reflect edits made during debugging, it is necessary to perform a download.

To switch from offline mode to monitor mode, on the Online tab, in the Monitors group, click Go Online.
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● Screen Monitor
Automatically displays device addresses used on the screen displayed on the MICRO/I. Enables values of device 
addresses to be monitored and changed.

■ Device Address
Displays the device addresses used on the screen displayed on the MICRO/I.

 next to Comment toggles between showing and hiding comments. When comments are displayed, click  to 
display a popup menu, then click Comment and select the check box.

■ Comment
Displays comments on device addresses saved in Tag Editor. Comments are displayed only after you click  next to 
Device Address to display a popup menu, then click Comment and select the check box. 

■ Value
Displays the current value of device address in decimal format. To change a value, double-click a cell and then specify 
a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  to display a popup menu, 
then click HEX and BIN and select the check box.

■ Hexadecimal, Binary
Displays the current value of device address in hexadecimal and binary format. To change a value, double-click a cell 
and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Comments are displayed only after you click  next to Value to display a popup menu and then select the HEX and 
BIN check box.

■ Data Type
Selects the data type of the selected value. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

When UBIN32(D), BCD8(EB), or Float32(F) that uses sequential address numbers (upper byte and 
lower byte) is selected for Data Type, if the address number of the maximum value is specified, one word 
is not sufficient, so "????????" is displayed in the monitor.



WindO/I-NV4 User’s Manual 23-7

1 Monitoring with WindO/I-NV4

23

M
onitor Function

● Custom Monitor
Enables the values of registered device addresses to be monitored and changed.

■ Add to List
Saves device addresses registered in Monitor to project data as a device address list. A saved lists can be monitored 
by selecting it from the List.
Click this button to display the Device Address List Name Setting dialog box. For details, refer to “Saving Registered 
Device Addresses to Project Data as a Device Address List” on page 23-10.

■ Device Address
Registers the device addresses to monitor individually.
Click this button to display the Tag Editor. For details, refer to “Registering the device addresses to monitor 
individually” on page 23-8.

■ Script
Batch saves all device addresses used in a script.
Click this button to display Script Manager. For details, refer to “Batch Saving Device Addresses Used in Scripts” on 
page 23-9.

■ Import
Imports the device addresses from a device address list saved as a CSV text file.
Click this button to display the Device Address List dialog box. For details, refer to “Importing Device Addresses from 
a Device Address List” on page 23-12.

■ Export
Saves the device addresses displayed in Monitor as a CSV text file. This file is called a Device Address List.
Click this button to display the Save As dialog box. For details, refer to “Saving a Device Address List as a CSV File” on 
page 23-11.
The saved device address list can be imported using Import.

■ Clear
Deletes all the device addresses displayed in Monitor.

■ List
Displays a device address list saved with the project data.
Select a list to clear the device addresses shown in Monitor and display the device addresses in the list.
Double-click a cell to display the Device Address List Name Setting dialog box. The name of the device address list can 
be edited.
Select a list and press DELETE to delete it from the List.
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■ Monitor
The registered device addresses are displayed in a list.
Select the device address list from the List to show the device addresses registered in the list.

Registering the device addresses to monitor

Registering the device addresses to monitor individually

Click Device Address. Or, double-click a cell under Device Address in Monitor, and then click .
The Tag Editor is displayed. For details on configuring device address settings, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

Device Address: The registered device addresses are displayed.

Double-click a cell to register or change a device address. Click  to display the Tag Editor. 
For details on how to configure device address settings, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-64.

 toggles between showing and hiding comments. When comments are displayed, click  to 
display a popup menu, then click Comment and select the check box.

Comment: Displays comments on device addresses saved in Tag Editor. Comments are displayed only 
after you click  next to Device Address to display a popup menu, then click Comment and 
select the check box.

Value: Displays the current value of device address in decimal format. To change a value, double-click 
a cell and then enter a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  to 
display a popup menu, then click HEX and BIN and select the check box.

Hexadecimal, Binary: Displays the current value of device address in hexadecimal and binary format. To change a 
value, double-click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Comments are displayed only after you click  next to Value to display a popup menu and 
then select the HEX and BIN check box.

Data Type Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

When UBIN32(D), BCD8(EB), or Float32(F) that uses sequential address numbers (upper byte and 
lower byte) is selected for Data Type, if the address number of the maximum value is specified, one word 
is not sufficient, so "????????" is displayed in the monitor.
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Batch Saving Device Addresses Used in Scripts

1 Click Script.

Script Manager is displayed.

2 Select the script ID of the script for the device address to be batch-saved, and then click Select.

All the device addresses used by the script are registered.
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Saving Registered Device Addresses to Project Data as a Device Address List

If registered device addresses are saved with project data as a list, then even when the project data is later reopened, 
the device addresses can be called from the List to be reutilized.

1 Click Add to List.

The Device Address List Name Setting dialog box is displayed.

2 Enter a name for the device address list.

The maximum number is 40 characters. Only alphanumeric characters and symbols can be used.

3 Click OK.

The device address list is added to the List.

4 Saving project data.

The following characters cannot be used for names of device address list.
 \ / : ; * ? " < > |

If a project file is closed without saving, device address lists will not be saved with the project data.
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Saving a Device Address List as a CSV File

To use a device address list (registered device addresses list) in another project, save it as a CSV text file. This file is 
called a Device Address List.

1 Click Export.

The Save As dialog box is displayed.

2 Select Save in, enter a File name, and then click Save.

This concludes saving device address list.
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Importing Device Addresses from a Device Address List

Imports the device addresses from a device address list saved as a CSV text file into custom monitor.

1 Click Import.

The Device Address List dialog box is displayed.

2 Click . 

The Open dialog box is displayed. 

3 Select a saved device address list, and then click Open.

The device addresses are listed.
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4 Click the device address to import.

5 Click OK.

If there is an already registered device address on the Custom Monitor, an overwrite confirmation message is 
displayed.
• Click Yes to overwrite the device address displayed in the confirmation message.
• Click Yes To All to overwrite all the device addresses.
• Click No to display the next confirmation message without overwriting the device address displayed in the 

confirmation message.
• Click Cancel to stop importing device addresses.

The device address is added to Monitor.

To select multiple items of text, press and hold SHIFT or CTRL while you click the specific items.
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● Batch Monitor
Displays sequential addresses as a batch.

■ Target
Select the device that includes the device address that will be set from MICRO/I or External Device (External 
Device ID): (External Device Name).
You can configure the External Device ID and the external device name in the Communications Driver Network 
tab on the Project Settings dialog box. For details, refer to Chapter 4 “3.4 Communication Driver Network Tab” on 
page 4-31.

■ Device Type
Selects the device type.
The list only shows device types that can be used.

■ Address Number
Specify the address. The range that can be set varies based on the device type selected.

■ Bit Number
Specify the bit (0 to 15) of the word device when a word device is selected in Device.

■ Length
Specifies the number of device addresses displayed in the list (Bit number of the word device specification: 1 to 16, 
Other than above: 1 to 1000).

■ Data Type
Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ (Monitor)
Automatically displays the selected device addresses, in the number specified under Length, from top to bottom, 
consecutively.

(Monitor)

Device Address: The specified device addresses are displayed.
Value: Displays the current value of device address in decimal format. To change a value, double-click 

a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  to 
display a popup menu, then click HEX and BIN and select the check box.

Hexadecimal, Binary: Displays the current value of device address in hexadecimal and binary format. To change a 
value, double-click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Comments are displayed only after you click  next to Value to display a popup menu and 
then select the HEX and BIN check box.

When UBIN32(D), BCD8(EB), or Float32(F) that uses sequential address numbers (upper byte and 
lower byte) is selected for Data Type, if the address number of the maximum value is specified, one word 
is not sufficient, so "????????" is displayed in the monitor.
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● External Device Monitor
Displays the state of external devices connected to the MICRO/I.

■ (Connection status)
Displays the state of external devices connected to the MICRO/I. If a red cross appears over the icon of an external 
device, communication is stopped.
Clicking the External Device icon enables switching between connection and disconnection.

■ (External Device ID)
Displays the External Device ID of all external device addresses used in the project.

■ (External Device Name)
Displays the name of external devices used in the project.

(Connection status)

(External Device ID)

(External Device Name)
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1.3 Display the Value of Device Address in Popup

During monitoring, mousing over device addresses displayed in the Object List window or device addresses in a 
script opened in Script Editor displays the current value in a popup window.

• Object List window

• Script Editor

1.4 Highlighting Objects While Satisfying Conditions

When the Trigger Condition is satisfied during monitoring, the objects for which conditions are being satisfied are 
highlighted in the Object List window.

• Popup viewing of values of device addresses in the Object List window works only if the screen 
displayed in the Object List window matches the screen displayed on the MICRO/I.

• Popup viewing of values of device addresses in Script Editor works only if the script during editing is being 
used by a global script command or a script command on the screen displayed on the MICRO/I.

• The maximum number for popup window is 80 characters. Any characters entered after the 80th will not 
be displayed.

• If 65 or more device addresses are displayed in the Object List window, monitor refreshing and popup 
message will slow down.
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1.5 Switching the Screen of the MICRO/I

During monitoring, it is possible to switch to the screen displayed on the MICRO/I using a WindO/I-NV4 command.

■  (Back)
You are returned to the Base Screen that was displayed immediately before the screen was switched.

■  (Forward)

Advances to the Base Screen that was displayed immediately before the screen was switched using the  (Back).

■  (First Screen)
Switches to the Base Screen with the lowest screen number in the project data.

■  (Previous Screen)
Switches to the Base Screen of screen number one lower than the Base Screen currently displayed. If the screen 
numbers are not consecutive numbers, this command switches to the closest number.

■  (Specified Screen)
Switches to the Base Screen of a specified number.

■  (Next Screen)
Switches to the Base Screen of screen number one higher than the Base Screen currently displayed. If the screen 
numbers are not consecutive numbers, switches to the closest number.

■  (Last Screen)
Switches to the Base Screen of highest screen number in the project data.

1.6 Open Current Screens

The screen displayed on MICRO/I opens in the editing window.

1.7 Change Values of Device Addresses and Check the Operation of Project Data Offline

To change values of device addresses and check the operation of project data on the MICRO/I unit, first switch to 
monitor mode, and then click Go Offline.

The MICRO/I switches to offline mode and “Offline Mode” flashes at the bottom left of the screen.
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It is possible to change values of device addresses and check the operation on the MICRO/I.

2.1 How the Monitoring Function is Used

Monitoring in the MICRO/I can perform the following functions.

• Checking and changing the value of specified device address

2 Monitoring on the MICRO/I

MICRO/I

130
Device Monitor

LDR1

LM0

Device
LM
LDR

Data Del Select

0
00000

0
1

Device Monitor

Dec/Hex

Device
LM
LDR

Data Del Select

0
00000

0
1

Device Monitor

Dec/Hex

Device Monitor can be used in offline mode. The values of the external device addresses can be checked 
and changed with the MICRO/I alone.
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2.2 Device Monitor

By registering device addresses in Run Mode, both data monitoring and changing can be conducted. Registered 
device addresses are listed in Device Monitor in ascending order (A to Z, 0 to 9). Registered device addresses are 
saved until power to the MICRO/I is turned OFF, or the mode is changed.

● Displaying Device Monitor

1 Press the upper-left corner of the screen on the MICRO/I for three seconds or more.

The Maintenance Screen is displayed.

2 Press Device Monitor.

Device Monitor is displayed.

• Available device address range depends on types and settings of external devices. Selecting unavailable 
device address, “Communication error” happens and it can not be back in without reboot. For details, 
refer to Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1.

• If three Popup Screens are displayed on the screen (or if two Popup Screens are displayed in the Alarm 
Log Settings), in order to use Device Monitor in the same way on Popup Screens, the Device Monitor 
cannot be used. 

Press and hold 
3 or more seconds

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Back Light

If a password has been configured for the project data, the Enter Password screen will be displayed. Select 
a user name and then enter a password. For details, refer to Chapter 21 “User Accounts and the Security 
Function” on page 21-1.
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● Device Address Registration

1 Press Select on Device Monitor.

The Select Device Address screen is displayed.

2 Press  or  to select the device type.

For Internal Device, proceed to step 4.

3 Enter the External Device ID as a hexadecimal value and press .

Device

Data Del Select

0

Device Monitor

Dec/Hex

LM           (bit) 0

Select Device Address

0 CLR CAN
ENT

1 2 3

4 5 6 F

7 8 9 E

A B C D

ID

The next address of the device address entered previously is automatically displayed in the Select Device 
Address screen.

ID
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4 Enter the address number and then press ENT.

• Press CLR to clear all values entered for the address number.
• Press CAN to stop registering device addresses.

The device address is registered to Device Monitor.

5 Repeat steps 1 through 4 to register all device addresses to be monitored.

LM           (bit) 1

Select Device Address

0 CLR CAN
ENT

1 2 3

4 5 6 F

7 8 9 E

A B C D

ID

1

2

If a device address is invalid, pressing ENT will not return to Device Monitor.

LM

Data Del Select

01

Device Monitor

Dec/HexDevice
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● Changing Value of Device Address

1 Press  or  to select the device address to be changed the value.

2 Press Data on Device Monitor.

The Write Data screen is displayed.

LM
LDR

Data Del Select

0
00000

1
2

Device Monitor

Dec/HexDevice

LM
LDR

Data Del Select

0
00000

1
2

Device Monitor

Dec/HexDevice
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3 Enter the value of device address and press ENT.

• Press Dec or Hex to change the display type for the value to enter.
• Press CLR to delete the entered value of device address.
• Press CAN to stop entering the value of device address.

The value of device address is changed.

Write Data

0 CLR CAN
ENT

1 2 3

4 5 6 F

7 8 9 E

A B C DDec Hex

Current
(word)

       0
/      0H

LDR 12

1

2

• If a value of device is invalid, pressing ENT will not return you to Device Monitor.
• If the display type is decimal, A to F cannot be used.

LM
LDR

Data Del Select

0
00001

1
2

Device Monitor

Dec/HexDevice
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● Device Monitor Configuration

■ Title Bar

Displays the title,  (Move) button, and (Close) button.

■

Switches the display type for the current value of device address. Switches between DEC and HEX.

■ (Device Address)
The registered device address is displayed.

■ (Value)
The current value of device address is displayed.

■ (Focus)
Highlights the selected device address.

■ 
Moves the focus up by one line.

■ 
Moves the focus down by one line.

■ Data
Changes the value of the selected device address. Press to display the Write Data Screen. For details, refer to 
“Changing Value of Device Address” on page 23-22.

■ Del
Deletes the selected device address.

■ Select
Registers a selected device address. Press to display the Select Device Address screen. For details, refer to “Device 
Address Registration” on page 23-20.

Device
LM
LM

Data Del Select

0
1

1
2

Device Monitor

Dec/Hex

Close button

(Value)

Move button

(Device Address)

(Focus)

Title bar

 (Move) button: Moves the Device Monitor.

 (Close) button: Closes the Device Monitor.

Dec/Hex
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2.3 Change Values of Device Addresses and Check the Operation of Project Data Offline

Offline mode allows you to change values of device addresses and to check the operation of project data on the 
MICRO/I unit only. By possessing virtualized external device addresses inside the MICRO/I, you can efficiently debug 
using the Device Monitor function.

● Switching to Offline Mode

1 Press the upper-left corner of the screen on the MICRO/I for three seconds or more.

The Maintenance Screen is displayed.

2 Press System Mode.

The MICRO/I switches to the Top Page of the System Mode.

3 Press Offline.

The MICRO/I switches to offline mode and “Offline Mode” is displayed at the bottom left of the screen.

4 Monitor and change the values of device addresses with Device Monitor to check the operation of project data.

If there are any errors, edit the project data with WindO/I-NV4, and then download the edited project data to the 
MICRO/I.

To exit offline mode, switch to System Mode with the operations in steps 1 and 2, and then press Run on the Top 
Page.

Press and hold 3
or more seconds

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

If a password has been configured for the project data, the Enter Password screen will be displayed. Select 
a user name and then enter a password. For details, refer to Chapter 21 “User Accounts and the Security 
Function” on page 21-1.

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16
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This chapter describes the overview of the Pass-through function, it's configuration and other important details.

   

1.1 How the Pass-Through Function is Used

The Pass-through function downloads or uploads a PLC program from a computer or an external device via the 
MICRO/I.

1.2 Supported External Devices

This Pass-through function can be used with the following PLCs:

*1 Use WindLDR Ver.5.00 or higher when you use the Ethernet Pass-through functon.
*2 User programs cannot be downloaded and uploaded through FC5A-SIF2 with Pass-through Function.
*3 We tested by GX Developer Version 8

Chapter 24 Pass-Through Function

1 Overview

Computer
MICRO/I

130

External device

Device Link Communication

Pass-Through Communication

Read

Write

Read

WritePLC programming 
software

Manufacturer Series Name Model Communication Driver

IDEC

OpenNet Controller FC3A

OpenNet, MicroSmart, 

SmartAXIS Pro/Lite (RS-232C/485)*1

MICROSmart FC4A

MICROSmart Pentra FC5A*2

SmartAXIS FT1A

Mitsubishi*3
FX Series

FX0, FX0N, FX1, FX1S, FX2, FX2C MELSEC-FX (CPU)

FX2N, FX2NC, FX1N, FX1NC MELSEC-FX2N (CPU)

FX3U, FX3UC MELSEC-FX3UC (CPU)

QCPU Q02CPU, Q02HCPU MELSEC-Q (CPU)
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1.3 How to Connect when Using the Pass-Through Function

Connect the computer and MICRO/I with an Ethernet cable or a USB cable, and connect the MICRO/I and external 
device with a serial cable.

1.4 Use the Pass-Through Function

The Pass-through function operates under the following conditions:

• The MICRO/I is in the Run mode or Monitor mode.

• A communication driver that supports the Pass-through operation.

• In the Project Settings dialog box, on the Communication Driver tab, the Enable Pass-Through check box is 
selected.

MICRO/IComputer

USB cable

Ethernet cable

Serial cable

External device

Use the WindO/I-NV2 Utility software Pass-through Tool if you have the following:
• A compertitor's PLC.
• Currently using WindLDR Ver. 5.0* - 6.0*.
For details on Pass-through Tool, see the WindO/I-NV2 Utility software Pass-through Tool Manual.
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This section describes the settings procedure for the Pass-through function. The Pass-through function can be 
configured with WindO/I-NV4 or in System Mode.

2.1 How to Enable the Pass-Through Function in WindO/I-NV4

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Click the Communication Driver tab.

3 Select the external device communication from the (Function) to make the Pass-through function is enabled.

4 Under External Device, select the Enable Pass-Through check box.

This option is accessible if the Communication Driver is supported. For details, refer to “1.2 Supported External 
Devices” on page 24-1.

5 Click OK.

This concludes the configuration to enable the Pass-through function.

2 Pass-Through Function Settings Procedure

(Function)
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2.2 How to Enable the Pass-Through Function in MICRO/I System Mode

1 Press the upper-left corner of the MICRO/I screen for three or more seconds.

The Maintenance Screen is displayed.

2 Press System Mode.

The screen changes to the Top Page in the System Mode.

3 Press Main Menu.

The Main Menu screen is displayed.

4 Press Initial Setting.

Press and hold 3
or more seconds

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

If a password has been configured for the project data, the Password Screen is displayed. Select user name 
and enter password. For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-
1.

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16

2010/OCT/14/THU   14:56:44

Initial
Setting

Clock
Setting

Run System
Info.

TopPage Offline ExtMem
Device

Self
Diag.

Main
menu   ---   ---   ---
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5 Press Ext. Device.

6 Press Ext. Device 1 to Ext. Device 4.

7 Press Pass Through.

8 Select the Enable PassThrough check box and press SAVE.

This concludes the configuration to enable the Pass-through function.

System
Op.

Initia
-lize

Ext.
Device

O/I
Link

Comm.
I/F --- --- ---

Main
menu

Init
Set   ---   ---

Ext.
Device1

Ext.
Device2

Ext.
Device3

Ext.
Device4

  ---   ---   ---   ---

Main
menu

Init
Set

Ext.
Device   ---

Retry
Cycles

Time
Out

Trans.
Wait

Pass
Through

Para-
meter1

Para-
meter2

Para-
meter3

Para-
meter4

Main
menu

Init
Set

Ext.
Device

Ext.
Dev.1

SAVE CAN

Main
menu

Init
Set

Ext.
Device

Ext.
Dev.1

　 Enable PassThrough
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• When sending and receiving data with an external device from PLC programming software using the Pass-through 
function, MICRO/I Device Link Communication and Pass-through function communication are performed at the 
same time, so the data transfer speed of each will decrease.
In this case, if Device Link Communication between the MICRO/I and the external device is stopped by the Pass-
through Tool, the data transfer speed of downloading or uploading the PLC program via MICRO/I will be improved. 
However, "Communication Error" will be displayed on the MICRO/I screen.

• Do not use communication with WindO/I-NV4 and Programming software at the same time.

• If the communication via Pass-through fails, change the settings such as Baud Rate, Timeout, Transfer Mode etc on 
PLC programming software.

• If one of the following problems occurs while using the Pass-through function and a communication error is 
displayed, turn power off and on to the MICRO/I again.
- The communication cable between the computer and MICRO/I was disconnected after stopping communication 

of the MICRO/I and the external device using the Pass-through Tool.
- The computer was forcibly shut down due to a power loss or other problem

• The Pass-through function can only use one of "External Device Communication 1" through "External Device 
Communication 4".

3 Important Notes

Example: WindLDR

Transfer Mode: ASCII

Baud Rate: 9600 bps

Timeout: 5000 msec.
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This chapter describes the web server function used during maintenance.

  

1.1 Web Server Function Overview

The web server function remotely performs the MICRO/I maintenance using a web browser terminal such as a 
computer or PDA.

•  Monitoring
•  Remote Control
•  Remote Monitoring

1.2 System Composition

An example system configuration for using the web server function is shown below.
Configure the MICRO/I Ethernet settings (IP address, netmask, default gateway) and connect to a local network.

Chapter 25 Maintenance

1 Web Server Function

(1) Access the MICRO/I from a web browser connected to the local network to use the web server function.

(2) When the local network is connected to an external network, configure the web browser connected to the remote 
network with the local network’s gateway, router, and other settings. Access the MICRO/I from the remote web 
browser to use the web server function. For gateway, router, and other settings, contact the administrator of the 
network the MICRO/I is connected to.

Web Browser Terminal
(Computer, PDA, etc.)

Web Browser Terminal
(Computer, PDA, etc.)

Local Network Ethernet Communication (TCP/IP)

Remote Network

(1)

(2)

External Network

External device

MICRO/I

External device

MICRO/I
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1.3 Minimum System Requirements

Use of the following web browsers is recommended with the web server function.
•  Internet Explorer 8.0 or higher
•  Firefox 3.0 or higher

1.4 Settings and Access Method

Follow the procedure below to display the MICRO/I web page (homepage) on a web browser.

1 Connect the MICRO/I to a local network.

Connect the MICRO/I’s Ethernet interface to the Ethernet port of the local network’s router or hub with a LAN cable.

2 Configure the MICRO/I.

• Ethernet settings
 Refer to Chapter 4 “When Ethernet is selected under Interface Configuration” on page 4-23.

• User account settings
 Refer to Chapter 21 “3 Security Dialog Box” on page 21-33.

• Remote operation & monitoring function settings
 Refer to “Remote Control and Monitoring function settings” on page 25-3.

3 Access the MICRO/I.

Start the web browser on the web browser terminal and access the following URL.

http://(MICRO/I IP address)/

If successfully accessed, the MICRO/I displays the password screen.

4 Enter the user name and password configured in the running project.

Enter the user name and password for a user in the “Administrator”, “Operator”, or “Reader” security group.

When the user name and password are successfully verified, the MICRO/I web page (homepage) is displayed.

Web browsers other than those recommended can use the web server function, but problems may occur 
with features such as automatic updates and displaying images.

Example 1: When the MICRO/I’s IP address is 192.168.0.1
http://192.168.0.1/

Example 2: When the MICRO/I’s IP address is 192.168.0.1 and the web server's port number is 8080
http://192.168.0.1:8080/

User name: The user name configured in the running project. (Default: User)

Password: The alphanumeric password of 4 to 15 characters long configured in the running project. If a password 
is not set, leave the password blank.

• An “Administrator” or “Operator” user account is required to open the remote operation page.
• If you do not access the MICRO/I for 5 minutes or more after accessing it, you will be required to reenter 

your user name and password.
Some web browsers will remember the user name and password you entered and automatically reenter 
them when required until the browser is closed. With this kind of web browser, you are not required to 
reenter your user name and password after 5 minutes or more have elapsed since accessing the MICRO/I.

• The MICRO/I can be accessed simultaneously from multiple web browser terminals. However, the 
maximum number of web browsers that can simultaneously access it is five.
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● Remote Control and Monitoring function settings

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Configure the items on the Web Server tab.

■ Disable Web Server function
When the web server function is disabled, the web page for the IP address held by the MICRO/I is not displayed, even 
when accessed.
(Default: Off)

■ Remote Control and Monitoring
Enables and disables remote monitoring and remote control. (Default: Disable)

■ Execution Interval (msec)
Specifies the interval (0 to 5000) for the MICRO/I to return data.
When the remote control function and the remote monitoring function place a load on MICRO/I operation, that load 
can be reduced by increasing this value.
However, the display update speed in the web browser will become slower. (Default: 5 (= 50 ms))

■ Port Number
Specifies the port number to use for the web server function. (Default: 80)

3 Click the OK button.
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1.5 Web Page Configuration

● Web page configuration
The MICRO/I web pages have the following page configuration.
There are links to each page from the homepage (http://(IP address of MICRO/I)/).

Homepage http://(IP address of MICRO/I)

System Detailed Information Page

Remote Functions Page

Remote Monitoring

Remote Operation
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● Web page screen configuration
Each page can be displayed in either English or Japanese. When the web browser's preferred language is set to 
Japanese, the pages are displayed in Japanese. When the web browser's preferred language is set to a language 
other than Japanese, the pages are displayed in English.

All pages are displayed in a right-left two frame configuration on web browsers that support frames.
See example below.

■ Left frame
Links to each page are shown in this menu frame.

■ Right frame
Shows the function page.
Except for the full screen remote monitoring screen and remote operation screen, all of the pages shown in the right 
frame have a Maximize link, Menu link, and Home link.

When using a web browser that does not support frames, the display position of items changes, but the content is the 
same.

Left Frame Right Frame

[Maximize] Link

Menu Link
Home Link

[Maximize]: Disables the frame display and shows the page in the full web browser screen.

Menu: Shows the menu page.
The content of the menu page is the same as the left frame (menu frame) when showing the frame.

Home: Goes to the homepage. When going to the homepage, frames are always shown.
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1.6 Monitoring

You can remotely monitor the state of the MICRO/I from a web browser. Click the link for each page on the left frame 
to show the desired page.

● Homepage
If you successfully access the MICRO/I, the homepage is displayed.
See example below.

The MICRO/I information shown on the homepage is listed below.

Display item Description

Mode

Shows the system’s current mode.
• Run Mode
• System Mode
• Monitor Mode
• Offline Mode
• Data Transfer Mode

Error

Shows the following errors.
• Communication Error
• No Screen Data
• Waiting for Default Screen No.
• Processing Error
• Backup Data Lost
• Network Off Line
• Device Range Error
• Script Error

System

Type Number Shows the MICRO/I model number.

Project Name
Shows the project name.
(When characters other than half-width alphanumeric characters are included 
on the English page, the project name is shown as “-Wrong Strings-”.)

System Version Shows the MICRO/I system software version.

System Time (m/d/y h:m:s) Shows the date and time of the MICRO/I's internal clock when the page was acquired.

External 
Device 
Communi-
cation 1 to 
4

Interface Shows the communication interface.

Manufacturer Shows the external device manufacturer name.

Communication Driver Name Shows the communication driver name.

Communication Driver Version Shows the communication driver version.
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O/I Link

Baud Rate [bps] Shows the O/I link communication speed.

O/I Link Station Shows the O/I link master station or slave station number.

Slave Registration Settings Shows the slave registration setting register for the O/I link communication master.

Slave Online Status Shows the slave online information register for the O/I link communication master.

Display item Description

• For details about error messages, refer to Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1.
• For details on O/I Link, see Chapter 3 “O/I Link Communication Interface” in the WindO/I-NV4 External 

Device Setup Manual.
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● System detailed information page
Click the System Detailed Information link in the left frame or the More Information link in the homepage's 
right frame to show the system detailed information page.
See example below.

The MICRO/I information shown on the system detailed information page is listed below.

Display item Description

Mode

Shows the system's current mode.
• Run Mode
• System Mode
• Monitor Mode
• Offline Mode
• Data Transfer Mode

Error

Shows the following errors.
• Communication Error
• No Screen Data
• Waiting for Default Screen No.
• Processing Error
• Backup Data Lost
• Network Off Line
• Device Range Error
• Script Error

System

Type Number Shows the MICRO/I type model number.

System Version Shows the MICRO/I system software version.

System Time (m/d/y h:m:s)
Shows the date and time of the MICRO/I's internal clock when the 
page was acquired.
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Project 
Information

Project Name
Shows the project name.
(When characters other than half-width alphanumeric characters are included 
on the English page, the project name is shown as “-Wrong Strings-”.)

Author Shows the project author.

Date Modified (m/d/y h:m:s)
Shows the project’s last modified date/time. The displayed date/
time is Greenwich Mean Time (GMT).

Installed Font Shows the extension fonts installed in the MICRO/I.

External 
Device 
Communi-
cation 1 to 4

Interface Shows the communication interface.

Manufacturer Shows the external device manufacturer name.

Communication Driver Name Shows the communication driver name.

Communication Driver Version Shows the communication driver version.

(Parameter unique to driver - 1)

The four items below the driver version show each driver’s unique 
settings. The item names differ according to the drivers.

(Parameter unique to driver - 2)
(Parameter unique to driver - 3)
(Parameter unique to driver - 4)
Serial Interface Shows the serial interface used as the External Device Communication 1 to 4.

Baud Rate [bps] Shows the speed of the External Device Communication 1 to 4.

Data Bits Shows the data length of the External Device Communication 1 to 4.

Stop Bits Shows the stop bits of the External Device Communication 1 to 4.

Parity Shows the parity of the External Device Communication 1 to 4.

Flow Control
Shows the flow control method of the External Device Communication 
1 to 4.

Retry Cycles
Shows the number of times to retry communication before 
displaying a communication error of the External Device 
Communication 1 to 4.

Time Out [msec]
Shows the response waiting time from the External Device 
Communication 1 to 4.

Transmission Wait [msec]
Shows the transmission interval for a communication command of 
the External Device Communication 1 to 4.

O/I Link

Baud Rate [bps] Shows the O/I link communication speed.

O/I Link Station Shows the O/I link master station or slave station number.

Slave Registration Settings
Shows the slave registration setting register for the O/I link 
communication master.

Slave Online Status
Shows the slave online information register for the O/I link 
communication master.

Ethernet

IP Address Shows the IP address.

Netmask Shows the netmask.

Gateway Shows the gateway address.

MAC Address Shows the Ethernet MAC address.

System 
Operation

Default Screen Number Shows the screen number displayed when MICRO/I starts running.

Screen Number Format Shows the depiction method for the displayed screen number.

Start Time [sec] Shows the time until starting communication with the external device.

Auto Backlight OFF [min] Shows the time for the backlight to turn off automatically.

Flashing Cycle [sec]
Shows the flashing speed for parts and draw objects with the 
blinking attribute.

Touch Sound Shows On or Off for the touch panel confirmation sound.

Menu Language Shows the system screen’s display language.

Display item Description

• The contents of the display items on the system detailed information page are the values set on the 
Project Settings dialog box displayed by clicking Project under System Setup on the Configuration tab in 
WindO/I-NV4.

• For details on the item of the External Device Communication 1 to 4, see the WindO/I-NV4 External 
Device Setup Manual.
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1.7 Remote Functions

You can remotely monitor and control the MICRO/I from a web browser.
You can check the screen of MICRO/I.

● Remote monitoring page
Click the Monitor link in the left frame to display the remote monitoring page.
A screen image of the screen displayed on the MICRO/I is shown.
See example below.

The following items can be specified on the remote monitoring page.

■ Picture Format
Specify the image format to use in remote monitoring.

• On the remote monitoring page, the MICRO/I cannot be controlled even when the screen image 
displayed in the web browser is clicked. To control the MICRO/I, please open the remote control page.

• When the MICRO/I display is off by the backlight auto off function or the System Area 1 screen display 
(address number+1, bit 7), the screen image is not displayed in a web browser.

• If JavaScript is prohibited in the web browser settings, the web page will not operate correctly. Please 
enable JavaScript.

• The screen image cannot be displayed on web browsers that do not support the bitmap or JPEG format.
• The display may not be updated depending on the web browser's cache settings.

65536 Color JPEG Format (Slow): Capable of showing the screen image displayed on the MICRO/I in the web 
browser without degradation. However, the update speed of the web browser 
display is slower than 256 Color Bitmap Format (Fast) and the MICRO/I 
screen update speed also slows down.

256 Color Bitmap Format (Fast): Shows the screen image displayed on the MICRO/I reduced to 256 colors. The 
screen image displayed on the MICRO/I is somewhat degraded, but the 
update speed of the display on the web browser speeds up and the impact on 
the MICRO/I screen update speed is reduced. (The screen update speed of 
the 256 color bitmap format tends to be faster than the 65536 color JPEG 
format, but it may be slower depending on the screen’s displayed content.)



WindO/I-NV4 User’s Manual 25-11

1 Web Server Function

25

M
aintenance

■ [Maximize] link
Hides the left frame, page title, and screen format settings, and shows only the MICRO/I screen image. The screen 
format settings are the same as before clicking the [Maximize] link.
These screens are examples.

● Remote control page
Click the Control link in the left frame to display the remote control page.
An image of the screen displayed on the MICRO/I is shown. You can also control the MICRO/I by clicking on the 
displayed screen image.
This screen is an example.

• If JavaScript is prohibited in the web browser settings, the web page will not operate correctly. Please 
enable JavaScript.

• The screen image cannot be displayed on web browsers that do not support the bitmap or JPEG format.
• The display may not be updated depending on the web browser's cache settings.
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The following items can be specified on the remote operation page.

■ Picture Format
Specify the image format to use in remote operation.

■ Control Options
Operation restrictions prohibit operation from other computers or the touch panel of the MICRO/I while the MICRO/I 
is being remotely controlled.

■ [Maximize]
Hides the left frame, page title, and screen format settings, and shows only the MICRO/I screen image. The screen 
format settings are the same as before clicking the [Maximize] link.

65536 Color JPEG Format (Slow): Capable of showing the screen image displayed on the MICRO/I in the web 
browser without degradation. However, the update speed of the web browser 
display is slower than 256 Color Bitmap Format (Fast) and the MICRO/I 
screen update speed also slows down.

256 Color Bitmap Format (Fast): Shows the screen image displayed on the MICRO/I reduced to 256 colors. The 
screen image displayed on the MICRO/I is somewhat degraded, but the 
update speed of the display on the web browser speeds up and the impact on 
the MICRO/I screen update speed is reduced. (The screen update speed of 
the 256 color bitmap format tends to be faster than the 65536 color JPEG 
format, but it may be slower depending on the screen's displayed content.)

Disable Control From Other Clients: Check to prohibit remote control from other computers. When this function is 
enabled, if a web browser is already accessing the MICRO/I, the message 
Remote Control is disabled by other client will be displayed on the other 
browser and access is denied. When disabled, the MICRO/I can be accessed 
from multiple web browsers.

Disable Control From Touch Panel: Check to prohibit control with the MICRO/I touch panel. When this function is 
enabled, if a web browser is already accessing the MICRO/I, the message 
Touch panel is disabled by Remote Control Function will be displayed 
on MICRO/I and operation by the MICRO/I touch panel is not possible. When 
disabled, control by the MICRO/I touch panel is possible.
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This chapter describes the project transfer function to upload and download project data to the MICRO/I, to upload 
and download PLC program files to a PLC connected to the MICRO/I using an external memory device.
These three functions for exchanging data using an external memory device are collectively called data transfer 
functions.

  

1.1 What Can Be Done with the Project Transfer Function

The project transfer function uploads or downloads project data between the MICRO/I and an external memory 
device inserted in the MICRO/I.

● Download project data saved on an external memory device to the MICRO/I. However, you must 
create project data for transfer.

● Upload the project data used for operation on the MICRO/I and save it to an external memory device.

Chapter 26 Data Transfer Function

1 Project Transfer Function

Create Project File 
for Transfer Download

MICRO/IComputer

Project File
(ZNV Format)

Project File
(ZNV Format)

USB flash drive

External Memory Device

Upload

MICRO/I

Project File
(ZNV Format)

USB flash drive

External Memory Device

When using the project transfer function and a project file is uploaded, the project file name is “project 
name + file extension (.ZNV)”.
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1.2 Project Data Transfer Procedures

The following methods can be used to upload or download project data between the MICRO/I and an external 
memory device inserted in the MICRO/I.

• Using the USB Autorun function
 For details, refer to Chapter 27 “2 USB Autorun Function” on page 27-20.

• Using Key Buttons, Multi-Buttons, or Multi-Commands
 For details, refer to “1.4 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer Project Data” on 

page 26-6.
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1.3 Converting Project Data for Transfer

Project data must be converted to dedicated data for transfer in order to download project data to the MICRO/I using 
the project transfer function.
Use the following procedure to create project data for transfer using an external memory device.

1 Insert an external memory device in the computer.
When using a USB flash drive, insert the USB flash drive in the computer’s USB port.

2 Open the project data to transfer using WindO/I-NV4.

3 On the Home tab, in the Project group, click the Download icon.
The Download dialog box is displayed.

4 Check that Communication Settings is External Memory Device, and then click the Download button.
The Select Drive dialog box is displayed.

Computer

USB flash drive
To USB port

When the project data has not been saved after it was opened, a save confirmation message is displayed.
Click the OK button to save the project data and display the Download dialog box.
Click on the Cancel button to return to the editing screen without saving the project data.

1. If Communication Settings is not External Memory Device, click the Change button.
The Communication Settings dialog box is displayed.

2. Select External Memory Device for Communicate with, and then click the OK button.
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5 Specify the drive for the external memory device and click the OK button.

A confirmation message is displayed.

■ Drive
Specify the drive of the computer assigned to the external memory device.

■ Network
Displays the Network Drive Assignment dialog box. You can specify a drive on the network.

■ External Memory Device Folder
Specify the folder where the project data is to be downloaded.

Click the  button to display the Project Settings dialog box. You can specify an External Memory Device folder as 
the download destination.

6 Click the Yes button.

A Download dialog box is displayed and the project data is now being saved.
When this process is complete, a message is displayed.

7 Click the OK button.
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8 Click the Close button in the Download dialog box.

The project data for transfer is created in the External Memory Device folder on an external memory device.

For details about the created data folder and file structure, refer to Chapter 27 “External Memory Devices” 
on page 27-1.

If the folder or file structure on the External Memory Device folder is modified, the MICRO/I and 
WindO/I-NV4 will not be usable.
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1.4 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer Project Data

● Download

1 Create a project file for transfer (.ZNV) and save it on an external memory device.

For details, refer to “1.3 Converting Project Data for Transfer” on page 26-3.

2 Insert an external memory device in the MICRO/I.

3 Press the Key Button or Multi-Button or execute the Multi-Command configured with Download Project under Data 
Transfer on the Key Browser dialog box.

● Upload

1 Insert an external memory device in the MICRO/I.

2 Press the Key Button or Multi-Button or execute the Multi-Command configured with Upload Project under Data 
Transfer on the Key Browser dialog box.

Allocate a Key Button, Multi-Button, or Multi-Command configured with the project transfer function to the 
MICRO/I.
 For details, refer to Chapter 8 “5 Key Button” on page 8-66.
 For details, refer to Chapter 8 “6 Multi-Button” on page 8-88.
 For details, refer to Chapter 12 “6 Multi-Command” on page 12-37.

MICRO/I

USB flash drive

External Memory Device

MICRO/I

USB flash drive

External Memory Device
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1.5 Precautions

• An error message is displayed if the project data upload or download fails.
For details, refer to Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1.

• While the project transfer function is running, the MICRO/I stops processing other functions.

• When project data is downloaded using the project transfer function, the HMI Keep Registers and the HMI Keep 
Relays are cleared.

• If a project file (ZNV format) exists with the same name in the save destination when uploading a project file (ZNV 
format), the file is overwritten with the uploaded file without displaying an overwrite confirmation message.

• When using the project transfer function, make the project data file name half-width alphanumeric characters.

• While running the project transfer function using a Key Button, Multi-Button, or Multi-Command, if a data transfer 
function (project transfer or PLC program transfer) is initiated, the only function that will work is the currently 
running function. If two or more data transfer functions are configured to a Multi-Button or Multi-Command, only 
the data transfer function displayed at the top of the function list on the parts property dialog box will run.

• When running the project transfer function, the external memory device must have enough free space equivalent 
to the size of the ZNV project file. Check that there is sufficient free space on the external memory device that will 
be used with the project transfer function. If the device does not have sufficient free space, the project upload or 
download may fail.
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2.1 Supported PLCs

PLCs that support the PLC program transfer function are listed below.

2.2 What Can Be Done using the PLC Program Transfer Function

The PLC program transfer function is used to upload or download PLC program files (ZLD format) between a PLC 
connected to the MICRO/I and an external memory device inserted in the MICRO/I.

● Downloading a PLC program
Download a PLC program file (ZLD format) saved on an external memory device to a PLC connected to the MICRO/I.
You must create a PLC program file for transfer (ZLD format).

● Uploading a PLC program
Upload a PLC program from the PLC connected to the MICRO/I and save the PLC program file (ZLD format) to an 
external memory device.

2 PLC Program Transfer Function

Manufacturer Series name Supported system (CPU unit) Communication driver

IDEC

OpenNet Controller FC3A • Serial Interface:
OpenNet, MicroSmart, SmartAXIS Pro/Lite 
(RS232C/485)

• Ethernet Interface:
OpenNet, MicroSmart, SmartAXIS Pro/Lite 
(Ethernet)

MicroSmart FC4A

MicroSmart Pentra FC5A

PLC Program File
(ZLD Format)

DownloadCreate PLC Program File 
for Transfer

PLCMICRO/IComputer

PLC Program File
(ZLD Format)

USB flash drive

External Memory Device

Upload

PLCMICRO/I

Save

PLC Program File
(ZLD Format)

USB flash drive

External Memory Device

When a PLC program file is uploaded using the PLC program transfer function, the file name is “Model 
name_Port number_Station number_Year month day hours minutes seconds + File extension (.ZLD)”. 
The port number varies based on the interface used to upload with HG2G-5T. The displayed item is as follows:
  SERIAL1(RS232C): C1
  SERIAL1(RS422/485): C2
  Ethernet: ET
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2.3 PLC Program File Transfer Procedures

The following methods can be used to upload or download a PLC program file between a PLC connected to the 
MICRO/I and an external memory device inserted in the MICRO/I.

• Using the USB Autorun function
 For details, refer to Chapter 27 “2 USB Autorun Function” on page 27-20.

• Using Key Buttons, Multi-Buttons, or Multi-Commands
 For details, refer to “2.5 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer PLC Programs” on 

page 26-11.
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2.4 Converting PLC Program Files for Transfer

Before transferring a PLC program file, using the PLC Program Transfer Function, it must be converted to a (ZLD 
format).

1 Open the PLC program file to to be transferred using WindLDR.

2 Click  to the right of Save As on the application menu and click PLC Program.

The Save As dialog box is displayed.

3 Enter a file name and click Save.

▼

When using a PLC program with the PLC program transfer function, always enter the file name as half-
width alphanumeric characters.



WindO/I-NV4 User’s Manual 26-11

2 PLC Program Transfer Function

26

D
ata Transfer Function

2.5 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer PLC Programs

● Download

1 Convert a PLC program file for PLC program transfer.

For details, refer to “2.4 Converting PLC Program Files for Transfer” on page 26-10.

2 Save it to an external memory device.

3 Insert an external memory device in the MICRO/I.

4 Press the Key Button or Multi-Button or execute the Multi-Command configured with Download PLC Program 
under Data Transfer on the Key Browser dialog box.

● Upload

1 Insert an external memory device in the MICRO/I.

2 Press the Key Button or Multi-Button or execute the Multi-Command configured with Upload PLC Program under 
Data Transfer on the Key Browser dialog box.

Allocate a Key Button, Multi-Button, or Multi-Command configured with the PLC program transfer function to 
the MICRO/I.
 For details, refer to Chapter 8 “5 Key Button” on page 8-66.
 For details, refer to Chapter 8 “6 Multi-Button” on page 8-88.
 For details, refer to Chapter 12 “6 Multi-Command” on page 12-37.

Save

Computer

PLC Program File
(ZLD Format)

USB flash drive

External Memory Device

PLCMICRO/I

USB flash drive

External Memory Device

PLCMICRO/I

USB flash drive

External Memory Device
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2.6 Precautions

• An error message is displayed if the PLC program file upload or download fails.
For details, refer to Chapter 31 “1.1 Errors Displayed on the Screen” on page 31-1.

• WindLDR Ver. 6.30 or later is required to create PLC program files.

• MICRO/I operation and PLC operation stops while the PLC program transfer function is running. After the PLC 
program file upload or download is completed, the MICRO/I returns to the mode immediately before running the 
PLC program transfer function and the PLC automatically starts running.

• Only passwords containing uppercase alphanumeric characters can be entered from the MICRO/I. When the PLC 
password is configured with characters other than uppercase alphanumeric characters, the password cannot be 
cleared.

• The PLC program transfer function cannot be run when the MICRO/I is in Offline Mode. Switch to Run Mode, 
Monitor Mode, or System Mode before running the PLC program transfer function.

• If a PLC program file exists with the same name in the save destination when uploading a PLC program file, the file 
is overwritten with the uploaded file without displaying an overwrite confirmation message.

• While running the PLC program transfer function using a Key Button, Multi-Button, or Multi-Command, if a data 
transfer function (project transfer or PLC program transfer) is initiated, the only function that will work is the 
currently running function. If two or more data transfer functions are configured to a Multi-Button or Multi-
Command, only the data transfer function displayed at the top of the function list on the parts property dialog box 
is run.
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This chapter describes the specifications, functions, and notes to observe when using external memory devices with 
the MICRO/I.

   

1.1 Supported External Memory Devices

External memory device such as the USB flash drive is used on the MICRO/I interface. 

1.2 What Can Be Done Using an External Memory Device

The following functions are available when an external memory device is inserted in the MICRO/I.

1.3 Specifications of External Memory Devices

● USB flash drive
Models support USB flash drives with the following specifications:

• Max capacity 32 GB.

• Compatible with FAT16 or FAT32 formatted USB flash drives.

• The maximum file size that can be read and written is 256 MB.

• Character set support only for alphanumeric characters.

• File names may be up to 120 characters long. (Includes file extensions.)

• File paths may be up to 250 characters long. (Includes file extensions and drive characters.)

• Drive letters cannot contain the following characters:
\ " & ( ) * + , . / : ; < > [ ]  = | ^

• File and directory names cannot contain the following characters:
\ / : * ? " < > |

Chapter 27 External Memory Devices

1 External Memory Devices

External Memory Device HG2G-5T

USB flash drive YES

Functions
HG2G-5T

Reference
USB flash drive

Screenshot YES
Page 8-53
Page 12-26

Alarm Log output YES Page 13-20

Data Log output YES Page 14-16

Reading/writing recipe data YES Page 18-1

Displaying picture files YES Page 2-28

Transferring projects and PLC programs YES Page 26-1

USB Autorun function YES Page 27-20

USB Popup Screen function YES Page 27-34

Check the IDEC web site for more information about compatible USB flash drives.
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1.4 File structure

When downloading or uploading data using the System Mode on the MICRO/I, or WindO/I-NV4, the following files 
and folders are accessible. This folder is called the External Memory Device folder. For the HG2G-5T, the External 
Memory Device folder is created on the USB flash drive. By default, the External Memory Device folder name is 
"HGDATA01". For details, refer to “1.6 Setting the External Memory Device Folder” on page 27-14.

HGDATA01 (External Memory Device folder)

HGDATA02

HGDATA03

External Memory Device

USB flash drive

Folder name File name Description

CAPTURE
CAP[date/time].JPGs
Date/time format: 
YYMMDD_HHMMSS

Screenshot data
(file name is assigned automatically)

ALARMLOG

[user-defined].CSV
Default file name

Batch: ALMHTO.CSV
Real time: ALMHTA.CSV

Alarm Log data

DATALOG

[user-defined].CSV
Default file name

Batch: LOGO**.CSV
Real time: LOGA**.CSV

Data Log data
(** corresponds to the data number)

OPERATIONLOG

[user-defined].CSV
Default file name

Batch: OPLOGO.CSV
Real time: OPLOGA.CSV

Operation Log data

RECIPE [user-defined].CSV
Default: RCP****.CSV

Recipe data
(*** corresponds to the recipe number)

PICTURE [user-defined].bmp/jpg Picture files

Users can create multiple External Memory Device folders for different projects on a single external memory 
device. Note, the External Memory Device folder on the external memory device must reside on the root 
directory.

Do not alter project files (ZNV format) and PLC program files (ZLD format). Altered files cannot be used 
with MICRO/I or PLCs.
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1.5 Reading/Writing Data

● Using WindO/I-NV4 to read and write to an external memory device inserted in the MICRO/I
This procedure shows how to read and write data to the External Memory Device folder specified for the project 
currently running on the MICRO/I.
Use either method below to make the connection.
• Connect a USB cable to the USB port on the computer and the USB interface on the MICRO/I.
• Connect an Ethernet cable to the Ethernet port on the computer and the Ethernet interface on the MICRO/I.

Communication settings

Follow these procedures to configure the communication device and port to allow reading and writing to the external 
memory device inserted in the MICRO/I.

1 On the Home tab, in the Project group, click Comm. Setup.

The Communication Settings dialog box appears.

2 Select MICRO/I under Communicate with.

3 Select the type of connection under Port, then click OK.

External Memory DeviceMICRO/I

USB flash drive

Computer

USB Cable

Ethernet Cable

To USB Port To USB Interface

Mini-B PlugA Plug

To Ethernet Port To Ethernet Interface
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Downloading

This procedure shows how to download a specified file into a folder on the external memory device for the currently 
running project.

1 On the Home tab, in the Project group, click the arrow under Download.

2 Click Files to External Memory Device or Files to External Memory Device while running.

The Open dialog box appears.

■ Files to External Memory Device
This function temporarily stops the MICRO/I and then downloads files to the external memory device inserted in the 
MICRO/I. MICRO/I resumes running when files have been downloaded.

■ Files to External Memory Device while running
This function downloads files to the external memory device inserted in the MICRO/I without stopping the MICRO/I.

3 Specify the file name and click Open.

A confirmation message appears.

4 Click Yes.

The External Memory Device Maintenance dialog box appears and the file download begins.
When the download is complete, a message box appears.

If security is enabled for the project on MICRO/I, a dialog appears for you to enter a user name and 
password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.



WindO/I-NV4 User’s Manual 27-5

1 External Memory Devices

27

External M
em

ory D
evices

5 Click OK.

6 Click Close on the External Memory Device Maintenance dialog box.
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Uploading

This procedure shows how to upload specified data from the External Memory Device folder on the external memory 
device for the currently running project.

1 On the Home tab, in the Project group, click the arrow next to Upload.

2 Click Stored Data in External Memory Device.

The Upload from External Memory Device dialog box appears.

3 Select the items to be uploaded, and then specify the destination folder in the Location box.

Uploadable data is as follows.
• Screenshots
• Alarm Log files
• Data Log files
• Operation Log files
• Recipe Files
• Picture Files

4 Click OK.

The External Memory Device Maintenance dialog box appears and the data upload begins.
A message box appears when the data upload is complete.

• Click  to call up the Select a Folder dialog box and specify the destination folder for uploading.
• After starting WindO/I-NV4, screen shots, alarm log data, data log data, and recipe files can be uploaded 

from an External Memory Device folder without opening project data.

If security is enabled for the project on MICRO/I, a dialog appears for you to enter a user name and 
password. For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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5 Click OK.

6 Click Close on the External Memory Device Maintenance dialog box.
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● Using WindO/I-NV4 to read and write to an external memory device inserted in the computer
When using a USB flash drive, insert the USB flash drive in the computer’s USB port.

Communication settings

To read and write to the external memory device inserted in the computer using WindO/I-NV4, the external memory 
device must be specified as the communication device. Configure the communication settings as follows before 
downloading or uploading.

1 On the Home tab, in the Project group, click Comm. Setup.

The Communication Settings dialog box appears.

2 Under Communicate with, select External Memory Device, then click OK.

Computer

USB flash drive
To USB port
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Downloading

This procedure shows how to download the project data to the External Memory Device folder on the external 
memory device using WindO/I-NV4.

1 Open the project data to download using WindO/I-NV4.

2 On the Home tab, in the Project group, click the icon above Download.

The Download dialog box appears.

3 Click Download.

The Select Drive dialog box appears.

4 Select the external memory device drive, then click OK.

A confirmation message appears.

■ Drive
Specify the computer's drive assigned as the external memory device drive.

■ Network
Displays the Network Drive Assignment dialog box. This dialog allows you to specify a drive on the network.

■ External Memory Device Folder
Specify the destination folder for downloading project data.

Click  to call up the Project Settings dialog box. This procedure allows you to change the External Memory Device 
folder on the external memory device where the download will be stored.
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5 Click Yes.

The Download dialog box appears and the file download begins.
When the download is complete, a message box appears.

6 Click OK.

7 Click Close on the Download dialog box.
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Uploading

This procedure shows how to upload the project data from the External Memory Device folder on the external 
memory device inserted in the computer, to the computer using WindO/I-NV4.

1 On the Home tab, in the Project group, click Upload.

The Select External Memory Device Folder dialog box appears.

2 Select the external memory device drive, then click OK.

The Upload dialog box appears.

■ External Memory Device Folder
Displays the folder specified in the Folder tree described next.

■ Folder
Specify the source folder for uploading the project data.

■ Drive
Specify the computer's drive assigned as the external memory device drive.

■ Network
Displays the Network Drive Assignment dialog box. This dialog allows you to specify a drive on the network.

3 Click Upload.

The Upload dialog box appears and the file upload begins.
When the upload is complete, a message box appears.
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4 Click OK.

5 Click Close on the Upload dialog box.

A confirmation message appears indicating the project will be opened.

6 Click OK.

The uploaded project opens.

● Manipulating files using the file management functions provided with the OS
It is possible to use Explorer or any other program provided with the Windows OS to replace the recipe data and 
picture file that MICRO/I uses.
Insert the external memory device into the computer and save the new file(s) using the same name as the existing 
files in each folder under the External Memory Device folder.
For the picture files that can be used with the MICRO/I, refer to Chapter 2 “1.4 Available Image Files” on page 2-19.

If a password has been configured for the project data, the Enter Password screen will be displayed. 
The password to enter varies based on the check box setting of the Use Password to open a Project 
found under the Options tab in the Security dialog box.
When this check box is selected, enter the password for Use Password to open a Project.
When this check box is cleared, enter the password for the user account assigned to the Administrator 
security group.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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● External memory device writing timing
If the write timing setting for Alarm Log, Data Log, and Operation Log data is set to Real Time, the data is stored in 
the file output buffer once.
The writing timing from the file output buffer to the external memory device is as follows.
• Within 3 minutes of an output event to the external memory device.
• When the HMI Special Relay LSM18 changes to 1.
• When switching to the System Mode.
• When downloading/uploading project data.

In the following events, MICRO/I writes the data in the file output buffer to the external memory device 
once, and then moves on to the next process. This creates a processing delay which can cause WindO/I-
NV4 to raise a communication error when downloading or uploading a project file. If a communication error 
occurs, try downloading/uploading the project file again.
• When data exists in the file output buffer
• When attempting to switch to the System Mode while reading/writing to the external memory device.
• When downloading/uploading project data.
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1.6 Setting the External Memory Device Folder

The External Memory Device folder on the external memory device can be renamed using WindO/I-NV4.

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

2 On the External Memory Device tab, enter the desired name in the External Memory Device Folder text box.

Use only alphabetic characters (A to Z) and numbers (0 to 9) and the maximum is 8 characters.

3 Click OK.

It is not possible to change folder names and file names other than the External Memory Device folder.

The External Memory Device folder is named “HGDATA01” if project data has never been downloaded to the 
MICRO/I.
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1.7 Deleting Files on the External Memory Device

Files in the External Memory Device folder of the external memory device inserted in the MICRO/I during operation 
can be deleted using WindO/I-NV4.

1 On the Configuration tab, in the System Setup group, click Project.
The Project Settings dialog box appears.

2 On the External Memory Device tab, select the Remove Files check box.

3 Specify the range of files to delete by checking the appropriate items.

■ All Screenshots
Deletes all files in the CAPTURE folder.

■ All Alarm Log files
Deletes all files in the ALARMLOG folder.

■ All Data Log files
Deletes all files in the DATALOG folder.

■ All Operation Log files
Deletes all files in the OPERATIONLOG folder.

4 In Trigger Device Address, specify the bit device or the bit number of a word device to serve as the condition for 
deleting files.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-64.

5 Click OK.

The online function in WindO/I-NV4 can also be used to delete files on the external memory device. For 
details, refer to Chapter 22 “4 Clear” on page 22-20.
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1.8 Formatting the External Memory Device

● Formatting an external memory device using the Online Function in WindO/I-NV4
The external memory device inserted in the MICRO/I can be formatted with the WindO/I-NV4 online function.
Using the WindO/I-NV4, the following external memory devices are accessible.

1 On the Online tab, in the MICRO/I group, click Format.

A confirmation message appears warning that existing data will be deleted.

2 Click Yes.

The External Memory Maintenance dialog box appears and formatting begins.

3 Click Close.

Always format the external memory device before using it.

HG2G-5T: USB flash drive

• In Communication Settings, Communicate with must be set to MICRO/I in advance, and Port 
must be set to USB in advance. For details on how to configure these settings, refer to “Communication 
settings” on page 27-3.

• If a project has been saved on the external memory device with security enabled, a dialog appears for 
you to enter a user name and password. For details, refer to Chapter 21 “User Accounts and the Security 
Function” on page 21-1.

After completing a format of the external memory device, the External Memory Device folder is 
automatically created when going to the Run Mode.
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● Formatting external memory device under the System Mode on the MICRO/I
External memory device inserted in MICRO/I can be formatted by using the menu in the System Mode on the MICRO/I.

1 Insert the external memory device into the MICRO/I.

2 Press and hold the upper left corner of the MICRO/I screen for 3 or more seconds.

The Maintenance Screen appears.

3 Press the System Mode.

MICRO/I switches to the Top Page in the System Mode.

4 Press the Main Menu.

The Main Menu appears.

5 Press the Ext.Mem.Device.

MICRO/I

USB flash drive

External memory device

Press and hold 3 
or more seconds

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

If security is enabled for the project on MICRO/I, a dialog appears for you to enter a user name and 
password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16

2010/OCT/14/THU   14:56:44

Initial
Setting

Clock
Setting

Run System
Info.

TopPage Offline ExtMem
Device

Self
Diag.

Main
menu   ---   ---   ---
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6 Press FORMAT.

A confirmation message appears.

7 Press YES.

MICRO/I starts formatting the external memory device.
When formatting is completed, “The format completed.” is displayed.

FORMAT

Main
menu

ExtMem
Device   ---   ---

Format USB Flash Drive ?

YES NO
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1.9 Precautions

• For projects that use external memory devices, always insert the external memory device before turning the 
MICRO/I on.

• The maximum number of screenshots that can be captured can be set in HMI Special Data Register LSD65.

• External memory devices have a limitation on the number of writes allowed. 
Regularly backup data on the external memory device.

• Never turn the power off to the MICRO/I or remove the external memory device while reading/writing to it. 
Otherwise, the data on the external memory device may be destroyed. Should this occur, reformat the external 
memory device.

• When external memory device is inserted into the MICRO/I, first perform the following operations, and then turn 
off the power to the MICRO/I or remove the external memory device.

• When a read or write failure occurs with the external memory device, HMI Special Data Register LSD33 is set with 
the error status. For details about the error, refer to Chapter 28 “HMI Special Data Register (LSD)” on page 28-5.

•  If an unusable external memory device is inserted, the following error message appears.

• Multiple USB flash drives cannot be used at the same time.

• Do not connect the USB flash drive to the MICRO/I through a USB hub.

• The message “Stopping external memory” appears while reading or until writing stops.
To resume reading or writing to the external memory device, re-insert it.

• Altering folders and files in the External Memory Device folder on the external memory device will make the 
external memory device unusable in MICRO/I and WindO/I-NV4.

USB flash drive: After setting HMI Special Relay LSM18 to 1, check that HMI Special Relay LSM19 is 0.

USB flash drive: This USB isn't available.
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2.1 Overview of the USB Autorun Function

The USB Autorun function automatically displays a menu screen from which the user can execute predefined 
commands when a USB flash drive is inserted into the MICRO/I.

The commands that can be executed with the USB Autorun function are as follows.

● Downloading a project file
Downloads a project file (ZNV format) saved on a USB flash drive to the MICRO/I.

When the download is complete, the MICRO/I will reset and start running from the beginning of the project that was 
just downloaded.

2 USB Autorun Function

USB Autorun Function Menu Screen

USB flash drive

Production line A - replace 
MICRO/I program

Copy MICRO/I program to USB 
flash drive

Production line A - replace 
PLC program

Copy PLC program to USB 
flash drive

Production line B - replace 
PLC program Run All Cancel

Confirmation

Press the command to execute.USB Autorun 
definition file
(hgauto.ini)

MICRO/I

• This allows operators to change project files and PLC programs without using a computer.
• These defined processes are called commands, and the file that contains the details of the command and 

menu screen is called the USB Autorun definition file (hgauto.ini).
• A USB Autorun definition file (hgauto.ini) must be stored on the USB flash drive to use the USB Autorun 

function.

Save

Save

Download

Computer
USB flash drive

MICRO/I

USB Autorun 
definition file
(hgauto.ini)

Project file
(ZNV format) Project file

(ZNV format)

Refer to Chapter 26 “1 Project Transfer Function” on page 26-1 for important notes and limitations.
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● Uploading a project file
Uploads the project file (ZNV format) used to operate the MICRO/I and saves it to a USB flash drive.

When the upload is complete, the MICRO/I will reset and start over at the beginning of the project.

● Downloading a PLC program file
Downloads a PLC program file (ZLD format) saved on a USB flash drive to the PLC connected to the MICRO/I.

● Uploading a PLC program file
Uploads the PLC program file from the PLC connected to the MICRO/I and saves it in ZLD format to a USB flash drive.

Save Upload

Computer

Project file
(ZNV format)

USB Autorun 
definition file
(hgauto.ini)

USB flash drive
MICRO/I

Refer to Chapter 26 “1 Project Transfer Function” on page 26-1 for important notes and limitations.

Save

Save

Download

PLCComputer
USB flash drive

MICRO/I

PLC program file
(ZLD format)

PLC program file
(ZLD format)

USB Autorun 
definition file
(hgauto.ini)

Refer to Chapter 26 “2 PLC Program Transfer Function” on page 26-8 for compatible PLCs, important notes, 
and limitations.

Save Save Upload
PLCComputer

PLC program file
(ZLD format)

USB Autorun 
definition file
(hgauto.ini)

USB flash drive
MICRO/I

Refer to Chapter 26 “2 PLC Program Transfer Function” on page 26-8 for compatible PLCs, important notes, 
and limitations.
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2.2 USB Autorun Function Configuration Procedure

● Executing commands using the USB Autorun function

Configuration Procedure

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

2 On the Autorun tab, select the Enable USB Autorun check box and click OK.

For details, refer to Chapter 4 “3.9 Autorun Tab” on page 4-39.

3 Create a USB Autorun definition file (hgauto.ini) and save it on the USB flash drive.

For details, refer to “2.3 Creating a USB Autorun Definition File” on page 27-25.

• If the USB Autorun function of the MICRO/I is not enabled, the menu screen will not be displayed, even if 
a USB flash drive is inserted into the MICRO/I.

• Once the USB Autorun function of the MICRO/I is enabled, the function will remain enabled until either a 
project file with the Enable USB Autorun check box unchecked is downloaded, or the function is 
disabled via the System Mode.

When enabling the USB Autorun function using the MICRO/I, on the Top Page in the System Mode, press 
Main Menu, Initial Setting, System Operation (for HG4G/3G/2G-5F) or System Op. (for HG2G-5T), 
and then press Autorun.

Save

Computer
USB flash drive

USB Autorun 
definition file
(hgauto.ini)
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4 Prepare the necessary files and store them on the USB flash drive.

The necessary files are as follows.

• To download a project file
Create a project file (ZNV format).
For details, refer to Chapter 26 “1.3 Converting Project Data for Transfer” on page 26-3.

• To download an IDEC PLC program
Create a PLC program file (ZLD format).
For details, refer to Chapter 26 “2.4 Converting PLC Program Files for Transfer” on page 26-10.

Operating Procedure

1 Insert the USB flash drive into the MICRO/I.

The menu for the USB Autorun function appears.

Save

Computer

Project file
(ZNV format)

PLC program file
(ZLD format)

Only when downloading

USB flash drive

USB flash drive MICRO/I

If the menu screen does not appear, follow these troubleshooting tips. Correct the problem and re-insert 
the USB flash drive.

Cause: USB Autorun definition file (hgauto.ini) does not exist on the USB flash drive.

Correction: Create a USB Autorun definition file and save it on the USB flash drive. For details, refer to 
“2.3 Creating a USB Autorun Definition File” on page 27-25.

Cause: The USB Autorun definition file (hgauto.ini) contains an error.

Correction: For details, refer to “2.3 Creating a USB Autorun Definition File” on page 27-25.

Cause: The USB Autorun function is disabled in the MICRO/I settings.

Correction: Enable the USB Autorun function by referring to Steps 1 and 2 on page 27-22.
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2 Press the command to execute.

The command executes.

3 When the command finishes executing, a screen appears indicating the execution result.

Press Ack to close the execution result screen and display the menu screen.

Production line A - replace 
MICRO/I program

Copy MICRO/I program to USB 
flash drive

Production line A - replace 
PLC program

Copy PLC program to USB 
flash drive

Production line B - replace 
PLC program Run All Cancel

Confirmation

Press the command to execute.

• Pressing Run All causes all commands defined in the USB Autorun definition file (hgauto.ini) to execute 
one by one.

• If security is enabled for the project on MICRO/I, a dialog appears for you to enter a user name and 
password.
For details, refer to “2.4 USB Autorun Function Security” on page 27-33.

• When uploading/downloading IDEC PLC program files to a password-protected PLC, a dialog appears for 
you to enter the password.

Do not remove the USB flash drive while command is executing.

Production line A - replace 
MICRO/I programFunction

The following function completed

Ack

Result

If a command executes with a button (except the Run All), the menu screen is displayed after pressing Ack 
on the execution result dialog.
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2.3 Creating a USB Autorun Definition File

The menu screen that appears when a USB flash drive inserted in the MICRO/I is defined in the USB Autorun 
definition file.
The USB Autorun definition file is created using the following methods.

• Created with the USB Autorun definition file creation tool
 Refer to USB Autorun Definition File Creation Tool manual.

• Created with the text editor
 Refer to “Created using the text editor” on page 27-25.

● Created using the text editor
You create this file using Notepad or any commercially available text editor. Fill in the items in each section and save 
the file with the name “hgauto.ini”.

The USB Autorun definition file has these 3 sections.
Enter the items and definitions for each section.

[AUTORUN] section (required)
Specify the number of command items, enable/
disable the buttons, and the display language to use.

[AUTORUN]
item = 5
button_command = Enable
button_runall = Enable
language = English

[COMMAND] section (required)
Specify the command to execute and its parameters.
Create buttons to execute the number of commands 
specified in the [AUTORUN]: section from 
[COMMAND_1] to [COMMAND_5], in that order.

[COMMAND_1]
command = PRO_DOWNLOAD
src_path = "B:\NV4DATA\HG_PROJECT.ZNV"
reset_keep_device = Enable
title = "Production line A - replace MICRO/I program"
∙
∙
∙
∙
∙
∙
[COMMAND_5]
command = LDR_UPLOAD
dst_path = "B:\Uploaded_Program"
src_port = COM1
src_net_no = 0
title = "Copy PLC program to USB flash drive"

[COMMENT] section
Enter text to display, as necessary, at the bottom of 
the menu screen.

[COMMENT]
comment = "Press the command to execute."

Production line A - replace 
MICRO/I program

Copy MICRO/I program to USB 
flash drive

Production line A - replace 
PLC program

Copy PLC program to USB 
flash drive

Production line B - replace 
PLC program Run All Cancel

Confirmation

Press the command to execute.

[COMMAND_1] 
execution button

[COMMAND_4] 
execution button

[COMMAND_5] 
execution button

Button to close 
the menu screen

Execution button for all commands

[COMMAND_2] 
execution button

[COMMAND_3] 
execution button

Displays text entered 
in [COMMENT]
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[AUTORUN] section

■ item (required)
Specify the number of commands used from 1 to 5. The USB Autorun function will fail to execute if a value other than 
1 to 5 is specified.

■ button_command

■ button_runall

■ language

[COMMAND] section

■ command (required)

Specify whether to enable/disable the execution buttons for [COMMAND_1] to [COMMAND_5].
Enable: enables the button.
Disable: disables the button.

If this item is left blank or contains an illegal value, the MICRO/I assumes “Enable”.

Specify whether to enable/disable the execution buttons for Run All.
Enable: enables the button.
Disable: disables the button.

If this item is left blank or contains an illegal value, the MICRO/I assumes “Enable”.

Specify the language to use for the button labels and messages.
Japanese: Shift-JIS
European: English
Chinese: GB2312
Taiwanese: BIG5
Korean
Central European
Baltic
Cyrillic

If this item is left blank or contains an illegal value, the MICRO/I assumes “Japanese”.

Specify the command to execute.
PRO_DOWNLOAD: Download a project file
PRO_UPLOAD: Upload a project file
LDR_DOWNLOAD: Download a PLC program file
LDR_UPLOAD: Upload a PLC program file
The items required differ for each command except for the “title” item.
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command = PRO_DOWNLOAD

■ src_path (required)
Specify the path (250 or less characters) where the project file is to be downloaded.
Use “B:\” for a USB flash drive.

■ reset_keep_device
Specify whether to initialize the keep devices or not when the project file is downloaded. However, when project data 
that changes the settings of the data storage area is downloaded, the keep devices are always initialized.

command = PRO_UPLOAD

■ dst_path (required)
Specify the path to the folder (250 or less characters) where the uploaded project file will be saved.
Use “B:\” for a USB flash drive.

command = LDR_DOWNLOAD

■ src_path (required)
Specify the path (250 or less characters) where the PLC program file is to be downloaded.
Use “B:\” for a USB flash drive.

■ dst_port (required)
Specify the name of the MICRO/I port to which the PLC to download from is connected.

■ dst_net_no (required when specifying the destination as a slave number or External Device ID)
If the communication interface that connects the PLC for downloading is the serial interface, specify the slave number. 
If the communication interface is the Ethernet interface, specify the External Device ID. Specify the same number set 
as the slave number or External Device ID for the PLC.

■ dst_plc_ip (required when specifying the destination as an IP address)
Specify the IP address of the download destination PLC.
Example: dst_plc_ip = 192.168.0.1

■ dst_plc_port
Specify the port number of the download destination PLC.
Example: dst_plc_port = 2101

Enable: Initializes the keep devices.
Disable: Does not initialize the keep devices.

If this item is left blank or contains an illegal value, the MICRO/I assumes "Enable".

COM1: Serial interface (SERIAL1); RS232C (Terminal Block)
COM2: Serial interface (SERIAL1); RS422/485 (Terminal Block)
ETHER: Ethernet interface (LAN)

When specifying the destination as an IP address and this item is left blank or contains an illegal value, the 
MICRO/I assumes that the value is "2101". This item is not required when specifying the destination as a 
slave number or External Device ID.
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command = LDR_UPLOAD

■ dst_path (required)
Specify the path to the folder (250 or less characters) where the uploaded PLC program file will be saved.
Use “B:\” for a USB flash drive.

■ src_port (required)
Specify the name of the MICRO/I port to which the PLC to upload from is connected.

■ src_net_no (required when specifying the destination as a slave number or External Device ID)
If the communication interface that connects the PLC for uploading is the serial interface, specify the slave number. If 
the communication interface is the Ethernet interface, specify the External Device ID. Specify the same number set as 
the slave number or External Device ID for the PLC.

■ src_plc_ip (required when specifying the destination as an IP address)
Specify the IP address of the upload source PLC.
Example: src_plc_ip = 192.168.0.1

■ src_plc_port
Specify the port number of the upload source PLC.
Example: src_plc_port = 2101

Common items

■ title
Enter a title for the button label. The maximum number is as follows.

• A line feed will automatically be added and it can be added where desired. When added in a desired location, \n will 
be inserted automatically and is thus calculated as 2 single-byte characters.

• When using a semicolon (;), backslash (\), or double quotations ("), an escape character (\) will be automatically 
inserted before those characters and will thus be calculated as 2 single-byte characters.

COM1: Serial interface (SERIAL1); RS232C (Terminal Block)
COM2: Serial interface (SERIAL1); RS422/485 (Terminal Block)
ETHER: Ethernet interface (LAN)

When specifying the destination as an IP address and this item is left blank or contains an illegal value, the 
MICRO/I assumes that the value is "2101". This item is not required when specifying the destination as a 
slave number or External Device ID.

HG2G-5T: 1 line of 14 characters
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[COMMENT] section

■ comment
Enter a message shown at bottom of the menu screen. The maximum number is as follows.

• A line feed will automatically be added but can be added where desired. When added in a desired location, \n will 
be inserted automatically and is thus calculated as 2 single-byte characters.

• When using a semicolon (;), backslash (\), or double quotations ("), an escape character (\) will be automatically 
inserted before those characters and will thus be calculated as 2 single-byte characters.

Notes on comments

To add comments to the USB Autorun definition file, use a semicolon (;).
All text after the semicolon (;) and up to the line feed will be treated as a non-executable comments.

Restrictions

• The maximum number of characters per line is 512 single-byte characters including line feed codes.
All the text on the line will be ignored if there are more than 512 single-byte characters on the line.

• Each item must be described as a single line. If a line feed occurs before the end of the description, all characters 
after the line feed are ignored.

• The maximum size of the USB Autorun definition file (hgauto.ini) is 512 KB. The file cannot be used if it exceeds 
this limit.

• Only line feed codes of the format generally supported by Windows (CR+LF) are supported. If any other format is 
used, the USB Autorun definition file (hgauto.ini) will fail to run properly.

HG2G-5T: 1 line of 29 characters
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Sample definition file and explanation

Sample definition

; sample hgauto.ini

(1)

[AUTORUN]
item = 5 ; number of items
button_command = Enable ; enable individual command buttons
button_runall = Enable : enable the "Run All" button.
language =English ; use English

(2)

[COMMAND_1]
command = PRO_DOWNLOAD ; download the project file
src_path = "B:\Sample_Project.ZNV" ; source path
reset_keep_device = Enable ; initialize the keep devices
title = "Production line A - replace MICRO/I program" ; button label

(3)

[COMMAND_2]
command = LDR_DOWNLOAD ; download PLC program file
src_path = "B:\LDRDATA\LDR_PROGRAM.ZLD" ; source path
dst_port = COM1 ; destination port number
dst_net_no = 0 ; destination slave number
title = "Production line A - replace PLC program" ; button label

(4)

[COMMAND_3]
command = LDR_DOWNLOAD ; download PLC program file
src_path = "B:\LDRDATA\LDR_PROGRAM.ZLD" ; source path
dst_port = COM1 ; destination port number
dst_net_no = 1 ; destination slave number
title = "Production line B - replace PLC program" ; button label

(5)

[COMMAND_4]
command = PRO_UPLOAD ; upload a project file
dst_path = "B:\Uploaded_Project" ; destination path
title = "Copy MICRO/I program to USB flash drive" ; button label

(6)

[COMMAND_5]
command = LDR_UPLOAD ; Upload a PLC program file
dst_path = "B:\Uploaded_Program" ; destnation path
src_port = COM1 ; source port number
src_net_no = 0 ; source slave number
title = "Copy PLC program to USB flash drive" ; button label

(7)
[COMMENT]
comment = " Press the command to execute." ; Message shown at bottom of screen.
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Explanation

(1) This definition file displays five command execution buttons on the menu screen displayed by the USB Autorun 
function. It also enables the Run All button. All button labels and messages are displayed in English.

(2) Downloading a project file from a USB flash drive to the MICRO/I.

(3) Downloading a PLC program from the USB flash drive to the PLC connected to the MICRO/I.

(4) Downloading a PLC program from the USB flash drive to the PLC connected to the MICRO/I.

(5) Uploading a project to a USB flash drive.

[AUTORUN] Defines the number of commands to use and details about the menu screen.

item = 5 Specifies that five commands will be used.

button_command = Enable
Enables execution buttons for each command from [COMMAND_1] 
to [COMMAND_5].

button_runall = Enable Enables the Run All button.

language = English Displays all button labels and messages in English.

[COMMAND_1]
Defines the command assigned to execution button [COMMAND_1]. 
This is the first command that executes when Run All is pressed.

command = PRO_DOWNLOAD Executes “Download a project file”.

src_path = "B:\Sample_Project.ZNV"
Downloads the project file “Sample_Project.ZNV” saved on the USB 
flash drive (B:) to the MICRO/I.

reset_keep_device = Enable Initializes the keep devices.

title = "Production line A - replace MICRO/I 
program"

Displays the text “Production line A - replace MICRO/I program” as 
the button label.

[COMMAND_2]
Defines the command assigned to execution button [COMMAND_2]. 
This is the second command that executes when Run All is pressed.

command = LDR_DOWNLOAD Executes “Download a PLC program”.

src_path = "B:\LDRDATA\LDR_PROGRAM.ZLD"
Downloads the “LDR_PROGRAM.ZLD” PLC user program stored in 
the “LDRDATA” folder of the USB flash drive (B:) to the PLC (slave 
number 0) connected to the MICRO/I's COM1 port.

dst_port = COM1

dst_net_no = 0

title = "Production line A - replace PLC program"
Displays the text “Production line A - replace PLC program” as the 
button label.

[COMMAND_3]
Defines the command assigned to execution button [COMMAND_3]. 
This is the third command that executes when Run All is pressed.

command = LDR_DOWNLOAD Executes “Download a PLC program”.

src_path = "B:\LDRDATA\LDR_PROGRAM.ZLD"
Downloads the “LDR_PROGRAM.ZLD” PLC user program stored in 
the “LDRDATA” folder of the USB flash drive (B:) to the PLC (slave 
number 1) connected to the MICRO/I's COM1 port.

dst_port = COM1

dst_net_no = 1

title = "Production line B - replace PLC program"
Displays the text “Production line B - replace PLC program” as the 
button label.

[COMMAND_4]
Defines the command assigned to execution button [COMMAND_4]. 
This is the fourth command that executes when Run All is pressed.

command = PRO_UPLOAD Executes “Upload a project file”.

dst_path = "B:\Uploaded_Project"
Uploads the project file used to operate the MICRO/I and saves it to 
the folder “Uploaded_Project” on the USB flash drive (B:).

title = "Copy MICRO/I program to USB flash 
drive"

Displays the text “Copy MICRO/I program to USB flash drive” as the 
button label.
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(6) Uploading a PLC program file to a USB flash drive.

(7) Displays messages below the menu screen for the USB Autorun function.

[COMMAND_5]
Defines the command assigned to execution button [COMMAND_5].
This is the fifth command that executes when Run All is pressed.

command = LDR_UPLOAD Executes “Upload a PLC program file”.

dst_path = "B:\Uploaded_Program"
Uploads the PLC program file running on the PLC (slave number 0) 
connected to the MICRO/I's COM1 port, and saves it in the folder 
“Uploaded_Program” on the USB flash drive (B:).

src_port = COM1

src_net_no = 0

title = "Copy PLC program to USB flash drive"
Displays the text “Copy PLC program to USB flash drive” as the 
button label.

[COMMENT]
Defines the number of commands to use and details about the 
menu screen.

comment = "Press the command to execute."
Displays the text “Press the command to execute.” below the menu 
screen.
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2.4 USB Autorun Function Security

If security has been enabled for the MICRO/I project, MICRO/I displays a password entry dialog box when the USB 
Autorun function runs.

Select the user name from the security group that has command execution permissions, enter the password, and 
press ENT.

● Execution privileges by security groups
The commands that can be executed differ depending on the security group.

Enter the appropriate password
for Data Transfer Function

CAN

User

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Command
Security Group

Administrator Operator Reader

Downloading a project file YES NO NO

Uploading a project file YES NO NO

Downloading a PLC program file YES NO NO

Uploading a PLC program file YES NO NO
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The USB Popup Screen function displays a specific screen by simply inserting a USB flash drive in the MICRO/I.
This provides an easy way to display a message when the operator inserts a USB flash drive.

3.1 Automatically Displaying a Popup Screen when a USB Flash Drive is Inserted

● Configuration Procedure

1 On the Configuration tab, in the System Setup group, click the Project.

The Project Settings dialog box appears.

2 On the Autorun tab, select the Open Popup Screen when USB Flash Drive is inserted check box.

3 Specify the Screen Number of the Popup Screen to display, and the Coordinates, then click OK.

For details, refer to Chapter 4 “3.9 Autorun Tab” on page 4-39.

3 USB Popup Screen Function
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● Operating Procedure
Insert the USB flash drive into the MICRO/I.

The Popup Screen appears.

USB flash drive MICRO/I

MICRO/I

USB flash drive was inserted.Popup Screen

If security is enabled for the Popup Screen that is displayed by the USB Popup Screen function, a dialog 
appears for you to enter a user name and password.
For details, refer to “2.4 USB Autorun Function Security” on page 27-33.

When the USB Popup Screen function is enabled, if the USB flash drive contains a definition file (hgauto.ini) 
for use with the USB Autorun function, both functions will appear on the menu screen.
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This chapter describes internal devices.

    

■ HMI Internal Relay (LM)
This is a bit-unit device. It can store 2,048 addresses.

■ HMI Keep Relay (LK)
This is a bit-unit device that holds the values of device. The value of this device can be set to 0 by clearing the project 
data download option or online function, or it becomes 0 if the backup battery is drained. The address range can be 
varied between 1,024 and 8,192. For details, refer to Chapter 16 “Minimum and Maximum Amount of Data Storage 
and Number of Addresses” on page 16-2.

■ HMI Timer Relay (LTC)
The HMI Timer is a bit-unit device that can be changed to 1 in value of device switched by the Timer from Parts. It 
can store 32 addresses.

■ HMI Temporary Relay (LBM)
This is a bit-unit device for temporarily storing values. The value of this device switches between screens and text 
groups and user accounts, and it becomes 0 if the screen is reset. It can store 128 addresses.

Chapter 28 Internal Devices

1 Bit Devices

Internal Device Name Symbol R/W Address Range Base

HMI Internal Relay LM R/W 0 to 2047 10

HMI Keep Relay LK R/W Variable 10

HMI Timer Relay LTC R 0 to 31 10

HMI Temporary Relay LBM R/W 0 to 127 10

HMI Special Internal Relay LSM R/W 0 to 63 10

R/W is an abbreviation of Read/Write. R/W indicate that both reading and writing are possible, while R 
indicates that only reading is possible.
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■ HMI Special Relay (LSM)
A specific function is assigned for each of the 64 special internal relay (LSM). 

Device Address Function/Part
LSM0 Normally set to 1.

LSM1
When Base Screen is switched, a value of this bit is 1 only on the second scan.
It also operates when switching text group or user account, or resetting the display screen.

LSM2
When Base Screen is switched, a value of this bit is 1 only on the first scan.
It also operates when switching text group or user account, or resetting the display screen.

LSM3
When Base Screen is switched, the value of this bit is 0 only on the first scan.
It also operates when switching text group or user account, or resetting the display screen.

LSM4 Alternates between 0 and 1 with each scan.
LSM5 When Popup Screen is opened, a value of this bit is 1 only on the first scan.
LSM6 While touch panel is pressed, a value of this bit is 1.

LSM7
Alternates between 0 and 1 each time data is read (read scan) from all external device addresses being 
used by External Device Communication 1.

LSM8
When the power is turned ON, then a value of this bit is 1. When switching to another screen from the 
default screen or when switching the Text Group, then the value is 0.

LSM9
When value changes from 0 to 1, the backup data stored in flash memory is restored.
When it becomes 1 value does not become 0 until the Touch is reset or 0 is written.

LSM10
When switched from 0 to 1, the current backlight setting and the data for Keep Relays and Keep Register 
configured in the Data Storage Area are transferred to the flash memory.
Once LSM10 switches to 1, it does not change to 0 until MICRO/I recycles power or 0 is written to LSM10.

LSM11
Changes from 0 to 1 when the Base Screen is switched, after the values of all external device addresses 
being used are read, and remains 1 until there is a switch to another screen.
It also operates when switching text group or user account, or resetting the display screen.

LSM12 When Popup Screen is closed, a value of this bit is 1 only on the first scan.

LSM13
Value becomes 0 when Popup Screen is opened, and then changes from 0 to 1 after the values of all 
external device addresses being used by that Popup Screen are read. 

LSM14 to 17 Reserved

LSM18
When value changes from 0 to 1, access to USB flash drive is stopped. The access state can be checked 
with the value of LSM19.
When it becomes 1 value does not become 0 until the MICRO/I is reset or 0 is written.

LSM19 Value is 1 while there is access to USB flash drive. If value is 0 the USB flash drive can be safely ejected.
LSM20, 21 Reserved

LSM22
This is the Operation Log function. When data in excess of the amount that can be recorded in one 
operation occurs, the value becomes 1. 
When it becomes 1 value does not become 0 until the MICRO/I is reset or 0 is written.

LSM23, 24 Reserved
LSM25 This bit is 1 while writing the data to the USB flash drive.
LSM26 to 32 Reserved

LSM33
When the amount of data for parts placed on the top layer exceeds the upper limit, then the value of this 
bit is 1. This bit remains at a value of 1 until the MICRO/I is reset or 0 is written, then the value is 0.

LSM34 to 41 Reserved

LSM42
Alternates between 0 and 1 each time data is read (read scan) from all external device addresses being 
used by External Device Communication 2.

LSM43
Alternates between 0 and 1 each time data is read (read scan) from all external device addresses being 
used by External Device Communication 3.

LSM44
Alternates between 0 and 1 each time data is read (read scan) from all external device addresses being 
used by External Device Communication 4.

LSM45 to 47 Reserved
LSM48 200 millisecond clock (alternates between 0 and 1 every 100 milliseconds)
LSM49 1 second clock (alternates between 0 and 1 every 500 milliseconds)

LSM50
When switched to 1, limits the External Device Communication and gives priority to the communications 
between the computer and PLC. (Enabled only when using the Pass-Through function.)

LSM51 Reserved

LSM52
While in remote monitor or control, a value of this bit changes from 0 to 1 in just one scan. This bit can be 
used to check if the touchscreen is being controlled by the remote computer. You may also use this bit as 
a trigger condition in a button to forbid the control from the remote computer.
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This operation of this relay is illustrated in the timing chart below.

LSM53
When the value changes to 1, the preset values for IP address, subnet mask, and default gateway 
(LSD192 to 203) are written to the MICRO/I, then it automatically resets. After the MICRO/I is reset, 
value becomes 0.

LSM54
When the value changes to 1, the preset values for External Device ID and IP address (LSD204 to 208) 
are written to the MICRO/I, then it automatically resets. After the MICRO/I is reset, value becomes 0.

LSM55 to 63 Reserved

Device Address Function/Part

• Transfer of the LSM10 Keep Relay and Keep Register to the flash memory can take an excess of one 
second. Writing to the Flash Memory can be repeated a maximum of 100,000 times. Keep writing to the 
Flash Memory to a minimum.

• When there is no remaining battery power, data transferred with LSM10 will be restored once the power 
to the MICRO/I has been turned on.

• LSM1, 2, 3 and 11 also operates when switches the Text Group.
• Once a value of LSM18 and 22 changes from 0 to 1, it remains at a value of 1 until MICRO/I is reset or 0 

is written, then the value is 0.

A scan refers to a period during which all parts placed on a screen are processed. It is not related to the 
period of reading values of external device addresses.
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■ HMI Data Register (LDR)
8192 points are available.

■ HMI Keep Register (LKR)
The value in these registers is retained during power OFF. The maximum number of HMI Keep Register depends upon 
the number set in WindO/I-NV4. For details, refer to Chapter 16 “Minimum and Maximum Amount of Data Storage 
and Number of Addresses” on page 16-2.

■ HMI Timer (Current) (LTD)
This register stores the current value of Timer from the parts. 32 points are available.

■ HMI Temporary Register (LBR)
This register can be used to store value as temporary. This register value will be cleared to 0 when a text
group or user account is changed, when a screen is reset or the screen is changed. 128 points are available.

■ HMI Link Register (LLR)
An area that stores the data of the registered device addresses for the external device during Sub Host 
Communication.
64 points are available.
This register can also be used as an internal register like LDR when Sub Host Communication is not used.

2 Word Devices

Internal Device Name Symbol R/W Address Range Base

HMI Data Register LDR R/W 0 to 8191 10

HMI Keep Register LKR R/W Variable 10

HMI Timer (Current) LTD R 0 to 31 10

HMI Temporary Register LBR R/W 0 to 127 10

HMI Link Register LLR R/W 0 to 63 10

HMI Special Data Register LSD R/W 0 to 255 10

R/W is an abbreviation of Read/Write. R/W indicate that both reading and writing are possible, while R 
indicates that only reading is possible.
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■ HMI Special Data Register (LSD)
These registers (256 points) perform the following special operations.

Device Address Function/Part

LSD0 to 3 Reserved

LSD4 Scan time Maximum value (msec.)

LSD5 Screen switch response time (msec.)

LSD6 Read scan communication time of External Device Communication 1 (msec.)

LSD7 Scan counter (incremented at each scan)

LSD8 1 second counter (incremented each second)

LSD9 10 msec. counter (increments every 10 msec.)

LSD10 100 msec. counter (incremented every 100 msec.)

LSD11 200 msec. counter (incremented every 200 msec.)

LSD12 500 msec. counter (incremented every 500 msec.)

LSD13 Stores the current Year data from the MICRO/I. “Year” (4 BCD digits)

LSD14 Stores current time data from MICRO/I. “Month” (2 BCD digits)

LSD15 Stores current time data from MICRO/I. “Day” (2 BCD digits)

LSD16 Stores current time data from MICRO/I. “Hour” (2 BCD digits)

LSD17 Stores current time data from MICRO/I. “Minute” (2 BCD digits)

LSD18 Stores current time data from MICRO/I. “Second” (2 BCD digits)

LSD19 Stores current time data from MICRO/I. “Day-of-week” (1 BCD digit)

LSD20 When a value of “1” is written into this special register, the Internal clock in MICRO/I is updated 
according to the data stored in LSD21-26. It automatically resets to “0” after the update.

LSD21 Write a “Year” value to store in the MICRO/I internal clock. (2 BCD digits)

LSD22 Stores set value for “Month” in MICRO/I internal clock. (2 BCD digits)

LSD23 Stores set value for “Day” in MICRO/I internal clock. (2 BCD digits)

LSD24 Stores set value for “Hour” in MICRO/I internal clock. (2 BCD digits)

LSD25 Stores set value for “Minute” in MICRO/I internal clock. (2 BCD digits)

LSD26 Stores set value for “Second” in MICRO/I internal clock. (2 BCD digits)

LSD27 Scan time Current value (msec.)

LSD28 Scan time Minimum value (msec.)

LSD29, 30 Reserved

LSD31 Stores the currently displayed screen number.

LSD32
Set a value ( in reference to a Base Screen number you want to switch to) and it will automatically 
switch to a specified Base Screen number.
Note, after switching to a Base Screen, the value stored automatically resets to 0.

LSD33

USB flash drive error status
0: Normal
1: USB flash drive not inserted or Incompatible USB flash drive
2: Format error
3: Access error, Insufficient memory in USB flash drive or Reading or writing failure

LSD34 USB flash drive free memory capacity Lower word (Kbytes)

LSD35 USB flash drive free memory capacity Upper word (Kbytes)

LSD36 USB flash drive total memory capacity Lower word (Kbytes)

LSD37 USB flash drive total memory capacity Upper word (Kbytes)

LSD38 to 46 Reserved

LSD47 Reserved (for Communication drivers)

LSD48 Reserved

LSD49 Stores the O/I Link slave station number. (Read-only)

LSD50

The sequence value of the message number (or channel number if the alarm function is being 
used) selected by the cursor in the Alarm List Display is stored.
A value of between 1 and 1024 (allocated using ((Block No. - 1) x 16 + bit position + 1)) is stored 
for the number.
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LSD51 Brightness level: 0 to 31

LSD52 The ID number of the script for which the error occurred.

LSD53 Script error status

LSD54 Reserved (for Script)

LSD55 Reserved

LSD56
The number of lines of data from the start line to the line currently selected with the cursor 
displayed in the Alarm List Display/Alarm Log Display is stored.

LSD57
The number of log data pieces stored in the Data Storage Area by the alarm log function is stored. 
(0 to 1024)

LSD58

USB flash drive download status
The following bit becomes to 1 while downloading to USB flash drive by WindO/I-NV4.
The bit switched to 0 after downloading.
Bit 2:  Recipe data
Bit 4:  Project data
Bit 5:  Picture data
Bit 9:  PLC Program

LSD59 Reserved

LSD60 Reserved (for Line Chart)

LSD61 Reserved (for Trigger Condition)

LSD62 Reserved (for TCP/IP)

LSD63 to 64 Reserved

LSD65 The maximum number of screenshots in the USB flash drive.

LSD66 Reserved

LSD67

Stores the connection status for TCP clients and the TCP server for the User Communication set to 
the Ethernet interface.
Bit 0: User Communication 1
Bit 1: User Communication 2
Bit 2: User Communication 3

LSD68

When the value changes from 0 to 1, the connections for the TCP clients and the TCP server for the 
User Communication set to the Ethernet interface are forcibly disconnected.
Bit 0: User Communication 1
Bit 1: User Communication 2
Bit 2: User Communication 3

LSD69 to 96 Reserved

LSD97 Read scan communication time of External Device Communication 2 (msec.)

LSD98 Read scan communication time of External Device Communication 3 (msec.)

LSD99 Read scan communication time of External Device Communication 4 (msec.)

LSD100 Reserved (for O/I Link Communication)

LSD101 Polling period register for the O/I Link Slave

LSD102 Slave registration setting register for O/I Link Master

LSD103 Reserved (for O/I Link communication)

LSD104 Slave online information register for O/I Link Master

LSD105 Reserved (for O/I Link communication)

LSD106 Slave error information register for O/I Link Master

LSD107 Reserved (for O/I Link communication)

LSD108, 109 Reserved

LSD110, 111 Reserved (for Communication drivers)

LSD112 to 127
Register for Communication drivers
For details, see the WindO/I-NV4 External Device Setup Manual.

LSD128 to 191 Reserved

Device Address Function/Part
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LSD192 to 195

The preset value for IP address of the MICRO/I. When the value of LSM53 is changed to 1, the 
values of these device addresses are written to the MICRO/I. When the power is turned on, the set 
values of the project are read to these device addresses.
Example: When the IP address is 192.168.0.1

LSD192=192, LSD193=168, LSD194=0, LSD195=1

LSD196 to 199

The preset value for subnet mask of the MICRO/I. When the value of LSM53 is changed to 1, the 
values of these device addresses are written to the MICRO/I. When the power is turned on, the set 
values of the project are read to these device addresses.
Example: When the subnet mask is 255.255.254.0

LSD196=255, LSD197=255, LSD198=254, LSD199=0

LSD200 to 203

The preset value for default gateway of the MICRO/I. When the value of LSM53 is changed to 1, the 
values of these device addresses are written to the MICRO/I. When the power is turned on, the set 
values of the project are read to these device addresses.
Example: When the default gateway is 192.168.0.24

LSD200=192, LSD201=168, LSD202=0, LSD203=24

LSD204 The External Device ID to change the IP address

LSD205 to 208

The preset value for IP address of external device. When the LSM54 is changed to 1, the values of 
these device addresses are written to the MICRO/I. When the value of LSD204 changes, the set 
values of the project are read to these device addresses.
Example: When the IP address is 192.168.0.2

LSD205=192, LSD206=168, LSD207=0, LSD208=2

LSD209 to 255 Reserved

Device Address Function/Part

• LSD4 and 6 store the maximum value, and when the Base Screen is switched, they are reset.
• The values of LSD4 to 6 are included errors of +/- 10 msec.
• When registers LSD7, 8, 9, 10, 11 or 12 contain FFFF (H) and are incremented, the value becomes 0.
• When you reckon time by using LSD9, the time difference (in 10ms units) from the previous value can be 

calculated.
• The range for the “Year” in LSD13 is 2000 to 2099, and reverts to 2000 after 2099.
• When “1” is written to LSD20, internal clock is updated by the contents of LSD21-26. After setting the 

year, month, day, hour, minute, and second data in LSD21 to 26, writes a “1” to LSD20.
• The display format for LSD31 is set under “Screen No. Format” in Project Settings. (BCD, BIN)
• This data format for LSD32 is the same as “Screen No. Format” in Project Settings. (BCD, BIN)

If the screen number is not exist in the project, “No Screen Data” message will appear.
If 0xFFFF(Hex) is written to LSD32, MICRO/I will display the Top Page of System Mode .
In case that the current screen is changed by System Area1 and LSD32 at the same instant, the screen 
number of the System Area1 will be displayed.

• The data stored in LSD34 to 37 are stored in kilobytes. 1 K byte is 1024 bytes. Values of less than 1 K 
byte are rounded up.

• By using the LSD50 value in the Message Switch Display you can display the message that corresponds to 
the cursor in the Alarm List Display.

• Refer to Chapter 20 “1.4 Script Error” on page 20-4 for details regarding LSD52 and LSD53.
• LSM7 and LSD6, 102 to 107 are not available for Slave units when using O/I link communication.
• The maximum number of the Screen Captures stored in the external memory device is set in LSD65. The 

value in LSD65 can be anywhere from 1 to 999. (The default value is 99.)
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This chapter describes the MICRO/I setup screen and how to perform setup.

  

1.1 Maintenance Screen Overview

Using the screen that is displayed when the MICRO/I is in Run Mode, you can switch from Run Mode to System Mode 
and load a screen to adjust device monitor and screen brightness.

Maintenance screen functions are indicated below:

1.2 Displaying the Maintenance Screen

Press the upper-left corner of the MICRO/I screen for three seconds or more.
If the Base Screen is switched before three seconds have elapsed, the load operation for the maintenance screen will 
be canceled. Please press it again.

Chapter 29 MICRO/I Setup

1 Maintenance Screen

Button Description

System Mode
Switch the MICRO/I to System Mode. In System Mode, the MICRO/I can be changed to its initial 
settings and data can be initialized.
For details, refer to “2 System Mode Overview” on page 29-3.

Device Monitor
Shows the Device Monitor. This screen can be used to register device addresses and monitor and 
change values of device addresses. For details, refer to Chapter 23 “2.2 Device Monitor” on page 
23-19.

Adjust Brightness Shows the adjust brightness screen. This screen is used to adjust the brightness of the MICRO/I.

Maintenance

System Mode

Device Monitor

Adjust Brightness

If a password has been configured for the project data and press System Mode or Device Monitor, the Enter 
Password screen will be displayed. Select a user name and then enter a password. For details, refer to 
Chapter 21 “User Accounts and the Security Function” on page 21-1.

Press and hold 
3 or more seconds

MICRO/I

• To display the maintenance screen, select the Enable Maintenance check box under the System tab 
in the Project Settings dialog box.

• If a touch switch is placed in the upper-left corner of the screen, switching to the maintenance screen 
will not be possible.
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1.3 Adjusting Screen Brightness

1 On the maintenance screen, press Adjust Brightness.

The Adjust Brightness screen is displayed.

Also, press  or  to adjust to your preferred brightness.

Maintenance

System Mode

Device Monitor

Adjust Brightness

×Maintenance

＜＜ ＞＞
Adjust Brightness

Screen brightness can be adjusted using methods other than the ones listed above.

•  or  buttons on the Top Page in System Mode
• Changing the values for HMI Special Data Register LSD51.
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The System Mode allows you to access the internal MICRO/I initial settings, self diagnosis, and clearing logged data. 
In this mode, the project in the MICRO/I will not be running.

2.1 System Mode Screens

In the System Mode, the Top Page appears (as shown below).

The Top Page and the Main Menu screen display a symbol of Battery Level Status.

■ Battery Level Status

2 System Mode Overview

Top Page Main Menu screen

Press Main Menu to display the Main Menu screen 
shown in the right figure.

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16
2010/OCT/14/THU   14:56:44

Initial
Setting

Clock
Setting

Run System
Info.

TopPage Offline ExtMem
Device

Self
Diag.

Main
menu   ---   ---   ---

For information on accessing the MICRO/I System Mode, refer to “1.2 Displaying the Maintenance Screen” 
on page 29-1. 

Full Battery level is full.

Battery level is running low. (The “Battery Level Low” message appears at the top of the screen.)

Empty
Battery level is almost empty, or not inserted. (The “Replace Battery. Battery Level Low” message 
appears at the top of the screen.)

The Symbols depend on MICRO/I model.
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The Top Page and Main Menu screen have the items shown below. Pressing each button switches to the 
corresponding setting or operation screen.

■ Top Page

■ Main Menu screen

Item
Descriptions See page

HG2G-5T

Run Switches to Run Mode. Page 29-10

Offline Switches to Offline mode. Page 29-10

Main Menu Switches to Main Menu screen. Page 29-4

Item
Descriptions See page

HG2G-5T

Initial Setting
•Setup the settings relating to operation and communication parameters of 
the MICRO/I.

•Initialize the log data.
Page 29-6

Clock Setting Allows setting of the internal clock of the MICRO/I. Page 29-10

Offline Goes to Offline mode. Page 29-10

Run Goes to Run mode Page 29-10

System Info.
Displays information relating to the type No., projects, as well as system 
software of the current MICRO/I.

Page 29-11

Ext.Mem.Device Format USB flash drive. Page 29-11

Top Page Switches to Top Page. Page 29-11

Self Diag.
Executes self diagnosis of memory, the clock, the touch panel, display, 
communication, expansion interface and others.

Page 29-11

HG2G-5T can only display the screens of the System Mode in English.
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2.2 Names and Layout of Setup Menus

■ HG2G-5T

Ext. Device 1

Ext. Device 2

System Op. Backlight

Default Scr. No.

Autorun

O/I Link Set1
O/I Link Set2

Brightness

Comm. I/F

Comm.
Seq. Check

Offline

Op. Log
Touch PnlAdj

Ext. Device 3

Ext. Device 4

Ext. Device Retry Cycles
Time Out
Trans. Wait

Parameter1
Pass Through

Parameter2
Parameter3
Parameter4

Retry Cycles
Time Out
Trans. Wait

Parameter1
Pass Through

Parameter2
Parameter3
Parameter4

Retry Cycles
Time Out
Trans. Wait

Parameter1
Pass Through

Parameter2
Parameter3
Parameter4

Retry Cycles
Time Out
Trans. Wait

Parameter1
Pass Through

Parameter2
Parameter3
Parameter4

RS232C

IP Address
RS422/485

Default Gateway
Misc Setting
Ext. IP Address

Backlight

Sequent

Trace

System Info.

Self Diag.

Ext.Mem.Device

Fixed Points
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3.1 Initial Setting

Pressing Initial Setting in the Main Menu screen displays the setup screen. 
You can use this screen to input the settings for MICRO/I operation and communication parameters, and to clear the logs. 
To return to the Main Menu screen, press Main Menu at the top of the screen.

● System Op.
From the Main Menu screen, press Initial Setting, and then System Op. to display the system operation menu 
screen. 
You can use this screen to set the items below. Press the button for each item to set it.

■ Backlight

Backlight Control
Set the amount of time (in minutes) until the backlight brightness is reduced automatically when the screen is not 
touched or switched.

Auto Backlight OFF
Set the amount of time (in minutes) until the backlight turns off automatically when the screen is not touched or 
switched.
Procedure

1 From the Main Menu screen, press Initial Setting, System Op., and then Backlight.

2 Press the left/right buttons to select the item, and then enter the time until the backlight brightness is reduced 
automatically with the numeric keys.

3 Press the left/right buttons to select the item, and then enter the time until the backlight automatically turns off with 
the numeric keys.

4 Press SAVE to save the settings.

■ Start Time
This item sets the amount of time (in minutes) until communication with the external device starts after MICRO/I 
power ON. This can be used to synchronize boot times with the external device.
From the Main Menu screen, press Initial Setting, System Op., and then Start Time.
Enter the time with the keypad.
Press ENT to apply the entered value. 
Press CAN to cancel the entered value and display the currently set value.

3 Settings

• To return to the initial settings screen, press Init Set at the top of the screen.
• To return to the system operation menu screen from any of the settings screens below, press System 

Op. at the top of the screen.

• If you switch to another screen or change the value before pressing SAVE, the settings are not saved.
• Functions with the time set to 0 are disabled.

The setting is not updated if you display another screen before applying the setting.
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■ Details
The following items can be set.
• Whether or not to have a sound made when a touch switch is pressed.
• Select the screen number to be displayed as a binary number or BCD (binary coded decimal).
• To set blink cycle.
• Display the error message in Japanese or English.
From the Main Menu screen, press Initial Setting, System Op., and then Details.

Select the item to change using the  or  . The selected item is highlighted. Each press of CHG button changes 
the property of the selected item. Repeat this procedure until the desired properties are displayed. Press ENT to apply 
the entered value.

■ Default Screen No.
This item sets the No. (as a decimal value) of the screen to display after power ON. 
From the Main Menu screen, press Initial Setting, System Op., and then Default Scr. No..
Use the Keypad to enter the value. 
Press ENT to apply the entered value.
Press CAN to cancel the entered value and display the currently set value.

■ Password
Changes the password set for the user account.
If  security function is used, you will be able to change the password for the selected user account (either as an 
administrator or other users registered in the security group) from the touchscreen.
From the Main Menu screen, press Initial Setting, System Op., and then Password. 

Press  to change the user account.

Press Change Password to display the password input screen. 
Use the password input keys to enter a password from 4 to 15 characters. 
Pressing ENT applies the entered password and closes the password input screen.
Pressing CLR clears the password input field.

■ Autorun
Enables or disables the USB Autorun function.
When this option is enabled, Autorun function will be executed when a USB flash drive is inserted to MICRO/I.
From the Main Menu screen, press Initial Setting, System Op., and then Autorun.

The setting is not updated if you display another screen before applying the setting.

• The setting is not updated if you display another screen before applying the setting.
• If the Default Screen No. is set to 0, MICRO/I will display the screen set in the external device instead of 

the internal initial screen. For details, refer to Chapter 4 “System Area 1” on page 4-17.

• If you press CAN on the Password Screen, the setting is not updated and you return to the Password 
Screen.

• Pressing ENT without entering a password disables the password function.

When you do not assign a password to a project data, the Password is blank.

The setting is not updated if you display another screen before applying the setting.
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● Initialize
From the Main Menu screen, press Initial Setting, and then Initialize to display the initialization menu screen.
You can use this screen to set the following items. Press the button for each item to set it.

■ Alarm Log
Clears all the alarm log data.
From the Main Menu screen, press Initial Setting, Initialize, and then Alarm Log.
Press Yes to clear the Alarm Log data.

■ Data Log
Clears all the data logged from Data Log. 
From the Main Menu screen, press Initial Setting, Initialize, and then Data Log.
Press Yes to clear the Data Log data.

■ Op. Log
Clears all the operation log data.
From the Main Menu screen, press Initial Setting, Initialize, and then Op. Log.
Press Yes to clear the Operation Log data.

■ Touch Pnl Adj
Adjusts the analog touch panel.
From the Main Menu screen, press Initial Setting, Initialize, and then Touch Pnl Adj. The position of the analog 
touch panel is properly adjusted and set.
Press Yes and adjust the touch panel according to the instructions on the screen.

● Ext. Device
From the Main Menu screen, press Initial Setting, Ext.Device, and then Ext.Device 1, Ext.Device 2, 
Ext.Device 3 or Ext.Device 4 to display the menu screen for the external device communication.
To specify settings, press the button to select a choice. External Device Communication setting items vary based on 
the currently connected hardware. For details about settings, refer to the WindO/I-NV4 External Device Setup Manual.
If Not Use are selected from the Communication Driver, you cannot select this option.

● O/I Link
From the Main Menu, press Initial Setting, and then O/I Link to display the O/I link menu screen.
This screen presents information on the O/I Link.
Various settings can be made by pressing O/I Link Set1 or O/I Link Set2.

• To return to the initial settings screen, press Init Set at the top of the screen.
• To return to the initialization menu screen from any of the settings screens below, press Initialize at the 

top of the screen.

HG2G-5T

Press the center of each  symbol displayed on the screen, in 
the following order: lower-left corner, lower-right corner, upper-
right corner, upper-left corner of the MICRO/I screen.

Press the center of the symbol.

To return to the initial settings screen, press Init Set at the top of the screen.

• To return to the initial settings screen, press Init Set at the top of the screen.
• For details about settings, see the WindO/I-NV4 External Device Setup Manual.
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● Comm. I/F
From the Main Menu screen, press Initial Setting, and then Comm. I/F to display the communication interface 
settings menu screen.
You can use this screen to set the items below. Press the button for each item to set.

■ RS232C
Allows the setting of communication parameters for the Serial Interface (SERIAL1) (RS232C).
From the Main Menu screen, press Initial Setting, Comm. I/F, and then RS232C.

■ RS422/485
Allows the setting of communication parameters for the Serial Interface (SERIAL1) (RS422/485).
From the Main Menu screen, press Initial Setting, Comm. I/F, and then RS422/485.

■ IP Address
Use the following procedure to set the IP address and Subnet mask settings.
From the Main Menu screen, press Initial Setting, Comm. I/F, and then IP Address.
Press the left/right buttons to select an item, then use the Keypad to enter the IP address and subnet mask values. 
Press SAVE to save the settings.

■ Default Gateway
Specify the default gateway.
From the Main Menu screen, press Initial Setting, Comm. I/F, and then Default Gateway.
Press the left/right buttons to select an item, then use the Keypad to enter the default gateway value.
Press SAVE to save the settings.

■ Misc Setting
Specify whether to allow or prohibit Maintenance Communication via TCP/IP (refer to Chapter 22 “Using the online 
function for Ethernet communication” on page 22-6).
From the Main Menu screen, press Initial Setting, Comm. I/F, and then Misc Setting.
Each press of CHG changes the property of the selected item. Repeat this procedure until the desired properties are 
displayed. 
Press ENT to apply the entered value.

■ Ext. IP Address
Change the IP addresses of the External Device IDs for external devices.
From the Main Menu screen, press Initial Setting, Comm. I/F, and then Ext. IP Address.

Procedure
1 Press the left/right arrow buttons to select the External Device ID, and then enter a value of the External Device ID 

with the numeric keys.

2 Press the left/right arrow buttons to select the item, and then enter the IP address with the numeric keys.

3 Press SAVE to save the settings.

• To return to the initial settings screen, press Init Set at the top of the screen.
• Press Comm. I/F at the top of the screen to return to the communication interface settings menu.

The setting is not updated if you display another screen before applying the setting.

The setting is not updated if you display another screen before applying the setting.

The setting is not updated if you display another screen before applying the setting.

The settings are not saved if you display another screen or change the External Device ID before pressing 
SAVE.
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3.2 Clock Setting

Press Clock Setting in the Main Menu screen to display the clock settings screen. 
Use this screen to set MICRO/I’s internal clock. 
To return to the Main Menu screen, press Main Menu at the top of the screen.

Procedure

1 Press the left/right buttons to select an item, then use the Keypad to enter the date or time.

2 Press SAVE to save the date/time setting.

3.3 Offline

This mode allows you to change values of device addresses and to check the operation of project data on the MICRO/I. 
To return to the Main Menu screen, press Main Menu at the top of the screen.

Press Offline in the Main Menu screen to run under the offline mode.

3.4 Run

Switches to run mode and executes the project.

The setting is not updated if you display another screen before applying the setting.

• Using the Device Monitor Function in conjunction with the Monitor function is a more efficient means of 
debugging. For details, refer to Chapter 23 “2.2 Device Monitor” on page 23-19.

• Under offline mode, values of the external device addresses that are not used on the displayed screen are 
reset when the screen changes.
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3.5 System Info.

From the Main Menu screen, press System Info., and then press System or System 2 to display the system 
information screen. This screen displays information such as the MICRO/I type No., stored system software type and 
version No. 
To return to the Main Menu screen, press Main Menu at the top of the screen.

● System
From the Main Menu screen, press System Info., and then press System.
Displays the following settings:
• MICRO/I type No.
• MAC address
• Boot software version
• System software version
To return to the system information screen, press System Info. at the top of the screen.

● System 2
From the Main Menu screen, press System Info., and then press System 2.
Displays the following settings:
• Project file name
• External Device Communication 1 to 4 and Communication Interface

- External device manufacturer
- Communication driver name
- Communication driver version

To return to the system information screen, press System Info. at the top of the screen

● Font
From the Main Menu screen, press System Info., and then press Font.
Displays the font type stored in MICRO/I.
To return to the system information screen, press System Info. at the top of the screen.

3.6 Ext.Mem.Device

From the Main Menu screen, press Ext.Mem.Device, and then Format to format the USB flash drive.
To return to the Main Menu screen, press Main Menu at the top of the screen.

3.7 Top Page

Press Top Page in the Main Menu screen to return to the Top Page.

3.8 Self Diag.

Pressing the Self Diag. in the Main Menu screen displays the self-diagnosis screen. 
Use this screen to run MICRO/I internal self-diagnosis. To execute an operation, press the corresponding button. 
To return to the Main Menu screen, press Main Menu at the top of the screen.

Only the first 15 characters of the project name are displayed.

• You need inspection jigs to run self-diagnosis.
• Self Diagnosis is a special screen for factory inspections. Do not use without due reason.
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1.1 Packing content

Before installing the HG2G-5T, make sure that the specifications of the product conform to your requirements, and 
that no parts are missing or damaged due to accidents during transportation.

1.2 Type Number

Chapter 30 MICRO/I Specifications

1 HG2G-5T

Name Pcs/pack

HG2G-5T Unit 1

Instruction Sheet
 (Japanese/English/Simplified Chinese)

1

Mounting clips 4

Communication plug for external devices
 (Attached to the HG2G-5T)

1

USB Cable Lock Pin 1

USB Clamp Band 1

LCD size Bezel color Type No.

5.7 inch TFT Monochrome LCD

Light gray HG2G-5TN22TF-W

Dark gray HG2G-5TN22TF-B

Silver HG2G-5TN22TF-S

5.7 inch TFT Color LCD

Light gray HG2G-5TT22TF-W

Dark gray HG2G-5TT22TF-B

Silver HG2G-5TT22TF-S
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1.3 Part Names

No. Name Description

(1) POWER LED
Green (lit) : Normal Operation (Power is ON.)
Not lit : Power is off.

(2) Display

(3) Touch Panel

(4) Power Supply Terminal

(5) Serial Interface (SERIAL1)
RS232C, RS422/485
Connector : Terminal Block 9 pin

(6) Ethernet Interface (LAN)

IEEE802.3u
10BASE-T/100BASE-TX
Connector : RJ-45
(With Auto MDI/MDI-X function)

(7) Battery Cover

(8) Terminating Resistor Selector Switch For RS422/485 interface

(9) Mounting Clip Position 

(10) USB Interface (USB)
USB2.0 (Device)
Connector : Mini-B

(11) USB Interface (USB2)
USB2.0 (Host)
Connector: Type A

(2) (3) (7)(9)(9)

(1)(6) (4) (9) (8) (5) (9) (10) (11)
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1.4 External Interfaces

● Serial Interface (SERIAL1)
Use applicable cables for wiring and recommended ferrules (made by Phoenix Contact) as follows.

• Terminating Resistor Selector Switch (for RS422/485 interface)

When using RS422/485 interface of the serial interface (SERIAL1), set the Terminating Resistor Selector Switch to the 
ON side. This will connect the internal terminating resistor (100Ω) between RDA and RDB.

  CAUTION

Make sure to turn off the power to the HG2G-5T before wiring each interface or switching the 
terminating resistor selector Switch.

Interface Specification RS232C, RS422/485

Connector Detachable Terminal Block 9 pin

Applicable cable AWG20 to AWG22

Recommended Pressure Terminal

AI 0.34-8 TQ
AI 0.5-8 WH
AI-TWIN 2 x 0.5-8 WH
(Phoenix Contact)

Tightening Torque 0.22 to 0.25 N·m

No. Name I/O Function Communication type

1 SD OUT Send Data

RS232C

2 RD IN Receive Data

3 RS OUT Request to Send

4 CS IN Clear to Send

5 SG - Signal Ground

RS422/485

6 SDA OUT Send Data (+)

7 SDB OUT Send Data (-)

8 RDA IN Receive Data (+)

9 RDB IN Receive Data (-)

No.9No.1

ON OFF 
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1.5 Specifications

■ Applicable Standards

■ Environmental Specifications

■ Electrical Specifications

■ Construction Specifications

Safety Standard
UL508, ANSI/ISA 12.12.01,
CSA C22.2 No.142 (c-UL),
CSA C22.2 No.213 (c-UL)

EMC Standard IEC/EN 61131-2

Operating Temperature -20 to +60°C

Operating Humidity 10 to 90% RH (no condensation)

Storage Temperature -20 to +70°C

Storage Humidity 10 to 90% RH (no condensation)

Altitude 0 to 2000m

Pollution Degree 2

Corrosion Immunity Free from corrosive gases

Rated Voltage 12V DC / 24V DC

Power Consumption
8W maximum
When not using USB Interface (USB2): 4W maximum

Power Voltage Range 10.2V DC to 28.8V DC

Allowable Momentary Power 
Interruption

10 ms maximum (Power supply: 20.4V DC to 28.8V DC)
1 ms maximum (Power supply: 10.2V DC to 20.4V DC)

Inrush Current 40A maximum

Dielectric Withstand Voltage 1000V AC, 10mA, 1 minute (between power and earth terminals)

Vibration

5 to 8.4Hz amplitude 3.5mm,

8.4 to 150Hz acceleration 9.8m/s2

10 times on each of three mutually perpendicular axes (100 minutes)
(IEC61131-2)

Shock 147m/s2, 11ms (5 shocks on each of three mutually perpendicular axes)   
 (IEC61131-2)
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■ Performance Specifications

■ EMC Specifications

*1 The backlight life refers to the time until the surface brightness reduces to a half after using continuously at 25°C.
*2 The degree of protection for the operating section after the panel is attached. The compliance test has been passed, but this 

is not a guarantee of operation in all environments.
*3 Not a guarantee in all usage environments with oil materials.

Type No. HG2G-5TN HG2G-5TT

Display

LCD Type TFT Monochrome LCD TFT Color LCD

Display Colors 2 Colors (16 tones) 65536 Colors

Effective Display 
Area [mm]

115.2 (W) × 86.4 (H)

Display Resolution 320 (W) × 240 (H) pixels

View angle Left/Right: 65°, Top: 80°, Bottom: 60° Left/Right: 80°, Top: 80°, Bottom: 80°

Brightness of LCD 
only 1100 [cd/m2] 500 [cd/m2]

Backlight LED

Backlight Life*1 100,000 hours nominal

Touch Panel

Switch Type Analog Resistive Film

Operating Force 3N maximum

Multiple Operations Impossible

Life 1,000,000 operations

User Memory 5MB

Backup Battery
CR2032 lithium primary battery
Guarantee Period: 1 Year (operating temperature at 25°C)
Recommended Replacement Span: Every 4 Years (operating temperature at 25°C)

Backup Data Calendar, Log Data, HMI Keep Register/Relay

Buzzer output Single tone (tone length is adjustable)

Degree of Protection

IP66 F(IEC60529)*2

TYPE 4X

TYPE 13*3

When the panel thickness is less than 1.5 mm: IP65F

Weight (approx.) 500g

Radiated Emission
Class A : 10m
40dBµV/m quasi-peak (30M to 230MHz)
47dBµV/m quasi-peak (230M to 1GHz)

Electrostatic Discharge
Contact : ±6kV
Air : ±8kV

Electromagnetic Field

10V/m (80 to 1000 MHz)
3V/m (1.4 to 2.0 GHz)
1V/m (2.0 to 2.7 GHz)
80% AM (1kHz)

Fast Transient Burst
Power : ±2kV
Communication cable : ±1kV

Surge Immunity
±500V (between +24V-0V)
±1kV (between +24V-FE, 0V-FE)

Conducted Radio
Frequency Immunity

3V (Power, Communication cable)
(150kHz to 80MHz)
80% AM (1kHz)
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Notes related to emissions
In order to meet the emission specifications for the HG2G-5T, attach a ferrite core to the power cables and 
communication cables.
   Recommended ferrite core: ZCAT3035-1330 manufactured by TDK Corporation

Power supply
section

+ - FE

Communication
section

External device

MICRO/I

DC power supply

Attach the ferrite core near the 
power supply section of the power 
cables connected to the MICRO/I 
unit.

Attach the ferrite cores according to 
the usage conditions of the external 
devices, surrounding environment, and 
the cables.
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1.6 Dimensions

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change. 
The dimensions given here are representative values and are intended for reference only.

Unit: mm

12
0.

0

13
4.

7

43
.6

35
.9

5.
0

167.2

152.5

Unit: mm

45

35.9 53 152.5

12
0.

0
50
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1.7 Installation

● Operating Environment
For designed performance and safety of the HG2G-5T, do not install the HG2G-5T in the following environments:

• Where dust, briny air, or iron particles exist.
• Where oil or chemical splashes for long time.
• Where oil mist is filled.
• Where direct sunlight falls on the HG2G-5T.
• Where strong ultraviolet rays fall on the HG2G-5T.
• Where corrosive or combustible gasses exist.
• Where the HG2G-5T is subjected to shocks or vibrations.
• Where condensation occurs due to rapid temperature change.
• Where high-voltage or arc-generating equipment (electromagnetic contactors or circuit protectors) exists in the 

vicinity.

● Ambient Temperature
• Allow sufficient space for ventilation, and install the equipment away from heat sources.
• Allow at least 100mm between the HG2G-5T and walls or other equipment.
• Do not install the HG2G-5T where the ambient temperature exceeds the rated operating ambient temperature 

range. When mounting the HG2G-5T in such locations, provide a forced air-cooling fan or air-conditioner to keep 
the ambient temperature within the rated temperature range.

● HG2G-5T Installation
• Make a panel cut-out on the panel with the dimensions shown below.

                       Unit: mm

• Place the HG2G-5T in a panel cut-out and fasten with the attached mounting clips at four places of the top and 
bottom side to a specified torque of 0.2 to 0.3 N·m uniformly.
The HG2G-5T has the mounting clip positions not only on the top and bottom side but also on the left and right 
side. But when fasten with the attached mounting clips at the left and right side, the HG2G-5T may impair the 
waterproof, the vibration resistance, and the shock resistance characteristics.

  CAUTION

• Do not tighten excessively, otherwise the HG2G-5T may warp and cause wrinkle on the display, or 
impair the waterproof characteristics.

• If the mounting clips are tightened obliquely to the panel, the HG2G-5T may fall off the panel.
• When installing the HG2G-5T into a panel cut-out, make sure that the gasket is not twisted. 

Especially when re-installing, take special care because any twists in the gasket will impair the 
waterproof characteristics.

A B Panel Thickness

121.0
+2.0
  0

153.0
+2.0
  0

1.0 to 5.0

B 

A 

Mounting Clip

Mounting Clip

Panel 
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1.8 Wiring

● Power Supply Terminal
• Pin assignment is shown in the following table.

• Use applicable cables for wiring and recommended ferrules (made by Phoenix Contact) as follows.

● Cautions for using the HG2G-5T connected to a personal computer
When connecting the HG2G-5T to a personal computer via the USB Interfaces, the HG2G-5T or the personal 
computer may break down depending on the conditions of the personal computer. Make sure of the following 
cautions, in order to prevent an accident.
• If the personal computer has a 3-pin power plug or power plug with a ground lead type, make sure to use a plug 

socket including a ground input electrode or ground the earth lead, respectively.
• If the personal computer has a 2-pin power plug without ground lead, follow the procedure below when connect 

the HG2G-5T to the personal computer.
(1) Pull out the power plug of the personal computer from the AC outlet.
(2) Connect the HG2G-5T to the personal computer.
(3) Insert the power plug of the personal computer into the AC outlet.

  CAUTION

• Turn off the power supply before wiring.
• Make the wiring as short as possible and run all wires as far away as possible from high-voltage 

and large-current cables. Follow all the procedures and precautions when wiring the HG2G-5T.
• Separate the HG2G-5T power supply wiring from the power lines of I/O devices and motor 

equipment.
• Ground the functional earth terminal to make sure of correct operation.

+ Power supply 12V DC / 24V DC

- Power supply 0V 

Functional Earth (FE)

Applicable cable AWG18 to AWG22

Recommended 
Pressure Terminal

AI 0.34-8 TQ
AI 0.5-8 WH
AI 0.75-8 GY
AI 1-8 RD
AI-TWIN 2 x 0.5-8 WH
AI-TWIN 2 x 0.75-8 GY
AI-TWIN 2 x 1-8 RD
(Phoenix Contact)

Tightening Torque 0.5 to 0.6 N·m
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1.9 USB Cable Lock Pin Attachment

When using the USB device, attach the USB Cable Lock Pin to prevent disconnecting the USB cable from the HG2G-5T.

1 Insert the USB cable into the USB2 port.

2 Strain the [Edge part] of the USB Cable Lock Pin, and insert the [Edge part] to the 2 holes lower the USB2 port.

3 Fasten the USB Clamp Band around the USB cable and the [Clamp part], secure them tightly.

Clamp partEdge part

Lower 
holes

Fasten the USB Clamp Band without the space between the [Clamp part] and it, and the inclination.

Correct Incorrect Incorrect
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1.10 Maintenance and Inspection

Maintain and inspect the HG2G-5T periodically to ensure the best performance. Do not disassemble, repair, or modify 
the HG2G-5T during inspection.

● Replacing the Backup Battery
A backup battery is built into the HG2G-5T to retain the internal backup data (log data, keep resister, and keep relay) 
and clock data.
When the “Replace the battery” message is displayed, replace the backup battery by following the procedure below.
When the “Battery level LOW” message is displayed, replace the battery immediately; otherwise, the backup data and 
clock data may be lost. 
Whether or not to display the reminder message for battery replacement can be specified with the configuration 
software. Refer to Chapter 4 “3.1 System Tab” on page 4-13 for details.

1 Remove the battery holder cover.

2 Turn on the power to the HG2G-5T, wait for approximately one minute, and then turn off the power again.

3 Insert a flathead screwdriver into the battery holder as shown in the figure, and remove the battery. The battery may 
pop out from the battery holder.

Display
Wipe any stain of the display using a soft cloth slightly dampened with neutral detergent or 
alcoholic solvent. Do not use solvents such as thinner, ammonia, strong acid, and strong 
alkaline.

Terminals, Connectors
Check the terminals and connectors to make sure of no loose screws, incomplete insertion, or 
disconnected lines.

Mounting Clips
Make sure that all mounting clips and screws are tightened sufficiently. If the mounting clips 
are loose, tighten the screw to the recommended tightening torque.

Backlight
The HG2G-5T’s backlight cannot be replaced by the customer. When the backlight needs to be 
replaced. Contact your vendor or IDEC Corporation.

Backup Battery
The operating life of the internal battery is approximately four years. It is recommended to 
replace the battery every four years even before the reminder message for battery replacement 
is displayed.

Touch Panel
A gap may be caused in the operation accuracy of the touch panel by the secular distortion, 
etc. Readjust the touch panel according to the following procedure when there is a gap in the 
operation of the touch panel.

After turning off the power to the HG2G-5T in step 2, complete the steps through 4 within 30 seconds to 
replace the battery without losing the backup data and clock data. However, it is recommended that the 
backup data be transferred to flash memory as a precautionary measure. For the procedure to transfer the 
data to flash memory, refer to Chapter 28 “Internal Devices” on page 28-1. If it is not necessary to save the 
data, step 2 can be skipped.
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4  Put a new replacement battery into the battery holder.

5 Replace the battery holder cover into the original position. Replace the battery holder cover on the HG2G-5T, and turn 
it clockwise to lock the cover.

• The operating life of the internal battery is approximately four years. It is recommended to replace the battery 
every four years even before the reminder message for battery replacement is displayed.

• IDEC provides replacement service for the battery (at customer’s expense). Contact your vendor or IDEC 
Corporation.

Handling of Batteries and Devices with Built-in Batteries in EU Member States

Note) The following symbol mark is for EU countries only and is according to the directive 2006/66/EC Article 20 
information for end-users and Annex II.

This symbol mark means that batteries and accumulators, at their end-of life, should be disposed of separately from 
your household waste.

If a chemical symbol is printed beneath the symbol shown above, this chemical symbol means that the battery or 
accumulator contains a heavy metal at a certain concentration. This will be indicated as follows :
Hg : mercury (0.0005%), Cd : cadmium (0.002%), Pd : lead (0.004%)

In the European Union there are separate collection systems for used batteries and accumulators.
Please dispose of batteries and accumulators correctly in accordance with each country or local regulation.

 WARNING

The battery may be regulated by national or local regulation. Observe the instructions of proper 
regulation. As electric capacity is left in a discarded battery and it comes into contact with other 
metals, it could lead to distortion, leakage, overheating, or explosion, so make sure to cover the (+) 
and (-) terminals with insulating tape before disposal.

 CAUTION

When replacing the battery, use the specified battery only. Note that any problems and failures 
arising from or in connection with the use of a battery other than the specified battery is not 
guaranteed.
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● Maintenance Screen
Turn on the power to the HG2G-5T, then press and hold the touch panel on the upper-left corner of the screen for 
three seconds or longer. The Maintenance Screen appears on the screen.

• Permission to show the Maintenance Screen can be set using the WindO/I-NV4. Refer to Chapter 4 “3.1 System 
Tab” on page 4-13 for details.

• The Maintenance Screen is not displayed in the System Mode.

● System Mode
Press the [System Mode] at the top of the Maintenance Screen. The Top Page Screen appears.

Initial Setting, Self Diagnosis and Initialization of the data, etc can be executed in the System Mode.

● Adjusting the Brightness
The brightness of the HG2G-5T display can be adjusted on the Adjust Brightness Screen.

1 Press the [Adjust Brightness] at the bottom of the Maintenance Screen. 
The Adjust Brightness Screen appears.

2 Press the [<<] and [>>] at the bottom of the Adjust Brightness Screen to adjust the brightness to the optimal 
setting. 

Maintenance Screen 

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16
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3 Press the [X] to close the Adjust Brightness Screen.

To adjust the brightness in the System Mode, use the [<<] and [>>] buttons located at the bottom of the Top Page.

● Adjusting the Touch Panel
A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. Readjust the touch 
panel according to the following procedure when there is a gap in the operation of the touch panel.

• Touch panel adjustment procedure

1 Press the [Main Menu], then the Main Menu Screen appears.

2 Press in order of [Initial Setting] → [Initialize] → [Touch PnlAdj]. The confirmation screen appears and asks “Adjust 
Touch Panel Setting?”

Press the [Yes], then the Touch Panel Adjust screen appears.

3 Press the center of the X mark, then the position of the mark changes one after another. Press five marks 
sequentially.

4 When normally recognized, the confirmation screen of 2 is restored.

At procedure 3, when pressing a point away from the center of the X mark, a recognition error will result. Then the X 
mark returns to the initial position, then repeat the procedure of 3 again.

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16

Press the center of the symbol.

Make sure to press the center of the mark. This will ensure the accuracy of the touch panel operation.
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2.1 HG2G-5T

● Options

● Replacement Parts

*1 The protective sheet is UV resistant, however, resistance against direct sunlight in outdoor usage is not guaranteed.

2 Options

Name Type No. Description

Maintenance Cable HG9Z-XCM42

USB cable to connect to a computer
Length: 2m
<Connector>
HG: USB Mini-B
Computer: USB Type-A

USB Panel-Mount Extension 
Cable

HG9Z-XCE11
Extension cable for attaching to USB2 (Type-A) port on front 
panel
Length: 1m

HG9Z-XCE21
Extension cable for attaching to USB (Mini-B) port on front 
panel
Length: 1m 

PLC Connection Cable

FC2A-KP1C

For IDEC · MICROSmart, OpenNet controller
Length: 2.4m
<Connector>
HG: Parted Wire
Host: Mini-DIN 8pin

HG9Z-XC275

For IDEC · MICROSmart, OpenNet controller
Length: 5m
<Connector>
HG: Parted Wire
Host: Mini-DIN 8pin

Protective Sheet *1 HG9Z-2D5PN05 5 pcs/pack

Protective Cover HG9Z-2E2PN03
To Cover the front of HG, and to protect Display from 
chemicals
3 pcs/pack

Name Type No. Description

Mounting Clip SLD-K02PN10 10 pcs/pack

Replacement Battery HG9Z-XR1 CR2032 lithium primary battery

Communication Plug for 
external devices

HG9Z-XT09V
Vertical type 
Wiring Direction: Bottom of HG

HG9Z-XT09
Horizontal type
Wiring Direction: Backside of HG

USB Cable Lock Pin HG9Z-XU1PN05
For USB2 (Type-A) port
5 pcs/pack
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31

Troubleshooting

This chapter describes the errors that may occur with the MICRO/I and the measures necessary to correct these 
errors.

  

The MICRO/I displays a variety of error messages in order to assist you in quickly analyze and resolve problems with 
the hardware, communications system, and user screen data.

1.1 Errors Displayed on the Screen

The following error messages are displayed in the event of communication system problems and problems with user 
screen data. When an error occurs, take the appropriate indicated action. If an error persists despite your attempts to 
correct it, contact your vendor or IDEC Corporation.

Chapter 31 Troubleshooting

1 Error Messages

Error Message Cause Solution
Waiting for default 
screen No.

The default screen number is set at 0. Either write the screen number to the 
System Area display screen number 
region, or set the initial screen 
number to a number other than 0.

No screen data The specified Base Screen does not exist. Set the Base Screen and download it 
to the MICRO/I.

No USB flash drive exists No USB flash drive inserted when the unit attempted to access 
the USB flash drive.

Insert a USB flash drive.

This USB flash is not 
available

• The type of USB flash drive is not recognized.
• The USB flash drive is broken.

Please use a new recommended USB 
flash drive.

USB flash Drive Access 
Error

When the unit attempted to access the USB flash drive:
• The USB flash drive did not have enough free space.
• The USB flash drive was removed partway through.
• The USB flash drive was broken.

Create some free space on the USB 
flash drive or get a new one.

ZNV file is not found The project file (ZNV format) was not in the specified location 
on the external memory device when a download was made 
using the Project Data Transfer function.

Check whether or not the file is in the 
specified location on the external 
memory device.

ZLD file is not found The PLC Program file (ZNV format) was not in the specified 
location on the external memory device when a download was 
made using the PLC Program Transfer function.

Check whether or not the file is in the 
specified location on the external 
memory device.

ZNV file format Error When a download was made using the Project Data Transfer 
function:
• The project file is not in ZNV format.
• The file is corrupt.

Remake the project file (ZNV format).

ZLD file format Error When a download was made using the PLC Program Transfer 
function:
• The PLC Program file is not in ZLD format.
• The file is corrupt.

Remake the PLC Program file (ZLD 
format).

Product Series is not 
correct

When a download was made using the Project Data Transfer 
function, the model of the downloaded project and the model of 
the destination MICRO/I were different

Check that the model name that is set 
in the file you want to download is the 
same as the model name of the 
destination MICRO/I.

PLC Type is not correct When a download or upload was made using the PLC Program 
Transfer function:
• The model of the downloaded PLC Program and the model 

of the destination PLC were different.
• The runtime program version using the downloaded PLC 

Program and the one of the destination PLC were different.

Check PLC models and runtime 
program versions.

PLC Password is not valid When a download or upload was made using the PLC Program 
Transfer function, the password you entered was incorrect.

Enter the correct password.

PLC communication Error When a download or upload was made using the PLC Program 
Transfer function, a communication problem with the PLC 
occurred.

It is possible that there is a problem 
with the connection with the PLC. 
Check the connection between 
MICRO/I and the PLC.



1 Error Messages

31-2 WindO/I-NV4 User’s Manual

Insufficient memory 
error

The resource memory of the HG is insufficient because of the 
use of a large number of the following parts.
• Pilot Lamps, Multi-State Lamps, and Picture Displays.
• Message Display, Message Switching Display, and Alarm List 

Display with the Scroll checkbox is selected.
• Line Chart with the Display cursor checkbox is selected.
• Parts over the number limit of parts that can be set per 

screen by overlapping Base Screen.

Clear the Scroll or Display cursor 
checkbox, or delete parts to reduce 
memory resource utilization.

Device write error The script generated a lot of write data, and the write operation 
failed.

Reduce the number of write 
operations to be performed at the 
same time.

Communication Error An error occurred during communication with the external 
device.

Check the communication lines and 
the communication settings.
The External Device ID and external 
device name on which the Communication 
error has occurred are displayed.

Processing error • A value is divided by 0.
• There is data which cannot be handled with the specified 

data type; BCD4(B), BCD8(EB), or Float32(E).
• The setting of Origin, Minimum, or Maximum for the Bar 

Chart or Line Chart are invalid, or the Minimum and 
Maximum are the same values.

• The setting of Minimum, Maximum, or ranges for the Meter 
are invalid, or the Minimum and Maximum are the same 
values.

• There is invalid clock data which is used in Calendar parts.

Check the calculation or settings.

Device range error • The data is written to the device with the address out of the range.
• The number of device addresses exceeds the limitation.

Check the device address settings.

Script error An error occurred for a process in execution of the script. Check the value of LSD52 and LSD53, 
and correct the script. For details, 
refer to Chapter 20 “Script” on page 
20-1.

Network off-line This error message is only displayed when O/I Link is being 
used.

For details, see the WindO/I-NV4 
External Device Setup Manual.

Error Message Cause Solution
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1.2 Low Battery Voltage

An internal battery maintains clock settings and log data in the MICRO/I. When the battery runs out, keep register 
data, log data and other backup data will be cleared, and the contrast is reset to the default value. If this happens, 
the following message is displayed when the MICRO/I is powered up, so take the indicated action.

In this case, Bit 14 (backup data error) of address number + 2 in System Area 2 is set, and it is reset when MICRO/I 
is powered on.

The following warning messages will be displayed before the battery is dead.
In this case, the Bit 12 (Replace battery error) or Bit 13 (Replace battery error) of address number + 2 in the System 
Area 2 is set, and it is set whenever the MICRO/I is powered on.

To display the warning message, in the Project Settings dialog box, on the System Settings tab, select the 
Battery warning message check box.

Message Description

Backup data lost Replace the battery.
The Log Data and Calendar Data are lost. Set the clock again. 

In case of storing Keep Memory and Keep Relay to the flash memory using HMI Special Internal Relay 
LSM10, stored data is transferred to the memory automatically when Backup data is lost.

Message Description

Replace battery The remaining battery revel is low. Replace the battery in a short time.

Replace battery
(Battery level LOW)

The remaining battery revel is lowest. Replace the battery immediately, otherwise backup 
data will be lost.
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2.1 When You Cannot Download Project Data

If you are unable to download project data from the WindO/I-NV4, press the top left corner of the panel for three 
seconds or longer while at the same time turning the power off and back on again.

The screen in the System Mode is displayed, and then MICRO/I becomes downloadable status. If you download via 
Ethernet, check again the setting of TCP/IP before executing the download.
Also, when MICRO/I does not show the System Mode screen and continues a blackout having a bleep each second, 
be sure to download using Serial Interface 2 or port for USB.

2.2 If the backlight is OFF and the buzzer sounds

If you fail to download the runtime program to MICRO/I, the backlight may turn to OFF and a beep may sound 
continuously every second, even after the power has been turned off and on again. Rectify the situation by 
downloading the project using WindO/I-NV4 via USB cable.

2.3 Touch Panel Does Not Respond Correctly

If the touch panel needs to be readjusted, then go to the System Mode to readjust the touch panel. For details about 
adjusting method, refer to Chapter 29 “Touch Pnl Adj” on page 29-8.

2.4 Power LED light is OFF

If the LED on the front of MICRO/I does not light up when power is turned ON, it may indicate a problem exists in the 
main unit. Contact your vendor or IDEC Corporation.

2 Handling Problems

MICRO/I

When the backlight is OFF and the buzzer sounds, you cannot download the project to MICRO/I via Ethernet 
or using an external memory.
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Appendix

This chapter contains the color number, and describes details about the Color Palette and other settings used in 
WindO/I-NV4.

  

● Color Data Correspondence Table
This table is used when using Message Display and Script. Select a value from the Data column of the table and you 
can change the display color of an object by values of device addresses.

Appendix

1 Color Number

Color No. Data Color No. Data Color No. Data Color No. Data Color No. Data Color No. Data
000 0x00 045 0x2D 086 0x56 127 0x7F 167 0xA7 207 0xCF
001 0x01 046 0x2E 087 0x57 128 0x80 168 0xA8 208 0xD0
002 0x02 047 0x2F 088 0x58 129 0x81 169 0xA9 209 0xD1
003 0x03 048 0x30 089 0x59 130 0x82 170 0xAA 210 0xD2
004 0x04 049 0x31 090 0x5A 131 0x83 171 0xAB 211 0xD3
005 0x05 050 0x32 091 0x5B 132 0x84 172 0xAC 212 0xD4
006 0x06 051 0x33 092 0x5C 133 0x85 173 0xAD 213 0xD5
007 0x07 052 0x34 093 0x5D 134 0x86 174 0xAE 214 0xD6
008 0x08 053 0x35 094 0x5E 135 0x87 175 0xAF 215 0xD7
009 0x09 054 0x36 095 0x5F 136 0x88 176 0xB0 216 0xD8
010 0x0A 055 0x37 096 0x60 137 0x89 177 0xB1 218 0xDA
011 0x0B 056 0x38 097 0x61 138 0x8A 178 0xB2 219 0xDB
012 0x0C 057 0x39 098 0x62 139 0x8B 179 0xB3 220 0xDC
013 0x0D 058 0x3A 099 0x63 140 0x8C 180 0xB4 221 0xDD
014 0x0E 059 0x3B 100 0x64 141 0x8D 181 0xB5 223 0xDF
019 0x13 060 0x3C 102 0x66 142 0x8E 182 0xB6 224 0xE0
020 0x14 062 0x3E 103 0x67 143 0x8F 183 0xB7 225 0xE1
021 0x15 063 0x3F 104 0x68 144 0x90 184 0xB8 226 0xE2
022 0x16 064 0x40 105 0x69 145 0x91 185 0xB9 227 0xE3
023 0x17 065 0x41 106 0x6A 146 0x92 186 0xBA 228 0xE4
024 0x18 067 0x43 107 0x6B 147 0x93 187 0xBB 229 0xE5
025 0x19 068 0x44 108 0x6C 148 0x94 188 0xBC 230 0xE6
026 0x1A 069 0x45 109 0x6D 149 0x95 189 0xBD 231 0xE7
027 0x1B 070 0x46 110 0x6E 150 0x96 190 0xBE 232 0xE8
028 0x1C 071 0x47 111 0x6F 151 0x97 191 0xBF 233 0xE9
029 0x1D 072 0x48 112 0x70 152 0x98 192 0xC0 234 0xEA
030 0x1E 073 0x49 113 0x71 153 0x99 193 0xC1 236 0xEC
032 0x20 074 0x4A 114 0x72 154 0x9A 194 0xC2 237 0xED
033 0x21 075 0x4B 115 0x73 155 0x9B 195 0xC3 238 0xEE
034 0x22 076 0x4C 116 0x74 156 0x9C 196 0xC4 239 0xEF
035 0x23 077 0x4D 118 0x76 157 0x9D 197 0xC5 241 0xF1
037 0x25 078 0x4E 119 0x77 158 0x9E 198 0xC6 242 0xF2
038 0x26 079 0x4F 120 0x78 160 0xA0 199 0xC7 243 0xF3
039 0x27 080 0x50 121 0x79 161 0xA1 200 0xC8 244 0xF4
040 0x28 081 0x51 122 0x7A 162 0xA2 201 0xC9 245 0xF5
041 0x29 082 0x52 123 0x7B 163 0xA3 202 0xCA 246 0xF6
042 0x2A 083 0x53 124 0x7C 164 0xA4 204 0xCC 255 0xF7
043 0x2B 084 0x54 125 0x7D 165 0xA5 205 0xCD
044 0x2C 085 0x55 126 0x7E 166 0xA6 206 0xCE
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● Windows RGB Value Correspondence Table
The color numbers correspond to the following Windows RGB values.

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

000 000000 045 666600 086 CC9933 127 00CC66 167 CC0099 207 99FFCC

001 11111 046 996600 087 999933 128 33CC66 168 FF0099 208 66FFCC

002 222222 047 CC6600 088 669933 129 66CC66 169 FF3399 209 33FFCC

003 333333 048 FF6600 089 339933 130 99CC66 170 CC3399 210 00FFCC

004 444444 049 FF9900 090 009933 131 CCCC66 171 993399 211 00CCFF

005 555555 050 CC9900 091 000033 132 FFCC66 172 663399 212 33CCFF

006 666666 051 999900 092 330033 133 FFFF66 173 333399 213 66CCFF

007 777777 052 669900 093 660033 134 CCFF66 174 003399 214 99CCFF

008 888888 053 339900 094 990033 135 99FF66 175 0000CC 215 CCCCFF

009 999999 054 009900 095 CC0033 136 66FF66 176 3300CC 216 FFCCFF

010 AAAAAA 055 00CC00 096 FF0033 137 33FF66 177 6600CC 218 CCFFFF

011 BBBBBB 056 33CC00 097 FF3333 138 00FF66 178 9900CC 219 99FFFF

012 CCCCCC 057 66CC00 098 CC3333 139 00CC99 179 CC00CC 220 66FFFF

013 DDDDDD 058 99CC00 099 993333 140 33CC99 180 FF00CC 221 33FFFF

014 EEEEEE 059 CCCC00 100 663333 141 66CC99 181 FF33CC 223 0066FF

019 000088 060 FFCC00 102 003333 142 99CC99 182 CC33CC 224 3366FF

020 0000FF 062 CCFF00 103 000066 143 CCCC99 183 9933CC 225 6666FF

021 008888 063 99FF00 104 330066 144 FFCC99 184 6633CC 226 9966FF

022 00FFFF 064 66FF00 105 660066 145 FFFF99 185 3333CC 227 CC66FF

023 008800 065 66FF00 106 990066 146 CCFF99 186 0033CC 228 FF66FF

024 00FF00 067 00CC33 107 CC0066 147 99FF99 187 0066CC 229 FF99FF

025 888800 068 33CC33 108 FF0066 148 66FF99 188 3366CC 230 CC99FF

026 FFFF00 069 66CC33 109 FF3366 149 33FF99 189 6666CC 231 9999FF

027 880000 070 99CC33 110 CC3366 150 00FF99 190 9966CC 232 6699FF

028 FF0000 071 CCCC33 111 993366 151 006699 191 CC66CC 233 3399FF

029 880088 072 FFCC33 112 663366 152 336699 192 FF66CC 234 0099FF

030 FF00FF 073 FFFF33 113 333366 153 666699 193 FF99CC 236 3300FF

032 330000 074 CCFF33 114 003366 154 996699 194 CC99CC 237 6600FF

033 660000 075 99FF33 115 006666 155 CC6699 195 9999CC 238 9900FF

034 990000 076 66FF33 116 336666 156 FF6699 196 6699CC 239 CC00FF

035 CC0000 077 33FF33 118 996666 157 FF9999 197 3399CC 241 FF33FF

037 FF3300 078 00FF33 119 CC6666 158 CC9999 198 0099CC 242 CC33FF

038 CC3300 079 006633 120 FF6666 160 669999 199 00CCCC 243 9933FF

039 993300 080 336633 121 FF9966 161 339999 200 33CCCC 244 6633FF

040 663300 081 666633 122 CC9966 162 009999 201 66CCCC 245 3333FF

041 333300 082 996633 123 999966 163 000099 202 99CCCC 246 0033FF

042 003300 083 CC6633 124 669966 164 330099 204 FFCCCC 255 FFFFFF

043 006600 084 FF6633 125 339966 165 660099 205 FFFFCC

044 336600 085 FF9933 126 009966 166 990099 206 CCFFCC
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The View Browser displays the list of graphics that have been prepared in advance in WindO/I-NV4. The settings 
displayed on View Browser vary based on the parts.
These graphics can be used as the outline of parts.
Example: Bit Button

■ Type
Selects the category of graphics.

■ OFF, ON
Displays the graphic when OFF or ON. Click ON or OFF to switch the graphics displayed on the list.

■ Picture List
Displays the list of registered graphics. Select the graphic to use as the outline of the part.

2 View Browser



3 Color Palette

A-4 WindO/I-NV4 User’s Manual

  

The Color Palette is used to select colors for drawing objects, text on parts, outlines, flanges, plates and other objects.
Display the Color Palette by clicking a color in the Properties dialog box and then select the color.
The type of color palette shown depends on the models being used.

■ 256 Color Palette*1

■ 16-level Monochrome Palette*2

■ More Colors, Close
Switches the palette display. Clicking More Colors shows all the colors assignable to the Color button. Close shows 
only the basic colors assignable to the Color button.

■ Text Manager Color
This feature allows use of the text color specified in the Text Manager. Click here to use the text color specified in the 
Text Manager. This option can only be set when the Use Text Manager check box is selected.

■ Transparent Color
Converts the color in the imported picture to be transparent. This option can only be selected when Picture Manager 
was used.

■ None
This option is no fill color. This can only be set for Background Color in drawing object text.

*1 Color LCD models only
*2 Monochrome LCD models only

3 Color Palette

(Color)

(Color)
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The Pattern Palette is used to select patterns or tonal gradations for drawing and part objects.
The Pattern Palette appears when you click Pattern in the object’s Properties dialog box.
Click Pattern and select a pattern or tonal gradations.

Drawings

Parts

● Foreground and Background Colors
Drawing and part objects are formed by foreground and background colors.

■ Pattern
The selected pattern is applied to the foreground color.

The background color is visible through the unpainted parts of the foreground color.

■ Gradation
The selected gradation is applied to the foreground color.

The background color is visible through the unpainted parts of the foreground color.

4 Pattern Palette

Pattern image

Gradation image

Pattern image

Gradation image

Foreground color
Background color

Foreground color
Background color



4 Pattern Palette

A-6 WindO/I-NV4 User’s Manual

● Patterns and gradations
These patterns and gradations are available on WindO/I-NV4. When 024 on the Foreground Color and 000 on the 
Background Color are selected for the Rectangle, the display images are as follows:

■ Patterns

■ Gradation

*1 None can only be applied to drawing objects. Selecting None is the same as not applying any color at all.

Pattern name None*1 Foreground 
100%

Foreground 
25%

Foreground 
50%

Background 
100%

Pattern buttons

Display sample

Pattern name
Horizontal 

lines
Vertical lines

Slant 
Upwards

Slant 
Downwards

Crosshatch Tint

Pattern buttons

Display sample

Gradation name Diagonal up 1 Horizontal 1
Diagonal 
down 1

Vertical 1 Diagonal up 2 Horizontal 2 

Gradation buttons

Display sample

Gradation name
Diagonal 
down 2

Vertical 2 Central 1 Central 2 Vertical 3 Vertical 4

Gradation buttons

Display sample

Gradation name Horizontal 3 Horizontal 4

Gradation buttons

Display sample
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Text Alignment is used to adjust the way text appears on Drawing Objects and Parts.

● Horizontal Writing
These examples show how text appears using different combinations of the Align Text Horizontal and Align Text 
Vertical properties.

■ Align Text Horizontal

5 Text Alignment

Align Text Horizontal
Left Center Right Center-Left

Align Text 
Vertical

Top ---

Center
(Center-Top)

Bottom ---

Left: Aligns the text along the left edge.

Center: Centers the text horizontally in the center.

Right: Aligns the text along the right edge.

Center-Left: Centers the line containing the most number of characters, and then aligns the other lines 
to the left end of that line.

Aligns along left edge

Centers text in the middle

Aligns along right edge

Aligns to left end of line with most characters

Centers line with most characters

If Align Text Horizontal is set to Center-Left, Align Text Vertical will automatically be set to Center-
Top. Center-Top results in the same display as Center.
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■ Align Text Vertical

● Vertical Writing
These examples show how text appears for Align Text Horizontal.
Align Text Vertical defaults to Top.

Top: Aligns the text along the top edge.

Center (Center-Top): Centers the text vertically in the center.

Bottom: Aligns the text along the bottom edge.

Aligns text along top edge

Centers text in the middle

Aligns text along bottom edge

Align Text Horizontal
Left Center Right

Align 
Text 

Vertical
Top
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5 Text Alignment
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■ Align Text Horizontal

Left: Aligns the text along the left edge.

Center: Centers the text horizontally in the center.

Right: Aligns the text along the right edge.

Aligns along left edge

Centers text in the middle

Aligns along right edge

• Vertical text cannot be set if Font is set to Stroke.
• Take note of these points when the Vertical Writing check box is selected:

- When there is a mixture of double-byte and single-byte characters, the half-width characters are 
leftaligned.

- Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

Aligned to 
left edge

Horizontal
display

Next
characters
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6.1 Installing the USB driver

Windows 8

Follow these steps to install the USB driver.

1 Connect the USB cable to the USB interface on the MICRO/I (with power supplied) and the USB port on the computer 
(computer should be on).

2 An icon is displayed on the taskbar. Click this icon to display the progress dialog box.

3 When the installation has finished, the taskbar icon automatically disappears.

The concludes USB driver installation.

Windows 7, Windows Vista

Follow these steps to install the USB driver.

1 Connect the USB cable to the USB interface on the MICRO/I (with power supplied) and the USB port on the computer 
(computer should be on).

6 USB Driver

Before the MICRO/I can be connected to a computer, it is necessary to install WindO/I-NV4. If you connect 
MICRO/I to the computer before installing either driver, an error message will appear prompting you to 
install the driver software. In this case, clear the error and install either driver.

MICRO/IComputer

USB cableA plug Mini-B plug

To USB port To USB interface

The USB interface supports both the 64-bit and 32-bit editions of Windows 7, and the 32-bit edition of 
Windows Vista. It does not support the 64-bit edition of Windows Vista.

MICRO/IComputer

USB cableA plug Mini-B plug

To USB port To USB interface
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2 A message is displayed at the bottom-right of the desktop.

3 The message "Your device is ready to use" is displayed at the bottom-right of the desktop.

The concludes USB driver installation.

Windows XP

Follow these steps to install the USB driver.

1 Connect the USB cable to the USB interface on the MICRO/I (with power supplied) and the USB port on the computer 
(computer should be on).

A message Found New Hardware appears, followed by the Found New Hardware Wizard.

2 Select No, not this time and click Next.

The USB interface supports only the 32-bit edition of Windows XP. It does not support the 64-bit edition.

MICRO/IComputer

USB cableA plug Mini-B plug

To USB port To USB interface



6 USB Driver

A-12 WindO/I-NV4 User’s Manual

3 Select Install the software automatically (Recommended) and click Next.

The Hardware Installation dialog box is displayed.

4 Click Continue Anyway.

The USB driver installation begins.

5 Click Finish.

The driver names will appear as follows if the USB driver installs properly.
• IDEC USB CDC ACM.

If the Hardware Installation dialog box is not displayed and the installation aborts, check the Driver 
Signing Options.
For details, refer to “Changing driver signing options” on page A-13.
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Changing driver signing options
If the USB driver installation stops before it is complete, follow these steps to check the driver signing options.

1 Click Start - Control Panel - Performance and Maintenance - System.

The System Properties dialog box is displayed.

2 Click Driver Signing on the Hardware tab.

The Driver Signing Options dialog box is displayed.

3 Select Warn under the label What action do you want Windows to take?, and click OK.

This brings you back to the System Properties dialog box.

4 Click OK on the System Properties dialog box.

This brings you back to the Control Panel.

5 Click  (Close) on the Control Panel.

If Block is selected, the Hardware Installation dialog box is not displayed and installation stops.

To reinstall the USB driver, disconnect the USB cable from the USB interface on the MICRO/I and from the 
USB port on the computer. Reinstall by referring to “Windows XP” on page A-11.
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6.2 Checking the USB Driver

Follow these steps to confirm that the USB driver was installed properly, and that the computer recognizes MICRO/I 
correctly.

1 Call up the Device Manager.

■ Windows 8
Right-click on the Start screen and then click All Apps, Control Panel, and Hardware and Sound. In the 
Hardware and Sound dialog box, click Device Manager.

■ Windows 7
Click Start, Control Panel, System and Security, and then Device Manager.

■ Windows Vista
Click Start, Control Panel, System and Maintenance, System, and then Device Manager.
If the User Account Control dialog box is displayed, click Continue.

■ Windows XP
(1) Click Start, Control Panel, Performance and Maintenance, and then System.

The System Properties dialog box  is displayed.
(2) Click Device Manager on the Hardware tab.

2 Click Ports (COM & LPT).

If the following device name is shown, the USB driver is already installed and the computer recognizes the MICRO/I.
• IDEC USB CDC ACM. (XXXX) (XXXX is the port name.)

• The device name will disappear if the USB cable is disconnected or the MICRO/I power is turned off.
• When the MICRO/I power is turned on and the USB cable is connected, the words Unknown Device or 

a “?” may appear in place of the device name, indicating the computer may not be recognizing the USB 
driver correctly. Disconnect the USB cable and turn the MICRO/I power off. Then turn the MICRO/I 
power on again and connect the USB cable to check that the computer recognizes the USB driver. If the 
computer still does not recognize the USB driver, uninstall it from the Device Manager and reinstall it.
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